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Welcome
This Help provides in-depth information on how to use the RSA5100B Series Real-Time Signal Analyzers. For a shorter introduction to the
Signal Analyzer, refer to the RSA5100B Series Real-Time Signal Analyzer Quick Start User Manual. To see tutorial examples of how to use
your analyzer to take measurements in different application areas, refer to the RSA5100B Series Real-Time Signal Analyzer Application
Examples Reference.

Welcome
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About the Tektronix signal analyzer
Product software
The instrument includes the following software:

• System software: The RSA5100B Series product software runs on a specially configured version of Windows 10. As with standard
Windows 10 installations, you can install other compatible applications, but the installation and use of non-Tektronix software is not
supported by Tektronix. Do not substitute any version of Windows that is not specifically provided by Tektronix for use with your
instrument.

• Product software: The product software is the instrument application. It provides the user interface (UI) and all other instrument
control functions. You can minimize or even exit/restart the instrument application as your needs dictate.

Occasionally, new versions of software for your instrument may become available at our Web site. Visit www.tektronix.com/software for
information.

Software and hardware upgrades
Tektronix may offer software or hardware upgrade kits for this instrument. Contact your local Tektronix distributor or sales office for more
information.

Software upgrades
Tektronix may offer upgrade kits for this software. Contact your local Tektronix distributor or sales office for more information.

Accessories

Standard accessories
The standard accessories for the instruments are shown below. For the latest information on available accessories, see the Tektronix Web
site. 

Quick Start User Manual
• English - Option L0, Tektronix part number 071-3224-XX
• Japanese - Option L5, Tektronix part number 071-3225-XX
• Simplified Chinese - Option L7, Tektronix part number 071-3226-XX
• Russian, Option L10, Tektronix part number 071-3227-XX

Application Examples Reference
• English – Tektronix part number 071-3283-XX
• Japanese - Option L5, Tektronix part number 071-3284-XX
• Simplified Chinese - Option L7, Tektronix part number 071-3285-XX
• Russian, Option L10, Tektronix part number 071-3286-XX

Product Documentation CD-ROM
The Product Documentation CD-ROM contains a collection documentation available for your product, in PDF format. See Documentation
for a list of the documents included on the CD-ROM.

Note: To check for updates to the instrument documentation, browse to www.tektronix.com/manuals and search by your
instrument's model number.

Important documents folder
• Certificate of Calibration documenting NIST traceability, 2540-1 compliance, and ISO9001 registration

About the Tektronix signal analyzer
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Power cords
• North America - Option A0, Tektronix part number 161-0104-00
• Universal Euro - Option A1, Tektronix part number 161-0104-06
• United Kingdom - Option A2, Tektronix part number 161-0104-07
• Australia - Option A3, Tektronix part number 161-0104-05
• 240V North America - Option A4, Tektronix part number 161-0104-08
• Switzerland - Option A5, Tektronix part number 161-0167-00
• Japan - Option A6, Tektronix part number 161-A005-00
• China - Option A10, Tektronix part number 161-0306-00
• India - Option A11, Tektronix part number 161-0324-00
• No power cord or AC adapter - Option A99

Optical wheel mouse

Options
To view a listing of the optional application licenses (options) installed on your instrument, select Help > About Your Tektronix Real-Time
Analyzer. There is a label on the rear-panel of the instrument that lists installed hardware options.

Application licenses can be added to your instrument. For the latest information on available licenses, see the Tektronix Web site.

Documentation and support

Documentation
In addition to the instrument Help, the following documents are available. For the most current product documentation, application, and
solutions information, visit the Tektronix Web site www.tektronix.com/downloads. 

• Quick Start User Manual (071-3224-XX - English). This manual has information about installing and operating your instrument. This
manual is also available in Japanese (071-3225-XX), Simplified Chinese (071-3226-XX), and Russian (071-3227-XX). These manuals
are available in both print and a printable PDF file.

• Application Examples Reference (071-3283-XX). This manual provides examples of how to solve problems using an RSA5100B
Series Signal Analyzer. This manual is also available in Japanese (071-3284-XX), Simplified Chinese (071-3285-XX), and Russian
(071-3286-XX). These are available in both print and a printable PDF file.

• Programmer Manual (077-00901-XX). This manual provides information to use commands for remotely controlling your instrument.
This is available as a printable PDF file.

• Service Manual (077-0903-XX). This manual includes procedures to service the instrument to the module level. This is available as a
printable PDF file.

• Specifications and Performance Verification Technical Reference Manual (077-0900-XX). This manual includes both the
specifications and the performance verification procedures. This is available as a printable PDF file.

• Declassification and Security Instructions (077-0902-XX). This document helps customers with data security concerns to sanitize or
remove memory devices from the instrument. This is available as a printable PDF file.

The most recent versions of the product documentation, in PDF format, can be downloaded from www.tektronix.com/manuals. You can find
the manuals by searching on the product name.

Where to find more information
You can find all product related documentation on the Tektronix Web site at www.tek.com/manuals. Browse www.tek.com for additional
information related to applications and solutions.

About the Tektronix signal analyzer
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Video tutorials
You can browse the Tektronix YouTube channel (www.youtube.com/user/tektronix) to find video tutorials about various topics related to
your product. You can also subscribe to the Tektronix YouTube channel to keep up with new postings. 

Searching for topics
For example, you can watch a video tutorial about using the WLAN Presets. To find a video on this topic, do the following. The following
image shows you what the Tektronix YouTube Channel looks like.

1. Click on the search icon located just above the video you see when the page first loads.

Note: This icon allows you to search the Tektronix YouTube channel specifically. The search icon located at the top of the
page allows you to search all of YouTube .

2. Type in the keyword “WLAN” in the search field.
3. Click the search icon to start the search.
4. Videos related to the topic will appear. Click a video to view it.

How to manage the 5GNR analysis license
After installing the Tek RSA5100B 5GNR Analysis plugin, it needs to be activated on that instrument/PC/laptop. The activation requires an
activation code which is 20 digit alphanumeric characters separated by a hyphen between every four characters. The following topics give
procedure to activate or deactivate the 5GNR Analysis.

5GNR Analysis activation
1. Start the Tek RSA5100B application.
2. On the Tools menu, click Manage 5GNR Analysis Activation…. The Manage 5GNR Analysis Activation dialog box appears.
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3. If you do not have the activation code, under Activation, click Copy, and then close the Manage 5GNR Analysis Activation dialog
box.

Note: Share the Computer ID and API Version that you have copied with your local Tektronix account manager to get the
activation code generated for this system.

4. If you have the activation code, under Activation, in the Activation code box, enter the activation code that you received from
Tektronix, and then click the Activate.

5. If you receive the “5GNR Analysis activation failed. Please enter a valid activation code.” message, click OK, and then contact your
local Tektronix support or Account Manager to get the correct activation code.

About the Tektronix signal analyzer
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6. If you receive the “5GNR Analysis activation successful” message, click OK.

7. Close the Manage 5GNR Analysis Activation dialog box and restart the Tek RSA5100B application.

5GNR Analysis de-activation
1. Start the Tek RSA5100B application.
2. On the Tools menu, click Manage 5GNR Analysis Activation…. The Manage 5GNR Analysis Activation dialog box appears.

3. Under Deactivation, click Deactivate 5GNR Analysis.

4. Click OK and continue with 5GNR Analysis de-activation.
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5. If you receive the “5GNR Analysis deactivation successful” message, click OK, and then restart the Tek RSA5100B application.
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Orientation
Front panel connectors

Item Connector Description

1 Trig Out Trigger output connector. 50 Ω, BNC, High > 2.0 V, Low < 0.4 V, (output current 1 mA).

2 Trig In External Trigger input connector, –2.5 V to +2.5 V (user settable).

3 USB 2.0 USB 2.0 connector.

4 USB 2.0 USB 2.0 connector.

5 RF Input RF input connector 50 Ω.

Front-Panel controls

Reference Item Function Menu Equivalent

1 Media Removable hard disk drive (optional).

Table continued…
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Reference Item Function Menu Equivalent

2 Displays Opens the Displays dialog box enabling
you to select which displays to open.

Setup > Displays

3 Settings Opens/closes the Settings control panel
for the selected display.

Setup > Settings

4 Trigger Opens/closes the Trigger control panel. Setup > Trigger

5 Acquire Opens/closes the Acquire control panel. Setup > Acquire

6 Analysis Opens/closes the Analysis control panel. Setup > Analysis

7 Freq Press to adjust the measurement
frequency.

Setup > Analysis > Frequency

8 Span (Spectrum) Press to adjust the span or press and hold
to display the Freq & Span control panel
for the General Signal Viewing displays.

9 Amplitude Opens/closes the Amplitude control panel. Setup > Amplitude

10 BW (Spectrum) Press to adjust the bandwidth or press
and hold to display the BW control panel
for the General Signal Viewing displays.

Reference Item Function Menu Equivalent

11 Run/Stop Starts and stops acquisitions. Run > Start Run > Stop

12 Peak (Markers section) Moves the active marker to the maximum
peak of the trace in the selected display. If
markers are turned off, the marker reference
(MR) will appear at the maximum peak.

Markers > Peak

Table continued…
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Reference Item Function Menu Equivalent

13 Select (Markers section) Selects the next marker. If markers
are turned off, the MR marker (marker
reference) will appear.

14 Define (Markers section) Opens the Markers control panel. If markers
are turned off, the MR marker (reference)
will appear.

15 Control knob Changes values in numeric and list controls.
Pressing the knob (clicking it) is the same as
pressing the Enter key on a keyboard.

16 Arrow keys Move the Markers. The Up arrow moves the
selected marker to the next highest peak.
The down arrow moves the selected marker
to the next lower peak value. The right and
left arrows move the selected marker to the
next peak.

17 Increment/decrement keys Increments or decrements the selected
value

18 Delete, (Markers section) Deletes the selected marker

19 Add, (Markers section) Add a marker to the selected trace

20 Replay Replays the current acquisition record

21 Single Sets the Run mode to Single Sequence

Reference Item Function Menu Equivalent

22 Keypad Enters values in numeric controls.

23 Enter Completes data entry in controls. Same
as pressing the Enter key on an external
keyboard.
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Reference Item Function Menu Equivalent

24 Recall Opens the Recall dialog box. File > Recall

25 Save Opens the Save As dialog box. File > Save As

26 Touch Screen Off Turns the touch screen on and off. It is off
when lighted.

27 Help Displays the help. Help > Online Manual

28 Applic Sets the instrument to the selected
Application Preset values.

Presets > Application

29 DPX Sets the instrument to the selected DPX
Preset values.

Presets > DPX

30 User Sets the instrument to the selected User
Preset values.

Presets > User

31 Preset Returns the instrument to the default or
preset values.

Preset

Touch screen
You can use touch to control the instrument in addition to the front-panel controls, mouse, or extended keyboard. Generally, touch can be
used anywhere that click is mentioned in this help.

To disable the touch screen, push the front-panel Touch Screen Off button. When the touch screen is off, the button is lighted. You can
still access the on-screen controls with a mouse or keyboard.

You can adjust the touch screen operation to your personal preferences. To adjust the touch screen settings, from Windows, select Start >
Control Panel > Touch Screen Calibrator.

Note: If the instrument is powered on in Windows Safe Mode, the touch screen is inoperative. You will need to use a mouse or
keyboard to restore normal operation.

Touch-Screen actions
You can use the touch screen to change marker settings and how waveforms are displayed by using the Touch-screen Actions menu.
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To use the Touch-screen Actions menu, touch the display in a graph area and hold for one second, then remove your finger. You can also
use a mouse to display the Touch-screen Action menu by clicking the right mouse button.

Icon Menu Description

Select Selects markers and adjusts their position.

Span Zoom Zooms the graph area about the selected point. Touch
the graph display at a point of interest and drag to
increase or decrease the span about the point of
interest. Span Zoom adjusts the span control and can
affect the acquisition bandwidth.

CF Pan Adjusts the Center Frequency according to horizontal
movement.

Zoom Adjusts horizontal and vertical scale of the graph.
The first direction with enough movement becomes
the primary scale of adjustment. Adjustment in the
secondary direction does not occur until a threshold of
30 pixels of movement is crossed.

Dragging to the left or down zooms out and displays
a smaller waveform (increases the scale value).
Dragging to the right or up zooms in and displays
a larger waveform (decreases the scale value).

Pan Adjusts horizontal and vertical position of the
waveform. The first direction with enough movement
becomes the primary direction of movement.
Movement in the secondary direction does not occur
until a threshold of 30 pixels of movement is crossed.

- Reset Scale Returns the horizontal and vertical scale and position
settings to their default values.

- Marker to peak Moves the selected marker to the highest peak. If no
marker is turned on, this control automatically adds a
marker.

Table continued…
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Icon Menu Description

- Next Peak Moves the selected marker to the next peak. Choices
are Next left, Next right, Next lower (absolute), and
Next higher (absolute).

- Add marker Defines a new marker located at the horizontal center
of the graph.

- Delete marker Removes the last added marker.
- All markers off Removes all markers.

Trigger On This Use to visually define trigger parameters in the DPX
display (present only in the DPX Spectrum display).

Touch-Screen Menu for Spurious Display
The Touch-screen actions menu in the Spurious display has some minor changes compared to the standard version used in other displays.

Icon Menu Description
- Single-range Changes the current multi-range display to a single range display.

The displayed range is the range in which you display the
touchscreen-actions menu. Selecting Single-range from the menu
is equivalent to selecting Single on the Settings > Parameters tab.

- Multi-range Changes the current single-range display to a multi-range display.
Selecting Multi-range from the menu is equivalent to selecting Multi
on the Settings > Parameters tab.

- Marker -> Sel Spur Moves the selected marker to the selected spur.

Elements of the display
General application window areas. The main areas of the application window are shown in the following figure. 
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Specific elements of the application display window. Specific elements of the display are shown in the following figure. More detailed
information is available in the Menus section.
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Ref number Setting Description
1 Recall Displays the Open window in order to recall setup files, acquisition data files, or

trace files.
2 Save Opens the Save As dialog in order to save setup files, pictures (screen captures),

acquisition data files, or export measurement settings.
3 Undo/Redo Undoes or redoes the previous edit to a display or measurement settings, a

preset, or a measurement change.
4 Displays Opens the Select Displays dialog box so that you can select measurement

displays.
5 Settings Opens the Settings control panel for the selected display. Each display has its

own control panel.
6 Trigger Opens the Trigger control panel so that you can define the instrument trigger

settings.
7 Acquire Opens the Acquire control panel, which displays the Sample Rate and Record

length of the recalled waveform file.
8 Analysis Opens the Analysis control panel so that you can define the analysis settings

such as frequency, analysis time, and units.
9 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,

configure internal attenuation, and specify external gain/loss corrections.
10 GNSS/Antenna Opens the GNSS/Antenna control panel so that you can configure and activate an

external GNSS receiver and antenna.
Table continued…
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Ref number Setting Description
11 Favorite User Presets Click to select from a list of custom favorite User presets and load the selected

preset. For more detailed information, see the Make a User preset a Favorite
preset topic.

12 Main menu bar Located above the Favorites toolbar, it contains access to menus. For detailed
information, see the Main Menu (see page 780) topic.

13 Preset Recalls the Main preset.
14 Replay Runs a new measurement cycle on the last acquisition data record using any new

settings. See the Replay menu topic for more details.
15 Run

and

Run/Stop toolbar

• Run menu and Run/Stop toolbar

Starts and stops data acquisitions and specifies the run conditions. For
example, if you select Single in the Run/Stop toolbar (or Run Single in the
Run menu), a single measurement cycle is run. If you select Continuous in the
Run/Stop toolbar (or Run Continuous in the Run menu), the data acquisition
runs until stopped.

• Run menu

The Run menu also includes Resume and Abort. Resume restarts data
acquisition, but does not reset accumulated results, such as Average or
MaxHold. This allows you to stop acquisitions temporarily, then continue.

Abort immediately halts the current acquisition/measurement cycle. In-
process measurements and acquisitions are not allowed to complete.

See the Run menu topic for more details.

16 The Edit Favorites icon allows you access the below menu, which allows you to
edit the contents of the Favorites bar. For more information, see the Favorites bar
topic.

Table continued…
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Ref number Setting Description
17 Reference Level Displays the reference level. To change the value, click the text and enter a

number using a keyboard, or use a mouse scroll wheel.
18 Frequency Displays the frequency at which measurements are made. For spectrum displays,

this is called “Center Frequency”. To change the value, click the text and use the
front panel knob to dial in a frequency. You can also enter a frequency with the
front panel keypad or use the front panel up and down buttons.

Rear-Panel connectors

Item Description

1 AC Input, main power connector

2 GPIB

3 Zero Span Analog Output (Option 66)

4,5 Digital I and Q Outputs (Option 65)

6 +28 V DC Output, switched

7 Microphone in; Headphone, audio output; and Line In connectors

8 External Trigger 2 lnput

9 COM 2, serial port for connecting peripherals

10 VGA external monitor output (resolution not limited to VGA)

11 PS2 keyboard input

12 USB 2.0 ports for mouse and other peripherals (printers, external hard disks)

13 Ref Out, reference frequency output

14 Ref In, reference frequency input

Table continued…
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Item Description

15 LAN, Ethernet network connector

Setting up network connections
Because the instrument is based on Windows, you configure network connections for the instrument the same way you would for any PC
based on Windows. See Help and Support in the Windows Start menu to access the Windows Help System for information on setting up
network connections.
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Operating your instrument
Restoring default settings
To restore the software to its factory default settings: 

1. Select Presets > Preset Options.
2. In the Presets tab of the Options control panel, click to the view the Preset type drop down menu and select Main.
3. Click to the view the Presets drop down menu and select Original.
4. Click the red X icon in the top right corner of the Options control panel to close the panel.
5. Select Presets > Main from the menu bar to return the software to its original factory default settings.

Note: You can also press the Preset button on the front-panel or click the Preset button on the right-hand side of the display
menu bar to load the Main preset.

Note: The Original Main preset resets all settings and clears all acquisition data (previously recalled waveform files). Settings that
have not been saved will be lost.

Running alignments
Alignments are adjustment procedures. Alignments are run by the instrument using internal reference signals and measurements and do
not require any external equipment or connections.

These are the settings for Alignments: 

• Automatically align as needed
• Run alignments only when the Align Now button is pressed
• Run alignments only when the Align or Align All button is pressed (only available for instruments with an HD option installed).

If Automatically align as needed is selected, alignments run whenever the signal analyzer detects a sufficient change in ambient
conditions to warrant an alignment.

If Run alignments only when "Align Now" button is pressed is selected, the signal analyzer never runs an alignment unless you
manually initiate an alignment using the Align Now button.

If Run alignments only when "Align" or “Align All” button is pressed is selected, the signal analyzer never runs an alignment unless
you manually initiate an alignment using the Align or Align All buttons.

Note: There are a few critical adjustments that must run occasionally even if Automatically align is not enabled.

Alignment Status
When the signal analyzer needs to run an alignment, it displays a message on screen. If no message is displayed, you can assume that
the signal analyzer is properly aligned.

Note: If you must use the instrument before it has completed its 20-minute warm-up period, you should perform an alignment to
ensure accurate measurements.

Initiating an Alignment
1. Select Tools > Alignments.
2. Select the Align Now button.
3. Select the desired align button:

• For instruments without an HD option installed, select the Align Now button.
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• For instruments with an HD option installed, you can select one of two alignment buttons. Select Align to run only the alignment
procedure necessary to complete an alignment at the current temperature. Select Align All to run all alignment procedures.

The signal analyzer will run an alignment procedure. Status messages are displayed while the alignment procedure is running. If the
instrument fails the alignment procedure, an error message will be displayed. If the instrument fails an alignment, run Diagnostics (Tools >
Diagnostics) to see if you can determine why the alignment failed.

Note: While an alignment is running, both the IQ and Zero Span output are disabled.

Alignments during warm-up. During the 20-minute warm-up period, the signal analyzer will use the alignment data generated during the
previous use of the instrument as it warms to operating temperature (if Auto mode is selected). During the specified period for warm-up,
the instrument performance is not warranted.

Alignments during normal operation. Once the signal analyzer reaches operating temperature ±3 degrees C (as detected inside the
instrument), an alignment will be run. If an alignment becomes necessary during a measurement cycle (if Auto mode is selected), the
measurement is aborted and an alignment procedure is run. Once an alignment procedure is completed, the measurement cycle restarts.

Alignments for instruments with an HD option. Instruments with an HD option have certain components that require alignment for
±1 degree C change. In these cases, once the signal analyzer reaches operating temperature ±1 degree C (as detected inside the
instrument), an alignment will be run.

Note: The first time the instrument runs after a software upgrade (or reinstall), the instrument will perform a full alignment after the
20–minute warm-up period. This alignment cannot be aborted and it occurs even if alignments are set to run only when manually
initiated.

Alignments Are Not Calibrations
Alignments are adjustment procedures run by the instrument using internal reference signals and measurements. Calibrations can only
be performed at a Tektronix service center and require the use of traceable test equipment (signal sources and measuring equipment) to
verify the performance of the instrument.

Presets
Menu Bar: Presets
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The analyzer includes a set of configurations or presets that are tailored to specific applications. These configurations, referred to as
Presets, open selected displays and load settings that are optimized to address specific application requirements.

Preset Options
Select the Presets > Preset Options menu to open the Options control panel. This panel allows you to select the following. Once you
have chosen these settings, you can access any preset or list of presets from Presets on the menu bar.

• Preset type: Select the Preset type.
• Presets: Select which preset you want to display for that particular preset type.
• Preset action: Selecting a preset from the Preset drop down menu results in one of two actions depending on which item you choose

in the Preset action list: Recall selected preset will immediately execute a preset when it is selected from the Presets menu. Show
list will display a list of presets subtypes from which you can then select the preset you want to recall." .

Available Presets
Select Presets > Preset Options from the menu bar to access the available types of Presets:

• Main
• DPX
• Standards
• Application
• User

You can set if a preset is immediately executed when selected, or if a list of presets is displayed from which you can select the Preset to
recall. Available presets are described in the following table.

Presets Description

Main

Current This Preset sets the instrument to display a Spectrum display with settings matched to
show a Spectrum display with settings appropriate for typical spectrum analysis tasks.
This preset was updated from the original factory preset with version 3.2 of the instrument
software.

Original This Preset is the original factory preset used with software versions 1.0 through 3.2. This
version of the factory preset is included to allow users to maintain compatibility with existing
remote control software.

Full Spectrum This Preset sets the instrument to display a Spectrum display with the center frequency set
to 1/2 the instrument frequency range and the acquisition bandwidth set to the maximum
real-time bandwidth, which depends on the installed option.

DPX

Open the DPX display The Open the DPX display opens the DPX display without closing existing displays.

Swept The DPX Swept Preset displays the DPX Spectrum display with the span set to maximum
and the center frequency set to 1/2 the span.

Real Time The DPX Real Time Preset displays the DPX Spectrum display with the center frequency
set to 1.5 GHz and the span set to the maximum available real-time bandwidth.

Table continued…
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Presets Description

Zero Span The DPX Zero Span Preset displays the DPX Zero Span display with the position set to 0 s
and the sweep set to 1 ms.

Standards

WLAN This preset sets the instrument to display the WLAN Summary, WLAN Constellation, and
SEM displays. After you select the standards and bandwidth, the software configures these
displays to apply the parameters appropriate for typical WLAN analysis tasks.

P25 This preset sets the instrument to display the MCPR, Time Overview, P25 Summary, and
P25 Constellation displays. After you select the standard and modulation type, the software
configures these displays to apply the parameters appropriate for typical P25 analysis
tasks.

Bluetooth This preset set the instrument to display a particular set of displays depending on which
combination of standard (Low Energy or Basic Rate) and test setup (one of up to eight) you
select. After you select the standard and test setup, the software configures the displays to
apply the parameters appropriate for typical Bluetooth analysis tasks.

LTE This preset loads a set of LTE displays and a test setup, frame structure, and channel
bandwidth to perform LTE tests. The software configures these displays to apply the
parameters appropriate for LTE analysis tasks.

5GNR This preset loads a set of 5GNR displays and a test setup, frame structure, and channel
bandwidth to perform 5GNR tests. The software configures these displays to apply the
parameters appropriate for 5GNR analysis tasks.

Application

Time-Frequency Analysis The Time-Frequency preset configures the instrument with settings suited to analyzing
signal behavior over time.

Spectrum Analysis The Spectrum Analysis application preset provide you with the settings commonly used for
general purpose spectrum analysis.

Modulation Analysis The Modulation Analysis setup application preset provides you with the most common
displays used during modulation analysis. Only present when Option 21 is installed.

Pulse Analysis The Pulse Analysis application preset provides you with the most common displays used
during pulse analysis, and makes changes to the default parameters to settings better
optimized for pulsed signal analysis. Only present when Option 20 is installed.

Spur Search Multi Zone 9k-1GHz The Spur Search application preset configures the instrument to show the Spurious display
with the frequency range set to 9 kHz to 1 GHz.

Phase Noise The Phase Noise application preset opens the Phase Noise display, and makes changes to
the default parameters to settings better optimized for phase noise analysis. Only present
when Option 11 is installed.

Table continued…
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Presets Description

Noise Figure The Noise Figure application preset opens the Gain, Noise Figure, and Noise Table
displays, and makes changes to the default parameters to settings better optimized for
noise figure analysis. Only present when Option 14 is installed.

User (Favorites)

User Preset 1 This Preset is provided as an example for you to create your own Presets. This preset
displays the Spectrum, Spectrogram, Frequency vs Time, and Time Overview displays.

User Preset 2 This Preset is provided as an example for you to create your own Presets. This preset
displays the Spurious display configured to test for Spurious signals across four ranges.

Other user presets User presets you create and save will appear in the Preset drop down menu of the User
Presets window. Any User preset that you have designated as a Favorite will be marked
with an *.

Recalling a Preset
To recall a preset, select Presets and then the desired preset type.

Note: You can set which presets to recall from the Presets > Preset Options control panel.

To recall a named (User) preset from the front panel, press the button on the front panel matching the preset type you want to recall. For
example, to recall a DPX preset type, press the DPX button.

Note: You can also click the Preset button on the right-hand side of the menu bar to load the Main preset.

Note: The only Presets recalled by the front-panel Preset button, the Preset icon in the icon bar, and the *RST remote command,
are the Main Presets. Application, DPX, Standards, and User Presets can only be recalled using selections in the Presets menu.

Creating User Presets
You can add your own presets to the list that appears in the User Presets dialog box. Configure the analyzer as needed for your application
and create a Setup file in C:\RSA5100B Files\User Presets. The name you give the file will be shown in the User Presets list on the
Presets tab of the Options control panel. For instructions on how to save a Setup file, see Saving Data.

Configuring a User Preset
After you have selected a preset:

• Set the measurement frequency using the front-panel knob or keypad.
• Adjust the span to show the necessary detail.

User (Favorites) Presets
Select the Presets > User (Favorites) menu to open the User Presets window. The Presets drop-down list shows the three default user
presets provided with the software.
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• User Preset 1: Sets up the Spectrum, Time Overview, Spectrogram, and Frequency vs Time displays.
• User Preset 2: Sets up the Spurious display.

Make a User preset
You can add your own User presets to the list that appears in the User Presets dialog box as follows:

1. Select Save As from the File menu to open the Save As dialog box.
2. Select to save to C:\RSA5100B\User Presets.
3. Enter a file name. The name you give the file will appear in the User Presets dialog box list.
4. Select a .Setup file type from the Save as type drop-down list.
5. Click Save.

Make a User preset a Favorite preset. You can place one or more User presets on the Favorites bar as a Favorite preset for quick
access. Do this as follows:

1. Select Presets > User to open the User Presets window.
2. Select the desired preset from the Presets drop-down list.
3. Click the Add Favorite button. An * will appear next to the selected preset. You can do this for more than one preset.

Operating your instrument

RSA5100B Series Real-Time Signal Analyzers Help 41



4. If desired, add a note for this preset in the Notes field and then click the Save button. Whenever you recall this preset, this note will
appear in a separate window, as shown below.

5. Click the OK button in the User Presets window.

6. Click on the  icon on the Favorites bar and you will see the recently added Favorite preset listed.

7. When you are ready to recall a Favorite preset, click  and select the preset from the list that appears.
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8. To remove a Favorite preset, select it from the User Presets window and click the Remove Favorite button. The * should disappear

from the list.

Standards Presets
The Standards presets allow you to recall preconfigured displays for the standards that you select. You can select from the following
standards groups.

• WLAN: The IEEE wireless LAN (WLAN) standards specify the wireless interface between two wireless clients or a wireless client and a
base station. The WLAN presets allow you to access displays preconfigured for the WLAN standards and bandwidths you select.

Note: More information is available about WLAN standards here. You can also watch a video tutorial about WLAN Presets at
www.youtube.com/user/tektronix. Click here for information about searching the Tektronix YouTube channel for videos.

• P25: The Project 25 (P25) TIA-102 standards specify the design of interoperable digital two-way wireless communications products.
The P25 presets allow you to access displays preconfigured for the P25 standards you select. You can choose either the Phase 1
(FDMA) standard or the Phase 2 (TDMA) standard.

Note: More information is available about P25 standards here.

• Bluetooth: The Bluetooth standards specify short range RF signals. The Bluetooth presets allow you to access displays preconfigured
for the specific Bluetooth standards you select: Basic Rate, Low Energy, and Enhanced Data Rate (EDR).

Note: More information is available about Bluetooth standards here.

• LTE: The LTE standards ensure that the RF signals meet 3GPP measurements specifications. The LTE presets test setups load
pre-configured displays and control setting as suggested by the selected standard to accelerate the test setup of the analyzer.
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Note: More information is available about LTE standards and test setups here.

• 5GNR: The 5GNR standards ensure that the RF signals meet 3GPP measurements specifications. The 5GNR presets test setups load
pre-configured displays and control setting as suggested by the selected standard to accelerate the test setup of the analyzer.

Modulation Analysis
The Modulation Analysis application preset opens the following displays:

• DPX display: Shows you a continuous spectrum monitoring of the specified carrier frequency.
• Signal Quality: Shows a summary of modulation quality measurements (EVM, rho, Magnitude Error, Phase Error, and others).
• Constellation: Shows the I and Q information of the signal analyzed in an I vs. Q format.
• Symbol Table: Shows the demodulated symbols of the signal.

To use the Modulation Analysis preset (assuming the Preset action is set to Show list in the Presets tab of the Options control panel):

1. Select Presets > Application. Select Modulation Analysis and then click OK.
2. Set the measurement frequency using the front-panel knob or keypad. Your signal should appear in the DPX display.
3. Set the reference level so that the peak of your signal is about 10 dB below the top of the DPX display.
4. Set the modulation parameters for your signal. This includes the Modulation Type, Symbol Rate, Measurement Filter, Reference Filter

and Filter Parameter. All of these settings are accessed by pressing the Settings button.

For most modulated signals, the Modulation Analysis application preset should present a stable display of modulation quality. Additional
displays can be added by using the Displays button, and other settings can be modified to better align with your signal requirements.

Phase Noise
The Phase Noise application preset opens the Phase Noise display.

Pulse Analysis
The Pulse Analysis application preset opens the following displays:

• DPX: The DPX display is opened with the maximum available span.
• Time Overview: Shows amplitude vs. time over the analysis period.
• Pulse Trace: Shows the trace of the selected pulse and a readout of the selected measurement from the pulse table.
• Pulse Measurement Table: This shows a full report for the user-selected pulse measurements.
• Pulse Cumulative Histogram: Shows a histogram that support statistics over multiple acquisitions. It shows basic pulse measurements

and has user definable bins for the cumulated pulses. It provides detailed information about the bins and its content.
• Pulse Cumulative Statistics Table: Shows a statistics table that provides information on Standard Deviation, Average, Max, and Min

over different acquisitions.
• Pulse-Ogram: Shows a correlated Amplitude Time vs Time and frequency vs time display, where Y is pulse parameter, X is pulse

duration, and Z is number of pulses. It shows you a definable number of stacked pulses in amplitude versus time (reference being
the trigger time), as well as in amplitude versus frequency. This display will also show the information as an ‘ogram, where the pulse
number is being scanned over time.

You can make a selected pulse and measurement appear in the Pulse Trace display by highlighting it in the Pulse Measurement Table.
Key pulse-related parameters that are set by the Pulse Analysis application preset are:

• Measurement Filter: No Filter.
• Measurement Bandwidth: This is set to the maximum real-time bandwidth of the instrument (25 MHz in a base instrument, 40 MHz in

instruments with Option B40, 85 MHz in instruments with Option B85, or 165 MHz in instruments with Option B16x). Note: The label on
the “Measurement Bandwidth” setting is just “Bandwidth”. Like the main instrument Preset command and the other application presets,
the Pulse Analysis application preset also sets most other instrument controls to default values.
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• Analysis Period: This is set to 2 ms to ensure a good probability of catching several pulses for typical signals.

To use the Pulse Analysis preset (assuming the Preset action is set to Show list in the Presets tab of the Options control panel):

1. Select Presets > Application. Select Pulse Analysis and then click OK.
2. Set the Center Frequency control to the carrier frequency of your pulsed signal.
3. Set the Reference Level to place the peak of the pulse signal approximately 0-10 dB down from the top of the Time Overview display.

You may need to trigger on the signal to get a more stable display. This is set up in the Trigger control panel. (“Trig” button). Using the
Power trigger type with the RF Input source works well for many pulsed signals.

4. Set the Analysis Period to cover the number of pulses in your signal that you want to analyze. To do this, click in the data entry field of
the Time Overview window and set the analysis length as needed.

Spectrum Analysis
The Spectrum Analysis application preset opens a Spectrum display and sets several parameters. The Spectrum Analysis preset sets the
analyzer as follows.

• Spectrum Analysis : Sets the frequency range to maximum for the analyzer, and sets the RF/IF optimization to Minimize Sweep
Time.

To use the Spectrum Analysis preset (assuming the Preset action is set to Show list in the Presets tab of the Options control panel):

1. Select Presets > Application. Select Spectrum Analysis and then click OK.
2. Set the measurement frequency using the front-panel knob or keypad.
3. Adjust the span to show the necessary detail.

Time-Frequency Analysis
The Time-Frequency Analysis application preset opens the following displays:

• Time Overview: Shows a time-domain view of the analysis time ‘window’.
• Spectrogram: Shows a three-dimensional view of the signal where the X-axis represents frequency, the Y-axis represents time, and

color represents amplitude.
• Frequency vs. Time: This display's graph plots changes in frequency over time and allows you to make marker measurements of

settling times, frequency hops, and other frequency transients.
• Spectrum: Shows a spectrum view of the signal. The only trace showing in the Spectrum graph after selecting the Time-Frequency

Analysis preset is the Spectrogram trace. This is the trace from the Spectrogram display that is selected by the active marker. Stop
acquisitions with the Run button because its easier to work with stable results. In the Spectrogram display, move a marker up or down
to see the spectrum trace at various points in time.

The analysis period is set to 5 ms.

To use the Time-Frequency Analysis preset (assuming that Time-Frequency Analysis is the selected preset on the list of Application
Presets and Preset action is set to Recall selected preset):

1. Select Presets > Application. Select Time-Frequency Analysis and then click OK.
2. When the preset's displays and settings have all been recalled and acquisitions are running, adjust the center frequency and span to

capture the signal of interest.
3. Set the Reference Level to place the peak of the signal approximately 0-10 dB down from the top of the Spectrum graph.
4. If the signal is transient in nature, you might need to set a trigger to capture it. For more information on triggering in the time and

frequency domain, see Triggering.

When the signal has been captured, the spectrogram shows an overview of frequency and amplitude changes over time. To see frequency
transients in greater detail, use the Frequency vs. Time display.

The Time-Frequency Analysis preset sets the analysis period to 5 ms. The Spectrum Span is 40 MHz. The RBW automatically selected for
this Span is 300 kHz. For a 300 kHz RBW, the amount of data needed for a single spectrum transform is 7.46 μs. A 5 ms Analysis Length
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yields 671 individual spectrum transforms, each one forming one trace for the Spectrogram to display as horizontal colored lines. This
preset scales the Spectrogram time axis (vertical axis) to -2, which means that the Spectrogram has done two levels of time compression,
resulting in one visible line for each four transforms. This results in 167 lines in the Spectrogram for each acquisition, each covering 29.84
μs.

Noise Figure
The Noise Figure and Gain Measurements application preset opens the following displays:

• Gain: This display shows gain versus frequency of the signal. The gain measurement is the ratio of output power to input power in an
amplifier or circuit element.

• Noise Figure: This display shows the noise factor in dB. This measurement can help you assess the low level sensitivity of the DUT.
Lower noise figure is found in better performing DUTs. Noise factor is defined as the ratio of the input signal to noise ratio to the output
signal to noise ratio (Input SNR/Output SNR).

• Noise Table: This table lists selected measurements in a spreadsheet format, showing the numeric value at step frequencies for Gain,
Noise Figure, Y Factor, Noise Temperature, PHot, and PCold.

You can read more about Noise Figure and Gain measurements here.

Setting options
Menu Bar: Tools > Options

There are several settings you can change that are not related to measurement functions. The Option settings control panel is used to
change these settings. 

Settings tab Description

Presets Use this tab to configure Presets. You can specify the action to take when a preset is recalled and
which preset to recall when the Preset button is selected.

Analysis Time Use this tab to specify the method used to automatically set the analysis and spectrum offsets when
the Time Zero Reference is set to Trigger.

Save and Export Use this tab to specify whether or not save files are named automatically and what information is
saved in acquisition data files.

GPIB Use this tab to set the primary GPIB address for the instrument.

Security Selecting the Hide Sensitive readouts check box causes the instrument to replace measurement
readouts with a string of asterisks.

Prefs Use this tab to select different color schemes for the measurement graphs and specify how markers
to automatically jump to the next peak when you drag them. When this setting is deselected, you can
drag a marker to any point on the trace.
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Presets
The Presets tab in the Options control panel allows you to specify actions taken when you press the Preset button. You can read more
about this tab here.

Analysis Time
The Analysis Time tab in the Options control panel is used to specify the method used to automatically set the analysis and spectrum
offsets when the Time Zero Reference is set to Trigger. The available settings are:

• Include trigger point – Selects an algorithm that uses the measurements to determine how far in advance of the trigger to set the
analysis offset. The analyzer tries to ensure that data about the trigger point is included in the analyses.

• Start at trigger point (legacy) – The method used by the instrument in prior versions, which sets the Analysis Offset to zero when
possible. The analyzer tries to ensure that data following the trigger point is included in the analyses. Use this method if your
measurements or procedures depend on past behavior of the Auto Analysis Offset function.

Save and Export
The Save and Export tab allows you to specify whether or not files are saved with an automatically generated name, and how much data is
saved in an acquisition data file.

All files. The Automatically increment filename/number function can automatically name saved files by appending a number to a base file
name. Use this tab to enable/disable automatic naming of files. For example, if Automatically Increment Filename Number is disabled,
when you select Save from the File menu, you will have to enter a name for the file.

Acquisition data files. This setting specifies whether saved data files include the entire acquisition record or only the data for the analysis
length (a subset of the acquisition record). You can choose from the following:

• IQ records: Includes IQ records
• DPX spectra: Includes DPX spectra
• Both: Includes both IQ records and DPX spectra

You can also select to include an entire IQ record or just the analysis length of it.

TIQ acquisition data files. Specifies which data records to save. You can choose from the following:

• Current acquisition: Saves the current acquisition.
• Current frame: If Fast Frame is enabled, saves only the current frame. The current frame is the one most recently analyzed.
• Selected frames: If Fast Frame is enabled, saves the specified frames.
• All in history: Saves all acquisition records in the history.
• Save TIQ file now: Invokes the Save As dialog box with the Save as type drop-down list set to TIQ.

Security
The Security tab enables you to hide sensitive readouts in displays with readouts, such as the OFDM Summary display.

Prefs
The Prefs tab enables you to set properties that apply to all displays.
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Color scheme. The Color scheme setting provides three color schemes for the measurement graphs. The color scheme setting does not
change the overall instrument application or Windows color scheme.

• Thunderstorm – This scheme displays graphs in shades of blue. This provides a less vibrant color scheme than the default setting.

• Blizzard – This scheme displays graphs with a white background to save ink when printing.

• Classic – The default setting. This scheme displays the graph area with a black background.

Markers snap to peaks when dragged. When selected, this setting causes makers to automatically jump to the next peak when you drag
them. When this setting is deselected, you can drag a marker to any point on the trace.
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Using the measurement displays
Selecting displays
Menu Bar: Setup > Displays

Favorites toolbar:

Use the Select Displays dialog to choose the displays that appear on the screen. 

To select displays:

1. Press the Displays button or select Setup > Displays.
2. Select one of the choices under Measurements. The measurement chosen determines the choices available in Available displays.
3. Double-click the desired display in the Available displays box or select the desired display and click Add.
4. Click OK.
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Interactions Between Displays
Different displays can require different settings, for example acquisition bandwidth, analysis length, or resolution bandwidth, to achieve
optimum results. The application automatically adjusts some settings to optimize them for the selected display. The check mark indicator
in the upper, left-hand corner of the display indicates the display for which the application is optimized. Depending on application settings,
some displays might stop displaying results if they are not the selected display.
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Taking measurements
Available measurements
Available automatic measurements include RF power measurements, OFDM analysis, WLAN analysis, APCO P25 analysis,
Bluetooth analysis, LTE analysis, 5GNR analysis, EMC Analysis, audio analysis, analog modulation measurements, digital modulation
measurements, noise figure and gain measurements, and pulsed RF measurements.

See the specific measurement topic in this document for information about how to take a measurement.

Power measurements

Measurement Description

Channel Power The total RF power in the selected channel (located in the Chan Pwr and ACPR display).

Adjacent Channel Power Ratio (ACPR) Measure of the signal power leaking from the main channel into adjacent channels.

Multi-Carrier Power Ratio (MCPR) The ratio of the signal power in the reference channel or group of channels to the power in
adjacent channels.

Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted
signal (located in the CCDF display).

CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much
time a signal spends at or above a given power level relative to the average power of a
measured signal.

OFDM analysis
Measurement Description
Channel Response Plots the channel response (magnitude or phase) versus the subcarrier or frequency.

Here, the channel refers to all sources of signal frequency response impairment up to the
analyzer input, including the transmitter itself, as well as any transmission medium through
which the signal travels between the transmitter and the analyzer.

Constellation Measure of the signal power leaking from the main channel into adjacent channels.
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Flatness Ratio of the peak power in the transmitted signal to the average power in the transmitted
signal

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Table continued…
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Measurement Description
Power Shows the data symbols' individual subcarrier Power values versus symbol interval (time)

and subcarrier (frequency).

WLAN measurements
Measurement Description
Channel Response Plots the channel response (magnitude or phase) versus the subcarrier or frequency.

Here, the channel refers to all sources of signal frequency response impairment up to the
analyzer input, including the transmitter itself, as well as any transmission medium through
which the signal travels between the transmitter and the analyzer.

Constellation Measure of the signal power leaking from the main channel into adjacent channels.
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Flatness Ratio of the peak power in the transmitted signal to the average power in the transmitted
signal

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Power vs Time The signal power amplitude versus time. For 802.11b signals, the packet Power-On and
Power-Down ramp times are also measured.

Summary Shows several measurements of WLAN signal quality.
Symbol Table Shows decoded data values for each data symbol in the analyzed signal packet. For

OFDM (non-802.11b) signals, results are presented with subcarrier (frequency) indices
in the horizontal dimension and symbol (time) intervals in the vertical dimension. For
802.11b signals, the Preamble, Header, and Data (PSDU) symbol values are presented
sequentially, with symbol indices in the left column.

Audio measurements
Measurement Description
Audio Spectrum Shows audio modulation characteristics. You can choose to show just the spectrum of

the audio signal or show the audio spectrum of the signal and the results of distortion
measurements. The Audio Spectrum display can show a table listing the frequency of a
Harmonic Distortion (HD) and Non-Harmonic Distortion (NHD) and its level. The Spectrum
graph indicates these harmonics and non-harmonics with special markers.

Digital Modulation measurements

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK
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Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the
magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference
between I and Q channels away from the ideal 90 degrees expected from the perfect I/Q
modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

Measurements for OQPSK and SOQPSK modulation types

Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q
samples. For EVM, I and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the I and Q
symbol decision points are time-aligned before collecting the I and Q samples. In this case,
one I and one Q sample is collected for each symbol (half as many samples as the same
number of symbols for (non-offset) EVM.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

Table continued…
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Measurement Description
IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the

magnitude of the carrier feed-through signal.
Frequency Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the instrument.
Gain Imbalance The gain difference between the I and Q channels in the signal generation path.

Constellations with gain imbalance show a pattern with a width that is different form height.
Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference

between I and Q channels away from the ideal 90 degrees expected from the perfect I/Q
modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

Measurements for nFSK modulation types

Measurement Description
Peak FSK err Peak value of the frequency deviation error at the symbol point.
RMS FSK Err RMS value of the frequency deviation error at the symbol point.
Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal

magnitude.
RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal

magnitude.
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the instrument.
Freq Deviation Frequency distance from the center frequency at the symbol point.
Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of the

analyzed signal.
Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and

the instrument calculates the error between the user entered value and the instrument
calculated value.

Measurements for C4FM modulation type

Measurement Description
RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.
Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.
Deviation Frequency distance from the center frequency at the symbol point.
Length Number of symbols in the analysis area.

Analog Modulation measurements
Measurements for AM modulation
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Measurement Description
+AM Positive peak AM value.
-AM Negative peak AM value.
Total AM Total AM value, which is equal to the peak-peak AM value divided by 2.

Measurements for FM modulation

Measurement Description
+Pk Positive peak frequency deviation.
–Pk Negative peak frequency deviation.
RMS RMS value of the frequency deviation.
Pk-Pk/2 Peak-to-peak frequency deviation divided by 2.
Pk-Pk Peak-to-peak frequency deviation.

Measurements for PM modulation

Measurement Description
+Pk Positive peak phase deviation.
–Pk Negative peak phase deviation.
RMS RMS value of the phase deviation.
Pk-Pk Peak-to-peak phase deviation.

Noise Figure and Gain measurements
Measurement Description
Noise Temperature This measures thermal noise in the system.
Y Factor This measurement method relies on a measurement of Noise Powers. These

measurements during the calibration portion of the Y Factor technique are close to the
noise floor limit; therefore, a low noise, low level measuring receiver or a spectrum analyzer
with a low noise sensitive preamplifier is required.

Gain The measures the ratio of output power to input power in an amplifier or circuit element.
Noise Figure This measures how much noise is added by an amplifier of other system component. Noise

Figure is Noise Factor expressed in dB. Noise factor is defined as the ratio of the input
signal to noise ration to the output signal to noise ratio (Input SNR/Output SNR) for a
reference load at an equivalent source noise temperature of 290K.

Uncertainty Shows the uncertainty in noise and gain measurements and also provides values showing
the contribution of various elements to the overall uncertainty.

APCO P25 measurements

Measurement Description
RF output power Measure of RF output power when the transmitter is connected to

the standard load during defined duty cycle.
Table continued…
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Measurement Description
Operating frequency accuracy Measure of the ability of the transmitter to operate on its assigned

frequency.
Unwanted emissions (ACPR) Ratio of the total power of a transmitter under prescribed conditions

and modulation to that of the output power that falls within
a prescribed bandwidth centered on the nominal frequency of
adjacent channels.

Frequency deviation Measurement of the amount of frequency deviation that results for a
Low Deviation and High Deviation test pattern.

Modulation fidelity Measures the degree of closeness to which the modulation follows
the ideal theoretical modulation determined by the rms difference
between the actual deviation and the expected deviation for the
transmitted symbols.

Symbol rate accuracy Measures the ability of the transmitter to operate at the assigned
symbol rate (4.8 kHz for Phase 1, 6 kHz for Phase 2).

Transmitter power and encoder attack time Measures the time required for a transmitter to prepare and transmit
information on the radio channel after changing state from standby
to transmit (applies to conventional mode).

Transmitter power and encoder attack time with busy/idle
operations

Measures the time required for a transmitter to prepare and
transmit information on the radio channel after the receiving channel
changes state from busy to idle.

Transmitter throughput delay Measures the time it requires for audio changes in the microphone
to be encoded and transmitted over the air.

Transient frequency behavior Measures the difference of the actual transmitter frequency and
assigned transmitter frequency as a function of time when the RF
output power is switched on or off.

HCPM transmitter logical channel time alignment Measures the ratio of total transmitter power under prescribed
conditions and modulation to the peak power that falls in a
prescribed bandwidth centered on the nominal frequency of the
adjacent channel during the transmitter power ramping interval.

Bluetooth measurements
Measurement Description
Modulation characteristics Verifies that the modulation characteristics of the transmitted signal are correct. This

measurement can only be done if the payload has the bit pattern 10101010 or 11110000.
Carrier frequency offset and drift Verifies that the carrier frequency offset and carrier drift of the transmitted signal is within

the specified limits for the Basic Rate and Low Energy standards. This test can be done
only if the payload contains 10101010 bit pattern.

Output power Verifies the maximum peak and average power emitted from the EUT. The standard
recommends this test be done for a PRBS payload pattern.

Table continued…

Taking measurements

RSA5100B Series Real-Time Signal Analyzers Help 56



Measurement Description
In-band emission / ACPR Verifies that the in-band spectral emission is within limits. The standard document

recommends that this measurement be done with Hopping off, finding the integrated
power in 1 MHz band (with RBW 100 kHz) in 80 channels starting from 2401 MHz to
2481 MHz. The integrated power values calculated in the adjacent channels are compared
against recommended limits (except the three channels around transmitted frequency).
This measurement is referred to as ACPR in the Basic Rate standards document.

20 dB bandwidth Verifies if the emissions inside the operating frequency range are within limits. This
measurement is done with Hopping off. The difference between frequency points at which
the power level drops to 20 dB below the peak power of the emission is found as 20 dB
bandwidth.

Frequency range These measurements verify if the emissions inside the operating frequency range are
within the limits.

Power density This measurement verifies the maximum RF output power density.
Out-of-band spurious emission This measurement can be done for FCC or ETSI masks using the Spurious display.
Relative power Verifies the relative power in the GFSK and PSK part of the Enhanced Data Rate signal.

This measurement is supported only when an Enhanced Data Rate signal is detected.

LTE measurements
Measurement Description
Cell ID detection The Cell ID is detected from the input LTE signal.

For TDD and FDD.

Adjacent Channel Leakage Ratio (ACLR) The Adjacent Channel integrated power is calculated and shown. The relative power
compared to the reference signal is also computed. The computed power is compared
against limits suggested by the selected standard and pass/fail is reported.

For TDD and FDD.

Channel Power The channel power is calculated in the channel bandwidth.

For TDD and FDD.

Occupied Bandwidth The Occupied bandwidth is calculated as bandwidth containing 99% of the total integrated
power in the selected span around the selected center frequency.

For TDD and FDD.

Operating Band Unwanted Emission The power in the offset regions is calculated and presented and compared against limits
set in the offset and limits table and pass/fail is reported.

For TDD and FDD.

TOFF The power in off-slot region is computed and compared against selected limits.

For TDD only.
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5GNR Measurements
Measurement Description
Modulation Accuracy (ModACC) It measures the deviation of the received symbol relative to the ideal transmitted symbol.

The IQ data is processed to identify the OFDM Symbol boundaries and FFT is performed
using the various settings under the Modulation Accuracy tab. The subcarrier data is
equalized and then data and DMRS are extracted to perform various EVM measurements
as per the 3GPP Spec and then used for display in Constellation Display. The Estimation
tab provides advanced settings related to IQ Impairments and Frequency Offset estimation
and corrections.

Channel Power (CHP) The measurement is used to verify the maximum carrier output power across the frequency
range. It includes the measurement of individual carrier power under carrier aggregation
mode. The Integrated Bandwidth type can be chosen between Channel and Signal
Bandwidth to include or remove the Guard Bands between carriers respectively.

Adjacent Channel Power (ACP) It measures the power leakage from the carrier channels into the neighboring frequency
channels, commonly referred to as offset channels. The RBW, sweep time, and Spectral
Window can be selected from the measurement options tab. By default, 2 offset channels
are enabled for measurement.

Spectral Emission Mask (SEM) It measures the spurious emissions of a transmitter in the immediate frequency bands and
compares against the limit chosen in the settings. The RBW settings and the width of the
bands can be selected from the measurement options tab. Predefined band settings as per
3GPP are also provided in the options.

Occupied Bandwidth (OBW) The OBW is the bandwidth containing 99% of the total integrated power of the transmitted
spectrum, centered on the assigned channel frequency.

Error Vector Magnitude (EVM) The EVM vs Symbol or EVM vs Time will give the EVM of OFDM symbols present in the
number of symbols considered or the time within a slot.

Power vs Time (PVT) The PVT measurement measures the time domain power dynamics of the NR signal.

Pulse measurements

Measurement Description

Average ON Power The average power transmitted during pulse on.

Peak Power Maximum power during pulse on.

Average Transmitted Power The average power transmitted, including both the time the pulse is on and the time it is off,
and all transition times.

Pulse Width The time from the rising edge to the falling edge at the –3 dB / –6 dB level (50%) of the
user selected 100% level. Level is user selectable for Volts or Watts.

Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user
selected 100% level.

Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user selected
100% level.

Table continued…
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Measurement Description

Repetition Interval The time from a pulse rising edge to the next pulse rising edge.

Repetition Rate The inverse of repetition interval.

Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.

Duty Factor (Ratio) The ratio of the pulse width to the pulse period.

Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot,
overshoot, or undershoot. By default, the first 25% and the last 25% of the pulse top is
excluded from this measurement to eliminate distortions caused by these portions of the
pulse. 

If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements
for the analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple
results will be in %Watts. The default for the general Units control is dBm, so the Ripple
results default is %Watts.

See also Ripple.

Ripple dB The Ripple measurement expressed in dB.

Droop Droop is the power difference between the beginning and the end of the pulse On time. A
straight-line best fit is used to represent the top of the pulse. The result is a percentage
referenced to the Average ON Power.

Droop dB The Droop measurement expressed in dB.

Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units are
%Watts or %Volts.

Overshoot dB The Overshoot measurement expressed in dB.

Pulse-Ref Phase Difference The difference between the frequency of the current pulse and frequency of the previous
pulse. The i nstantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse

Pulse-Ref Freq Difference The difference between the frequency of the current pulse and frequency of the previous
pulse. The i nstantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

RMS Freq Error The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time
trace, computed over the Measurement Time.

Max Freq Error The maximum frequency error is the difference between the measured carrier frequency of
the signal and the user-selected center frequency of the analyzer.

RMS Phase Error The RMS Phase Error measurement is the RMS average of the Phase vs Time trace,
computed over the Measurement Time.

Table continued…
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Measurement Description

Max Phase Error The phase is measured at each point during the pulse's ON time. The phase error for each
point is the difference between the measured phase value and the calculated ideal phase
value. After the phase error is calculated for all points in the acquisition record, the largest
error in the positive direction and the largest in the negative direction are determined.
Whichever of these two values has the greater absolute value is designated the Max Phase
Error.

Freq Deviation The Frequency Deviation measurement is the difference between the maximum and
minimum measured values of the signal frequency during the Measurement Time.

Phase Deviation The Phase Deviation is the difference between the maximum and minimum Phase values
measured during the ON time of a pulse.

Impulse Response Amplitude The difference in dB between the levels of the main lobe and highest side lobe.

Impulse Response Time The difference in time between the main lobe and highest side lobe.

Absolute Frequency The absolute pulse frequency measured at a point specified by the user. The measurement
includes carrier frequency as well. The measurement point should be within the pulse
width, starting from the 50% point.

Pulse-Pulse Frequency Difference The difference between the frequency of the current pulse and frequency of the previous
pulse. The instantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

Pulse-Pulse Phase Difference The phase difference between the selected pulse and the first pulse in the analysis window.
The instantaneous phase is measured at a user-adjustable time following the rising edge of
each pulse.
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General signal viewing
Overview
The displays in General Signal Viewing (Displays > Measurements > General Signal Viewing) are:

• Amplitude vs Time
• DPX Spectrum
• Frequency vs Time
• Phase vs Time
• RF I & Q vs Time
• Spectrogram
• Spectrum
• Time Overview

These displays provide extensive time-correlated multi-domain views that connect problems in time, frequency, phase and amplitude for
enabling you to more quickly understand cause and effect when troubleshooting.

DPX

DPX primer
With the DPX display (which displays only DPX waveforms saved by RSA5000/RSA6000/SPECMON Series Real-Time Spectrum
Analyzers), you can detect and accurately measure transients as brief as 2.7 µs. The instrument computes up to 390,625 spectrums
per second of the digitized input signal. Then it displays all these spectrums as a color-graded bitmap that reveals low-amplitude signals
beneath stronger signals sharing the same frequency at different times.

The strong signal in the DPX spectrum graph, shown in Figure 1 on page 61, is a repeating pulse at a fixed frequency. There is also
a lower-power CW signal that steps very quickly through the same span. During the pulse's on time, the power of the two signals is
additive, resulting in nearly undetectable differences in the pulse envelope shape. But during the time the pulse is off, the sweeping signal
is detected and shown in its true form. Both signals are visible in the bitmap because at least one full cycle of their activities occurs within a
single DPX display update.

Figure 1: DPX spectrum graph

Compare the display of a Figure 2 on page 62 and that of a real-time signal analyzer with a Figure 3 on page 62. The signal captured
is a typical WLAN interchange between a nearby PC and a more-distant network access point (AP). The laptop signal is nearly 30 dB
stronger than the AP's signal because it is closer to the measuring antenna.
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Figure 2: Traditional swept spectrum analyzer

Figure 3: DPX display

The Figure 2 on page 62 uses line traces that can show only one level for each frequency point, representing the largest, the smallest or
the average power. After many sweeps, the Max Hold trace shows a rough envelope of the stronger laptop signal. +Peak detection was
selected for the other trace in an attempt to capture the weaker but more frequent AP signal, but the bursts are very brief, so the likelihood
of seeing one in any particular sweep is small. It will also take a long time to statistically capture the entire spectrum of a bursted signal due
to the architecture of the swept spectrum analysis.

The Figure 3 on page 62, reveals much more insight on the same signal. Since it is a bitmap image instead of a line trace, you can
distinguish many different signals occurring within each update period and/or different version of the same signal varying over time. The
heavy band running straight across the lower third of the graph is the noise background when neither the laptop nor the AP is transmitting.
The red lump of energy in the middle is the ON shape of the AP signal. Finally, the more delicate spectrum above the others is the laptop
transmissions. In the color scheme used for this demonstration (“Temperature”), the hot red color indicates a signal that is much more
frequent than signals shown in cooler colors. The laptop signal, in yellow, green and blue, has higher amplitude but doesn't occur nearly as
often as the AP transmissions because the laptop was downloading a file when this screen capture was taken.

How DPX Works
This section explains how DPX displays are created. The input RF signal is conditioned and down-converted as usual for a signal analyzer,
then digitized. The digitized data is sent through an FPGA that computes very fast spectral transforms, and the resulting frequency-domain
waveforms are rasterized to create the bitmaps.

The DPX bitmap that you see on screen is composed of pixels representing x, y, and z values for frequency, amplitude, and Density. A
multi-stage process, shown in Figures 4 - 7, creates this bitmap, starting with analog-to-digital conversion of the input signal.

Simplified Flow of Multi-stage Processing from RF Input Through to Spectrum Processing:
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Figure 4: RF signals are downconverted and sampled into a continuous data stream.

Figure 5: Samples are segmented into data records for FFT processing based on the selected resolution bandwidth.

Figure 6: Data records are processed in the DPX transform engine

Figure 7: Overlapping the FFTs shortens the minimum event duration required for 100% probability of intercept.

Collecting spectral data. Sampling and digitization is continuous. The digitized data stream is chopped into data records whose length is
based on the desired resolution bandwidth (RBW). An additional requirement is placed on FFT length by the desired number of points in a
trace. Table 1 shows this relationship and the FFT length is reported in the display if desired. Then the DPX transform engine performs a
discrete Fourier transform on each record, continually producing spectral waveforms.

Table 1: Minimum FFT length versus trace length – independent of span and RBW

Trace length (points) Minimum FFT length
801 1,024
2,401 4,096
4,001 8,192
10,401 16,384

As long as spectral transforms are performed faster than the acquisition data records arrive, the transforms can overlap each other in
time, so no events are missed in between. Minimum event length for guaranteed capture depends on the length of the data records being
transformed. An event must last through two consecutive data records in order for its amplitude to be accurately measured. Shorter events
are detected and visible on screen, but may be attenuated. The DPX Spectrum RBW setting determines the data record length; narrow
RBW filters have a longer time constant than wide RBW filters. This longer time constant requires longer FFTs, reducing the transform rate.
Additional detail on minimum signal duration is provided in Guaranteed Capture of Fast Events.

The spectral waveforms are plotted onto a grid of counting cells called the “bitmap database”. The number held by each database cell
is the z-axis count. For simplicity, the small example grid used here in the following grids is 11x10, so our spectral waveforms will each
contain 11 points. A waveform contains one (y) amplitude value for each (x) frequency. As waveforms are plotted to the grid, the cells
increment their values each time they receive a waveform point.
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Figure 8: Example 3-D Bitmap Database after 1 (left) and 9 (right) updates. Note that each column contains the same total number of “hits”.

The grid on the left shows what the database cells might contain after a single spectrum is plotted into it. Blank cells contain the value zero,
meaning that no points from a spectrum have fallen into them yet.

The grid on the right shows values that our simplified database might contain after an additional eight spectral transforms have been
performed and their results stored in the cells. One of the nine spectrums happened to be computed as a time during which the signal was
absent, as you can see by the string of “1” occurrence counts at the noise floor.

The maximum rate for performing the variable-length frequency transforms that produce those waveforms can be greater than 390,625 per
second. Measurement settings that slow this transform rate include narrowing the RBW and increasing the number of points for the line
traces available in the DPX display along with the bitmap. Even at their slowest, spectral transforms are performed orders of magnitude
faster than a physical display can respond, and also too fast for humans to see, so there's no need to update the screen or measurements
at this rate. Instead, the grid collects thousands of waveforms into “frames”, each covering about 50 milliseconds (ms). A 50 ms frame
contains the counts from up to 14,600 waveforms. After each frame's waveforms have been mapped into the grid, the cell occurrence
counts are converted to colors and written to the DPX bitmap, resulting in a bitmap update rate of around 20 per second.

Frame length sets the time resolution for DPX measurements. If the bitmap shows that a -10 dBm signal at 72.3 MHz was present for 10%
of one frame's duration (5 ms out of 50 ms), it isn't possible to determine just from the DPX display whether the actual signal contained
a single 5 ms pulse, one hundred 50 microsecond (μs) pulses, or something in between. For this information, you need to examine the
spectral details of the signal or use another display with finer time resolution, such as Frequency vs. Time or Amplitude vs. Time.

Converting occurrence counts to color. About 20 times per second, the grid values are transferred to the next process step, in which
the z-axis values are mapped to pixel colors in the visible bitmap, turning data into information. In this example, warmer colors (red,
orange, yellow) indicate more occurrences. The color palette is user-selectable, but for now we will assume the default “temperature”
palette.

Number of Occurrences Color

0 black

1 blue

2 light blue

3 cyan

4 green blue

5 green

6 yellow

7 orange

Table continued…
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Number of Occurrences Color

8 red orange

9 red

The result of coloring the database cells, according to the number of times they were written into by the nine spectrums, one per pixel on
the screen, creates the DPX displays.

Figure 9: Color-coded low-resolution example (left) and a real DPX display (right).

In addition to the choice of palette, there are z-axis scaling adjustments for Maximum, Minimum, and Curve. Maximum sets the occurrence
value that will be mapped to the highest color in the palette. Minimum sets the occurrence value for the lowest color. In the “temperature”
palette, the highest color is deep red and the lowest is dark blue. Occurrence values less than the selected Minimum are represented with
black pixels, while pixels that exceed the selected Maximum are red in hue but somewhat transparent. Values between Maximum and
Minimum are represented by the other colors of the palette.

Adjusting the Minimum above the black default allows you to concentrate most of your color resolution over a small range of medium or
higher occurrence rates to visually discriminate between different signals that have nearly equal probability values.

To see why adjustable color scaling is useful compare Figure 10 on page 65 and Figure 11 on page 66. On the Scale tab, the Max
control is set to 100% in Figure 10 on page 65. The range of colors now covers the full z-axis range of densities from 0 to 100%. The
signals used to create this bitmap are fairly diffused in both frequency and amplitude, so most pixels have low occurrence counts or density
values and the upper half of the color palette is unused.

Figure 10: DPX spectrum bitmap with default color scale settings.

When the Auto Color button is selected, the Maximum control's value is set to the highest pixel value in the current bitmap, shown in Figure
11 on page 66. Now none of the available colors remain unused. The entire palette is mapped to the occurrence values present at the
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time the button is selected, providing better visual resolution for low densities. Selecting the Autoscale button in the DPX display scales all
three axes based on current results.

Figure 11: The Auto Color function optimizes the color scale settings.

Color Mapping Curves
The mapping between z-axis values and color does not have to be linear. The Curve control lets you choose the shape of the mapping
equation. A Curve setting of 1 selects the straight-line relationship. Higher Curve numbers pull the curve upwards and to the left,
concentrating color resolution on lower densities. Settings less than 1 invert the curve, moving the focus of the color range towards higher
density values. \Figure 12 on page 66 shows the mapping curves.

Figure 12: Representative color mapping curves for the “Temperature” palette.

Using the same signal shown in Figure 10 on page 65 and Figure 11 on page 66, the impact of the Curve control can be observed. With
the Curve control set to 1 in the Scale tab, shown in Figure 13 on page 66, the mapping between color and density is linear, so the colors
spread evenly across the full density range. The color distribution is visible in the colored palette illustration to the left of the Curve control
in the Settings panel.

Figure 13: Over a narrow Signal Density range, the color curve is set to 1.
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When the Curve control is set to 0.5, as shown in Figure 14 on page 67, the best color resolution is in the upper half of the density range,
and only the dark blues are assigned to densities below 50%. Note the difference in the palette illustration.

Figure 14: Adjusting to values less than 1, increases the contrast for viewing events in the top half of the selected density range.

In Figure 15 on page 67, the Curve control is increased to 3. The majority of colors shifts to the lower half of the density scale, but various
shades of orange and red are still available for densities above 50%.

Figure 15: For color curve settings greater than 1, better contrast is provided for events near the low end of the density range.

Swept DPX
DPX Spectrum is not limited in span by its real-time bandwidth. Like the regular Spectrum display, DPX Spectrum steps through multiple
real-time frequency segments, building a wide-span display with line traces and the bitmap. See Figure 16 on page 67.

Figure 16: Off-air ambient signals over a 1 GHz span in the swept DPX display.

The analyzer “dwells” in each frequency segment for one or more DPX frames, each containing the results of up to 14,600 spectral
transforms. Dwell time is adjustable, so you can monitor each segment of the sweep for up to 100 seconds before moving to the next step.
While dwelling in a segment, the probability of intercept for signals within that frequency band is the same as in normal, real-time spans:
100% capture of events as short as 10.3 μsec.

A full pixel bitmap is created for every segment and compressed horizontally to the number of columns needed for displaying the frequency
segment. Compression is done by averaging pixel densities of the points being combined together. The final swept bitmap contains a
representation of the same pixel bitmap resolution, just like the non-swept bitmaps. Line traces are also created in full for each segment,
and then horizontally compressed to the user-selected number of trace points for the full span.

A complex algorithm for determining the number and width of each frequency segment has been implemented. The variables in the
equation include user-adjustable control settings like Span, RBW, and number of trace points, RF and IF optimization, and Acquisition BW.

General signal viewing

RSA5100B Series Real-Time Signal Analyzers Help 67



Installed hardware options also can affect the span segmentation. The number of segments ranges from 10 to 50 for each 1 GHz in a
sweep.

A helpful piece of information for operators is the actual Acquisition Bandwidth used for capturing each segment. “Acq BW” is shown in
the Acquire control panel on the Sampling Parameters tab. Acq BW is typically set automatically by the instrument, based on the needs
of all the open displays, but can also be set manually. In either case, the displayed bandwidth is used for every frequency segment in
the swept DPX display, though in practice, the displayed portion of the segment is somewhat narrower than the actual Acquisition BW, for
performance reasons.

The entire instrument frequency range of many GHz can be covered in a DPX sweep. The Dwell Time control sets the amount of time DPX
spends in each segment. This control, circled in Figure 17 on page 68, can be set between 50 ms and 100 seconds.

Figure 17: During swept DPX operation, the Dwell time control adjusts the observation time of each frequency segment used to construct the composite DPX display.

Guaranteed Capture of Fast Events
The main reason that swept-tuned and step-tuned spectrum analyzers can't provide 100% Probability of Intercept, POI, for a signal that
isn't continuously present is that they spend only a short period of time tuned to each segment of their frequency span during each sweep.
If something happens in any part of the span other than where it is tuned at that instant, that event will not be detected or displayed. There
is also a period of time between sweeps, retrace time, during which the analyzer is not paying attention to the input signal. FFT-based
analyzers, including vector signal analyzers, also miss signals during the time between acquisitions. Their POI depends on a combination
of factors including span, number of FFT points, acquisition time, memory read/write time, and signal processing speed. Vector analyzers
process information sequentially, so when read/write from data and processing is occurring, data is not being acquired.

RSAs, on the other hand, capture data across all frequencies within their real-time span during every acquisition. With Tektronix' exclusive
Frequency Mask trigger and DPX Density trigger, POI increases to 100%, insuring capture of any spectral event matching the trigger
definition. When operating in free run as a simple signal analyzer, the RSA has a POI similar to other FFT-based analyzers, with gaps
between each acquisition. Processing is done concurrent with the acquisitions.

Guaranteed Capture in DPX Real-Time Spans
The DPX display captures any signal that is at least 2.7 microseconds long (with Option 09) and within the real-time bandwidth. This
performance is possible because the instrument computes up to 390,625 spectrum transforms per second. The faster the spectrum
updates, the shorter the time between acquisitions and the greater the probability that any signal will be detected.

The following table shows the specified minimum signal duration (MSD) for 100% probability of intercept under various combinations of
Span and RBW in DPX for a representative signal analyzer. As you can see, MSD is affected by multiple factors.
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Table 2: Minimum signal duration for 100% probability of trigger at 100% amplitude

Frequency-Mask and DPX signal processing
Minimum signal duration, 100% probability of intercept, Frequency-Mask
and DPX density trigger (μs)

Span RBW (kHz) FFT length Spectrums/sec Standard Opt. 09

Full amplitude -3 dB Full amplitude -3 dB

165 MHz 20000 1024 390,625 15.5 15.4 2.7 2.6

10000 1024 390,625 15.6 15.4 2.8 2.6

1000 1024 390,625 17.8 15.7 5.0 2.9

300 2048 195,313 23.4 16.3 13.1 6.1

100 8192 48,828 44.5 23.4 44.5 23.4

30 32768 12,207 161.9 91.7 161.9 91.7

85 MHz 10000 1024 390,625 15.6 15.4 2.8 2.6

1000 1024 390,625 17.8 15.7 5.0 2.9

500 1024 390,625 20.2 15.9 7.4 3.1

300 1024 390,625 23.4 16.3 10.6 3.5

100 4096 97,656 44.5 23.4 34.2 13.2

30 16384 24,414 121.0 50.7 121.0 50.7

20 16384 24,414 161.0 55.6 161.0 55.6

40 MHz 5000 1024 390,625 15.8 15.4 3.0 2.6

1000 1024 390,625 17.8 15.7 5.0 2.9

300 1024 390,625 23.3 16.3 10.5 3.5

100 2048 195,313 39.4 18.3 29.1 8.1

30 4096 97,656 90.4 21.8 90.4 21.8

20 8192 48,828 140.7 36.3 140.7 36.3

10 16384 24,414 281.3 72.6 281.3 72.6

Table continued…
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Frequency-Mask and DPX signal processing
Minimum signal duration, 100% probability of intercept, Frequency-Mask
and DPX density trigger (μs)

Span RBW (kHz) FFT length Spectrums/sec Standard Opt. 09

Full amplitude -3 dB Full amplitude -3 dB

25 MHz 3800 1024 390,625 16.0 15.4 3.2 2.6

1000 1024 390,625 17.7 15.7 4.9 2.9

300 1024 390,625 23.4 16.3 10.6 3.5

200 1024 390,625 27.4 16.8 14.6 4.1

To demonstrate the POI in action, a challenging bi-stable signal is used. A CW sinusoid sits at 2.4453 GHz most of the time, but every
1.28 seconds, its frequency changes for about 100 μs before returning to normal. The duty factor of this transient is less than 0.01%.

Figure 18 on page 70 shows a swept analyzer set up for a 5-second sweep of its MaxHold trace. It shows that there is something
occurring around the signal. This sweep rate was empirically determined to be the optimum rate for reliable capture of this signal in the
shortest time. Faster sweep times can reduce the probability of intercept and result in fewer intersections of the sweep with the signal
transient.

Figure 18: Swept spectrum display of the infrequent transient.

The DPX display shown in Figure 19 on page 71 shows the exact same event, also captured over a 5 second period. A lot more
information can be discovered about the transient. It is obvious at first glance that the signal is hopping by about 3 MHz, with 1.2 MHz of
frequency overshoot on transitions
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Figure 19: The DPX spectrum display after 5 seconds. The MaxHold trace is cyan.

Guaranteed Capture in DPX Swept Spans
Probability of intercept (POI) for signals within a single segment, while DPX is dwelling in that segment, is the same as for non-swept DPX
operation. 100% POI for events as brief as 2.7 microseconds long (with Option 09). But just as in traditional swept analyzers, during the
time the acquisition is tuned to any one segment, the analyzer is not monitoring signals in any of the other segments, so probability of
capture in segments other than the current one is zero. Because of the wide real-time bandwidth, the number of segments needed to cover
the span is much less than for swept analyzers, so the overall probability of intercept is significantly better for DPX sweeps.

Another factor affecting POI is number of trace points. The bitmap is always 801 points wide, but the line traces allow user selection
for number of points. 801 is the default and the other choices are 2401, 4001, and 10401. Frequency transforms for traces containing
more than 801 points take longer, and this lower waveform update rate increases the minimum signal duration proportionally. This caution
applies for swept and non-swept operation. The trace length control is on the Prefs tab in the DPX control panel.

DPX Density Measurements
“Density” is a measure of the amount of time during a defined measurement period during which signals are present within a particular
area of the DPX Spectrum bitmap. A clean CW tone gives a 100% reading, while a pulse that is on for one microsecond out of every
millisecond reads 0.1%. This section describes how density is computed from hit counts.

If we plot 41 more waveforms into the example grid we used previously (in addition to the nine we already plotted), each column ends with
a total of 50 hits. The density for any one cell in a column is its own count value divided by 50 , expressed in percent as shown in Figure
21 on page 72. The math is very simple: a cell with 24 counts has a 48% density. In practice, instead of batches of 50 waveforms, we
collect a frame of thousands of waveforms before each update to the density bitmap.

Figure 20: Grid showing cell counts after 50 waveforms. For each column, the sum of z-axis values is 50.
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Figure 21: Grid after converting occurrence counts to percent density values. The sums of the cell density measurements within each column are all 100%.

Measuring Density with Markers
Hit counts are cleared after every frame update, as long as Persistence is not turned on. The density value for any pixel is simply the
percent of time it was occupied during the most recent 50 ms frame. Markers can be used to see the Density value for one or more
individual points on the screen, enabling measurements of the signal density at any interesting point in the DPX display.

In Figure 22 on page 72, Wireless LAN signals are analyzed in the presence of a Bluetooth radio signal in the 2.4 GHz ISM band.

Figure 22: DPX display of WLAN and Bluetooth signals, with a marker on the highest signal.

The “Marker to Peak” function was used to find the peak signal recorded in the display. The marker readout in the upper left corner of
Figure 22 on page 72 shows the Density, Amplitude, and Frequency for the pixel you selected with the marker. By adding additional
markers, you can measure the signal density differences between multiple signals of interest.

Marker Peak Search in the DPX Bitmap
Markers on the DPX bitmap can search for peaks, similar to marker peak searching on spectrum line traces. For a human, it is pretty
easy to discern “signals” in the bitmap picture. Your brain intuitively identifies strings of contiguous bright pixels. This isn't so easy for a
computer. The first thing the RSA must do for any peak search is analyze pixel density values to identify apparent signals. Then it can sift
through these density peaks for the amplitude peaks you want to find.

Z-axis density values for the pixels in each column of the bitmap are internally converted into histograms to find density peaks indicating
the presence of signals. Table 3 on page 73 shows the five middle columns from the example grid we used to illustrate density
measurements in a previous section (Figure 21 on page 72). The density values for each pixel in the middle, highlighted column are plotted
on the y axis in the bar chart in Figure 23 on page 73. The bar chart x axis is bitmap row number, numbering from the top of the table.
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Table 3: Bitmap section showing density values.

0% 0% 0% 0% 0%

0% 0% 8% 0% 0%

0% 0% 12% 0% 0%

0% 0% 26% 0% 0%

0% 0% 36% 0% 0%

0% 2% 6% 2% 0%

4% 8% 0% 8% 0%

86% 82% 4% 76% 12%

10% 8% 6% 14% 86%

0% 0% 2% 0% 2%

Figure 23: Bar chart of the density values in the bolded column of Table 2.

Assume that Density Threshold is set to 5% and Density Excursion to 5% also. Starting with x=1 in the bar chart, test each bar against
the threshold. The threshold criteria is met at x=2. Keep testing until you find a bar that is shorter than the previous bar by at least the
Excursion setting. In this case it is x=6. This tells us that a “signal” covers rows 2 through 5. Its density peak is at row 5.

Now you can look for another peak. Continue looking at bars to the right and you will find a density value at row 9 that meets the threshold
criteria, but since there are no bars to the right of it that meet the excursion criteria, we can't declare row 9 a signal because it fails to meet
the excursion criteria. If row 1 had 1% density, then row 9 would be a density peak.

Once density peaks are found for all columns in the bitmap, we can start looking for the amplitude peaks. When the Peak button is
selected, the analyzer checks the histograms of every column in the bitmap and finds the density peak with the highest amplitude. The
amplitude search has its own versions of Threshold and Excursion settings, but in dBm and dB units. When Next Peak Down command is
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given, the search will scan inside the current column for the next density peak. Next Peak Right examines each column to the right of the
current marker location to locate density peaks that also meet the amplitude peak criteria.

To demonstrate the value of marker peak search in the DPX bitmap, we will use the time-multiplexed signals showing multiple amplitude
levels from an example earlier in this manual. The Peak button and its menu equivalent place the active marker on the peak signal in
Figure 24 on page 74. The peak signal is the density peak of highest amplitude in the bitmap.

Figure 24: The marker was positioned by selecting the Peak button. Density, frequency, and amplitude measurements at the marker are displayed in the upper left corner of
the graph.

The Marker Toolbar, at the bottom of Figure 24 on page 74, allows easy navigation of peak signals (Peak Left, Peak Right, Next Peak Up,
or Next Peak Down). Selecting the arrow keys enables the marker to search for amplitude/density peaks at other frequencies, while the
Next Peak Up and Next Peak Down arrows enable the marker to search for other high-density points at the same frequency.

In the Define Peaks tab of the Define Markers control panel, Figure 25 on page 74, you can adjust the density threshold and excursion
controls to modify search behavior. The amplitude threshold and excursion controls also apply to DPX marker searches. Smoothing keeps
the marker from finding multiple peaks within the same apparent signal by averaging an adjustable number of pixel densities together, but
it does not affect the single-pixel measurement readout displayed by the marker.

Figure 25: Amplitude and Signal Density controls can be adjusted to define Peak search behavior.

Density Measurements over an Adjustable Area (“The Box”)
The density for a single pixel is its ratio of actual hits vs. possible hits over a defined time period, and markers display these density values.
For measuring density over an area larger than one pixel, the DPX display includes a measurement box you can resize and drag around in
the DPX display with your mouse or finger.

If you could make the box so narrow that it contained only points within a single column of pixels, the density of this area would be the sum
of the included pixels' density values. For example, if the box was three pixels tall and the density values for these pixels were 4, 2, and 7%
respectively, the overall density for the three-pixel area would be 13%. Imagine a box one pixel wide and as tall as the graph. Assume that
the input signal's amplitude was such that all hits fell at or near the vertical center of the screen. Since 100% of the waveforms written to
the bitmap passed through the box, the density for the box is 100%.

When you widen the box to cover a broader range of frequencies, software computes the density sum for the included pixels in each
column inside the box. The aggregate density value for this box is the average density, calculated by adding the column density sums then
dividing by the number of columns. For a 100% result, there must not be any hits above the top edge of the box or below its bottom edge.
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In other words, every waveform drawn across the graph entered the box through its left side and exited the box through its right side, with
no excursions out the top or bottom. Figure 25 on page 74 demonstrates this principle on a CW signal. As you can see on the left-hand
side, no amplitudes exist above or below the box; the density of the signal is 100%. On the right hand side, there are signals below the
box, therefore the density is less than 100%.

Figure 26: Density of signals defined within an area. Left: Correct measurement of a CW signal. All columns in the box include the signal. Right: Incorrect measurement area.
The measurement is accurate, but probably not what you expected. Some columns in the box contain no hits, so they contribute zeros to the calculation of average density.

The density measurement box' vertical size and location are always set in dB and dBm, no matter what units you have selected for
measurements. (Amplitude control panel > Units tab.) The box is not draggable when the selected units are linear (such as Amps, Volts,
Watts…), though you can still adjust its size and location using the Frequency and Amplitude controls in both the DPX Settings > Density
and Trigger > Event tabs. Since the vertical scale is non-linear, a box of constant amplitude changes visual height as it changes vertical
position, a disconcerting effect if you are trying to drag it.

Figure 27: DPX Density control panel is used to define the area of interest for DPX density measurements.

A readout will appear somewhere in the graph. If the box is off-screen, the readout will be accompanied by an arrow pointing towards the
invisible box. Grab this readout with your mouse or finger and drag the density readout to the area you want to measure.

To adjust the box size, a mouse is the easiest way to drag the sides and corners of the rectangle. For precise settings, use the knob, arrow
keys, or keyboard to adjust frequency and amplitude values for the rectangle. These controls are located in the right half of the Density tab
in the control panel.

Persistence
Previous sections of this topic have assumed that persistence was not applied to the DPX bitmap. Without persistence, hit counts in the
grid are cleared after each frame update. Now we will describe how persistence modifies this behavior, starting with infinite persistence
because it is simpler than variable persistence.

Hit counts are not cleared between frames if infinite persistence is enabled. When the instrument is set up for continuous acquisitions,
hits keep collecting until you stop acquisitions or click the Clear button above the DPX display. Software keeps track of the total number
of waveforms computed during the entire collection period. Density equals the total number of hits to a cell divided by the total number of
waveforms.

Variable persistence is trickier. A single-occurrence signal shown in the bitmap does not disappear suddenly upon the next frame update,
nor does it linger forever. It fades gradually away. The user sets a time constant for the Dot Persistence control which determines how long
it takes for signals to fade. Fading is accomplished by reducing the hit count in every cell, after each frame update, by a factor based on
the persistence time constant. The longer the time constant, the less the hit counts are reduced.
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Figure 28: Example of fast transient discovery with and without variable persistence turned on. In the display on the left, with variable persistence of 10 seconds, the
occasional sub-second transient that spikes up above the normal signals is held in the display rather than disappearing as soon as the signal goes away. The display on the
right, with persistence turned off, requires watching the display continually to see the brief signal.

Not only are single-occurrence signals allowed to remain in the display for awhile by variable persistence, additional hits keep piling on.
The result is that cell values are no longer pure hit counts; they include counts due to new hits from waveforms plus proportionally reduced
counts from prior frames. As part of translating hit counts into density values, a new software algorithm uses a finite-series equation
to discriminate between the effects of persistence and the arrival of new hits. The inflationary effects of persistence on cell counts are
removed, so density readings represent the true ratio of actual hits to possible hits over the persistence interval.

The density computation for variable persistence is a very good estimate of true signal density, with errors of less than 0.01%. For exact
density measurements, use either no persistence or infinite persistence.

Another subtlety of persistence is its smoothing effect on the density measurement of intermittent signals. Consider a pulse that is on
for 10 ms and off for 90 ms of each 100 ms cycle. We'll make the simplifying assumption that the pulse ON time always falls entirely
within a single DPX frame update (50 ms). If persistence is not applied, the density measurement is computed on each individual frame.
The results will be 20% for each frame containing the ON time and 0% for the other frames. If infinite persistence is enabled, however,
the density measurement will settle to 10% after the second frame, and remain at this value for as long as the pulsing continues. With
persistence, the density is effectively computed over many frames.

Persistence Effects on Density
Persistence does not alter colors in a density-based bitmap. Its effect is to extend the amount of time over which densities are calculated,
leaving signal events visible for the persistence duration.

Before the introduction of density measurements and extra-long hit counters, persistence caused colors to “bloom”, becoming more and
more intense over time as the hit counts increased. Longer persistence intervals caused increased blooming, turning crisp signals into fat
red stripes. When hit counts are converted to density values, the display is not subject to this effect. As long as the input signals maintain
reasonably stable repetition rates and duty ratios, their density values will also remain stable despite ever-increasing hit counts in the
underlying grid cells.

If you are accustomed to the original hit-count-based persistence displays, it may seem counter-intuitive that repeating signals in a
density-based bitmap will not get brighter and redder over time with infinite persistence. A quick review of the density algorithm explains
why: the hit count is divided by the total number of waveforms over the persistence interval. For example, if a signal occupies a pixel 50%
of the time over a period of 15 minutes, the density reading will be 50% throughout the entire 15 minutes, though the underlying hit count is
steadily increasing.

Z-Axis Resolution
Another factor that can cause color bloom is overflow of the hit counters. If a pixel could only count up to 1000 hits, its density and color
values would clip at 100% after just 1000 hits, even if waveform points continue to arrive in the same pixel location. With thousands of
waveform points being written to the bitmap, counts add up really fast for highly-repetitive signals. An example of saturation time for one
our products is given in the following table. All DPX implementations have maximum hit count values to ensure a minimum time to overflow
of greater than 60 minutes.
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Table 4: Comparison of DPX z-axis resolution and its effect on saturation.

Hit Count 36-bit custom float (equivalent to 33-bit integer)

Maximum Hit Count 233

Minimum Time until Overflow (for pixels with 100% density) 8.1 hours

Clipping due to overflow of the counters in one or more cells will not occur until hours have passed, or even days.

One more benefit to having deeper hit counters is better visual resolution of density. RSAs with the highest-performance DPX hardware
installed use floating-point numbers to count hits, allowing us to count billions of waveforms while retaining one-hit resolution, providing
better than 99 dB of dynamic range for density measurements. Density measurements in μ%, n%, and even f% ranges are quite possible
for extremely rare signals captured with infinite persistence.

With straight-line mapping between density and color (Curve setting of 1), resolution is fixed by the number of colors in the palette. For
non-linear mappings (Curve settings higher or lower than 1), most of the colors are concentrated at either the low or high end of the density
scale, so you can visually discriminate finer differences between density values in that range.

Persistence Adjustments
Dot Persistence can be enabled for the “Bitmap” trace using the Settings control panel. The Persistence can be displayed as Infinite or
Variable. For Variable Persistence, you can select the time constant for fading in seconds as shown in Figure 29 on page 77.

Figure 29: The trace settings control panel allows user control of persistence parameters.

Figure 30 on page 77 demonstrates the observed behavior of variable persistence when a CW signal, represented in the first frame, is
turned off. Even if the event was instantaneous and was confined within a single frame, you will observe the color changing to indicate
lower and lower density values, until the signal finally disappears entirely.

Figure 30: With variable persistence, a brief CW signal captured by DPX remains in the display for an adjustable period of time before fading away.

DPX Density Trigger
The standard DPX display shows you a clear picture of transients and other hard-to-find signals and goes well beyond helping you
discover these difficult to find signals by actually triggering on their appearance to capture them into acquisition memory for in-depth
analysis. If you can see it in the DPX bitmap, you can trigger on it.

Other trigger methods can detect signals that exceed an amplitude threshold, or even a sophisticated amplitude-vs-frequency mask, but
they can't find a signal at a particular frequency if another signal of higher amplitude is sometimes present at that same frequency. The
Runt trigger addresses some of these signal-under-signal cases, but not all. As shown in Figure 31 on page 78, the DPX Density trigger
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can discriminate signals within a precise amplitude-frequency range without the operator having to know any characteristics of the target
signal besides where it might show up in the DPX Spectrum graph.

Figure 31: Example of Density Trigger. Left: A free-run DPX display showing pulses with varying frequency. Occasionally, a short pulse in the middle appears for a split
instant, but it is hard to capture it with just a Run/Stop button. Right: The triggered DPX displays shows the low-amplitude pulse that was not apparent in the untriggered
display. The analyzer was set to trigger whenever the average density in the user-drawn box measured 50% or higher.

The DPX Density trigger uses the same screen-based measurement box as the DPX Density measurement. While the target signal is
absent, the density measurement characterizes the “normal” signals within the box. When the target signal finally appears, the density
value increases. The trigger system monitors the density measurement and activates a trigger whenever the density value exceeds
the adjustable density threshold. The only thinking you have to do is to set this threshold to a level somewhere between the normal
density readings and the density due to the trouble-making signal. However, the instrument software can compute the threshold value
automatically.

Trigger On This™
The Trigger On This™ function allows you to point and click to set up the DPX Density trigger. By right-clicking on a spot within the DPX
display, or pressing and holding your finger on the touchscreen display for about a second, a menu selection will appear. Selecting Trigger
On This causes a DPX Density box to appear and automatically adjusts the threshold. The DPX display will now only update whenever the
automatic threshold is exceeded. Subsequently, if needed for your signal, open the Trigger control panel to adjust the density threshold or
the size of the measurement box until the event is reliably captured.

Automatic Threshold Adjustment by Trigger On This™
The trigger density threshold automatically set by Trigger On This is 80% of the measured value. If the signal was present at the moment
you selected Trigger On This, the threshold will be 20% less than the signal density, so the next time the signal is present long enough
(or present enough times) to exceed the threshold density, it will cause a trigger. If the signal happened to be missing when you selected
Trigger On This, the threshold value will be even lower. If you clicked in a part of the display with no signal activity at all, the threshold will
be set to zero. Any signal that shows up here will fire the trigger.
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Figure 32: The analyzer triggered when the density in the DPX measurement box exceeded the threshold set by Trigger On This. You can see in the Spectrogram and
Frequency-vs-Time displays that the signal event which caused the trigger was a quick frequency hop. The Time Overview shows that the signal amplitude never changed,
so a power level trigger would not have worked.

DPX Density Trigger Timing
The time resolution for DPX density measurements is the frame length, around 50 ms. A basic implementation of the DPX Density trigger
concept is also frame-based, so a trigger event that occurs anywhere within a frame will not be recognized until the end of the frame.
Therefore, the worst case trigger uncertainty is 50 ms.

DPX Density trigger doesn't always have to wait until the end of a frame before firing. For the common configuration of triggering when the
measured density is higher than the threshold, the density measurement in the trigger can be computed many times within each frame and
it can fire the trigger as soon as the threshold is exceeded.

Consider the case where the threshold is zero. As soon as a single waveform causes a hit within the measurement box, we know that the
density is greater than zero. It takes a little longer to test for a 5 or 10% density, and even more time for thresholds at or near 100%.

The DPX Density trigger can also be set to fire when the measured density is below the threshold value. This is useful when you suspect
that your signal is missing some of the time. For a signal that is supposed to be CW, you can set the trigger controls to acquire when
the density measurement of the signal peak drops below 100%. When using the “lower than” form of the DPX Density trigger, the time
resolution is one frame because of the following logic: We can't be sure the actual density is less than, say, 15% until at least 85% of the
full test time has elapsed. In order to keep things simple and fast in the trigger module, the RSA just waits until the end of each 50 ms
frame to do the “lower than” comparisons.

Persistence and DPX Density Trigger
The smoothing effect of persistence on density measurements can help in determining a good threshold value. With persistence turned
off, an infrequent signal's density reading jumps between higher and lower values as it turns on and off, and it can be hard to read these
flashing numbers. By turning persistence on, you instruct the instrument to average the density over a longer time period. This density
result is somewhere between the ON and OFF density values - the very definition of a good trigger threshold.

Unlike the DPX Density measurement, the DPX Density trigger is not affected in any way by persistence. Density calculations in the trigger
system are made with hit count data received from each individual DPX frame, before any persistence is applied. Even when the density
measurement reading in the display is averaged over many frames due to persistence, the trigger is computing density for each frame and
comparing these quick snapshots against the threshold setting.
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DPX display overview
The DPX display enables you to see how traces change over time and thus displays signal events that cannot be seen on a swept
spectrum analyzer. A DPX Spectrum indicates how traces change in two ways. First, it uses color shading to show how consistent the
shape of a trace is. Second, it uses persistence to hold signals on the screen so you can see them longer.

DPX display
The DPX display works by using a two-dimensional array to represent points on the display. Each time a trace writes to a point on the
display, a counter in the array is incremented. A color is assigned to each point in the display based on the value of its counter. Thus, as
acquisitions occur over time, a colored waveform, the Bitmap, develops on the display that shows how frequently each display point has
been written to.

An important feature of the DPX display is dot persistence. Dot persistence sets how long a point on the display will be visible. You can set
the Dot Persistence to be Variable or Infinite. In variable persistence mode, you specify a decay period that limits how long a point will be
displayed. In infinite persistence mode, once a point in the display has been written to, it will remain visible indefinitely.

The DPX display can plot the trace in the following views: 

• Spectrum – This view plots power on the vertical axis versus frequency on the horizontal axis. This display is similar to a standard
Spectrum display.

• Zero Span – This view plots power on the vertical axis versus time on the horizontal axis. This display shows how the power level at
the center frequency changes with time.

• Frequency - This view plots frequency on the vertical axis versus time on the horizontal axis. This displays how frequency changes
over time, where the center frequency is displayed at the center of the vertical axis.

• Phase - This view plots phase on the vertical axis versus time on the horizontal axis. This displays how phase changes over time,
where the zero degree phase position is displayed at the center of the vertical axis.

• DPXogram - This view is a spectrogram version (time plotted along the vertical axis versus frequency on the horizontal axis) of the
DPX Spectrum trace. DPX spectrogram creates the spectrogram in real time, and does not require an acquisition to be transferred into
memory and analyzed. Because of this real time processing, there are no gaps in the spectral lines, even for monitoring periods that
can last for several days.

The DPXogram has the following limitations:

• DPXogram cannot sweep a range greater than the maximum real-time bandwidth. When the instrument is sweeping, the
DPXogram display shows the Disabled - data is from swept acquisition message.

• No overlap, however, DPXogram can display multiple Spectrums/line.
• The DPXogram monitors in real time and can be used as a monitor while triggers are occurring. It cannot be set to display only

triggered lines.
• Split - This view consists of two DPX views. A DPXogram view appears on the top half of the display and a DPX Spectrum view

appears on the bottom half of the display.

To display a DPX view:

1. Select Freq and use the front panel knob or number keys to set the measurement frequency.
2. Select the Displays button or Setup > Displays. This displays the Select Displays dialog box.
3. From the Measurements box, select General Signal Viewing.
4. Select DPX from the Available displays box.
5. Click the Add button. This will add the DPX icon to the Selected Displays box (and remove it from the Available displays box).
6. Click the OK button. This displays the DPX Spectrum view.
7. Select the desired view from the drop-down list on the left side of the graph.
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Figure 33: DPX Zero Span view

Figure 34: DPX Split View
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Elements of the DPX display

Item Display element Description

1 Vert Position Sets the top of graph value. This is only a visual control for panning the graph. The
Reference Level is adjusted in the Toolbar and the Ampl control panel. By default, Vert
Position = Ref Level.

2 Units Sets the global Amplitude units for all the views in the analysis window. This will change the
Amplitude selection in the Units tab of Analysis control panel.

3 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

4 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its value is italicized.

5 DPX view Selects the DPX view. Choices are Spectrum, DPXogram, and Split.

6 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen.

7 CF Adjusts the analyzer center frequency.

8 CF indicator Indicates the center frequency.

9 Span/Scale Span - Adjusts frequency range of the measurement. Scale - If Horizontal scale has been
manually adjusted in Settings > Scale, then this control adjusts the visual graph scaling
without affecting the Span.

10 Clear Erases the bitmap and traces in the graph and restarts multi-trace functions (Avg, Hold).

Table continued…
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Item Display element Description

11 Function Readout of the Detection and Function selections for the selected trace.

12 Show Controls whether the selected Trace is visible or not. When trace is Off, the box is not
checked.

13 Trace Selects a trace. Touching here pops up a context menu listing the available traces, whether
they are enabled or not. If you select a trace that is not currently enabled, it will be made
enabled.

Additional elements of the DPXogram split display

This display is only available when a compatible real time spectrum analyzer is connected.

Item Display element Description

1 Spectrums/line Appears only when the display is stopped. Readout of the number of spectrum lines
represented by each line of the DPXOgram display. This value changes when the Time/div
or Time resolution settings are changed.

Line time depends on RBW and FFT processing.

2 DPXogram trace The selected line in the DPXogram graph can be shown in the DPX Spectrum graph of the
Split view. The most recent DPXogram line, usually at the bottom of the graph, is selected
by default. If any markers are on, the selected marker determines the selected line.

Table continued…
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Item Display element Description

3 Color scale Legend at the right side of the DPX Spectrum display. This element illustrates the
relationship between the colors in the DPXogram plot and the amplitude axis of the DPX
Spectrum plot. This scale changes with Color (DPXogram) palette selection and Max and
Min settings on the Ampl Scale tab.

Time Resolution of DPXogram Display
Due to the large amount of data produced by the DPX hardware during acquisitions, a compressed version of the plot is shown while
running. This plot is limited to 500 lines, with each line having 267 points. However, a much longer record, with higher frequency resolution
is being collected. As soon as the instrument is stopped, this underlying data is shown, replacing the temporary version. There are 50 lines
in each vertical division of the 2-D DPXogram plot, so the time resolution of the graph is Time/div divided by 50. However, you can set the
instrument to collect multiple spectra per line, allowing you to zoom in later on this high-time-resolution data.

  

When the DPXogram display is stopped, the analyzer can display the full resolution of the captured data. The Time Resolution readout
applies only when the DPXogram is running.

Effects of Changing Time Resolution. The Time Resolution control affects acquisition parameters for the DPX hardware. This means
that if you change the Time Resolution value while the instrument is stopped, the new value applies to the NEXT acquisition, and might not
represent the results currently shown in the display.

Time resolution can be changed either directly, by manually adjusting the Time Resolution control, or automatically, by changing the
Time/div control. Auto is the default, yielding one spectrum per line in the display. When the Time Resolution is decreased below its auto
value, multiple spectra are collected to create each line in the DPXogram graph. Once you stop the instrument, you can decrease the
Time/div value or use Zoom to see increased time resolution.

If the time resolution is set to a very small number while the Time/div is set to a large value, you might notice that there is a limit to
the number of spectra that can be collected. This limit depends on the number of trace points selected. For 801-point spectra, 60,000
underlying spectra can be collected. The number of 2401-point spectra collected is 20,000, and for 4001-point spectra the number is
12,000. When the limit is reached, the oldest spectra are discarded as newer spectra are captured.

Touchscreen Actions on Markers in the Graph Area

Action Description

Mouse click within 1/2 div. of a
marker

Selects the marker and updates the marker display to show the selected marker's values.

Touch marker to select and then
use knob, or arrow keys

Adjust the setting associated with the Marker.

Touch and drag a marker Changes marker position to the "drop point". You can use Tools > Options > Prefs to change whether
markers jump from one peak to the next while dragging or move smoothly along the trace.
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Available Traces for Display – Standard Instrument
Five traces can be shown in the DPX display– one bitmap and four line traces. The default traces are Bitmap and +Peak detection. The
other three traces are –Peak detection, average detection, and math.

Trace Description

Bitmap Displays the density of acquired data. The number of data points acquired at each pixel (representing a
particular amplitude level at a specific frequency at a point in time) is indicated by color.

+Peak detected Line trace. Displays the maximum values acquired in each update. Normal and Hold functions are available
for this trace.

–Peak detected Line trace. Displays the minimum values acquired in each update. Normal and Hold functions are available
for this trace.

Average detected Line trace. Displays the average of all the values acquired in each update. Normal and Hold functions are
available for this trace.

Math Trace Line trace. Displays the difference between two traces. The two traces used are set in the Traces tab of the
Settings panel.

Determining Which Trace Types Are Displayed
You can see the status of all the traces by selecting the Trace drop-down list. Traces that are not displayed are preceded by "Enable". In
the following figure, you can tell that the Bitmap and -Peak Trace traces are displayed but the +Peak, Average, and Math Traces are not
displayed.

Selecting Enable -Peak Trace from the Trace list displays the -Peak detected values trace.

You can see whether a trace is enabled by looking at its Show check box. The "selected trace" is selected in the Trace list. The Show
check box is checked when the selected trace is enabled. To the right of the show box are readouts for detection of the selected trace
(+Pk, Avg (VRMS), ) and its function (Hold, Normal,). You can enable/disable the selected trace by checking or unchecking Show.

Selecting Traces for Display – Standard Instrument
To select a trace for display:

1. Use the Settings control panel:

• Select Setup > Settings or click the Settings button.
• Select the Traces tab.
• Select the trace from the drop-down menu.
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• Select the Show check box.
2. Select a trace from the Trace drop-down list.

Specifying How +Peak, –Peak, and Average Traces Are Displayed
You control how the +Peak, –Peak and Average (Avg (VRMS)) traces are displayed from the Traces tab of the Settings control panel. From
the Traces tab, you can also specify whether these traces display results from single updates or results collected over multiple updates.

To change how the traces are displayed:

1. Select Setup > Settings or click the Settings button.
2. Select the Traces tab.
3. Select the trace type from the drop-down list.
4. If you select +Peak Trace or -Peak Trace, use the Function drop-down list to select either Normal or Hold.

a. Select Normal to set the trace to display the maximum/minimum values acquired in each individual update.
b. Select Hold to set the trace to display the maximum/minimum values acquired over time. The trace values are updated only if they

exceed the existing values.
5. If you select Avg (VRMS) or Avg (of logs), use the Function drop-down list to select either Normal, Average (VRMS), or Avg (of

logs).

a. Select Normal to set the trace to display the average values acquired in each update.
b. Select Average (VRMS) or Avg (of logs) to set the trace to display an average of the average values. Use the Count box to enter

the number of times the trace is averaged.

Available Traces for Display
Five traces can be shown in the DPX Spectrum, Zero Span, Frequency, and Phase displays– one bitmap and four line traces. The default
traces are Bitmap and Trace 1. The other three traces are 2, 3, and Math. Line traces 1, 2, and 3 have user-selectable Detection and
Function settings. The final line trace is Math, allowing you to subtract one line trace from another.

For the DPXogram display, only one trace is available – the DPXogram trace.

For the Split display, you can display the Bitmap trace, Trace 1, Trace 2, Trace 3, Math trace, and Ogram Line (the selected line from the
DPXogram display) on the DPX Spectrum portion of the display.

Selecting Traces for Display
This is done almost the same as with the standard instrument, except that the choices available for Trace are different. Instead of +Pk,
–Pk, and Avg traces, you select Trace 1, 2, and 3 and independently set the Detection method for each of these traces to +Pk, -Pk, Avg
(VRMS), or Avg (of logs).

Reference. Changing the DPX Spectrum Display Settings

DPX settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings

The measurement settings for the DPX display are shown in the following table. 
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Settings tab Description

Freq & Span Sets frequency and span parameters for the DPX display. This tab appears for the Spectrum and
DPXogram displays.

Params Sets sweep time and scroll settings. This tab appears only for the DPX Zero Span, DPX Frequency
and DPX Phase displays.

Freq & BW The Freq & BW tab specifies frequency and bandwidth parameters for the DPX Zero Span, DPX
Frequency, and DPX Phase views.

BW Sets Resolution Bandwidth.

Traces Tab Allows you to select the number and types of traces to display and their functions.

Traces Tab Allows you to select the number and types of traces to display and their functions.

Horiz & Vert Scale Tab Sets the vertical and horizontal scale parameters for all the DPX views.

(Available only when Spectrum view is active.)

Bitmap Scale Tab Sets the DPX Bitmap display parameters.

Amplitude Scale Tab The Amplitude Scale tab allows you to change the vertical scale and offset, enable the 3-D Waterfall
display, and set the color scheme used for the DPXogram trace.

Time & Freq Scale Tab The Time and Freq Scale tab allows you to change the vertical and horizontal scale settings, number
of points in the trace, and Time resolution.

Prefs Specifies whether certain display elements are visible.

Density Specifies location and size for the DPX Density measurement box. (Spectrum display only.)

Audio Demod Enables and sets parameters for audio demodulation function.

Params tab - DPX zero span DPX frequency and DPX phase views
The Params tab sets the sweep time for the DPX Zero Span, Frequency and Phase views. Use the Params tab to set the scroll mode
settings for the DPX Zero Span, Frequency and Phase views. In Scroll mode, points of the trace are plotted as they occur, as opposed to
normal mode where the trace is plotted after an acquisition is completed. 
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Table 5: Params tab settings Zero Span, Frequency and Phase views

Setting Description

Sweep time Sets the time period for the measurement. By default, the Horizontal Scale is equal to Sweep time
and the sweep covers 10 divisions. When the graph is zoomed in, the sweep time extends beyond the
left and/or right edges of the graph. Range: 100 ns – 2000 s. Default: 1 ms.

Trace motion for Sweep ≥ 1 sec Specifies how the trace is displayed when the sweep time is equal to or greater than 1 second.

Normal Select Normal to scroll the position at which data points are added to the trace. In this mode, a caret
(^) moves below the graph to indicate the latest position.

Roll Select Roll to scroll the trace as points are added at the right side of the graph. When Roll is selected,
the trace moves to the left as points are added to the trace at the right side of the graph.

None Select None to display the trace without motion.

Freq and BW tab - DPX zero span DPX frequency and DPX phase views
The Freq & BW tab specifies frequency parameters for some of the DPX display views.

Table 6: Freq & BW tab settings for the bitmap trace

Setting Description

Center Frequency Sets the frequency at the center of the measurement bandwidth.

Step Size Sets the increment size when changing the Frequency using the knob or mouse wheel. Arrow keys
have an increment 10 times this setting.

Auto When Auto is enabled, the step size is adjusted automatically based on Spectrum's span setting.

Measurement BW, no filter This setting allows you to override the automatic bandwidth calculation and directly enter a bandwidth
value without the time-domain filter. If you enter a value for the measurement bandwidth, be aware
that the actual bandwidth of data provided to the measurement will be at least as wide as the value
you request and may be as much as two times wider than requested. This override of the selected
measurement bandwidth is done so that the instrument uses sufficient bandwidth relative to the
chosen symbol rate to ensure good signal quality measurements.

RBW (Time-domain BW) filter RBW (Time-domain BW) is a filter used to process the input signal before the system analyzes the
signal. The filter value determines the acquisition bandwidth that the view requires. Range: 1 HZ to
60 MHz.

Actual BW Shows the actual bandwidth being used for the display.

General signal viewing

RSA5100B Series Real-Time Signal Analyzers Help 88



Traces tab
The Traces tab allows you to set the display characteristics of displayed traces in the DPX display. The Traces tab settings vary depending
on the DPX display view enabled (Spectrum, DPXogram, or Split).

Figure 35: Traces tab with Trace1 and average selected

Figure 36: Traces tab with DPXOgram selected

Figure 37: Traces tab with Bitmap selected

Figure 38: Traces tab with Math Trace selected

Setting Description
Trace drop-down list Selects which trace to configure. The available traces are Bitmap,

Trace 1, Trace 2, Trace 3, and Math.
Table continued…
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Setting Description
Show Specifies whether or not the trace shown in the Trace setting is

displayed
Freeze Halts updates to the selected trace.
Detection Sets the Detection method used for the trace. Available detection

methods are +Peak, -Peak, and Avg (VRMS).
Function Selects the trace processing method. Available settings are:

Normal, Average, and Hold.
Count Sets the number of traces averaged to generate the displayed

trace. (Present only when Function is set to Average.)
Dot Persistence (Available only when Bitmap is selected) Allows a dot to remain visible if it is not updated with new data.

Choices for this setting are Variable and Infinite.
Variable The Variable dot persistence setting controls how long a point in the

display is visible before fading. Range: 100 ms – 60 s. Resolution
0.1.

Infinite The Infinite dot persistence setting prevents a point in the display
from fading (not available for the DPXogram trace).

Trace minus Trace (Available only when Math Trace is selected) The Math trace is a mathematically-derived trace defined as Trace
A minus Trace B. You can select Trace 1, 2, or 3 to serve as either
Trace A or Trace B.

Save Trace As Saves the selected trace to a file for later recall and analysis.
Show Recalled Trace Displays a saved trace instead of a live trace.

Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the maximum number of trace points is
100,000, and the selected analysis region is 200,000 samples, the measurement must decimate the 200,000 resulting trace points by 2 to
prevent exceeding the 100,000 trace point limit. Since only one value can be selected for each trace point, an algorithm must be used to
select (detect) the appropriate value to use.

The available detection methods are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples
available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.

Note: The Detection setting does not affect the trace until the spectrum length is longer than the Auto setting.

Dot Persistence
Dot Persistence is the characteristic of the DPX display that determines how long a pixel in the display remains visible.

To set the Persistence:
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1. Select Setup > Settings.
2. Select the Traces tab.
3. Select Dot Persistence.
4. Select either Infinite or Variable.
5. If you select Variable, enter a value in the text box. The Variable persistence value can be set from 0.05 to 100 seconds.

DPX Trace Processing
The +Peak, -Peak, and Average traces can be processed to display in different ways. The Function setting controls trace processing.

• Hold - Displays the value in the trace record for each display point. Each new trace display point is compared to the previous
maximum value and the greater value is retained for display and subsequent comparisons. Available for traces using +Peak or -Peak
detection.

• Normal - Displays the trace record for each display point without additional processing. Available for all detection selections.
• Average - Default setting for the Average. Multiple traces are averaged together to generate the displayed trace. There is one vertical

value for each underlying frequency data point. Once the specified number of traces have been acquired and averaged to generate the
displayed trace, each new trace takes the place of the oldest trace in the calculation. The Count setting specifies how many traces are
averaged. Available for traces using Average detection.

Trace averaging uses the exponential method. If Count = 10, the newest trace's contribution to the averaged trace is 10%. When Count
is not checked, the algorithm assumes the maximum number of traces contributing to the average is 232.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for comparison to a live trace. First, specify a trace for recall and second, enable Show Recalled
Trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.
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2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.
4. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the

graph).

Horiz and vert scale tab
The Horiz & Vert Scale tab allows you to change the vertical scale settings used for the Bitmap trace. Changing the scale settings changes
how the trace appears on the display but does not change control settings such as Measurement Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale.

Offset Adjusts the Reference Level away from the top of the trace display.

Reset Scale Sets Scale to its default value and Offset to zero. Disabled when Units (Setup > Analysis > Units) is
set to Watts or Volts.

Autoscale Resets the scale of the vertical axis to contain the complete trace. Disabled when Units (Setup >
Analysis > Units) is set to Watts or Volts.

Horizontal Controls the horizontal position and scale of the trace display.

Scale Changes the horizontal scale.

Position Adjusts the horizontal position of the signal. This does not change the center frequency.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Bitmap scale tab
The Bitmap Scale tab allows you to set the color scheme used for the Bitmap trace. Changing the DPX bitmap Color, Max and Min scale
settings changes how the trace appears on the display but does not change control settings such as Measurement Frequency.
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Setting Description

DPX Bitmap (Signal Density) Controls the appearance and scale of the DPX Bitmap trace.

Color Allows you to select the color palette used for the DPX Bitmap trace.

Max Sets the hit density represented by the top of the color scale. "Clipping" occurs for densities greater
than this value.

Range: 1p% - 100%; Default: 100%.

Min Sets the hit density represented by the bottom of the color range. Range: 0 - 80%; Default: 0.

Curve Adjusts how colors are mapped to the signal density. The mapping can be linear (Curve = 1), or it can
be set to concentrate the resolution on the lower level of the range (Curve > 1) or the mapping can be
set to show the best resolution on the upper range of density or hit count (Curve < 1).

Auto Color Adjusts the Max and Min settings to display the broadest range of colors.

Amplitude scale tab
The Amplitude Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D Waterfall display, and set the color
scheme used for the DPXogram trace. 

Setting Description

Height Height controls apply only to the 3-D Waterfall display.

Scale Changes the vertical scale for trace Amplitude in the graph (not the vertical scale for Time).

Position Specifies the level displayed at the bottom edge of the graph. (Bottom front edge in the 3-D view).

Autoscale Adjusts the vertical position bottom for linear units like Amps and Volts. Adjust the vertical position top
for log units like dBm. dBm is the default.

Table continued…
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Setting Description

3-D Waterfall Displays the DPXogram in a 3-D format.

Northeast Shifts the perspective of the 3-D graph so that the oldest traces move back and to the right.

Northwest Shifts the perspective of the 3-D graph so that the oldest traces move back and to the left.

Reset Scale Resets the Height and Color settings to their default values.

Color (DPXogram)

Color Displays a drop-down list that allows you to set the color scheme used for the DPXogram trace.

Max Sets the power level represented by the top of the color scale.

Min Sets the power level represented by the bottom of the color scale.

Time and freq scale tab
The Time and Freq Scale tab allows you to change the vertical and horizontal scale settings, set the time resolution and number of trace
points of the DPXogram display.

Setting Description

Vertical (time)

Time/div For most Spectrogram applications. Primary time scale control is Time/div. Time scale can be
zoomed in or out when acquisitions are stopped.

Position The position of the DPXOgram record at the bottom of the display. Position cannot be changed
while acquisitions are active, and is reset to zero when acquisitions are started again.

Time at position Displays the time of the DPXogram line shown at the bottom of the graph. This time is relative to
the Time Zero Reference of the current acquisition. If Position is set to a negative value, the Time
at position readout will be blanked.

Reset Scale Sets the Time/div and Position settings to their default values.

Trace Points Sets the number of trace points computed for each DPXogram line. These are the points used for
marker measurements and for results export.

Table continued…
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Setting Description

Time resolution Specifies the length of time represented by each line in the graph.

Line time depends on RBW and FFT processing.

Auto Sets the time represented by each line in the graph to be adjusted by the analyzer checked) or
manually (when unchecked). When Auto is enabled, Time Resolution change based on Time/div.

Capacity Readout of the total length of time that can be captured. This readout is provided so that you can
see how changing the Trace Points and Time resolution affects the amount of data that can be
captured. Capacity is represented in the format dd:hh:mm:ss.

Horizontal (frequency)

Scale Sets the displayed frequency range of the graph. This control affects only visual scaling, and
does not change the acquisition or analysis parameters.

Position Sets the frequency displayed at the center of the graph. Changing this value does not change the
Frequency setting.

Autoscale Sets the frequency scale to the Spectrogram Span value.

Density tab
The Density tab specifies the parameters of the measurement box used for measuring average signal density of an area in the bitmap. The
measurement box is also used by DPX Density triggering. 

To measure the average signal density over a rectangular portion of the DPX bitmap, you can adjust the size and location of the
measurement area using these controls, or by dragging the measurement box in the graph. You move the box by dragging the readout.
You adjust the size of the box by dragging the corners or edges.
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Setting Description

Show Measurement Shows or hides the measurement box in the graph when Triggering is not set to DPX Density. If
Triggering is set to DPX Density, the measurement box is always visible.

Frequency Specifies the frequency at the center of the measurement box. The +/- value specifies the width of the
measurement box.

Amplitude Specifies the amplitude of the center of the measurement box. The +/- value specifies the height of
the measurement box.

Audio demod tab
Audio demodulation can help you identify unknown radio signals. You control the audio demodulation function with the Audio Demod tab.
You access the Audio Demod tab from the Settings control panel of the DPX display.

Note: Audio Demodulation is available only in real-time acquisition mode (not swept acquisition), and the Trigger mode must be
set to Free Run (not Triggered).

Setting Description

On/Off Enables/disables audio demodulation.

Audio Gain Adjusts the volume of the demodulated audio.

AM Selects Amplitude Modulation as the demodulation method.

Table continued…
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Setting Description

FM Selects Frequency Modulation as the demodulation method.

Tune with Specifies how the frequency to be demodulated is specified. You can select markers or the frequency
control.

Receiver Freq Readout of the frequency to be demodulated.

Receiver BW Adjusts the equivalent receiver bandwidth for the audio demodulation. The range of values is 1 kHz to
500 kHz.

AM / FM
Note that these buttons select the demodulation method; they do not specify a frequency band.

Tune with
The choices for this setting are: one of the markers (MR, M1, M2, M3, M4) or the Frequency control (either the front-panel knob or the Freq
control in the application).

To use a marker to specify the frequency to be demodulated:

1. Select Markers > Define Markers to display the Define Markers control panel.
2. Select Add to turn on the next marker.

Note: The first marker defined will always be MR. The MR marker is the reference for delta marker readouts.

3. Select the trace to which the marker should be attached from the drop-down list.
4. Click Add to add additional markers. Assign them to the appropriate trace.
5. Click the close button to remove the Define Markers control panel.

Select markers. Select one of the markers in the Tune with drop-down list and then set the location of the marker to the frequency you
want to demodulate. If the marker you select is not enabled, the analyzer will tune to the frequency the marker was last set to.

Receiver BW
The Receiver BW setting will not change the acquisition bandwidth. Thus, if the acquisition bandwidth is too narrow, audio demodulation
will be disabled. The following three cases illustrate the relationship between the Acquisition BW, Receiver Frequency, and Receiver BW.

Case 1. In this case, the upper limit of the Receiver BW exceeds the upper limit of the acquisition bandwidth. When this occurs, audio
demodulation is disabled and an error message is displayed.
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Case 2. In this case, the upper and lower limits of the Receiver BW exceed the upper and lower limits of the acquisition bandwidth. When
this occurs, audio demodulation will be disabled and an error message is displayed.

Case 3. In this case, the upper and lower limits of the Receiver BW fall within the upper and lower limits of the acquisition bandwidth. This
is the desired relationship between the three settings, and audio demodulation is enabled.

Time overview

Time overview display
The Time Overview display shows the entire acquisition record and shows you how the spectrum time and analysis time fit within the
acquisition record. This enables you to see how you can adjust the spectrum time and analysis time to measure portions of the data.

You can specify the maximum number of trace points in the Time Overview display. You can set the maximum number of trace points to
1K, 10K, 100K, 1M points or to Never decimate. If the Acquisition Length includes more than 10,000 sample points (and Max trace points
is not set to Never decimate), the trace is decimated (using the +Peak method, similar to +Peak detection in a Spectrum display) to 10,000
points. This decimated trace is what is used for marker measurements.

The Time Overview window displays the Spectrum Length and Analysis Length. The Spectrum Length is the period of time within the
acquisition record over which the spectrum is calculated. The Analysis Length is the period of time within the acquisition record over which
all other measurements (such as Amplitude vs. Time) are made. The Spectrum Length and Analysis Length can be locked together so that
the data used to produce the Spectrum display is also used for measurement displays; however, they do not have to be tied together. They
are by default specified separately and used to analyze different parts of the acquisition record.
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Elements of the Time Overview Display

Item Element Description

1 Time Select the type of time analysis to be performed. You can select Analysis, Spectrum, or
Linked.

2 Offset Sets the offset of the selected analysis time control.

3 Length Sets the length of the selected analysis time control.

4 Position and Scale Adjusts the vertical scale and position.

5 Scale indicators Shows the vertical scale.

6 Autoscale button Resets the horizontal scale to display the entire acquisition record and the vertical scale to
show all trace points.

7 Horizontal offset Adjusts the horizontal offset.

8 Results Timeline This fuchsia line indicates the portion of the record actually used for calculating the
selected result. For example: if a pulse measurement is selected, it shows the period
of the specific pulse. For a constellation display, it shows the points included in the
demodulation.

9 Amplitude vs. Time graph The trace represents the entire acquisition record (at full horizontal scale). The graph
indicates the Analysis Length or Spectrum Length on the graph with a darker background.

10 Horizontal Scale Adjusts the span of the graph. By decreasing the scale, the graph essentially becomes a
window that you can move over the acquisition record by adjusting the offset.

11 Spectrum Length and Offset
Indicator (red line, top of graph)

This red line indicates the Spectrum Length and Offset. The longer the time, the longer the
bar. Adjusting the offset shifts the bar left or right.

Table continued…
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Item Element Description

12 Analysis Length and Offset
Indicator (blue line, top of graph
below red line)

The blue line indicates the Analysis Length and Offset. The longer the time, the longer the
bar. Adjusting the offset shifts the bar left or right.

Note: The area with black background (not gray) in the Amplitude vs. Time Graph highlights the control selected in the Analysis
Time Control drop-down list.

Changing the Time Overview Display Settings

Time overview settings
Menu Bar: Setup > Settings

Front Panel : Settings

The Setup settings for Time Overview are shown in the following table. 

Settings tab Description

Scale Adjusts the vertical and horizontal scale and offset of the display.

Trace Allows you to select the types of trace to display and its function.

Prefs Specifies whether or not certain display elements are shown.

Navigator view
The Time Overview Navigator View places the Time Overview display across the top of the application screen. This allows you to adjust
the area of interest in the Navigator View and see the results simultaneously in the other displays. For example, in the following image,
adjusting the mask in the Navigator View moves the trace and markers in all of the other displays.
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Show Navigator View
To show the Navigator View, select View > Navigator View. To remove the Navigator View, deselect Navigator View in the View menu.

Trace tab
The Trace Tab allows you to set the display characteristics of displayed traces. 

Setting Description

Show Shows / hides the selected trace.

Detection Sets the Detection method used for the trace. Not available for saved traces. Available detection
methods are +Peak, -Peak, +/-Peak, Avg (VRMS), and Sample. Not all detection methods are
available in all displays.

Table continued…
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Setting Description

Function Selects the trace processing method. Available settings are: Normal, Average, Max Hold, and Min
Hold.

(Number of Traces) Sets the number of traces averaged to generate the displayed trace. (Present only when Function is
set to Average.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the maximum number of trace points is
100,000, and the selected analysis region is 200,000 samples, the measurement must decimate the 200,000 resulting trace points by 2 to
prevent exceeding the 100,000 trace point limit. Since only one value can be selected for each trace point, an algorithm must be used to
select (detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to each trace point varies
with both analysis length and trace length. For example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes
just enough samples to produce one IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods (depending on the display) are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• +/-Peak – Selects the highest and lowest values of all the samples contained in two consecutive acquisition intervals.
• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples

available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.

• Sample – The result is calculated based on the first sample available in the set of IQ samples for each trace point.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

• Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a single vertical value.
• Average - Multiple traces are averaged together to generate the displayed trace. There is one vertical value for each underlying

frequency data point. Once the specified number of traces have been acquired and averaged to generate the displayed trace, each
new trace takes the place of the oldest trace in the calculation. The Number of Traces setting specifies how many traces averaged.

• Max Hold - Displays the maximum value in the trace record for each display point. Each new trace display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

• Min Hold - Displays the minimum value in the trace record for each display point. Each new trace display point is compared to the
previous minimum value and the lesser value is retained for display and subsequent comparisons.
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Saving Traces
To save a trace for later analysis:

1. Select the Save icon . This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.
6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the

graph).

Spectrum

Spectrum display
To display a spectrum:

1. Click the Displays button or select Setup > Displays.
2. From the Measurements box, select General Signal Viewing.
3. Double-click the Spectrum icon in the Available displays box. This adds the Spectrum icon to the Selected displays box (and

removes it from the Available displays box). Alternatively, you can click the Spectrum icon and then click the Add button to select
Spectrum for display.

4. Click the OK button.
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Elements of the Spectrum Display

Item Display element Description

1 Vertical position Sets the top of graph value. This is only a visual control for panning the graph. The
Reference Level is adjusted in the Toolbar and the Amplitude control panel. By default,
Vert Position = Ref Level.

2 Units Sets the global Amplitude units for all the views in the analysis window. This will change
the Amplitude selection in the Units tab of Analysis Control panel.

3 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

4 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its value is
italicized.

5 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab.

6 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen.

7 Position Default function is CF - center frequency (equivalent to the Freq setting). If Horizontal
scaling has been manually adjusted in Settings > Scale, then Offset will replace CF as the
setting at the bottom-left corner of the screen.

8 CF indicator Indicates the center frequency.

Table continued…
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Item Display element Description

9 Span / Scale Default function is Span - frequency difference between the left edge of the display and
the right edge. If Horizontal scaling has been manually adjusted in Settings > Scale, then
Scale will replace Span as the setting at the bottom-right corner of the screen.

10 Clear Restarts multi-trace functions (Avg, Hold).

11 Function Readout of the Detection and Function selections for the selected trace.

12 Show Controls whether the selected Trace is visible or not. When trace is Off, the box is not
checked.

13 Trace Selects a trace. Clicking here pops up a context menu listing the available traces, whether
they are enabled or not. If you select a trace that is not currently enabled, it will be made
enabled.

Touchscreen Actions on Markers in the Graph Area

Action Description

Mouse click within 1/2 div. of a
marker

Selects the marker and updates the marker display to show the selected marker's values.

Touch marker to select and then
use knob, or arrow keys

Adjust the setting associated with the Marker.

Touch and drag a marker Changes marker position to the "drop point".

Changing the Spectrum Display Settings

Spectrum settings
Menu Bar: Setup > Settings

Front Panel: Settings

The settings for the Spectrum display are shown in the following table. 

Settings tab Description

Freq & Span Sets frequency and span parameters for the Spectrum Analysis display.

BW Sets Resolution Bandwidth and windowing parameters.

Traces Sets Trace display parameters.

Traces (Math) Sets the traces used to create the Math trace.

Table continued…
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Settings tab Description

Scale Tab Sets vertical and horizontal scale and position parameters.

Prefs Tab Specifies whether or not certain display elements are shown.

Scale tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls. 

Setting Description

Vertical

Scale Changes the vertical scale.

Position Vertical Position adjusts the top of graph amplitude value. This control allows you to move (“pan”) the
traces up and down in the graph without changing the Reference Level.

Autoscale Resets the Offset so that the trace appears below the top of the graph.

Horizontal

Scale Allows you to change the range of frequencies shown in the graph without changing the span or
measurement frequency.

Position Allows you pan the graph.

Autoscale Resets Scale to the Span setting.

Reset Scale Resets all settings to their default values.

Log scale Resets the display to show the frequency axis in a logarithmic scale.

Spectrogram

Spectrogram display
The Spectrogram is a display with the vertical axis (time) composed of successive spectral displays, each having the amplitude
represented by color or intensity. The horizontal axis represents frequency. The most recently acquired spectrum results are added to
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the bottom of the spectrogram. The addition of a new spectrum can occur at the fastest rate that new spectra can be plotted, or, if you
choose, new spectra can be added at a timed rate. The spectrogram view is well-suited to displaying long-term trends of spectral data. The
maximum number of lines that can be displayed in a spectrogram is 125,000.

The spectrogram can also be displayed in a 3-D waterfall format. In the 3-D waterfall format, the spectrogram displays the time axis along
a simulated Z-axis. 

Note: Spectrogram data is shared with the Spectrum display. There is no linkage between DPX and Spectrogram.

To display a Spectrogram:

1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.
2. From the Measurements box, select General Signal Viewing.
3. Double-click the Spectrogram icon in the Available Displays box. This adds the Spectrogram icon to the Selected displays box.
4. Click the OK button. This displays the spectrogram view.
5. To display a 3-D version of the spectrogram, select the 3-D checkbox.

Elements of the Spectrogram Display
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Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Spectrogram display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Time/div Sets the length of time represented by each vertical division. Divisions are indicated by tick
marks along the left edge of the graph.

3 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its value is
italicized.

4 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab.

5 3-D checkbox Enables and disables the 3-D view.

6 Selected records indicators Shows the positions of the start and stop records selected on the Select data records
tab. Drag the indicators to select which records will be played by Replay All. Note that
these are not visible while acquisitions are running; the instrument must be stopped for the
indicators to be visible.

7 T Trigger indicator. This icon indicates the trigger point within the current acquisition.

8 Pos Position indicates the bottom line visible in graph. Changing this setting scrolls the window
up and down through the displayed acquisition records.

9 Autoscale Resets Vertical and Horizontal scale and Pos to default values.

10 CF Sets the Center Frequency.

11 Span Sets the span of the spectrogram display.

12 Current data record indicator A blue line indicates the current data record. When the analysis length is short, the blue
line appears as a thin line much like the selected indicator line. When the analysis length
is relatively long, the blue line appears more like a blue bar.

13 Position scroll bar Changes the position of the trace in the window. Changing the position scroll bar is the
same as adjusting the Pos setting.

14 Selected indicator This inverse-colored line indicates the Spectrogram line that will appear in the Spectrum
display when the Spectrogram trace is enabled. This line is attached to the selected
marker.

15 Clear Clears the spectrogram display; however, data records in acquisition history remain in
memory and are available for replay. To clear memory, select File > Acquisition Data Info
> Delete All Data.

Table continued…
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Item Display element Description

16 Marker indicators These icons indicate the position of markers in the spectrogram. You can move markers
by dragging the desired marker indicator.

17 Detection setting Displays the selected Detection method (see Settings > Trace tab).

18 Marker readout Marker readout for the selected marker. In the Spectrogram display, the marker readout
includes a date and timestamp. The time is displayed in a 24-hour format. The timestamp
readout can be shown or hidden independently of the other marker readouts (see Settings
> Prefs).

19 Time Scale status readout Three readouts can appear here depending on settings: Time/update, Spectrums/line, and
Overlap. See Time Scale Status Readout.

Time Scale Status Readout
Three types of readouts can appear in the display depending on settings:

• Time/update – Displays minutes:seconds when Spectrum Monitor is selected in the Settings > Time & Freq Scale tab in the Vertical
(Time) section.

• Spectrums/line – Displays an integer number when vertical scale is Normal and each line contains the results from one or more
frequency transforms (whether zoomed out or not).

• Overlap – Displays the overlap percentage when vertical scale is Normal and each line's transform shares some points with the
transforms of lines before and after it (zoomed in). Overlap can only be done when the Analysis Length > 2x RBW frame length.

The Spectrogram can show results from one or multiple acquisitions and it can show one or multiple lines for each acquisition.

Changing the Spectrogram Display Settings

Spectrogram settings
Menu Bar: Setup > Settings

Front Panel: Settings

The Setup settings for the Spectrogram display are visible when Spectrogram is the selected display. 

Settings tab Description

Freq & Span Sets frequency and span parameters for the Spectrogram display.

BW Sets Resolution Bandwidth and windowing parameters.

Trace Sets Trace display parameters.

Amplitude Scale Selects between 2-D and 3-D, sets height scale, position and orientation for 3-D display. Sets color
parameters for the spectrogram trace.

Table continued…
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Settings tab Description

Time & Freq Scale Sets the vertical and horizontal scale parameters for the spectrogram trace. The Spectrum Monitor
controls are also on this tab.

Prefs Specifies whether or not certain display elements are shown.

Trace tab
The Spectrogram Trace tab controls let you specify the Detection method, save traces, and recall saved traces for display. The
Spectrogram Trace tab does not have all the controls that other Trace tabs contain, however, it does have a unique display element, the
Selected Line readout. For details on Detection, Freeze, and saving and recalling traces, see the Traces Tab.

Selected Line
Displays the time at the Selected Line. If Markers are enabled, the selected line is positioned by the selected marker. If no markers are
enabled, the selected line is the first line in the current analysis period.

Amplitude scale tab
The Amplitude Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D Waterfall display, and set the color
scheme used for the spectrogram trace. 

Setting Description

Height (3-D only)

Scale Changes the vertical scale for trace Amplitude in the graph (not the vertical scale for Time).

Position Specifies the level displayed at the bottom edge of the graph. (Bottom front edge in the 3-D view).

Autoscale Adjusts the vertical position and scale of the trace lines to bring them into the visible portion of the
graph.

3–D Waterfall Displays the spectrogram in a 3-D format.

Table continued…
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Setting Description

Northeast Shifts the perspective of the 3-D graph so that the oldest traces move back and to the right.

Northwest Shifts the perspective of the 3-D graph so that the oldest traces move back and to the left.

Reset Scale Resets the Height and Color settings to their default values.

Color (Power)

Color Displays a drop-down list that allows you to set the color scheme used for the spectrogram trace.

Max Sets the maximum power level represented by the top of the color scale.

Min Sets the minimum power level represented by the bottom of the color scale.

Time and freq scale tab
The Time and Freq Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D Waterfall display, and set the
color scheme used for the spectrogram trace.

Setting Description

Vertical (Time)

Normal For most Spectrogram applications. Primary time scale control is Time/div. Time scale can be zoomed
in or out.

Spectrum Monitor For long-term signal monitoring applications. In spectrum monitor mode, each line in the spectrogram
represents the period of time specified by the Time/update parameter. Time scale can be zoomed out,
but not zoomed in (no overlap).

Time/update Sets the time, in minutes and seconds, represented by each line of the spectrogram. Only available in
Spectrum Monitor.

Reset Scale Resets the Time/div and Pos settings to their default values.

Autoscale Scales the vertical (time) axis to compress all existing trace lines into the visible area of the graph.
Resets the Position value to zero, placing the most recent spectrogram line at the bottom of the
spectrogram display. Only Position is affected by Autoscale when Spectrum Monitor is selected.

Time/div Sets the time displayed per division.

Table continued…
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Setting Description

Visible elapsed time Displays the length of time visible in the display. This does not represent the total time available to
view.

Position Adjusts vertical position of the trace within the graph area. Setting represents the offset, in divisions,
between the bottom of the graph and the bottom (most recent) line in the results trace.

Time at position Displays the time of the spectrogram line shown at the bottom of the graph. This time is relative to the
Time Zero Reference of the current acquisition.

Horizontal (Frequency)

Scale Sets the frequency range of the graph without changing the Span value.

Position Sets the frequency displayed at the center of the graph. Changing this value does not change the
Freq setting.

Autoscale Sets the frequency scale to the Spectrogram Span value.

Spectrum Monitor
Spectrum Monitor performs long term monitoring. The monitor mode compresses time into each line of the spectrogram, which enables
you to monitor long periods of time (from 1 second per line up to 600 minutes per line). With extended memory (Option 53) installed in the
instrument, you can capture up to 125,000 lines. With standard memory installed in the instrument, the maximum number of lines you can
capture is 31,250.

During each line's collection period, spectrum transforms are computed for each acquisition taken by the instrument. As each transform
completes, it is incorporated into the current spectrogram line. How each line of the spectrogram is created in spectrum monitor mode
depends on the detection setting (Settings > Trace). For example, if Detection is set to +Peak, each spectrogram line is effectively a peak
hold display of all the spectral data captured since the prior line.

Amplitude vs time

Amplitude vs time display
The Amplitude vs. Time display plots the signal amplitude against time. The amplitude appears on the vertical axis while time is plotted
along the horizontal axis.

Note that the trace(s) in the Amplitude vs. Time display can be set to a maximum of 100,000 points (however, the actual number of trace
points can extend up to 1,000,000 points if Max trace points is set to Never Decimate). If the Analysis Length includes more than the
selected Max trace points value, the trace is decimated (using the method specified with the Detection control) to be equal to or less than
the Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated) trace is what is
used for marker measurements and for results export. You can set the Max trace points on the Settings > Prefs tab.

To show Amplitude vs. Time display: 

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select General Signal Viewing in the Measurements box.
3. In the Available displays box, double-click the Amplitude vs. Time icon or select the icon and click Add. The Amplitude vs. Time icon

will appear in the Selected displays box and will no longer appear under Available displays.
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4. Click OK.

Elements of the Display

Item Display element Description

1 Vertical scale adjustment Adjusts the vertical scaling.

2 Span Adjust the bandwidth of the data to be analyzed. (Not the period of time shown in the
display.)

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Offset Adjust the horizontal offset.

5 Max and Min readouts Displays the maximum and minimum amplitudes, as well as when those values occur.

6 Scale Sets the time spanned by the graph.

7 Clear button Restarts multi-trace functions (Avg, Hold).

8 Trace function Displays the current trace function setting (Settings > Trace tab > Function).

Reference. Changing Amplitude vs Time Display Settings

Amplitude vs time settings
Menu Bar: Setup > Settings

Front Panel: Settings

The settings for the Amplitude vs. Time display are shown in the following table.
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Settings tab Description

Freq & BW Sets the Bandwidth Method used for setting the measurement bandwidth.

Traces Allows you to select the type of trace to display and their functions.

Traces (Math) Sets the traces used to create the Math trace.

Scale Sets the vertical and horizontal scale parameters.

Prefs Specifies whether certain display elements are visible.

Freq and BW tab
The Freq & BW (Bandwidth) tab allows you to specify the bandwidth parameters used for setting measurement bandwidth. This
determines what Acq BW the measurement will request. 

Settings Description

Time-domain Bandwidth filter Time-domain BW is a filter used to process the trigger input signal before the trigger system analyzes
the signal. The frequency edge trigger point must lie within the range of time domain bandwidth. This
makes the range of the frequency edge trigger = Center Frequency ±(0.5 × Time Domain Bandwidth)

Measurement BW, no filter This control limits the bandwidth of measurements. You use the measurement bandwidth setting to
improve the signal-to-noise ratio of the measurement, resulting in lower measurement uncertainty.
However, if the measurement bandwidth is set too low, resulting in fewer samples per second, it can
reduce the number of points within the measurement length below the 256 stable samples required,
thus causing the analysis to fail.

Frequency vs time

Frequency vs time display
The Frequency vs. Time Display shows how the signal frequency varies with time.

Note that the trace(s) in the Frequency vs. Time display can be set to a maximum of 100,000 points (however, the actual number of trace
points can extend up to 1,000,000 points if Max trace points is set to Never Decimate). If the Analysis Length includes more than the
selected Max trace points value, the trace is decimated (using the method specified with the Detection control) to be equal to or less than
the Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated) trace is what is
used for marker measurements and for results export. You can set the Max trace points on the Settings > Prefs tab.

To display the Frequency vs. Time Display: 

1. Select the Displays button or Setup > Displays.
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2. In the Select Displays dialog, select General Signal Viewing in the Measurements box.
3. In the Available displays box, double-click the Frequency vs. Time icon or select the icon and click Add. The Frequency vs. Time

icon will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to display the Freq vs. Time display.

Elements of the Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the frequency range displayed on the vertical axis.

2 Offset adjustment Adjusts the frequency shown at the center of the display.

3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the best display.

4 Maximum and Minimum
frequency readouts

Displays the maximum and minimum values, as well as when those values occur.

5 Horizontal Scale Sets the time spanned by the graph.

6 Clear button Restarts Average trace.

7 Trace function Displays the current trace function setting (Settings > Trace > Function).

Changing Frequency vs Time Display Settings

Frequency vs time settings
Menu Bar: Setup > Settings

Front Panel: Settings
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The Setup settings for Frequency vs. Time are shown in the following table. 

Settings tab Description

Freq & BW Sets the frequency and bandwidth parameters.

Trace Sets the trace display parameters.

Scale Sets the Vertical and Horizontal scale and offset parameters.

Prefs Specifies whether certain display elements are visible.

Phase vs time

Phase vs time display
The Phase vs. Time display plots the signal phase against time. The phase appears on the vertical axis while time is plotted along the
horizontal axis.

Note that the trace(s) in the Phase vs. Time display can be set to a maximum of 100,000 points (however, the actual number of trace
points can extend up to 1,000,000 points if Max trace points is set to Never Decimate). If the Analysis Length includes more than the
selected Max trace points value, the trace is decimated (using the method specified with the Detection control) to be equal to or less than
the Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated) trace is what is
used for marker measurements and for results export. You can set the Max trace points on the Settings > Prefs tab.

To display Phase vs. Time: 

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select General Signal Viewing in the Measurements box.
3. In the Available displays box, double-click the Phase vs. Time icon or select the icon and click Add. The Phase vs. Time icon will

appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the Phase vs. Time display.

Elements of the Display
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Item Display element Description

1 Top of graph adjustment Adjusts the vertical scale. Use the knob to adjust the value of the top of the graph.

2 Vertical offset adjustment Adjusts the phase error shown at the vertical center of the display.

3 Autoscale button Adjusts the vertical and horizontal settings so that the entire trace fits in the view.

4 Horizontal Offset Adjusts the horizontal position of the trace.

5 Max and Min readouts Displays the maximum and minimum value of the phase error within the analysis times
and the times at which they occurred.

6 Horizontal Scale Sets the time spanned by the graph.

7 Clear button Restarts multi-trace functions (Avg, Hold).

8 Trace function Shows the trace function as set on the Settings > Trace tab.

Changing the Phase vs Time Display Settings

Phase vs time settings
Menu Bar: Setup > Settings

Front Panel: Settings

The settings for the Phase vs. Time display are shown in the following table. 

Settings tab Description

Freq & BW Sets the frequency and bandwidth parameters.

Trace Sets the trace display parameters.

Scale Sets the Vertical and Horizontal scale and offset parameters.

Prefs Specifies whether certain display elements are visible.

RF I and Q vs time

RF I and Q vs time display
This is a plot of the baseband In-Phase (I) and Quadrature (Q) components of a modulated carrier. The plot is in the time domain, with I
and/or Q values the Y-axis.

Note that the trace(s) in the RF I & Q vs. Time display can be set to a maximum of 100,000 points (however, the actual number of trace
points can extend up to 1,000,000 points if Max trace points is set to Never Decimate). If the Analysis Length includes more than the
selected Max trace points value, the trace is decimated (using the method specified with the Detection control) to be equal to or less than
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the Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated) trace is what is
used for marker measurements and for results export. You can set the Max trace points on the Settings > Prefs tab.

To display an RF I & Q vs. Time display: 

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select General Signal Viewing.
3. Double-click the RF I&Q vs. Time icon in the Available Displays box. This adds the RF I & Q vs. Time icon to the Selected displays

box.
4. Click the OK button.

Elements of the Display

Item Display element Description

1 Top of Graph adjustment Use the knob to adjust the vertical scaling.

2 Vertical offset adjustment Adjusts the level shown at the center of the display.

3 Autoscale button Adjusts the offset and scale for both vertical and horizontal to provide the best display.

4 Maximum and Minimum level
readouts

Displays the maximum and minimum values, within the Analysis Time, as well as the times
at which they occurred.

5 Scale Sets the time spanned by the graph.

6 Clear button Restarts multi-trace functions (Avg, Hold).

7 Trace function Displays the current trace function setting (Settings > Trace > Function). If the traces are
averaged, the number of averages is displayed.

8 Trace Control Selects which trace is displayed (using the drop-down list) and which trace is active (click
on the trace name to display a menu).
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Changing the RF I & Q vs Time Display Settings

RF I and Q vs time settings
Menu Bar: Setup > Settings

Front Panel: Settings

The Setup settings for RF I&Q vs. Time are shown in the following table. 

Settings tab Description

Freq & BW Sets the frequency and bandwidth parameters.

Trace Sets the trace display parameters.

Scale Sets the Vertical and Horizontal scale and offset parameters.

Prefs Specifies whether certain display elements are visible.

Common controls for general signal viewing displays

General signal viewing shared measurement settings
The control panel tabs in this section are identical or very similar for each of the displays in the General Signal Viewing folder (Setup >
Displays). Some tabs are shared by all the displays, some tabs are shared by only a couple of displays.

For some tabs, the control values are shared across all the General Signal Viewing displays. For other control values, each display has
unique values for the controls. Details are provided for the specific tabs.

Table 7: Common controls for general signal viewing displays

Settings tab Description

Freq & Span Sets the frequency and span parameters.

Trace Sets the trace display parameters.

Traces – Math Sets the traces used to create the Math trace.

BW Sets the Bandwidth Method used for setting the measurement bandwidth.

Scale Sets the Vertical and Horizontal scale and offset parameters.

Prefs Specifies whether certain display elements are visible.

Freq and BW tab - freq vsTime phase vs time RF I and Q vs time display
The Freq & BW tab provides access to settings that control frequency settings for the Freq vs Time, Phase vs Time, RF I & Q vs Time
display. 
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Setting Description

Measurement Freq The frequency at the which measurements are made. This value is the same as the setting for
Frequency in the Application bar.

Measurement BW This control limits the bandwidth of measurements. You use the measurement bandwidth setting to
improve the signal-to-noise ratio of the measurement, resulting in lower measurement uncertainty.
However, if the measurement bandwidth is set too low, resulting in fewer samples per second, it can
reduce the number of points within the measurement length below the 256 stable samples required,
thus causing the analysis to fail.

Link to Span When enabled, the measurement bandwidth of the RF I & Q display is determined by the span of the
analyzer. When unchecked, the measurement bandwidth is specified by the user, and no additional
filter is applied.

Set to max BW Sets the measurement bandwidth to the maximum acquisition bandwidth of the instrument.

Freq and span tab
The Freq & Span tab provides access to settings that control frequency settings for the trace display. The control values set in this tab are
shared by all the General Signal Viewing displays. 

Setting Description

Center The frequency at the center of the selected Span.

Start The lowest frequency in the span.

Stop The highest frequency in the span.

Step Size Sets the increment/decrement size for Center, Start and Stop values.

Span The difference between the start and stop frequencies. This is the measurement bandwidth for the
general signal viewing displays.

Table continued…
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Setting Description

Dwell time (DPX display only) The amount of time the DPX sweep remains in a frequency segment collecting data and updating the
bitmap and traces before moving on to the next higher frequency segment. The minimum Dwell Time
setting is 50 ms, the normal update rate for DPX computations. Maximum Dwell Time per frequency
segment is 100 s. The number of frequency segments and their start/stop frequencies are internally
determined based on span, acquisition bandwidth, RBW and other parameters.

Max Span Sets the Span to the maximum value.

Auto checkbox Sets the Step Size and Dwell time automatically when checked.

Center, Start, Stop, and Span Frequencies Are Correlated
Changing the values for Center frequency, Start frequency, Stop frequency or Span will change the values for the other settings,
depending on which setting you change. For example, if you change the Center frequency, the Start and Stop frequencies will be adjusted
automatically to maintain the same Span.

Note however that if the Start and Stop frequencies are changed so that they are closer than the minimum span setting, the Start and Stop
frequencies will be adjusted to maintain the minimum Span setting.

Setting Changed Manually Settings Changed Automatically As a Result Setting Not Automatically Changed

Start Center, Span Stop

Stop Center, Span Start

Center Start, Stop Span

Span Start, Stop Center

Traces tab
The Traces Tab allows you to set the display characteristics of displayed traces. 

Setting Description

Trace Selects a trace. (This setting is not present for every display.)

Show Shows / hides the selected trace.

Table continued…

General signal viewing

RSA5100B Series Real-Time Signal Analyzers Help 121



Setting Description

Detection Sets the Detection method used for the trace. Not available for saved traces. Available detection
methods are +Peak, -Peak, +/-Peak, Avg (VRMS), Sample, CISPR Avg, CISPR Pk, and CISPR QPk.
Not all detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max Hold, and Min
Hold.

Count Sets the number of traces averaged to generate the displayed trace. (Present only when Function is
set to Average, Min Hold, or Max Hold.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace. When a trace is recalled, controls such as show, freeze,
function, and detection of trace will be disabled.

Trace
Available traces for Spectrum are: Trace 1, Trace 2, Trace 3, Math, and Spectrogram. Other displays support fewer traces. Traces 1-3 are
based on the input signal and enable you to display the input signal using different processing. For example, you could display Trace 1 with
Function set to Normal, Trace 2 with Function set to Max Hold and Trace 3 with Function set to Min Hold.

The Math trace is the result of subtracting one trace from another.

The Spectrogram trace applies only to the Spectrum display and is available only if the Spectrogram display is shown. The Spectrogram
trace shows the trace selected in the Spectrogram as a spectrum trace.

Detection
Trace Detection is used to reduce the results of a measurement to the desired number of trace points. For example, if the maximum
number of trace points is 100,000, and a measurement over the selected analysis length yields 200,000 points, the measurement must
decimate these 200,000 trace points by 2 to prevent exceeding the 100,000 trace point limit. Since only one value can be represented for
each trace point, an algorithm must be used to select (detect) the appropriate value to use.

The results array from an analysis can be detected (or “decimated”) in a variety of ways. The number of results points produced for each
trace point varies with both analysis length and trace length. For example, the frequency transform used for the Spectrum display produces
just one output value for each desired trace point. In this case, the detection method chosen has no effect, as no decimation is required.
Increasing the Analysis Length (or for the Spectrum display, the Spectrum Length), causes the available detection method's output traces
to differ from each other because they have a larger set of samples for the various detection methods to process.

The available detection methods (depending on the display) are:

• +Peak – The highest value is selected from the results to be compressed into a trace point.
• -Peak – The lowest value is selected from the results to be compressed into a trace point.
• +/-Peak – Both the highest and lowest values are selected from the results to be compressed into a trace point.
• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the results values it

includes. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results.
• Avg (of logs) – The detector is used to emulate legacy spectrum analyzer results and for the specification of displayed average noise

level. In older swept analyzers, a voltage envelope detector is used in the process of measuring signal level, and the result is then
converted to Watts and then to dBm. Averaging is then applied to the resultant traces.
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For CW signals, this method results in an accurate power measurement. However, with random noise and digitally modulated carriers,
errors result from this 'average of logs' method. For random noise, the average of logs methods results in power levels -2.51 dB lower
than that measured with a power meter, or with a signal analyzer that measures the rms value of a signal, and performs averaging on
the calculated power in Watts and not dBm or other log-power units.

This detector should be used when following a measurement procedure that specifies it, or when checking the Displayed Averaged
Noise Level (DANL) of the instrument. The 'average of logs' detection and trace function is used for DANL specification to provide
similar results to other spectrum/signal analyzers for comparison purposes. Use of the Average of Logs method of measurement is not
recommended for digitally modulated carriers, as power measurement errors will occur.

Note: The Detection setting does not affect the trace until the spectrum length is longer than the Auto setting.

• Sample – The first value is selected from the set of results to be compressed into a trace point.
• CISPR Peak – The trace value is calculated by the methods described for peak detectors in the CISPR documents.
• CISPR QPk – The trace value is calculated by the methods described for quasi peak detectors in the CISPR documents.
• CISPR Avg – The trace value is calculated by the methods described for average detectors in the CISPR documents.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

• Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a single vertical value.
• Average - Multiple traces are averaged together to generate the displayed trace, which will contain just one vertical value for each

underlying frequency data point. Once the specified number of traces have been acquired and averaged to generate the displayed
trace, additional traces contribute to the running average, except in Single Sequence run mode. In the case of Single Sequence, the
instrument stops running after the specified number of traces have been averaged together. The Number of Traces setting specifies
how many traces are averaged. The averaging is performed on the linear (Voltage) values, resulting in the correct RMS average).

• Max Hold - Displays the maximum value in the trace record for each display point. Each new trace's display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

• Min Hold - Displays the minimum value in the trace record for each display point. Each new trace's display point is compared to the
previous minimum value and the lesser value is retained for display and subsequent comparisons.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.
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4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.
6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the

graph).

Traces tab - math trace
This tab is not a distinct tab, it is just how the Traces tab appears when Math is selected in the Traces drop-down list. 

Trace 4 is a mathematically-derived trace defined as Trace A minus Trace B. You can select Trace 1, 2, or 3 to serve as either Trace A or
Trace B.

Setting Description

Trace When set to Trace 4 (Math), this tab is displayed.

Show Shows / hides the selected trace.

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Trace minus Trace Selects which traces serve as Trace A and Trace B.

BW tab
The BW (bandwidth) tab allows you to change Resolution Bandwidth and Video Bandwidth settings, and set the windowing method used
by the transform process by selecting a filter shape (not present for all displays). 

Setting Description

RBW Sets the Resolution Bandwidth value to be used in the spectrum analysis view. The value is italicized
when Auto is selected.

Table continued…
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Setting Description

Auto When Auto is checked, the RBW is calculated as a percentage of the Span. Kaiser is selected as
the windowing method. When Auto is unchecked, the RBW is set by the user. Selecting any Window
other than Kaiser changes the RBW setting to manual.

Span/RBW ratio If Auto is checked, this value is used to calculate the RBW. If Auto is unchecked, this setting is not
selectable.

Filter Shape Specifies the windowing method used for the transform (when Auto is unchecked). (Spectrum and
Spectrogram displays only.)

VBW Adjusts the VBW (Video Bandwidth) value. (Spectrum and Spectrogram displays only.)

Filter Shape Settings
In the analyzer, computationally efficient discrete Fourier transform algorithms such as FFT (Fast Fourier Transform) or CZT (Chirp-Z
Transform) are generally employed to transform time-domain signals into frequency-domain spectra. There is an assumption inherent
in the mathematics of Discrete Fourier Transforms that the data to be processed is a single period of a periodically repeating signal.
The discontinuities between successive frames will generally occur when the periodic extension is made to the signal. These artificial
discontinuities generate spurious responses not present in the original signal, which can make it impossible to detect small signals in the
presence of nearby large ones. This phenomenon is called spectral leakage.

Applying a filter, such as Kaiser, to the signal to be transformed is an effective method to combat the spectral leakage problem. Generally
the filter has a bell shape. Multiplying the transform frame by the filter function eliminates or reduces the discontinuities at the ends of the
frame, however, at the expense of increased RBW.

Filter Shape Characteristics
The choice of filter shape depends on its frequency response characteristics such as side-lobe level, equivalent noise bandwidth and
maximum amplitude error. Use the following guidelines to select the best filter shape.

Filter Shape Characteristics

Kaiser (RBW) Best side-lobe level, shape factor closest to the traditional Gaussian RBW.

-6dB RBW (MIL) These filters are specified for bandwidth at their -6 dB point, as required by military EMI regulations.

CISPR These filters comply with the requirements specified in the P-CISPR 16 -1-1 document for EMI
measurements.

Blackman-Harris 4B Good side-lobe level.

Uniform (None) Best frequency resolution, poor side-lobe level and amplitude accuracy.

Flat-Top Best amplitude accuracy, best representation of brief events captured near the beginning or end of the
time-domain data frame, poor frequency resolution.

Hanning Good frequency resolution, high side-lobe roll-off rate.
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VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the effect of noise on
the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is 1/10,000 of the RBW setting. VBW is disabled
when the Filter shape is set to CISPR.

Note: If you are following a procedure that says to "set VBW to three times the RBW value or greater", it means that the test
should be conducted with no VBW effects. In the analyzer, this condition is met by disabling the VBW function.

Scale tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.

The Scale tab values are unique to each display. Also, note that each display uses horizontal and vertical units that are appropriate for
the display. For example, for the Spectrum display uses power (dBm) units and frequency (Hz) units; the Amplitude vs. Time display uses
power (dBm) and time (seconds) units; and the Phase vs. Time display uses phase (degrees) and time (seconds) units. 

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale.

Offset Vertical Offset adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Changes the range shown between the left and right sides of the graph.
Position Changes the position of the acquisition record shown at the left edge of the graph.

Reset Scale Resets all settings to their default values.

Prefs tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on the Prefs tab vary depending
on the selected display, but include such items as enabling/disabling marker Readout and switching the Graticule display on/off.

Each of the General Signal Viewing displays maintains its own separate values for the controls that appear on the Prefs tab. Some
parameters appear with most displays while others appear with only one display.
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For example, in the following image, the Show Marker readout in graph check box appears in the Prefs tab for every display. However, the
Show Power Trigger level check box only appears on the Amplitude vs Time Prefs tab.

The following image shows the Prefs tab for the Time Overview display.

The following image shows the Prefs tab for the DPX display when DPXogram or Split is the selected view.

The following table explains the controls that can appear on the Prefs tab.

Setting Description

Show: Sets the horizontal settings that appear below the graph area. You can select Start, Stop or Center,
Span.

Trace points Sets the number of trace points used for marker measurements and for results export.

Max trace points

(Time Overview Display only)

Sets the maximum number of trace points used for marker measurements and for results export.

Show trace legend Enables display of a legend in the measurements area that shows the Detection method and Function
setting for displayed traces. The color of the legend text matches the color of the associated trace.

Show graticule Check to display the graticule. Uncheck to hide the graticule.

Table continued…
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Setting Description

Navigator View

(Time Overview Display only)

Places the Time Overview display across the top of the application window, above all other active
displays.

Show Parameter Readouts For the DPX display, enables/disables the display of DPX parameters. The parameters readout shows
100% Probability of Intercept, Transforms/s, and FFT Points.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show timestamp in graph
(selected line)

For spectrogram displays, this readout shows or hides the timestamp associated with the selected line
or marker position.

DPX shows only trigger frames For the DPX Spectrum display, check to show only trigger frames.
Show Power Trigger Level Displays or hides a green line in the graph that indicates the level at which the power trigger is set.

The line is not displayed if Trigger is set to Free Run.

Show Parameter Readouts (DPX Spectrum Only)
The elements of the Show Parameter Readouts are:

• 100% POI – This is the minimum event duration required to ensure 100% Probability of Intercept or event capture. This duration
depends on interaction between span, RBW, and FFT length. You can use the POI time value to determine if you are at risk of either
missing a narrow transient or of its captured amplitude being less than the actual signal.

Table 8: Minimum signal duration for 100% probability of trigger at 100% amplitude

Frequency-Mask and DPX signal processing
Minimum signal duration, 100% probability of intercept, Frequency-
Mask and DPX density trigger (μs)

Span RBW (kHz) FFT length Spectrums/sec Standard Opt. 09

Full amplitude -3 dB Full amplitude -3 dB

165 MHz 20000 1024 390,625 15.5 15.4 2.7 2.6

10000 1024 390,625 15.6 15.4 2.8 2.6

1000 1024 390,625 17.8 15.7 5.0 2.9

300 2048 195,313 23.4 16.3 13.1 6.1

100 8192 48,828 44.5 23.4 44.5 23.4

30 32768 12,207 161.9 91.7 161.9 91.7

Table continued…
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Frequency-Mask and DPX signal processing
Minimum signal duration, 100% probability of intercept, Frequency-
Mask and DPX density trigger (μs)

Span RBW (kHz) FFT length Spectrums/sec Standard Opt. 09

Full amplitude -3 dB Full amplitude -3 dB

85 MHz 10000 1024 390,625 15.6 15.4 2.8 2.6

1000 1024 390,625 17.8 15.7 5.0 2.9

500 1024 390,625 20.2 15.9 7.4 3.1

300 1024 390,625 23.4 16.3 10.6 3.5

100 4096 97,656 44.5 23.4 34.2 13.2

30 16384 24,414 121.0 50.7 121.0 50.7

20 16384 24,414 161.0 55.6 161.0 55.6

40 MHz 5000 1024 390,625 15.8 15.4 3.0 2.6

1000 1024 390,625 17.8 15.7 5.0 2.9

300 1024 390,625 23.3 16.3 10.5 3.5

100 2048 195,313 39.4 18.3 29.1 8.1

30 4096 97,656 90.4 21.8 90.4 21.8

20 8192 48,828 140.7 36.3 140.7 36.3

10 16384 24,414 281.3 72.6 281.3 72.6

25 MHz 3800 1024 390,625 16.0 15.4 3.2 2.6

1000 1024 390,625 17.7 15.7 4.9 2.9

300 1024 390,625 23.4 16.3 10.6 3.5

200 1024 390,625 27.4 16.8 14.6 4.1

• Transforms/s – This is the number of transforms/second being performed by the DPX engine. It is a function of the selected resolution
bandwidth and number of trace points. The desired RBW determines the number of points required in each transform, which alters
the transform rate. Additionally, the selected trace length may place requirements on the number of points required in the transform
independent of the selected resolution bandwidth.

• FFT Points – The approximate number of points in the FFT of the input signal. FFT points provides an indication of frequency
resolution, but it is not an exact measurement. Note that higher numbers for FFT points mean that the instrument is taking a longer
string of input samples for each FFT, which decreases the time resolution.
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Table 9: Minimum FFT length versus trace length - independent of span and RBW

Trace length (points) Minimum FFT length

801 1,024

2,401 4,096

4,001 8,192

10,401 16,384
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Analog Modulation
Overview
The displays in Analog Modulation (Displays > Measurements > Analog Modulation) are:

• AM
• FM
• PM

The Analog Modulation displays provide measurements and time-domain trace displays.

AM Display
The Amplitude Modulation Display is a graph of Modulation Factor vs Time. The AM display includes three numeric readouts. 

To show the AM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Analog Modulation.
3. Double-click the AM icon in the Available Displays box. This adds the AM icon to the Selected displays box.
4. Click the OK button. This shows the AM display.

Elements of the Display
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the AM
display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the %AM indicated at the top of the graph by increasing or decreasing the vertical
scale. Changing the top value affects the bottom of graph value because the graph scales
about vertical center. Also, note that the top of graph setting interacts with the internal
vertical scale setting (which is not user settable).

3 Position Specifies the %AM shown at the center of the graph display.

4 Bottom Readout Displays the value of the modulation factor shown at the bottom of graph.

5 Measurement readouts Displays numeric values for the +AM (positive modulation factor), –AM (negative
modulation factor), and Total AM.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the horizontal range of the graph. By decreasing the scale (time across the entire
graph), the graph essentially becomes a window that you can move over the trace by
adjusting the position.

8 Clear Erases the trace from the graph.

9 Trace Detection readout Displays the Settings > Trace > Detection setting.

Changing the AM Settings

AM Settings
Main menu bar: Setup > Settings 

The AM Settings control panel provides access to settings that control parameters of the AM Display.

Analog Modulation

RSA5100B Series Real-Time Signal Analyzers Help 132



Setting Description

Parameters Sets the Carrier Amplitude Detection method. You can choose either Average or Median.

Trace Sets Trace display parameters.

Scale Sets vertical and horizontal scale and position parameters.

Prefs Specifies whether or not certain display elements are shown. Specifies the maximum number of
points shown in the display graph.

Parameters Tab
The Parameters tab enables you to specify two parameters that control the carrier amplitude detection.

Setting Description

Average Selects the Average method for computing the average baseline for measurements.

Median Selects the Median method for computing the average baseline for measurements.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

AM Modulation
An amplitude modulated carrier can be described mathematically by:

A, in the above equation, represents the carrier amplitude, a(t) represents the time-varying modulation and ω0 represents the carrier
frequency.

The signal modulation envelope is given by:

There are several ways to express the AM modulation depth, expressed as a percentage.

Peak method

Trough Method
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Max-Min Method

In each case, the value of the carrier amplitude, A, needs to be estimated from the input signal.

The instrument represents signals in a sampled form. The sampled envelope can be expressed as a function of sample index K and
sampling period T as:

The instrument allows the choice of two methods for estimating the carrier amplitude:

Average Method

Median Method

In both cases, the instrument computes the average and the median over the analysis period. It should be noted that the two methods give
the same result for sinusoidal modulation where the sampling frequency is much higher than the modulation frequency.

Trace Tab
The Trace Tab allows you to set the display characteristics of a trace.

Setting Description

Show Shows/hides the trace. If the instrument continues to run, the measurement results below the graph
display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak, -Peak, and
Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Table continued…
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Setting Description

Show recalled trace Displays a saved trace instead of a live trace.

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ samples in a data acquisition can be
detected in a variety of ways. The number of IQ samples available to each trace point varies with both analysis length and trace length. For
example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak, and Avg (VRMS) are all equal.
Changing the Spectrum Length causes the available detection methods to differ in value because they have a larger set of samples for the
various detection methods to process.

The available detection methods are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples
available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.

Trace Processing
Traces can be processed to display in different ways. The Detection setting controls trace decimation, when needed. When the trace points
each cover more than one sample data point, the vertical results values for multiple data points are combined into each trace point. Each
trace point ends up with a single vertical value.

• Average - Each trace point is computed by averaging together the multiple results points it represents.
• +Peak - Each trace point represents the highest vertical value among the results it includes.
• –Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.
2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.
4. Verify that the Show check box is selected.
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Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the level shown at the center of the graph.

Autoscale Resets the Position so that the entire trace is in the graph.

Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the position of the acquisition record shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to provide the optimum display.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the AM display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Table continued…
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Setting Description

Max trace points The trace in the AM display can be set to a maximum of 100,000 points (however, the actual number
of trace points can extend up to 500,000 points if Max trace points is set to Never Decimate). If the
Analysis Length includes more than the selected Max trace points value, the trace is decimated (using
the method specified with the Detection control) to be equal to or less than the Max trace points
setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export.

FM Display
The Frequency Modulation Display shows Frequency Deviation vs. Time. The vertical axis units are Hertz and the horizontal axis units are
seconds. When taking measurements, only the first burst in the Analysis period is analyzed. No trace points are shown for data outside the
first detected burst, nor are measurements made on data outside the first detected burst.

To show the FM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Analog Modulation.
3. Double-click the FM icon in the Available Displays box. This adds the FM icon to the Selected displays box.
4. Click the OK button. This shows the FM display.

Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the FM
display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

Table continued…
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Item Element Description

2 Top of Graph control Sets the frequency indicated at the top of the graph. Since the Position value at the
vertical center of this graph remains constant as the Top of Graph value is adjusted,
the Vertical Scale increases as the Top of Graph value increases, which also affects the
bottom of graph readout. Vertical Scale can also be controlled from the Settings control
panel's Scale tab.

3 Position Specifies the frequency shown at the center of the graph display. Changing this value
moves the trace up and down in the graph, which affects the Top of Graph and Bottom of
Graph values as well.

4 Bottom of Graph Readout Displays the frequency value at the bottom of the graph.

5 Measurement readouts Displays numeric values for the +Pk (positive frequency deviation), –Pk (negative
frequency deviation), RMS (RMS value of the deviation), Pk-Pk (peak-to-peak frequency
deviation), and Pk-Pk/2 (peak-to-peak frequency deviation divided by two).

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time over
10 divisions), the graph essentially becomes a window that you can move over the
acquisition record by adjusting the horizontal position.

8 Clear Clears the trace and numeric measurement results.

9 Trace Detection readout Displays the Settings > Trace > Detection setting.

10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq Error, it shows
the difference between the instrument Frequency setting and the measured value of the
signal's carrier frequency. When it displays Freq Offset, it shows the frequency offset
specified on the Settings > Parameters tab. If Freq Error is displayed, it also indicates that
the Carrier frequency detection setting is Auto. If Freq Offset is displayed, it indicates that
the Carrier frequency detection setting is manual.

Changing the FM Settings

FM Settings
Main menu bar: Setup > Settings 

The FM Settings control panel provides access to settings that control parameters of the FM Display.
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Setting Description

Parameters Sets the burst detection threshold, measurement bandwidth, and carrier frequency detection method.

Trace Sets Trace display parameters.

Scale Sets vertical and horizontal scale and position parameters.

Prefs Specifies whether or not certain display elements are shown. Specifies the maximum number of
points shown in the display graph.

Parameters Tab
The Parameters tab enables you to specify parameters for carrier detection. 

Setting Description

Burst detect threshold This parameter specifies the power level used to determine whether a burst is present. A valid burst
is required to take measurements. The burst detected first is used for the analysis. The units for burst
detect threshold are dBc, relative to the maximum acquisition sample data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

Frequency offset Displays the carrier signal's offset from the instrument's measurement frequency. Auto is used to
select the method for determining the carrier frequency. When Auto is selected, the instrument
determines the carrier frequency by analyzing the signal. When Auto is deselected, you can set the
carrier frequency offset using Frequency Offset.

Load from Marker Pressing this button sets the frequency offset to the frequency offset of the selected marker. (Pressing
this button automatically deselects Auto.)

Frequency Offset
In Auto (Auto is selected), the instrument scans the measurement bandwidth about the measurement frequency and looks for the
highest-powered signal. This is defined as the carrier frequency. In Manual (Auto is deselected), the carrier frequency is specified by
adding/subtracting the specified Frequency offset from the measurement frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement
BW*1.1)/2. If the Load from Marker button is pressed, the frequency offset is determined from the phase difference between the two
markers on screen compared to the time between the two markers. This function is useful for removing frequency slope from the phase
modulated signal.

Load from Marker
When the Auto check box is selected, the instrument scans the measurement bandwidth about the center frequency and looks for the
highest-powered signal. This is defined as the carrier frequency. When the Auto check box is deselected, the carrier frequency is specified
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by adding/subtracting the specified Frequency offset from the center frequency. Pressing the Load from Marker button loads the marker
frequency into the Frequency offset box.

Trace Tab
The Trace Tab allows you to set the display characteristics of displayed traces.

Setting Description

Show Shows / hides the trace. If the instrument continues to run, the measurement results below the graph
display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak, -Peak, and
Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ samples in a data acquisition can be
detected in a variety of ways. The number of IQ samples available to each trace point varies with both analysis length and trace length. For
example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak, and Avg (VRMS) are all equal.
Changing the Spectrum Length causes the available detection methods to differ in value because they have a larger set of samples for the
various detection methods to process.

The available detection methods are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples
available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.
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Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

• Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a single vertical value.
• Average - Each trace point is computed by averaging together the multiple results points it represents.
• +Peak - Each trace point represents the highest vertical value among the results it includes.
• –Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.
2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.
4. Verify that the Show check box is selected.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the frequency shown at the center of the graph.

Autoscale Resets the Position so that the entire trace fits within the graph.

Horizontal

Table continued…
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Setting Description

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the position of the acquisition record shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to provide the optimum display.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the FM display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the FM display can be set to a maximum of 100,000 points (however, the actual number
of trace points can extend up to 500,000 points if Max trace points is set to Never Decimate). If the
Analysis Length includes more than the selected Max trace points value, the trace is decimated (using
the method specified with the Detection control) to be equal to or less than the Max trace points
setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export.

PM Display
The Phase Modulation Display shows Phase vs. Time. The vertical axis units are degrees and the horizontal axis units are seconds. When
taking measurements, only the first burst in the Analysis period is analyzed. No trace points are shown for data outside the first detected
burst, nor are measurements made on data outside the first detected burst.
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Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the PM
display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph control Sets the phase value indicated at the top of the graph. Since the Position value at the
vertical center of this graph remains constant as the Top of Graph value is adjusted,
the Vertical Scale increases as the Top of Graph value increases, which also affects the
bottom of graph readout. Vertical Scale can also be controlled from the Settings control
panel's Scale tab.

3 Position Specifies the phase shown at the center of the graph display. Changing this value moves
the trace up and down in the graph, which affects the Top of Graph and Bottom of Graph
values as well.

4 Bottom of Graph Readout Displays the phase value at the bottom of the graph.

5 Measurement readouts Displays numeric values for the +Pk (positive phase deviation), –Pk (negative phase
deviation), Pk-Pk (peak-to-peak phase deviation), and RMS (RMS value of the phase
deviation).

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time over
10 divisions), the graph essentially becomes a window that you can move over the
acquisition record by adjusting the horizontal position.

Table continued…
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Item Element Description

8 Clear Clears the measurement results.

9 Trace Detection readout Displays the Trace Detection setting (see Settings > Trace > Detection).

10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq Error, it shows
the difference between the instrument Frequency setting and the measured value of the
signal's carrier frequency. When it displays Freq Offset, it shows the frequency offset
specified on the Settings > Parameters tab. If Freq Error is displayed, it also indicates that
the Carrier frequency detection setting is Auto. If Freq Offset is displayed, it indicates that
the Carrier frequency detection setting is manual.

Changing the PM Settings

PM Settings
Main menu bar: Setup > Settings

The PM Settings control panel provides access to settings that control parameters of the PM Display.

Setting Description

Parameters Sets the Carrier Frequency Detection method. You can choose either Automatic or Manual. Sets burst
threshold and phase detection method.

Trace Sets Trace display parameters.

Scale Sets vertical and horizontal scale and position parameters.

Prefs Specifies whether or not certain display elements are shown. Specifies the maximum number of
points shown in the display graph.

Parameters Tab
The Parameters tab enables you to specify parameters that control the carrier frequency and phase detection. 
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Setting Description

Burst detect threshold Specifies the power level used to determine whether a burst is present. A valid burst is required
to take measurements. The burst detected first is used for the analysis. The units for burst detect
threshold are dBc, relative to the maximum acquisition sample data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

Frequency offset Displays the carrier signal's frequency offset from the instrument's Measurement Frequency. Auto
is used to select the method for determining the carrier frequency. When Auto is selected, the
instrument determines the carrier frequency by analyzing the signal. When Auto is deselected, you
can set the carrier frequency offset using Frequency Offset.

Load Δ from Marker Pressing this button disables the Auto Frequency Offset function and sets the Frequency offset to the
frequency offset calculated from the difference between MR (the marker reference) and the selected
marker (or M1 if MR is currently the selected marker).

Phase offset Displays the phase offset. When Auto is selected, the instrument determines the phase offset. When
Auto is deselected, the user sets the phase offset with this control.

Load from marker Pressing this button sets the phase offset to the phase offset of the selected marker. (Pressing this
button automatically deselects Auto.)

Frequency Offset
In Auto (Auto is selected), the instrument scans the measurement bandwidth about the Measurement Frequency and looks for the
highest-powered signal. This is defined as the carrier frequency. In Manual (Auto is deselected), the carrier frequency is specified by
adding/subtracting the specified Frequency offset from the Measurement Frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement
BW*1.1)/2. If the Load Δ from marker button is pressed, the frequency offset is determined from the phase difference between the two
markers on screen compared to the time between the two markers. This function is useful for removing frequency slope from the phase
modulated signal.

Phase Offset
In Auto (Auto is selected), the instrument sets the phase offset to fit the waveform to the screen centering 0° phase on the vertical axis.
The actual phase offset is indicated on the Phase Offset readout. In Manual (Auto is deselected), the instrument sets the phase offset
using the value specified in Phase offset. For example, when Phase offset is set to 10°, the waveform shifts upward by 10° on screen.
Selecting Load from marker sets the phase offset to the value of the selected marker. Range: –180 to +180°.

Trace Tab
The Traces Tab allows you to set the display characteristics of displayed traces.
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Setting Description

Show Shows / hides the trace. If the instrument continues to run, the measurement results below the graph
display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak, -Peak, and
Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ samples in a data acquisition can be
detected in a variety of ways. The number of IQ samples available to each trace point varies with both analysis length and trace length. For
example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak, and Avg (VRMS) are all equal.
Changing the Spectrum Length causes the available detection methods to differ in value because they have a larger set of samples for the
various detection methods to process.

The available detection methods are:

• +Peak – Each point on the trace is the result of detecting the positive peak value present in the set of IQ samples available to that
trace point.

• -Peak – Each point on the trace is the result of detecting the negative peak value present in the set of IQ samples available to that
trace point.

• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples
available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

• Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a single vertical value.
• Average - Each trace point is computed by averaging together the multiple results points it represents.
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• +Peak - Each trace point is represents the highest vertical value among the results it includes.
• –Peak - Each trace point is represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.
2. Navigate to the desired file and click Open.
3. Check the Show Recalled Trace check box.
4. Verify that the Show check box is selected.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the phase shown at the center of the graph.

Autoscale Resets the Position so that the entire trace in the graph.

Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the phase shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to show the entire trace within the graph.
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Prefs Tab
The Prefs tab enables you to change appearance characteristics of the PM display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the PM display can be set to a maximum of 100,000 points (however, the actual number
of trace points can extend up to 500,000 points if Max trace points is set to Never Decimate). If the
Analysis Length includes more than the selected Max trace points value, the trace is decimated (using
the method specified with the Detection control) to be equal to or less than the Max trace points
setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export.
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RF Measurements
Overview
The displays in RF Measurements (Displays > Measurements > RF Measurements) are:

• CCDF
• Channel Power and ACPR
• Frequency and Phase Settling Time (Option SVT)
• MCPR
• Occupied Bandwidth
• Spurious

The RF Measurements power measurements and signal statistics help you characterize components and systems.

Power Measurements

Measurement Description

Channel Power The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.

Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power in adjacent
channels.

Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted signal
(located in the CCDF display).

CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much time a signal
spends at or above a given power level relative to the average power of a measured signal.

Channel Power and ACPR (Adjacent Channel Power Ratio) Display
Use the Channel Power and ACPR measurement to measure channel power by itself, or adjacent channel leakage ratio with one main
channel.
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Measuring Adjacent Channel Power Ratio
1. Select the Displays button.
2. Select RF Measurements from the Measurements box.
3. Double-click Chan Power and ACPR in the Available displays box. Click OK to complete your selection.
4. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to that of your main channel.

5. Select the Freq & RBW tab and adjust the frequency to that of your main channel. You can also change the frequency from the Status
bar found at the bottom left side of the display.

6. To set the number of adjacent channels, select the Channels tab. Enter the number of channels in the Number of adjacent pairs
value box. If zero is entered for the number of adjacent pairs, the resultant measurement will be channel power only.

Note: As you add adjacent channels, the span of the display is adjusted so that all the channels can be seen. Use the
horizontal scale and offset to zoom the display in on any portion of the trace.

7. To set the spacing between channel centers, enter the required value in the Channel Spacing value box.
8. To set the channel bandwidth, enter the required value in the Channel Bandwidth value box.
9. After you have configured the channel settings, click the close button in the Settings panel or press Settings again to remove the

Settings panel.

Viewing Results
Measurement results are displayed in a table below the graph and within the graph itself (which can be enabled/disabled in the Settings
> Prefs tab). To see all measurements, you might need to scroll the table. The size of the results table can be changed by dragging the
horizontal divider bar between the graph and table areas.
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Heading Description

Channel Identifies the displayed channels. A1 means the first adjacent channel. A2 means second adjacent
channel. Adjacent channels are numbered according to their offset from the Main channel. The
closest channel is numbered 1. The next closest channel is numbered 2; and so forth.

Lower The power measured for the lower adjacent channel. Adjacent channel power measurements are
displayed in dB relative to the Main channel.

Upper The power measured for the upper adjacent channel. Adjacent channels power measurements are
displayed in dB relative to the Main channel.

Avg Channel Power (Main) The power measured for the Main channel. The detection type used for measuring channel power and
adjacent channel powers is Average. This means that the average of the linear (pre-log) samples is
used to determine the power. The Main channel power is displayed in dBm.

Setting Channel Power and ACPR Settings Parameters

RF Channel Power Measurement
The RF channel power gives an indication of the total average (and other measures) RF power in a given channel.

For some communications systems, there is an “out-of-service” total power measurement defined in the specifications that calls for a
specified constant modulation. In this case, the output power should be relatively constant. For many measurements, this may not be the
case, and the Power Measurement results will vary as the signal varies.

Average power is the square root of the sum of the squares of the voltage samples over the measurement time.

The defined “channel” width for the Power Measurement defines the bandwidth and shape of the filter used to remove any RF power on
frequencies outside of the channel bandwidth.

Channel Power
The total RF power in the selected frequency band. The detection type used for measuring channel power is Average. This means that the
average of the linear (pre-log) samples is used to determine the channel power. To measure channel power, use the ACLR measurement,
and set the number of adjacent channels to zero. This results in only the channel power being measured.

Average Channel Power
The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Leakage Power Ratio
Adjacent Channel Leakage power Ratio (ACLR) is the ratio of the mean power centered on the assigned channel frequency to the mean
power centered on an adjacent channel frequency. In the 3GPP specification, both the main channel and adjacent channels are required to
be filtered with RRC (Root Raised Cosine) filters.

Adjacent Channel Power
Measure of the signal power leaking into nearby channels.

Channel Power and ACPR Settings
Main menu bar: Setup > Settings 
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The settings for the Channel Power and ACPR display are shown in the following table.

Settings tab Description

Freq & RBW Specify the frequency and resolution bandwidth used for the ACPR measurement.

Measurement Params Specify several parameters that control the measurement, such as channel filter, chip rate, averaging,
and correcting for noise floor.

Channels (ACPR) This tab specifies the BW and offset parameters of the Channels for the selected ACPR
measurement.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether certain display elements are visible.

Restore defaults. Sets parameters for a 1-channel WCDMA measurement.

Channels Tab for ACPR
The Channels tab is where you specify parameters for the channels measured in the ACPR display.

Setting Description

Number of adjacent pairs Specifies the number of adjacent channel pairs. Range: 1 - 50; Resolution 1.

Channel Bandwidth The maximum channel bandwidth is limited to approximately the maximum acquisition bandwidth of
the instrument, ranging from 25 MHz to 165 MHz depending on the option installed.

Channel Spacing Specifies the difference in frequency between the centers of each channel.

The following figure illustrates the settings controlled from the Channels tab.
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Changing the Number of Adjacent Pairs
1. Select Number of adjacent pairs number entry box.
2. Enter a value for the number of adjacent pairs using the knob or the keypad.

Note: As you change the value for the number of adjacent pairs, the analyzer will update the spectrum display to identify the
adjacent channels.

3. Select the Close box when you have finished making changes.

Changing the Channel Bandwidth
1. Select the Channel Bandwidth number entry box.
2. Enter a value for the number of adjacent pairs using the knob or the keypad.

Note: As you change the value for the number of adjacent pairs, the analyzer will update the display to indicate the channel
bandwidth.

3. Select the Close box when you have finished making changes.

Channel Spacing
1. Select Channel Spacing number entry box.
2. Enter a value for the difference in center frequency between channels using the knob or the keypad.

Note: As you change the value for the number of adjacent pairs, the analyzer will update the display to indicate the channel
bandwidth.

3. Select Close when you have finished making changes.

Signal Strength Display
Use the Signal Strength display to measure signal strength (channel power and peak channel power).
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Measuring channel power and field strength
1. Select the Displays button.
2. Select RF Measurements from the Measurements box.
3. Double-click Signal Strength in the Available displays box. Click OK to complete your selection.
4. Tune the analyzer to the channel. To do this, you can enter the frequency directly into the Frequency field on the Basic Toolbar (see the

bottom of the above image), or you can use the Select Channel button on the Channel Navigation toolbar.
5. Press the Run button to take the measurements. If you are using a data acquisition file, click Replay.
6. If you are measuring a signal with a directional antenna, select the Audio check box located above the graph, on the left side.

When Audio is checked, the analyzer sounds a tone that varies in frequency with the channel power. If you change the direction of the
antenna and the channel power drops, the frequency of the audio tone will also drop. If the channel power increases, the audio tone
frequency will also increase.

As channel power changes, the vertical channel power bar graph located on the far right side of the measurement display will rise and
fall with the channel power.

Viewing Results
Measurement results are displayed below the graph and within the graph itself (the latter of which can be enabled/disabled in the Signal
Strength Settings > Prefs tab).

Figure 39: Results for Signal Strength measurement

Heading Description

Channel Power (Main) The integrated power measured for the Main channel.

Peak Channel Power (Main) The maximum integrated power measured for the Main channel.
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Signal Strength Settings on page 155

Signal Strength Settings
Menu Bar: Setup > Settings 

The settings for the Signal Strength display are shown in the following table.

Settings tab Description

Freq & RBW Specify the frequency and resolution bandwidth used for the signal strength measurements.

Measurement Params Specify several parameters that control the measurement, averaging. External amplitude corrections,
and display units.

Channels This tab specifies the BW

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies trace points, trace detection, and visible display elements ( graticule, marker readouts, etc )
for the Signal Strength measurement display.

Freq & RBW Tab for Signal Strength display
The Freq & RBW tab specifies frequency parameters for the signal strength measurements.

Setting Description

Meas Freq Specifies the center/measurement frequency.

Step The Step control sets the increment/decrement size for the knob adjustment of the center frequency.
Arrow key adjustment of frequency is also affected (it is 10x the knob adjustment). If Auto is enabled,
the signal analyzer will adjust the Step size as required.

Table continued…

RF Measurements

RSA5100B Series Real-Time Signal Analyzers Help 155



Setting Description

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is Independent of
the Spectrum view's RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = 10 times the current RBW value. VBW
Minimum = 1/10,000 RBW setting.

Note: While the center frequency and step settings on this control tab are shared between ACPR, MCPR and Occupied
Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the effect of noise on
the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is 1/10,000 of the RBW setting.

Measurement Params Tab for Signal Strength display
The Measurement Params tab is where you set parameters that control the Signal Strength measurement.

Parameter Description

Average Enables/disables measurement averaging. Averaging can be enabled in either the Frequency
Domain or Time Domain.

Frequency domain This setting takes the average linear value of the traces (so that rms values are preserved). The
number of averages is user-defined. Frequency domain averaging is available in spans larger
(or smaller) than the maximum real time bandwidth. This is the mode to use unless you need to
extract maximum dynamic range from an ACPR measurement.

Time domain This setting takes the average linear value of the traces. It is useful if you need to extract
maximum dynamic range from an ACPR measurement. The number of traces is user defined.
But, the signals must be triggered and repeating. That is, the signal needs to be exactly the same
for each acquisition. When this condition is met, each waveform contains the same signal, but the
random noise changes from acquisition to acquisition and the average value of the random noise
is lowered, while the signal value remains constant. Time domain averaging is not available in
spans wider than the maximum real-time bandwidth.

Off This setting turns averaging off.

Number Specifies the number of acquisitions to be averaged when Averaging is set to Frequency Domain.
Specifies the number of successive capture records that are averaged when Averaging is set to
Time Domain.

Amplitude Units Opens the Units Tab on page 647 dialog box.

Ext Corrections Opens the External Gain/Loss Correction dialog box.
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Correct for noise floor
When this setting is enabled, the instrument applies a correction to the ACPR or MCPR measurement to reduce the effect of instrument
noise on the results. It generates this correction by taking a preliminary acquisition to measure the instrument noise floor. Once this
is done, the measurement proceeds, applying the correction to each result. When any relevant settings (reference level, attenuator,
frequency, or span) are changed, the instrument performs a new noise measurement and correction.

The noise correction signal is created by switching off the input to the RTSA and performing acquisitions of the instrument internal noise.
A minimum of 100 acquisitions are averaged to create the noise reference signal. It is possible to increase the number of acquisitions
for creation of the noise reference signal. When frequency domain averaging is enabled and the number of averages exceeds 100, the
number of frequency domain averages becomes the total number of acquisitions to determine the instrument internal noise. Noise is
measured for each channel defined by the measurement. The noise reference from each channel is subtracted from the incoming signal
power for each channel to create the corrected result. All calculations are performed in Watts, and then converted to the desired units.

The amount of noise correction is limited to 12 dB to avoid the possibility of a negative power measurement. This is a rare condition that
could occur if the subtraction of the reference power from the channel power results in a negative value (or'infinite' dBm).

The measured values differ from the displayed trace in two ways. First, any filtering applied to the channels is not displayed on the trace.
Second, the single value of measured noise for a channel is subtracted from each trace point in the channel, rather than offsetting the
entire channel by a single amount. This produces a smooth trace with no discontinuities at the channel edges.

Channels Tab for Signal Strength display
The Channels tab is where you specify the channel bandwidth measured in the Signal Strength display.

Changing the Channel Bandwidth
1. Select the Channel Bandwidth number entry box.
2. Enter a value for the channel bandwidth.
3. Select the Close box when you have finished making changes.

Scale Tab for Signal Strength display
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Center Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Table continued…
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Setting Description

Scale Changes the vertical scale units. This is only accessible when the vertical units are set to dBm.

Autoscale Automatically scales the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Autoscale Automatically scales the horizontal axis to optimize the display of the trace.

Reset scale Resets all settings to their default values.

Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters include enabling/disabling Marker Readout,
switching the Graticule display on/off, and trace points and detection.

Setting Description

Trace Points Sets the number of trace points computed for each line. These are the points used for marker
measurements and for results export.

Show graticule Shows or hides the graticule.

Trace Detection +Peak: Shows the peak power in a bin (of chosen RBW) if there are multiple points to choose from
within a bin.

Avg (VRMS): Shows the average power in a bin (of chosen RBW) if there are multiple points to
choose from within a bin.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

MCPR (Multiple Carrier Power Ratio) Display
Use the MCPR measurement to measure adjacent channel power ratio for multiple main channels or when adjacent channel pairs have
different offsets and/or bandwidths. The MCPR display show the Reference Power and the ratio of each adjacent channel to the Reference
Power. You can select whether the Reference Power is the total of all active channels or a single channel.
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Measuring Multiple Carrier Power Ratio
1. Press the front-panel Displays button.
2. From the Select Displays window, select RF Measurements or P25 Analysis from the Measurements box.
3. Double-click the MCPR icon in the Available displays box. Click OK to complete your selection.
4. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to that of the main channel. Select

Meas. Freq to set the measurement frequency. Use the front panel knob to adjust the frequency.

5. Select the Freq & RBW tab and adjust the frequency to that of the main channel. You can also adjust the frequency on the Status
bar using the Frequency field on the bottom left of the display.

6. Click on the Channels tab. To set the number of Main channels, enter the number of Main channels in the Number text entry box
under Main Channels.

Note: As you add channels, the span of the display will be adjusted so that all the channels can be seen.

7. To set the bandwidth of all main channels, enter a value in the BW value box.
8. To set the spacing between the main channels, enter a value in the Spacing value box.
9. To prevent a main channel power level from being included in the Power Reference (Total) calculation, select the channel to be

excluded in the Inactive box.
10. To add adjacent channels, click the Add button under Adj Chans.

11. To edit Frequency Offset or Bandwidth, click within the value box and use the front-panel knob or your keyboard to set the value.
Click Close to save your changes.

Note: Frequency Offset is the difference between the center frequency of the selected channel and the Measurement
Frequency. All channels (Main or Adjacent) are specified by their offset from the Measurement Frequency.

12. To enable and define power limits, check the Enable Power Limits box and enter the desired Upper and Lower limits. You can read
more about power limits here.
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13. After you have configured the Main and Adjacent channels, click the close button in the Settings panel or the Settings button to
remove the settings panel.

14. Click the Run button to take the measurements. Click the Replay button if you are using a recalled acquisition data file.

Viewing Results
MCPR measurement results are displayed both in the spectrum graph and in a table below the spectrum display. Individual Main channel
power measurements appear in the graph under their channel identifiers. Individual adjacent channel power ratios also appear in the graph
under the adjacent channel identifier.

The following table details the entries in the results table.
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Heading Description

Ch Identifies the adjacent channels. Adjacent channels are numbered according to their offset from the
Main channel. The closest channel is numbered 1. The next closet channel is numbered 2; and so
forth. The prefix “L” means lower; “U” means upper.

Offset The offset is the difference in frequency between the Measurement Frequency and the center
frequency of the channel.

Lower Displays the ratio of the lower adjacent channel power to the Power Reference.

Upper Displays the ratio of the upper adjacent channel power to the Power Reference.

L. Limit Displays the lower power limit.

U. Limit Displays the upper power limit.

Power Reference Depending on the selected Power Ref, this readout displays either the power of the selected main
channel or the total power in the active main channels.

Depending on the number of adjacent channels, to see all the measurements, you might need to drag the divider bar between the main
display and the results table at the bottom of the window to change the height of the results table.

Setting MCPR Measurement Parameters

Setting Power Limits
When power limits are enabled (Settings > Channels > Add or Settings > Channels > Edit), the comparison of the actual results of an
adjacent channel is done against the limits. If there is a failure, the Lower and Upper power cells in the MCPR table will be red and the
failure segments of the trace display will be red. The words Fail in red will also appear in the top left corner of the display (even if one
adjacent band fails). See the following image for an example.
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Multiple Carrier Power Ratio
The ratio of the signal power in an adjacent channel to the power in one or more main channels.

MCPR Settings
Main menu bar: Setup > Settings 

The Setup control panel tabs for MCPR (Multiple Carrier Power Ratio) are:

Settings tab Description

Freq & RBW Specify the frequency and resolution bandwidth used for the MCPR measurements.

Measurement Params Specifies parameters controlling how the MCPR measurement is made.

Channels Specifies the parameters of the channels to be measured.

Scale Specifies the vertical and horizontal scale and offset values.

Table continued…
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Settings tab Description

Prefs Specifies whether or not certain display elements are shown.

Restore defaults. Sets parameters for a 4-carrier WCDMA measurement.

Freq & RBW Tab for ACPR and MCPR Displays
The Freq & RBW tab specifies frequency parameters for the Channel Power & ACPR measurements and MCPR measurement.

Setting Description

Meas Freq Specifies the center/measurement frequency.

Step The Step control sets the increment/decrement size for the knob adjustment of the center frequency.
Arrow key adjustment of frequency is also affected (it is 10x the knob adjustment). If Auto is enabled,
the signal analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is Independent of
the Spectrum view's RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = 10 times the current RBW value. VBW
Minimum = 1/10,000 RBW setting.

Note: While the center frequency and step settings on this control tab are shared between ACPR, MCPR and Occupied
Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the effect of noise on
the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is 1/10,000 of the RBW setting.

Measurement Params for ACPR and MCPR Displays
The Measurement Params tab is where you set parameters that control the ACPR and MCPR measurements.
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Parameter Description

Average Enables/disables measurement averaging. Averaging can be enabled in either the Frequency
Domain or Time Domain.

Frequency-domain This setting takes the average linear value of the traces (so that rms values are preserved). The
number of averages is user-defined. Frequency domain averaging is available in spans larger
(or smaller) than the maximum real time bandwidth. This is the mode to use unless you need to
extract maximum dynamic range from an ACPR measurement.

Time-domain This setting takes the average linear value of the traces. It is useful if you need to extract
maximum dynamic range from an ACPR measurement. The number of traces is user defined.
But, the signals must be triggered and repeating. That is, the signal needs to be exactly the same
for each acquisition. When this condition is met, each waveform contains the same signal, but the
random noise changes from acquisition to acquisition and the average value of the random noise
is lowered, while the signal value remains constant. Time domain averaging is not available in
spans wider than the maximum real-time bandwidth.

Number Specifies the number of acquisitions to be averaged when Averaging is set to Frequency Domain.
Specifies the number of successive capture records that are averaged when Averaging is set to
Time Domain.

Correct for Noise Floor Enables/disables the Noise Floor Correction function.

Power Reference Specifies power against which the results are compared. Choices available are each of the
existing main channels and “Total (active channels”.

Only present when MCPR is the selected display.

Channel Filter Specify the channel filter used. Select between None (default) and Root-raised Cosine.

Filter Parameter Value entry box for the Root-raised Cosine filter Adjacent Channel Filter.

Present only when the Channel Filter is set to Root-raised Cosine.

Chip Rate Value entry box for the Root-raised Cosine chip rate.

Present only when the Channel Filter is set to Root-raised Cosine.
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Correct for Noise Floor
When this setting is enabled, the instrument applies a correction to the ACPR or MCPR measurement to reduce the effect of instrument
noise on the results. It generates this correction by taking a preliminary acquisition to measure the instrument noise floor. Once this
is done, the measurement proceeds, applying the correction to each result. When any relevant settings (reference level, attenuator,
frequency, or span) are changed, the instrument performs a new noise measurement and correction.

The noise correction signal is created by switching off the input to the RTSA and performing acquisitions of the instrument internal noise.
A minimum of 100 acquisitions are averaged to create the noise reference signal. It is possible to increase the number of acquisitions
for creation of the noise reference signal. When frequency domain averaging is enabled and the number of averages exceeds 100, the
number of frequency domain averages becomes the total number of acquisitions to determine the instrument internal noise. Noise is
measured for each channel defined by the measurement. The noise reference from each channel is subtracted from the incoming signal
power for each channel to create the corrected result. All calculations are performed in Watts, and then converted to the desired units.

The amount of noise correction is limited to 12 dB to avoid the possibility of a negative power measurement. This is a rare condition that
could occur if the subtraction of the reference power from the channel power results in a negative value (or ‘infinite’ dBm).   

The measured values differ from the displayed trace in two ways. First, any filtering applied to the channels is not displayed on the
trace. Second, the single value of measured noise for a channel is subtracted from each trace point in the channel, rather than offsetting
the entire channel by a single amount. This produces a smooth trace with no discontinuities at the channel edges.

Channels Tab for MCPR
Main menu bar: Setup > Settings > Channels 

The Channels tab is where you specify the parameters for the channels measured in the MCPR display.

Setting Description

Main Channels

Number Sets the number of Main channels.

BW Maximum channel bandwidth is limited to approximately the maximum acquisition bandwidth of the
instrument, ranging from 25 MHz to 165 MHz depending on the option installed.

Spacing Sets the frequency difference between the centers of the Main channels.

Inactive Selected channels are ignored by the measurement routine.

Adj Chans

Add Opens the Edit Channel Parameters dialog, which you use to specify the parameters of a new pair of
adjacent channels. You can add up to 50 adjacent channel pairs.

Table continued…
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Setting Description

Edit Opens the Edit Channel Parameters dialog box. (You must first select a channel to enable the Edit
button.)

Delete Deletes the selected main channel or adjacent channel pair.

Channel Definition table A table of the parameters for every channel. Offset is the frequency difference between the Center
Frequency and center of the selected channel. Nothing in the table is editable directly. You can set the
upper and lower limits by clicking on the Add button.

The following figure illustrates the settings controlled from the Channels tab.

Editing Channel Parameters
To edit the offset or bandwidth of a Main channel:

1. Select the value in the BW or Spacing number entry boxes.
2. Adjust the value as required. All the Main channels share the same BW and Spacing.
3. Select the appropriate check box to make a channel Inactive, as appropriate.
4. Click the Close button when you have finished making changes.

To edit the offset or bandwidth of an Adjacent channel:

1. Select the channel to be edited in the channel definition table.
2. Select Edit. This displays the Edit Channel Parameters dialog box.
3. Adjust the values for the Frequency Offset, Bandwidth, and upper and lower Limits, as required.
4. Click the Close button when you have finished making changes.

Adding Channels
To add a main channel:

1. Select the Number entry box.
2. Use the knob to enter a value for the desired number of Main channels.
3. Click the Close button when you have finished making changes.

To add an adjacent channel pair:

1. Select Add. This displays the Edit Channel Parameters dialog box.
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2. Use the knob to enter values for the Frequency Offset, Bandwidth, and upper and lower Limits, as required. The Frequency Offset is
measured from the Meas Frequency of the Main channels.

3. Click the Close button when you have finished making changes.

Deleting Channels
To delete a main channel:

1. Select the Number entry box.
2. Use the knob to reduce the number of channels or enter a new value using the front-panel keypad.
3. Click the Close button when you have finished making changes.

To delete an adjacent channel:

1. Select the channel to be deleted in the channel definition table.
2. Select Delete. This removes the selected channel from the channel table.
3. Click the Close button when you have finished making changes.

Occupied BW & x dB BW Display
The Occupied BW display shows the bandwidth within which 99% (a user-defined value, the default is 99%) of the power transmitted within
the measurement bandwidth falls.

To show the Occupied BW display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select RF Measurements in the Measurements box.
3. In the Available displays box, double-click the Occupied Bandwidth icon or select the icon and click Add. The Occupied Bandwidth

icon will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to display the Occupied Bandwidth.

Elements of the Display
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Item Display element Description

1 Check mark indicator The check mark indicator denotes the display for which the acquisition hardware is
optimized. This indictor appears only when the display is the selected display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Averaging readout Appears when averaging is enabled (Settings > Parameters tab > Average results).
Displays "Avg: n of m" while averaging the results and "Avg: m" once the requested
number of results have been averaged.

3 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

4 Trace function readout Displays either Normal or MaxHold to indicate trace function.

5 Clear Resets count for Average and MaxHold functions. Enabled only when Averaging or
MaxHold is enabled. Pressing Clear will clear the trace and, if acquisition is running,
restart the averaging or hold process.

6 Graph Displays the input signal. Shaded areas indicate the measurement bandwidth (Settings >
Parameters tab > Measurement BW).

7 Blue lines The blue lines indicate where the selected results (selected in the Main results area) are
being measured on the trace.

8 Grid divider Determines the portion of the display allocated to the graph and detailed results area. You
can move the grid divider all the way to the top or bottom and any position in between.

9 Detailed results area Displays additional measurements results.

10 Position and dB/div

Units (not shown)

Position sets the top of graph value. The dB/div setting is the vertical scale value.

Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

11 Main results area Displays results for Occupied Bandwidth (OBW) and x dB bandwidth. Use the two radio
buttons to select which of the two results are illustrated in the graph with the blue lines and
arrows. There are also controls for adjusting OBW % Power, x dB BW, and RBW.

12 VBW Enables the VBW (Video Bandwidth) filter. Displays current VBW filter setting. See Setup
> Settings > Freq & RBW tab.

Detailed Results Readouts

Measurement Description

Freq Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the analyzer.

Table continued…
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Measurement Description

OBW Level left The signal level at the left edge of the occupied bandwidth.

OBW Level right The signal level at the right edge of the occupied bandwidth.

OBW Ref Power The total power measured within the measurement bandwidth.

x dB BW Ref Power The peak power measured within the measurement bandwidth.

Changing the Occupied Bandwidth Settings

Occupied Bandwidth
Bandwidth within which some defined percentage of the power transmitted on a single channel lies.

Occupied BW & x dB BW Settings
Main menu bar: Setup > Settings 

The control panel tabs for the Occupied Bandwidth display are shown in the following table.

Settings tab Description

Freq & RBW Allows you to specify the Center Frequency, Step size and RBW.

Parameters Allows you to specify the Occupied BW % Power, x dB level, Measurement BW, enable averaging and
the Max Hold function.

Scale Allows you to set the vertical and horizontal scale parameters.

Prefs The Prefs tab enables you to set characteristics of the measurement display.

Parameters Tab
The Parameters tab enables you to specify parameters that control the Occupied BW measurement.

Setting Description

Occupied BW % Power Specifies the proportion of power within the occupied bandwidth (referenced against the total power in
the measurement bandwidth).

Table continued…
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Setting Description

x dB level x dB level defines the x dB BW level search threshold.

Measurement BW Specifies the frequency range used by the measurement.

Max Hold spectral data Enables the Max Hold function.

Average results Enables/disables results averaging. Note that this is not an averaging of the trace, but an averaging of
the results.

Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to 10,000.

x dB Level
The x dB level determines the x dB BW. The instrument analyzes the spectrum trace to locate the frequencies at which the level is x dB
down from the peak level calculated over the measurement bandwidth. The frequency difference between the upper and lower crossing
thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -26 dB

Max Hold Spectral Data
Max Hold displays the maximum value in the acquisition record for each display point. Each new trace display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

Spurious display
To show the Spurious display:

1. Click the Displays button or select Setup > Displays.
2. From the Measurements box, select RF Measurements.
3. Double-click the Spurious icon in the Available displays box. This adds the Spurious icon to the Selected displays box (and

removes it from the Available displays box). Alternatively, you can click the Spurious icon and then click the Add button to select
Spurious for display.

4. Click the OK button.
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Elements of the Spurious Display

Item Display element Description

1 Check mark indicator Indicates the display for which the acquisition hardware is optimized.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Vert Position Sets the top of graph value. This is only a visual control for panning the graph. The
Reference Level is adjusted in the Toolbar and the Ampl control panel. By default, Vert
Position = Ref Level.

3 Units Sets the global Amplitude units for all the views in the analysis window. This will change
the Amplitude selection in the Units tab of Analysis Control panel.

4 dB/ div Sets the vertical scale value. The maximum value is 20.00 dB/division.

5 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

6 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen. Selects
Multi-range display mode.

7 Start Adjusts the graph start frequency. This setting affects only visual scaling, not
measurement parameters.

Table continued…
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Item Display element Description

8 Green bar Indicates the range that is selected on the Settings > Ranges and Settings > Limits tabs.

9 Spur table Displays spur measurements. See the following table for details.

10 Stop Adjusts the graph stop frequency. This setting affects only visual scaling, not measurement
parameters.

11 Clear Restarts multi-trace functions (Average, Max Hold).

12 Trace function Indicates the trace processing method. If Average or Max Hold is selected, this readout
displays the number of traces being processed (averaged or compared for the Max Hold
value).

13 Show Controls whether the selected trace is visible or not. When trace is Off, the box is not
checked.

14 Trace Selects a trace. Clicking here pops up a context menu listing the available traces, whether
they are enabled or not. If you select a trace that is not currently enabled, it will be made
enabled.

15 Ref: If enabled, displays the power reference level.

16 Pass / Fail readout Indicates whether one or more spurs have exceeded a limit specified on the Settings >
Limits tab.

Elements of the Spurious Graph Display

Item Display element Description

1 The green line or shading indicates an Abs (absolute) limit. The absolute limit is enabled
when the mask is set to Abs, Abs & Rel, or Abs OR Rel. Note that absolute and relative
amplitude masks can overlap.

2 The gray-shaded area indicates a portion of the spectrum where no measurements are
being taken.

Table continued…
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Item Display element Description

3 The cyan line or shading indicates a Relative limit. The relative limit is enabled when the
mask is set to Rel, Abs & Rel, or Abs OR Rel. Note that absolute and relative amplitude
masks can overlap.

4 abs rel Reminder that green-shaded areas highlight absolute limits and cyan-shaded areas
highlight relative limits.

5 This indicates the selected spur, when it is in violation of the limits. In Run mode, this is the
peak spur violation. The selected marker is highlighted in the Spur table below the graph
with a blue background.

6 A spur marker. Indicates a spur that does not exceed the mask settings. See the Settings
> Ranges and Limits tab.

7 A violation marker. Indicates a spur that exceeds the mask settings. See the Settings >
Ranges and Limits tab.

- - Indicates the selected spur when it is not in violation of the limits. The selected marker is
highlighted in the Spur table below the graph with a blue background.

8 1, 2, 3... A Spur number. The number indicates the row in the spur table that corresponds to the
spur. The instrument can display up to 999 spurs.

9 A, B, C, D... Identifies the enabled ranges.

10 Green bar Indicates the range selected on the Settings > Ranges and Limits tab tab.

11 Ref Indicates the location of the power reference. See Settings > Reference.

Elements of the Spur Table

Column Description

Spur A number that identifies a spur in the graph area. The instrument can display a maximum of
999 spurs.

Range The letter representing the frequency range where the spur is located.

Freq Abs The absolute frequency at which the spur occurs.

Table continued…
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Column Description

Freq Rel The relative frequency at which the spur occurs. The relative frequency is the difference between the
absolute frequency (absolute) and the carrier frequency.

Ampl Abs The absolute amplitude of the spur.

Ampl Rel The relative amplitude at which the spur occurs. The relative amplitude is the difference between the
absolute amplitude and the carrier amplitude. See the Settings > Limits tab.

Lim Abs The value of the absolute amplitude limit at the spur frequency. This value can vary even with small
spur frequency changes if the start and stop limit values are different. See the Settings > Ranges and
Limits tab.

Lim Rel The relative amplitude limit at which the spur occurs. This value can vary even with small spur
frequency changes if the start and stop relative amplitude limit values are different. See the Settings >
Ranges and Limits tab.

Blue background The cell in the Spur column with a blue background identifies the selected spur.

Red background Cells in the Spur column with a red background identify violations.

Cells in the results area with a red background identify the measurement that exceeded a limit.

Rearranging the Columns in the Spur Table
You can rearrange the order of the columns in the Spur Table. To move a column, click on the column heading and drag it to the desired
position.

Sorting the Rows in the Spur Table
You can sort the rows in the Spur table by clicking on the column heading. For example, if you click on the Freq Abs heading, the results
in the Spur table will be sorted by frequency. If you click on Range, the rows will be sorted by range. Clicking a second time on the same
heading reverses the order.

Changing the Spurious Display Settings

Spurious display settings
Main menu bar: Setup > Settings 

The control panel tabs for the Spurious display are shown in the following table.

Settings tab Description

Parameters Specifies whether the graph displays one range or multiple ranges. Specifies whether all spurs are
shown or only spurs over specified limits.

Reference Specifies the Power Reference level.

Table continued…
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Settings tab Description

Ranges Specifies start and stop frequencies of ranges and which ranges to take measurements in. Sets
parameters that define a spur. Review, save and load the Range table from this tab.

Limits Specifies Pass/Fail limit parameters.

Traces Specifies the trace Function.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies the appearance features of the graph area.

Restore defaults. Sets the Spurious parameters to their default values.

Parameters Tab
The Parameters tab enables you to specify settings that control the Spurious measurement.

Setting Description

Frequency Ranges

Multi Enables the instrument to display all enabled ranges in the graph.

Single Limits the graph to the display of only one range. The displayed range is set to the range that contains
the selected spur.

List Spurs

All spurs Displays any spur that exceeds the Threshold and Excursion values set on the Ranges tab.

Over Limit Displays only spurs that exceed both the Threshold and Excursion values set on the Ranges tab and
the limits specified on the Limits tab.

Reference Tab
The Reference tab enables you to specify the Power Reference parameter. The Power reference parameter is used to calculate relative
values in the Spur table and to calculate relative amplitude limits.
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Setting Description

Power Reference Specifies the power reference level used for relative values and limits.

No reference Power level readings are calculated only for absolute values, no relative values are calculated.

Manual level The reference level for relative measurements is specified by the Reference power level setting.

Carrier The reference level for relative measurements is based on the power level calculated at the specified
carrier frequency.

Setting the Power Reference Level to No Reference

To set the power reference to No Reference:

• Select No reference from the Power reference drop-down list.

Setting the Power Reference Level to Manual Level

To set the power reference to manual level:

1. Select Manual level from the Power reference drop-down list. This displays the Reference power level entry box.
2. Specify the desired power level in the Reference power level entry box.
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Setting the Power Reference Level to Carrier

To set the power reference to Carrier:

1. Select Carrier from the Power reference drop-down list.
2. To set the Carrier frequency, specify the necessary values in the Frequency and Channel width entry boxes .
3. Specify the Threshold level.
4. Specify the Integration BW. The Integration BW is the bandwidth over which the carrier is measured.
5. If necessary, specify the Resolution Bandwidth by changing the value in the Res BW entry box. Auto is the recommended setting.
6. Set the Detection method. Select +Peak, Avg (VRMS), or Avg (of logs).

Note: If the power level measured over the Integration BW about the carrier frequency is below the threshold level, the
instrument concludes that no carrier is present and no relative measurements will be taken. Absolute measurements will still
be taken.

Ranges and Limits Tab
Use the Ranges and Limits tab to specify the parameters that control the Spurious measurement. From the Ranges and Limits tab, you
specify the start and stop frequencies for ranges, whether or not a range is enabled, the parameters that specify what constitutes a spur,
measurement filter shape and bandwidth, and the detection method used for processing signals, as well as the pass/fail parameters for
limit testing.

Setting Description

Expand Displays the Ranges and Limits Table in a new, resizeable window.

Reset layout You can reorder columns in the Ranges and Limits Table by dragging the columns to a new position.
Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Ranges and Limits table from a file. The default directory is the last folder to
which you saved an Acq data export (.CSV)” file.

Save Click to save the current Ranges and Limits table to a file. The default directory is the last folder to
which you saved an Acq data export (.CSV)” file.

To specify the ranges and limits for the Spurious measurement:
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• Edit the values in the Ranges and Limits table.

You can edit the Ranges and Limits table in two ways:

• Edit values directly from the Ranges and Limits tab. You will need to scroll the table to access all settings.
• Click the Expand button. This displays the Ranges and Limits Table in a new window that can be sized to the full screen.

The following table describes the parameters that are set in the Ranges and Limits Table.

Table 10: Ranges and Limits Table Settings

Setting Description

On Specifies whether or not measurements are taken in the specified range.

Start (Hz) Readout of the start frequency for the selected range.

Stop (Hz) Readout of the stop frequency for the selected range.

Filter shape Specifies the filter shape used for the Spurious measurement.

BW (Hz) Specifies the bandwidth used for the selected filter shape.

Auto Sets the BW automatically. If CISPR is selected for Filter shape, this control is disabled.

Detector For CISPR detectors, this selection enables calculation as per the methods described in the CISPR
documents. Supported CISPR detectors include CISPR Pk, CISPR QPk,

and CISPR Avg.

For non-CISPR detectors, this selection indicates the processing method used for compressing
excess intermediate data into the desired number of trace points.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: 10 times RBW current value; VBW
Minimum: 1/10,000 RBW setting. Disabled when Filter shape is set to CISPR.

VBW On Specifies whether the VBW filter is applied.

Table continued…
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Setting Description

Thrshld (dBm) Threshold specifies the level that must be exceeded for a signal peak to be recognized as a spur. A
signal peak must also exceed the Excursion setting to be considered a spur.

Excrsn (dB) Excursion specifies the peak to peak magnitude that must be exceeded for a signal peak to be
recognized as a spur. A signal transition must also exceed the Threshold setting to be considered a
spur.

Mask Selects the type of limits used for Pass/Fail testing. Spurs that exceed the mask settings are
considered violations. The available choices are shown below.

Abs Spurs that exceed the Absolute limits settings are identified as violations.

Rel Spurs that exceed the Relative limits settings are identified as violations.

Abs & Rel Spurs that exceed both the Absolute and Relative limits settings are identified as violations.

Abs OR Rel Spurs that exceed either the Absolute or Relative limits settings are identified as violations.

Off Turns off limit testing for the selecting range. Measurements are still taken in the range, but violations
are not flagged. Signal peaks that exceed the Threshold and Excursions values will still be identified
as spurs.

(Abs Start and Abs Stop) Absolute amplitude limits are not based on the measured carrier amplitude or manual reference. Start
and stop values can be different.

Abs Start (dBm) Abs Start specifies the limit at the start frequency of the range.

Abs Stop (dBm) Abs Stop specifies the limit at the stop frequency of the range.

Abs Same Sets the limit at the start and stop frequencies to the value set for the start frequency.

(Rel Start and Rel Stop) Relative amplitude limits are calculated from the Power Reference. If the Power Reference is set to
the Carrier level, the relative amplitude limits will change with the carrier level. Start and stop values
can be different.

Rel Start (dB) Specifies the limit at the start frequency of the range.

Rel Stop (dB) Specifies the limit at the stop frequency of the range.

Rel Same Sets the limit at the stop frequency to the value set for the start frequency.

Save As Click to save the current Ranges and Limits table to a file.

Load Click to load a saved Ranges and Limits table from a file.

Done Save changes and close the Ranges and Limits Table window.

Changing the Range Start and Stop Frequencies
To change the range start and stop frequencies, edit the Start and Stop frequencies in the Ranges and Limits Table:
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1. Click the Expand button on the Settings > Range and Limits tab. This displays the Ranges and Limits Table.
2. Click the On box for a range to take measurements in the range.
3. Click on the Start or Stop frequency setting to change it. Type in a number for the frequency and a letter as a multiplier. You can use k,

m, or g to set the frequency multiplier.
4. Click Done to save your changes.

Specifying Spur Requirements
A spur is a signal peak that exceeds both the Threshold and Excursion settings in the Ranges and Limits table. The Threshold and
Excursion settings are absolute values; they are not calculated relative to a reference. The Threshold and Excursion settings are specific
to the selected range. If you want to use different settings for spurs in different ranges, you have to set the values separately for each
range. The Excursion control is used to avoid interpreting a single spur as multiple narrower spurs by requiring the amplitude to drop by the
Excursion amount between spurs. Raising the Threshold value means that fewer, larger signals will be identified as spurs.

To specify the spur requirements for a range:

1. Click the Expand button on the Range and Limits tab. This displays the Ranges and Limits Table.
2. Select the Range (A–T) for which you want to specify the spur requirements.
3. Set the Thrshld value.
4. Set the Excrsn value.

Setting Limits
Use the Limits settings in the Ranges and Limits Table to specify the pass/fail parameters for the Spurious measurement. When the Mask
setting is set to any value except off, the instrument identifies any signal peak that exceeds the specified limits as a violation and displays
Fail on the screen. If no signal peak exceeds the limits, the instrument displays Pass on the screen.

Performing Pass/Fail Limit Testing
To set limits:

1. Click the Expand button on the Range and Limits tab. This displays the Ranges and Limits Table.
2. Adjust the Start and Stop frequencies as required for each range you want to test.
3. For ranges that you wish to test, verify that the On box is checked.
4. For each range you wish to test, select the desired Mask type from the drop-down list.
5. Set the limits as desired in the Abs Start, Abs Stop, Rel Start, and Rel Stop boxes. The values you can edit depend on the mask

type you select.
6. Verify that the Thrshld and Excrsn values are set as required. These are the values that define a spur.
7. Click Done to save your changes and close the Range and Limits Table window.
8. Click Run to begin testing.

CCDF Display
The CCDF (Complementary Cumulative Distribution Function) is a statistical characterization that plots power level on the x-axis and
probability on the y-axis of a graph. Each point on the CCDF curve shows what percentage of time a signal spends at or above a given
power level. The power level is expressed in dB relative to the average signal power level. The CCDF Display also shows the Average
power level and the Peak/Average ratio.

To show the CCDF display:

1. Recall an appropriate acquisition data file.

RF Measurements

RSA5100B Series Real-Time Signal Analyzers Help 180



2. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
3. From the Measurements box, select RF Measurements.
4. Double-click the CCDF icon in the Available Displays box. This adds the CCDF icon to the Selected displays box.
5. Click the OK button.
6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the CCDF Display

Item Display element Description

1 100% The top of the graph represents the 100% probability that the signal will be at or above the
average signal level.

2 Power level select Adjust to display the value of the CCDF curve at a specific power level. The selected
power level is indicated by a small triangle on the CCDF curve.

3 CCDF value Readout of the value of the CCDF curve at the selected power level.

4 Avg Readout of the Average power level and the CCDF value at the Average power level.

5 Readout Table Readout of the CCDF curve at six points.

6 Pk / Avg Readout of the Peak to Average power ratio.

7 Measurement time Readout of the length of time used for the measurement. Displays --- s when the
Measurement time is set to continuous.

Changing the CCDF Display Settings

CCDF Settings
Main menu bar: Setup > Settings 
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The control panel tabs for the CCDF Display are shown in the following table.

Settings tab Description

Parameters Specifies the time to be measured.

Traces Select the trace to be measured and select reference trace for display.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether on not certain display elements are shown.

Restore defaults. Sets the CCDF parameters to their default values.

Scale Tab
The Scale tab for the CCDF display allows you to change the start and stop points for the horizontal trace. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Center Frequency.

Setting Description

Rest Scale Resets all settings to their default values.

Horizontal Controls the span of the trace display and position of the trace.

Start Sets the starting range of the trace.

Stop Sets the end range of the trace.

Parameters Tab
The Parameters tab enables you to specify several parameters that control signal acquisition for the CCDF Display.
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Setting Description

Single When Single is selected, the CCDF measurement is based on the Analysis Time parameters set on
Analysis control panel (Setup > Analysis > Analysis Time), shared by all displays. In Single, CCDF is
time-correlated with the other open displays.

Total Time When Total Time is selected, you can adjust its value. The value set here changes the Analysis
Length (and Acquisition Length, if needed) to 20 msec. If the Total Time value is longer than the
Analysis Length, CCDF uses multiple acquisitions to collect signal data.

Continuous When Continuous is selected, the CCDF measurement combines each new record (Actual Analysis
Length) into the existing result. It does not erase and start over until user presses STOP or CLEAR.

Span Specifies the range of frequencies used for analysis.

Single
To have statistically meaningful results, CCDF works best when calculated on at least 1 ms of data. Depending on the Analysis Time
setting, the CCDF display may present error messages:

• If the Actual Analysis Time is greater than 1 ms, the CCDF Display will calculate the trace without any problems.
• If the Actual Analysis time is less than 1 ms, the CCDF Display will measure the data as best if can, but if it receives fewer than

20 samples, the CCDF display will clear the trace and report "Not enough samples".

Total Time
Setting the Measurement Time to Total Time changes the Analysis Length (and Acquisition Length, if needed) to 20 msec. This can impact
other measurements. For instance, the OBW measurement would change because it would get more analysis length than it normally
needs, so switching in/out of the CCDF Total Time selection noticeably affects OBW results. This happens to a lesser amount when
Measurement Time is set to Single or Continuous. This is because each sets Analysis Length to 1 msec. These different Analysis Lengths
may affect other measurements, too.

Phase Noise Display
Phase Noise measures and graphs the power in a 1 Hz bandwidth referenced to the carrier power. This is repeated for many frequency
points across a user-adjustable span.

To show the Phase Noise display:

1. Click the Displays button or select Setup > Displays.
2. From the Measurements box, select RF Measurements.
3. Double-click the Phase Noise icon in the Available displays box. This adds the Phase Noise icon to the Selected displays box (and

removes it from the Available displays box). Alternatively, you can click the Phase Noise icon and then click the Add button to select
Phase Noise for display, or drag the Phase Noise icon to the Selected Displays box.

4. Click the OK button.
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Elements of the Phase Noise Display

Item Display element Description

1 Check mark indicator Indicates the display for which the acquisition hardware is optimized.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Vert Position (dBc/Hz) Sets the top of graph value. This is only a visual control for panning the graph.

3 Trace selector Selects a trace.

4 Show check box Shows/hides the selected trace.

5 Detection method / Average
count

Displays the Detector method used for the trace. If Average detection is enabled, the
number of averaged traces appears here.

6 Measurement Marker readout Readout of the value of the phase noise at the selected offset. The Phase Noise
measurement marker does not affect the results reported in the readouts or table below
the graph, nor is it associated with markers in any other display.

7 Clear Restarts multi-trace function (Average).

8 Horizontal stop Readout of the Right Horizontal frequency value. This setting affects only visual scale, not
measurement bandwidth. (See Settings > Scale)

9 Measurement marker Indicates the position of the measurement point.

10 Integration frequency range
indicators

The gray-shaded areas denote the frequencies outside the integration frequency range.
(See Settings > Settings > Frequency)

Table continued…
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Item Display element Description

11 Phase Noise Table Displays the phase noise values at different offsets.

12 Horizontal start Readout of the Left Horizontal frequency value. Affects only visual scaling, not
measurement bandwidth. (See Settings > Scale)

13 Measurement results readouts Display of the different measured values.

Elements of the Measurement Results Readout / Phase Noise Table

Readout Description

Carrier power The power level at the carrier frequency.

Freq Error The measured carrier frequency error.

RMS Phase Noise The RMS value of the phase noise, measured over the Integration BW.

Jitter The jitter in seconds, measured over the Integration BW. Includes the effects of random and coherent
jitter.

Residual FM The residual frequency modulation, measured over the Integration BW.

Trace 1 The phase noise on trace 1 at different frequency offset values. Note that if Trace 1 is set to +/- Peak
detection, the value displayed in the table is the +Peak value.

Trace 2 The phase noise on trace 2 at different frequency offset values. Note that if Trace 2 is set to +/- Peak
detection, the value displayed in the table is the +Peak value.

Changing the Phase Noise Settings

How Phase Noise Is Measured
If carrier tracking is on, the instrument measures phase noise relative to the highest-amplitude signal within about 20 MHz of the
user-entered frequency. The difference between center frequency and the frequency of the measured carrier is reported as frequency
error. If carrier tracking is not on, the instrument measures phase noise relative to the amplitude at the user-entered frequency.

The unit will tune to a number of offsets from the carrier frequency, and calculate the spectrum for the frequency range about each offset
using a resolution bandwidth appropriate for the offset frequency. This is done to optimize speed while maintaining acceptable frequency
resolution. A table of the values used for measurement frequency offset, resolution bandwidths, hardware IF filter bandwidths and RF
attenuations is shown below.
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Measurement frequency offset
range

Measured span RBW use for
spectrum
calculation

Hardware IF filter RF Attenuation

10 Hz to 100 Hz 312.5 kHz 1 Hz 40 MHz Auto from ref level
100 Hz to 1 kHz 312.5 kHz 2 Hz 40 MHz Auto from ref level
1 kHz to 10 kHz 312.5 kHz 20 Hz 40 MHz Auto from ref level
10 kHz to 100 kHz 3 MHz 200 Hz 40 MHz Auto from ref level
100 kHz to 1 MHz 3 MHz 1 kHz 40 MHz Auto from ref level
1.0 MHz to 1.9 MHz 300 kHz 1 kHz 1 MHz Auto from ref level (-5 dB)1

1.9 MHz to 20.0 MHz 300 kHz 1 kHz 1 MHz Auto from ref level (-20 dB)1

20 MHz to 100 MHz 20 MHz 10 kHz 40 MHz Auto from ref level (-5 dB)1

100 MHz to 1000 MHz 20 MHz 100 kHz 40 MHz Auto from ref level (-5 dB)1

After acquisition and calculation, the spectrum is corrected to display power in a 1 Hz bandwidth referenced to the carrier power (dBc/Hz).
The correction algorithm does not discriminate between noise signals and coherent signals in making the dBc/Hz correction. Since all
measured signals are corrected as if they were noise, coherent signal measurement results can contain errors in level. This is a key
difference between an SA-based measurement and a dedicated phase noise tester.

The largest difference between operation of a swept spectrum analyzer and a real-time signal analyzer when measuring phase noise is a
result of the wide acquisition bandwidths found in the real-time signal analyzer.

The real-time signal analyzer can select between 1 MHz, 40 MHz and 165 MHz IF filters when performing acquisitions.

By contrast, a traditional spectrum analyzer uses an IF bandwidth that can range from a few kHz wide up to 10 MHz wide, depending upon
the selected resolution bandwidth. When the IF bandwidth is small it is able to reject out-of-band carriers so they don't overload the final
IF and digitizers in the instrument. This allows the signal analyzer to begin to reduce attenuation as the phase noise measurement tunes
farther away from the carrier, improving dynamic range. The same thing is done in the real-time signal analyzer, but the 1 MHz final IF
section in the real-time signal analyzer can't reject signal within about 1 MHz whereas a conventional spectrum analyzer can reject signals
within a few kHz of the desired carrier. This is the reason for the shape of the phase noise plot seen in the following illustration.

1 Attenuator adjustment when ‘optimize dynamic range’ is selected
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In the previous illustration, the effect of choosing ‘optimize dynamic range’ is seen. In the offsets between 10 Hz and 1 MHz, the 40 MHz
acquisition bandwidth is used, and the RF attenuator is set based on the reference level of the instrument to prevent overload of the RF/IF
signal path.

At an offset of >1 MHz, a 1 MHz IF bandwidth is applied, 5 dB of RF attenuation is removed from the signal path and the noise ‘floor’ of the
measurement is reduced. At 2 MHz offset from carrier, 20 dB of attenuation is removed with a resultant increase in dynamic range. Finally,
at 20 MHz offsets, the 40 MHz filter is used again with 20 dB attenuation removed. In order to be able to use the 40 MHz BW filter at a
20 MHz offset, the measurement frequency is moved so that the carrier is 30 MHz from the measurement point, and well down the filter
rejection skirt.

Phase Noise Settings
Main menu bar: Setup > Settings 

The control panel tabs for the Phase Noise display are shown in the following table.

Settings tab Description

Frequency Specify Measurement BW and Integration BW. Enable carrier frequency tracking and specify the
Carrier threshold level.

Parameters Specifies the Optimization method.

Traces Specifies trace parameters such as detection method and whether smoothing is enabled. Traces can
also be saved and loaded for reference from this tab.

Scale Specify vertical and horizontal scale settings.

Prefs Specify appearance features of the graph area.

Restore defaults. Sets the Phase Noise parameters to their default values.

Frequency Tab
Use the Frequency tab to specify parameters used for taking the Phase Noise measurement.
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Setting Description

Measurement BW This sets the frequency range for the phase noise measurement range. The instrument's Frequency
control is used to set the "carrier frequency of interest". The widest available start/stop range is from
10 Hz greater than the carrier frequency (“Stop Offset”) to 1 GHz above the carrier (“Stop Offset”).
Very small start offsets will take significant time to measure as very narrow resolution bandwidths are
used in to achieve small-offset measurements. Large-offset stop frequencies cause small effects on
measurement time, but will increase the displayed scale of the phase noise plot.

Start Offset Sets the starting point for the Phase Noise plot. Offset is from the carrier frequency. The minimum
start offset is 10 Hz. The maximum start offset is 100 MHz. The setting is limited to powers of ten (1,
10, 100...).

Stop Offset Sets the stopping point for the Phase Noise plot. Offset is from the carrier frequency. The minimum
start offset is 100 Hz. The maximum stop offset is 1 GHz. The Stop offset value must be at least 10X
the Start offset value. The setting is limited to powers of ten (1, 10, 100...).

Integration BW Integration bandwidth sets the frequency range over which integrated results for phase noise
(labeled “RMS Phase Noise”) and jitter are calculated. Integration start and stop cannot exceed
the measurement bandwidth. If you set the integration bandwidth greater than the measurement, the
error message ‘Setup error: Integration BW exceeds Measurement BW’ will appear.

Start Offset Specifies the Integration BW's start offset from the carrier frequency.

Stop Offset Specifies the Integration BW's stop offset from the carrier frequency.

Track carrier frequency The instrument finds the carrier signal and measures its frequency at least once each time the
Phase Noise measurement is taken and reports the error between the Freq setting and the measured
frequency of the carrier. When Track carrier frequency is enabled, the measurement adjusts its tuning
to counteract the carrier error or drift. When carrier tracking is disabled, the measurement is made
using the Freq setting specified by the user.

Carrier threshold The minimum power level required for the signal to be recognized as a carrier. If no signal is found
above this level within 20 MHz of the Freq setting, the Phase Noise measurement will fail.

Parameters Tab
The Parameters tab enables you to specify acquisition settings that control the Phase Noise measurement.

Average. Specifies whether averaging is used or not. This setting affects integrated numeric results and the trace display. The range for
this setting is 2 to 100. The default setting is disabled.
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Settling Time Measurement Overview
The Settling Time measurement (Option 12) is used to measure frequency and phase settling time of frequency-agile oscillators
and subsystems. Automated measurements can reduce user-to-user measurement variations, improve repeatability and measurement
confidence, and save time in gathering results.

Measurement Definitions

Settling time. The time measured from a reference point to when the signal of interest settles to within user-defined tolerance.

Settled frequency. The final reference frequency, determined automatically or manually. The tolerance band is centered about this settled
frequency.

Settled phase. The final reference phase, determined automatically or manually. The tolerance band is centered about this settled phase.

Mask Testing
Mask testing is a tool to automatically determine the pass/fail state of the Device-Under-Test. The mask is defined over three or fewer
user-defined time zones, with an independent limit band for each time zone. If the mask is violated, the area of violation is highlighted
in red on screen, and a Fail message is displayed. The pass/fail status of the mask test can be queried over GPIB for rapid results. To
configure Mask testing, see the Mask tab.

The instrument's Search function can watch the Settling Time measurement for either pass or fail results, and perform actions such as
stopping or saving data when the defined condition occurs. See Mask Test Settings on page 636 for details on configuring Mask Test.

Frequency Settling Time Theory of Operation
The following paragraphs describe how a frequency and phase settling measurement is made.
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Figure 40: Frequency settling time flow diagram
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Figure 41: Phase settling time flow diagram

Acquisition hardware collects I and Q samples at the measurement frequency. Sample Rate is based on the measurement bandwidth
setting.

The instantaneous phase is computed as:
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The instantaneous frequency is the derivative of the phase:

Data smoothing is applied (if selected by the user). This filtering method uses ±n adjacent samples to produce an average value that is
used to replace the values of the original 2n samples. An example is shown below.

If averaging is turned on, the smoothed data array is averaged with data arrays of previous acquisitions on a point-by-point basis.
Smoothing has the advantage of reducing noise-like variations in the measurement, but carries the risk of masking real measurement data.
The amount of smoothing applied must be determined by evaluating the waveform you see for artifacts that result from the process.

Next, Settled Frequency is calculated. Settled frequency is the average frequency determined by looking back in time from the point set
by the Measurement Length control over a minimum of 256 samples. This value is used to determine the frequency level about which
to center the Tolerance range. The measurement then searches backward through the data until it finds the first point that exceeds the
tolerance range. A maximum of 20 million acquisition data samples can be processed by the measurement.

Settling Time is measured as the time from the start reference to the point where the frequency remains within the tolerance band. The
start reference can be any of three points:

• The trigger point
• The beginning of the analysis period. This result can only be computed when the instrument can find a previous settled state within the

measurement period
• The point at the end of the previous frequency hop where the frequency first leaves the tolerance band. This result can only be

computed when the instrument can find a previous settled state within the measurement period.
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Figure 42: Settling time start reference points

All measurements are now complete and the numeric settling time values can be sent to the display. However, no result traces have been
produced yet. Detection is used to reduce the measured points (which can number up to 10 million) to a number more easily processed by
the display processor. +/- Peak detection is always used, preserving the maximum positive and negative excursions for display. Reducing
the number of points in the result reduces the time resolution of the markers. If averaging is on, the measurement results are computed on
the average of the undecimated results.

Phase Settling Time Overview
Phase settling time is determined, as described previously, with the addition of tilt correction.

The instrument estimates tilt (or slope of the phase) using linear least square fitting over (at least) 256 samples of the phase vs. time
waveform, looking backwards from the point set by the Measurement Length. The instrument adjusts the phase waveform so that its phase
is of zero value at the point set by the Measurement Length.

Settling Time Displays
The Frequency Settling Time measurement is used to measure the frequency settling time of frequency-agile oscillators and subsystems.
The Phase Settling Time measurement is used to measure the phase settling time of phase-agile oscillators and subsystems. Automated
measurements can reduce user-to-user measurement variations, improving repeatability and measurement confidence and saving time in
gathering results. To measure phase settling, a phase reference is required. This means that the measurement tool must be frequency-
referenced to the device under test, or must act as the frequency reference to the device under test. To lock the reference to an external
source, go to Setup > Configure In/Out > Frequency Reference and choose External. Values from 1 MHz to 25 MHz in 1 MHz steps can
be used as an external reference.

To show a Settling Time display:

1. Click the Displays button or select Setup > Displays.
2. From the Measurements box, select RF Measurements.
3. Double-click the Freq Settling icon or the Phase Settling icon in the Available displays box. This adds the selected display to the

Selected displays box (and removes it from the Available displays box).
4. Click the OK button.
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Figure 43: Frequency settling time display

Figure 44: Phase settling time display

Elements of the Display

Item Display element Description

1 Top of graph Sets the frequency/phase that appears at the top of the graph. However, note that the
top of graph setting, vertical scale setting (Settings > Scale tab), and Vertical Position
settings interact. Adjusting this value changes the frequency/phase at the top of the graph
by adjusting the scale setting.

Phase Settling Time: Sets

2 Vertical Position Sets the frequency/phase value at the vertical center of the graph.

Table continued…
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Item Display element Description

3 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen.

4 Horizontal Position Sets the horizontal position of the trace on the graph.

5 Measurement readouts Displays measurement results. See Measurement Readout Text Color below.

6 Signal transition start indicator A blue vertical line that indicates the staring point of the Settling Time measurement that
is based on the signal transition away from the previous settled state, if a previous settled
state is found within the measurement period.

7 Trigger point indicator An orange line and “T” (which appears below the graph) that indicates the location of the
trigger point in time.

8 +/- Tolerance indicators A pair of blue horizontal lines that show the tolerance range.

9 Settled time indicator A blue vertical bar that shows the point on the trace at which the measurement has
determined the signal frequency or phase to be settled.

10 Measurement length indicator A magenta vertical line that specifies the end of the allowed measurement period. This is a
control, not a result.

11 Scale Adjusts the horizontal (time) scale of the graph.

12 Clear Restarts multi-trace functions (Avg, Hold) and erases the trace.

13 Function Displays the Detection and Function selections for the selected trace. (Detection is always
+/-Peak for Settling Time measurements.)

14 Show Controls whether the selected Trace is visible or not. When trace is Off, the box is not
checked.

15 Trace Selects a trace. Touching here displays a menu that shows the available traces and
whether they are enabled or not. If you select a trace that is not currently enabled, it will be
enabled.

Measurement Readout Text Color

The measurement readouts can appear in either black text or red text. Measurement results that appear in black text indicate:

• the signal is settled AND
• the signal is settled longer than the minimum settled duration AND
• the settling time is valid OR the settling time from trigger is valid

If any of the conditions listed are not met, the measurement results text is red.

Elements of the Frequency Settling Time Graph
The following illustration shows the various indicators that appear in the Frequency Settling Time graph.
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Note: The blue vertical bar that indicates the end of the previous settled state may not always appear. For frequency settling time,
this can happen because the starting frequency is outside the measurement bandwidth.

Elements of the Phase Settling Time Graph

The following illustration shows the various indicators that appear in the Phase Settling Time graph. For most phase settling time
measurements, there is not a previous settled state within the measurement period, making it impossible to measure the settling time from
the previous settled value. However, the settling time from trigger is typically available.
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Note: The blue vertical bar indicating the measurement start time may not appear. Zero phase is referenced to the measured hop,
as the phase will not typically have a settled value during the previous hop.

Measuring Settling Time

1. Select the Displays button.
2. Select RF Measurements from the Measurements box.
3. Double-click the Freq Settling icon or Phase Settling icon in the Available displays box. Click OK to complete your selection.
4. Select General Signal Viewing from the Measurements box.
5. Double-click the Time Overview icon in the Available displays box. Click OK to complete your selection.
6. Press the front-panel Freq button and use the front-panel keypad or knob to adjust the frequency to that of the signal you want to

measure.
7. Select the Trig button.
8. In the Trigger control panel, select Triggered. Configure the trigger settings an needed to achieve a triggered signal.

For the next step in measuring settling time, you must set the starting point of the measurement. To do this, you will use the Time
Overview display.

9. Select the Time Overview display.
10. At the left edge of the graph, drag across the graph to adjust the analysis offset. Adjust the Analysis Offset to locate the start of the

settling time measurement just ahead of the signal transition where you want to measure the settling time. Any portion of the signal in
the gray area will be excluded from the settling time measurement.
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Figure 45: Setting the starting point of the settling time measurement

Even if the signal transition is difficult to see on the Time Overview display, you can set the starting point based on the location of the
Trigger indicator below the graph. Or open the Frequency vs. Time graph to see the frequency transition.

11. Click in the Settling Time display to select it.
12. Select the Settings button to display the Settling Time Settings control panel.
13. On the Define tab, adjust the Meas BW to improve the signal-to-noise ratio as appropriate. Make sure the bandwidth covers

the settled frequency, particularly when the instrument Measurement Frequency is not locked to the spectrum Center Frequency
(Analysis control panel > Frequency tab).

14. Set the Target Reference on page 201 to Auto or Meas freq as appropriate. If you select Meas freq, also set Offset to fine-tune the
measurement frequency if necessary.

15. Set the Tolerance as required for your measurement.

If your signal must be settled for a period of time before it is considered settled, you can specify a minimum settled duration for the
settling time measurement.

16. Select the Time Params tab. Adjust the Min Settled Duration on page 202 as required.

To get the measurement made in the correct location on the signal, you must adjust the measurement length. You do this by dragging
the magenta line in the Settling Time graph.

17. Drag the measurement length indicator (magenta line) to the correct location on the signal. Choose a point at which the signal
appears to be well settled. The measurement will then find the exact time at which the signal actually settled to within the specified
tolerance.

Note the difference in the settling time in the two illustrations that follow. In both examples, the Target reference is set to Auto. The only
difference is the measurement length, as shown by the magenta line.
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Figure 46: Frequency settling time display before setting the measurement length

Figure 47: Frequency settling time display after setting the measurement length

Settling Time Settings
Main menu bar: Setup > Settings

The settings for the Frequency and Phase Settling Time displays are shown in the following table.

Settings tab Description

Define Sets the measurement parameters that characterize the settling time measurement.

Time Params Sets measurement end-time and minimum settled duration parameters.

Mask Enable or disables mask testing and sets the parameters that specify the three zones used for mask
testing.

Trace Specifies trace display characteristics and which traces are displayed.

Table continued…
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Settings tab Description

Scale Sets vertical and horizontal scale and position parameters.

Prefs Specifies whether or not to show certain display elements, the maximum number of points in the
exported trace, and the displayed precision of the settling time measurement.

Common Controls Settling Time Displays Shared Measurement Settings
The control panel tabs in this section are shared by the Frequency and Phase Settling Time displays. These control panel tabs are not
shared with other RF Measurement displays. With few exceptions, each display shares values for each of the controls on these tabs. For
example, Vertical Scale values are independent for each of the displays (degrees for Phase Settling Time and Hertz for Frequency Settling
Time).

Table 11: Common controls for settling time measurement displays

Settings tab Description

Define Specifies the parameters that characterize the settling time measurement.

Time Params Specifies the Measurement length and minimum settled duration for the settling time measurement.

Mask Specifies the parameters used for Mask testing.

Trace Specify which traces to show and how they are computed.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies display parameters of the Settling Time displays.

Define Tab for Settling Time Displays
The Define tab for the Frequency Settling Time measurement controls several parameters that affect how the measurement is made.

Meas Freq
Select the frequency of the signal to be measured. Measurement Frequency can be selected as the target frequency (see Target
Reference).

Note: If Lock Center Frequency of Spectrum Display to Measurement Frequency is unchecked, then Measurement Frequency is
independent of Center Frequency) Range: Entire input frequency of the instrument
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Meas BW
This control limits the bandwidth of the Settling Time measurement. You use the measurement bandwidth setting to improve the
signal-to-noise ratio of the measurement, resulting in lower measurement uncertainty. However, if the measurement bandwidth is set too
low, resulting in fewer samples per second, it can reduce the number of points within the measurement length below the 256 stable
samples required, thus causing the analysis to fail. The measurement bandwidth is 100 Hz to 165 MHz (Option B16x) or 100 Hz to 40 MHz
(Standard). To see the effect of measurement bandwidth on measurement uncertainty, see the Specifications and Performance Verification
manual. This manual is supplied on the Documents CD or can be downloaded from www.tek.com/manuals.

Target Reference
The target reference is a calculated or user-specified value of final settled frequency within the measurement period. When set to Auto,
the instrument determines this value by averaging at least the last 256 samples at the end of the measurement period. When set to
Meas freq, the Target Reference is set to the Measurement Frequency of the instrument. You can enter a manual offset from the target
frequency to fine-tune the Target Reference when Meas freq is selected.

Tolerance(+/-)
The Tolerance is the frequency or phase range within which the signal must remain to be considered settled. This is set as a ± value by
the user. In the frequency settling time measurement, the tolerance band is centered about the target value. In the phase settling time
measurement, the tolerance band is centered about the settled phase value.

The target frequency depends on the Target reference value setting:

• If Target Reference is set to AUTO, then the target value is the settled value (the frequency at which the signal is considered settled).
• If Target Reference is set to MeasFreq, then the Target value = Meas Frequency + Offset.

Offset
Offset is used for fine-tuning the Target Reference when Meas freq is selected. The value for Offset is entered manually.

Time Params Tab for Settling Time Displays
The Time Params tab is used to set the Measurement length and minimum settled duration parameters.

Measurement Length
Measurement length locates the end of the measurement period for settling time. This value is set independently of the analysis period for
other measurements in the analyzer. This allows other measurements to display multiple frequency hops during an analysis, while focusing
the settling time analysis on a single hop. You can set the measurement length either by entering a value in the entry box, or by dragging
the magenta bar to the desired location in the graph. Traces and the display to the right of the measurement time are shown in grey to
indicate that this section of the waveform is not being used in the measurement. If your signal does not settle to within your tolerance band,
make sure that the measurement time ends during the settled portion of the waveform. The beginning of the settling time measurement is
set with the analysis offset control, the same as other measurements in the instrument. Use analysis offset to exclude earlier hops from the
measurement. See Analysis Time for setting the analysis offset control.
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If there is more than one phase or frequency hop in the signal to be analyzed, use the Measurement Length control to instruct the analyzer
which hop to measure. First, adjust the main Analysis Offset control to a point in time slightly earlier than the transition you wish to
measure. Do this in the Time Overview display or the Analysis Settings control panel. Then adjust the Measurement Length so the end of
the Settling Time measurement falls within the apparent settled period after the signal transition. The reason it is important for the user to
set this control is that the Settling Time measurements start at this point and look backwards in time (towards the signal transition) to find
the latest trace point that is not inside the tolerance band.

Note: If your signal does not settle to within your tolerance bands, make sure that the measurement time ends during the settled
portion of the waveform.

Min Settled Duration
The minimum settled duration is the amount of time the signal must remain within the tolerance band to be considered settled. Some user
specifications require that the signal be settled for a minimum period. If this is not required in your application, set this value to the default
of 0 seconds.

Mask Tab for Settling Time Displays
The Mask tab is used to specify the parameters used for Mask testing. 

Enable Mask Test
Enables or disables mask testing.

Start 1, 2, 3
Sets the starting point for the time zone of interest. If you don't want to use all three zones, set the Start Time for the unneeded zones to a
time after the end of the Measurement Length.

Stop
Sets the end point for the final time zone of interest.

Limit (+/-)
Sets the mask violation limits for each time zone.

Mask Time Reference
When mask testing is enabled, the Mask time reference selection specifies the starting point of the mask. You can choose to start the mask
test at the trigger point or at the point on the trace where the signal began its transition from its previous settled frequency or phase level to
the level you intend to measure.

This capability is useful because some applications do not have a trigger signal available. For those situations where a trigger signal is
available, the specification for the device-under-test may require that measurements be referenced to that signal.
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Trace Tab for Settling Time Displays
The Traces Tab allows you to set the display characteristics of displayed traces.

Smooth
Smooth is a low-pass filter function that uses n points in the trace to determine the smoothed value. For example, in the case of n=3, 3
consecutive points are averaged to determine the result of the smoothed output. This is very useful for single-shot signals that contain
significant noise where multiple trace averages cannot be used. However, smoothing does have limits, and the user should visually
determine whether smoothing is removing noise from the measurement, or if it is affecting the signal. The following illustration shows the
effect smoothing has on the displayed trace.

The range for the Smooth function is 2–1000. The setting resolution is 1. arrow keys increment it in steps of 1, 2, 5, 10. When smoothing is
enabled, it applies to both traces. Smooth is turned off by default.

Average
This sets the number of acquisitions to be averaged together to produce the result. Averaging reduces random variations but maintains the
correct waveshape for repeating signal aberrations. To use averaging, the signal must be repetitive. For example, the tuning direction must
always be same for each measurement to be averaged. Signals that vary in tuning direction will tend to average positive-going effects with
negative-going effects and the settling time characteristics will cancel out.

The range for the Average function is 2–10000. The setting resolution is 1. The knob increments this value by 1, and the arrow keys
increment it in steps of 1, 2, 5, 10. When smoothing is enabled, it applies to both traces. Smooth is turned off by default.

Trace
Selects a trace for display. Choices are Trace 1 and 2. Either trace can be a recalled trace.
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Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.
5. Check the Show Recalled Trace check box.
6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the

graph).

Scale Tab for Settling Time Displays
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls.

Setting Description

Vertical

Scale Changes the vertical scale or span of the graph.

Position Sets the frequency (or phase) at the vertical center of the graph.

Relative Freq Sets the vertical (position) display readouts to show frequency values relative to the center frequency
or as absolute values.

Autoscale Resets the Scale and Position to center the trace in the graph.

Table continued…
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Setting Description

Horizontal

Scale Sets the range of time shown in the graph.

Position Allows you to pan the graph left and right.

Autoscale Resets Scale and Position to the automatically determined settings.

Prefs Tab for Settling Time Displays
The Prefs tab allows you to change display parameters of the Settling Time displays. 

The following table explains the controls that can appear on the Prefs tab.

Setting Description

Max trace points Sets the number of trace points used for marker measurements and for results export.

Show graticule Select to display or hide the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Settling Time decimal places Specifies the precision of the settling time measurement readout that appears below the graph. This
setting does not affect the precision of internal calculations.

SEM Display
The SEM (Spectrum Emission Mask) display measures out-of-band emissions immediately outside the channel bandwidth that result from
the modulation process and non-linearity in the transmitter. The Spectrum Emission Mask display allows you to define up to six pair of
masks, or offsets, that specify the limits for out-of-band emissions and performs a pass/fail tests of the signal against the defined offsets
and limits.

To show the Spectrum Emission Mask display:

1. Select Displays or select Setup > Displays.
2. In the Select Displays dialog, select RF Measurements or WLAN Analysis in the Measurements box.
3. In the Available displays box, double-click the SEM icon or select the icon and click Add. The SEM icon will appear in the Selected

displays box and will no longer appear under Available displays.
4. Click OK to show the Spectrum Emission Mask display.
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Elements of the Display

Item Display element Description

1 Check mark indicator Indicates the display for which the acquisition hardware is optimized.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top-of-graph setting Sets the level that appears at the top of the graph.

(not
shown)

Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

3 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

4 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

5 Autoscale Properly offsets the peak of the display from the top of the screen.

If the screen has been enlarged through a manual vertical (dB/div) setting entry, the view
is not vertically rescaled when Autoscale is used.

6 CF / Pos Default function is CF - center frequency (equivalent to the Measurement Freq setting).
If Horizontal scaling has been manually adjusted in Setup > Settings > Scale, then Pos
replaces CF as the setting at the bottom-left corner of the screen. Adjusting Pos shifts the
trace left or right in the graph, but does not change the measurement frequency.

7 Span / Scale Default function is Span - frequency difference between the left edge of the display and
the right edge. If Horizontal scaling has been manually adjusted in Settings > Scale, then
Scale will replace Span as the setting at the bottom-right corner of the screen.

8 Clear Erases the current results from the display.

Table continued…
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Item Display element Description

9 Function readout Readout of the Function selection for the Reference channel (Setup > Processing >
Function).

Spurious

10 Detection readout Readout of the Detection selection for the Reference channel (Setup > Processing >
Detection).

11 Pass / Fail readout Readout indicating whether any part of the trace has exceeded the any of the limits
defined in the Offsets & Limits table (Setup > Settings > Offsets & Limits Table).

Pass / Fail Readout
This readout displays either Pass or Fail XX%. When the signal exceeds the mask in any offset, it is considered a mask violation, and
results in Fail XX% being displayed. If there are no mask violations, Pass is displayed.

How the fail percentage is determined. Each offset has two sides, one lower and one upper. For example, Offset A has two sides: AL
(lower side) and AU (upper side). In the SEM display, there is a maximum of six offsets (A-F) and each offset can have a maximum of two
sides (if Both is selected for Side in the Offsets & Limits table). This results in a total of six offsets multiplied by two sides per offset, which
results in 12 offsets. Mask violations can occur in any of these offsets. The failure percentage is calculated as follows:

Fail percentage = Number of offsets with mask violations x 100 / Total number of enabled offsets

For example: Assume there are three enabled offsets: A, B, C, and all these offsets have both lower and upper sides. Thus, the total
number of enabled offsets is equal to six. Suppose there are mask violations in the offsets AL and CU, then the number of offsets having
mask violations is equal to 2. Therefore, Fail percentage = 2 * 100 / 6 = 33%.

Results Display
The Results Display shows the measurement results for the SEM display.

Readout Description

Ref: A two-part readout to the left of the table that displays information about the Reference
Channel. The first part of the readout displays the Measurement Type selected on the
Parameters tab. The second part of the readout displays the measurement result for the
Reference channel.

Row A sequence number for ordering the offsets. Click to organize by row number, resort rows
from high to low or low to high.

Offset The Offset name. A combination of the offset (A-F) and the location (U for upper and L for
Lower).

Table continued…
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Readout Description

Start Freq The start frequency of the offset (relative to the Measurement Freq).

Stop Freq The stop frequency of the offset (relative to the Measurement Freq).

Peak Abs Absolute power peak power at worst case margin of the offset

Margin Abs The worst case difference between the trace and the absolute limit line. Note that an offset
can have different start and stop levels, thus, the margin can vary if the offset start and stop
levels are different.

Peak Rel Relative peak power of worst case margin of the offset. Relative with respect to the
reference power level.

Margin Rel The worst-case difference between the trace and the relative limit line. Because an offset
can have different start and stop levels, the margin can vary if the offset start and stop
levels are different.

@Freq The frequency at which the worst margin occurs.

Integ Abs The absolute integrated power of the offset.

Integ Rel The relative integrated power of the offset (with respect to the reference power).

Reordering results in the results table. You can sort the results in the Results table by clicking the column heading containing the values
you want to sort on. You can sort results for the following columns: Row, Offset, Start Frequency, Stop Frequency, Peak Abs, and Peak
Rel.

Rearranging columns in the results table. You can rearrange the order of the columns and their size. To rearrange columns, select the
column heading you want to move and drag it to the new position; the new location is indicated by a dark blue bar that appears between
column headings.

You can resize the columns by selecting the divider between columns and dragging it to a new position.

Spectrum Emission Mask Settings
Main menu bar: Setup > Settings 

Favorites toolbar:

The settings for the Spectrum Emission Mask display are visible when SEM is the selected display. To display the SEM Settings, select
Setup > Settings.

Settings tab Description

Parameters Tab Specifies several characteristics that control how the measurement is made.
Processing Tab Specifies settings for detection on the Reference channel and the offsets. Specifies the function

setting.
Ref Channel Tab Specifies how the measurements on the reference channel are performed.
Offsets & Limits Table Specifies characteristics of offsets and mask limits.
Table continued…
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Settings tab Description

Scale Tab Specifies the vertical and horizontal scale settings.
Prefs Tab Specifies the appearance features of the graph area and the maximum trace points.

Parameters Tab - SEM
The Parameters tab specifies several characteristics that control how the Spectrum Emission Mask measurements are made.

Setting Description

Meas Freq Specify the frequency of the signal to be measured.
Step Sets the increment size when changing the Frequency using the knob or mouse wheel.
Auto When Auto is enabled, the step size is adjusted automatically based on the span setting.
Real-Time When Real-Time mode is enabled, the entire SEM span is measured using a real-time/contiguous

acquisition. Not all described parameters are available in Real-Time mode.
Measurement Type Specifies the type of measurement for the reference channel; used as a reference for the offsets.
Total Power Sets the reference to the integrated power of the reference channel within the reference's integration

bandwidth.
PSD Sets the reference to the mean of the power spectral density (dBm/Hz) of the reference channel. The

trace and the absolute and relative limits line are also in dBm/Hz
Peak Sets the reference to the Peak power of the reference channel.
Offset definition Defines the relative position of the start/stop frequency of an offset. Choose the offset definition based

on the standard.
Ref center to OS center Specifies that the start/stop frequencies are defined from the center frequency of the reference

channel to the center of the filter BW.
Ref center to OS edge Specifies that the start/stop frequencies are defined from the center frequency of the reference

channel to the center of the (inner) edge of the filter BW of the offset.
Ref Edge to OS center Specifies that the start/stop frequencies are defined from the edge of the reference channel to the

center of the filter BW of the offset.
Ref Edge to OS edge Specifies that the start/stop frequencies are defined from the edge of the reference channel to the

(inner) edge of the filter BW of the offset.
Filter Shape Specifies the shape of the filter determined by the window that is applied to the data record, in the

spectrum analysis, to reduce spectral leakage. 3GPP specifies a Gaussian window shape be applied
to the reference channel measurements.

Gaussian This filter shape provides optimal localization in the frequency domain.
Rectangular This filter shape provides the best frequency, worst magnitude resolution. This is essentially the same

as no window.
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Processing Tab - SEM
The Processing tab controls the Detection settings for the Reference Channel and Offsets, as well as selecting the Function.

Settings tab Description

Detection (in each sweep)

Ref Channel Specifies the Detection method used for the Reference Channel. Detection is used to produce the
desired measurement result (peak or average) and to reduce the results of a measurement to the
desired number of trace points.

Avg (VRMS) For each sweep, each point of the trace is the result of determining the RMS voltage value for the
last 'n counts' of the collected traces for the same point. When 'n count' has not been reached, partial
averaging results are displayed.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from the results
to be compressed into a trace point.

Offsets Specifies the detection method used for the offsets.

Avg (VRMS) Selects the Average Vrms detection method. With this method, each point on the trace in each offset
is the result of determining the RMS Voltage value for all of the results values it includes.

+Peak Selects the +Peak detection method. With this method, the highest value in each offset is selected
from the results to be compressed into a trace point.

Function (across multiple sweeps)

Function Selects the trace processing method. Available settings are: Normal, Avg (VRMS), and Hold.

Normal When a new trace has been computed, it replaces the previous trace.

Max Hold With each sweep, each trace point in the new trace is compared to the point’s value in the old trace
and the greater value is retained for display and subsequent comparisons.

Avg (VRMS) For each sweep, each point on the trace is the result of determining the RMS Voltage value for all of
the collected traces' values for the same point.

Ref Channel Tab
The Ref Channel tab controls how the measurement of the Reference channel is performed.

RF Measurements

RSA5100B Series Real-Time Signal Analyzers Help 210



Settings tab Description

Power Reference The value used to calculate relative measurements.

Auto When Auto is unchecked, you can enter a value for the reference power, and the measured reference
power is not used or displayed

RBW Sets the RBW for the Reference Channel.

VBW Enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the
effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters
of traditional swept analyzers. When the checkbox next to VBW is not checked, the VBW filter is not
applied. SEM standards specify what value of VBW should be applied, if any.

Channel width Specifies the width of the reference channel.

Integration BW Specifies the integration bandwidth used to compute the total power in the reference channel.

Channel Filter Specifies the measurement filter used in the Reference Channel. Choices are None and Root-raised
Cosine.

Filter param Specifies the alpha value (or roll-off factor) of the Root-raised cosine filter. Present only when Channel
Filter is set to Root-raised Cosine.

Chip rate Specifies the chip rate used for the Root-raised Cosine filter. Present only when Channel Filter is set
to Root-raised Cosine.

Offsets & Limits Table Tab - SEM
The Offsets & Limits Table tab is used to specify parameters that define Offsets and masks.

Figure 48: Expanded display of Offsets & Limits Table
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Setting Description

Buttons

Expand Displays the Offsets & Limits Table in a new, resizeable window.

Reset Layout You can reorder columns in the Offsets & Limits Table by dragging the columns to a new position.
Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Offsets & Limits table from a file.

Save As Click to save the current Offsets & Limits table to a file.

Done When the table is expanded, click Done when you have finished editing the table to save your
changes and close the expanded table display.

Table columns

On Specifies whether or not measurements are taken in the specified offset.

Start (Hz) Start Frequency of the selected offset.

Stop (Hz) Stop Frequency of the selected offset.

Side Specifies whether the specified range appears on both side of the carrier frequency or just one side
(left or right).

RBW (Hz) Specifies the RBW for the selected range.

n (RBWS) An integer value that specifies how many times to multiply the RBW to set the Filter bandwidth.

Filter BW (n x RBW) Displays the Filter BW. Filter BW is the equivalent BW of each point in the offset. When n > 1,
an integration technique is used to achieve the Filter BW using narrower RBWs. For most SEM
measurements, this value is set to 1. The 3GPP standard suggests n greater than 1.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW Minimum:
1/10,000 RBW setting.

VBW On Specifies whether the VBW filter is applied.

Mask Select the type of limits used for Pass/Fail testing. Signal excursions that exceed the mask settings
are considered violations. The available choices are shown below.

Abs Start (dBm) Specifies the mask level at the inner edge of the selected offset.

Abs Stop (dBm) Specifies the mask level at the outer edge of the selected offset.

Abs Same Specifies whether the value for the inner and outer edges of the offset must be the same value. When
enabled, the Abs Stop cell is grayed-out and set to the value of the Abs Start cell.

Rel Start (dBm) Specifies the mask level for the Relative mask at the inner edge of the selected offset.

Table continued…
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Setting Description

Rel Stop (dBm) Specifies the mask level for the Relative mask at the outer edge of the selected offset.

Rel Same Specifies whether the inner and outer edges of the offset must be the same value. When enabled, the
Rel Stop cell is grayed-out and its value is set to the value of the Rel Start cell.

Scale Tab - SEM
Use the Scale tab to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears on the
display. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Specifies the frequency range displayed in the graph

Position Specifies the frequency shown at the center of the graph.

Autoscale Resets the scale of the horizontal axis to optimize the display of the trace.

Reset Scale Resets all settings to their default values.

Prefs Tab - SEM
The Prefs tab enables you to change parameters of the measurement display. The parameters available on the Prefs tab vary depending
on the selected display, but include such items as enabling/disabling Marker Readout and switching the Graticule display on/off. Some
parameters appear with most displays while others appear with only one display.
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Setting Description

Show graticule Controls the vertical position and scale of the trace display.

Max Trace points (per range) When the spectrum analysis produces more than the selected maximum number of points, the
method specified in Detection control is used to decimate the result. This setting applies to both the
Reference channel and offsets.

Show Marker readout in graph Adjusts the reference level away from top of the graph.

Show limits Controls the appearance of mask limits in the graph.

Shaded Shows limits using a shaded area. Green shading is used to identify Absolute limits. Blue shading is
used to indicate Relative limits.

Line only Shows limits using only a line. A green line is used to identify Absolute limits. A blue line is used to
indicate Relative limits.

None No lines or shading are used to indicate limits in the graph. Violations of the mask are still identified by
red shading.

Common Controls RF Measurements Shared Measurement Settings
The control panel tabs in this section are shared by multiple displays in the RF Measurement folder (Setup > Displays). With few
exceptions, each display maintains separate values for each of the controls on these tabs. For example, Scale values are independent for
each of the displays.

Table 12: Common controls for RF measurement displays

Settings tab Description

Freq & RBW Allows you to specify the Center Frequency, Step size and RBW.

Traces Specifies trace parameters such as detection method and whether smoothing is enabled. Traces can
also be saved and loaded for reference from this tab.

Scale Specify vertical and horizontal scale settings.

Prefs Specify appearance features of the graph area.

Freq & RBW Tab
The Freq & RBW tab specifies frequency parameters for some of the RF Measurements displays.
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Setting Description

Meas Freq Specifies the measurement frequency.

Step The Step control sets the increment/decrement size for the knob adjustment of the center frequency.
Arrow key adjustment of frequency is also affected (it is 10x the knob adjustment). If Auto is enabled,
the analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is Independent of
the Spectrum view's RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value.

Note: While the measurement frequency and step settings on this control tab are shared between ACPR, MCPR and Occupied
Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers to reduce the effect of noise on
the displayed signal. The VBW algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is 1/10,000 of the RBW setting.

Note: If you are following a procedure that says to "set VBW to three times the RBW value or greater", it means that the test
should be conducted with no VBW effects. In the SignalVu software, this condition is met by disabling the VBW function.

Traces Tab
The Traces tab enables you to select traces for display. You can choose to display live traces and/or recalled traces. The Trace tab for
Settling Time displays is described in the Settling Time controls section.

Note: Not all RF Measurements support multiple traces and/or save and recall of traces.
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Setting Description

Trace Selects a trace for display.

CCDF display: Choices are Trace 1, 2, and Gaussian. Trace 1 and 2 can be recalled.

Spurious display: Choices are Trace 1, 2, 3, 4, and Math trace. All traces can be recalled. Math trace
is computed for all ranges.

Show Shows / hides the selected trace.

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show recalled trace Used to select a saved trace for display. When a trace is recalled, controls such as show, freeze, and
function will be disabled.

Detection (Phase Noise only) Sets the Detector used for the trace. Only +/- Peak and Avg (VRMS) are available for the\ Phase
Noise display. This setting is not available for saved traces. +/-Peak detection results in a trace with
two Y values for each X location, with shading between.

Function Selects the trace processing method (Spurious display only). Possible settings are: Normal, Average
(VRMS), Avg (of logs), and Max Hold.

Smoothing (Phase Noise only) When enabled, diminishes point-to-point trace variations. Smoothing +/- Peak traces treats + and -
lines independently. The smoothing value adjusts how many points are in each filter set. Range: 1 -
20; Default: 5.

Smooth: (points)

Average: (count)

Available for Phase and Frequency Settling Time displays only.

Smooth is a low-pass filter function that uses n points in the trace to determine the smoothed value.

Average sets the number of acquisitions to be averaged together to produce the result.

See Trace Tab for Settling Time Displays on page 203 for complete details.

Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the maximum number of trace points is
100,000, and the selected analysis region is 200,000 samples, the measurement must decimate the 200,000 resulting trace points by 2 to
prevent exceeding the 100,000 trace point limit. Since only one value can be selected for each trace point, an algorithm must be used to
select (detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to each trace point varies
with both analysis length and trace length. For example, with Spectrum Length set to ‘Auto’ in the Analysis menu, the instrument analyzes
just enough samples to produce one IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods (depending on the display) are:

• +/-Peak – Selects the highest and lowest values of all the samples contained in an acquisition interval.
• Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage value for all of the IQ samples

available to the trace point. When displayed in either linear (Volts, Watts) or Log (dB, dBm), the correct RMS value results. When the
averaging function is applied to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average for
RMS values.
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Trace processing (Function)
The trace can be processed to display in different ways. The Function setting controls trace processing.

• Max Hold - Displays the maximum value in the trace record for each display point. Each new trace display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

• Normal - Displays the trace record for each display point without additional processing.
• Avg (VRMS) [Average VRMS] – Multiple traces are averaged together to generate the displayed trace, which will contain just one

vertical value for each underlying frequency data point. Once the specified number of traces have been acquired and averaged to
generate the displayed trace, additional traces contribute to the running average, except in Single Sequence run mode. In the case
of Single Sequence, the instrument stops running after the specified number of traces have been averaged together. The Number of
Traces setting specifies how many traces are averaged. The averaging is performed on the linear (Voltage) values, resulting in the
correct RMS average).

• Avg (of logs) – This is a trace function used to emulate legacy spectrum analyzer results and for the specification of displayed
average noise level. In older swept analyzers, a voltage envelope detector is used in the process of measuring signal level, and the
result is then converted to Watts and then to dBm. Averaging is then applied to the resultant traces.

For CW signals, this method results in an accurate power measurement. However, with random noise and digitally modulated carriers,
errors result from this 'average of logs' method. For random noise, the average of logs methods results in power levels -2.51 dB lower
than that measured with a power meter, or with a spectrum analyzer that measures the rms value of a signal, and performs averaging
on the calculated power in Watts and not dBm or other log-power units.

This detector should be used when following a measurement procedure that specifies it, or when checking the Displayed Averaged
Noise Level (DANL) of the instrument. The 'average of logs' detection and trace function is used for DANL specification to provide
similar results to other spectrum/signal analyzers for comparison purposes. Use of the Average of Logs method of measurement is not
recommended for digitally modulated carriers, as power measurement errors will occur.

Note: The Detection setting does not affect the trace until the spectrum length is longer than the Auto setting.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.
2. Check the Show check box.
3. Click the ... button to display the Open dialog box.

1. Navigate to the desired file and click Open.
2. Check the Show Recalled Trace check box.
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3. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list located at the top-left corner of the
graph).

Gaussian Trace (applies only to CCDF)
The Gaussian trace is a reference trace that you can compare your trace against. Because the Gaussian trace is for reference, there are
no settings for the trace other than whether or not it is shown.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Center Frequency. Parameters on this tab may vary depending on the selected
display.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units. This is only accessible when the vertical units are set to dBm.

Position Adjusts the level shown at the center of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Rest Scale Resets all settings to their default values.

Horizontal Controls the span of the trace display and position of the trace.

Scale (Start) Allows you to, in effect, change the span.

Position (Stop) Adjusts the position of the acquisition record shown at the left edge of the graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Log (Spurious only) Resets the display to show the frequency axis in a logarithmic scale.
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Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on the Prefs tab vary depending
on the selected display, but include such items as enabling/disabling Marker Readout and switching the Graticule display on/off. Some
parameters appear with most displays while others appear with only one display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points In general, time-domain traces can include up to 100K points and frequency-domain traces can
include up to 10K points. When the analysis produces a results array longer than the selected trace
length, the trace is decimated (using the method specified with the Detection control) to be equal to or
less than the Max trace points setting (except when Max trace points is set to Never Decimate). This
decimated (or undecimated) trace is what is used for marker measurements and for results export.

Settling Time decimal places
(Frequency and Phase Settling
Time displays only)

Specifies the number of decimal places shown in the results readout below the graph. This setting
does not affect the precision of internal calculations.

Show trace legend (CCDF
(Complementary Cumulative
Distribution Function) display
only)

Displays or hides the trace legend.
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WLAN Measurements
WLAN Measurements Overview
The WLAN Analysis option allows you to evaluate WLAN signals, performing standards based transmitter measurements in the time,
frequency, and modulation domains. WLAN measurements can be made on signals defined by 802.11a/b/g/j/n/p (standard IEEE
802.11-2012) and 802.11ac (draft IEEE P802.11ac-D4.0 or later). User controls allow you to modify signal parameters for analysis
of signals. The analysis results give multiple views of WLAN signal characteristics to allow the diagnosis of signal imperfections and
impairments quickly and easily. Display controls allow you to selectively display the analysis results to help locate trouble-spots in the
signal.

WLAN Standards
The following options support the given standards:

• Option SV23: Supports IEEE 802.11a, g, j, and p OFDM signals and 802.11b DSSS/CCK signals
• Option SV24: Supports IEEE 802.11n signals with bandwidths of 20 MHz and 40 MHz
• Option SV25: Supports IEEE 802.11ac signals with bandwidths of 20, 40, 80, and 160 MHz

WLAN Standards Presets
The Standards Presets button located on the WLAN Settings Control Panel allows you to recall preconfigured displays for the standards
and bandwidths that you select. You can also access these presets from Presets on the display menu bar. You can read more information
about the Standards Presets.

The following table shows the center frequency and displays that are automatically loaded for each of the listed standards and bandwidths.
SEM masks are also loaded and are explained here.
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Table 13: WLAN presets standards, bandwidths, center frequencies, and displays

Standard Bandwidth (MHz)
Center frequency
(GHz) Displays loaded

802.11a 20 5.18 SEM, Time Overview, WLAN Constellation, WLAN Summary

802.11g 20 2.412

802.11j 10 5.18

20

802.11p 5 5.8

10

20

802.11n 20 2.412

40

802.11ac 20 5.18

40 5.19

80 5.21

160 5.25

802.11b 2.412

SEM mask parameters. The SEM wireless standard masks that are applied to the WLAN signal depend on the standard you select when
you configure the preset. Once you select a standard and bandwidth, the application will automatically load the mask that best fits the
signal for which the standard applies. All mask parameters are derived from IEEE standards and loaded for you. This provides you the
assurance that you are evaluating the signal with the most appropriate mask.

WLAN Displays
The displays in WLAN Analysis (Setup > Displays > Measurements) are:

• SEM
• WLAN Channel Response
• WLAN Constellation
• WLAN EVM
• WLAN Magnitude Error
• WLAN Phase Error
• WLAN Power versus Time
• WLAN Spectral Flatness
• WLAN Summary
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WLAN Channel Response Display
The WLAN Channel Response display plots the channel response (magnitude and phase) versus the subcarrier or frequency. Here, the
channel refers to all sources of signal frequency response impairment up to the analyzer input, including the transmitter itself, as well as
any transmission medium through which the signal travels between the transmitter and the analyzer.

Note: WLAN Channel Response is only available for OFDM (non-802.11b) signals.

To show the WLAN Channel Response display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Chan Response icon or select the icon and click Add. The WLAN Chan

Response icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Chan Response display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing, and Bandwidth controls as appropriate for

the input signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Display

Item Display element Description

1 Magnitude graph (top graph)

1a Top of graph Sets the level that appears at the top of the magnitude graph. This is only a visual
control for panning the graph. The Reference Level is adjusted in the Toolbar and the
Ampl control panel. By default, Vert Position = Ref Level.

Table continued…
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Item Display element Description

1b Position (dB) Sets the vertical position value. The maximum value is 20.00 dB. The readout
indicates the subcarrier (for non-b standards only) or frequency shown at the bottom
of the display.

1c Bottom of graph readout Indicates the magnitude at the bottom of the top graph. This value changes with the
dB and vertical Position settings.

2 Phase graph (bottom graph)

2a Top of graph Sets the phase value indicated at the top of the graph. Since the Position value at the
vertical center of this graph remains constant as the Top of Graph value is adjusted,
the Vertical Scale increases as the Top of Graph value increases, which also affects
the bottom of graph readout.

2b Position (°) Specifies the phase shown at the center of the graph display. Changing this value
moves the trace up and down in the graph, which affects the Top of Graph and Bottom
of Graph values as well.

2c Bottom of bottom graph readout Indicates the phase at the bottom of the bottom graph. This value changes with the
Position setting.

3 Autoscale Adjusts the Vertical and Horizontal scaling to optimize the trace display on screen.

4 Start (Position) Shifts the trace left or right in the graph. The readout indicates the subcarrier (for
non-b standards only) or frequency shown at the left edge of the display.

5 Stop (Scale) Specifies the number of subcarriers (for non-b standards only) shown in the graph.

WLAN Channel Response Settings
The WLAN Channel Response Settings control panel provides access to settings that control parameters of the Channel Response
Display.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Tab Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the time units (Symbols or Seconds) for WLAN Analysis displays.

Traces Tab Enables you to select from magnitude or phase trace, save a trace, and recall an trace

Scale Tab Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.
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WLAN Constellation Display
The WLAN Constellation Display shows the WLAN signal modulation amplitude and phase in I (horizontal) versus Q (vertical) form.
For multicarrier WLAN OFDM signals, the points show all data symbol subcarriers' modulation. For single-carrier 802.11b, each point
corresponds to a single modulated chip.

To show the WLAN Constellation display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Constellation in the Measurements box.
4. In the Available displays box, double-click the WLAN Constellation icon or select the icon and click Add. The WLAN Constellation

icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Constellation display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval, Channel Bandwidth, and Subcarrier Spacing controls as

appropriate for the input signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Display

Item Display element Description

1 Plot Constellation graph.

Table continued…
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Item Display element Description

2 Marker readout If markers are enabled, the marker readout shows the selected Marker, Symbol,
Subcarrier, Type, Value, Magnitude, and Phase for the symbol at the marker location.
Located to the left of the constellation plot or below it, depending on the size of the
window.

3 Marker controls Define and position markers.

WLAN Constellation Settings
Main menu bar: Setup > Settings

Favorites toolbar:

The WLAN Constellation Settings control panel provides access to settings that control parameters of the Constellation Display. 

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Tab Enables you to freeze the display or hide the measurement or average trace.

Scale Tab Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

WLAN EVM Display
The WLAN EVM display shows the data symbols' individual subcarrier Error Vector Magnitude values versus symbol interval (time) and
subcarrier (frequency).

Note: For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN EVM display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN EVM in the Measurements box.
4. In the Available displays box, double-click the WLAN EVM icon or select the icon and click Add. The WLAN EVM icon will appear in

the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN EVM display.
6. Set the Frequency appropriate for the signal.
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7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard as appropriate. Set the Standard, Guard Interval, Channel Bandwidth, and

Subcarrier Spacing controls as appropriate for the input signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Display

Item Display element Description

1 Top of graph Sets the EVM value that appears at the top of the graph. This is only a visual control for
panning the graph.

2 Bottom of graph Sets the EVM value that appears at the bottom of the graph. This is only a visual control
for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Start (Position) Specifies the horizontal position of the trace on the graph display.

5 Stop (Scale) Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

WLAN EVM Settings
Main menu bar: Setup > Settings 

Favorites toolbar:

The settings for the WLAN EVM display are shown in the following table.
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Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Enables you to freeze the display or hide the measurement or average trace.

Scale Specifies the vertical, subcarrier (for non-b standards only) and symbols scale and position settings.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Magnitude Error Display
The WLAN Magnitude Error display shows the data symbols' individual subcarrier Magnitude Error values versus symbol interval (time)
and subcarrier (frequency).

Note: For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN Magnitude Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Mag Error icon or select the icon and click Add. The WLAN Mag Error icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Mag Error display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph Sets the Magnitude Error value that appears at the top of the graph. This is only a visual
control for panning the graph.

2 Bottom of graph Sets the Magnitude Error value that appears at the bottom of the graph. This is only a
visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

WLAN Magnitude Error Settings
Main menu bar: Setup > Settings

The settings for the WLAN Mag Error display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Phase Error Display
The WLAN Phase Error display shows the data symbols' individual subcarrier Phase Error values versus symbol interval (time) and
subcarrier (frequency).

Note: For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN Phase Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Phase Error icon or select the icon and click Add. The WLAN Phase Error icon

will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Phase Error display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph Sets the Phase Error value that appears at the top of the graph. This is only a visual
control for panning the graph.

2 Bottom of graph Sets the Phase Error value that appears at the bottom of the graph. This is only a visual
control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

WLAN Phase Error Settings
Main menu bar: Setup > Settings 

The settings for the WLAN Phase Error display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Power vs Time Display
The WLAN Power vs Time display shows the signal power amplitude versus time. For 802.11b signals, the packet Power-On and
Power-Down ramp times are also measured.

To show the WLAN Power vs Time display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Power vs Time icon or select the icon and click Add. The WLAN Power vs Time

icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Power vs Time display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Display
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Item Display element Description

1 Top of graph, first setting Sets the Power level that appears at the top of the graph, in dBm. This is only a visual
control for panning the graph.

(not
shown)

Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

2 Top of graph, second setting Sets the vertical Scale of the graphs, in dB/div. This is only a visual control for panning the
graph.

3 View Selects the specific view of the packet burst within the display:

- Full Burst displays the entire packet, with vertical lines indicating length of the packet

- Rising Edge zooms the display into the interval around the packet rising edge, with
vertical lines indicating the 10% to 90% Power-On Ramp time

- Falling Edge zooms the display into the interval around the packet falling edge, with
vertical lines indicating the 90% to 10% Power-Down Ramp time

4 Bottom of graph readout Shows the Power level at the bottom of the graph in dBm.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Bottom of graph, left side Sets the starting time of the graph in seconds

7 Bottom of graph, right side Sets the scale (width) of the graph in seconds

8 Table below graph - Burst Power: Average power of the burst packet, in dBm

- Burst Width: Measured time width of the burst packet from Power-On to Power-Down (or
end of waveform, if that occurs before Power-Down), in seconds

Note: Power-On Ramp Time and Power-Down Ramp Time values are only
available for 802.11b analysis.

- Power-On Ramp Time: Time interval for signal level to increase from 10% to 90% of
maximum packet power, in seconds

- Power-Down Ramp Time: Time interval for signal level to decrease from 90% to 10% of
maximum packet power, in seconds. This value is not available is the analysis record does
not include the packet power-down portion.

WLAN Power vs Time Settings
Main menu bar: Setup > Settings 

The settings for the WLAN Power vs Time display are shown in the following table.
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Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

Scale Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Spectral Flatness Display
The WLAN Spectral Flatness display shows the average power levels of subcarriers across the signal bandwidth and indicates if they
remain within the limits defined for a particular standard.

The averaged subcarrier level is shown as a line on the display, while the individual subcarrier levels are shown as points. The Pass or Fail
result indicates whether the average line remains between the upper and lower limit mask boundaries.

Note: WLAN Spectral Flatness is only available for OFDM (non-802.11b) signals.

To show the WLAN Spectral Flatness display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Flatness icon or select the icon and click Add. The WLAN Flatness icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Flatness display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing, and Channel Bandwidth controls as

appropriate for the input signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph, first setting Sets the Flatness value that appears at the top of the graph in dB. This is only a visual
control for panning the graph.

2 Top of graph, second setting Sets the lower range of the Flatness value that appears at the top of the graph in dB/div.
This is only a visual control for panning the graph.

3 Bottom of graph Shows the Flatness value set at the bottom of the graph.

4 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

5 Posn Specifies the horizontal position of the trace on the graph display.

6 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the analysis results by adjusting the position.

WLAN Spectral Flatness Settings
Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Spectral Flatness display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis.

Note: The Units control on this tab only affects the Analysis Length (AFAIK). Use the Units
control in the Prefs tab to affect the displays.

Trace Enables you to display or hide the measurement or average trace.

Scale Tab Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Summary Display
The WLAN Summary display shows several measurements of WLAN signal quality. The summary display and it’s contents will vary by
standard selected. Not all of the display contents are provided in this section.

To show the WLAN Summary display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Summary icon or select the icon and click Add. The WLAN Summary icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Summary display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.
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WLAN Summary Display for 802.11a/g/j/p/n/ac Signals

Elements of the Display for 802.11a/g/j/p/n/ac Signals
Table 14:

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Bandwidth Display of the channel bandwidth selected on Setup > Settings > Modulation Parameters tab.

Burst Power The average power of all symbols in the packet, including Preamble and Data segments.

Peak-to-Average The ratio of the highest instantaneous signal power level to the average signal power.

Burst Index The index of the analyzed packet within the analysis record.

IQ Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It indicates the level
of carrier feedthrough detected at the center (DC) subcarrier.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the measurement
frequency setting.

Common Pilot Error The RMS magnitude error of the pilots over all data symbols.

Symbol Clk Error The symbol clock error in parts per million.

Table continued…
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Measurement Description

EVM The RMS and Peak values of the normalized subcarrier Error Vector Magnitude values. The
normalized subcarrier EVM values are calculated as the difference between the detected received
signal subcarrier constellation points and ideal reference points estimated by the instrument from the
received signal. Values are reported in units of percent or dB. Peak values include the symbol and
subcarrier location.

RMS and Peak values are displayed for groupings of all subcarriers, Pilots only and Data only.
Results are calculated over all Data symbols in the packet.

Average RMS and Peak RMS values are accumulated over multiple packet analysis cycles. The Clear
button on the display resets these values by clearing the result memory.

Packet Format Displays the packet format: AG, HT_MF, HT_GF, VHT.

Data Modulation Displays the modulation used in the Data symbols: BPSK, QPSK, 16QAM, 64QAM, 256QAM.

Guard Interval Displays the Guard Interval used by the Data symbols: 1/4, 1/8.

Symbols, EVM, Avg Power Displays the type and number of symbols, EVM-RMS and average power of the Preamble and Data
portions of the packet.

SIG Data

L-SIG Data

HT-SIG Data

VHT-SIG Data

Displays he decimal values of the received packet SIGNAL, HT-SIGNAL and VHT-SIGNAL symbols'
fields. The Pass/Fail result in each heading line indicates whether the calculated Parity or CRC value
matches the received Parity or CRC value of the corresponding SIGNAL symbol grouping.

WLAN Summary Display for 802.11b Signals
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Elements of the Display for 802.11b Signals
Table 15:

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Parameters tab.

Burst Power The average power of the entire packet.

Peak-to-Average The ratio of the highest instantaneous packet signal power level to the average signal power.

Burst Index The index of the analyzed packet within the analysis record.

IQ Origin Offset The amount of power at the signal carrier frequency relative to the total power of the signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the measurement
frequency setting.

EVM The RMS and Peak values of the normalized Error Vector Magnitudes taken at signal chip intervals.
The normalized EVM values are calculated as the difference between the detected received signal
constellation points and ideal reference points estimated by the instrument from the received signal.
Values are reported in units of percent or dB. Peak values indicate the associated chip locations.

RMS and Peak values are displayed for groupings of All chips, and the first 1000 (1k) chips.

Average RMS and Peak RMS values are accumulated over multiple packet analysis cycles. The Clear
button on the display resets these values by clearing the result memory.

Packet Format Displays the packet format: DSSS 1M, DSSS 2M, CCK 5.5M or CCK 11M.

Data Modulation Displays the modulation used in the PSDU/Data packet segment.

Chips, EVM, Avg Power Displays the number of chips, EVM-RMS and average power of the Preamble, Header and Data
portions of the packet.

Header Data Displays he decimal values of the received packet Header's Signal, Service, Length, and CRC fields.
The CRC Pass/Fail result indicates if the received CRC value is equal to the CRC value computed
from the received Signal, Service and Length values.

WLAN Summary Settings
Main menu bar: Setup > Settings 

Favorites toolbar:

The settings for the WLAN Summary display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.

Table continued…
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Settings tab Description

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.

EVM Specifies the EVM units (dB or %) and Max Bursts to Avg. The EVM is generally measured on symbol
or chip instants and is usually measured after best-fit estimates of the frequency error and a fixed
phase offset have been removed.

Prefs Specifies the units of the display and whether elements of the graphs are displayed.

WLAN Symbol Table Display
The WLAN Symbol Table display shows decoded data values for each data symbol in the analyzed signal packet. For OFDM signals
(all standards except 802.11b), results are presented with subcarrier (frequency) indices in the horizontal dimension and symbol (time)
intervals in the vertical dimension. For 802.11b signals, the Preamble, Header, and Data (PSDU) symbol values are presented sequentially,
with symbol indices in the left column.

To show the WLAN Symbol Table display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select WLAN Analysis in the Measurements box.
4. In the Available displays box, double-click the WLAN Symb Table icon or select the icon and click Add. The WLAN Symbol icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the WLAN Symbol Table display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
9. If you are analyzing a data file, press the Replay button to take measurements on the recalled acquisition data file.

WLAN Measurements

RSA5100B Series Real-Time Signal Analyzers Help 239



WLAN Symbol Table for OFDM signals

Item Description
1 Subcarrier identifiers (OFDM only). Yellow column indicates Pilot

subcarrier locations.
2 Symbol identifiers
3 Subcarrier data values.
4 Marker readout when markers are enabled.

WLAN Measurements

RSA5100B Series Real-Time Signal Analyzers Help 240



WLAN Symbol Table for 802.11b signals

Item Description
1 Symbol number index (from beginning of packet or segment) of first

Symbol data value on the line.
2 Symbol values, with the value in column 2 of each row

corresponding to the symbol number index in column 1, and then
the symbol value in column 3 corresponding to the next symbol
number index, etc., to the end of each row.

For example: The symbol number index 130 = 0 in column 2. The
symbol number index for column 3 is 131, which equals 0. The
symbol number index for column 4 is 132, which equals 1. This
pattern continues to the end of the row.

WLAN Symbol Table Settings
Main menu bar: Setup > Settings

Front panel: Settings

Favorites toolbar:

The settings for the WLAN Symbol Table display are shown in the following table.

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Analysis Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.
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WLAN Analysis Shared Measurement Settings
Main menu bar: Setup > Settings

Favorites toolbar:

The control panel tabs in this section are shared between the displays in the WLAN Analysis folder (Setup > Displays). Some tabs are
shared by all the displays, some tabs are shared by only a subset of displays. The settings available on some tabs change depending on
the selected display.

Table 16: Common controls for WLAN analysis displays

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Analysis Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.
Trace Enables you to display or hide the measurement or average trace.
Scale Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and position settings.
EVM Specifies the EVM units and max burst averages.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.

Modulation Params Tab - WLAN
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that define the signal format.

Settings Description

Standard Specifies the standard used for the input signal. Choices are 802.11a/b/g/j/n/p/ac.

Guard Interval Specifies the guard interval used in the input signal. You can select the following:

– Auto from SIG uses the Guard Interval value extracted from the signal

– 1/8 allows setting the value manually

– 1/4 allows setting the value manually

Channel Bandwidth Specifies the nominal channel bandwidth. This setting affects the Subcarrier Spacing value
when the Subcarrier Spacing Auto box is checked.

Table continued…
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Settings Description

Subcarrier Spacing Specifies the spacing between subcarriers. When Auto is selected, this setting is
automatically calculated according to the Channel Bandwidth value. If Auto is unchecked, a
custom subcarrier spacing value can be entered for nonstandard signal definition.

FFT Sample Rate Indicates the FFT sample rate, based on the bandwidth or subcarrier setting.

FFT Length Indicates the fixed FFT length.

Analysis Params Tab - WLAN
The Analysis Params tab contains parameters that control the analysis of the input signal.

Settings Description

Burst Selection Index Allows specifying the burst you want to measure when multiple bursts are present in an
acquisition. Index number of the first burst is 1, second burst is 2, etc.

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error and the
measured Frequency Error is displayed. When the Auto box is unchecked, the entered value
is used by the analysis as a fixed frequency offset. This is useful when the exact frequency
offset of the signal is known.

Symbol Analysis Offset Specifies the analysis offset in the symbol interval. This value is a percentage of the Guard
Interval. The allowable range is -100% to 0%. -100% positions the FFT to start at the
beginning of the Guard Interval, 0% positions it to start at the end of the Guard Interval.
Default value is -50% which usually gives the best measurement results.

Swap I & Q Select the checkbox to swap the I and Q components of a signal. This compensates the
input signal for spectral inversion.

Equalizer Training Specifies the method used to estimate channel frequency response and equalization. This
control can be used to diagnose changes in frequency response over the signal packet.

Preamble The instrument uses only the Preamble to estimate channel frequency response. This
response is then used to equalize the entire signal packet.

Table continued…

WLAN Measurements

RSA5100B Series Real-Time Signal Analyzers Help 243



Settings Description

Preamble + Data The instrument makes an initial channel frequency response estimate from the Preamble.
It then estimates the channel response for each data symbol using the decoded data
content to derive equalization for each symbol individually. This allows compensation for
time-varying channel response over the packet.

Data Modulation Allows choice of automatic or manual method of data symbol modulation identification, as
follows:

– Auto Detect estimates the modulation from the data symbol IQ content.

– Auto from SIG sets the modulation as indicated by the embedded SIG preamble symbol
format data.

– Manual allows specifying the modulation type regardless of the signal content.

Enable 1024QAM detection Check box to enable auto-detection of 1024QAM.

Pilot tracking Specifies if pilot subcarriers should be used to correct amplitude, phase, and symbol timing
variations over the packet. The choices available are Phase, Amplitude, and Timing. The
default setting is Phase correction enabled, Amplitude and Timing correction disabled..

Subcarrier derotation Allows some displays to show subcarriers with or without Gamma subcarrier phase rotation
removed. Gamma phase rotation is applied to 802.11n and 802.11ac subcarriers in defined
subranges depending on the selected Channel Bandwidth >40 MHz. Only Constellation and
Symbol Table results are affected by this control.

When the box is unchecked, the rotation is not removed, which provides a direct view of the
physical modulation on the channel.

When the box is checked, the rotation is removed, allowing easier decoding of the
underlying data content.

Data Range Tab - WLAN
The Data Range tab enables you to control how much signal is analyzed, as well as specify the range of results that are displayed for the
WLAN Constellation, EVM, Flatness, Magnitude Error, Phase Error, and Symbol Table graphs. The tab contents vary by standard.

Data Range tab for non-b standards.

Settings Description

Symbols Specifies which symbols are displayed in the graphs.
All Select All to display all symbols.
Range Select Range to specify a subset of symbols for display.
Table continued…
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Settings Description

Start Specifies the first symbol to include in the display.
Stop Specifies the last symbol to include in the display.
Single Select Single to display a single symbol.
Index Use Index to specify the symbol you want to display.
Subcarriers Specifies which subcarriers are displayed.
All Select All to display all subcarriers in the signal.
Pilots Select Pilot to display only pilot subcarriers.
Data Select Data to display only data subcarriers.
Single Specifies a specific subcarrier for display.
Index Specifies the specific subcarrier to be displayed.

Range Specifies a range of subcarriers to be displayed.

Start Specifies the start value of the range to be displayed.
Stop Specifies the ending value of the range to be displayed.
Max symbols to analyze Specifies how many symbols are analyzed. You can use this setting to speed analysis by

limiting the number of symbols being analyzed.

Data Range tab for 802.11b standards.

Settings Description

Chips Specifies which symbols are displayed in the graphs.
All Select All to display all chips.
Preamble Only Select to include only the Preamble in the display.
Header Only Select to include only the Header in the display.
Data Only Select to include only the Data in the display.
Max number of chips to analyze Specifies how many chips are analyzed. You can use this setting to speed analysis by

limiting the number of chips being analyzed. Check this box and then enter the maximum
number of chips to analyze.

Analysis Time Tab - WLAN
The Analysis Time tab contains parameters that define how the signal is analyzed in the WLAN Analysis displays.
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Settings Description

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Use this to specify how long a period of time is analyzed.

– Range: minimum value depends on modulation type

– Resolution: 1 symbol

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Units Specifies the units of the Analysis Length in either Symbols or Seconds.

Trace Tab - WLAN
The Trace tab allows you to set the trace display characteristics of the selected display. This tab is not available for all WLAN displays.

Settings Description

Trace Use this drop-down list to select whether or not the Average trace or the measurement trace is
displayed. The measurement trace depends on the selected display.

Show Symbols Select or deselect this checkbox to show or hide symbols.

Freeze Selecting Freeze halts updates to the symbols.

Traces Tab - WLAN Channel Response
The Traces tab allows you to set the trace display characteristics of the WLAN Channel Reponse display.
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Settings Description

Trace Selects the Magnitude or Phase trace for saving or recalling.

Save Trace As . . . Select to save a trace.

Recall Trace . . . Select to recall a trace.

Scale Tab - WLAN
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. There are four versions of the Scale tab for WLAN displays. One version is used for the
Constellation display, one for the Spectral Flatness display, one for the Power vs Time display, and one for the EVM, Magnitude Error,
Phase Error, and Channel Response displays.

Figure 49: Scale tab for the WLAN Power vs Time display

Figure 50: Scale tab for WLAN EVM, Magnitude Error, Phase Error, and Channel Response displays

Figure 51: Scale tab for WLAN Constellation display
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Figure 52: Scale tab for WLAN Spectral Flatness display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Subcarrier Controls the scale of the subcarrier graph and position of the trace.

Scale Specifies how many subcarriers are displayed horizontally.

Position Specifies the subcarrier that appears at the left edge of the subcarrier graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Symbols Controls the scale of the Symbols graph.

Scale Specifies the number of symbols that appear in the symbols graph.

Position Specifies the symbol that appears at the left edge of the Symbols graph.

Autoscale Resets the scale and position settings to optimize the display.

Auto When Auto is checked, the scale and position values for the Symbols graph are automatically
adjusted to maintain the optimal display.

Zoom Sets the Constellation display size and position.

Scale Sets the magnification value for the Constellation display.

Vertical Position Sets the vertical location of the Constellation display within the graph. Range is -3.7 to +3.7.

Horizontal Position Sets the horizontal location of the Constellation display within the graph. Range is -3.7 to +3.7.

EVM Tab - WLAN
The EVM Tab enables you to chose between dB and percent for the EVM units and to select to set the maximum bursts to average. The
EVM Tab is only available for the WLAN Summary display.
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Settings Description

EVM units Specifies whether the displayed EVM units are dB or percent.

Max Bursts to Avg Specifies the maximum number of bursts to average when Count is selected.

Count Enables the Max Bursts to Avg function.

Prefs Tab - WLAN
The Prefs tab enables you to change appearance characteristics of the WLAN Analysis displays. Not all settings on the Prefs tab shown
below appear for every WLAN display.

Settings Description

Time units Specifies whether the displayed time units are seconds or symbols.

Freq units Specifies whether the displayed frequency units are frequency (Hz) or subcarrier channel.

Radix Specifies whether symbol values are displayed in binary or hex format (for example, in the Symbol
Table or markers readouts).

Show graphs Specifies which graphs are displayed. Select from Symbols, Subcarriers or Both, Magnitude, Phase,
or Both. Disabled (no masks), Shaded Region, or Line Only. These selections are only available for
OFDM signals.

Show graticule Specifies to show the graticule on the display when checked.

Show marker readout Specifies to show the marker readout when checked.
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OFDM Analysis
OFDM Analysis Overview
The OFDM Analysis option provides measurements for OFDM signals specified by 802.11a/g/j (Wifi) and 802.16 (2004) (commonly known
as Fixed WiMAX) standards. User controls allow you to modify signal parameters for analysis of non-standard signals. The analysis results
give multiple views of OFDM signal characteristics to allow diagnosing signal imperfections and impairments quickly and easily. Display
controls provide the ability to selectively display the analysis results to help locate trouble-spots in the signal.

The displays in OFDM Measurements (Displays > Measurements > OFDM Measurements) are:

• OFDM Channel Response
• OFDM Constellation
• OFDM EVM
• OFDM Spectral Flatness
• OFDM Mag Error
• OFDM Phase Error
• OFDM Power
• OFDM Summary
• OFDM Symbol Table

OFDM Channel Response Display
The OFDM Channel Response display plots the channel response (magnitude or phase) versus the subcarrier or frequency. Here, the
channel refers to all sources of signal frequency response impairment up to the analyzer input, including the transmitter itself, as well as
any transmission medium through which the signal travels between the transmitter and the analyzer.

To show the OFDM Channel Response display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Chan Response icon or select the icon and click Add. The OFDM Chan

Response icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Chan Response display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
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Elements of the Display

Item Display element Description

1 Top-of-graph (magnitude) Sets the level that appears at the top of the magnitude graph. This is only a visual control
for panning the graph. The Reference Level is adjusted in the Toolbar and the Ampl control
panel. By default, Vert Position = Ref Level.

2 dB/div (magnitude) Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 Display selector Selects the display type. Channel Response Magnitude or Phase can be displayed as a
Magnitude or Phase graph.

4 Bottom-of-graph readout
(magnitude)

Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

5 Autoscale Adjusts the Vertical and Horizontal scaling to display the optimize the trace display on
screen.

Table continued…
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Item Display element Description

6 Pos Shifts the trace left or right in the graph. The readout indicates the subcarrier or frequency
shown at the left edge of the display.

7 Scale Specifies the number of subcarriers shown in the graph.

8 Top-of-graph (phase) Sets the phase value indicated at the top of the graph. Since the Position value at the
vertical center of this graph remains constant as the Top of Graph value is adjusted,
the Vertical Scale increases as the Top of Graph value increases, which also affects the
bottom of graph readout.

9 Position (phase) Specifies the phase shown at the center of the graph display. Changing this value moves
the trace up and down in the graph, which affects the Top of Graph and Bottom of Graph
values as well.

10 Bottom-of-graph (phase) Indicates the phase at the bottom of the graph. This value changes with the Position
setting.

OFDM Channel Response Settings
The OFDM Channel Response Settings control panel provides access to settings that control parameters of the Channel Response
Display.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Tab Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the time units (Symbols or Seconds) for OFDM Analysis displays.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Constellation Display
Display shows the OFDM signal subcarriers' amplitude and phase in IQ constellation form.

To show the OFDM Constellation display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Constellation in the Measurements box.
4. In the Available displays box, double-click the OFDM Constellation icon or select the icon and click Add. The OFDM Constellation

icon will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Constellation display.
6. Set the Frequency appropriate for the signal.
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7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.

Elements of the Display

Item Display element Description

1 Plot Constellation graph.

2 Marker Readout If markers are enabled, the marker readout shows the selected Marker, Symbol,
Subcarrier, Type, Value, Magnitude, and Phase for the symbol at the marker location.
Located to the left of the constellation plot or below it, depending on the size of the
window.

OFDM Constellation Settings
Main menu bar: Setup > Settings

Front panel: Settings

Favorites toolbar:

The OFDM Constellation Settings control panel provides access to settings that control parameters of the Constellation Display. 

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Advanced Params Specifies parameters used by the instrument to analyze the input signal.

Data Range Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.

Trace Enables you to freeze the display or hide the measurement or average trace.

Table continued…
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Settings tab Description

Scale Tab Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

OFDM EVM Display
The OFDM EVM display shows the data symbols' individual subcarrier Error Vector Magnitude values versus symbol interval (time) and
subcarrier (frequency).

To show the OFDM EVM display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM EVM in the Measurements box.
4. In the Available displays box, double-click the OFDM EVM icon or select the icon and click Add. The OFDM EVM icon will appear in

the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM EVM display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard as appropriate. Set the Standard, Guard Interval and Spacing and Bandwidth

controls as appropriate for the input signal.

Elements of the Display

Note: There is no carrier assigned to DC.

Item Display element Description
1 Top of graph Sets the EVM value that appears at the top of the graph. This is only a visual control for

panning the graph.
2 Bottom of graph Sets the EVM value that appears at the bottom of the graph. This is only a visual control

for panning the graph.
Table continued…
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Item Display element Description
3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
4 Pos Specifies the horizontal position of the trace on the graph display.
5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially

becomes a window that you can move over the analysis results by adjusting the position.

OFDM EVM Settings
Main menu bar: Setup > Settings 

Front panel: Settings

Favorites toolbar:

The settings for the OFDM EVM display are shown in the following table.

Settings tab Description

Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Advanced Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.
Trace Enables you to freeze the display or hide the measurement or average trace.
Scale Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Spectral Flatness Display
The OFDM Spectral Flatness display shows the average power levels of subcarriers across the signal bandwidth and indicates if they
remain within the limits defined for a particular standard.

The averaged subcarrier level is shown as a line on the display, while the individual subcarrier levels are shown as points. The Pass or Fail
result indicates whether the average line remains between the upper and lower limit mask boundaries.

To show the OFDM Spectral Flatness display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Flatness icon or select the icon and click Add. The OFDM Flatness icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Flatness display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing and Channel Bandwidth controls as

appropriate for the input signal.
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Elements of the Display

Item Display element Description
1 Top of graph Sets the Flatness value that appears at the bottom of the graph in dB. This is only a visual

control for panning the graph.
2 Bottom of graph Shows the Flatness value set at the top of the graph.
3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
4 Pos Specifies the horizontal position of the trace on the graph display.
5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially

becomes a window that you can move over the analysis results by adjusting the position.

OFDM Spectral Flatness Settings
Main menu bar: Setup > Settings

Front panel: Settings

Favorites toolbar:

The settings for the OFDM Spectral Flatness display are shown in the following table.

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Advanced Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for WLAN Analysis displays.
Trace Enables you to display or hide the measurement or average trace.
Scale Tab Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Analysis

RSA5100B Series Real-Time Signal Analyzers Help 256



OFDM Magnitude Error Display
The OFDM Mag Error display shows the data symbols' individual subcarrier Magnitude Error values versus symbol interval (time) and
subcarrier (frequency).

To show the OFDM Magnitude Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Mag Error icon or select the icon and click Add. The OFDM Mag Error icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Mag Error display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.

Elements of the Display

Item Display element Description
1 Top of graph Sets the Magnitude Error value that appears at the top of the graph. This is only a visual

control for panning the graph.
2 Bottom of graph Sets the Magnitude Error value that appears at the bottom of the graph. This is only a

visual control for panning the graph.
3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
4 Pos Specifies the horizontal position of the trace on the graph display.
5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially

becomes a window that you can move over the analysis results by adjusting the position.

OFDM Magnitude Error Settings
Main menu bar: Setup > Settings

Front panel: Settings
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Favorites toolbar:

The settings for the OFDM Mag Error display are shown in the following table.

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Advanced Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.
Trace Enables you to display or hide the measurement or average trace.
Scale Tab Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs Tab Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Phase Error Display
The OFDM Phase Error display shows the data symbols' individual subcarrier Phase Error values versus symbol interval (time) and
subcarrier (frequency).

To show the OFDM Phase Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Phase Error icon or select the icon and click Add. The OFDM Phase Error icon

will appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Phase Error display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.

Elements of the Display
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Item Display element Description
1 Top of graph Sets the Phase Error value that appears at the top of the graph. This is only a visual

control for panning the graph.
2 Bottom of graph Sets the Phase Error value that appears at the bottom of the graph. This is only a visual

control for panning the graph.
3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
4 Pos Specifies the horizontal position of the trace on the graph display.
5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially

becomes a window that you can move over the analysis results by adjusting the position.

OFDM Phase Error Settings
Main menu bar: Setup > Settings 

Front panel: Settings

Favorites toolbar:

The settings for the OFDM Phase Error display are shown in the following table.

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Advanced Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Tab Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.
Trace Enables you to display or hide the measurement or average trace.
Scale Tab Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs Tab - OFDM on page 269 Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Power Display
The OFDM Power display shows the data symbols' individual subcarrier Power values versus symbol interval (time) and subcarrier
(frequency).

To show the OFDM Power display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Power icon or select the icon and click Add. The OFDM Power icon will appear

in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Power display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
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Elements of the Display

Item Display element Description

1 Vertical Position Sets the top of graph value. This is only a visual control for panning the graph. The
Reference Level is adjusted in the Toolbar and the Ampl control panel. By default, Vert
Position = Ref Level.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.
(not
shown)

Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

2 Bottom of graph readout Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
4 Pos Specifies the horizontal position of the trace on the graph display.
5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph essentially

becomes a window that you can move over the analysis results by adjusting the position.

OFDM Power Settings
Main menu bar: Setup > Settings 

Front panel: Settings

Favorites toolbar:

The settings for the OFDM Power display are shown in the following table.

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Advanced Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Table continued…
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Settings tab Description
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.
Trace Enables you to display or hide the measurement or average trace.
Scale Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Summary Display
The OFDM Summary display shows several measurements of OFDM signal quality.

To show the OFDM Summary display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Summary icon or select the icon and click Add. The OFDM Summary icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Summary display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.

Elements of the Display

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.
Frequency Error The frequency difference between the measured carrier frequency of the signal and the measurement

frequency setting.
IQ Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It indicates the level

of carrier feedthrough detected at the center (DC) subcarrier.
Average Power The average power of all symbols in the analysis. Calculated over only the data symbols in the

packet.
Symbols How many symbols were analyzed.
Symbol Clk Error The symbol clock error in parts per million.
CPE CPE, Common Pilot Error, is the RMS magnitude error of the pilots over all analyzed symbols.
Table continued…
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Measurement Description

Peak-to-Average The ratio of the highest instantaneous signal power level to the average signal power. Calculated over
only the data symbols in the packet.

EVM The RMS and Peak values of the normalized subcarrier Error Vector Magnitude values. The
normalized subcarrier EVM values are calculated as the difference between the detected received
signal subcarrier constellation points and ideal reference points estimated by the instrument from the
received signal. Values are reported in units of percent and dB. Peak values include the symbol and
subcarrier location.

RMS and Peak values are displayed for groupings of all subcarriers, Pilots only and Data only.
Results are calculated over the entire signal packet analyzed, covering the number of Symbols
indicated in the Summary display.

OFDM Summary Settings
Main menu bar: Setup > Settings 

Front panel: Settings

Favorites toolbar:

The settings for the OFDM Summary display are shown in the following table.

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Advanced Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Symbol Table Display
The OFDM Symbol Table display shows decoded data bits for each subcarrier in each symbol in the analyzed signal packet. Results are
presented with subcarrier (frequency) indices in the horizontal dimension and symbol (time) intervals in the vertical dimension.

To show the OFDM Symbol Table display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select OFDM Analysis in the Measurements box.
4. In the Available displays box, double-click the OFDM Symb Table icon or select the icon and click Add. The OFDM Symbol icon will

appear in the Selected displays box and will no longer appear under Available displays.
5. Click OK to show the OFDM Symbol Table display.
6. Set the Frequency appropriate for the signal.
7. Select Setup > Settings to display the control panel.
8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth controls as appropriate for the input

signal.
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Item Description
1 Subcarrier identifiers.
2 Symbol identifiers.
3 Subcarrier data values.
4 Marker readout when markers are enabled.

OFDM Symbol Table Settings
Main menu bar: Setup > Settings 

Front panel: Settings

Favorites toolbar:

The settings for the OFDM Symbol Table display are shown in the following table.

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Advanced Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.

OFDM Analysis Shared Measurement Settings
Main menu bar: Setup > Settings

Front panel: Settings

Favorites toolbar:
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The control panel tabs in this section are shared between the displays in the OFDM Analysis folder (Setup > Displays). Some tabs are
shared by all the displays, some tabs are shared by only a couple of displays. The settings available on some tabs change depending on
the selected display.

Table 17: Common controls for OFDM analysis displays

Settings tab Description
Modulation Params Specifies the type of modulation used for the input signal and other parameters.
Advanced Params Specifies parameters used by the instrument to analyze the input signal.
Data Range Specifies which symbols and subcarriers of the signal to display.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for OFDM Analysis displays.
Trace Enables you to display or hide the measurement or average trace.
Scale Specifies the vertical, subcarrier, and symbols scale and position settings.
Prefs Specifies the units of the display and whether elements of the graphs are displayed.

Modulation Params Tab - OFDM
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that control the demodulation
of the input signal.

Settings Description

Standard Specifies the standard used for the input signal. Choices are 802.11a/g/j and 802.16 (2004).

Guard Interval Specifies the guard interval used in the input signal. Choices are 1/4, 1/8, 1/16/, 1/32, and
User. When you select User, you can enter a percentage value to specify the size of the
guard interval as a percentage of the useful symbol interval. The Guard Interval range is
0–100%.

Spacing and Bandwidth Specifies the spacing between subcarriers and the nominal channel bandwidth. Only one of
these settings can be set at a time, the other setting is automatically calculated.

Sample Rate Indicates the FFT sample rate, based on the bandwidth or subcarrier setting.

Advanced Params Tab - OFDM
The Advanced Params tab contains parameters that control the analysis of the input signal.
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Settings Description

Constellation determination Specifies the method used to detect the constellation. Auto Detect analyzes the signal to
determine the appropriate constellation, Manual allows you to specify the constellation type.
Manual choices are: BPSK, QPSK, 16QAM, and 64QAM.

Symbol analysis offset Specifies the analysis offset in the symbol interval. This value is a percentage of the Guard
Interval. The allowable range is -100% to 0%. -100% positions the FFT to start at the
beginning of the Guard Interval, 0% positions it to start at the end of the Guard Interval.
Default value is -50% which usually gives the best measurement results.

Channel Estimation Specifies the method used to estimate channel frequency response and equalization. This
control can be used to diagnose changes in frequency response over the signal packet.

Preamble When you select Preamble, the instrument uses only the Preamble to estimate channel
frequency response. This response is then used to equalize the entire signal packet.

Preamble + Data When you select Preamble + Data, the instrument makes an initial channel frequency
response estimate from the Preamble. Then estimates the channel response for each data
symbol using the decoded data content to derive equalization for each symbol individually.
This allows compensation for time-varying channel response over the packet.

Pilot tracking Specifies if pilot subcarriers should be used to correct amplitude, phase, and symbol timing
variations over the packet. The choices available are Phase, Amplitude, and Timing. The
default setting is Phase.

Swap I & Q Select the checkbox to swap the I and Q components of a signal. This compensates the
input signal for spectral inversion.

Data Range Tab - OFDM
The Data Range tab enables you to control how much signal is analyzed, as well as specify the range of results that are displayed in the
Constellation, EVM, Magnitude Error, Phase Error, Power and Symbol Table graphs.
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Settings Description

Symbols Specifies which symbols are displayed in the graphs.

All Select All to display all symbols.

Range Select Range to specify a subset of symbols for display.

Start Specifies the first symbol to include in the display.

Number Specifies how many symbols to display in the graphs.

Single Select Single to display a single symbol.

Index Use Index to specify the symbol you want to display.

Subcarriers Specifies which subcarriers are displayed.

All Select All to display all subcarriers in the signal.

Pilots Only Select Pilot to display only pilot subcarriers.

Data Only Select Data to display only data subcarriers.

Single Specifies a specific subcarrier for display.

Index Specifies the specific subcarrier to be displayed.

Range Specifies a range to subcarriers to be displayed.

Start Specifies the start value of the range to be displayed.

Stop Specifies the ending value of the range to be displayed.

Max symbols to analyze Specifies how many symbols are analyzed. You can use this setting to speed analysis by
limiting the number of symbols being analyzed.

Analysis Time Tab - OFDM
The Analysis Time tab contains parameters that define how the signal is analyzed in the OFDM Analysis displays.
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Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer, this value may not match the Analysis Length requested (in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (all time values are relative to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Actual" readout. This setting is not available when Auto is checked.
Range: minimum value depends on modulation type. Resolution: 1 symbol.

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Offset is measured from the trigger point.

Trace Tab - OFDM
The Trace tab allows you to set the trace display characteristics of the selected display. This tab is not available for all OFDM displays.

OFDM Analysis

RSA5100B Series Real-Time Signal Analyzers Help 267



Settings Description

Trace Use this drop-down list to select whether or not the Average trace or the measurement trace is
displayed. The measurement trace depends on the selected display.

Show Select or deselect this checkbox to show or hide the trace selected in the Trace drop-down list.

Freeze Selecting Freeze halts updates to the trace.

Scale Tab - OFDM
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. There are two versions of the Scale tab for OFDM displays. One version is used only for the
Constellation display and the other version is used for the OFDM EVM, OFDM Magnitude Error, OFDM Phase Error, and OFDM Power
displays.

Figure 53: Scale tab for OFDM EVM, OFDM Mag Error, OFDM Phase Error, and OFDM Power displays

Figure 54: Scale tab for OFDM Constellation display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Table continued…
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Settings Description

Subcarrier Controls the scale of the subcarrier graph and position of the trace.

Scale Specifies how many subcarriers are displayed horizontally.

Position Specifies the subcarrier that appears at the left edge of the subcarrier graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Symbols Controls the scale of the Symbols graph.

Scale Specifies the number of symbols that appear in the symbols graph.

Position Specifies the symbol that appears at the left edge of the Symbols graph.

Autoscale Resets the scale and position settings to optimize the display.

Auto When Auto is checked, the scale and position values for the Symbols graph are automatically
adjusted to maintain the optimal display.

Zoom Sets the Constellation display size and position.

Scale Sets the magnification value for the Constellation display.

Vertical Position Sets the vertical location of the Constellation display within the graph. Range is -3.7 to +3.7.

Horizontal Position Sets the horizontal location of the Constellation display within the graph. Range is -3.7 to +3.7.

Prefs Tab - OFDM
The Prefs tab enables you to change appearance characteristics of the OFDM Analysis displays. Not all settings on the Prefs tab shown
below appear for every OFDM display.

Settings Description

Time units Specifies whether the displayed time units are seconds or symbols.

Freq units Specifies whether the displayed frequency units are frequency (Hz) or subcarrier channel.

Radix Specifies whether symbol values are displayed in binary or hex format (for example, in the Symbol
Table or markers readouts).

Table continued…
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Settings Description

Show graphs Specifies which graph types are displayed.

Both Displays both the Subcarrier and Symbol graphs.

Subcarriers Displays only the subcarrier graph.

Symbols Displays only the symbol graph.

Show graticule Displays or hides the graticule in the graphs.

Show marker readout Displays or hides the marker readouts in the graphs.
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Noise figure and gain measurements
Overview
The noise contribution from circuit elements is usually defined by noise figure, noise factor, or noise temperature.

For example, the function of an amplifier in a particular system is to amplify the signal presented at its input and deliver it to the load.
The thermal noise that is present at the input is amplified along with the input signal. The amplifier also contributes additional noise. The
load receives a composite signal made up of the sum of the amplified input signal, the amplified thermal noise, and the additional noise
contributed by the amplifier.

Noise figure, noise factor, and noise temperature are figures of merit used to quantify the noise added by the amplifier. This noise can be
measured directly using available test equipment.

For example, devices with high noise figure can be measured directly, as long as gain is known, with accurately known bandwidths. The
input to the DUT should be terminated in a source that is near the reference temperature (290K).

The Noise Figure and Gain Measurement options in this instrument measure noise figure using the Y Factor method, perform mask testing
to user-defined limits, and include an uncertainty calculator.

Note: To read a white paper about Noise measurements and when to use particular types of noise measurements, visit
www.tektronix.com/downloads.

Displays
Displays include noise figure, gain, Y-factor, noise temperature, and tabular results. Single-frequency metering and swept-trace results
are available, as well as support for industry-standard noise sources. Measurements for amplifiers and other non-frequency converting
devices, and fixed local-oscillator up and down converters are also available.

The displays for Noise Figure and Gain (Displays > Measurements > Noise Figure and Gain) are:

• Noise Temperature
• Gain
• Noise Figure
• Noise Table
• Uncertainty Calculator
• Y Factor

These measurements allow you to measure the noise contributions of circuit elements to a signal.

Noise Figure and Gain Measurements
The analyzer takes the following noise measurements: Noise Figure, Noise Temperature, Y Factor, and Gain. See the Available
Measurements section for brief definitions of each measurement.

Noise table display

Noise table display
The Noise Table lists selected measurements in a spreadsheet format, showing the numeric value at step frequencies for Gain, Noise
Figure, Y Factor, Noise Temperature, PHot, and PCold.

Noise figure and gain measurements
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Displaying the Noise Table Using a Preset
Using the Noise Figure Application Preset will turn on the Noise Figure, Gain, and Noise Table displays, and set the preamplifer (if present)
ON, with the acquisition mode to minimum noise and the attenuator to 0 dB for the best noise floor.

CAUTION: Make sure that the input of the analyzer is not connected to a device that will overload or damage the preamplifier.

1. Select Presets >Application from the menu bar.
2. Select Noise Figure from the Preset drop down menu.
3. Click OK.

Displaying the Noise Table
1. Press the Displays button or select Setup > Displays.
2. Select Noise Figure and Gain in the Measurements box.
3. Double-click Noise Table in the Available displays box to add the display to the Selected displays box.
4. Click OK.

Setting the Frequency for a Local Oscillator
If you are using a local oscillator and need to set the local oscillator frequency, do the following:

1. With the Noise Table selected, press the Settings button.
2. Select Up or Down Convertor as the Measurement Type in the Overview tab.

3. Click on the Frequency icon in the Overview tab image (see above). This will open the Params tab.
4. Set the frequency under LO Settings.
5. Click the X located in the right top corner of the Settings control panel to close the panel.
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Noise table settings
Menu Bar: Setup > Settings

Front Panel: Settings

Favorites toolbar:

The Settings control panel tabs for the Noise Table Display are shown in the following table. 

Settings tab Description

Overview Specifies the measurement type (non-frequency converting or frequency converting devices) to be
shown in the display. Also allows you to navigate to the related panel tabs.

Freq Setup Specifies several parameters that control frequency of the test and number of points per
measurement.

Noise Source Specifies ENR and noise source mode (constant or from a table).
Ext Gain/Loss Corrections Specifies gain and loss values for cables, connectors, and external preamplifiers.
Params Specifies local oscillator (LO) and RSA settings, reference temperature, resolution bandwidth (RBW),

and average counts.
Internal Settings Specifies the reference level (dB), set internal attenuator (manual or auto), optimize RF and IF, and

set an internal preamp.
Prefs Specifies display preferences such as graticule on/off, number of displayed points and measurement

units.

Calibrate. Calibrates the equipment setup prior to measurement.

Gain display

Gain display
The Gain display shows gain versus frequency of the signal. The gain measurement is the ratio of output power to input power in an
amplifier or circuit element.
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Elements of the Gain Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Gain display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 dB Sets the vertical scale maximum.
3 /Div The distance between graticule lines on the display in dB.
4 Position Sets the vertical scale center.
5 Min Sets the vertical scale minimum.
6 Autoscale Set the axes to values that show all trace points.
7 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the offset and

scale on the horizontal axis.
8 Max Shows the maximum level of the trace.
9 Min Shows the minimum level of the trace.
10 Mean Shows the mean value of the trace.

Gain settings
Menu Bar: Setup > Settings

Front Panel: Settings

The Setup settings for the Gain display are shown in the following table. 
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Settings tab Description

Overview Specifies the measurement type to be shown in the display. Also allows you to navigate to the related
panel tabs.

Freq Setup Specifies several parameters that control frequency displayed.

Noise Source Specifies ENR and noise source mode (constant or from a table).

Ext Gain/Loss Corrections Specifies gain and loss values for cables, connectors, and external preamplifiers.

Params Specifies local oscillator (LO) and RSA settings, reference temperature, resolution bandwidth (RBW),
and average counts.

Internal Settings Specifies the reference level (dB), set internal attenuator (manual or auto), optimize RF and IF, and set
an internal preamp.

Traces Specify the display trace parameters and also allows you to save traces.

Scale Specifies the scale settings that control how the trace appears on the display but does not change
control settings.

Prefs Specifies preferences such as graticule on/off, number of displayed points and measurement units.

Calibrate. Calibrates the equipment setup prior to measurement.

Noise figure

Noise figure display
The Noise Figure display shows the noise factor in dB. This measurement can help you assess the low level sensitivity of the DUT. Lower
noise figure is found in better performing DUTs. Noise factor is defined as the ratio of the input signal to noise ratio to the output signal to
noise ratio (Input SNR/Output SNR).
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Elements of the Noise Figure Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Noise Figure display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Max Sets the vertical scale maximum.

3 /Div The distance between graticule lines on the display in dB.

4 Position Sets the vertical scale center.

5 Min Sets the vertical scale minimum.

6 Autoscale Set the axes to values that show all trace points.

7 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the offset and
scale on the horizontal axis.

Noise figure settings
Menu Bar: Setup > Settings

Front Panel: Settings

The settings for the Noise Figure Display are shown in the following table. 
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Settings tab Description

Overview Specifies the measurement type to be shown in the display. Also allows you to navigate to the related
panel tabs.

Freq Setup Specifies several parameters that control measurement and displayed frequencies.

Noise Source Specifies ENR and noise source mode (constant or from a table).

Ext Gain/Loss Corrections Specifies gain and loss values for cables, connectors, and external preamplifiers.

Params Specifies local oscillator (LO) and RSA settings, reference temperature, resolution bandwidth (RBW),
and average counts.

Internal Settings Specifies the reference level (dB), set internal attenuator (manual or auto), optimize RF and IF, and set
an internal preamp.

Traces Specify the display trace parameters and also allows you to save traces.

Scale Specifies the scale settings that control how the trace appears on the display but does not change
control settings.

Prefs Specifies preferences such as graticule on/off, number of displayed points and measurement units.

Calibrate. Calibrates the equipment setup prior to measurement.

Noise temperature

Noise temperature display
The Noise Temperature display shows the temperature of a source impedance that would give the same SNR as the amplifier or system
element, if it were noiseless. 
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Elements of the Noise Temperature Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Noise Temperature display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Max Sets the vertical scale maximum.

3 /Div The distance between graticule lines on the display in K.

4 Position Sets the vertical scale center.

5 Min Sets the vertical scale minimum.

6 Autoscale Set the axes to values that show all trace points.

7 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the offset and
scale on the horizontal axis.

8 Vertical scale Sets the vertical scale value.

Noise temperature settings
Menu Bar: Setup > Settings

Front Panel: Settings

The settings for the Noise Temperature Display are shown in the following table. 
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Settings tab Description

Overview Specifies the measurement type to be shown in the display. Also allows you to navigate to the related
panel tabs.

Freq Setup Specifies several parameters that control measurement and displayed frequencies.

Noise Source Specifies ENR and noise source mode (constant or from a table).

Ext Gain/Loss Corrections Specifies gain and loss values for cables, connectors, and external preamplifiers.

Params Specifies local oscillator (LO) and RSA settings, reference temperature, resolution bandwidth (RBW),
and average counts.

Internal Settings Specifies the reference level (dB), set internal attenuator (manual or auto), optimize RF and IF, and set
an internal preamp.

Traces Specify the display trace parameters and also allows you to save traces.

Scale Specifies the scale settings that control how the trace appears on the display but does not change
control settings.

Prefs Specifies preferences such as graticule on/off, number of displayed points and measurement units.

Calibrate. Calibrates the equipment setup prior to measurement.

Y factor

Y factor display
The Y-Factor measurement method uses a noise source that can be switched off and on with a specified amount of excess noise. It
is based on two power measurements, each performed with the same port impedances and the same measurement bandwidth. This is
specified as the Excess Noise Ratio (ENR). ENR is the ratio of noise from the source to the system thermal noise or kTB, often expressed
in dB.

Y-Factor measurements require an initial calibration where the noise source is measured in the on and off state with the DUT bypassed.
This allows removal of the RSA noise figure using the two-stage NF correction, and allows for accurate gain measurement.

Elements of the Y Factor Display
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Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the Y
Factor display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Max Sets the vertical scale maximum.

3 /Div The distance between graticule lines on the display in dB.

4 Position Sets the vertical scale center.

5 Min Sets the vertical scale minimum.

6 Autoscale Set the axes to values that show all trace points.

7 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the offset and
scale on the horizontal axis.

8 Vertical scale Sets the vertical scale value.

Y factor settings
Menu Bar: Setup > Settings

Front Panel: Settings

The settings for the Y Factor Display are shown in the following table. 

Settings tab Description

Overview Specifies the measurement type to be shown in the display. Also allows you to navigate to the related
panel tabs.

Freq Setup Specifies several parameters that control measurement and displayed frequencies.

Noise Source Specifies ENR and noise source mode (constant or from a table).

Ext Gain/Loss Corrections Specifies gain and loss values for cables, connectors, and external preamplifiers.

Params Specifies local oscillator (LO) and RSA settings, reference temperature, resolution bandwidth (RBW),
and average counts.

Internal Settings Specifies the reference level (dB), set internal attenuator (manual or auto), optimize RF and IF, and set
an internal preamp.

Table continued…
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Settings tab Description

Traces Specify the display trace parameters and also allows you to save traces.

Scale Specifies the scale settings that control how the trace appears on the display but does not change
control settings.

Prefs Specifies preferences such as graticule on/off, number of displayed points and measurement units.

Calibrate. Calibrates the equipment setup prior to measurement.

Uncertainty calculator

Uncertainty calculator display
The noise factor of a DUT is computed from two power measurements (noise source and DUT) and two calibration power measurements
(external preamp and RSA). These computations rely on specified characteristics on the noise source ENR, input and output match
specifications, and other component specifications used in these measurements. The Uncertainty Calculator accepts the key specifications
of each device and their specification limit and converts them to standard uncertainty for the noise figure and gain measurement. The
output of the Uncertainty Calculator is the uncertainty tolerance for gain and noise figure based on the confidence level (conversion factor)
set by the user.

It is important to understand that the computations rely on the nominal values and tolerance limits of components in the noise
figure and gain measurement. The Calculator will accept different forms of component specifications and confidence level in the
component specifications. The Calculator converts the component specifications into standard uncertainties for the measurement. All of
the component standard uncertainties are combined into a standard measurement uncertainty. The standard measurement uncertainty
is multiplied by a coverage factor to yield an expanded coverage factor for the measurement. For K=2, approximately 95% confidence
is frequently used, as is K=3, approximately 99% confidence (maximum). So, if the noise figure is reported as 2 dB ±0.25 dB at 95%
confidence, this means that the “true” value of noise figure is thought to lie between 1.75 dB to 2.25 dB with 95% confidence.
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Elements of the Uncertainty Calculator Display

Item Display element Description

1 Computed Uncertainty Shows the noise figure and gain standard uncertainties. You can also select the
measurement uncertainty (99%, 95%, or 80%).

Table continued…
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Item Display element Description

2 Noise Source Sets the noise source ENR, uncertainty of the ENR and source match, coverage
(measurement confidence), output Voltage Standing Wave Ratio (VSWR). It also shows
the error distribution and the Noise Figure and Gain uncertainties, which will vary
according to the values entered for the available parameters. These values can be
determined from the manufacturer’s data sheet for the noise source you are using.

3 DUT- Device Under Test Sets the input Voltage Standing Wave Ratio (VSWR) and output VSWR for your device
under test (DUT). It also shows the coverage (measurement confidence) and error
distributions for this element of the uncertainty calculation.

4 Ext Preamp Sets the external preamp to in use (Yes), and the input Voltage Standing Wave Ratio
(VSWR) value. When the external preamp is selected on, you can also set the noise figure
and gain of the preamp. It also shows the coverage (measurement confidence) and error
distributions for the input Voltage Standing Wave Ratio (VSWR).

5 RSA Sets the error parameters for the RSA. These include the input noise figure and noise
figure uncertainty, gain uncertainty, input VSWR, and the sub-DANL noise floor error
terms of the RSA. Input noise figure and VSWR information can be taken from the RSA
data sheet or measured by the user for the specific instrument used. Gain uncertainty
contains a predetermined value that is the same for all RSAs. Sub-DANL distortion refers
to distortion products present in the RSA that exist below the noise floor and cannot be
measured by the user. The worst-case value is given for the term by default. You can
also select the coverage (measurement confidence) for Noise Figure uncertainty, Gain
measurement, and sub DANL floor. The error distribution is also displayed.

Uncertainty calculator settings
Menu Bar: Setup > Settings

Front Panel: Settings

The settings for the Uncertainty Calculator display are shown in the following table. 

Settings tab Description

Uncertainty Shows noise figure and gain uncertainty values (dB).

Intermediate Values Shows standard uncertainties in system.

Uncertainty Tab
The Uncertainty tab shows the noise figure and gain uncertainty values (dB). These values change based on the noise measurement
result and the parameters set in the Uncertainty Calculator display.
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Setting Description

Noise Figure Shows the standard uncertainty for the noise figure measurement. This value also reflects the
uncertainty tolerance for noise figure based on the confidence level (conversion factor) set by the user
in the Display.

Gain Shows the standard uncertainty for the gain measurement. This value also reflects the uncertainty
tolerance for gain based on the confidence level (conversion factor) set by the user in the Display.

Intermediate Values Tab
The Intermediate Values tab shows the noise figure and gain uncertainty values (dB). These values change based on the parameters set
in the Uncertainty Calculator display and the noise measurement results.

Setting Description

Uncertainty for Noise Figure Shows the uncertainty for three components of the noise figure measurement.

Uncertainty for Gain Shows the uncertainty for three components of the gain measurement.

Mismatch Source-SA Shows the error between the noise source and the spectrum analyzer.

Mismatch Source-DUT Shows the error between the noise source and the device under test (DUT).

Mismatch DUT-SA Shows the error between the device under test (DUT) and the spectrum analyzer.

Common controls for noise figure and gain displays

Noise figure and gain measurement settings
The control panel tabs in this section are shared by the displays in the Noise Figure and Gain measurement (Setup > Displays). Changing
a setting on one tab changes that setting for all the noise and gain measurement displays.
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Settings tab Description

Overview Specifies the measurement type to be shown in the display. Also allows you to navigate to the related
panel tabs.

Freq Setup Specifies several parameters that control measurement and displayed frequencies.

Noise Source Specifies ENR and noise source mode (constant or from a table).

Ext Gain/Loss Corrections Specifies gain and loss values for cables, connectors, and external preamplifiers.

Params Specifies LO and RSA settings, reference temperature, RBW, and average counts.

Internal Settings Specifies the reference level (dB), set internal attenuator (manual or auto), optimize RF and IF, and set
an internal preamp.

Traces Specifies the display trace parameters and also allows you to save traces.

Scale Specifies the scale settings that control how the trace appears on the display but does not change
control settings.

Prefs Specifies display view.

Overview tab
The Overview tab is used to specify the measurement type that appears in the display. You can also use the images in the tab to quickly
navigate to tabs that allow you to adjust parameters at key places in the circuit system. You can select either Amp/Direct, Up Converter,
or Down Converter as the measurement type. If you are using an up frequency converter, for example, you would want to select Up
Converter.

The above image shows the Overview tab with Amp/Direct selected.

The above image shows the Overview tab with Up Convertor selected.

Setting Description

Measurement Type Specify whether the measurement should account for a frequency converter (Up Converter or Down
Converter) or not (Amp/Direct).
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Freq setup tab
The Freq Setup tab is used to specify the frequency mode (Sweep, Single, or Frequency Table). If you select the Frequency Table, you can
edit and load an existing table or save a table.

Setting Description

Frequency Mode Set to Single Frequency, Sweep Frequency, or Frequency Table. To set the band of interest for Sweep
Frequency, set the Start and Stop frequencies and then specify the Steps value for the number of
measurement points you want to have. To set the band of interest for Single Frequency, set the
Center Frequency value. To use the Frequency Table, you can edit the current table, load an existing
table, or save the current table.

Center Frequency Specify the center frequency (GHz).

Span Specify the range over which to measure the signal. (Only available with Sweep mode.)

Start frequency Specify the minimum frequency to include in the measurement. (Only available with Sweep mode.)

Stop frequency Specify the maximum frequency to include in the measurement. (Only available with Sweep mode.)

Steps Specify the number of steps in the measurement range. This value determines how many steps
(rows) are in the frequency table. (Only available with Sweep mode.)

Table You can edit an existing frequency table, load a previously saved table, or save a table.

Noise source tab
The Noise Source tab is used to specify the Noise mode (constant or table) and the ENR constant. If you select Table mode, you can edit
and load an existing table or save a table.
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Setting Description

Mode Set mode to Constant or Table. For Constant, set the ENR value. For Table, enter the noise source
model and serial number.

To use the Table, you can edit the current table, load an existing table, or save the current table.

You can also load a predefined noise source. These values are useful starting points because they
contain the frequency points for common noise sources, along with representative excess noise
ratios. However, you must enter your own ENR values.

ENR Constant Specify the excess noise ratio (ENR) value. The ENR is the difference between the two power levels
calculated in a Y-Factor measurement.

Noise Source Model Specify the model of the noise source. (Only available with Table mode.)

Noise Source Serial Number Specify serial number of the noise source. (Only available with Table mode.)

Table You can edit an existing Noise Source table, load a previously saved table, or save a table.

Ext Gain-Loss corrections tab
The Ext Gain/Loss Corrections tab is used to specify external gain and loss values. You can set loss values for three common loss
scenarios: loss at the DUT input, loss at the DUT output, and loss at calibration. You can also edit directly in an external loss table.

Setting Description

Constant values Specify up to three external gain values (dB). Use these settings to apply a flat gain/loss correction to
the signal. Positive values represent a gain and negative values represent a loss. The range is –50 to
+30 dB. Resolution is 0.1 dB.

Loss @ DUT Input This specifies the loss at the DUT input. For example, this can be the result of an adapter connected
between a waveguide adapter and the DUT input.

Loss @ DUT Output This specifies the loss at the DUT output. For example, this can be the result of an adapter connected
between the DUT output and the analyzer.

Loss @ Calibration This specifies the total loss in the calibrated system. For example, if an adapter must be used during
calibration that is not present during measurements, the frequency response of the adapter can be
removed with this correction table.

Table continued…
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Setting Description

External Loss Tables Each loss component (at DUT input, DUT output, and at calibration) can use an External Loss Table
for correction of loss versus frequency. When an External Loss Table is selected, the analyzer adjusts
the signal according to the values in the table. An external loss table allows you to compensate the
signal level for variations in cable loss, antenna frequency response or preamp frequency response.
You can read more about using Loss Tables here.

Temperature Specify the temperature (K) of the loss elements. The temperatures are used in adjusting the
measured results based on the temperature difference of the loss elements compared to the
reference temperature. You can also use the reference temperature for these values by selecting
the click-box. The reference temperature is entered in the Params tab.

The following image shows the External Loss Table setup window.

Params tab
The Params tab is used to specify the local oscillator (LO) and RSA settings, reference temperature, resolution bandwidth (RBW), and
average count. 

Setting Description

RSA Settings The Settle Time sets the time the RSA will pause before measuring after turning the noise source
On or Off to assure measurement stability. The required settling time for your measurement setup will
vary with the noise source used. The default values have been set for Noisecom 346B series noise
sources. Settling time for your noise source may be different and can be determined by judging the
stability of your measurement as the settle time is varied.

Table continued…
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Setting Description

Ref Temperature Sets the reference temperature (K).

RBW Sets the resolution bandwidth (MHz).

Average Count Sets the number of measurements to average.

LO Settings Sets the frequency of the local oscillator, which is an oscillator that produces the internal signal that is
mixed with an incoming signal to produce the IF signal. Set the Side Band to Upper, Lower, or Double.

Internal settings tab
The Internal Settings tab is used to specify the reference level (dB) for the signal analyzer's RF front end, the settings for the internal
attenuator, enable/disable the optional internal preamp, and specify the RF & IF Optimization. If you use the application preset for Noise
Figure and Gain, these settings will be automatically optimized for the best measurements. The application preset will turn the preamplifier
on, set the attenuator to 0 dB, and set RF/IF optimization to minimize noise using 25 MHz bandwidth acquisitions. In instruments that have
wider acquisition bandwidths, measurement speed can be improved by setting the RF & IF Optimization to Best for multiple displays. This
allows use of wider acquisition bandwidths, but causes a slight reduction in ultimate instrument noise floor.

Setting Description

Ref Level Specify the reference level (dB) for the signal analyzer's RF front end.

Internal Attenuator Set to Auto or manual. When Auto mode is enabled, the attenuation setting is displayed but is not
adjustable. When Auto is disabled, the attenuator operates in manual mode, allowing you to set the
internal attenuation. The internal attenuation setting range is 0 - 75 dB.

RF & IF Optimization Specifies how the gain and bandwidth should be optimized (in the RF and IF stages of the front end).
Read about these settings here.

Internal Preamp Switch the preamp on or off. To ensure the best accuracy, turn on the Internal Preamp and allow it to
run for 20 minutes to thermally stabilize before taking critical measurements.

Traces tab
The Traces tab is used to specify the display trace parameters and also allows you to save traces. This tab is available for trace displays
only.
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This is the Traces tab when Function is set to Normal.

This is the Traces tab when Function is set to .

Setting Description

Trace Specify up to three traces and whether or not to show the traces of freeze them.

Detection Detection is set to Average (VRMS).

Function Specify the trace function as Normal, Average (VRMS), Max Hold, or Min Hold.

Count

(Only available for Noise
Temperature display)

Specify the trace count.

Scale tab
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Frequency. In effect, these controls operate like pan and zoom controls. This tab is only available for trace displays.

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Table continued…

Noise figure and gain measurements

RSA5100B Series Real-Time Signal Analyzers Help 290



Settings Description

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Auto When Auto is checked, the scale and position values for the are automatically adjusted to maintain
the optimal display.

Reset Resets horizontal and vertical values to default values.

Horizontal Controls the horizontal position and scale of the trace display.

Scale Changes the horizontal scale of the graph.

Position Adjusts the horizontal reference level of the graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Prefs tab
The Prefs tab is used to set display preferences. You can set preferences to show measurement points, graticule, trace legend, scale,
units, or to view a linear display of results instead of dBm depending on the selected display.

The following image shows the Prefs tab for all of the trace displays.

The following image shows the Prefs tab for the Noise Table display.

The following image shows the Prefs tab for the Noise Figure display.
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Pulsed RF
Pulsed RF Overview
The Pulsed RF option (SVP) allows you to take measurements that provide deep insight into pulse train behavior. You can define and
analyze unique pulse characteristics in the time and frequency domains and gain additional insight into the performance of Radar or EW
subsystems. The Pulse Cumulative Histogram and Pulse Cumulative Statistics Table accumulate results over multiple acquisitions. The
remaining Pulse displays show results for the current acquisition. You can use cross-correlated markers to pinpoint events in one display
and debug in other displays.

The displays in Pulsed RF (Setup > Displays > Pulsed RF) are:

• Cumulative Histogram
• Cumulative Statistics
• Pulse-Ogram™
• Pulse Statistics
• Pulse Table
• Pulse Trace

Pulse Measurements
The analyzer takes the following pulse measurements.

Measurement Description
Average ON Power The average power transmitted during pulse on.
Peak Power Maximum power during pulse on.
Average Transmitted Power The average power transmitted, including both the time the pulse is on and the time it is off, and all

transition times.
Pulse Width The time from the rising edge to the falling edge at the –3 dB / –6 dB level (50%) of the user selected

100% level. Level is user selectable for Volts or Watts.
Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user selected 100%

level.
Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user selected 100%

level.
Repetition Interval The time from a pulse rising edge to the next pulse rising edge.
Repetition Rate The inverse of repetition interval.
Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.
Duty Factor (Ratio) The ratio of the pulse width to the pulse period.
Table continued…
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Measurement Description
Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot, overshoot,

or undershoot. By default, the first 25% and the last 25% of the pulse top is excluded from this
measurement to eliminate distortions caused by these portions of the pulse. 

If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements for the
analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple results will be in
%Watts. The default for the general Units control is dBm, so the Ripple results default is %Watts.

See also Ripple on page 739.

Ripple dB The Ripple measurement expressed in dB.
Droop Droop is the power difference between the beginning and the end of the pulse on time. A straight-line

best fit is used to represent the top of the pulse. The result is a percentage referenced to the Average
ON Power.

Droop dB The Droop measurement expressed in dB.
Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units are %Watts

or %Volts.
Overshoot dB The Overshoot measurement expressed in dB.
Pulse-ref-Phase Difference The phase difference between the current pulse and the first pulse in the analysis window. The

instantaneous phase is measured at a user-adjustable time following the rising edge of each pulse.
Phase Difference The time interval by which one wave leads of lags another.
Pulse-ref Freq Difference The difference between the frequency of the current pulse and frequency of the previous pulse. The

instantaneous frequency is measured at a user-adjustable time following the rising edge of each
pulse.

RMS Freq Error The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time trace,
computed over the Measurement Time.

Max Freq Error The maximum frequency error is the difference between the measured carrier frequency of the signal
and the user-selected center frequency of the analyzer.

RMS Phase Error The RMS Phase Error measurement is the RMS average of the Phase vs Time trace, computed over
the Measurement Time.

Max Phase Error The phase is measured at each point during the pulse on time. The phase error for each point is the
difference between the measured phase value and the calculated ideal phase value. After the phase
error is calculated for all points in the acquisition record, the largest error in the positive direction and
the largest in the negative direction are determined. Whichever of these two values has the greater
absolute value is designated the Max Phase Error.

Freq Deviation The Frequency Deviation measurement is the difference between the maximum and minimum
measured values of the signal frequency during the Measurement Time.

Phase Deviation The Phase Deviation is the difference between the maximum and minimum Phase values measured
during the on time of a pulse.

Impulse Response Amplitude The difference in dB between the levels of the main lobe and highest side lobe.
Impulse Response Time The difference in time between the main lobe and highest side lobe.
Time This is the time in seconds relative to the time reference point in the first acquisition record in the data

set.
Table continued…
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Measurement Description
Absolute Frequency The absolute pulse frequency measured at a point specified by the user. The measurement includes

carrier frequency as well. The measurement point should be within the pulse width, starting from the
50% point.

Pulse-Pulse Frequency Difference The difference between the frequency of the current pulse and frequency of the previous pulse. The
instantaneous frequency is measured at a user-adjustable time following the rising edge of each
pulse.

Pulse-Pulse Phase Difference The phase difference between the selected pulse and the first pulse in the analysis window. The
instantaneous phase is measured at a user-adjustable time following the rising edge of each pulse.

Delta Frequency (Non-chirped
pulse)

The Delta Frequency measurement is the difference from the measurement frequency to each pulse
frequency. Pulse frequency is calculated across the time defined by the Frequency Domain Linearity
setting in the Define tab.

The measurement is available for modulation types CW (Constant Phase), CW (Changing phase).
and Other (manual) setting in the Freq Estimation tab.

The measurement is not specified for chirp or other signals and no answer is returned when
frequency estimation is set to Chirp.

If frequency estimation is set to Other, then Frequency Offset must be set to 0 Hz and the Range can
be set to ±40% of the acquisition bandwidth.

A least-square fit of slope of phase vs. time over the measurement period is used for the
measurement of the individual pulse frequency. Frequency difference is calculated as the difference
between the reference frequency and the calculated frequency of the pulse.

Cumulative Histogram Display
This histogram display shows the numerical distribution of the various pulse measurement results accumulated over multiple frames (in
Fast Frame mode) and acquisitions. You can see the pulse count in a chosen bin by choosing the bin number or the X value (of the chosen
result). Pulses that do not lie within the chosen Min/Max are shown as outliers.

To show the Cumulative Histogram display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. Press the Displays button or select Setup > Displays.
4. In the Select Displays dialog, select Pulse Analysis in the Measurements box.
5. In the Available displays box, double-click the Cumulative Histogram icon or select the icon and click Add. The icon will appear in the

Selected displays box and will no longer appear under Available displays.
6. Click OK to show the Cumulative Histogram display.
7. If you are analyzing a stored data file, press the Replay button to take measurements on the acquisition data file.
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Elements of the display

Item Display element Description
1 Result Drop down list of measurements. The results of the selected measurement in this

Cumulative Histogram display will also show in the Pulse Statistics display and be
highlighted in the Pulse Table display. All results will be available for view when Auto
mode is enabled in the Cumulative Histogram display settings on page 296 window. Only
selected results will be available for view when Manual mode is enabled in the Histogram
Settings window.

2 X A value of the selected result where the pulse indicator is positioned. Changing X will
automatically change the bin number to the one that contains the X value.

3 Bin Bin number where the indicator is positioned. Changing this number will change the value
of X to the middle of the selected bin.

4 Pulses in Bin Number of pulses in the selected bin.
5 Total Pulses Total number of pulses analyzed in the current acquisition.
6 Vertical Sets the vertical range.
7 Autoscale Sets the axes to values for clear visibility of trace points.
8 Horizontal offset and scale Controls that specify the offset and scale on the horizontal axis.
9 Clear button Clears results from the display and starts a new measurement.
10 Outliers Number of pulses that have measurement values outside of the maximum and minimum

values indicates the outliers below the lower limit and those exceeding the upper limit.
Table continued…
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Item Display element Description
11 Histogram Table button Contains the Bin number, Bin Range, and Pulses in bin for the chosen measurement.

Cumulative Histogram display settings
Main menu: Setup > Settings 

Front Panel: Settings

Favorites Toolbar:

The Settings control panel tabs for the Cumulative Histogram display are shown in the following table.

Settings tab Description
Params Specifies several parameters that control how pulses are counted and defined.
Define Specifies parameters that control where measurements are taken on a pulse.
Levels Specifies parameters that control the method and levels used to calculate some pulse values.
Freq Estimation Specifies the reference used for computing frequency error.
Scale Specifies the vertical and horizontal scale settings.
Prefs Specifies whether or not certain display elements are shown.

Histogram Settings button
This button is located on the Pulse Cumulative Histogram Settings control panel. Click this button to open a window where you can select
which measurement results will be available in the Result drop down menu. You can select to use Auto or Manual mode.

Manual mode for histogram settings. In Manual mode, the histogram computation is done for the selected measurement results. You
set the maximum and minimum values. The Bin field represents the total number of bins used in the histogram.
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Auto mode for histogram settings. In Auto mode, the histogram computation is done for all measurement results. Minimum and
maximum limits are chosen automatically based on the first 10,000 pulses. The Bin field represents the total number of bins used in the
histogram.

Restore Defaults button
This button is located on the Pulse Cumulative Histogram Settings control panel. Click this button to set the Cumulative Histogram
parameters to their default values.

Cumulative Statistics Table display
This display is a statistics table that provides information on Pulse Count, Max, Max TimeStamp, Min, Min TimeStamp, Peak to Peak,
Average, and Standard Deviation over different acquisitions.

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select Pulsed RF in the Measurements box.
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4. In the Available displays box, double-click the Cumulative Statistics icon or select the icon and click Add. The icon will appear in the
Selected displays box and will no longer appear under Available displays.

5. Click OK to show the Cumulative Statistics display.

Elements of the display
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Display element Description

Measurement The row across the top of the table shows the selected measurement.

You can right click on this row to access this menu to edit the table:

Select Add Measurements to open this window to select measurements:

Maximum Maximum value of the measurement across acquisitions with a time stamp.
Maximum TimeStamp This time stamp denotes the time the maximum value of the measurement occurred across

acquisitions.
Minimum Minimum value of the measurement across acquisitions with a time stamp.
Minimum TimeStamp This time stamp denotes the time the minimum value of the measurement occurred across

acquisitions.
Average Average value of the measurement values accumulated over multiple acquisitions until the current

acquisition.
Peak to peak This is the difference between Maximum and Minimum value of the measurement
Standard deviation Standard deviation of the measurement that has a population equal to the Pulse Count value.
Clear button Clear the results and starts a new measurement.

Note: When analysis is done on only one pulse, the Standard Deviation is zero. Log10 (0) is not defined and thus is reperesented
by a “–” when the unit is dB.
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Cumulative Statistics Table display settings
Main menu: Setup > Settings 

Front Panel: Settings

Favorites Toolbar:

The Settings control panel tabs for the Cumulative Statistics Table display are shown in the following table.

Settings tab Description
Measurements Specifies which measurements to show in the table. Click the box(es) next to the measurement(s) you

want to show. You can also click the Select All and Clear All buttons.
Params Specifies how pulses are counted and defined.
Define Specifies parameters that control where measurements are taken on a pulse.
Levels Specifies parameters that control the method and levels used to calculate some pulse values.
Freq Estimation Specifies the reference used for computing frequency error.
Prefs Specifies whether on not certain display elements are shown.

Restore defaults button
This button is located on the Cumulative Statistics Table Settings control panel. Sets the Cumulative Statistics Table parameters to their
default values.

Pulse-Ogram display
The Pulse-Ogram™ display shows a stacked view of radar pulses when the analyzer is using fast-frame mode. The fast-frame captures IQ
samples around a pulse when triggered. Each fast frame is configured to capture few IQ samples before rise-time, and after fall-time of a
single pulse, and a timestamp associated with that pulse. With this information, the different fast-frame captures are stacked one after the
other and displayed as Time v/s Time, and the corresponding spectrum information as Frequency v/s Time. The stacking allows for overlap
of adjacent frames. The user can also select the range of frames for viewing in the display. This enables the user to study various aspects
of pulse such as pulse width, reflections, rise-time, fall-time, etc.

Marker correlation in Pulse-Ogram
At the end of an acquisition, the TOV and Spectrum show the last frame acquired. When we place a marker in Pulse-Ogram, the marker
would not move in TOV and Spectrum unless you bring the marker to the last frame in Pulse-Ogram. Similarly, if marker is moved in TOV
and Spectrum, then the marker in Pulse-Ogram will move to the last frame automatically.

If you want the marker movement in Pulse-Ogram to change the pulse indicator in the Pulse Table or Pulse Trace display, then you must
add the Pulse Statistics display in Time trend mode. Movement of the marker now in the Pulse Statistics display or Pulse-Ogram display
will change the pulse indicator position too, and therefore the appropriate pulse will be shown in the Pulse Trace display.

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.
2. Press the Displays button or select Setup > Displays.
3. In the Select Displays dialog, select Pulsed RF in the Measurements box.
4. In the Available displays box, double-click the Pulse-O-gram icon or select the icon and click Add. The icon will appear in the

Selected displays box and will no longer appear under Available displays.
5. Click OK to show the Pulse-O-gram display.
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Elements of the display

Display element Description
Time vs Time This view has the IQ data captured in the fast frames in a stacked view (with overlap).
Frequency vs Time This view has the corresponding spectrum of the signal captured.
Frame offset Controls the number of frames that are offset in the display. The starting frame will be frame offset + 1.
Frame scale Controls the number of frames that can be seen in the display.
Frame count Total number of fast frames in the acquisition.
Frame # Indicates the frame number in which the marker is present. This option will only appear when the

marker is added.
Plot type Shows Stacked and is not selectable.
Display Select to view Time vs Time or Frequency vs Time or Both.
RBW Shows the resolution bandwidth for the Frequency vs Time view.

Pulse-Ogram display settings
Main menu: Setup > Settings 

Front Panel: Settings

Favorites Toolbar:

The Settings control panel tabs for the Pulse-Ogram display are shown in the following table.

Settings tab Description
Analysis Specifies settings related to analysis of the signal.
Traces Specifies the display characteristics of displayed traces.
Scale Specifies the parameters related to fast frame.
Prefs Specifies marker readout options.

Pulse Table display
The Pulse Table lists selected measurements in a spreadsheet format, showing the pulse numbers and all the results for each
measurement on all the detected pulses. Pulses are numbered from one. 
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Displaying the Pulse Table
1. Press the Displays button or select Setup > Displays.
2. Select Pulsed RF in the Measurements box.
3. Double-click Pulse Table in the Available displays box to add the display to the Selected displays box.
4. Click OK.

Selecting the Measurements to Show
1. With the Pulse Table selected, press the Settings button.
2. In the Pulse Table Settings control panel, select the Measurements tab.

3. Select the measurements you wish to take from the list of measurements or click Select all to choose all measurements.
4. Click the close box ( ) to remove the Settings control panel.

Changing the Pulse Table Display Settings

Pulse Table display settings
Main menu bar: Setup > Settings 

Front Panel: Settings

Favorites Toolbar:

The Settings control panel tabs for the Pulse Table Display are shown in the following table.

Settings tab Description
Measurements Selects the measurements to be show in the Pulse Table.
Table continued…
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Settings tab Description
Params Specifies several parameters that control how pulses are counted and defined.
Define Specifies parameters that control where measurements are taken on a pulse.
Levels Specifies parameters that control the method and levels used to calculate some pulse values.
Freq Estimation Specifies the reference used for computing frequency errors.

Restore defaults button
This button is located on the Pulse Table Settings control panel. Sets the Pulse Table parameters to their default values.

Pulse Trace display
The Pulse Trace display shows one measurement result and a trace graph illustrating that measurement for a selected pulse number. You
can also choose to display arrows and lines in the graph that illustrate where on the pulse the measurement is being taken.

Elements of the Pulse Trace Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Pulse Trace display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Result Use this list to select the measurement to show. The measurement chosen here selects
the same result to be displayed in the Statistics view and highlighted in the Table view.
Selecting a result in any of these views causes the same result to be selected in all of
them.

Table continued…
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Item Display element Description

3 Pulse Selects which pulse result is shown. Like the Result, this selection is shared with the
Statistics and Table views. The maximum number of pulses that can be measured is
limited to 10000.

4 Pulse threshold indicator This green triangle indicates the power threshold used to detect pulses. See Settings >
Params > Power threshold to detect pulses.

5 Autoscale Set the axes to values that show all trace points.

6 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the offset and
scale on the horizontal axis.

7 Top of graph adjustment Sets the power level shown at the top of the graph. If the number is greater than the Ref
Level, a white line will appear in the graph to indicate the Ref Level.

(not
shown)

Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

8 Vertical scale Sets the vertical scale value.

Changing the Pulse Trace Display Settings

Pulse Trace display settings
Main menu: Setup > Settings 

Front Panel: Settings

Favorites Toolbar:

The Setup settings for the Pulse Trace display are shown in the following table.

Settings tab Description
Params Specifies several parameters that control how pulses are counted and defined.
Define Specifies parameters that control where measurements are taken on a pulse.
Levels Specifies parameters that control the method and levels used to calculate some pulse values.
Freq Estimation Specifies the reference used for computing frequency error.
Scale Specifies the vertical and horizontal scale settings.
Prefs Specifies whether on not certain display elements are shown.

Restore defaults button
This button is located on the Pulse Trace Settings control panel. Sets the Pulse Trace display parameters to their default values.

Pulse Statistics display
The Pulse Statistics view displays a plot of a pulse measurement's values for every pulse in the analysis period. For example, the Pulse
Statistics display will show the Rise Time measurement for each of 30 pulses, with rise time on the Y axis and pulse number on the X
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axis. Alternatively, the Statistics Display can show an FFT trace for the values of a measurement over all the pulses analyzed. Numeric
readouts of Pulse Count, Max, Min, Peak to Peak, Average, and Standard Deviation in this display summarize results for the selected
pulse measurement.

Elements of the Pulse Statistics Display
The following images show the display when different plot types are selected. The table following these images explains the elements of
these displays.

Figure 55: The above image shows an FFT plot.

Figure 56: The above image shows a Trend plot.
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Figure 57: The above image shows a Time Trend plot.

Figure 58: The above image shows a Histogram plot.

Item Display element Description

1 Result Use this list to select which measurement statistics to display. The measurement chosen
here selects the same result to be displayed in the Pulse Trace display and the Pulse
Table display. Selecting a result in any of these views causes the same result to be
selected in all of them.

2 Results indicators

(The indicators shown depend on the plot type selection. The values shown are plot indicator (Item 9) values.)

Pulse Pulse indicator for Trend or Time Trend plots that indicates the pulse selected by the Pulse
setting.

Freq Pulse indicator for FFT plots that marks the trace point at the selected frequency.

Table continued…
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Item Display element Description

X For Histogram plots: A value of the selected result where the pulse indicator is positioned.
Changing X will automatically change the bin number to the one that contains the X value.

Bin For Histogram plots: Bin number where the indicator is positioned. Changing this number
will change the value of X to the middle of the selected bin.

Pulses in Bin For Histogram plots: Number of pulses in the selected bin.

Total Pulses For Histogram plots: Total number of pulses analyzed in the current acquisition.

3 Vertical Sets the vertical range.

4 Autoscale Sets the axes to values for clear visibility of trace points.

5 Histogram Table button Contains the Bin number, Bin range, and Pulses in bin for the chosen measurement.

6 Plot type selector Select Trend, Time Trend, FFT, or Histogram as plot type.

7 Horizontal offset Adjusts the horizontal offset.

8 Statistics summary Display of measurement statistics for the selected result.

9 Pulse indicator For Trend and Time Trend plot types, this indicates the pulse selected by the Pulse
setting. For the FFT plot type, this indicator marks the trace point at the selected
frequency. For Histogram plot types, this indicator marks the selected results bin.

10 Scale Adjusts the horizontal scale.

Changing the Pulse Statistics Display Settings

Pulse Statistics settings
Main menu bar: Setup > Settings 

Front Panel: Settings
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Favorites Toolbar:

The settings for the Pulse Statistics display are shown in the following table.

Settings tab Description
Params Specifies several parameters that control how pulses are counted and defined.
Define Specifies parameters that control where measurements are taken on a pulse.
Levels Specifies parameters that control the method and levels used to calculate some pulse values.
Freq Estimation Specifies the reference used for computing frequency errors.
Scale Specifies the vertical and horizontal scale settings.
Prefs Specifies whether or not certain elements of the display are shown.

Restore defaults button
This button is located on the Pulse Statistics Settings control panel. Sets the Pulse Statistics display parameters to their default values.

Pulsed RF Measurement Settings
Some of the control panel tabs are shared by the Pulsed RF displays (Setup > Displays). Changing a setting in a shared tab changes that
setting for all the Pulsed RF displays. The other control panel tabs are unique for each display. The following information explains both
types.

Table 18: Common controls for pulsed RF displays

Settings tab Description

Measurements Specifies which measurement results appear in the Cumulative Statistics Table and Pulse Table
displays.

Params Specifies several parameters that control how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Analysis

(Only Available for the Pulse-
Ogram display)

Specifies parameters related to analysis of the signal.

Levels Specifies parameters that control the method and levels used to calculate some pulse values.

Freq Estimation Specifies the reference used for computing frequency errors.

Traces

(Only available for the Pulse-
Ogram display)

Specifies the smooth points for the Time vs Time view and the detection method for the Frequency vs
Time view.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether or not certain elements of the display are shown.
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Measurements Tab
The Measurements tab is used to specify the measurements that appear in the Cumulative Statistics Table display and the Pulse Table
display.

Show in Cumulative Statistics Table
Checked measurements appear in the table.

Select all
Click Select all to choose all measurements for display in the table.

Clear all
Click Clear all to remove all measurements from the table display.

Params Tab
The Params tab enables you to adjust several measurement parameters for Pulsed RF displays. Not all parameters show for all displays. 

Setting Description

Measurement Filter Specify whether a filter is used to limit the bandwidth of the input signal.

Bandwidth Sets the bandwidth of the measurement filter.

Power threshold to detect pulses Specifies the level used for locating pulses in the data.

Minimum OFF time between
pulses

Specifies the time the signal must fall below the power threshold for two pulses to be considered
separate pulses.

Max number of pulses Specifies the number of pulses to measure within the analysis time.

(Only available for the Pulse Statistics, Pulse Trace, and Pulse Table displays.)
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Measurement Filter
Three choices are available for the measurement filter:

• No Filter - Max BW: The widest acquisition bandwidth available is used. The Bandwidth setting is disabled, but shows the value in
use.

• No Filter: - This is the default. The Bandwidth control is enabled to specify an acquisition bandwidth.
• Gaussian - The Bandwidth control is enabled for you to specify a value. The instrument uses an acquisition bandwidth two times wider

than the entered value.

Power Threshold to Detect Pulses
Specifies the minimum power level the trace must exceed to be detected as a pulse. The range for this setting is: -3 to -70 dBc. The setting
resolution is 1 dB. The default value is -10 dB.

Minimum OFF time between pulses
Specifies the time the signal must fall below the power threshold for two pulses to be considered separate pulses. The minimum value for
this setting is 1.000 ns.

Max Number of Pulses
Only available for the Pulse Statistics, Pulse Trace, and Pulse Table displays.

If the Analysis Time contains fewer pulses than specified, the analyzer will measure all the pulse within the analysis time. If there are more
pulses in the Analysis Time, than the specified number, the analyzer measures the specified number of pulses and ignores the rest. The
setting resolution is: 1. If this setting is not checked, the analyzer will measure all pulses within the Analysis Time.

To determine the maximum number of pulses that can be analyzed, use the following equation:

Maxnumberofpulses thatcan analyzed= PulseRate× capacity

where:

• Pulse rate is the number of pulses per second (frequency).
• Capacity is a length of time which is displayed on the Acquire > Sampling Parameters tab.

Note that the maximum number of pulses is affected by several parameters. For example, measurement bandwidth affects the sample
rate. The measurement algorithm also can reduce the maximum number of pulses that can be analyzed (by increasing the sample rate)
based on the characteristics of the signal.

Additionally, when FastFrame is enabled, determining the maximum number of pulses is even more challenging. In FastFrame mode, the
signal analyzer samples the signal around events of interest and ignores the signal between events of interest. Thus, if the instrument
is only looking at pulses and ignoring the signal between pulses, the number of pulses that can be analyzed depends strongly on the
characteristics of the pulse itself (for example, fewer wide pulses can be analyzed than narrow pulses, all other things being equal).

The Pulse Cumulative Statistics display provides statistics of pulses like Average, Standard Deviation, and Peak to Peak. Pulse Count
does not have an upper limit for Pulse Cumulative Statistics. The Pulse Cumulative Histogram display provides information about the trend
of the Pulse characteristics and outliers. This display does not support any upper limit or lower limit.

Note: In Fast Save mode, Pulse /Frame Count can go up to 200,000. This count also depends on the hard disk drive (HDD)
capacity to store acquisitions.

The asterik (*) around a pulse number indicates that it is a Fast Frame.

All Pulse Analysis displays except the Pulse-Ogram update results only after analysis of all fast frames.
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Define Tab
The Define tab enables you to specify parameters that control where measurements are made on a pulse. The settings available depend
on the measurement selected. This tab is not available for the Pulse-Ogram display.

The settings that appear on the Define tab are described below. They may vary according to the Measurement(s) selection.

Freq-Domain Linearity

Setting Description

Time method Specifies how the measurement's duration is determined. The choices are Absolute and
Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point from which Start
time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%; Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before starting to
measure the pulse. The Start time is measured from the point along the pulse rising edge
specified by the Ref setting. Start Range: ±100 ms; Resolution: 3 digits; inc/dec small: 1 ns,
large: 1,2,5,10...; Default: 0

Length (L) Length specifies the period of time that is used for pulse measurements The measurement time
begins at the Start point and continues for the amount of time specified by Length.

Relative time method

Length In the Relative time method, Length specifies the percentage of the top of the pulse that is used
for measurements. The instrument automatically determines the pulse top. The measurement
length is centered within the pulse ON time.

Impulse Response

Pulsed RF

RSA5100B Series Real-Time Signal Analyzers Help 311



Setting Description

Apply ampl corrections Enable/disable corrections that remove errors due to the window function and to the time offset
of the side lobe.

Keep-out time (+/-) The Keep-out time specifies a region that is ignored when the trace is analyzed for side lobes.
The setting defines a region to the left and to the right of the center of the main lobe. Lobes that
fall within this time region are not eligible to be the “highest side lobe”.

Time method Specifies how measurement parameters are determined. The choices are Absolute and
Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point from which Start
time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%; Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before starting to
measure the pulse. The Start time is measured from the point along the pulse rising edge
specified by the Ref setting. Start Range: ±100 ms; Resolution: 3 digits; inc/dec small: 1 ns,
large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement time begins at
the Start point and continues for the amount of time specified by Length.

Relative time method In the Absolute time method, Length specifies the period of time that is used for pulse
measurements.

Length In the Relative time method, Length specifies the percentage of the top of the pulse that is used
for measurements. The instrument automatically determines the pulse top. The measurement
length is centered within the pulse ON time.

P-R F Diff, P-P F Diff, F Abs, P-R ø Diff, P-P ø Diff
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Setting Description

Measurement point Specifies the period in time after the 50% rising edge at which frequency and phase difference
measurements are made.

Ripple

Setting Description

Length Length specifies the percentage of the top of the pulse that is used for measurements. The
instrument automatically determines the pulse top. The measurement length is centered within
the pulse ON time. Only the Relative Time method is available for Ripple.

Overshoot

Setting Description

Time method Specifies how measurement parameters are determined. The choices are Absolute and
Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point from which Start
time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%; Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before starting to
measure the pulse. The Start time is measured from the point along the pulse rising edge
specified by the Ref setting. Start Range: ±100 ms; Resolution: 3 digits; inc/dec small: 1 ns,
large: 1,2,5,10...; Default: 0

Table continued…
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Setting Description

Length (L) Amount of time that should be included in the measurement. The measurement time begins at
the Start point and continues for the amount of time specified by Length.

Relative time method

Ref Ref specifies the level along the pulse rising edge that is defined as the point from which Start
time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%; Default: 100%

Start Start specifies the time the instrument waits after the rising-edge reference before starting to
measure the pulse. The Start time is measured from the point along the pulse rising edge
specified by the Ref setting. Start Range: ±100 ms; Resolution: 3 digits; inc/dec small: 1 ns,
large: 1,2,5,10...; Default: 0

Length In the Relative time method, Length specifies the percentage of the top of the pulse that is used
for measurements. The instrument automatically determines the pulse top. The measurement
length is centered within the pulse ON time.

Levels Tab
Use the Levels tab to set parameters that control the method and levels used to calculate some pulse values.

Setting Description

100% Level Specifies the method used to determine the 100% level(s).

50% Level Specifies the method used to determine the 50% level on the pulse.

Rise/Fall Levels Select whether to use the 10% to 90% or 20% to 80% points (based on voltage level) to define the
rise and fall times.

100% Level
Use the 100% Level settings to select the method used to determine the 100% level(s) used for calculating pulse parameters, for example,
Rise, Fall, and Width.

The Pulse Average Amplitude defines the pulse top as the average of the values of all the points along the pulse top. This average is used
as the 100% level, from which the 10, 20, 50, 80 and 90% levels are calculated. Pulse measurements are referenced against these various
levels. For example, Rise is the time between the 10 and 90% (or 20 and 80%) levels on the rising edge of the pulse. When the Pulse
Average Amplitude method is selected, the same 100% level is used for both rising and falling edges.

Because some RF pulse types have droop (a height difference between the beginning and ending points of the pulse top), the 100%
percent level on the rising edge may not be equal to the 100% level on the falling edge. The Independent method of pulse point location is
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designed for pulses with different 100% levels at their rising and falling edges. The Independent method calculates the 100% level for the
rising edge separately from the 100% level of the falling edge. As a result, the 10, 20, 50, 80 and 90% levels are also different for the rising
and falling edges, allowing for more accurate measurements on pulses with droop.

50% Level
Select Voltage to use -6 dB as the 50% point. Select Power to use -3 dB as the 50% level.

Freq Estimation Tab
Use the Freq Estimation tab to specify parameters used for determining frequency offset. This tab is not available for the Pulse-Ogram
display.

Setting Description

Modulation type Specifies which algorithm to use for estimating frequency error.

Pulse Frequency Reference Specifies the method used to determine the pulse frequency error and if applicable, the chirp slope.

Auto Selecting Auto causes the instrument to calculate the frequency offset and if applicable, the chirp
slope.

Freq Offset If Auto is not enabled, specify the value for frequency offset here. If Auto is enabled, the offset is set
to zero and this readout displays the calculated frequency error.

Chirp BW If Auto is not enabled, specify the value for Chirp Slope here. If Auto is enabled, this readout displays
the calculated Chirp slope. This setting is used only when the modulation type is set to Linear Chirp.

Modulation Type
Frequency estimation is performed by the instrument using selectable methods, depending on signal type. The selections for modulation
type are CW (constant phase), CW (changing phase), Linear Chirp and Other. Select the method of frequency method based upon a best
match to your signal based on the following descriptions:

• CW (constant phase): The signal is not designed to change in either frequency or phase during the measured pulse train.
• CW (changing phase): The signal does not change the carrier phase within each pulse, although it could change the phase from one

pulse to another pulse. The signal is not designed to make frequency changes.
• Linear Chirp: The signal changes frequency in a linear manner during each pulse. The signal has the same carrier phase at the same

time offset from the rising edge of the pulse.
• Other: The signal is not one of the listed types. You must manually enter the Frequency Offset value.

The following table maps the appropriate signal type selection with the signal characteristics.
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Signature Phase offset from one pulse to another

Zero Any (unknown)

CW CW Constant Phase CW Changing Phase

LFM Linear Chirp N/A

Analysis Tab
The Analysis tab is only available for the Pulse-Ogram display. It allows you to set parameters related to analysis of the signal. The settings
vary depending on which spectrum analysis region you select.

Setting Description

Measurement bandwidth Specifies the frequency range used by the measurement. This control is linked to the Bandwidth
control of other Pulsed RF Displays. If No Filter – Max BW is selected in other displays, the
control setting is disabled, but shows the maximum value possible. If No Filter or Gaussian is
selected in other displays, then the Bandwidth control is also enabled in the Pulse-Ogram display.

Filter shape Spectrum of the signal is windowed by the desired filter shape.

Use analysis time settings Provides the complete analysis length as displayed in Time Overview.

Pulse on time Analysis is done in the ON period of the data.

Length Specifies the analysis length.

Table continued…
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Setting Description

Power threshold to detect pulses Specifies the level used for locating pulses in the data.

Independent In Manual option, you can choose the analysis length of the desired type for the Freq vs Time
view in the display.

Start Specify the analysis offset. The default value is the offset in Time Overview.

Length Specify the analysis length. The default value is the length in Time Overview.

Traces Tab
The Traces tab is only available for the Pulse-Ogram display. It allows you to set the trace characteristics for the display.

Setting Description

Smooth points Shows the number of filter coefficients used for smoothening the noisy region for visual clarity.

Detection Trace Detection is used to reduce the results of a measurement to the desired number of trace points.

Detection
Trace Detection is used to reduce the results of a measurement to the desired number of trace points. For example, if the maximum
number of trace points is 100,000 and a measurement over the selected analysis length yields 200,000 points, the measurement must
decimate these 200,000 trace points by 2 to prevent exceeding the 100,000 trace point limit. Since only one value can be represented for
each trace point, an algorithm must be used to select (detect) the appropriate value to use.

The results array from an analysis can be detected (or “decimated”) in a variety of ways. The number of results points produced for each
trace point varies with both analysis length and trace length. For example, the frequency transform used for the Spectrum display produces
just one output value for each desired trace point. In this case, the detection method chosen has no effect, as no decimation is required.

Increasing the Analysis Length (or for the Spectrum display, the Spectrum Length), causes the available detection method's output traces
to differ from each other because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

• +Peak: The highest value is selected from the results to be compressed into a trace point.
• –Peak: The lowest value is selected from the results to be compressed into a trace point.
• Avg (VRMS): Each point on the trace is the result of determining the RMS Voltage value for all of the results values it includes. When

displayed in either linear (Volts, Watts) or Log (dB,dBm), the correct RMS value results.
• Sample: The first value is selected from the set of results to be compressed into a trace point.
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Scale Tab
The Scale tab is only available for trace displays. It allows you to change the vertical and horizontal scale settings. Changing the scale
settings changes how the trace appears on the display but does not change control settings such as Measurement Frequency. In effect,
these controls operate like pan and zoom controls. Each display has different settings, as shown below.

Figure 59: The above image shows the Scale tab for the Pulse Statistics display.

Figure 60: The above image shows the Scale tab for the Pulse Trace display.

Figure 61: The above image shows the Scale tab for the Pulse Cumulative Statistics display.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale. The units for this setting depend on the statistic selected from the Result
drop-down list in the Pulse Statistics display.

Position Adjusts the Reference Level away from the top of the trace display. The units for this setting depend
on the statistic selected from the Result drop-down list in the Pulse Statistics display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to change the span.

Position Allows you to pan a zoomed trace.

Table continued…
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Setting Description

Full Scale (Pulse Trace display
only)

Specifies the Horizontal scale default.

Selected Sets the horizontal scale default to be based on the result value for the currently-select pulse.

Max Pulse Sets the horizontal scale default to be based on the largest value for the selected pulse measurement.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Plot (Pulse Statistics display only) Specifies the FFT, Trend, Time Trend, or Histogram plot.

Reset Scale Restores all settings to their default values.

Figure 62: The above image shows the Scale tab for the Pulse-Ogram display.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Frame Offset Display will start after the indicated frame number.

Frame Scale Shows how many frames are displayed in both Time vs Time and Frequency vs Time views.

Horizontal

(Time vs Time view)

Controls the span of the Time vs Time trace display and position of the trace.

Position Allows you to pan a zoomed trace. The default value matches the offset of the acquisition.

Scale Allows you to change the span. The default value matches the length of the acquisition.

Reset Scale Restores the position and scale settings to default value.

Horizontal

(Frequency vs Time view)

Controls the span of the Frequency vs Time trace display and position of the trace.

Start Freq Allows you to set the starting frequency shown in the graph without changing analysis. The default
value matches the highest frequency of the span.

Table continued…
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Setting Description

Stop Freq Allows you to set the stop frequency shown in the graph without changing analysis. The default value
matches the highest frequency of the span.

Reset Scale Restores the start frequency and stop frequency to default values.

Prefs Tab
The Prefs tab is only available for Pulsed RF trace displays. It is not available for the table displays. It enables you to change parameters
of the measurement display. Available parameters vary depending on the selected display.

Figure 63: The above image shows the Prefs tab for the Pulse Cumulative Histogram display.

Figure 64: The above image shows the Prefs tab for the Pulse-Ogram display.

Figure 65: The above image shows the Prefs tab for the Pulse Cumulative Statistics display.
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Figure 66: The above image shows the Prefs tab for the Pulse Statistics display when Time Trend is the selected plot type. Trend and FFT plot types do not show the Show
Marker readout selection.

Figure 67: The above image shows the Prefs tab for the Pulse Statistics display when Histogram is the selected plot type.

Figure 68: The above image shows the Prefs tab for the Pulse Trace display.

Setting Description

Show graticule Displays or hides the graticule in the trace display.

Show Marker readout in graph

(Only available for Pulse Trace and
Pulse-Ogram displays.)

When a marker is enabled, this setting displays or hides the maker readout, but not the maker
itself, on Time Trend plots.

Histogram readout

(Only available for Cumulative
Histogram display and the Pulse
Statistics display when Histogram is
the plot type.)

Controls the parameters Histogram readout and Bins. Histogram readout can be set to either
Count or %. Count indicates the number of hits that fell into each bin. % indicates percentage of
the total count (for the acquisition) that fell into each bin.

Table continued…
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Setting Description

Calculate statistics in linear scale (for
results in log)

(Only available for Pulse Statistics
display.)

Checking this box allows for calculation of statistics in the linear domain (for example, the Power
values in dB are converted to Watts (linear scale) and statistics are computed in Watts and then
converted back to dB scale). This measurement will be observed only when this box is selected.

This selection only appears in the Pulse Statistics display for these measurements: Average
ON Power, Average Transmitted Power, Peak Power, Impulse Response Amplitude, Droop dB,
Overshoot dB, and Ripple dB.

Bins

(Only available for Pulse Statistics
display when Histogram is the plot
type.)

Specifies how many "bins" or histogram bars the results are distributed into.

Auto

(Only available for Pulse Statistics
display when Histogram is the plot
type.)

Sets the bin number to automatic default, which is 10.

Outlier readout

(Only available for Cumulative
Histogram display)

Controls the parameters Outlier readout and Bins. Outlier readout can be set to either Count or %.
Count indicates the number of hits that fell into each bin. % indicates percentage of the total count
(for the acquisition) that fell into each bin.

Trace points

(Only available for the Pulse-Ogram
display.)

Sets the number of trace points used for marker measurements and for results export.

Frame Info

(Only available for the Pulse-Ogram
display.)

Displays or hides the frame information in the display.

The statistics can be calculated in the linear domain as well the log

Average ON Power, Average Transmitted Power, Peak Power, Impulse Response Amplitude, Droop dB, Overshoot dB, Ripple dB, the
statistics can be calculated in linear domain as well, i.e. the Power values in dB are converted to watts (linear scale) and statistics are
computed in watts and then converted back to dB scale. This measurement will be observed only when the Calculate statistics in linear
scale (for results in log) is selected.
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EMC Accessories
Overview
Tektronix has accessories for EMC pre-compliance testing available to you. The following topics are presented to assist you with using
these accessories to perform tests.

• Radiated tests introduction
• Antennas and radiated test accessories

• EMI-BICON-ANT biconical antenna
• EMI-CLP-ANT Log Periodic Dipole Array antenna
• EMI-PREAMP preamplifier
• EMI-TRIPOD antenna tripod

• How to set up a radiated pre-compliance test for

• 30 MHz to 300 MHz
• 300 MHz to 1 GHz

• Conducted tests introduction
• Conducted test accessories

• EMI-LISN50UH-US
• EMI-LISN50UH-GB
• EMI-LISN50UH-EU

• How to set up a conducted pre-compliance test with LISN
• Other accessories

• CABLE-1M, CABLE-3M, CABLE-5M
• EMI-LISN5UH
• EMI-NF-AMP
• EMI-NF-PROBE
• EMI-TRANS-LIMIT

• Accounting for accessories contributions in the EMCVu software

Tip: View the topics in the EMC Analysis section of this Help for information about using the EMC Analysis software.

Radiated tests introduction
Radiated emissions testing is about measuring the electromagnetic field strength of the emissions that are unintentionally generated by
your product. Emissions are integral to the switching voltages and currents within any digital circuit; however, it is important that they
comply emission limits.

The actual setup for Compliance tests is clearly specified in the standard document as applicable to the different types of products. You
should refer to these standards for details about the actual setup. There are several challenges in the actual Radiated test setup. The
electromagnetic waves don't extend out from your product in a nice spherical pattern. The emissions tend to be directional, so a test lab
would typically vary the height of the receiving antenna between 1 and 4 meters as well as rotate a turntable. The receiving antenna picks
up both the signal direct from the EUT, as well as a bounce off the ground. To increase measurement accuracy, the ground is covered with
an electromagnetically reflective surface (aluminum, steel, wire mesh etc..) and this ground plane must be relatively flat. The EUT will be
scanned in the frequency band of interest and you will look for emissions that are close to the limits.
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Pre-compliance can help you find out emission issues early or troubleshoot emissions issues reported by a test house. A Radiated
Emission Pre-Compliance test setup diagram is shown below with the equipment under test (EUT), ground plane, antenna mounted on a
tripod, a pre-amplifier, and a spectrum analyzer. The radiation from the EUT is picked up by the antenna, the output of which is amplified
by a pre-amplifier for better sensitivity. The output of the pre-amplifier The output of the pre-amplifier is connected to the input of the
analyzer that acquires the signal and analyzes it with the help of the software (EMCVu).
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EMI-BICON-ANT (ABF-900A biconical antenna)
The EMI-BICON-ANT (Com-Power ABF-900A) is a broadband, linearly polarized Biconical Dipole Antenna with collapsible elements,
operating over the frequency range of 25 MHz to 300 MHz. Each full-size biconical element (54 cm cage diameter) collapses to a
maximum diameter of 5 cm for easy transport/storage.
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The ABF-900A biconical antenna is intended for use as an EMI test antenna for qualification-level regulatory compliance measurements
(FCC, CE, Mil-Std, RTCA DO-160, FDA, SAE Automotive, etc.).

ABF 900 has the following characteristics (Antenna factor).

These factors can be loaded into the EMCVu Accessories tab (located in the EMC Settings control panel or the EMC Project Setup
Wizard). The file will be available to you in C:\SignvalVu-PCFiles\EMC_Accessories.

Tip: See the Radiated tests introduction topic for more information and to view a connections diagram.
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EMI-TRIPOD (AT-812 antenna tripod)
The recommended support structure for the Com-Power ABF-900A is the Com-Power AT-812 Antenna Tripod. One of the standard AT-812
accessories is the Com-Power ATHP-812 Antenna Pipe Holder, which clamps securely around the one-inch diameter feed tube of the
ABF-900A. The ATHP-812 is then secured to a tripod or mast via its 1/4” x 20 thread mounting hole.

Figure 69: The above image shows the tripod.

Figure 70: The above image shows the mounted antenna with the pipe holder.

Tip: See the Radiated test introduction topic for more information and to view a connections diagram.
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EMI-CLP-ANT (ALC-100 Log Periodic Dipole Array (antenna)
The Com-Power ALC-100 is a broadband, linearly polarized Log Periodic Dipole Array (LPDA) antenna, operating over the frequency
range of 200 MHz to 1 GHz and with excellent efficiency between 300 MHz and 1 GHz.

The ALC-100 Compact Log Periodic Antenna is intended for use as an EMI test antenna for qualification-level regulatory compliance
measurements (FCC, CE, RTCA DO-160, FDA, SAE Automotive, etc.).

The ALC-100 can also be mounted using the AT-812 tripod (which is a part of the accessories given by Tektronix).

Tip: See the Radiated tests introduction topic for more information and to view a connections diagram.

EMI-PREAMP (PAM-103 preamplifier)
The Com-Power PAM-103 is a broadband, high gain, low-noise preamplifier operating over the frequency range of 1 MHz to 1 GHz.
Its high gain (33 dB ±3 dB) and low noise figure (<3.3 dB) make the PAM-103 preamplifier the ideal choice for optimizing your EMI
measurement system, whether it be a test chamber, open area test site, or tem-cell.

The PAM-103 can be powered by its internal, rechargeable battery packs, or by its AC to DC power adapter/battery charger. On a full
charge, the preamp will operate on battery power for over 13 hours. The battery low indicator light will let you know when it is time to plug
it in and the charging indicator light will let you know that it is charging. If you are unable to plug it in, you can feel confident in continuing
your test, because the PAM-103 will turn itself off before the battery voltage reaches the point at which the gain could become unstable.
Whether it is operating on battery power or external power, if the amp is on, the output should be stable and the gain should remain
constant.
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Nearly all measurement systems for radiated EMI tests require preamplification to achieve the necessary sensitivity.

Tip: See the Radiated tests introduction topic for more information and to view a connections diagram.

Radiated pre-compliance test setup (30 MHz to 300 MHz)
A simple pre-compliance setup is shown below using a ABF-900 antenna, a preamplifier, and an RSA306B real-time spectrum analyzer.

1. Mount the antenna pipe holder ATHP-812 on the top support (ATTS-812) of the tripod (AT-812).
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2. Mount the antenna pipe AB-900A on the antenna pipe holder (ATHP-812).

3. Fix the biconical antenna (ABF-900) to the antenna pipe (AB-900A).
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4. Connect the output of the antenna pipe to a pre-amplifier through a Tektronix cable.
5. Connect the output of the pre-amplifier to a Tektronix USB spectrum analyzer or a RSA5100B series spectrum analyzer.

Tip: See the Radiated tests introduction on page 323 topic for more information and to view a connections diagram.

Radiated pre-compliance test setup (300 MHz to 1 GHz)
A pre-compliance setup is shown below using the ALC-100 antenna, a preamplifier, and an RSA306B real-time spectrum analyzer.

1. Clamp the accessory to the top support (ATTS-812) of the tripod (AT-812).
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2. Mount the antenna (ALC-100) to the accessory connected in the previous step.

3. Connect the output of the antenna to a pre-amplifier through a Tektronix cable.
4. Connect the output of the pre-amplifier to a Tektronix USB spectrum analyzer or an RSA5100B series spectrum analyzer.
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Tip: See the Radiated tests introduction on page 323 topic for more information and to view a connections diagram.

Conducted tests introduction
Conducted emission tests are about testing the portion of electromagnetic energy created by your device that is conducted onto the power
supply cord. To restrict the amount of interference your device can couple back onto a power supply, test labs measure these emissions
(usually from 150 kHz - 30 MHz) and verify that they comply with specified limits.

This helps to ensure that the local power supply remains relatively clean and nearby devices will not be affected by your device.
Conducted emissions testing is usually performed on devices that connect to an AC power supply. For some standards, there are also
limits placed on devices that operate from a DC power supply.

LISN is one of the key accessories required for doing a conducted test.
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EMI-LISN50UH (TBLC08 Line Impedance Stabilization Network)
The following models are available:

• EMI-LISN50UH-US: This model supports DUT devices with US main power.
• EMI-LISN50UH-GB: This model supports DUT devices with GB main power.
• EMI-LISN50UH-EU: This model supports DUT devices with EU main power.

The 50 μh AC line Tekbox TBLC08 is a Line Impedance Stabilization Network (LISN) for the measurement of line-conducted interference
within the range of 9 kHz to 30 MHz, as per the CISPR16 standard. The device is designed for testing single phase, AC-powered
equipment with supply voltages up to maximum 260 V. Conducted noise can be measured on the phase and on the neutral conductor. The
TBLC08 is equipped with a switchable limiter/attenuator.

The LISN provides for stabilization and lets you measure what amount of energy is fed back to the power line. The LISN is powered and
the front-end power socket lets you power your equipment under test (EUT). The emissions that is fed back to the power line is available at
RF out for a receiver or spectrum analyzer to measure.

The LISN is connected to the AC power supply and provides power to the EUT. The spectrum analyzer is connected to the RF out of the
LISN. TBLC08 has an built-in limiter that can be switched ON to avoid transients. The emission that is usually fed back to the power line is
made available at RF OUT by the stabilization network.
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Tip: See the Conducted tests introduction topic for more information and to view a connections diagram.

CABLE (coaxial Type N to Type N)
The following cables for EMI testing are available from Tektronix:

• CABLE-1M: 1 meter RF coaxial Type N to Type N cable
• CABLE-3M: 3 meter RF coaxial Type N to Type N cable
• CABLE-5M: 5 meter RF coaxial Type N to Type N cable

EMI-LISN5UH (TBOH01 Line Impedance Stabilization Network)
The 5 μh DC line Tekbox TBOH01 is a Line Impedance Stabilization Network (LISN) for the measurement of line-conducted interference
within the range of 150 kHz to 110 MHz. It is inserted into the supply line of the DUT.

Tip: See the Conducted tests introduction on page 334 topic for more information and to view a connections diagram.

EMI-TRANS-LIMIT (LIT-153A transient limiter)
The Com-Power LIT-153A is a transient limiter that protects the EMI receiver input via the LISN from any short transients (a few
microseconds or less) on the power supply lines.
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Tip: See the Conducted tests introduction on page 334 topic for more information and to view a connections diagram.

EMI-NF-AMP (TBWA2 amplifier)
The TekBox TBWA2 is a 20 dB or 40 dB wideband amplifier for use with the TBPS01 probes.

Tip: See the EMI-NF-PROBE accessory topic.

See the Radiated tests introduction topic for more information and to view a connections diagram.
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EMI-NF-PROBE (TBPS01 near field probe set)
The TekBox TBPS01 is a near field probe set.

Tip: See the EMI-NF-AMP accessory topic.

See the Radiated tests introduction on page 323 topic for more information and to view a connections diagram.

Accounting for accessories contributions in EMCVu software
Each accessory has its own Gain/Loss (antenna factor in the case of antennas) that must be accounted for to get an accurate emission
measurement. The measured reading must be corrected for the Gain/Loss/ Factor contribution due to the accessories.

The EMCVu software allows you to correct for the accessory contributions. You can either use the Setup Wizard – Accessories tab or the
Accessories tab in the Settings control panel to account for these contributions. You can view the Combined Impact of all the accessories
in a graph, too.

The typical values of Gains/Losses/Factors of each of the Tektronix provided accessories is available for you to easy load. You can either
use the “Load Tektronix provided Accessories Gains/Losses” from the Setup Wizard or you can load individual accessory files using
“Configure Accessories > Edit > Load”. The individual .csv files are available in C:\SignalVu-PC Files\EMC Accessories.

Tip: See the How to perform an EMC pre-compliance test on page 343 topic for more information of how you can perform an
emission measurement. See the Combined impact of gains/losses on page 384 to read more about contributions.
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EMC Analysis
Introduction to EMC Analysis
The Electro Magnetic Compatibility (EMC) Analysis option (Option 32) allows you to perform pre-compliance emissions tests for your
devices and troubleshoot emission issues. A separate EMCVu icon is loaded to your Desktop for quick access to the EMC displays,
setups, and standards. These same displays, setups, and standards can also be accessed from the analyzer.

EMC is a measure of the capability of a device to operate as expected in its operating environment. A device should not affect the
capability of other equipment in a certain proximity to operate as expected. EMI can be defined as electromagnetic energy that affects
the functioning of an electronic device. Sources of EMI are predominantly from electronic devices or electrical systems. While EMI can be
generated from any electronic device, certain equipment and components, such as cell phones, welders, motors, and LED screens, are
more likely to create disturbances than others. Measuring the amount of EMI generated by the internal systems of devices is a process
known as emissions testing. The RF range is generally split into a Conducted range and a Radiated range.

Several consequences, including safety risks and product failures, can result if you fail to properly anticipate the EMC of a device.
Tektronix’s EMC solution helps you find the emission problems in your device and troubleshoot them.

EMC standards
The EMC standards bring a common approach to every member state to EMC/EMI testing. It is important to purchase the standards
document to do these tests because it lays out a clear procedure for test setup and methodologies. The CISPR standards usually define
test procedures for commercial products.

The various standards set down limits for conducted and radiated EMI emissions. Typically, limit lines are defined separately for residential
areas and industrial areas. These two areas are represented by two classes of limits: class A represents the industrial environment; class
B defines the limits for residential areas.

The following are standards for which limit lines can be easily loaded in this application. Complete information about setup and testing can
be found in the standard document.

Available standards under Europe are:
• EN55011: Industrial, scientific and medical (ISM) equipment containing a radio-frequency generator
• EN55012: Vehicles, motor boats and internal combustion engines - protection of off-board receivers
• EN55013: Sound / television broadcast receivers and associated equipment
• EN55014: Household appliances, portable electrical tools and similar apparatus, parts
• EN55015: Electrical lighting and similar equipment, for example fluorescent lamps
• EN55025: Vehicles, motor boats and internal combustion engines- protection of on-board receivers
• EN55032: Multimedia equipment (replaces CISPR 13 and CISPR 22 from 2017)
• EN60601: Medical Electrical equipment
• DEF STAN: Defense Standard for equipment and sub systems

Available standards under US are:
• FCC Part 15
• FCC Part 18
• MIL-STD 4161G

Key features
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EMC testing with Tektronix provides you the following suite of pre-compliance and troubleshooting tools and displays to help you debug
problems faster.

Pre-compliance on page 342

• EMC Project Setup Wizard on page 346: Use the EMC Project Setup Wizard to include contributions due to accessories, load ranges
and limits based on standards recommendations, choose between measurement types, and include information for reports.

• Measure ambient on page 357: Measure emission not contributed by the Equipment under Test (EUT) and compare it with results
obtained when the EUT is turned on.

• Re-measure spot on page 358: Identify emission results from a scan and re-measure on the selected spot (frequencies that have failed
Threshold/Limit lines) with detectors recommended by the standard or detectors defined by you.

• Reports on page 356: Include measurement results and settings in a report. Include multiple measurement results in a report.

Troubleshooting

• Harmonic Markers on page 364: Allows you to place markers at selected harmonic factors of a known fundamental frequency to find if
the emissions are caused by known design issues.

• Inspect Suspect Frequencies: Inspect a set of suspect frequencies in discrete mode or a set of harmonics of as many as 3
fundamental frequencies. You can use this tool with a near field probe set to see from where the suspect emission frequencies come.

• Level Target on page 367: Place a level target in the display and compare scans against the target visually.
• Compare Traces on page 368: Compare different scan traces, save traces, recall traces, and compare against limit lines. Compare

Ambient traces and use the Math function (the difference of two traces) to create a Math trace.
• Persistence Display on page 370: Troubleshoot intermittently occurring emissions using the persistence tool with the DPX display.

Displays

• EMC-EMI
• DPX
• Spectrogram
• Spectrum Display

How to open EMCVu

You can start the EMC Analysis tool one of the following ways:

1. Double click  on the Desktop. This EMCVu icon will open the analyzer defaulted to the EMC Analysis display with the Setup
Wizard open.

Tip: EMCVu is best viewed in 1920x1080 or 1920x1200 resolution.

2. Double click the RSA icon on the Desktop. This icon will open the analyzer.

a. Select Setup from the Main menu bar and select EMC. This allows you to access various EMC functions. To get started with an
EMC pre-compliance test, select Setup Wizard. You can read more about the EMC Project Setup Wizard here.
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b. Click the icon  on the Favorites bar and check the box next to EMC. This will place the EMC menu options on the Favorites bar
for quick access.
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Elements of the EMC Analysis window

Element Description
1 These menu items on the Favorites bar are EMC Analysis specific. You can add or remove these items from the

Favorites bar by clicking the  icon (located at the far right end of the bar) and then checking or unchecking the
box next to EMC.

2 The graph of the currently selected display appears here.
3 Emissions results will appear here.

Pre-compliance
The Tektronix EMC analysis option allows you to perform pre-compliance testing of your equipment to detect possible emissions
at an early stage, reducing the chances of failure at the test house. The EMC software can be accessed through the analyzer
application interface or though the EMCVu icon on your Desktop. This analysis option provides the following four key features to perform
pre-compliance testing.

1. Quick start guide on how to perform a pre-compliance test.
2. Setup Wizard

• Accessories tab
• Ranges & Limits tab

3. Measure ambient on page 357
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4. Re-measure spot on page 358
5. Reports on page 356

CISPR (International Special Committee on Radio Interference) detectors are needed when performing EMC testing of electronic devices.
Specifically, levels of EMI need to be under a reference while being measured with a specified CISPR detector. These detectors are
defined in Publication 16 of CISPR. Option SVQPNL-PC and SVPQFL-PC adds these CISPR detectors and filters so you can perform
the required EMI measurements needed for your DUT (Device Under Test). These detectors can be invoked in the Spectrum display or in
the EMC–EMI display. Note that these detectors process the signal over a long period of time (2 seconds), so it is expected that the user
interface may seem less responsive during that time.

Tip: Click here to see How to open EMCVu on page 340 (EMC Analysis).

Tip: The EMC Project Setup Wizard contains a subset of available EMC settings. See the EMC-EMI settings on page 376 topic
for information about those additional settings.

How to perform an EMC pre-compliance test

1. Double click  on the Desktop. This EMCVu icon will open the analyzer application defaulted to the EMC Analysis view with
the Setup Wizard open on the Getting Started tab.

2. Select Conducted or Radiated as the Emission Type. This selection is located at the top of the Setup Wizard window.
3. Select the Accessories tab.
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4. Click the Load Tektronix Provided Accessories Gains/Losses button.
5. If you selected Conducted emissions, a window will appear prompting you to turn on the limiter in LISN. When you have done this,

click OK to continue.

LISN and cable will be loaded for the conducted pre-compliance setup. If you need to add other accessories, do so now. View the
Add/edit individual accessories or Load accessories from a saved file on page 351 topics for detailed instructions.

6. If you selected Radiated emissions, a window will appear prompting you to select the frequency range of the antenna. When you
have done this, click OK to continue.
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Antenna, Cable, Pre-Amplifier, and Cable will be loaded for the radiated pre-compliance setup. If you need to add other accessories,
do so now. View the Add and/or edit individual accessories on page 349 or Load accessories from a saved file on page 351 topics for
detailed instructions.

7. Select the Ranges & Limits tab. View the Load from Standard on page 352 and Choose a measurement method on page 353 topics
to read about how to use this tab.

8. Select the Reports tab and select the information to be contained in the report. View the Reports on page 356 topic for details about
how to do this.

9. Click the Setup Complete– Run Test button to initiate a single scan.
10. If desired, you can change the Reference Level for better sensitivity. In general, you can set the reference level based on the largest

signal of interest.

For example, for a 50 dBuV reference level, the maximum emission level that can be measured is 55 dBuV (5 dB over-scale). If the
signal of interest is lower, then the reference level can be adjusted accordingly. Emission levels that are approximately 10 dB higher
than the noise level can be measured accurately.

The noise level can be easily measured by terminating the input to the LISN/Antenna or removing the EUT and other sources of EMI
from the test setup. The noise floor has to be measured with the same RBW that is used to measure emission level (recommended
by the standard). For example, if the noise floor is measured at -5 dBuV for 120 kHz RBW, then emission levels at 5 dBuV or higher
can be accurately measured.

Tip: Read about troubleshooting tools and displays in the Troubleshooting topic.

Tip: To access more EMC settings, click the  icon or select Setup > Settings from the Main menu bar when the EMC-EMI
display on page 371 is selected.
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Tip: The EMC Project Setup Wizard contains a subset of available EMC settings. See the EMC-EMI settings on page 376 topic
for information about those additional settings.

EMC Project Setup Wizard
The EMC Project Setup Wizard opens on the Getting Started tab. The content on the Getting Started tab leads you through a series of
well-defined steps to set up and perform an EMC pre-compliance test. The other tabs, buttons, and settings of the Setup Wizard allow you
to select accessories, set ranges and limits, create reports, and perform other tasks, as shown in the following table.

Tip: EMCVu is best viewed in 1920x1080 or 1920x1200 resolution.

Tip: The EMC Project Setup Wizard contains a subset of available EMC settings. See the EMC-EMI display settings topic for
information about those additional settings.

Setting/Tab Description

Emission Type Allows you to select the emission type: Conducted or Radiated.

Getting Started Guides you through a pre-compliance test.

Accessories Allows you to specify accessory related settings.

Ranges and Limits tab on page 351 Allows you to specify range and limit related settings for comparison, choose measurement
modes, and load standard recommended values.

Reports on page 356 Allows you to specify the details to be included in the test report.

Table continued…
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Setting/Tab Description

Help All of the Setup Wizard tabs, except Getting Started, have a Help button. Clicking this button
opens a Help file with information related to the currently active tab. For more in-depth information
about the EMC Analysis displays, settings, and functionality, select Help > User Manual from the
Main menu bar in the analyzer application.

Setup Complete — Run Test Allows you to begin a scan, initiating the test run.

Save Project Setup Allows you to save all of the Setup Wizard settings as an EMC project setup file.

Recall Project Setup Allows you to recall a saved EMC project setup.

Tip: The Setup Wizard will open every time the EMC-EMI display is launched. This behavior can be suppressed from the Prefs
tab in the EMC Settings control panel by disabling Show Setup Wizard on EMC-EMI display startup.

Accessories tab
This tab in the EMC Project Setup Wizard lists, and allows you to set up, the accessories required for the test. You can also view a graph
showing the combined impact of accessories gains and losses. The final measurement reading is corrected based on these accessory
contributions before it is shown in the display. The correction is calculated by negating the combined impact of all of the accessory
gains/losses you entered. 

Tip: The EMC Project Setup Wizard contains a subset of available EMC settings. See the EMC-EMI settings on page 376 topic
for information about those additional settings.
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Tip: Read more about the plot on this tab in the Combined impact of gains/losses (view in plot) topic.

You can load accessories one of the following ways:
• Use the Load Tektronix provided Accessories Gains/Losses button.
• Manually Add and/or edit individual accessory details.
• Use the Load All Accessories button.

More topics about setting up accessories and related information:
• Accessories setup
• Combined impact of gains/losses on page 384
• Calculation of combined impact of accessories gains/losses on page 386
• Edit accessory contributions
• External correction in DPX
• Loading accessories from a file
• Available accessories in the drop-down lists
• Two types of mismatch issues when recalling the csv file
• Changing accessory details

Load Tektronix provided accessories gains/losses
1. Select either Conducted or Radiated as the Emission Type (top of window, above the tab headings).
2. Click the Load Tektronix Provided Accessories Gains/Losses button.

3. For Conducted emissions:

You will be prompted to turn on the limiter in LISN. The default contributions loaded for the conducted pre-compliance setup are LISN
and cable. However, you can add any other accessories as needed.

4. For Radiated emissions:

The default contributions loaded for the radiated pre-compliance setup are Antenna, Cable, Pre-Amplifier, and Cable. However, you
can add any other accessories as needed.
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You will also be prompted to choose the antenna that is being used for the test. The biconical antenna is used for tests between
30 MHz and 300 MHz. The log periodic antenna is used for tests between 300 MHz and 1 GHz. Depending on the range of the test,
you can make the choice and the contribution due to those set of accessories will be loaded.

The parameters loaded for Cable are those of the CABLE-1M (1 meter) cable. If you are using a 3 m or 5 m cable, please load the
appropriate file from the C:\RSA5100B Files\EMC Accessories folder.

Tip: Read more about editing accessories in the Accessories tab and Accessories setup topics.

Add and/or edit individual accessories
1. To add an accessory, click on the arrow next to an accessory field and select from the drop down list. The list is dependent on the

selected emission type (Conducted or Radiated).
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2. To edit the details of an accessory, click the Edit button next the accessory you want to edit. A window will appear containing the
parameters of the accessory.

3. Edit the desired parameters. You can edit the following:

• Model number
• Serial number
• Asset tag
• Calibration due date
• Distance (for Antenna)
• Gain/Loss format

• Constant gain/loss2

• Antenna gain/loss table2

• Antenna factor
• Frequency interpolation (Linear or Log)

4. Click the OK button to close the edit window and go to another accessory.
5. Edit any other accessories, if needed.

2 Values are entered in dB with gain represented as positive values and loss as negative. For antennas, either isotropic gain information is entered in dBi or antenna
factors in dB/m.
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6. Click the Save All Accessories button to save the updated details of all edited accessories to a file.
7. Click the Load All Accessories button to load the updated accessories to the current setup.

Tip: Read more about editing accessories in the Accessories tab and Accessories setup on page 378 topics.

Load accessories from a saved file
1. Click the Load All Accessories button to load accessories from a saved setup file.

Note: The parameters loaded for Cable are those of the CABLE-1M (1 meter) cable. If you are using a 3 m or 5 m cable, please
load the appropriate file from the C:\RSA5100B Files\EMC Accessories folder.

Tip: Read about the combined impact of accessories and accessories setup information in the Accessories setup on page 378
topic.

Ranges and Limits tab
The Ranges and Limits tab of the EMC Project Setup Wizard allows you to specify the parameters that control the EMC-EMI
measurement. You can:

• Load from Standard
• View Ranges and Limits plot and edit label
• Edit Ranges and Limits on page 352
• Choose a measurement method on page 353
• Edit Scan and Spot Setup on page 355

Tip: The EMC Project Setup Wizard contains a subset of available EMC settings. See the EMC-EMI settings on page 376 topic
for information about those additional settings.
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Load from Standard
Click the Load from Standard button on the Ranges and Limits tab in the EMC Project Setup Wizard to load from a standard based on
the region selected. The following window will appear from which you can make selections.

• This window allows you to choose the region for which your product is intended and then a standard from a list of standards in that
region. You will need a copy of the standard document (the version number of the standard is mentioned as you make a choice of the
standard from the drop down).

• The various frequency ranges / limit line tables provided from the standard will be listed in a drop down for selection.
• Once the appropriate standard is loaded, you will see the ranges and limits recommended by the standard in a plot. The detector

choice recommended by the standard is also shown in the Scan Definition and Spot Setup below the plot. The limit line against which
the detector results will be compared is also shown as a mapping against each detector choice.

• A margin also can be set (shown by the dotted line) and this is applicable to all limit lines. The Margin setting is located to the left of the
plot.

• Some tables in standards recommend separate limit lines for each detector choice and all of them will be loaded.

View Ranges and Limits plot and edit label
• The Ranges and Limits loaded from standard can be seen in the plot in the Ranges & Limits tab of the EMC Project Setup Wizard.
• When loaded from standard, the limit label is set appropriately based on the standard and limit table choice. However, this can be

edited by clicking  (Edit Label button).
• The Limits are shown in different colors when more than one limit line is selected. This is indicated in the Limit legends.
• Margin for every limit line is shown in dotted form for every limit in the respective color.
• Frequency scale can be viewed in Linear or Log.

Edit Ranges and Limits
Ranges and limits can be customized from the Ranges & Limits tab of the EMC Project Setup Wizard. If you want to customize the limit
lines loaded from a standard or you want to create your own limit lines, do as follows.

1. Click the Edit Ranges and Limits button to left of the plot. The following expanded table will appear.

EMC Analysis

RSA5100B Series Real-Time Signal Analyzers Help 352



2. Edit the start and stop frequencies, RBW and VBW settings, and limit values.

As many as 3 limit lines can be included. The limit lines will be shown with individual color codes and the corresponding margin lines
shown in same color but in dotted form. The margin control is only one control applied in common to all limit lines.

3. Check to see that the customized limit lines appear in the plot.
4. Save frequency ranges and limit lines by clicking the Save button. You can also load from these saved files later.

Choose a measurement method
Once the desired ranges and limits are loaded, you can decide to do the measurement in one of the following three measurement
methods, which are available for most standards.
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• Pre-scan + Manual Spot: A quick pre-scan followed by choosing spots from results table and re-measuring them with detectors
recommended by the standard (or that of your choice).

• Pre-scan + Auto Spot: A pre-scan followed by an Automated re-measurement for a chosen number of spots.
• Complete Scan: A complete scan with detectors recommended by the standard - could be time consuming if detectors such as CISPR

Quasi Peak or CISPR Avg are chosen.

Tip: You can read more about measurement methods and how they can be set from the Ranges & Limits tab in the EMC Settings
control panel in the Measurements on page 393 topic.

The mapping of limit lines to the detectors is also shown under Scan Definition and Spot measurement. This tells you which detector will
be used for Scan and Spot measurements and which limit line will the Scan or Spot results be compared against.

The Estimated Analysis Time is shown to give an idea of how much time the Scan is expected to take for the detectors chosen. This
Estimated time is based out of the choice of detectors and the span of the actual scan measurement and is calculated under ideal
conditions for a machine with 16 GB RAM. Actual time taken for measurement could vary.

This estimated analysis time could be higher if detectors such as CISPR Quasi Peak are used for a larger span range.

The following three images show how the Scan Definition and Spot Measurement information may vary depending on the selected
measurement method.
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The three measurement methods might not be shown for some standards if they do not recommend detectors such as CISPR Quasi Peak
(for example, Mil/Gov 461G and DEF STAN). This is because the scan itself is done with CISPR Peak detector which can be done faster
and there is no need for a Pre-scan followed by spot measurements in such a case.

Edit Scan and Spot Setup
Edit Scan and Spot Setup allows you to modify any detector choice or dwell time. You can also do the limit mapping appropriately.

• Choose the appropriate detector for scan and spot re-measurement
• Set dwell time
• Choose the limit line mapping

EMC Analysis

RSA5100B Series Real-Time Signal Analyzers Help 355



By default, the standard recommended limit line is mapped to appropriate detectors.

Tip: You can read more about scan and spot setup in the Edit Scan and Spot Setup on page 355 topic.

Reports
The Reports tab in the EMC Project Setup Wizard allows you to select the information you want to include in a report.

Item Description

User information Includes user information in the report: Engineer name, Project name, and Organization name.
Empty fields will not be included in the report. If you do not want to include a default field, you can
leave it empty.

Table continued…
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Item Description

Environment information Includes environment information in the report: Temperature, Humidity, and Testing location.
Empty fields will not be included in the report. If you do not want to include a default field, you can
leave it empty.

EUT information Includes equipment under test (EUT) information in the report: Device type, Model Name,
Manufacturer name, and Serial number. Empty fields will not be included in the report. If you do
not want to include a default field, you can leave it empty.

Add Information New information details can be added to any of the three information areas by clicking an Add
Information button in the associated area. You can then providing details such as title and value of
the new item in the Add Information window.

Information to include Select which information areas to include in a report from this list. Check a box to include the
associated information. Uncheck a box to leave out the associated information.

1. Check the boxes in the Information to include: area of the Reports tab that are next to the information you want included in the
report.

2. Edit the information fields in the User, Environment, and EUT (equipment under test) areas, as needed.
3. If needed, click the Add Information button in the desired information area to add an additional field to the selected information area.

Tip: Read the Generating and saving reports on page 359 topic for detailed information about saving, generating, viewing, and
exporting reports.

Tip: The Setup Wizard will open every time the EMC-EMI display is launched. This behavior can be suppressed from the Prefs
tab in the EMC Settings control panel by disabling Show Setup Wizard on EMC-EMI display startup.

Measure ambient
An Ambient scan analysis can be done to quickly check if the Spots (emission at specific frequencies) obtained are due to ambient
emissions or the actual equipment. Perform this ambient scan analysis procedure to quickly check if the listed Spots are due to ambient
interference or the equipment.

1. Select Setup > EMC > Measure Ambient or click Measure Ambient from the EMC related items on the Favorites toolbar.
Alternatively, you can recall a trace saved from the Ambient tab in the EMC Settings control panel.

2. Follow the prompt that appears and turn off the Equipment under Test (EUT) or completely remove it from the setup.
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3. Click the Ambient tab in the EMC Settings control panel and set Detector, Dwell Time, and Delta Threshold appropriately.
4. Return the EUT to the setup, if removed, and turn it on.
5. Perform a scan with the same detector set in the Measurement Type tab.
6. View the Ambient trace in the graph.

Tip: Read about comparing ambient scan results in the Comparing ambient scan results on page 358 topic.

Tip: See the Ambient tab topic for more information about ambient settings.

Comparing ambient scan results
If you performed an ambient scan with the EUT turned on and the results table is populated with Spots (frequencies that have failed the
threshold or limit line), then comparison of those results with an ambient scan with the EUT off can be done. The comparison between
the Ambient trace (the scan with the EUT off) and Scan trace (the scan with the EUT on) is done at each failing frequency (Spot) in the
Emission Results table.

• Comparison of results is done only at all failing frequencies. The Delta difference between the Ambient trace and the Scan trace is
shown.

• The comparison of results is done only if the detector type for Scan and Ambient match.
• This Delta difference is compared against the Delta threshold setting made in from the Ambient tab in the EMC Settings control panel.
• If the absolute difference between the Ambient trace and Scan trace is less than the delta threshold, then those cells are shown

shaded in blue in the Emission Results table, as shown below. This means that the emission could be the result of the environment
and not the EUT.

Note: The Measure Ambient item in the Favorites toolbar will not be active if no instrument is connected or if no playback is
selected.

Re-measure spot
Click Setup > EMC > Re-measure Spot or click Re-measure Spot from the from the EMC related items on the Favorites toolbar, to
perform the spot re-measurement.

Spot re-measurement is performed on the selected spot (frequencies that have failed Threshold/Limit lines) from the Emission Results
table with detectors recommended by the standard or detectors defined by you. These detectors could typically be detectors that require
larger measurement/dwell time like CISPR Quasi peak.
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Spot re-measurement is useful when you want to do a quick pre-scan with peak detectors and then apply detectors with larger dwell time
only on those frequencies that have failed the Threshold or Limit line settings. It is also useful when the selected measurement method is
Pre-scan + Manual Spot or Pre-scan + Auto Spot.

• Once the scan is done for the trace, failing frequencies are listed in the Emission Results table and you can choose the spot(s) which
should be re-measured.

• You can choose the Spot(s) for performing spot measurements either from the plot or from the Emission Results table.
• The RBW for Spot measurement will be the same as that used by the pre-scan. This is because it would only be correct to compare

scan and spot results when they are done with the same RBW.
• The detector choice, limit line for comparison and dwell time for spot measurement are based on the choices you made while using the

Setup Wizard.
• You can also change the choice of detector(s) from the Measurement Type tab in the EMC Settings control panel. You can also choose

up to 3 detectors to analyze these spots.
• The Limit lines for comparison and the dwell time also can be edited.
• The re-measured spot results are then shown in the Emission Results table and also compared with appropriate limit lines.

If the Measurement method chosen is Pre-scan + Auto Spot, then the Re-measure Spot step is automatically performed. You can set the
maximum number spots to be automatically re-measured in the Measurement Type tab of the EMC Settings control panel. This option is
visible only when the measurement method is Pre-scan + Auto Spot.

Note: The Re-measure Spot item on the Favorites toolbar will not be active when no device is connected or when no playback is
selected.

Generating and saving reports
The Results and Reports window can be opened by selecting the  (Report) icon from the EMC related items on the Favorites toolbar.
This window has two tabs that allow you to save results, select what to include in a report, generate a report, export a report, and view a
report.

EMC Analysis

RSA5100B Series Real-Time Signal Analyzers Help 359



Save Results tab

1. Fill in the Measurement Heading field.
2. Add any additional information related to the test in the User Notes field.
3. Check the Include Control Settings box to include the EMC Settings control panel settings in the report.
4. Check the Include Graph check box and the Include Emission Results check box to include plot results and emission results in the

test report.
5. If available, check the Include Inspect Freq Result box to include Inspect results in the test report. This option is only available if an

Inspect measurement is chosen.
6. Select and browse to include any images in the report. Select the image file and click OK.
7. Click Save in the Save Results tab. The view will then change to the Generate Report tab where you can proceed to generate the

report.

Generate Report tab
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1. Select the details to be included in the report by checking or unchecking User Information, Environment information, and EUT
information.

2. Click the Edit button to edit the information, as needed. The following window will appear.
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3. Click the Add Information button in the desired information area to add an extra field or a parameter.
4. Click the Save button to save the information to a file for later recall. Or you can simply click the OK button to save the information for

this report. The Information Form will close and you can then select your results.
5. Check the box next to the result(s) for which you want to generate a report. You can select more then one result if you want to include

multiple measurement results in a single report.
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6. Click the Generate Report button to generate a report.
7. A preview window of the generated report will open. This window allows you to navigate, print, bookmark, email, and export the report.

A report can be exported in the preferred format (.pdf, .rtf, .xlsx, etc.) and saved locally for future use. Recommended file types are .pdf
and .rtf.

8. To delete existing results from the History panel of the Generate Report tab, check the boxes next to the items you want to delete, and
then click the Delete selected button. You can also use the edit, view, and delete icons next to a result to perform the related task.

EMC Troubleshooting
EMC testing with Tektronix provides you the following suite of troubleshooting tools and displays to help you debug problems faster.

Tools

• Harmonic Markers on page 364
• Inspect on page 364 (suspect frequencies)
• Level Target on page 367
• Compare Traces on page 368
• Persistence Display on page 370

Displays

• EMC-EMI
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• DPX
• Spectrogram
• Spectrum

Harmonic Markers
Harmonic markers tool allows you to place the markers at selected harmonic factors of a chosen fundamental frequency. It will be helpful
for you to see if certain emissions that result out of a scan are caused due to the harmonics of a known fundamental frequency. The
harmonic marker toolbar is used to define the fundamental frequency and harmonic factors.

1. Click Setup > EMC > Harmonic Markers from the Main menu bar, or click   (Harmonic Markers) on the Favorites bar to
open the Harmonic Markers toolbar.

2. Enter the Fundamental frequency in the Harmonic Markers toolbar. This is the base frequency on which harmonics are calculated.
3. Choose the harmonic factors from the drop down for the 5 markers (MR, M1, M2, M3, M4). The harmonic factors in the drop down can

be 1/8, 1/4, 1/2, 1, 2, 3, 4, 5, 6, 7, 8, 9 or 10.
4. Click Apply to place the markers at the appropriate harmonics.
5. Clicking Apply will also open the Marker table which will give information about the frequency at which these markers are placed and

the amplitude values can be seen under the respective display column (for example, in the EMC-EMI if that is the active display).

When the chosen harmonic factors are not in the range of the scan results then the markers could be aligned with the left or right edges to
indicate that the chosen factors are outside the range of the scan. For example, if the stop frequency is 6.2 GHz and if we attempt to place
a marker at the 10th harmonic of a fundamental frequency that is 1 GHz, then the marker will be placed at 6.2 GHz itself.

Tip: Harmonic markers can be used for other spectral displays; that is, displays having Amplitude vs Freq, such as Spectrum and
DPX). Even if EMC-EMI display is not open, this toolbar can be invoked from View > Harmonic Markers.

Inspect
Inspect is a troubleshooting tool you can use to analyze a set of suspect frequencies in more detail. As many as 3 detectors can be
selected and the detector results will be shown in a table format for each of the suspect frequencies. The result can also be compared with
a comparison level and the entire set of results can be reported out.

Click Setup > EMC > Inspect from the Main menu bar, or click  (Inspect) on the Favorites bar to open the Results table, which
shows the Inspect results.

On Selecting Inspect from EMC Toolbar or from Setup > EMC > Inspect, the results table and the Settings Control will open.

The measurement can be triggered by clicking Single or Continuous (located at the top of the Results table). The results can also be
brought into the Report using the Report tool from EMC Toolbar.

The Inspect display has the following two modes of harmonics measurement:

Harmonic mode
• In Harmonic mode, the suspect frequencies are built as harmonics of fundamental frequencies.
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• The detectors can be chosen from the drop down in the Detectors Setup. As many as 3 detectors can be chosen. Comparison level
can also be chosen for each detector too. Dwell time can be controlled too.

• Harmonic factors can be entered for each of the fundamental frequency by clicking on Edit factors (see snapshots below). Final
frequency is calculated as Fundamental Frequency * Harmonic factor. The Edit Harmonic Factors/RBW table will allow you to edit
RBW settings for the frequency that is being analyzed. Auto RBW flag will set RBW based on the chosen detector and frequency band
in which the final frequency falls.

• After selecting Single or Continuous in the Inspect Suspect Frequencies display, the Inspect results will be shown and they will be
compared with the respective Comparison Levels. Failures will be shown in red.

• Inspect Suspect frequencies can be done in Single (Stops after all suspect frequencies are analyzed once) or Continuous mode (will
continue updating the results table until stopped).
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Discrete mode
• In Discrete mode, you can develop a list of suspect frequencies by clicking on Edit Frequencies.

• The detectors can be chosen from the drop down in the Detectors Setup. As many as 3 detectors can be chosen. Comparison level
can also be chosen for each detector.

• Suspect frequencies can be entered by clicking on Edit Frequencies button.
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• The suspect list can also be loaded from “Load from Emission results” which will load the top 15 spots recorded in the Emission
Results table at the result of a scan.

• If no spots are listed in the Emission Results table, the following warning message is shown when the Load from Emission results
button is clicked.

• After selecting Single or Continuous in the Inspect Suspect Frequencies display, the Inspect results in Discrete mode will be shown
and the results are then compared with the respective Comparison Levels. Failures are shown in red.

In the Inspect Suspect Frequencies display, all detector results are held between acquisitions, unlike the scan results, which are computed
with every scan. When the Clear button is clicked, all detectors results will be cleared. This will allow you to set a smaller dwell time, even
for detectors such as CISPR Quasi Peak, and build stable results over acquisitions, resulting in faster analysis/updating.

Level Target
Level target is an indicator on the display that can be set by you. You can move it with a mouse. It can also be set at the Peak of the active
waveform. This tool is available on four displays (EMC-EMI, Spectrum, DPX, and Spurious). The Level Target will change in other displays
when changed in the active display.

You can use Level Target to assign it to the peak of a scan and retain the level for comparison for the next scan and see how it compares
with the new scan results.

1. Click Setup > EMC > Level Target from the Main menu bar, or click  (Level Target) on the Favorites bar. This will open the
Spectrum display and place the Level Target in the display. If the Spectrum display is already open, then hitting Level Target toggles
visibility of Level Target.

2. Click the To Peak button located on the left side of the Spectrum display to move the Level Target to the peak of the trace. You can
also click the To Peak button that appears in the Prefs tab of the Spectrum Settings control panel when the Show Level Target check
box is checked. To hide the Level Target indicator, uncheck the box.
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Compare Traces
This troubleshooting tool can be used to compare traces of different scan results. It can be used to compare as many as 2 Live Scan
traces, 3 Spot traces, 5 Recalled traces and a Math Trace (which is the result of subtracting any two traces). Legends for these traces will
also appear in the graph.

Click Setup > EMC > Compare Traces from the Main menu bar or click (Compare Traces) on the Favorites toolbar to open the
Traces tab in the EMC Settings control panel.

The control panel is divided into the following three areas:

Live traces area

• This area includes the traces that are shown on screen after a Scan or Spot re-measurement.
• Include up to a maximum of 2 scan traces and up to a maximum of 3 spot detector results.
• Function is available for Scan traces. This allows you to select to Max-hold or Average multiple acquisition results.
• The Save Selected Trace As button is only available if a live trace is selected. This button is disabled if no Live trace is selected.
• The check boxes in the Show column control the visibility of the trace in the main graph display.

Using Quick Save for Compare button
• You can compare scan results of two or more successive scan tests using this button.
• This button is only visible when one of the Live traces is selected.
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• When you click this button, the selected Live trace is saved automatically in your drive and recalled into one of the rows in Recalled
Traces. It will be automatically recalled into a row (Recall1 through Recall 5, in that order) depending on which one is free. The
following timed pop-up message will appear indicating the Recall Trace in which it is available for comparison.

• If none of the Recalled Traces are free, then clicking this button will save the trace in your drive and recall the trace as Recall 1
(replacing the earlier recalled trace in Recall 1). However, the files replaced can be browsed for and recalled using the Recall to
Selected Trace control.

• All traces saved with this button are saved in the C:\RSA5100B Files directory.

Recalled traces area

• Select any Recall trace (Recall 1 to Recall 5) to recall a saved trace.
• The Recall to Selected Trace button is only available if a Recall trace is selected.
• Once a trace is successfully recalled, the trace will be displayed in the graph for the chosen frequency range (set in the Ranges &

Limits tab of the EMC Settings control panel). Here is an example. The recalled trace is green:

• The recalled trace will be compared with the Limit lines (in the Ranges & Limits control settings) and the Emission results table will be
populated. Here is an example:
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Math trace area
Math Trace is a feature that allows you to obtain the subtraction result of any two traces. Two traces must be chosen from the Traces tab
and the difference trace will be shown in the graph. The Math trace is done only for log units in Y-axis and the difference trace is calculated
by subtraction of the dB values. The Math trace can also be saved (Save Trace As button) and recalled (check Show recalled trace box).

Math Trace allows you to check if emission components still exist from one scan trial to another or even to check if a live scan trace has
additional emission components as compared to the emission results obtained from Ambient (with EUT turned off). The following image
shows two traces and a Math trace. You can see that emission components 1 and 2 are emission components that are present in Scan1,
but not present in Recall1 (therefore it shows up in Math trace); however, the emission component at the far end is present both in Scan1
and Recall1 (hence cancelled out in the Math trace).

Persistence Display
This troubleshooting tool launches the DPX Spectrum display. This has the capability to show a persistence view over multiple acquisitions.
The speed of DPX allows you to select even transient emissions.

Click Setup > EMC > Persistence Display from the Main menu bar, or click  (Persistence Display) on the Favorites bar, to open
the DPX Spectrum display.
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Tip: You can read more about the DPX Spectrum display here.

EMC-EMI display
To show the EMC-EMI display:

1. Double click the  icon on the Desktop to launch EMCVu. This automatically opens the EMC-EMI display.
2. Alternatively, from the analyzer:

a. Click the Displays button or select Setup > Displays.
b. From the Measurements box, select EMC Analysis.
c. Double-click the EMC-EMI icon in the Available displays box. This adds the EMC-EMI icon to the Selected displays box (and

removes it from the Available displays box). Alternatively, you can click the EMC-EMI icon and then click the Add button to select
EMC-EMI for display.

d. Click the OK button.

Elements of the display
The EMC-EMI display window has three main areas:

1. Graph
2. Emission Results table
3. Inspect suspect frequency display
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Item Display element Description

1 dB/ div Sets the vertical scale value per division. The maximum value is 20.00 dB/division.

2 Units Sets the global Amplitude units for all the views in the analysis window. This will change
the Amplitude selection in the Units tab of the Analysis Settings control panel.

3 Vert Position Sets the top of graph value. This is only a visual control for panning the graph. The
Reference Level is adjusted in the toolbar and the Ampl Settings control panel. By default,
Vert Position = Ref Level.

4 Pass / Fail readout Indicates whether one or more frequencies have exceeded a limit specified on the
Settings > Limits tab. The readout will show as Fail even if a single Spot (either from
Scan or Spot Re-measurement) exceeds the Limit line. The Fail criteria can be modified to
include Margin from the Prefs tab.

5 Selected trace Indicates the selected or active trace.

6 Show Controls whether the selected trace is visible or not. When trace is Off, the box is not
checked.

Table continued…
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Item Display element Description

7 Trace function Indicates the trace processing method. If Average or Max Hold is selected, this readout
displays the number of traces being processed (averaged or compared for the Max Hold
value).

8 Clear Restarts multi-trace functions (Average, Max Hold).

9 Stop Adjusts the graph stop frequency. This setting affects only visual scaling, not measurement
parameters.

10 Emission results table Displays Emission results. See the Emission Results image and table that follow for
details.

11 Start Adjusts the graph start frequency. This setting affects only visual scaling, not
measurement parameters.

12 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen. Selects
Multi-range display mode.

13 Bottom of graph readout Indicates the amplitude at the bottom of the graph. This value changes with the dB/div and
Vertical Position settings.

14 Green bar Indicates the range that is selected on the Settings > Ranges and Settings > Limits tabs.

(Not
shown)

Inspect suspect frequencies This portion of the display appears to the right of the EMC-EMI graph when Inspect is
selected from the EMC related items on the Favorites toolbar. See the Inspect Suspect
Frequencies image and table that follow for more information about this display.

Emission Results table elements

Column Description

Select spot Selects the spot frequency for Re-measurement. Is shown in the graph too with white indicator.

Spot # A number that identifies a spot in the graph area. The instrument can display a maximum of 999 spots.

Range The letter representing the frequency range where the spot is located.

Freq (Hz) The failed frequency at which the spot occurs.

Table continued…
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Column Description

Ampl (Scan) The amplitude of the spot identified in scan.

Delta (Scan) Specifies the difference between Amplitude in scan and specified Limit line.

Ampl (Spot) The amplitude of the spot for chosen detector.

Delta (Spot) Specifies the difference between Amplitude and specified Limit line for the chosen detector.

• You can rearrange the order of the columns in the Emission Results table. To move a column, click on the column heading and drag it
to the desired position.

• You can sort the rows in the Emission Results table by clicking on the column heading. For example, if you click on the Freq, the
results in the Emission Results table will be sorted by frequency. If you click on Range, the rows will be sorted by range. Clicking a
second time on the same heading reverses the order.

• There can be as many as 2 Scan results (Ampl and Delta for each) and as many as 3 Spot Re-measure results (Ampl and Delta for
each) in the Emission results table.

• In addition to that, the Emission results table will also have columns for Recall trace (Amplitude and Delta with Limit 1) and Ambient
measurement results (Amplitude and Delta with Scan results).

Elements of Inspect Suspect Frequencies display
This section of EMC-EMI display shows the results of the Inspect Suspect Frequencies troubleshooting tool. This measurement has the
following two modes:

• Harmonic

• Discrete
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Setting Description

Single Selects the spot frequency for Re-measurement. Is shown in the graph too with white indicator.

Continuous A number that identifies a spot in the graph area. The instrument can display a maximum of 999 spots.

Settings The letter representing the frequency range where the spot is located.

Clear The failed frequency at which the spot occurs.

Column Description

Index Suspect frequencies numbered in the order in which they are defined.

Fundamental Frequency (Hz)

(Harmonic mode only)

Shows the fundamental frequency (Hz).

Harmonic Factor

(Harmonic mode only)

Shows the harmonic factor.

Frequency (Hz) Shows the frequency (Hz).

RBW The RBW you set in the Ranges and Limits tab on page 351 of the EMC Settings control panel is
shown in here.

Detector Detector results are shown in two columns (Abs and Delta) from comparison level for each detector.

Abs

Delta

Tip: Read the Inspect on page 364 topic in the Troubleshooting section for more information about this tool.
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EMC-EMI settings
Main menu bar: Setup > Settings

Favorites toolbar: 
The following tabs are available for the EMC-EMI display from the EMC Settings control panel.

Table 19: Common controls for RF measurement displays

Settings tab Description

Parameters Allows you to specify whether the graph displays one range or multiple ranges. You can also specify
whether all Spur/Spot on page 741 are shown or only spurs/spots over specified limits and margins.

Emission Type Enables you to specify conducted or radiated emissions for the EMI test.

Accessories Enables you to select, edit, load, and save accessories for conducted and radiated emissions tests.

Ranges & Limits Allows you to specify the start and stop frequencies for ranges, the parameters that define a spot (for
listing in the Emission Results table), and Pass/Fail parameters for limit testing.

Measurement Type Allows you to define the detectors for scan and spot measurement.

Traces Provides controls for live traces, recalled traces, and Math trace.

Ambient settings related to Ambient measurement and Ambient trace control. Ambient measurement can be
triggered by selecting Setup > EMC > Measure Ambient or clicking on Measure Ambient in EMC
Toolbar. The settings in the Ambient tab of Settings control panel apply only to measurements done
by selection of “Measure Ambient” This measurement is useful for capturing emissions caused by
environment or the Spectrum analyzer equipment. Before an Ambient scan is done, the EUT must be
switched off/or completely removed from the setup. Note - For workflow of this measurement can be
done, refer Measure Ambient section in the Pre-compliance section

Scale Allows you to change the vertical and horizontal scale settings.

Prefs Allows you to change the parameters of the EMC-EMI display.

Tip: Access to a subset of the above settings is available in the EMC Project Setup Wizard.

Parameters tab - EMC

Favorites toolbar: 
This tab is available for the EMC-EMI display from the EMC Settings control panel. It allows you to specify settings that control the EMC
Spurious measurement.
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Setting Description

Frequency Ranges

Multi Sets the analyzer to display all enabled ranges in the graph.

Single Limits the graph to display only the first range. Trace is shown only if this range is selected.

List Spots

All Spots Displays all frequency peaks that exceed the threshold values set in the Ranges & Limits
tab.

Over Limit Displays frequency peaks that exceed the threshold values and the chosen Limit lines set in
the Ranges & Limits tab.

Over limit with margin Displays frequency peaks that exceed both the threshold values and the margin
(corresponding to the chosen limit line).

Emission Type tab - EMC

Favorites toolbar: 
This tab is available for the EMC-EMI display from the EMC Settings control panel. It allows you to specify the emission type for the EMI
test you want to perform. This selection affects the list of accessories available for selection in the Accessories tabs of the EMC Setup
wizard and the EMC Settings control panel.

Setting Description

Conducted Select when conducted emission tests are to be done. Conducted emission tests measure the radio
disturbance voltage at the mains terminal of the equipment under test (EUT) using LISN.

Radiated Select when radiated emission tests are to be done. Radiated emission tests measure the radio
disturbance field strength emitted by the equipment under test (EUT) using an antenna.
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Accessories tab - EMC

Favorites toolbar: 
This tab is available for the EMC-EMI display from the EMC Settings control panel. It allows you to select, edit, load, and save accessories.
You can also view a gain/loss plot. More accessories settings are available from the Accessories tab in the EMC Project Setup Wizard.

Setting Description

Accessory name and drop down
list

Shows the names of the six selected accessories. You can select from the associated drop down
list. The content of the list is determined by the selected emission type. Check the box next to an
accessory to select it for a test.

You can see a table of all of the available accessories, by emission type, in the Accessories tab topic.

Edit Click to open a window that allows you to edit the details of the associated accessory. See the Add
and/or edit individual accessories on page 349 topic for detailed information about how to use this
window.

View Plot Click to view a gain/loss plot. This will also show the combined gain/loss as a net impact of all the
accessories. You can read more about this is the Combined impact of gains/losses on page 384 topic.

Load All Accessories Click to load a complete accessories setup from a saved file. This is faster than loading accessories
one by one if you have many.

Save All Accessories Click to save a complete accessories setup to a file for reuse. Details about all of the accessories will
be saved.

Tip: Read about setting up accessories in the Accessories setup topic.

Tip: Read about available accessories from Tektronix in the EMC accessories topic.

Accessories setup
Accessories can be set up for EMI test using the Accessories tab in the EMC Project Setup Wizard and the one in the EMC Settings
control panel . These tabs allow you to set up the accessories required for a test and view a graph showing the combined impact of
accessories gains and losses. The final measurement reading is corrected based on these accessory contributions before it is shown in
the display. The correction is calculated by negating the combined impact of all of the accessory gains/losses you entered. 

When any accessory is selected, its contribution will impact the final measurement results shown in the display. “Ext corrections enabled
for traces” is the message you will see in the status bar and display. This message can be suppressed from Tools > Options > Prefs.
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Tip: See the Accessories tab topic for information about the tab in the EMC Settings control panel.

See these topics about accessories setup:
• Available accessories in the drop-down lists
• Combined impact of gains/losses on page 384
• Edit accessory contributions on page 380
• External correction in DPX on page 389
• Loading accessories from a file on page 382
• Two types of mismatch issues when recalling the csv file
• Changing accessory details on page 381

Available accessories in the drop-down lists
A total of six accessories can be included in the test setup, as shown on the right side of the following image. Accessories can be selected
using the drop down lists. The content of these lists depends on the selected emission type, as show in the following table.

Emission type Available accessories

Conducted LISN, Cable, Limiter, Amplifier, Attenuator, Filter, Others

Radiated Antenna, Near field probe, Cable, Amplifier, Limiter, Attenuator, Filter, Others
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Tip: Loss factors of Tektronix supported accessories can be quickly loaded by clicking the Load Tektronix provided accessories
gains/losses on page 348 button.

Edit accessory contributions
Accessories specific information and details like Model no, Serial no, Asset tag, calibration due date can be edited using Edit option. A
window such as the one shown below will open. The following images show examples for Amplifier and Antennas (Factor and isotropic
gain).

Setting Description

Model Specify the Model Name/number of the accessory.

Serial Specify the Serial Number of the accessory.

Asset Tag Specify any user-specific Asset tag id for the accessory

Table continued…
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Setting Description

Cal Due Date Specify the Calibration due date of the accessory. It can be disabled by checking the check box if
not required.

Distance Specify the Distance between EUT and Antenna (Applies only when accessory is antenna).

Select Gain/Loss format Choose between the options available below. A) Constant Gain/Loss, B) Gain/Loss Table. For
Antenna, you will have a third selection available C) Antenna Factor

Constant Gain/Loss Specify the loss value which is constant for the complete frequency range. The Gain/ Loss will be
entered in dB. Gain values are entered as positive dB value and Loss as negative.

Gain Loss Table

(Corresponds to the accessory
selected)

Specify the loss values at specific frequency points. The Gain/ Loss values in these tables will be
entered in dB. Gain values are entered as positive dB value and Loss as negative. The values
in between the frequency points are interpolated with frequency axis treated as Linear/Log based
on the Frequency interpolation selection. Note- For Antenna, this table will be entered in dBi
(isotropic Gain values) as shown in the snapshot above

Antenna Factor Applicable only for Antenna. Antenna factors are given in dB/m. These values are typically
available in vendor data sheets. You can also load the typical values from Example Files if you
have purchases them from Tektronix.

Frequency Interpolation Specifies the frequency interpolation method used for interpolating Gain/Loss values or Antenna
factors. The frequency axis points are either taken as Linear or Log values based on this choice.
Linear interpolation is followed but x axis values can be either in Log or Linear as per this
selection.

Load Click to load a saved Accessory details from a file. This will recall all parameters seen in this
window.

Save As Click to save the Accessory details to a file. (All details shown above)

OK Click OK to give confirmation of the entered details.

Cancel Click Cancel to ignore the edit window and exit. This will discard any changes that you might have
made before OK is pressed.

Changing accessory details
To change the accessories details, click on the Edit button present against the antenna which needs to be edited.

1. A dialogue box pop up is displayed which contains the parameters of the accessory to be edited and updated.
2. Parameters to be updated are like Model No, Serial No, Asset Tag, Calibration due date, polarization, Distance, Loss Factor and

Frequency Interpolation.
3. Details which are updated can be saved for future analysis by clicking Save all Accessories button which saves the details to a file.
4. Click OK button to load all the updated details of the accessory.
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Loading accessories from a file
Tek supported accessories
Tektronix supports some of accessories namely Antenna, Amplifier, Near field probe and LISN with their detailed information embedded in
a .csv file which is readily available for the user as a part of the software in C:\RSA5100B Files\EMC Accessories.

Non-Tek supported accessories
Details of Non - Tek supported accessories can be loaded by preparing a .csv file manually by the user. (You can also build it using the UI
by adding a row for each frequency)

The Gain/Loss table values are usually found from the datasheet or graphs and accessory supported documents provided by the vendor
when purchased.

You can build a csv file with only two columns (Freq column and Gain/Loss column) without headers and you can load the file into this User
interface through Load button. You can also add more frequency rows by editing the csv fie. Once you load such a csv file, you can enter
the other details like Model, Serial number etc and save the file again and another csv file with all additional details and with appropriate
headers would get saved.

Tip: See the Two types of mismatch issues when recalling the .csv file on page 382 topic.

Two types of mismatch issues when recalling the .csv file
Emission type mismatch (for Load All)
When Load All Accessories is used, the complete setup which is saved for a specific emission type can be recalled only when emission
type matches. If the Emission type has been changed and if a recall is attempted, “Emission type mismatch” error is shown.

For example, if the setup saved in conducted emission type mode, it cannot be recalled into radiated emission type mode.

Header type mismatch
If the right type of csv file is not loaded in the Edit Accessory section, then the below error message is shown. For example, if the csv file
header line is modified externally, the error message will be shown when an attempt is made to load the csv in the Edit Accessory section.
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Emission Type mismatch (for individual accessories)
When the accessory is specific to Radiated (Near Field Probe or Antenna) or Conducted (LISN) emission type and an attempt is made to
Load the accessory information under a different emission type, the following error message is shown. For example, if the Emission Type is
Radiated, the error message will be shown if you attempt to load LISN Accessory information in the Edit Accessory section.

Sorting the Freq column in the Loss Table
• You can sort the Freq column in the Loss table by clicking on the column heading. For example, if you click on the Freq (Hz) header,

the results in the loss table will be sorted by frequency. Clicking a second time on the same heading reverses the order.
• When a new row is added, the column is sorted automatically based on the frequency value entered in the new row.
• When an existing frequency value is edited, then the column is sorted automatically based on the frequency value edited.
• When OK is clicked in the edit window of an antenna automatic sorting of loss column is happened.

Note: Duplicate entries of frequency is not allowed either manually or through csv file. Duplicate entry results in an error message
stating the row numbers of the duplicate frequencies.
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Combined impact of gains/losses
Details of the contribution of each accessory and the combined impact of gains/losses can be viewed in the Impact of Accessories
Gains/Losses plot in the Accessories tab. You can select to Show Points on the plot and to view the plot in the log or linear frequency
scale (shown on the bottom left of the display shown below). 

Figure 71: Individual contributions from Antenna, Amplifier, and Cable, and the combined impact, are shown in the above plot.
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Figure 72: Individual contribution and combined Gain/Loss factors of LISN and a cable (for conducted emission) are shown in the above plot.
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Tip: Read more about combined impact in the Calculation of combined impact of accessories gains/losses on page 386 topic.

Calculation of combined impact of accessories gains/losses
Case 1: non-antenna accessories
Combined gain/loss is calculated by combining the individual gains/losses of individual accessories. Except for Antenna, all accessory
gains/losses are in dB (Gain >0, Loss <0). So, the combined gain/loss is calculated by adding all the individual contributions. The plot
shows the combined effect in dB.

This combined impact of accessories gains/losses is negated to arrive at the correction factors. Correction factors are applied to the actual
spectrum analyzer reading before it is shown in the respective displays.
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The Combined impact is calculated only for common frequency range. If there are individual accessories that have different frequency
ranges, only the common range is chosen for calculation of combined gain/loss. An example is shown below. The combined loss range
matches only that of near field probe, although Cable and Amplifier gain/loss information entered for a wider frequency range.

It is this combined impact that is negated to arrive at correction factors which is eventually applied to the measured trace before it is shown
in the displays.
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Case 2: antenna accessories
In case of Antenna, you can enter the accessory contribution either as isotropic gain values or as Antenna factors (both of which is
commonly available in vendor data sheets). Isotropic gain should be entered as any other accessory contribution (Gain >0, Loss<0) and
Antenna factors is expected to be entered as you would see the factors in any data sheet in dB/m.

Antenna factors are used to adjust the final reading as follows. Corrected Reading (dBuV/m) = Spectrum analyzer
Reading (dBuV) + Antenna Factor (dB/m)

• When you have an Antenna as one of the accessories, the results are also shown in field strength units dBuV/m. Note that the above
image has a note that says Antenna factor and Combined Impact are in dB/m.

As mentioned earlier, the combined impact of all accessories are negated to arrive at correction factors. However, as Antenna factors
are used as it is given in data sheet for correction of results, Antenna factors are negated before calculating Combined Impact of all
Accessories Gains/Losses in the above plot. That is the reason you would observe the combined impact follows the inverse of Antenna
factors in the above figure.

The combined impact in the above case would be as follows. Combined Impact (dB/m) = Amplifier Gain (dB) + Cable effect (dB) –
 Antenna Factor (dB/m) (Note that the cable effect is entered as Gain >0 and Loss <0.)

And the combined impact is eventually subtracted from:

Corrected Reading (dBuV/m) = Spectrum Analyzer reading (dBuV) – Combined Impact (dB/m)

Even when the user enters the antenna contribution as isotropic gain, they are converted to antenna factors before presenting in the
Combined Impact plot.

Antenna Factor (dB/m) = (20*log10(f (in MHz) – 29.7707) – Isotropic Gain

Therefore, in the plot, you will always see the antenna factor contribution and the combined impact is calculated as explained above before
it is finally negated to be employed as correction factors to the measured readings.
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Warning when frequency range of scan does not match
A warning message is shown in the plot when the frequency range of the Correction factors (-1*Combined Impact) is smaller than the
frequency range of the scan. When a scan is attempted beyond the frequency range of the Correction factors, the following warning
message is shown “Scan range exceeds range of Combined accessories. Reduce scan range”

External correction in DPX
If external correction due to these accessories are to be applied on the DPX display then this can be done only by selecting All acquired
data (filter method).

Tip: Read more about external gain correction for DPX here.

Ranges & Limits tab - EMC

Favorites toolbar: 
This tab is available for the EMC-EMI display from the EMC Settings control panel. It allows you to specify the start and stop frequencies
for ranges, the parameters that define a spot (for listing in the Emission Results table), and Pass/Fail parameters for limit testing.

Setting Description

Expand Displays the Ranges & Limits table in a new, resizable window.

Table Shows the ranges and limits for the test.

You can edit values in the table directly. You may have to scroll the table to access all settings when
multiple ranges are selected.

You can reorder columns in the table by dragging the columns to a new position.

See the Ranges & Limits table topic below this table for more information.

Reset layout Returns the column order in the Ranges & Limits table to the factory default order.

Load Click to load a saved Ranges & Limits table from a file. The default directory is the last folder to which
you saved a .cvs file.

Save Click to save the current Ranges & Limits table to a file. The default directory is the last folder to which
you saved a .cvs file.

Limit 2 Check to set and Limit 2.

Limit 3 Check to set and Limit 3.

Margin Set the margin value.

Table continued…
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Setting Description

Load From Standard Loads a Ranges & Limits table as defined by a Standard.

Edit Limit Label Allows you to edit the Limit Label.

Ranges & Limits table elements

Setting Description

On Specifies whether the measurements are taken in the specified range or not.

Start (Hz) Readout of the start frequency for the selected range.

Stop (Hz) Readout of the stop frequency for the selected range.

RBW (Hz) Specifies the Resolution Bandwidth (RBW) used for the selected range.

Auto Sets the RBW automatically. For CISPR standards, the frequency range determines the RBW.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value.

VBW Maximum: RBW current value

VBW Minimum: 1/10,000 RBW setting

VBW On Specifies whether the VBW filter is applied or not.

Threshold (dBuV or dBuV/m) Specifies the level that must be exceeded for a signal peak to be recognized as a Spot. A signal peak
must also exceed the excursion setting to be considered a Spot.

Table continued…
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Setting Description

Excursion (dB) Specifies the peak to peak magnitude that must be exceeded for a signal peak to be recognized as
a Spot. A signal transition must also exceed the threshold setting to be considered a Spot. A Spot
requires the amplitude to drop by the excursion amount between Spots.

Limit 1/2/3 Start (dBuV or
dBuV/m)

Specifies the limit at the start frequency.

The limit values for the frequency range are calculated by linear interpolating between Limit Start and
Limit Stop. The frequency start and stop values are taken in Linear or Log, based on the scale choice.

Limit 1/2/3 Stop (dBuV or
dBuV/m)

Specifies the limit at the stop frequency.

The limit values for the frequency range are calculated by linear interpolating between Limit Start and
Limit Stop. The frequency start and stop values are taken in Linear or Log, based on the scale choice.

Limit 1/2/3 Same Sets the starting and stopping frequencies for Limit 1, Limit 2, and Limit 3 to the same value.

Limit 2 Set and display Limit 2.

Limit 3 Set and display Limit 3.

Margin Set the margin value.

Rest layout Returns the column order in the Ranges & Limits table to the factory default order.

Done Saves changes and closes the Ranges & Limits table expanded window.

Save Saves the current Ranges & Limits table to a file.

Load Loads a saved Ranges & Limits table from a file.

See these related Ranges & Limits topics:
• Change range Start and Stop frequencies on page 391
• Specify Spot requirements on page 392
• Set limits on page 392
• Perform Pass/Fail testing on page 392
• Load from Standard on page 352

Change range Start and Stop frequencies
To change the range start and stop frequencies from the Ranges & Limits tab edit the Start and Stop frequencies in the table as follows.

1. Click the Expand button on the Ranges & Limits tab. This displays the Ranges and Limits table.
2. Check the On box for the ranges that you want to measure.
3. Click on the Start or Stop frequency setting to change it. Type in a number for the frequency and a letter as a multiplier. You can use k,

m, or g to set the frequency multiplier.
4. Click Done to save your changes.

Tip: You can read about settings in the Ranges & Limits tab - EMC on page 389 topic.
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Specify Spot requirements
A Spot is a signal peak that exceeds both the Threshold and Excursion settings in the Ranges and Limits table. The Threshold and
Excursion settings are specific to the selected range. If you want to use different settings for Spots in different ranges, you must set the
values separately for each range. The Excursion control is used to avoid interpreting a single spot as multiple narrower spots by requiring
the amplitude to drop by the Excursion amount between spots. Raising the Threshold value means that fewer, larger signals will be
identified as spots.

Specify the Spot requirements for a range as follows:

1. Click the Expand button on the Ranges & Limits tab. This displays the Ranges and Limits Table.
2. Select the Range (A–T) for which you want to specify the Spot requirements.
3. Set the Thrshld value
4. Set the Excrsn value.

Spot specification is also dependent on the List Spots selection in the Parameters tab. By default, this selection is All Spots, in which case
all frequency peaks above the Threshold (subject to Excursion violation) are classified as Spots for listing in the Emission Results table. If
this selection is Over Limit, then only those frequency peaks above the limit line classify as a Spot for listing in the Emission Results table.
The third selection is Over Limit with Margin, which will only classify frequency peak that violate limit lines with margin included in them.

Tip: You can read about settings in the Ranges & Limits tab topic.

Set limits
Use the Limits settings in the Ranges & Limits table to specify the pass/fail parameters for the EMC-EMI measurement.

• When the Mask setting is set to any value except off, the analyzer identifies any signal peak that exceeds the specified limits as a
violation and displays Fail on the screen. If no signal peak exceeds the limits, the analyzer displays Pass on the screen.

• The Margin control lets you set the buffer that you want around the limit line.
• The frequency peaks that violate the limit lines are shown in red both in the graph and Emission Results section. If they violate only the

limit line, then they are shown in orange.

Tip: You can read about settings in the Ranges & Limits tab topic.

Perform Pass/Fail testing
Set up Pass/Fail EMI testing using the Ranges & Limits tab and table. All the following parameters can be set manually or loaded from a
file or from a specified Standard.

1. Click the Expand button on the Ranges & Limits tab. This displays the Ranges and Limits Table.
2. Adjust the Start and Stop frequencies as required for each range you want to test.
3. Verify that the On box is checked for ranges that you want to test.
4. Set the limits in the Start, Stop.
5. Set the required RBW and VBW.
6. Verify that the Thrshld and Excrsn values are set as required. These are the values that define a Spot.
7. Click Done to save your changes and close the Range and Limits table window.
8. Click Run to begin testing.

Tip: You can read about setting limits using the Ranges & Limits tab in the Set limits on page 392 topic.
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Tip: You can read about settings in the Ranges & Limits tab topic.

Measurement Type tab - EMC
Favorites toolbar:

This tab is available for the EMC-EMI display from the EMC Settings control panel. It allows you to define the detectors for scan and spot
measurement.

This tab is divided into the following three areas:

• Measurements on page 393
• Scan Settings on page 394
• Spot Measurement Setup on page 395

The results of Scan and Spot re-measurements are tabulated in the Emission Results table (shown below). This table is accessed from the
EMC-EMI display.

Measurements
There are three Measurement settings:

Pre-scan + Manual Spot
Select to perform a scan with the chosen detector(s) for the selected ranges. The scan will populate the Emission Results table with Spots
(frequency peaks that are above Threshold or Limit lines). The application then waits for you to select Spots from the Emission Results
table for Re-measurement.

This measurement type is useful for Standard recommended detectors that require longer measurement/dwell time. A quick Pre-scan
with Peak detector can be done in such cases. As a second step, Spots (frequencies that fail Threshold or Limit lines) can be chosen
for re-measurement with detectors recommended by the Standard. For example, if the Standard recommends usage of CISPR QP and
CISPR Avg detectors, then a pre-scan is performed CISPR +Peak. After the scan, you can choose the Spot(s) for performing Spot
Re-measurement using CISPR QP and CISPR Avg detectors (max 3 detectors). The RBW for Spot measurement is chosen based on the
ranges and limits set for the scan.
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Pre-scan + Auto Spot
Select to perform a scan with the chosen detector(s) for the selected ranges. The scan will populate the Emission Results table with
Spots (frequency peaks that are above Threshold or Limit lines). The application then automatically triggers a Spot re-measurement for the
number of Spots chosen by you. You can control the number of spots to be automatically re-measured under Max Spots, which is visible
only when Pre-scan + Auto Spot is selected.

Complete Scan
Performs a scan using detector(s) specified by you. You can also choose to load the detector choice from a Standard by clicking the Load
from Standard button located on the far left side of the Ranges & Limits tab (above the Restore Defaults button) in the EMC Settings
control panel. You can also access this button on the Ranges & Limits tab in the EMC Project Setup Wizard.

When the detector choices are loaded from the standard, Complete Scan will show the actual detectors recommended by the standard and
the results will be compared against appropriate limit lines. When the Pre-scan measurement type is chosen, a first scan is done with Peak
detector and the actual detectors recommended by the standard and the corresponding limit lines are set in the Spot Measurement setup.

Although you are free to change the detector choice after choosing a measurement type (Pre-scan +Manual Spot, Pre-scan + Auto Spot,
and Complete Scan), changing the measurement type will re-load the detectors recommended by the standard, and a detector you added
will not be remembered. For example, assume the standard recommends only CISPR QPk for Complete Scan and you choose to add
an additional detector in CISPR Avg. If you then change to Pre-scan mode, and then change back to Complete Scan mode, the detector
choice will be CISPR QPk, because that is the detector recommended by the standard. Your addition of CISPR Avg is not remembered
when the measurement mode is changed.

However, when a setup file is saved, or a project file is saved in EMC Project Setup Wizard, only the detector choices of the chosen
measurement type are saved.

Scan Settings
The following settings are available in the Scan Settings area of the Measurement Type tab.
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Setting Description

Detector Set the detection method using the drop down list. This will be loaded automatically when Load from
Standard is chosen from the Ranges & Limits tab of the EMC Settings control panel or EMC Project
Setup Wizard.

Available detection methods are:

Avg(VRMS), + Peak, MIL +Peak, DEFSTAN Avg, CISPR QPk, CISPR Pk, CISPR Avg, Avg (of logs),
and CISPR Avg (of logs).

Limit Set the limit lines (drop down list shows enabled limit lines) that will be used for comparison for the
chosen detector result. As many as 3 limit lines can be defined in the Ranges & Limits tab of the EMC
Settings control panel or EMC Project Setup Wizard.

When ranges and limits are loaded from a Standard, the Standard typically recommends separate
limit lines for each detector type. The limit lines that are loaded as Limit 1/2/3 are mapped to the
appropriate detector here.

You can also customize your own limit line into one of the three limit lines available and map it to a
detector from the drop down for limit lines here.

Dwell Time Shows the duration of the measurement. When the Auto check box is checked, it sets the Dwell Time
automatically based on detector choice.

Spot Measurement Setup
The following settings are available in the Spot Measurement Setup area of the Measurement Type tab.
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Setting Description

Detector Set the detection method using the drop down list. This will be loaded automatically when Load from
Standard is chosen from the Ranges & Limits tab of the EMC Settings control panel or EMC Project
Setup Wizard.

Available detection methods are:

Avg(VRMS), + Peak, MIL +Peak, DEFSTAN Avg, CISPR QPk, CISPR Pk, CISPR Avg, Avg (of logs),
and CISPR Avg (of logs).

Limit This is the same limit as for Scan Setup, but it is used for Spot re-measurement comparison. You can
set the limit lines (drop down list shows enabled limit lines) that will be used for comparison for the
chosen detector result. As many as 3 limit lines can be defined in the Ranges & Limits tab of the EMC
Settings control panel or EMC Project Setup Wizard.

When ranges and limits are loaded from a Standard, the Standard typically recommends separate
limit lines for each detector type. The limit lines that are loaded as Limit 1/2/3 are mapped to the
appropriate detector here.

You can also customize your own limit line into one of the three limit lines available and map it to a
detector from the drop down for limit lines here.

Dwell Time Shows the duration of the measurement. When the Auto check box is checked, it sets the Dwell Time
automatically based on detector choice.

Max Spots

(Only available when Pre-scan +
Auto Spot is selected)

Specifies the maximum number of top Spots in the Emission Results table (resulting from a scan) that
will be selected for re-measurement.

Check the All check box to include all Spots in the Emission Results table for re-measurement.

Traces tab — EMC

Favorites toolbar: 
This tab is available for the EMC-EMI display from the EMC Settings control panel. It provides information and controls for the trace results
from Scan and Re-measure Spot measurement results. It provides controls for live traces, recalled traces, and Math trace.

Setting Description

Live Traces Traces shown here are the trace results for the last Scan or re-measure Spot measurements.

Selected Selecting a trace makes it the active trace. The active trace shows on the top of the graph and is
useful when there are multiple traces viewed together. You can also select a trace from the top of the
EMC-EMI display.

Show Shows / hides the selected live trace.

Table continued…
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Setting Description

Trace Name Specifies the name of the trace. For live traces, these names are set by appending the detector
choice with the measurement (Scan vs Spot based on whether scan is done or Re-measure Spot
is done). The number after Scan or Spot is based on the number of detectors chosen for Scan and
Re-measure spot measurements in the Measurement Type tab of the EMC Settings control panel.

Function Specifies the function performed on the trace. Applicable only for scan trace in Live Traces.

Count Specifies the count value for Function when Function is not Normal (Max Hold, Average etc.). When
Function is Normal, this control is not editable because the Count is 1.

Quick Save for Compare Click this button to automatically save the selected Live Trace in your drive and recall it into one of the
rows in Recalled Traces, depending on which one is free. The search is done from Recall1 through
Recall 5, in that order. There will be a timed pop-up message indicating the Recall trace in which it is
available for comparison.

If none of the Recalled traces are free, then clicking this button will save the trace in your drive
and recall the trace as Recall 1 (replacing the earlier recalled trace in Recall 1). However, the files
replaced can be browsed for and recalled using the Recall to Selected Trace function. All traces
saved with this button are saved in the C:\SignalVu-PC Files directory.

See the Compare Traces on page 368 topic for additional information.

Save Selected Trace As Saves the selected live trace to a file for later recall and analysis. This button is active only when a
live trace is selected and saved.

Recalled Traces

Selected Selecting a trace makes it the active trace. The active trace shows on the top of the graph and is
useful when there are multiple traces viewed together.

The Emission Results table will be populated with Spots based on the comparison of the selected
recalled trace with Limit 1.

Show Shows / hides the selected recalled trace.

Trace Name Shows the name of the saved trace.

Trace File Path Shows the path of the saved trace file to be recalled.

Recall to Selected Trace Recalls the trace for analysis into the Recalled Traces table.

Math Trace on page 399

Show Shows / hides the selected Math trace.

Freeze Halts updates to the Math trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Table continued…
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Setting Description

Show recalled trace Displays a saved Math trace instead of a live trace. When a Math trace is recalled, controls such as
Show, Freeze and selections of traces for Math will be disabled.

Trace selections for Math The Math trace is the result of subtracting one trace from another. Choose the traces for the
difference operation from the two drop down menus. Trace 1 – Trace 2 is performed at every trace
point.

Save a live trace

To save a live trace for later analysis:

1. Select the Save Selected Trace As button. This displays the Save As dialog box.
2. Navigate to the desired folder or use the default.
3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace. To select a trace for recall:

1. Select a trace from the Recalled Traces table in the Traces tab and check the Show check box next to it. This will be the trace to which
you will recall a previously saved trace.

2. Click the Recall to Selected Trace button to display the Open dialog box.
3. Navigate to the desired file or use the default.
4. Select the appropriate trace to be opened and click Open.
5. The recalled trace will be plotted on the graph and comparison with Limit 1 will be done. Results will be shown in the Emission Results

table.
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Math Trace
The Math trace is a mathematically-derived trace defined as the difference between two traces. You can select the two traces for the
difference calculation from the Live Traces, Recalled Traces, and the Ambient Traces.

1. Select any trace from the two drop-down lists provided. Traces can either be live Scan traces, any of the 5 recalled traces, or an
Ambient trace.

The difference between the two traces will be derived from the operation Trace1 minus Trace 2.

2. Check the Show check box to set the Math trace as the active trace on the graph. You can also check the Freeze check box to halt
updates of the trace on the graph.

3. Save the Math trace to a file using the Save Trace As button.
4. A saved trace can be recalled for analysis as follows:

a. Click the ... button.

b. Navigate to the desired file and click Open. The path will appear in the field next to the ....
c. Check the Show recalled trace check box to show the recalled trace. When a trace is recalled under Math, controls such as Show,

Freeze, and selections of traces for Math will be disabled.
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• The Math function is done for each range set in the Ranges & Limits tab of the EMC Settings control panel.
• If the span or trace points for any range does not match, then an error message will appear for Math traces. For example:

“No Math trace: Unmatched trace X range”

“No Math trace: Unmatched trace lengths”
• The Math trace is done only for log units in Y axis and the difference trace is calculated by mere subtraction of the dB values.

Tip: See the Compare Traces on page 368 topic for more information about using traces for EMC Troubleshooting on page 363.

Ambient tab - EMC

Favorites toolbar: 
This tab is available for the EMC-EMI display from the EMC Settings control panel. It provides settings related to the Ambient
measurement and Ambient trace control. These settings only apply to measurements performed when Measure Ambient is clicked
from the EMC related items on the Favorites toolbar (or Setup > EMC > Measure Ambient). This measurement is useful for capturing
emissions caused by the environment or the spectrum analyzer equipment.

Setting Description
Show Shows / hides the ambient trace in the graph. Also controls the visibility of the ambient results in the

Emission Results table (Amplitude and Delta values).

See the Measure ambient on page 357 topic for more information about ambient results and how to
perform a scan.

Freeze Halts updates to the ambient trace.
Table continued…

EMC Analysis

RSA5100B Series Real-Time Signal Analyzers Help 400



Setting Description
Detection Sets the detection method. Ambient trace comparison results with Scan will not be shown in the

Emission Results table if the detector type of Ambient and Scan do not match.

Available detection methods are:

Avg(VRMS), + Peak, MIL +Peak, CISPR QPk, CISPR Pk, CISPR Avg, Avg (of logs), CISPR Avg (of
logs).

Function Selects the ambient trace processing method. Available settings are: Normal, Max Hold, Avg (VRMS),
and Avg (of logs).

Count Sets the number of traces averaged to generate the displayed trace. Only available when Function is
set to anything other then Normal. When Function is Normal, this control is not editable because the
count is 1.

Save Trace As Saves the selected ambient trace and selected detector to a file for later recall and analysis. Traces
are saved along with the selected detector for help in comparing Scan trace with Ambient trace

A save performed from the Traces tab saves only the trace. The detector type is not saved.

Show recalled trace Shows the recalled ambient trace information and the saved selected detector. When this check box
is checked, the detection control is loaded with the saved detector result and is not available for
selection. Function, Freeze, and Dwell Time controls are also disabled when Show recalled trace is
selected.

Traces that were saved from the Traces tab can also be recalled into the Ambient tab. However, those
recalled traces will not contain saved detector selections. In these cases, you must manually select
the detector type before recalling such a trace.

Dwell Time Shows the duration of the measurement. When the Auto check box is checked, it sets the Dwell
Time automatically based on the frequency range set in the Ranges & Limits tab of the EMC Settings
control panel.

Delta Threshold Shows the threshold difference. If the absolute difference between a Scan trace and an Ambient trace
is less than the Delta Threshold, then those Spot Ambient results are shown in blue. This threshold
setting allows you to quickly check if the peaks/spots obtained are due to ambient interference or the
equipment.

Tip: See the Measure ambient on page 357 topic for more information about ambient measurements.

Scale tab — EMC

Favorites toolbar: 
This tab is available for the EMC-EMI display from the EMC Settings control panel. It allows you to change the vertical and horizontal scale
settings. Changing the scale settings changes how the trace appears on the display but does not change control settings such as Center
Frequency. In effect, these controls operate like pan and zoom controls.
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Setting Description

Vertical Controls the vertical scale and position of the trace display.

Scale Changes the vertical scale units. It is 10* dB/div setting on the display.

Position Sets the value for the top of the display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal

Start Sets the Zoom Start frequency. This only affects the start frequency shown on the graph.

Stop Sets the Zoom Stop frequency. This only affects the stop frequency shown on the graph.

Log Sets the display to show the frequency axis in a logarithmic scale. The Limit lines are also interpolated
with x-axis in Log scale when this is selected.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Reset Scale Resets all settings to their default values.

Prefs tab — EMC

Favorites toolbar: 
This tab is available for the EMC-EMI display from the EMC Settings control panel. It allows you to change the parameters of the EMC-EMI
display.

Setting Description
Show Limit Legends and Label Shows or hides limit legends and label. Label can be edited in the Ranges & Limits tab.
Show graticule Shows or hides the graticule in the display.
Show trace legend Shows or hides the trace legend.
Table continued…
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Setting Description
Trace points (per Range) Sets the number of trace points used for showing scan results. Default value is 8001.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show Limits Set how limits are shown:

Shaded: Shows limits using a shaded area.

Line Only: Shows limits using only a line.

Off: No lines or shading are used to indicate limits in the graph.

Include Margin (Pass/Fail Status) Sets Pass/Fail status to be based on Limit line with margin and not just Limit line.
Show Spot Indicator Three types of Spot indicators are there (based on whether a Spot violates limit lines, limit lines with

margin, or just threshold).
Show Level Target Shows or hides Level Target in the EMC-EMI display.
To Peak

(Only available when Show Level
Target is enabled)

Sets the Level target at peak of the trace.

Show Setup Wizard on EMC-EMI
display startup

Shows or hides the EMC Project Setup Wizard when launching the EMC-EMI display.
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APCO P25 Analysis
P25 Overview
The Association of Public Safety Communication Officials (APCO) P25 Compliance Testing and Analysis option allows you to evaluate
radio signals to ensure they meet the standards set for the public safety communications community for interoperable LMR equipment.
This complete set of push-button Telecommunication Industry Association TIA-102 standard-based transmitter measurements includes
modulation measurements, power measurements, and timing measurements. These measurements are also compared with the limits that
best fit the signal for which the standard applies to provide pass/fail results.

The P25 measurements available with this option can be made on signals defined by the Phase 1 (C4FM) and Phase 2 (HCPM, HDQPSK)
P25 standards. With this test suite, test engineers can simplify the execution of a number of transmitter tests while still allowing for controls
to modify signal parameters for signal analysis. The analysis results give multiple views of P25 signal characteristics to allow the diagnosis
of signal imperfections and impairments quickly and easily. Display controls allow you to selectively display the analysis results to help
locate trouble-spots in the signal.

P25 Topics
The following information about the P25 Analysis option is available:

• Reference Table of Supported P25 Measurements
• P25 Standards Presets on page 405
• P25 Displays on page 406
• P25 Settings
• P25 Measurements on page 406
• P25 Test Patterns on page 412

Reference Table of Supported P25 Measurements
TIA-102 transmitter
measurement

Tektronix measurement display(s) (value name if
different from TIA-102 measurement name) Phase 1 Phase 2

RF output power P25 Summary

P25 Power vs Time

Yes Yes

Operating frequency accuracy P25 Summary (Operating Freq Accuracy) Yes Yes
Modulation emission spectrum SEM (The SEM display can be found in Select Displays > RF

Measurements)
Yes Yes

Unwanted emissions: Non
spurious adjacent channel power
ratio

MCPR (The MCPR display can be found in Select Displays >
P25 Analysis)

Yes Yes

Frequency deviation P25 Summary (Freq Dev) Yes HCPM

Modulation fidelity P25 Summary

P25 Constellation

Yes Yes

Symbol rate accuracy P25 Summary Yes Yes

Table continued…

APCO P25 Analysis

RSA5100B Series Real-Time Signal Analyzers Help 404



TIA-102 transmitter
measurement

Tektronix measurement display(s) (value name if
different from TIA-102 measurement name) Phase 1 Phase 2

Transmitter power and encoder
attack time

P25 Summary (Phase1 Tx Attack Time)

P25 Power vs Time (Power Attack Time and Encoder Attack
Time)

Yes N/A

Transmitter power and encoder
attack time with busy/idle
operations

P25 Summary (Phase1 Tx Attack Time (Busy/Idle))

P25 Power vs Time (Power Attack Time Busy Idle and
Encoder Attack Time Busy Idle)

Yes N/A

Transmitter throughput delay P25 Summary (Phase1 Tx Throughput Delay) Yes N/A
Transient frequency behavior P25 Freq Dev vs.Time Yes N/A
HCPM transmitter logical channel
peak adjacent channel power ratio

P25 Summary (HCPM Tx Logic Ch Pk ACPR) N/A HCPM

HCPM Transmitter logical channel
off slot power

P25 Power vs Time (Off Slot Power)

P25 Summary (HCPM Tx Logic Ch Off Slot)

N/A HCPM

HCPM Transmitter logical channel
power envelope

P25 Power vs Time (Power Info)

P25 Summary (HCPM Tx Logic Ch Pwr Env Limits)

N/A HCPM

HCPM Transmitter logical channel
time alignment

P25 Summary (HCPM Tx Logic Ch Time Alignt) N/A HCPM

P25 Standards Presets
The P25 standards preset allows you to access displays preconfigured for the P25 standards you select. You can read more about how
Presets work here.

The following table shows the bandwidth, modulation type, and displays that are automatically loaded for each of the listed standards.
MCPR masks are also loaded and are explained here.

Table 20: P25 standards, modulation type, bandwidth, and displays

Standard Modulation type Bandwidth (kHz) Displays loaded with preset
Phase 1 C4FM 12.5 MCPR, Time Overview, P25 Constellation, P25 Summary
Phase 2 HCPM (inbound) 12.5 MCPR, Time Overview, P25 Constellation, P25 Summary

HDQPSK (outbound) 12.5

Retain Current Center Frequency
This setting becomes available when P25 is the selected preset in the Standards Preset window. You can access this window by selecting
Presets > Standards and then selecting P25 from the Preset drop down menu. To activate the Retain current Center Frequency
Setting, check the box. This setting allows you to retain the previously used center frequency. By default, the box is unchecked and
therefore the four P25 preset displays will load with a center frequency of 850 MHz.
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The default adjacent channels table for MCPR is different for RF frequencies in the range of 769 to 806 MHz (called 700 MHz band) and
for frequency ranges outside it. The option of retaining center frequency in Standards Preset is therefore useful if you want to load the
default table for center frequencies in the 700 MHz band.

MCPR channel and limit parameters. The MCPR (ACPR) standard channel and limit parameters that are applied to the P25 signal
depend on the standard you select when you configure the preset. Once you select a standard and center frequency, the application
will automatically load the parameters and default limits recommended for best performance comparison by the Standard document. All
channel and limit parameters are derived from the TIA-102 standard and loaded for you. This provides you the assurance that you are
evaluating the signal with the most appropriate parameters.

Note: Changing analysis and display parameters recalculates the measurement results, but does not affect acquisitions.

P25 Displays
The displays in P25 Analysis (Setup > Displays > Measurements: P25 Analysis) are:

• MCPR
• P25 Constellation
• P25 Power vs Time
• P25 Eye Diagram Display
• P25 Frequency Dev Vs Time
• P25 Symbol Table
• P25 Summary
• Time Overview

P25 Measurements
The following topics contain important information you should know about specific P25 measurements.

RF Output Power (Phase 1 and Phase 2)
This is a measure of RF output power when the transmitter is connected to the standard load during defined duty cycle. This measurement
is presented as a scalar result in the P25 Summary display. Power variation is shown in the P25 Power vs Time display.

Information of note about this measurement:
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• For bursty HCPM (Phase 2 Inbound) signals, the RF Output Power is measured only during the on slot regions centered at the middle
of the on slot.

• The result shown in the P25 Summary Display is the average RF Output Power of all the bursts selected in the analysis window.
• If only one on slot region is chosen in the analysis window, then the RF Output Power of only the chosen on slot is reported.
• For non-bursty data, the entire duration of analysis window is considered to obtain RF Output Power.
• The result shown in the P25 Summary display does not account for any attenuation introduced by a user. Ensure that this attenuation

is accounted for when you enter limits for comparison.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when Trigger Measurements are selected.

Note: Read about important information related to HCPM bursty data measurements here.

Operating Frequency Accuracy (Phase 1 and Phase 2)
The Operating Frequency Accuracy is the ability of the transmitter to operate on its assigned frequency. This measurement is presented as
a scalar result in the P25 Summary display.

• For bursty HCPM (Phase 2 Inbound) signals, the operating frequency accuracy is measured only during the on slot regions centered at
the middle of the on slot.

• The result shown in the P25 Summary display is the average of all the bursts selected in the analysis window.
• If only one on slot region is chosen in the analysis window, then the operating frequency accuracy of only the chosen on slot is

reported.
• For non-bursty data, the entire duration of the analysis window is considered to obtain the operating frequency accuracy.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.

In Operating Frequency Error, double sided operating frequency error is converted to one sided error and compared against the
Absolute Limit.

• This measurement result is not shown in the P25 Summary display when Trigger Measurements are selected.

Unwanted Emissions (ACPR) (Phase 1 and Phase 2)
This measurement is the ratio of the total power of a transmitter under prescribed conditions and modulation to that of the output power
that falls within a prescribed bandwidth centered on the nominal frequency of adjacent channels. This measurement is shown in the MCPR
display.

• For HCPM signals, Adjacent Channel Power Ratio analysis is only done on the first on slot region. When the Modulation Type is set
to HCPM from any P25 display or from Standards Presets, there will be a search for bursts before ACPR analysis is done. If a burst
is found, then analysis is done only on first burst. If a burst is not found, it will show the results of the entire analysis length. The Main
Preset will remove the HCPM modulation Type setting, allowing MCPR to work in its regular mode.

• The MCPR display will only have one Main channel for P25 signals in addition to relevant adjacent channels.
• The default adjacent channels table for Unwanted Emissions (ACPR) as suggested by the standard can be loaded by using the P25

Standards Preset option (for which MCPR is one of the four displays).
• The default adjacent channels table for MCPR is different for RF frequencies in the range of 769 to 806 MHz (called 700 MHz band)

and for frequency ranges outside it.
• To load the default adjacent channels table of a 700 MHz band, first set the center frequency. Next, select Presets > Standards to

view the Standards Preset window. Lastly, check the Retain current Center Frequency Setting box.
• By default, the Retain Center Frequency box is unchecked and therefore the four P25 preset displays will load with a center frequency

of 850 MHz and load the adjacent channels table for non-700 MHz band.
• By default, only six adjacent channels (on either side) will be shown when 700 MHz band is analyzed in P25 (for visual clarity).

However, analysis is done for all the ten channels and results will be available in the table just under the display. You can zoom out to
see the remaining bands.
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Frequency Deviation (Phase 1 (C4FM) and Phase 2 (HCPM))
This measurement shows the amount of frequency deviation that results for a Low Deviation and High Deviation test pattern. This
measurement is shown in the P25 Summary display.

• This measurement only applies to HCPM and C4FM signals and High Deviation or Low Deviation test patterns. If this measurement is
run for any other test patterns or for HDQPSK signals, comparisons for limits (set in the Limits tab of the control panel) will result in N/A
being shown, as the measurement will not be valid.

• This measurement is done using a FM demodulator without any filter. As a result, it will not be exactly the same as the result given in
the P25 Frequency Deviation vs Time display. That display shows the frequency deviation after complete demodulation and might use
relevant shaping filters.

• The Low pass filter cut off frequency can be set from the Analysis Params tab of the Settings Control panel. The default value of the
cut off frequency is 5 kHz.

• Measurement results are only available when High Deviation, Low Deviation, or Symbol Rate test pattern is selected.
• The scalar result in the P25 Summary display will be shown as f1 (Positive Peak) and f2 (Negative Peak) when analyzing the High

Deviation test pattern (or the Symbol Rate test pattern for C4FM signals).
• The scalar result in the P25 Summary display will be shown as f3 (Positive Peak) and f4 (Negative Peak) when analyzing the Low

Deviation test pattern.
• The scalar results in the P25 Summary display do not have a corresponding graphical view. A closely representative display would be

the FM display (Setup > Displays > Analog Modulation).
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.

Modulation Fidelity (Phase 1 and Phase 2)
This measures the degree of closeness to which the modulation follows the ideal theoretical modulation determined by the rms difference
between the actual deviation and the expected deviation for the transmitted symbols. This measurement is shown in the P25 Summary
and P25 Constellation displays.

• This measurement is done on the first on slot region in the analysis window for bursty HCPM data. The analysis is done on 160
symbols centered at the burst.

• This measurement is done on all of the data chosen in the analysis window for non-bursty modulation types. A warning message
is issued if the data is less than 164 symbols (the standard recommends at least 164 symbols be present for the measurement of
non-bursty signals).

• This measurement is done by performing the frequency demodulation after taking the signal through relevant shaping filters and
comparing it with expected frequency deviation points.

• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when Trigger measurements are selected.
• HDQPSK-P25 filter attempts to remove the Inter Symbol Interference before symbol detection.

Note: Read about important information related to HCPM bursty data measurements here.

Symbol Rate Accuracy (Phase 1 and Phase 2)
Symbol Rate Accuracy measures the ability of the transmitter to operate at the assigned symbol rate (4.8 kHz for Phase 1, 6 kHz for Phase
2). It is a scalar result shown in the P25 Summary display.

• This measurement result appears in the P25 Summary display and only applies to High Deviation or Low Deviation test patterns. Test
patterns are selected in the Test Patterns tab in the Settings control panel.

• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement only applies to High Deviation or Low Deviation test patterns. If this measurement is run for any other test patterns,

comparisons for limits will result in N/A being shown, as the measurement will not be valid.
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Common Trigger Related Measurements
The measurements covered in this subsection have some common information. These measurements are:

• Transmitter Power and Encoder Attack Time (Phase 1): This measurement is the time required for a transmitter to prepare
and transmit information on the radio channel after changing state from standby to transmit (applies to conventional mode). This
measurement result can be seen in the P25 Summary display. A graphical representation of these results can be seen in the P25
Power vs Time display.

• Transmitter Power and Encoder Attack Time with Busy/Idle Operations (Phase 1): This measures the time required for a
transmitter to prepare and transmit information on the radio channel after the receiving channel changes state from busy to idle.
Transmission is inhibited until a status symbol indicates an idle channel. This measurement result can be seen in the P25 Summary
display. A graphical representation of these results can be seen in the P25 Power vs Time display.

• Transmitter Throughput Delay (Phase 1): This measures the time it requires for audio changes in the microphone to be encoded
and transmitted over the air. A calibrated receiver with a known receiver throughput delay is used to monitor the transmitted signal.
The aggregate delay of the transmitter under test and calibrated receiver is measured and the desired transmitter throughput delay is
then the aggregate delay less the delay of the calibrated receiver. A calibrated Receiver throughput delay from the UI is needed. This
measurement result can be seen in the P25 Summary display.

• Transient Frequency Behavior (Phase 1): This is a measure of difference of the actual transmitter frequency and assigned
transmitter frequency as a function of time when the RF output power is switched on or off. This measurement appears in the P25 Freq
Dev vs Time display.

• HCPM Tx Logical Channel Time Alignment (Phase 2 HCPM): This measures the ratio of total transmitter power under prescribed
conditions and modulation to the peak power that falls in a prescribed bandwidth centred on the nominal frequency of the adjacent
channel during the transmitter power ramping interval. This applies only to inbound signals. This measurement result appears in the
P25 Summary display.

Common information. The following information applies to all of the measurements in the previous list.

• Select the relevant Trigger measurement from the Trig Meas tab of the control panel.
• When this measurement is chosen from the Trig Meas tab of the control panel, only this result will be populated in the P25 Summary

display and everything else will have no result.
• The Time Zero Reference under the Analysis Time tab in the control panel is forced to Trigger.
• You can select to do the same experiment multiple times and this measurement will produce an average result of the last 10 single

acquisitions. Clicking the Clear button on the P25 Summary display will clear the results and start a new measurement.

Transmitter Power and Encoder Attack Time and Transmitter Power and Encoder Attack Time with Busy/Idle Operations (Phase
1). The following information is specific to these two measurements.

• The Transmitter Power Attack Time analysis is done by measuring the time taken from the trigger point to the point where the
transmitter output power will reach 50% of its maximum value.

• For Encoder Attack Time, the initial frame synchronization word is searched in the demodulated output and the time taken from trigger
to the start of the synchronization word is reported as the result.

• When a clear power ramp up is not available, the analysis will report the following error, indicating that no power ramp was received as
expected: Input data too short. When the synchronization word is not found, the analysis will report the following error: IQ Processing
error.

• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• The P25 Power vs Time display shows marking from trigger point to 50% ramp point and also up to the Synchronization word for

Transmitter Power and Encoder Attack Time. Frequency Dev vs Time can also be used to check for the synchronization word. The
following image shows this measurement.
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Transmitter Throughput Delay (Phase 1). The following information is specific to this measurement.

• Select Tx Throughput Delay from the Trig Meas tab of the Settings control panel to get this measurement.
• The original noise source is connected as input to this trigger and the acquisition is triggered when the input from the noise source

exceeds the trigger level set by the user.
• The actual input to the RSA comes after the noise signal from the source has passed through the DUT and calibrated receiver as

shown in the setup for this measurement in the measurement methods standard document.
• The level in the Trigger control panel set by the user is used for analysis to determine that input to the RSA/MDO4000B/C (after it has

gone through the DUT and calibrated receiver) has hit the power levels desired.
• The time difference between the trigger point and the point when the input to the RSA has exceeded the level set by the user for

triggering is calculated.
• The calibrated receiver throughput delay entered by the user in the Trig Meas tab in the Settings control panel (this option appears

when Throughput Delay is selected) is subtracted from the calculated time difference and reported as Throughput Delay.
• A limit comparison can be performed by selecting the appropriate limits from the Limits tab in the Settings control panel.

Transient Frequency Behavior (Phase 1). The following information is specific to this measurement.

• Select Transmitter Frequency Behavior from the Trig Meas tab of the Settings control panel to get this measurement.
• This measurement can be done for On to Off and Off to On behaviors. Select which behavior to measure by selecting the desired

behavior from the Transient Frequency drop down list that appears when the Transient Frequency Behavior measurement is selected
in the Trig Meas tab of the Settings control panel.

• Select enough acquisition length (from the Acquisition control panel) to ensure that sufficient data is available when the acquisition is
triggered. For a transient frequency behavior, there is a need for t1+t2 amount of time after ton as defined in the measurement methods
standard document. Approximately 100 ms of data after trigger should ensure that all cases are taken care of as suggested by the
standard. t1, t2, and t3 durations are fetched based on the RF frequency range.

• The identification of ton is done by looking for a significant frequency deviation after a certain power level has been achieved. A
manual override for the ton is also provided in the Trigger Meas tab of the Settings control panel when a Transient Frequency Behavior
measurement is chosen. This allows you to manually override the ton that is calculated (by releasing the Auto Option) and place it
appropriately based on the P25 Freq Dev vs Time display. The same is true for toff when the measurement is being done for the On to
Off behavior.

• t1 and t2 regions are identified after ton and t3 before toff (for the On to Off behavior).
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• The mean and max frequency deviation is reported in the regions identified.
• A Pass or Fail is also reported by comparing the Mean frequency deviation with the recommended values given in the standard.

A red band is shown if a particular region’s result is less than the performance recommendation. The following image shows this
measurement.

HCPM Tx Logical Channel Time Alignment (Phase 2 HCPM). The following information is specific to this measurement. This result can
be viewed in P25 Summary and P25 Power vs Time displays.

• This measurement is done in two steps: First by calculating tOB_sync using HDQPSK data (the ISCH pattern is looked for) and then
by using the result to calculate tIB_sync using HCPM data (the SACCH pattern is looked for).

The first step is done by choosing Time Alignment (tOB_sync measurement) in the Trig Meas tab in the Settings control panel.

When the second step, Time Alignment (t_error_0 calculation) or (t_error_1 calculation) is selected in the Trig Meas tab of the control
panel, there is an option to override the tOB_sync value calculated in the first step.

• When this measurement is chosen, only this result is provided in the P25 Summary display.
• You must provide the ultraframe boundary to the trigger of the analyzer.
• An autocorrelation of the input RF signal with the reference patterns is performed to get the peak that will determine tOB_sync

(measured) and t_error_0 or t_error_1 from the trigger point.

HCPM Tx Logical Channel Peak ACPR (Phase 2 HCPM)
This measures the ratio of total transmitter power under prescribed conditions and modulation to the peak power that falls in a prescribed
bandwidth centred on the nominal frequency of the adjacent channel during the transmitter power ramping interval. This applies only to
inbound signals. This measurement result appears in the P25 Summary display.

• This measurement is done by calculating power in the adjacent channels for the entire duration of data chosen by the user, including
the power ramp up and ramp down portions. The standard recommends 360 ms of data for this measurement, unlike the other ACPR
measurements for which the analysis is done only for the on slot region.

• The higher and lower adjacent channel power is reported in the P25 Summary display under Power Measurements.
• The two results are then subtracted from the calculated RF output power and the minimum of the two results is presented as the Min

Pk ACPR in the P25 Summary display.
• This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation test patterns.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when trigger measurements are chosen.

Note: Read about important information related to HCPM bursty data measurements here.
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HCPM Transmitter Logical Channel Off Slot power (Phase 2 HCPM)
This measures the power of a TDMA transmitter during the off portion of the TDMA pulse. This measurement only applies to inbound
signals. This result can be viewed in P25 Summary and P25 Power vs Time displays.

• The measurement is done as suggested by the standard to calculate PONREL and POFFREL. PONREL is the maximum level observed in
the interval 1 ms to 29 ms and POFFREL is the maximum level observed in 30.2 ms to 59.8 ms.

• PTX is the rated carrier power and can be set by the user from the Analysis Params tab in the Settings control panel.
• The absolute level of the off slot power is then calculated as POFF = PTX – (PONREL – POFFREL) dBm
• This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation test patterns.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when trigger measurements are chosen.

Note: Read about important information related to HCPM bursty data measurements here.

HCPM Transmitter Logical Channel Power Envelope (Phase 2 HCPM)
This is a measure of how well a portable radio controls the transmitter power as it inserts an inbound HCPM TDMA burst into a frame on a
voice channel. This measurement applies to inbound signals only.

• All scalar results relevant to this measurement are shown both in P25 Power vs Time display and the P25 Summary display.
• The measurement results and the duration in which the measurements are made are shown graphically in P25 Power vs Time display.

The results are grouped under Power Info and Time Info in the table at the bottom of the display.
• This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation test patterns.
• The Limits tab in the P25 Summary Settings control panel allows you to compare the results against limits set for Pass/Fail.
• This measurement result is not shown in the P25 Summary display when trigger measurements are chosen.

Note: Read about important information related to HCPM bursty data measurements here.

P25 Test Patterns
A variety of test patterns are specified in the TIA-102 documents for use in performance testing of transmitters. These test patterns allow
the software to compare the measurement result to the standards limit. Test engineers can select from the test patterns described in the
following tables.

Note: Although this table gives the test patterns for measurements as recommended by the Standard, other measurement results
are also be provided as additional information for a given test pattern. For example, Modulation Fidelity results can also be
provided for High Deviation and Low Deviation test patterns.

Table 21: P25 test patterns, Phase 1 C4FM

TIA-102 Phase 1 C4FM test pattern Phase 1 (C4FM) measurement
Standard transmitter RF Output Power

Operating Frequency Accuracy
Modulation Emission Spectrum
Unwanted Emissions (Adjacent Channel Power Ratio)
Modulation Fidelity
Transmitter Power and Encoder Attack Time
Transmitter Power and Encoder Attack Time (With Busy/Idle Operations)

Table continued…
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TIA-102 Phase 1 C4FM test pattern Phase 1 (C4FM) measurement
Low Deviation Operating Frequency Accuracy

Transient Frequency Behavior
Frequency Deviation

Standard Idle Transmitter Power and Encoder Attack Time (With Busy/Idle Operations)

Standard Transmitter Symbol Rate

(Same as High Deviation test pattern

Symbol Rate Accuracy

Frequency Deviation

C4FM Modulation Fidelity Modulation Fidelity

Standard Tone Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Other

(User created test pattern)

Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Table 22: P25 test patterns, Phase 2 Inbound and Outbound

TIA-102 Phase 2 test pattern Phase 2 measurement

Standard Transmitter (Inbound and
Outbound)

RF Output Power

Operating Frequency Accuracy

Modulation Emission Spectrum

Unwanted Emissions (Adjacent Channel Power Ratio)

Modulation Fidelity

Inbound Standard Tone Ch0 Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Inbound Standard Tone Ch1 Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Outbound Standard Tone Operational Frequency Accuracy

Table continued…
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TIA-102 Phase 2 test pattern Phase 2 measurement

Inbound Symmetrical Time Slot RF Output Power

Modulation Emission Spectrum

Modulation Fidelity

HCPM (Peak ACPR)

HCPM (Off slot power)

HCPM (Power envelope)

Unwanted Emissions (Adjacent Channel Power Ratio)

Low Deviation (Inbound) Frequency deviation for HCPM

Symbol Rate Accuracy

Low Deviation (Outbound) Symbol Rate Accuracy

High Deviation (Inbound and Outbound) Symbol Rate Accuracy

Other

(User created test pattern)

Can be used for measurements such as RF Output Power, Operating Frequency Accuracy,
Modulation Fidelity, and ACPR

Analysis of HCPM Bursty Data
It important to take into account the following information when analyzing HCPM bursty data.

• It is mandatory that at least one complete on slot and off slot region (including the ramp up and ramp down portion) have to be included
in the analysis window for HCPM measurement results to be analyzed.

• If HCPM is the chosen standard in Standards Presets, then a minimum length of 94 ms is set for the analysis window. This is to ensure
that a full on slot and off slot region is available irrespective of the selected analysis offset.

• Do not use the High Deviation or Low Deviation test patterns for bursty signals. Test patterns are selected in the P25 Settings control
panel on the Test Patterns tab. If selected, analysis would look for a bursty pattern. High Deviation and Low Deviation test patterns are
not bursty and therefore do not have the above analysis length restriction.

If you try to set the analysis length to less than 94 ms, the following status message will display: P25:HCPM:Minimum Analysis Length
should be ≥ 94 ms.

• Most measurements that are required to be done on on slot regions are done centered at the on slot region of HCPM bursty data.

HCPM Pilot symbols are not displayed in the P25 Symbol Table.

It is mandatory that at least one complete on slot and off slot region (including the ramp up and ramp down portion) have to be included
in the analysis window for HCPM measurement results to be analyzed.

The analysis module does not analyze two active adjacent slots (28 ms each) if they do not have the off slot (power off) region between
them.

When HCPM bursty data is analyzed, the following status message will appear on all relevant displays: P25:HCPM modulation
analysis is done only on on slot regions.
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Note: The test patterns, except for High Deviation and Low Deviation, do not impact the HCPM pattern analysis for other selected
test patterns, such as Standard Transmitter Test Pattern, Inbound Standard Tone Test Pattern Ch0, Inbound Standard Tone Test
Pattern Ch1, Inbound Symmetrical Time Bound Test Pattern, and Others.

P25 Constellation Display
The P25 Constellation Display shows the P25 signal modulation amplitude. For the HCPM and HDQPSK standards, you can view this
display as frequency deviation or as I and Q. For the C4FM standard, only the frequency deviation applies.

To show the P25 Constellation display you can select Presets > Standards > P25 or do the following:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select P25 Analysis in the Measurements box.
3. In the Available displays box, double-click the P25 Constellation icon or select the icon and click Add. The P25 Constellation icon will

appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the P25 Constellation display.
5. Select Setup > Settings to display the control panel.
6. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
7. For Phase 2 signals, select the Trace tab and set the Trace Type to Freq Dev or IQ.
8. Select the Test Patterns tab and select the desired test pattern as appropriate for the input signal.

Elements of the Display
The following image shows the P25 Constellation display set to IQ for a HDQPSK signal.

The following image shows the same signal as the previous image, but with the display set to Frequency Deviation.
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Item Display element Description

1 Marker Readout Located to the left of the constellation plot or below it, depending on the size of the
window. If markers are enabled, the marker readout will show frequency deviation results
or IQ results (time, mag, phase, symbol marker and symbol value) of the point with the
selected marker.

2 Measurement results readout These readouts are located to the left or below of the Constellation plot, depending on the
window size. The readout shows Modulation Fidelity (%) and Frequency Error (Hz).

The second readout can either be Freq Error where the result is followed by Auto or it
could be Freq Offset where the result is followed by Manual. This choice between Freq
Error and Freq Offset is made from the Analysis Params tab in the Settings control panel.

3 Plot Shown as either I vs Q or as Frequency Deviation. The trace type is controlled from the
Settings > Trace tab.

P25 Constellation Settings
Main menu bar: Setup > Settings

Front panel: Settings

Favorites toolbar:

The P25 Constellation Settings control panel provides access to settings that control parameters of the Constellation Display. 

Settings tab Description
Modulation Params Specifies the input signal standard and additional user-settable signal parameters.
Table continued…
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Settings tab Description
Analysis Params Specifies parameters used by the instrument to analyze the input signal.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.

Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for P25 Analysis displays.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.
Trig Meas Enables you to select from several different trigger measurements.

P25 Eye Diagram Display
The P25 Eye Diagram display shows a digitally modulated signal overlapped on itself to reveal variations in the signal.

To show the P25 Eye Diagram display:

1. Press the Displays button or select Setup > Displays.
2. From the Measurements box, select P25 Analysis.
3. Double-click the P25 Eye Diagram icon in the Available Displays box. This adds the P25 Eye Diagram icon to the Selected displays

box.
4. Click OK button. This displays the P25 Eye Diagram view.
5. Select Setup > Settings to display the control panel.
6. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
7. For Phase 2 signals, select the Trace tab and set the Trace Type to Freq Dev or IQ.
8. Select the Test Patterns tab and choose a test pattern appropriate for the input signal.

Elements of the Display
The following image shows the P25 Eye display with Trace Type set to IQ.
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The following image shows the P25 Eye display with Trace Type set to Freq Dev.

Item Display element Description

1 Top of graph The vertical scale is normalized with no units (for IQ) and with Hz (for Freq dev).

2 Position Specifies the value shown at the center of the graph display.

3 Bottom Readout Displays the value indicated by the bottom of graph.

Table continued…
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Item Display element Description

4 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

5 Position Displays the horizontal position of the trace on the graph display.

6 Scale Adjusts the span of the graph in symbols.

7 Freq Error Displays the difference between the maximum and minimum measured values of the
signal frequency during the Measurement Time. The readout can either be Freq Error
where the result is followed by Auto or it could be Freq Offset where the result is followed
by Manual. This choice between Freq Error and Freq Offset is made from the Analysis
Params tab in the Settings control panel.

P25 Eye Diagram Settings
Main menu bar: Setup > Settings 

Front panel: Settings

Favorites toolbar:

The settings for the P25 Eye Diagram display are shown in the following table.

Settings tab Description
Modulation Params Specifies the input signal standard and additional user-settable signal parameters.
Analysis Params Specifies parameters used by the instrument to analyze the input signal.
Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also

allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.
Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.
Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.

Available test patterns vary depending on the selected standard and modulation type.
Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to

view as Vectors or Lines, and to control the view as Freq Dev or IQ.
Scale Defines the vertical and horizontal axes.
Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

P25 Power vs Time Display
The P25 Power vs Time display shows the signal power amplitude versus time. In HCPM bursty data, the Regions A, B and C are shown
based on the middle of the burst and not based on the pilots.

To show the P25 Power vs Time display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select P25 Analysis in the Measurements box.
3. In the Available displays box, double-click the P25 Power vs Time icon or select the icon and click Add. The P25 Power vs Time icon

will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the P25 Power vs Time display.
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5. Select Setup > Settings to display the control panel.
6. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
7. Select the Test Patterns tab and choose a test pattern appropriate for the input signal.

Elements of the Display

Item Display element Description

1 Top of graph, first setting Sets the Power level that appears at the top of the graph, in dBm. This is only a visual
control for panning the graph.

2 Units Sets the global amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

3 Top of graph, second setting Sets the vertical Scale of the graphs, in dB/div. This is only a visual control for panning the
graph.

4 View

(Only available for bursty HCPM
data.)

Selects the specific view of the packet burst within the display:

Full Burst displays the entire packet, with vertical lines indicating Power ramp up, On Slot,
Power ramp down, and Off slot regions.

Ramp Up zooms the display into the interval around the packet rising edge.

Ramp Down zooms the display into the interval around the packet falling edge.

5 Bottom of graph readout Shows the Power level at the bottom of the graph in dBm.

6 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

7 Bottom of graph, left side Sets the starting time of the graph in seconds

8 Bottom of graph, right side Sets the scale (width) of the graph in seconds

Table continued…
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Item Display element Description

9 Table below graph This table shows the following results.

For non-bursty signals: RF output power

For bursty signals: Power Info (Offslot Power and Power Envelope results) and Time Info.

P25 Power vs Time Settings
Main menu bar: Setup > Settings 

The settings for the P25 Power vs Time display are shown in the following table.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Scale Defines the vertical and horizontal axes.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

P25 Summary Display
The P25 Summary display shows a summary of all the scalar measurements done on the acquired test pattern. The summary display and
contents will vary according to the selected standard.

Pass/Fail information is also provided in this display for all enabled scalar measurements. You can set limits and choose which
measurement to compare for Pass/Fail from the Limits tab in the P25 Summary Settings control panel. The default limits come from the
performance recommendation limits given by the Standard document. The default limits can be reloaded by selecting the P25 Standards
Preset option or by loading the default limits table.

To show the P25 Summary display you can select Presets > Standards >P25 or do the following:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select P25 Analysis in the Measurements box.
3. In the Available displays box, double-click the P25 Summary icon or select the icon and click Add. The P25 Summary icon will appear

in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the P25 Summary display.
5. Select Setup > Settings to display the control panel.
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6. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the
input signal.

7. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list depend of the standard and
modulation type you have selected.

P25 Summary Display
The Modulation Measurements, Power Measurements, and Trigger Measurements components of this display vary depending on which
modulation type is selected.

The following image shows an example of the display for a Phase 1 C4FM signal.

The following image shows an example of the display for a Phase 1 C4FM High Deviation signal.

The following image shows an example of the display for a Phase 2 HCPM (Inbound) signal.
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The following image shows an example of the display for a Phase 2 HDQPSK (Outbound) signal.

For more information about specific measurement results, see the P25 Measurements section here.

Elements of the Display

Element Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Bandwidth Display of the channel bandwidth which is set based on the standard and modulation type.

Modulation Type Display of the modulation type selected on Setup > Settings > Modulation Parameters tab.

Clear Click button to reset measurement. Clears all values.

Table continued…
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Element Description

Modulation Measurements Shows the modulation measurements associated with the signal.

Power Measurements Shows the power measurements associated with the signal.

Trigger Measurements Shows the trigger measurements associated with the signal.

P25 Summary Settings
Main menu bar: Setup > Settings 

The settings for the P25 Summary display are shown in the following table.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Limits Load and define P25 measurement limits for Pass/Fail comparison. You can save defined limits as
a .csv file and also load previously saved .csv files.

P25 Symbol Table Display
The P25 Symbol Table display shows decoded data values for each data symbol in the analyzed signal packet.

To show the P25 Symbol Table display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select P25 Analysis in the Measurements box.
3. In the Available displays box, double-click the P25 Symbol Table icon or select the icon and click Add. The P25 Symbol icon will

appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the P25 Symbol Table display.
5. Select Setup > Settings to display the control panel.
6. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
7. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list depend on the standard and

modulation type you have selected.
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P25 Symbol Table
The following image shows the P25 Symbol Table for HCPM (bursty) signals. For this signal type, the symbols are arranged as Bursts vs
Symbols. The analysis is done only on the on slot regions of the bursty HCPM data and 160 symbols (centered at the middle of the burst)
are reported on the symbol table for every on slot region. You can read more about specific measurements here.

The following image shows the P25 Symbol Table for C4FM (non-bursty) signals. For this signal type and for HDQPSK, there is no
grouping into bursts and all symbols that are analyzed are shown.
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Elements of the Display

Element Description

Marker Displays the selected marker label.

Time Displays the time in ms or in Symbols based on the Units chosen in the Analysis Time tab of the
Settings Control panel.

Symbol The value shown here reflects the symbol you have selected (highlighted) in the display.

Value Displays the value of the selected symbol.

P25 Symbol Table Settings
Main menu bar: Setup > Settings 

The settings for the P25 Symbol Table display are shown in the following table.

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Table continued…
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Settings tab Description

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Prefs Specifies the radix of the marker readout.

P25 Frequency Dev vs Time Display
The P25 Frequency Deviation vs. Time Display shows how the signal frequency varies with time.

To display the P25 Frequency Dev vs. Time Display:

1. Select the Displays button or Setup > Displays.
2. In the Select Displays dialog, select P25 Analysis in the Measurements box.
3. In the Available displays box, double-click the P25 Frequency Dev vs. Time icon or select the icon and click Add. The P25

Frequency Dev vs. Time icon will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to display the Freq Dev vs. Time display.
5. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and Reference filters as appropriate for the

input signal.
6. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list depend of the standard and

modulation type you have selected.

Elements of the Display
The following image shows the P25 Freq Dev vs Time display for Phase 1 C4FM (non-bursty) High Deviation signals.
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The following image shows the P25 Freq Dev vs Time display for Phase 2 HCPM (bursty) signals.

Note: For bursty HCPM signals, frequency deviation analysis is done only on 160 symbols centered at every on slot region in the
chosen analysis window and not on off slot regions. That is why there is no information shown during off slot regions. You can
read more specific information about P25 measurements here.

Elements of the Display

Item Display element Description

1 Top of graph adjustment Adjust the frequency range displayed on the vertical axis.

2 Position (center) Adjust the frequency shown at the center of the display.

3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the best display.

4 Position Displays the horizontal position of the trace on the graph display.

5 Scale Adjust the horizontal scale (time).

Changing Frequency vs Time Display Settings

P25 Frequency Dev Vs Time Settings
Main menu bar: Setup > Settings 

The Setup settings for P25 Frequency Dev vs. Time are shown in the following table.
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Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Test Patterns Specifies the type of test pattern being used. Some analysis differs based on the selected test pattern.
Available test patterns vary depending on the selected standard and modulation type.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Scale Defines the vertical and horizontal axes.

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

P25 Analysis Shared Measurement Settings
Main menu bar: Setup > Settings

The control panel tabs in this section are shared between the displays in P25 Analysis (Setup > Displays). Some tabs are shared by all
the displays, some tabs are shared by only a subset of displays. The settings available on some tabs change depending on the selected
display.

Table 23: Common controls for P25 analysis displays

Settings tab Description

Modulation Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the application to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for P25 Analysis displays.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Scale Defines the vertical and horizontal axes.

Test Patterns Enables you to select from eight different test patterns.

Trig Meas Enables you to select from various trigger measurements. The trigger selections vary by signal type.

Table continued…
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Settings tab Description

Prefs Specifies the radix of the marker readout and whether elements of the graphs are displayed.

Modulation Params Tab - P25
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that define the signal format.

Settings Description

Standard Specifies the standard used for the input signal: Phase 1, Phase 2.

Channel Bandwidth This readout shows the nominal channel bandwidth based on the standard.

Modulation Type Specifies the modulation type of the input signal. Choices vary depending on the selected
standard. Modulation types for Phase 2 are HCPM (Inbound) and HDQPSK (Outbound).
Phase 1 has only C4FM as the modulation type selection.

Measurement Filter Specifies the filter used as a measurement.

Reference Filter Specifies the filter used as a reference.

Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some filter types)

Symbol Rate This is a readout that shows the symbol rate for demodulating digitally modulated signals
based on the standard. This rate is always 4.8 kHz for Phase 1 signals and 6 kHz for Phase
2 signals.

Symbol Rate
Specifies the symbol rate for demodulating digitally modulated signals based on the standard. The symbol rate and the bit rate are related
as follows:

(Symbol rate) = (Bit rate)/(Number of bits per symbol)

The bit rate used for Phase 1 (C4FM) is 9600 bps. For Phase 2 (HCPM and HDQPSK) it is 12000 bps. There are two bits per symbol for
all above mentioned modulation types. Therefore, the symbol rate is 4800 Hz for Phase 1 and 6000 Hz for Phase 2.

Measurement and Reference Filters
The available measurement and reference filters depend on the selected modulation type. The following table shows the recommended
filters for the specified modulation types.

CAUTION: Although there are other filter types listed in the drop down menu, if you select any filter other than that which is
recommended, the measurement results may not be accurate.
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Modulation type Measurement filters Reference filters

HDQPSK HDQPSK-P25 None

HPCM None None

C4FM C4FM-P25 RaisedCosine (Filter parameter 0.2)

The measurement filter is applied before the demodulation bit is detected and the ideal reference is calculated.

The reference filter is applied to the internally generated ideal reference signal before the modulation fidelity is calculated.

How to Select Filters
In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for another kind of necessary
shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This setting tells the analyzer what
filter your receiver uses. When the analyzer is set to the same filter used by the receiver, the analyzer sees the signal as your receiver
would. The Measurement Filter setting should be the same as the filter used in the receiver under normal operation (as opposed to
testing).

The Reference Filter setting in the analyzer corresponds to the baseband filter in the transmitter-receiver combination (Fr * Ft). The
baseband filter for the transmitter-receiver combination is often referred to as the System Filter. This filter is called the reference filter
because it is used to recreate a reference signal that is compared to the received signal. This recreated reference signal is the ideal signal
with Fr * Ft applied; differences between this ideal signal and the received signal enables the determination of signal quality, such as
modulation fidelity measurements.

Filter Parameter (C4FM only)
The filter parameter specifies the alpha for the Raised Cosine filter when selected as the Reference filter. Some filter types have a fixed
parameter value that is specified by industry standard, while other filter types by definition have no filter parameter. For filter types with no
filter parameter, there is no filter parameter control present in the control panel. The recommended Reference filter for C4FM is Raised
Cosine and the corresponding filter parameter for C4FM is 0.2.

Analysis Params Tab - P25
The Analysis Params tab contains parameters that control the analysis of the input signal.

Settings Description

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error and the
measured Frequency Error is displayed. When the Auto box is unchecked, the entered value
is used by the analysis as a fixed frequency offset. This is useful when the exact frequency
offset of the signal is known.

Table continued…
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Settings Description

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Select Manual, Auto, or Link to Span.

PTX Specifies the RF Output Power as recommended for transmitters. This is only used in the
computation of off slot power in HCPM modulated signals.

Low Pass cut off frequency

(only for frequency deviation)

Specifies the filter cut off frequency for Frequency deviation measurement. This setting will
only affect the scalar results Frequency Deviation (Positive and Negative Peak f1,f2,f3, and
f4) in the Summary display.

This selection is only visible when High or Low Deviation or Standard Transmitter Symbol
Rate Pattern is chosen from the Test Patterns tab of the Settings Control panel.

Analysis Time Tab - P25
The Analysis Time tab contains parameters that define how the signal is analyzed in the P25 Analysis displays.

Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer, this value may not match the Analysis Length requested (in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (all time values are relative to the Time Zero Reference).
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You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Actual" readout. This setting is not available when Auto is checked.
Range: minimum value depends on modulation type. Resolution: 1 symbol.

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger. When a trigger measurement is chosen from the Trig Meas tab of the Settings control panel, Time Zero
Reference is forced to Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which acquisition begins.

Trigger Time zero starts from the trigger point.

Test Patterns Tab - P25
Test patterns allow the software to compare the measurement result to the standards limit. The list of available test patterns varies
depending on which standard and modulation type is selected.

Settings Description

Test Patterns Use this drop-down list to select an appropriate test pattern. The list varies depending on which
standard and modulation type is selected.

You can read more about test patterns here.

Trace Tab - P25
The Trace tab allows you to set the trace display characteristics of the P25 trace display. The selections vary depending on the selected
display.

The following image shows the tab for the Constellation and Eye Diagram displays. For the other trace displays, the Trace Type setting is
not available.

APCO P25 Analysis

RSA5100B Series Real-Time Signal Analyzers Help 433



Setting Description

Trace

(P25 Constellation and P25 Eye
Diagram displays only)

Select the trace to display.

P25 Constellation display only: Select the trace that is hidden or displayed based on whether or not
Show is selected.

Show

(P25 Constellation and P25 Eye
Diagram displays only)

Specifies whether the trace selected by Trace is displayed or hidden.

Freeze

(P25 Constellation display only)

Halts updates to the trace selected by the Trace setting. Present for the Constellation display only.

Points/Symbol Select how many points to use between symbols when connecting the dots. Values: 1, 2, 4, 8.

Content

(P25 Constellation and P25 Freq
Dev & Time displays only)

Select whether to display the trace as vectors (points connected by lines), points (symbols only
without lines), or lines (lines drawn between symbols, but no symbols are displayed). The choices
available depend on the display.

Trace Type

(P25 Constellation and P25 Eye
Digram displays only)

Select to specify whether the plots in the Constellation and Eye Diagram displays are shown as I vs Q
or as Frequency Deviation.

Scale Tab - P25
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. There are three versions of the Scale tab for P25 displays.

Figure 73: Scale tab for the P25 Eye Diagram display
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Figure 74: Scale tab for the P25 Power vs Time display

Figure 75: Scale tab for the P25 Freq Dev vs Time display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal

Horizontal Full Burst

Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Position Allows you to pan a zoomed trace without changing the Measurement Frequency. Position is only
enabled when the span, as specified by Freq/div, is less than the acquisition bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto When Auto is checked, the scale and position values for the Symbols graph are automatically
adjusted to maintain the optimal display.

Reset Resets the vertical and horizontal settings.

Note: The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for the horizontal scale, display
the Analysis Time tab. On the tab, select the appropriate units from the Units drop-down list.

Trig MeasTab - P25
The Trig Meas tab enables you to chose a trigger measurement. The available measurements in the drop-down menu depend on the
standard and modulation type selected in the Modulation Params tab. The Trig Meas tab is not available for Phase 2 HDQPSK (Outbound)
signals. You can read more about P25 trigger related measurements here.
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The following image shows the tab for Phase 1 (C4FM) signals.

The following image shows the tab for Phase 1 (HCPM Inbound) signals.

Settings Description

Trigger Measurements Select the trigger measurement test.

Prefs Tab - P25
The Prefs tab enables you to change appearance characteristics of the P25 Analysis displays. Not all settings on the Prefs tab shown
below appear for every P25 display. The Summary display does not have a Prefs tab.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker readout in the
display. There are three choices for Radix: Binary (00,01,10,11), Quaternary (0,1,2,3), and Modulation
Symbols (+1,+3,-1,-3).

Limits Tab - P25
The Limits tab is only available for the P25 Summary display. It enables you to load an existing limits table, save a limits table, or edit limits
values.
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Setting Description

Load Click to load a saved Limits table from a .csv file.

Save Click to save the current Limits table to a .csv file.

Edit Limits
To directly edit measurement limits in the table, click on the value in the Limit column that you want to change.

The following table describes the parameters that are set in the Limits Table.

Table 24: Limits Table Settings

Setting Description

On Click on the cell in the On column next to the measurement to specify whether ofrnot measurements
are selected for limit comparison to indicate Pass or Fail.. A check mark means the measurement will
be taken. An empty box means it will not be taken.

Measurement Name Specifies the name of the measurement related to the limit. (Not editable.)

Limit Specifies the value of the limit to the related measurement. When the cell is selected, the value is
shown along with the units.
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LTE Analysis
LTE Overview
The Long Term Evolution (LTE) Downlink RF Measurements Analysis option allows you to evaluate RF signals to ensure that they meet
3GPP measurements. These are described in the TS 36.104 Base Station (BS) radio transmission and reception and test specifications
TS36.141 Base Station (BS) conformance testing documents version 12.5. This analysis option supports both LTE TDD and LTE FDD
frame structures. This analysis option supports the following measurements.

• Channel Power
• Occupied Bandwidth
• Adjacent Channel Leakage Ratio (ACLR)
• Spectral Emission Mask (Operating Band Unwanted Emission)
• Cell ID
• For TDD LTE Transmitter Off Power
• Reference Signal Power

These measurements are also compared with the limits provided by the standard to give pass/fail results (except for Channel Power and
OBW).

More detailed information about these measurements is available in the LTE measurements on page 446 section and the supported
measurements table.

You can also select these measurements from four LTE preset test setups. The test setups load pre-configured displays and control setting
as suggested by the standard to accelerate the test setup of the analyzer. The following four test setups are available for this analysis
option.

• Cell ID
• ACLR
• Channel Power and TDD Toff Power
• SEM

More detailed information about these test setups is available here.

With the LTE downlink RF Measurement Analysis test suite, test engineers can simplify the execution of a number of transmitter tests while
still enabled to modify signal parameters for in-depth signal analysis. The analysis results give multiple views of LTE signal characteristics
to allow the diagnosis of signal imperfections and impairments quickly and easily. Display controls allow you to selectively display the
analysis results to help locate trouble spots in the signal.

LTE topics in this Help
The following information about the LTE Analysis option is available:

• Reference table of supported LTE measurements
• LTE measurements
• LTE Standards preset test setups on page 439
• LTE displays on page 445
• LTE measurement control settings

Supported LTE measurements
The following table gives a brief description of the available LTE measurements. More detailed information can be found here. LTE
measurements on page 446
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LTE measurement LTE standard(s) Description

Cell ID detection TDD

FDD

The Cell ID is detected from the input LTE signal.

Adjacent Channel Leakage Ratio (ACLR) TDD

FDD

The Adjacent Channel integrated power is
calculated and shown. The relative power
compared to the reference signal is also
computed. The computed power is compared
against limits suggested by the selected standard
and pass/fail is reported. The appropriate settings
for this measurement are loaded with the ACLR
test setup (Presets > Standards > LTE).

Channel Power TDD

FDD

The channel power is calculated in the channel
bandwidth.

Occupied Bandwidth TDD

FDD

The Occupied bandwidth is calculated as
bandwidth containing 99% of the total integrated
power in the selected span around the selected
center frequency.

Operating Band Unwanted Emission TDD

FDD

The power in the offset regions is calculated and
presented and compared against limits set in the
offset and limits table and pass/fail is reported.
The appropriate settings for this measurement
are loaded with the SEM test setup (Presets >
Standards > LTE).

Toff TDD The power in off-slot region is computed and
compared against selected limits.

Reference Signal Power TDD

FDD

Measures the power of cell specific reference
signals.

LTE Standards preset test setups
Presets > Standards

The LTE Standards preset allows you to access displays preconfigured for the test setup you select. The test setups load the displays and
control setting options suggested by the LTE standard to perform the measurements. You can read more about how Presets work here.

There are four test setups for LTE:

• Cell ID
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• ACLR

• Channel Power and TDD Toff Power
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• SEM

The following table shows what automatically loads with each test setup.
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Table 25: LTE preset test setups

Test setup Displays loaded with preset

Cell ID Frame structure:

- Downlink FDD

- Downlink TDD

(Default is Downlink FDD.)

Spectrum, Time Overview, LTE Constellation

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Table continued…
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Test setup Displays loaded with preset

ACLR Frame structure:

- Downlink FDD

- Downlink TDD

(Default is Downlink FDD.)

LTE ACLR

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Base station category:

- Wide Area Cat A

- Wide Area Cat B — Option 1

- Home Area (P-rated ≤ 20 dBm)

- Local Area (P-rated ≤ 24 dBm))

- Medium Area (P-rated ≤ 38 dBm))

(Default is Wide Area Cat A.)

Adjacent channel type:

- UTRA

- E-UTRA

(Default is UTRA.)

UTRA chip rate.

1.28 Mcps

3.84 Mcps

7.68 Mcps

Chip rate is only displayed under the following conditions:

TDD is frame structure

Adjacent channel type selected is UTRA

Channel bandwidth is >3 MHz

(Default chip rate is 3.84 Mpcs.)

Table continued…
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Test setup Displays loaded with preset

Channel Power and
TDD Toff Power

Frame structure:

- Downlink FDD

- Downlink TDD

(Default is Downlink FDD.)

Time Overview (TDD only), LTE Channel Spectrum,
LTE Power vs Time (TDD only)

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

SEM Frame structure:

- Downlink FDD

- Downlink TDD

(Default is Downlink FDD.)

SEM

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Base station category:

- Wide Area Cat A

- Wide Area Cat B — Option 1

- Home Area (2 dBm ≤ P ≤ 20 dBm)

- Local Area

- Medium Area (P ≤ 31 dBm)

(Default is Wide Area Cat A.)

Retain current center frequency and reference level settings
The Retain current Center Frequency setting appears when the LTE Standards Preset is chosen. This setting allows you to retain the
previously used center frequency. By default, the Center Frequency setting box is unchecked and the LTE preset displays will load with
1.96 GHz for FDD and 1.9 GHz for TDD.

The Retain current Ref Level setting appears when the LTE Standards Preset is chosen. This setting allows you to retain the previously
used reference level. By default, the Ref Level setting box is checked.

To activate these settings, check the box next to the desired setting. The following image shows the Retain current Ref Level setting box
checked.
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LTE displays
The displays in LTE Analysis (Setup > Displays > Measurements: LTE Analysis) are:

• LTE Channel Spectrum
• LTE ACLR
• LTE Constellation
• LTE Power vs Time
• SEM (This display is not an LTE specific display, but is available when RF Measurements is selected from the Select Displays dialog

(Setup > Displays) (see the following image).)
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LTE measurements
LTE Analysis enables RF measurements and detection of Cell ID in the transmitted signal for both TDD and FDD frame structure LTE
signals. For TDD signals, the analysis will also do the TOFF measurement. The following topics contain important information you should
know about specific LTE measurements. You can view a table with all of the available measurements here.

Channel Power and Occupied Bandwidth (TDD and FDD)
The Channel Power measurement is done by calculating the power in the LTE signal based on the selected channel bandwidth option. The
Occupied Bandwidth measurement calculates the frequency range over which 99% of the power is contained in the acquired signal. This
measurement is done for the selected channel bandwidth option.

More information about this measurement:

• Select the Channel Power and TDD Toff Power test setup from Presets > Standards > LTE to perform the measurement. This will load
the displays found in the LTE preset test setups table.

• This test setup allows you to choose the frame structure and the channel bandwidth.
• The Channel Spectrum display will contain the results of Channel Power and Occupied Bandwidth. The result gives the power in the

LTE signal (calculated over the channel bandwidth).
• Results are presented as scalar and are located below the display.
• For TDD signals, the channel power and the occupied bandwidth measurement are done on the on-slot region. If the valid on-slot

region is not found, the measurement is done in the selected analysis length.

ACLR (FDD and TDD)
The Adjacent Channel specification and limits for comparison are set based on selected frame structure, adjacent channel and base
station types from Standards Presets. It calculates the integrated power in the different adjacent regions and also indicates pass/fail based
on comparison with absolute and relative limits in LTE ACLR display.

More information about this measurement:

• Select the ACLR test setup from Presets > Standards > LTE to perform the measurement. This will load the displays found in the LTE
preset test setups table.

• This test setup allows you to select the frame structure, channel bandwidth, base station type, and adjacent channel type with the
following restrictions:

• Frame Structure can be TDD or FDD
• Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz
• Base station type can be Wide Area Cat A, Wide Area Cat B- Option 1, Home Area (P-rated ≤ 20 dBm), Local Area (P-rated ≤ 24

dBm), Medium Area (P-rated ≤ 38 dBm)
• Adjacent Channel type can E-UTRA or UTRA
• UTRA chip rate can be 1.28, 3.84, or 7.68 Mcps

Default rate is 3.84 Mcps for all UTRA adjacent channels of FDD and when channel bandwidth is 1.4 or 3 MHz.

However, you can choose other rates when the frame structure is TDD and when the bandwidth is more than 3 MHz. Otherwise,
the standard recommends use of 3.84 Mcps.

• Based on the settings you select from Standards Preset, the offset and bandwidth of the adjacent channels are set in the Offset and
Limits tab of the control panel. The settings are different for paired and unpaired spectrum.

• The settings also include the absolute power limit for comparison based on the base station type. The standard recommends the
settings in dBm/MHz for each base station type. The power limits are appropriately scaled with the integration bandwidth and
presented in dBm in the Offset and Limits table of the display. The integrated power in each adjacent band is compared with the
absolute and relative limits as recommended by the standard. The absolute limits are dependent on this choice of base station type
because they apply to different power levels (as the P-rated levels in the drop down menu indicate). The relative limit is also set.

• The results are presented in both tabular and display format. In the tabular display, the reference channel power and the offset,
bandwidth, integrated power, and relative power of the adjacent channels are presented. An expanded view format is also available.
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• The integrated power in the display is shaded blue in each adjacent channel region.
• Each adjacent channel is clearly shown. Interadjacent channel gaps are shown in gray.
• The limit lines are shown in different colors. Based on the Mask option chosen in the Offset & Limits table, failures in the different

bands are shown in red on violation. By default for LTE Standards Presets, the Mask option is Abs & Rel, so the failure is shown only
when the calculated power violates both relative and absolute power limits.

• The respective rows that violate both absolute and relative limits are also shown in red. Pass/fail information appears in the top left
corner of the display.

• This measurement can be performed in Real Time or Non-Real Time mode. In Real Time mode, a single acquisition required for the
entire span needed for this measurement is taken and the measurement is done. In the Non-Real Time mode, a separate acquisition
for each adjacent channel region is taken and analyzed.

Non-real time mode is also useful when the bandwidth offered by the instrument does not support the span requirement for this
measurement. The span requirement comes from the choice of adjacent channel type and channel bandwidth. In such cases,
Non-Real Time mode can be used.

• For UTRA adjacent channels, filtering of the adjacent channels with an RRC filter of the same bandwidth is employed, as suggested
by the standard. The chip rate is set to 3.84 Mcps for FDD and when the channel bandwidth is 1.4 or 3 MHz. For TDD, when the
channel bandwidth is more than 3 MHz, you can choose the UTRA chip rate from the ACLR test setup (Presets > Standards > LTE).
The options are 1.28, 3.84, and 7.68 Mcps.

• The standard recommends this measurement be done on the transmitter ON period when the signal being analyzed is TDD. An on slot
detection module in the analysis helps you to do the measurement in the transmitter ON period.

• If you are doing the measurement in Real Time, you can also load the Time Overview display, which will indicate to you the region
in which the measurement is done (a purple line at the bottom). You can see the measurement is done only on the valid transmitter
ON period. However, when a bursty data is not available, the measurement is done on the available analysis length.

Note: Real-Time mode can be set from the Parameters tab of the Settings control panel of the LTE ACLR display.
Disabling Real-Time mode is the non-Real-Time setting.

• When the measurement is done in non-Real Time mode, separate acquisitions are obtained for each adjacent channel band.
In such cases, it cannot be ensured that all the adjacent channel acquisitions are done on the transmitter ON period. It is
recommended that you use either Real time mode or an external trigger from the source (when used with non-Real-Time mode) to
do the measurement. An external trigger from the source can ensure that all the acquisitions are done just after the rising edge of
the burst. A status message in the display indicates when to use Real-Time mode or external trigger for TDD signals. The status
message that is displayed in the LTE ACLR display is "Signal must be triggered or measurement in Real-Time". This message
is displayed when TDD is chosen from Standard Presets, when Real-Time is not enabled from the Parameters tab of the control
panel, and when the instrument is in Free Run mode.

Operating Band Unwanted Emission (FDD and TDD)
This measurement finds the power in the offset regions recommended by the standard. The offset channel specification and limits for
comparison are set based on the selected channel bandwidth, frame structure, and base station types in Standards Preset. It calculates
the integrated power in the different offset regions and also indicates pass/fail information based on comparison with absolute and relative
limits in the SEM display.

More information about this measurement:

• Select the SEM test setup from Presets . Standards . LTE to perform the measurement. This will load the displays found in the LTE
preset test setups table.

• This test setup allows you to select the frame structure, channel bandwidth, and base station type with the following restrictions:

• Frame Structure can be TDD or FDD
• Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz
• Base station type can be Wide Area Cat A, Wide Area Cat B - Option 1, Home Area (2 dBm ≤ P ≤ 20 dBm), Local Area, Medium

Area (P ≤ 31 dBm)
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• Based on the settings chosen by the user from Standards Presets the offset and bandwidth of the offset channels are set in the Offset
and Limits tab of the control panel of SEM display.

• The settings also include the absolute power limit for comparison based on the base station type. The standard recommends the
settings in dBm/MHz for each base station type. The power limits are appropriately scaled with the integration bandwidth and
presented in dBm in the Offset and Limits table of the display. The integrated power in each adjacent band is compared with the
absolute and relative limits as suggested by the standard. The absolute limits are dependent on this choice of base station type as they
apply to different power levels (as the P-rated levels in the drop down menu indicate). The relative limit is also set.

• The results are presented both in tabular and display form.
• The Pass/ Fail information is also shown in the top left corner of the display.
• For TDD signals, a detection module in the analysis helps you to do the measurement in the transmitter ON period.

• If you are doing the measurement in Real Time, you can also load the Time Overview display, which will indicate to you the region
in which the measurement is done (a purple line at the bottom). You can see the measurement is done only on the valid transmitter
ON period. However, when a bursty data is not available, the measurement is done on the available analysis length.

Note: Real-Time mode can be set from the Parameters tab of the Settings control panel of the SEM display. Disabling
Real-Time mode is the non-Real-Time setting.

• When the measurement is done in non-Real Time mode, separate acquisitions are obtained for each adjacent channel band.
In such cases, it cannot be ensured that all the adjacent channel acquisitions are done on the transmitter ON period. It is
recommended that you use either Real-Time mode or an external trigger from the source (when used with non-Real Time mode) to
do the measurement. An external trigger from the source can ensure that all the acquisitions are done just after the rising edge of
the burst. A status message in the display indicates when to use Real Time mode or external trigger for TDD signals. The status
message that is displayed in the LTE SEM display is "Signal must be triggered or measurement in Real-Time". This message is
displayed when TDD is chosen from Standard Presets, when Real-Time is not enabled from the Parameters tab of the control
panel, and when the instrument is in Free Run mode.

• Settings for all tables provided in the base station conformance testing document (3GPP TS 36.141 v12.5 – for Release 12) has been
incorporated from Standards Presets.

• Wide Area and Local area settings from standard presets are provided as per the standard document.
• Home Area base station settings loaded from standard presets correspond to Reference power levels between 2 to 20 dBm.
• Medium Area base station settings loaded from standard presets correspond to reference power levels less than 31 dBm.

• The following settings are provided in a *.csv file that you can load. These files will be available in the installed directory (Example
Files\LTE).

• Wide Area category B Option 2 (for specific bands specified by the standard). There are three csv files based on operating band
and channel bandwidth for Wide Area.

• LTE_SEM_1.4MHz_CatB_optn2_bands_3_8.csv
• LTE_SEM_3MHz_CatB_optn2_bands_3_8.csv
• LTE_SEM_5to20Hz_CatB_optn2_bands_1_3_8_32_33_34.csv

• Home Area base station for power level less than 2 dBm. There are six csv files based on operating band and channel bandwidth
for Home Area.

• LTE_SEM_1_4MHz_above3GHz_Home2P.csv
• LTE_SEM_1_4MHz_below3GHz_Home2P.csv
• LTE_SEM_3MHz_above3GHz_Home2P.csv
• LTE_SEM_3MHz_below3GHz_Home2P.csv
• LTE_SEM_5to20MHz_above3GHz_Home2P.csv
• LTE_SEM_5to20MHz_below3GHz_Home2P.csv

• Medium Area base station for reference power level between 31 to 38 dBm. There are six csv files based on operating band and
channel bandwidth for Medium Area.
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• LTE_SEM_1_4MHz_above3GHz_Medium31P38P.csv
• LTE_SEM_1_4MHz_below3GHz_Medium31P38.csv
• LTE_SEM_3MHz_above3GHz_Medium31P38.csv
• LTE_SEM_3MHz_below3GHz_Medium31P38.csv
• LTE_SEM_5to20MHz_above3GHz_Medium31P38.csv
• LTE_SEM_5to20MHz_below3GHz_Medium31P38.csv

• Additional requirements given in Section 6.6.3.5.3 in 3GPP TS 36.141 v12.5 standard document. There are 14 csv files based on
the requirements in the standard document. The files are named based on the table numbers of Section 6.6.3.5.3 of the standard
document (3GPP TS 36.141 V12.5.0 (2014-09).

Cell ID (TDD and FDD)
The dominant Cell ID in the transmitted LTE signal is detected and presented in the Constellation display. Along with the Cell ID scalar
results, the group and sector ID are also presented. The constellation of the Primary and Second Synchronization signals are presented
too.

More information about this measurement:

• Select the Cell ID test setup from Presets > Standards > LTE to perform the measurement. This will load the displays found in the LTE
preset test setups table.

• This test setup allows you to select the frame structure and channel bandwidth with the following restrictions:

• Frame Structure can be TDD or FDD
• Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz

• Analysis of the LTE signals is done based on the settings you choose in the Standards Presets.
• The constellation for PSS and SSS (Primary and Secondary Synchronization Signals) are shown. You can optionally select to view

only the PSS or SSS constellation (selection is made in the Trace tab).
• Equalization based on PSS (Primary Synchronization Signal) data can be enabled using the "Enable Equalization" option (available

in the Analysis Params tab of the Settings Control panel.) This Equalization is based on PSS data and applied on other parts of the
OFDM symbol.

Reference Signal Power (TDD and FDD)
Reference Signal Power measures the power of cell specific reference signals. Reference signals are spread across time and frequency.
Reference signal position is dependent on the Cell ID, bandwidth, and antenna ports. For Downlink TDD (frame structure type 2), the
position of reference signals is also dependent on uplink-downlink and special subframe configurations.

Toff (TDD)
The Toff measurement is done only for the TDD signal. It is a measure of the off slot power in a LTE TDD signal.

More information about this measurement:

• Select the Channel Power and TDD Toff Power test setup from Presets > Standards > LTE to perform the measurement. This will load
the displays found in the LTE preset test setups table.

• This test setup allows you to select the frame structure and channel bandwidth with the following restrictions:

• Frame Structure can be TDD or FDD
• Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz

• Analysis of the LTE signals is done based on the settings you choose in the Standards Presets.
• By default, the Toff measurement is the average of several non-overlapping and adjoining 70 μs windows in the off slot region. This

measurement is done only on the 70 μs window in the center of the off slot region, when the Average over entire offslot region
option is disabled.

• The scalar result is presented in dBm/MHz.

LTE Analysis

RSA5100B Series Real-Time Signal Analyzers Help 449



• The result is compared against limits that can be defined using the Limits tab of the control panel. By default, these limits are set based
on the Base Station conformance testing document (3GPP TS 36.141 v12.5 – for Release 12). Pass/fail is shown in the top left corner
of the LTE Power vs Time display.

LTE Status Messages
The following status messages may appear. Each message indicates the related condition (Description) shown in the following table.

Status message Description

LTE Analysis: Signal must be triggered or measured in
Real Time

Shown in the display and status bar when the user attempts to make the ACLR
measurement and SEM measurement for TDD signals in non-Real-Time mode
and when the instrument is in free run.

Since the standard recommends the ACLR measurement to be done in
transmitter ON periods only, either the measurement has to be done in Real-
Time mode (in which a detection module ensures the measurement is done on
the transmitter ON period) or has to be externally triggered if in non-Real-Time
mode.

LTE Analysis: Recovery done on PSS/SSS on the center
62 carriers

Shown in the status bar to indicate that the constellation of PSS and SSS
shown in the LTE constellation is done based on analysis of PSS and SSS
signals in the center 62 carriers of the corresponding OFDM symbols.

Therefore, you may see the correct constellation and Cell ID even when a
different channel bandwidth is chosen from the control panel because the
analysis for PSS and SSS is done only on the center carriers.

LTE Analysis: Analysis Failure - Synchronization
Sequence not found

Shown in the status bar to indicate that a valid Cell ID (from PSS and SSS) is
not detected.

LTE ACLR display
The LTE Adjacent Channel Leakage Ratio (ACLR) display shows the ratio of the mean power centered on the assigned channel frequency
to the mean power centered on an adjacent channel frequency. In the 3GPP specification, both the main channel and adjacent channels
are required to be filtered with RRC (Root Raised Cosine) filters.

To show the LTE ACLR display you can select Presets > Standards > LTE.

Note: Loading the LTE ACLR display from the Presets > Standards > LTE menu is recommended. This loads the control settings
based on the selected options.

You can also load the LTE ACLR display as follows:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays window, select LTE Analysis in the Measurements box.
3. In the Available displays box, double-click the LTE ACLR icon or select the icon and click Add. The LTE ACLR icon will appear in the

Selected displays box and will no longer appear under Available displays.
4. Click the OK button to show the display.
5. Select Setup > Settings to display the control panel.
6. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the LTE ACLR display.
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Item Display element Description

A Pass/Fail Indicates Pass or Fail based on Absolute and Relative limits set by the user. The failure
condition is set by Mask in the Offset and Limits Table tab of the Settings control panel. By
default, the mask is set to Abs & Rel, meaning failure is reported only when both absolute
and relative results fail against the respective limits.

B Ref Detection Set to Avg (VRMS) or +Peak based on the choice made in Processing tab of the Settings
control panel.

C Normal Indicates how the result is presented over multiple sweeps. This selection is made in the
Processing tab of the control panel. Displays Average Count if Avg (VRMS) is checked in
the Processing tab in the Settings control panel.

D Clear Resets measurement. Clears all values.

E Plot Shows the reference channel and adjacent channels and the regions in between them.
The Absolute and Relative limit lines are also shown. The integrated power is shown as a
band. Scalar results are also shown.

F Span Adjust the span of the graph in symbols.

Table continued…
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Item Display element Description

G Results Table Tabulates the results in each adjacent band. Table shows the offset, bandwidth, Integrated
Absolute and Relative power in the upper and lower adjacent channel regions.

H CF Center Frequency at which the measurement is performed.

I Ref Total Power Gives the power in the Reference channel.

J Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

K Bottom readout Displays the value indicated by the bottom of graph.

L dB / div Shows the dB per each division in the Y axis of the plot.

(not
shown)

Units Sets the global Amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

M Top of graph The vertical scale is normalized with appropriate power units.

N Expand button Shows the results table in its own window with larger font size.

Clicking on the Expand button allows you to view the results table in a separate window, as shown in the following image.

LTE ACLR Settings
Main menu bar: Setup > Settings

The LTE ACLR Settings control panel provides access to settings that control parameters of the LTE ACLR display. 

Settings tab Description

Channels Allows you to control how the measurement is performed. When in Real Time, the RBW and VBW
settings apply for all channels (including offset regions) and the other parameters apply only for the
reference channel. When Non-Real Time mode is selected, all information in this tab, including RBW
and VBW, only applies to the reference channel.

Parameters Specifies several characteristics that control how the measurement is made. These parameters are
used by the instrument to analyze the input signal.

Table continued…
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Settings tab Description

Processing Specifies settings for detection on the reference channel and the offsets. Specifies the function setting
on how calculations are done across multiple sweeps.

Offsets & Limits Table Allows you to select the characteristics of offsets and mask limits.

Scale Specifies the vertical and horizontal scale settings.

Prefs Allows you to select to show or hide the graticule, power level, limits, and marker readouts.

LTE Channel Spectrum display
The LTE Channel Spectrum display shows the spectrum of the input signal across one channel. Channel power measures the average
power within the selected bandwidth and is expressed in dBm. Other units can be selected from the Units tab of the Analysis control panel.
The measured occupied bandwidth is calculated as the bandwidth containing 99% of the total integrated power within the selected span
around the selected center frequency.

To show the LTE Channel Spectrum display:

1. Press the Displays button or select Setup > Displays.
2. From the Measurements box, select LTE Analysis.
3. Double-click the LTE Channel Spectrum icon in the Available Displays box. This moves the LTE Channel Spectrum icon to the

Selected displays box.
4. Click OK button to view the display.
5. Select Setup > Settings to display the control panel.
6. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the LTE Channel Spectrum display.
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Item Display element Description

A Normal Displays Average Count if Average is turned on (set to Time Domain or Frequency
Domain) from the Measurement Params tab in the Settings control panel.

B Clear Resets measurement. Clears all values.

C Plot Specifies the value shown at the center of the graph display.

D Scale Adjust the span of the graph.

E Position Displays the horizontal position of the trace on the graph display.

F Scalar results Shows the Channel Power and Occupied Bandwidth measurement results.

G Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

H Bottom readout Displays the value indicated by the bottom of graph.

I dB / div Shows the dB per each division in the Y axis of the plot.

(not
shown)

Units Sets the global Amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

J Top of graph The vertical scale is normalized with appropriate power units.
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LTE Channel Spectrum Settings
Main menu bar: Setup > Settings 

The settings for the LTE Channel Spectrum display are shown in the following table.

Settings tab Description

Freq & RBW Allows you to specify the frequency and resolution bandwidth used for the measurement.

Measurement Params Allows you to set averaging (Time Domain, Off, or Frequency Domain) and to set the number value
associated with the Average setting.

Channels Allows you to set the Channel BW for the Channel Power measurement.

Scale Allows you to specify the horizontal and vertical scale settings.

Prefs Allows you to select to show or hide certain display elements.

LTE Constellation display
The LTE Constellation display shows the constellation of Primary (PSS) and Secondary (SSS) Synchronization Signals. Scalar results
include Cell ID, Group ID, Sector ID, and frequency error.

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select LTE Analysis in the Measurements box.
3. In the Available displays box, double-click the LTE Constellation icon or select the icon and click Add. The LTE Constellation icon will

be added to the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the display.
5. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the LTE Constellation display.
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Item Display element Description

1 Scalar results Gives results of Cell ID, Group and Sector ID information along with Frequency error.

2 Marker readout Shows marker type, magnitude, phase and subcarrier number.

3 Status message Shows relevant status messages.

(You can read about status messages here.)

4 Plot Displays PSS and SSS (Primary and Second Synchronization Signal) constellation.

LTE Constellation Settings
Main menu bar: Setup > Settings 

The settings for the LTE Constellation display are shown in the following table.

Settings tab Description

Modulation Params Specifies the frame structure and channel bandwidth.

Analysis Params Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for LTE Analysis displays.

Trace Allows you to set the display characteristics of the traces.

Scale Specifies the vertical and horizontal scale settings.
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LTE Power vs Time display
The LTE Power vs Time display shows the filtered power of the data and marks where the TOFF measurement is done. The TOFF scalar
results are also shown.

You can select Presets > Standards > LTE to view the display.

Note: Loading the LTE Power vs Time display from the Presets > Standards > LTE menu is recommended. This loads the
control settings based on the selected options.

You can also load the LTE Power vs Time display as follows:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select LTE Analysis in the Measurements box.
3. In the Available displays box, double-click the LTE Power vs Time icon or select the icon and click Add. The LTE Power vs Time icon

will be added to the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the display.
5. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the LTE Power vs Time display.
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Item Display element Description

A Pass / Fail Shows Pass or Fail based on whether the TOFF measurement (off slot power) is below the
recommended limit set in the Limit tab of the Settings control panel or not. The Pass/Fail
information is displayed only when the chosen frame structure if TDD and if a valid off slot
is found.

B Plot Displays the filtered signal in case of TDD and the region in which the off slot power is
measured is graphically shown. When the frame structure is chosen as FDD, the power in
the input signal is displayed.

C Scale Adjust the span of the graph in symbols.

D Analysis Start Gives the start of analysis region.

E Toff The TOFF (off slot power) is measured and displayed here when a valid off slot is found for
a TDD signal.

F Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

G Bottom readout Displays the value indicated by the bottom of graph.

H dB / div Shows the dB per each division in the Y axis of the plot.

(not
shown)

Units Sets the global Amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

I Top of graph The vertical scale is normalized with appropriate power units.

LTE Power vs Time Settings
Main menu bar: Setup > Settings 

The settings for the LTE Power vs Time display are shown in the following table.

Settings tab Description

Modulation Params Specifies the frame structure and channel bandwidth.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for LTE Analysis displays.

Prefs Allows you to select to show or hide the graticule and marker readouts.

Scale Specifies the vertical and horizontal scale settings.

Limit Specifies the mask limits.
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LTE Analysis Measurement Settings
Main menu bar: Setup > Settings

The control panel tabs in this section are shared between the displays in LTE Analysis (Setup > Displays). Some tabs are shared by all the
displays and some tabs are shared by only a subset of displays. The settings available on some tabs change depending on the selected
display.

Table 26: Controls for LTE Analysis displays

Settings tab Description

Modulation Params Allows you to set the frame structure and channel bandwidth.

Available for these displays: LTE Power vs Time, LTE Constellation.

Analysis Params Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for LTE Analysis displays.

Available for these displays: LTE Power vs Time, LTE Constellation.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Available for the LTE Constellation display only.

Prefs Allows preferences with Radix display and marker readouts.

Available for these displays: LTE Power vs Time, LTE ACLR, LTE Channel Spectrum, SEM.

Scale Defines the vertical and horizontal axes.

Available for all LTE displays.

Offsets & Limits Table Note: Available for the LTE ACLR display only.

Freq & RBW Specifies the frequency and resolution bandwidth used for the measurement.

Note: Available for the LTE Channel Spectrum display only.

Parameters Specifies several characteristics that control how the measurement is made.

Processing Specifies settings for detection on the reference channel and the offsets. Specifies the function setting
on how calculations are done across multiple sweeps.

Limit Allows you to define limits for pass/fail comparison with calculated values. The default values are as
recommended in the test specification.

Table continued…
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Settings tab Description

Channels Specifies the Channel BW for the Channel Power measurement. Allows you to set RBW, VBW, power
reference, as well.

Available for these displays: LTE ACLR, LTE Channel Spectrum.

Measurement Params Allows you to set averaging (Time Domain, Off, or Frequency Domain) and to set the number value
associated with the Average setting.

Channels tab - LTE
The Channels tab allows you to control how the measurement is performed.

The following image shows the Channels tab for the LTE ACLR display. When in Real Time, the RBW and VBW settings apply for all
channels (including offset regions) and the other parameters such as Power Reference, Channel Width, and Integrated bandwidth apply
only to the reference channel. When Non-Real Time mode is selected, all information in this tab, including RBW and VBW, only applies to
the reference channel.

Settings Description

Reference

Power Reference The value used to calculate relative measurements. When Auto is selected, the calculated
reference channel power is displayed. When Auto is unchecked, you can enter a value for
the reference power, and the measured reference power is not used or displayed.

Channel Width Specifies the width of the reference channel.

Integration BW Specifies the integration bandwidth used to compute the total power in the reference
channel.

All Channels (displayed for Real-Time mode)

Reference Channel (displayed for Non-Real Time mode)

RBW Sets the RBW

Table continued…
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Settings Description

VBW Enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer
emulates the VBW filters of traditional swept analyzers. When the check box next to VBW is
not checked, the VBW filter is not applied.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is
1/10,000 of the RBW setting.

The following image shows the Channels tab for the LTE Channel Spectrum display. This tab allows you to set the channel bandwidth,
which in turn sets the span for LTE Channel Spectrum.

Settings Description

Channel Bandwidth Specifies the Channel Bandwidth, which in turn sets the span of the LTE Channel Spectrum.

Parameters tab - LTE
The Parameters tab enables you to specify several parameters that control the LTE ACLR measurements are made.

Setting Description

Meas Freq Specify the frequency of the signal to be measured.

Step Sets the increment size when changing the Frequency using the knob or mouse wheel. Auto: When
Auto is enabled, the step size is adjusted automatically based on the span setting.

Real-Time When Real-Time mode is enabled, the entire LTE ACLR span is measured using a real-time/
contiguous acquisition. Not all described parameters are available in Real-Time mode.

When Real-Time is disabled (non-Real-Time mode), a separate acquisition for each region is taken
and analyzed. Non-Real-Time mode is also useful when the bandwidth offered by the instrument
does not support the span requirement for this measurement. The span requirement is guided by the
choice of adjacent channel type and channel bandwidth selected in LTE Standards Presets.

Table continued…
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Setting Description

Measure Noise Floor Takes preliminary acquisitions to measures the instrument noise floor. This initiates a noise correction.
A noise correction signal is created by switching off the RF input and performing acquisitions of the
instrument’s internal noise. Fifty acquisitions are averaged to create the noise reference signal. The
noise reference signal is measured for the Reference channel and each Offset is defined by the
measurement settings.

Apply noise correction This item is enabled and the check box automatically checked after the noise reference signal is taken
when the Measure Noise floor button is clicked. This initiates noise reference subtraction from the
incoming signal power for each region to create the corrected result. All calculations are performed in
Watts and then converted to the desired units.

The amount of noise correction is limited to 20 dB to avoid the possibility of a negative power
measurement. This is a rare condition that could occur if the subtraction of the reference power from
the channel power results in a negative value (or “infinite” dBm). The noise reference for a region is
subtracted from each trace point in the channel, rather than offsetting the entire region by a single
amount. This produces a smooth trace with no discontinuities at the region edges.

Note: If any relevant settings (such as reference level, frequency, span, RBW) are changed
once the noise reference is measured, the following warning message will be displayed
to notify you that Noise Correction was not applied: Noise correction not applied - select
Measure Noise Floor for new noise correction.

Filter shape Specifies the shape of the filter determined by the window that is applied to the data record, in the
spectrum analysis, to reduce spectral leakage. 3GPP specifies a Gaussian window shape be applied
to the reference channel measurements.

Gaussian: This filter shape provides optimal localization in the frequency domain.

Rectangular: This filter shape provides the best frequency, worst magnitude resolution. This is
essentially the same as no window.

Processing tab - LTE
The Processing tab controls the detection settings for the Reference Channel and Offsets, as well as selecting the function for the LTE
ACLR display.

Setting Description

Detection (in each sweep)

Table continued…
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Setting Description

Reference Channel Specifies the Detection method used for the Reference Channel. Detection is used to produce the
desired measurement result (peak or average) and to reduce the results of a measurement to the
desired number of trace points.

Avg (VRMS) For each sweep, each point of the trace is the result of determining the RMS voltage value for the
last 'n counts' of the collected traces for the same point. When 'n count' has not been reached, partial
averaging results are displayed.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from the results
to be compressed into a trace point.

Offsets Specifies the detection method used for the offsets.

Avg (VRMS) Selects the Average Vrms detection method. With this method, each point on the trace in each offset
is the result of determining the RMS Voltage value for all of the results values it includes.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from the results
to be compressed into a trace point.

Function (across multiple sweeps)

Normal When a new trace has been computed, it replaces the previous trace.

Max Hold With each sweep, each trace point in the new trace is compared to the point’s value in the old trace
and the greater value is retained for display and subsequent comparisons.

Avg (VRMS) For each sweep, each point on the trace is the result of determining the RMS Voltage value for all of
the collected traces' values for the same point.

Count Enter the Avg (VRMS) value. Displayed only when Avg (VRMS) is selected.

Offsets and Limits Table tab - LTE
The Offsets and Limits Table tab is used to specify parameters that define Offsets and masks for the LTE ACLR display. The following
images show the tab and expanded view of the tab, respectively.

The following image shows the Offsets and Limits Table tab when Real-Time is selected in the Parameters tab.

The following image shows the Offsets and Limits Table tab when Real-Time is not selected in the Parameters tab (referred to as
non-Real-Time mode).
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The following image shows the expanded view of the Offsets and Limits Table (click the Expand button to view).

Setting Description

Buttons

Expand (button) Displays the Offsets and Limits Table in a new, resizable window.

Reset Layout Allows you to reorder columns in the Offsets & Limits Table by dragging the columns to a new
position. Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Offsets & Limits table from a file.

Save As Click to save the current Offsets & Limits table to a file.

Done When the table is expanded, click Done when you have finished editing the table to save your
changes and close the expanded table display.

Table columns

On Specifies whether or not measurements are taken in the specified offset.

Freq Offset (Hz) Specifies the frequency offset for the offset region (adjacent channel region) from the Center
frequency of the Reference Channel. This offset is always specified from the center frequency of
the Reference Channel to the center frequency of the Offset region.

Start (Hz) Start Frequency of the selected offset.

Stop (Hz) Stop Frequency of the selected offset.

Bandwidth (Hz) Specifies the bandwidth of the Offset region.

Side Specifies whether the specified range appears on both side of the carrier frequency or just one side
(left or right).

RBW (Hz) Specifies the RBW for the selected range.

Table continued…
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Setting Description

Buttons

n(RBWS) An integer value that specifies how many times to multiply the RBW to set the Filter bandwidth.

Filter BW (n x RBW) Displays the Filter BW. Filter BW is the equivalent BW of each point in the offset. When n > 1, an
integration technique is used to achieve the Filter BW using narrower RBWs.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW Minimum:
1/10,000 RBW setting.

VBW (On) Specifies whether the VBW filter is applied.

Mask Select the type of limits used for Pass/Fail testing. Signal excursions that exceed the mask settings
are considered violations. The available choices are Abs, Rel and Abs & Rel.

Abs Limit (dBm) The offset region integrated power is compared against the Abs Limit value mentioned here.

Rel Limit (dB) The offset region integrated power relative to the reference channel integrated power is compared
with this limit.

Scale tab - LTE
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings. In effect, these controls operate like pan and zoom controls. The Scale tab values are unique to each display. Also, note that each
display uses horizontal and vertical units that are appropriate for that display. There are three versions of the Scale tab for LTE displays.

The following image shows the Scale tab for the LTE Power vs Time display.

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Reset Resets the scale of the vertical axis to default values.

Horizontal Full Burst Controls the horizontal span.

Table continued…
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Settings Description

Start Specifies the horizontal axis start point.

Stop Specifies the horizontal axis end point.

Reset Resets the scale of the horizontal axis to default values.

The following image shows the Scale tab for the LTE Channel Spectrum and LTE ACLR displays.

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the horizontal span of the trace display and position of the trace.

Scale Specifies the frequency range displayed in the graph

Position Specifies the frequency shown at the center of the graph.

Autoscale Resets the scale of the horizontal axis to optimize the display of the trace.

Reset Scale Resets all settings to their default values.

The following image shows the Scale tab for the LTE Constellation display.
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Settings Description

Zoom

Scale Zooms in and out of the constellation. As the scale is increased, it will zoom out.

Vertical Position Adjusts the vertical position.

Horizontal Position Adjusts the horizontal position.

Prefs tab - LTE
The Prefs tab enables you to change parameters of the measurement display. The parameters available on the Prefs tab vary depending
on the selected display, but include such items as enabling/disabling Marker Readout and switching the graticule display on/off. Some
parameters appear with most displays, while others appear with only one display.

The following image shows the Prefs tab for the LTE ACLR display.

The following image shows the Prefs tab for the LTE Channel Spectrum display.

The following image shows the Prefs tab for the LTE Power vs Time display.

Setting Description

Show graticule Shows or hides the graticule.

Table continued…
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Setting Description

Trace / Max Trace points When the spectrum analysis produces more than the selected maximum number of points, the
method specified in Detection control is used to decimate the result. This setting applies to both the
reference channel and offsets.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show Power Levels In Graph This display the power level (calculated integrated power in the offset region) in the graph.

Show limits

Shaded Shows limits using a shaded area. Absolute limit and Relative limit shading colors can be set under
Presets > Options.

Line only Shows limits using only a line. Absolute limit and Relative limit line colors can be set under Presets >
Options.

None No lines or shading are used to indicate limits in the graph. Violations of the mask are still identified by
red shading.

Average Over Offslot Enables for averaging of offslot power in non-overlapping 70 μs windows in the entire offslot region.
If this option is disabled, the off slot power is measured only in the center 70 μs window of the offslot
region.

Freq and RBW tab - LTE
The Freq and RBW tab specifies frequency parameters for the Channel Power and ACPR measurements and the MCPR measurement. It
is available for the LTE Channel Spectrum display. 

Settings Description

Meas Freq Specifies the center/measurement frequency

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view's RBW setting.

Auto: When Auto is enabled, the step size is adjusted automatically based on the span
setting.

Table continued…
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Settings Description

Step The Step control sets the increment/decrement size for the adjustment of the center
frequency. If Auto is enabled, the analyzer will adjust the Step size as required.

Auto: When Auto is enabled, the step size is adjusted automatically based on the span
setting.

VBW Adjusts the Video Bandwidth value.

The maximum VBW value is 10 times the current RBW setting. The minimum VBW value is
1/10,000 of the RBW setting.

Measurement Params tab - LTE
The Measurement Params tab allows you to set parameters that control the ACPR and MCPR measurements. This is available for the LTE
Channel Spectrum display.

Settings Description

Average

Off

Frequency-domain This setting takes the average linear value of the traces (so that RMS values are preserved).
The number of averages is user-defined. Frequency domain averaging is available in spans
larger (or smaller) than the maximum real time bandwidth. This is the mode to use unless
you need to extract maximum dynamic range from an ACPR measurement.

Time-domain This setting takes the average linear value of the traces. It is useful if you need to extract
maximum dynamic range from an ACPR measurement. The number of traces is user
defined, however, the signals must be triggered and repeating (meaning the signal needs
to be exactly the same for each acquisition). When this condition is met, each waveform
contains the same signal, but the random noise changes from acquisition to acquisition
and the average value of the random noise is lowered, while the signal value remains
constant. Time domain averaging is not available in spans wider than the maximum real-time
bandwidth.

Modulation Params tab - LTE
The Modulation Params tab specifies the type of modulation used by the input signal and other parameters that define the signal format.
This tab is available for the LTE Constellation and Power vs Time displays.
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Settings Description

Frame Structure Select the frame structure to set how the demodulation is done.

Downlink FDD Downlink Frequency Division Duplexing

Downlink TDD Downlink Time Division Duplexing

Auto Detect If checked, Channel Bandwidth and Cyclic Prefix are automatically detected. It will also
detect the TDD Configuration when Downlink TDD is the selected frame structure.

Channel Bandwidth Select from 6 bandwidths: 1.4, 3, 5, 10, 15, 20 MHz

(If Auto Detect is checked, the channel bandwidth is automatically calculated.)

Cyclic Prefix Select Normal or Extended.

TDD Configuration

Uplink-Downlink Select from 0 to 6. The configuration determines the appropriate downlink to uplink
switch periodicity.

Special Subframe Select from 0 to 9. This configuration determines the number of downlink pilots, guard
period, and uplink pilots between uplink to downlink switch.

Antenna Ports

Total Antenna Ports Select from 1 to 4. This is the total number of antenna ports.

Chosen Port Select the antenna port from which the signal is captured.

Analysis Params tab - LTE
The Analysis Params tab allows you to enable equalization on the demodulated LTE packet. The equalization is based on PSS (Primary
Synchronization Signal). This tab is only available for the LTE Constellation display.
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Settings Description

Enable Equalization Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

Analysis Time tab - LTE
The Analysis Time tab contains parameters that define how the signal is analyzed in the LTE Analysis displays. This tab is available for the
LTE Constellation and Power vs Time displays.

Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer. This value may not match the Analysis Length requested (in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (All time values are relative to the Time Zero Reference.)
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You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Available" readout. This setting is not available when Auto is
checked. Range: minimum value depends on the standard. Resolution: 1 symbol.

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which the acquisition begins.

Trigger Time zero starts from the trigger point.

Trace tab - LTE
The Trace tab allows you to set the trace display characteristics of the LTE Constellation display.

Setting Description

> The arrow indicates which measurement name is active so that you can check it (on) or uncheck it
(off).

On Check the box next the measurement name you want to turn on.

Measurement Name Selections are PSS (Primary Synchronization Signal) or SSS (Secondary Synchronization Signal)

Limit tab - LTE
The Limit tab is only available for the LTE Power vs Time display. It enables you to specify the limit used for comparison against measured
values of Toff measurement.
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Setting Description

Toff psd Specifies the limit that is used for comparison against measured values of Toff measurement. Pass/
Fail is determined with this limit.
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5GNR Analysis
Overview
The 5GNR RF Measurement Analysis option allows you to evaluate RF signals to ensure that they meet 3GPP measurement
specifications. These are described in the Base Station (BS) radio transmission and reception and test specifications Base Station
(BS) conformance testing documents version 15. This analysis option supports both Uplink and Downlink frame structures. This analysis
option supports the following measurements:

Modulation Accuracy (ModAcc) - It measures the deviation of the received symbol relative to the ideal transmitted symbol. The IQ data
is processed to identify the OFDM Symbol boundaries and FFT is performed using the various settings under the Modulation Accuracy
tab. The subcarrier data is equalized and then Data and DMRS are extracted to perform various EVM measurements as per the 3GPP
specifications and then used for display in Constellation Display. The Estimation tab provides advanced settings related to IQ Impairments
and Frequency Offset estimation and corrections.

Channel Power (CHP) - This measurement is used to verify the maximum carrier output power across the frequency range. It includes
the measurement of individual carrier power under carrier aggregation mode. The Integrated Bandwidth type can be selected between
Channel and Signal Bandwidth to include or remove the Guard Bands between the carriers respectively.

Adjacent Channel Power (ACP) - It measures the power leakage from the carrier channels into the neighboring frequency channels,
commonly referred to as offset channels. The RBW, Sweep time, and Spectral Window can be selected from the measurement options tab.
By default, two offset channels are enabled for the measurement.

Spectral Emission Mask (SEM) – It measures the spurious emissions of a transmitter in the immediate frequency bands and compares
against the limit chosen in the settings. The RBW settings and the width of the bands can be selected from the measurement options tab.
The predefined band settings as per 3GPP are also provided in the options.

Occupied Bandwidth (OBW) – The Occupied Bandwidth measures the bandwidth within which 99% of the power transmitted within the
measurement bandwidth falls.

Error Vector Magnitude (EVM) – An EVM will give the variation of an EVM over the OFDM symbols. Trace can be selected between RMS
and Peak.

Power vs Time (PVT)- The PVT measurement measures the time domain power dynamics of the NR signal. This measurement is also
known as Transmit ON-OFF Time Mask measurement.

You can also select these measurements from seven 5GNR preset test setups. The test setups load pre-configured displays and control
setting as suggested by the standard to accelerate the test setup of the analyzer. The following test setups are available for this analysis
option.

1. Modulation Accuracy
2. ACP
3. CHP
4. SEM
5. OBW
6. EVM
7. PVT

For more detailed information about these test setups, click here.

With the 5GNR RF measurement analysis test suite, test engineers can simplify the execution of several transmitter tests while still
enabled to modify signal parameters for in-depth signal analysis.

The analysis results give multiple views of 5GNR signal characteristics to allow the diagnosis of signal imperfections and impairments
quickly and easily. Display controls allow you to selectively display the analysis results to help locate trouble spots in the signal.
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5GNR Analysis topics in this Help
The following information about the 5GNR Analysis option is available:

Supported 5GNR measurements

5GNR measurements

5GNR standard preset test setups

5GNR displays

5GNR measurement analysis settings

Supported 5GNR Measurements
The following table gives a brief description of the available 5GNR measurements. More detailed information can be found here.

Table 27: 5GNR Measurements

5GNR Measurement 5GNR Standard(s) Description
Modulation accuracy Sec 6.5.2 for BS and Sec

6.4.2 for UE.
It measures the deviation of the received symbol relative to the ideal transmitted
symbol.

ACP Sec 6.6.3 for BS and Sec
6.5.2.4 for UE

It measures the power leakage from the carrier channels into the neighboring
frequency channels.

CHP Sec 6.2 for BS and Sec
6.3 for UE

It measures the RMS power within the carrier channel bandwidth.

SEM Sec 6.6.5 for BS and Sec
6.5 for UE

It measures spurious out-of-band emissions in the immediate neighboring bands
of the carrier.

OBW Sec 6.6.2(38.141) for BS
and Sec 6.5.1(38.521) for
UE

The Occupied Bandwidth measures the bandwidth within which 99% of the power
transmitted within the measurement bandwidth falls.

EVM Sec 6.5.2 for BS and Sec
6.4.2 for UE

An EVM will give the variation of an EVM over the OFDM symbols. Trace can be
selected between RMS and Peak.

PVT Sec 6.3.3 for UE It measures the time domain power dynamics of the NR signal. This
measurement is also known as Transmit ON-OFF Time Mask measurement.

How to avoid false triggering of 5G NR signals on RSA5100B instrument
When you keep the RSA5100B in the continuous acquisition mode, it misses triggering at the rising edges so to avoid this false triggering,
follow the procedure given below:

1. Start the Tek RSA5100B application.
2. On the Quick Access Toolbar, click the Trigger icon.

3. On the Trigger settings panel, click the Advanced tab.
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4. Select the Holdoff checkbox and enter the Holdoff time.

Note: The holdoff time should be higher than the Burst time. For ex. If the Burst time is 10 ms then the Holdoff time must be
11 ms.

5GNR Standards Preset Test Setups
Presets > Standards

The 5GNR Standards preset allows you to access displays preconfigured for the selected test setup. The test setups load the displays and
control setting options suggested by the 5GNR standard to perform the measurements.

There are seven test setups for 5GNR:

Table 28: Test setup presets

Preset name Preset image
Modulation Accuracy

Table continued…
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Preset name Preset image
ACP

CHP

Table continued…
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Preset name Preset image
SEM

OBW

Table continued…
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Preset name Preset image
EVM

PVT
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The following table lists the default configurations loaded with each test setup.

Table 29: 5GNR Preset test setups

Test setup Displays loaded with preset
Modulation accuracy Link Direction:

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Constellation
• NR Summary

Number of Component Carrier: 1, 2, 3, 4, 5, 6, 7, and
8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

Sub Carrier Spacing: 15, 30, 60, and 120 kHz

(Default is 30 kHz)

ACP Link Direction:

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Summary
• NR Adjacent Channel Power

Number of Component Carrier: 1, 2, 3, 4, 5, 6, 7, and
8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

Table continued…
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Test setup Displays loaded with preset
CHP Link Direction:

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Summary
• NR Channel Power

Number of Component Carrier: 1, 2, 3, 4, 5, 6, 7, and
8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

SEM Link Direction:

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Summary
• NR Spectral Emission Mask

Number of Component Carrier: 1, 2, 3, 4, 5, 6, 7, and
8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

OBW Link Direction:

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR Summary
• NR Occupied Bandwidth

Number of Component Carrier: 1, 2, 3, 4, 5, 6, 7, and
8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

Table continued…
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Test setup Displays loaded with preset
EVM Link Direction:

• Uplink
• Downlink

(Default is Uplink)

• Spectrum
• Time Overview
• NR EVM

Number of Component Carrier: 1, 2, 3, 4, 5, 6, 7, and
8

(Default is 1)

Channel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,
70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

Sub Carrier Spacing: 15, 30, 60, and 120 kHz

(Default is 30 kHz)

PVT Number of Component Carrier: 1, 2, 3, 4, 5, 6, 7, and
8

(Default is 1)

• Spectrum
• Time Overview
• NR Summary
• NR Power Vs TimeChannel Bandwidth: 5, 10, 15, 20, 25, 30, 40, 50, 60,

70, 80, 90, 100, 200, and 400 MHz

(Default is 100 MHz)

Sub Carrier Spacing: 15, 30, 60, and 120 kHz

(Default is 30 kHz)

Retain current Center Frequency and Ref Level settings
The Retain current Center Frequency setting appears when the 5GNR Standards Preset is selected. Select the check box to retain the
previously used center frequency. By default, the Center Frequency settings box is unchecked.

The Retain current Ref Level setting appears when the 5GNR Standards Preset is selected. Select the check box to retain the
previously used reference level. By default, the Ref Level settings box is checked.

To activate these settings, select the check box next to the desired setting. The following image shows the Retain current Ref Level
setting box is selected.
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5GNR Displays
The displays in 5GNR Analysis (Setup > Displays > Measurements: 5GNR Analysis) are:

1. NR Adjacent Channel Power
2. NR Channel Power
3. NR Constellation
4. NR Spectral Emission Mask
5. NR Occupied Bandwidth
6. NR EVM
7. NR Power vs Time
8. NR Summary

5GNR Status Messages
The following status messages may appear. Each message indicates the related condition (Description) shown in the following table.

Status message Description
Analysis failure Signal analysis has failed.
Analyzing Signal analysis is in progress.
Stopped Acquisition/Analysis stopped.
Acquiring Signal acquisition is in progress.
Transfer IQ data is being transferred.
Setup error Configuration settings error.
Acq BW too small for the current setup Bandwidth/Span lower than expected.
Analysis length too small for the current setup Insufficient data.
Trigger position is before the analysis window The analysis window in the "Time Overview" display does not

include the trigger position.
Insufficient Span or Incorrect Data for Analysis ACP display expects additional span or the data is incorrect.
Table continued…

5GNR Analysis

RSA5100B Series Real-Time Signal Analyzers Help 483



Status message Description
Cell ID Detected Cell ID detected for the Downlink 5GNR waveform in the

"Constellation" display.
Not enough samples for the current setup The current configuration expects more samples.
Analysis failure : Invalid Result Signal analysis has failed and results are invalid.
Analysis failure : Insufficient BW. Required BW : <x> Signal analysis has failed due to insufficient bandwidth. The

required bandwidth is denoted by the value in <x>.
Analysis failure : Trigger position is before analysis window Signal analysis has failed due to the trigger position not available

within the analysis window.
Analysis failure : Downlink measurement currently unsupported Signal analysis has failed as the PVT measurement currently

doesn't support downlink signals.
Analysis failure : Not enough data before trigger, requires: <x> data
before trigger

Signal analysis has failed as the PVT measurement expects <x>
time of data before the trigger.

Analysis failure : Invalid Configuration Signal analysis has failed as there was an incorrect configuration.
Analysis failure : Insufficient Span or Incorrect Data for Analysis Signal analysis has failed due to incorrect data or insufficient span.
Setup error No channels defined Configuration settings error indicating that there are no adjacent

channels or offsets defined.
Setup error Channels cannot overlap Configuration settings error indicating that there are adjacent

channels or offset that overlap each other.
Setup error Channel BW too wide for hardware Configuration settings error indicating that the bandwidth

requirements are not supported by hardware.
Setup error : Channel BW too wide for hardware, required BW =
<x> including RBW

Configuration settings error indicating that the bandwidth
requirements are not supported by hardware. The value in
<x> determines the required bandwidth, including the resolution
bandwidth.

RBW limited by Acq BW to <x> The actual RBW achieved is less than requested, because the user
requested RBW is too large compared to the current acquisition
span for the measurement. The final RBW value is denoted by <x>.

NR Adjacent Channel Power Display
The NR Adjacent Channel Power (ACP) display shows the power leakage from the carrier channels into the neighboring frequency
channels, known as offset channels.

To view the NR ACP display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click . This moves the NR Adjacent Channel Power icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.
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Elements of the display
The following image shows the NR ACP display.

Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Plot Displays the reference channel(s) and adjacent channel(s) and the regions in between

them. The Absolute and Relative limit lines are also shown. The integrated power is
shown as a band. Scalar results are also shown.

3 Span Adjust the span of the graph in symbols.
4 Results table Tabulates the results in each adjacent band. The table shows the offset, bandwidth,

Integrated Absolute and Relative power in the upper and lower adjacent channel
regions.

5 CF Center Frequency at which the measurement is performed.
6 rel Opens relative adjacent channel power color palette.
7 Total Agg Power Displays the total aggregated power of all subblocks.
8 Autoscale Adjusts the adjacent channel power magnitude and frequency scale settings so that

the entire trace fits in the graph.
9 Lower limit in the display graph Displays the lower limit of the channel power in the graph.
10 dB/div Shows the dB per each division in the vertical axis of the plot.
Table continued…
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Item Display element Description
11 Units of adjacent channel power Sets the global Amplitude units for all the views in the analysis window. This will

change the amplitude selection in the Units tab of the Amplitude control panel.
12 Upper limit of the display graph Displays the upper limit of the channel power in the graph.

NR Adjacent Channel Power Display Settings
Main menu bar: Setup > Settings

Front Panel: Settings

Favorites toolbar: 

The NR Adjacent Channel Power display settings control panel allows you to configure the settings of the NR adjacent channel power
display.

Settings tab Description
ACP Allows you to configure the ACP-specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Prefs Allows you to configure settings required to show/hide graticule, marker readouts, and readouts.

NR Channel Power Display
The NR Channel Power display shows the spectrum of the input signal across one channel. The channel power measures the RMS power
in the carrier channel in dBm. Other units can be selected from the Units tab of the Analysis control panel. 

To view the NR Channel Power display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click . This moves the NR Channel Power icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the display
The following image shows the NR Channel power display.
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Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Span Adjust the frequency span of the graph in symbols.
3 Results table Displays each component carrier’s absolute and relative channel power.
4 CF Center Frequency at which the measurement is performed.
5 rel Opens relative channel power color palette
6 abs Opens absolute channel power color palette
7 Total Agg Power Displays total aggregated power of all the subblocks.
8 Autoscale Adjusts the channel power magnitude and frequency scale settings so that the entire trace

fits in the graph.
9 Lower Limit in the display

graph
Displays the lower limit of the channel power in the graph

10 dB / div Shows the channel power per division in the vertical axis of the plot.
11 Units for Channel Power Sets the global Amplitude units for all the views in the analysis window. This will change the

amplitude selection in the Units tab of the Amplitude control panel.
12 Upper Limit in the display

graph
Displays the upper limit of the channel power in the graph

13 Rel power level Displays the relative power level as a horizontal line in the user-selected color from the
palette

14 Abs power level Displays the absolute power level as a horizontal line in the user-selected color from the
palette

NR Channel Power Display Settings
Main menu bar: Setup > Settings

Front Panel: Settings

5GNR Analysis

RSA5100B Series Real-Time Signal Analyzers Help 487



Favorites toolbar: 

The NR Channel Power display control panel allows you to configure the settings of the NR Channel power display.

Settings tab Description
CHP Allows you to configure the CHP specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Prefs Allows you to configure settings required to show/hide graticule, marker readouts, and

readouts.

NR Constellation Display
Displays the demodulated and equalized OFDM subcarrier symbols. The same display area is shared for plotting Data (PUSCH/PDSCH)
and DMRS. The plot at a single instance shows a constellation graph for a single component carrier. You can select between different
component carriers.

To view the NR Constellation display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click . This moves the NR Constellation icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the Display
The following image shows the NR Constellation display.
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Item Display element Description
1 Scalar results Displays the selected component carriers Cell ID, Frequency Error, and EVM.
2 Plot Displays data (PUSCH / PDSCH) and DMRS.

NR Constellation Display Settings
Main menu bar: Setup > Settings

Front Panel: Settings

Favorites toolbar: 

The NR Constellation display control panel allows you to configure the settings of the NR Constellation display.

Settings tab Description
Modulation Accuracy Allows you to configure the modulation accuracy-specific properties.
Estimation Allows you to configure the modulation accuracy Estimation properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Traces Allows you to set the display characteristics of the traces.
Prefs Allows you to show/hide graticule and marker readouts.

NR Spectral Emission Mask display
The NR Spectral Emission Mask (SEM) display shows the margin of the emission level from the limit and reports the measurement status.
Spectral emission mask measurements measure out-of-band emissions in the neighboring bands of the carrier.

To view the NR SEM display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click  . This moves the NR Spectral Emission Mask icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the display
The following image shows the NR SEM display.
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Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Scale Adjusts the frequency span of the graph.
3 Results table Displays the spectral emission mask results.
4 rel Displays the relative power SEM color palette
5 abs Displays the absolute power SEM color palette
6 Total Agg Power Displays the total aggregated power of all subblocks
7 Autoscale Adjusts the channel power magnitude and frequency scale settings so that the entire trace

fits in the graph.
8 Lower limit in the display

graph
Displays the lower limit in the graph.

Table continued…
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Item Display element Description
9 dB/div Displays the channel power per division in the vertical axis of the plot.
10 Units Sets the global amplitude units for all the views in the analysis window. This will change the

amplitude selection in the units tab of the amplitude control panel.
11 Upper limit in the display

graph
Displays the upper limit in the graph.

12 Pass/Fail Indicates Pass or Fail based on absolute and relative limits set by the user. The failure
condition is set by mask in the settings control panel.

13 Pass/Fail % Gives Pass/Fail offset regions to total offset regions in terms of percentage
14 Plot Shows the spectral emission offsets, masks, and the power in the offset region. The

absolute limit lines are also shown.
15 Pos Position in the frequency domain at which the measurement is performed.
16 Limit line (Blue in the plot) Displays the mask limit lines for the SEM measurement.

NR Spectral Emission Mask Display Settings
Main menu bar: Setup > Settings

Front Panel: Settings

Favorites toolbar: 

The NR Spectral Emission Mask display control panel allows you to configure the settings of the NR Spectral Emission Mask display.

Settings tab Description
SEM Allows you to configure SEM specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Prefs Allows you to configure settings required to show/hide graticule, marker readouts, and

readouts.

NR Occupied Bandwidth Display
The NR OBW display shows the bandwidth in which 99% of the power transmitted within the measurement bandwidth falls.

To view the NR OBW display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click  . This moves the NR Occupied Bandwidth icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
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8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the display
The following image shows the NR OBW display.

Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Plot Displays Start Frequency and Stop Frequency of the occupied bandwidth.
3 Scale Adjusts the frequency span of the graph.
4 Absolute Power Displays the absolute power value.
5 Occupied Bandwidth Displays the occupied bandwidth value.
6 Pos Position in the center frequency at which measurement is performed.
7 Stop Frequency Displays the Stop Frequency value.
8 Start Frequency Displays the Start Frequency value.
9 freq Displays the frequency color palette.
10 Autoscale Adjusts the channel power magnitude and frequency scale settings so that the entire trace

fits in the graph.
11 dB/div Displays the channel power per division in the vertical axis of the plot.
12 Units Sets the global amplitude units for all the views in the analysis window. This will change the

amplitude selection in the units tab of the amplitude control panel.
13 Pass/Fail Displays the result (Pass or Fail) based on the limit set in the OBW settings tab.
14 Start Frequency Indicator Line Displays the Start Frequency line.
15 Stop Frequency Indicator Line Displays the Stop Frequency line.
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NR Occupied Bandwidth Display Settings
Main menu bar: Setup > Settings

Front Panel: Settings

Favorites toolbar: 

The NR Occupied Bandwidth display control panel provides access to settings that control parameters of the NR Occupied Bandwidth
display.

Settings tab Description
OBW Allows you to configure the OBW specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Prefs Allows you to configure settings required to show/hide graticule, marker readouts, and readouts.

NR EVM Display
The NR EVM displays the variation of an EVM over the OFDM symbol. Trace can be selected between RMS and Peak. Here EVM can
either be the Peak value of EVM for each symbol or the RMS of each Symbol.

To view the NR EVM display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click  . This moves the NR EVM icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the display
The following image shows the NR EVM display.

5GNR Analysis

RSA5100B Series Real-Time Signal Analyzers Help 493



Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Plot Displays the data symbol’s EVM values versus symbol.
3 Stop symbol Displays the stop symbol value.
4 @Symbol Displays the symbol index at which the peak EVM occurred out of the entire set of symbols

within the defined measurement length.
5 Peak Displays the maximum value of peak EVMs calculated over measurement length.
6 RMS Displays the mean value of RMS EVMs calculated over measurement length.
7 Selected Trace Results Displays selected trace results.
8 Start symbol Displays the start symbol value.
9 Autoscale Adjusts the channel power magnitude and frequency scale settings so that the entire trace

fits in the graph.
10 Position Position in the frequency domain at which measurement is performed.
11 Peak EVM Displays the peak EVM value.
12 CC Index Displays the selected CC index.

Available values: Depends on number of CCs.

13 Trace drawing Allows to select the trace drawing mode.

Available values: Vectors and Points.

14 Trace selection Allows to select trace selection.

Available values: RMS EVM Per Symbol Mean Trace, Peak EVM Per Symbol Maximum
Trace
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NR EVM Settings
Main menu bar: Setup > Settings

Front Panel: Settings

Favorites toolbar: 

The NR EVM display control panel provides access to settings that control parameters of the NR EVM display.

Settings tab Description
Modulation Accuracy Allows you to configure the modulation accuracy-specific properties.
Estimation Allows you to configure the modulation accuracy Estimation properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Prefs Allows you to configure settings required to show/hide graticule, marker readouts, and

readouts.

NR Power vs Time Display
The NR Power vs Time display shows the signal power amplitude versus time.

To view the NR Power vs Time display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click  . This moves the NR Power vs Time icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the display
The following image shows the NR Power vs Time display.
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Item Display element Description
1 Clear Resets the measurement and clears all the values.
2 Plot Displays the signal power amplitude versus time.
3 Scale Adjust the span of the graph.
4 Burst width level Displays the burst width as a horizontal line.
5 Burst Width Displays burst width value.
6 Abs On Power Displays absolute on power value.
7 Position Position in the frequency domain at which measurement is performed.
8 Abs Off Power After Displays absolute off power after value.
9 Abs Off Power Before Displays absolute off power before value.
10 Autoscale Adjusts the channel power magnitude and frequency scale settings so that the entire trace

fits in the graph.
11 dB/div Displays the channel power per division in the vertical axis of the plot.
12 Units Sets the global amplitude units for all the views in the analysis window. This will change the

amplitude selection in the units tab of the amplitude control panel.
13 Pass/Fail Displays the result (Pass or Fail) based on absolute and relative limits set.
14 Limit Trace Displays the transmit ON/OFF time mask.

NR Power vs Time Settings
Main menu bar: Setup > Settings

Favorites toolbar: 

The NR Power vs Time display control panel provides access to settings that control parameters of the NR Power vs Time display.
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Settings tab Description
PVT Allows you to configure the PVT specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Prefs Allows you to configure settings required to show/hide graticule, marker readouts, and readouts.

NR Summary Display
Consolidated display of all the results from selected measurements like Modulation Accuracy, CHP, SEM, ACP, OBW and PVT. It provides
an option to save all the results to a “.csv” file. Additional results related to the Modulation Accuracy measurement are available here.

To show the NR Summary display:

1. Select File > Recall to analyze a stored data file or go to the next step.
2. Select Setup > Displays.
3. In the Select Displays window, select 5GNR Analysis in the Measurements box.

4. In the Available displays box, double-click . This moves the NR Summary icon to the selected displays box.
5. Click OK to view the display.
6. Select Setup > Settings to display the control panel.
7. Select Replay/Run to take measurements on the acquired data.
8. If you are analyzing a data file, click Replay to take measurements on the recalled acquisition data file.

Elements of the display

The following images show the NR Summary display.
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Summary view for Modulation Accuracy:

Item Display element Description
1 Number of component

carriers
Displays the number of component carriers.

2 Link direction Displays the link direction.
3 Results table Displays the modulation accuracy results.

Summary view for CHP:
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Item Display element Description
1 Total Agg Power Displays the total aggregated power.
2 Results table Displays the CHP results.

Summary view for ACP:

Item Display element Description
1 Number of NR Offsets Displays the number of NR Offsets.
2 Total Agg Power Displays the total aggregated power.
3 Results table Displays the ACP results.
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Summary view for SEM:

Item Display element Description
1 Pass/Fail Displays Pass/Fail result based on absolute and relative limits set by the user.
2 Total Agg Power Displays the total aggregated power.
3 Results table Displays the SEM results.

Summary view for OBW:
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Item Display element Description
1 Occupied Bandwidth Returns the bandwidth that occupies the specified percentage of the total power of the

signal. This value is expressed in Hz.
2 Absolute Power Returns the total power measured in the spectrum acquired by the measurement. This

value is expressed in dBm.
3 Start Frequency Returns the Start Frequency of the occupied bandwidth of carrier/subblock. This value is

expressed in Hz.
4 Stop Frequency Returns the Stop Frequency of the occupied bandwidth of carrier/subblock. This value is

expressed in Hz.

Summary view for PVT:

Item Display element Description
1 Measurement Status Returns the measurement status indicating whether the off power before and after is within

the standard defined limit.
2 Absolute OFF Power Before Returns the OFF power in the segment before the captured burst. The segment is defined

as one slot prior to a short transient segment and the burst. This value is expressed in
dBm.

3 Absolute OFF Power After Returns the OFF power in the segment after the captured burst. The segment is defined as
one slot after the burst and a short transient segment. This value is expressed in dBm.

4 Absolute ON Power Returns the power of the slots within the captured burst. This value is expressed in dBm.
5 Burst Width Returns the width of the captured burst. This value is expressed in seconds.

NR Summary Display Settings
Main menu bar: Setup > Settings

Front Panel: Settings
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Favorites toolbar: 

The NR Summary display control panel allows you to configure the settings of the NR Summary display.

Settings tab Description
Modulation Accuracy Allows you to configure the modulation accuracy-specific properties.
ACP Allows you to configure the ACP-specific properties.
CHP Allows you to configure the CHP specific properties.
SEM Allows you to configure SEM specific properties.
OBW Allows you to configure the OBW specific properties.
PVT Allows you to configure the PVT specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.

NR Analysis Measurement Settings
Main menu bar: Setup > Settings

Front Panel: Settings

Favorites toolbar: 

The control panel tabs in this section are shared between the displays in 5GNR Analysis (Setup > Displays). Some tabs are shared by
all the displays and some tabs are shared by only a subset of displays. The settings available on some tabs change depending on the
selected display.

Controls for 5GNR Analysis displays

Settings tab Description
Modulation Accuracy Allows you to configure the modulation accuracy-specific properties.
ACP Allows you to configure the ACP-specific properties.
CHP Allows you to configure the CHP specific properties.
SEM Allows you to configure SEM specific properties.
OBW Allows you to configure the OBW specific properties.
PVT Allows you to configure the PVT specific properties.
Signal Configuration Allows you to configure the signal properties.
Subblock Configuration Allows you to configure the properties needed to analyze a subblock in 5GNR signal.
Carrier Configuration Allows you to configure the carrier properties.
Averaging Allows you to configure the averaging parameters.
Traces Allows you to set the display characteristics of the traces.

Available for the NR Constellation display only.

Prefs Allows you to configure settings required to show/hide graticule, marker readouts, and
readouts.
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ACP Tab
The ACP tab allows you to configure the settings required for the adjacent channel power measurement.

The following image is of the ACP tab for the NR adjacent channel power display.

Setting Available options Description
Sweep Time 1 zs to 20 ms Specifies the sweep time or the total analysis time for the ACP measurement.

To manually specify the sweep time, uncheck Auto.

Default value: 1.000 ms

FFT Window Specifies the Fast Fourier Transform (FFT) window method.

Default value: None

None No FFT window.

• Flat Top
• Hanning
• Hamming
• Gaussian
• Blackman
• Blackman-Harris
• Kaiser-Bessel

Select reduce spectral leakage.

NR Offset 0, 1, 2, 3, 4, 5, 6 Specifies the number of offsets to be displayed and ACP measurement to be run.

Default value: 2

Resolution Bandwidth
RBW Displays the Resolution Bandwidth (RBW) for NR measurements.

To manually specify the RBW, uncheck Auto.

Default value: 30 kHz

RBW Filter Specifies the RBW filter method used for the transform.

Default value: FFT Based

Flat Specifies the RBW filter with a flat response.
FFT Based No RBW filtering is performed.
Gaussian Specifies the RBW filter with a gaussian response.

Signal Configuration Tab
The Signal Configuration tab allows you to configure the signal settings like link direction and transmitter architecture required for the
5GNR measurements. In downlink mode, it allows you to select the mode and the gNodeB category.
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The following image is of the Signal Configuration tab available for the NR adjacent channel power, NR channel power, NR constellation,
NR spectral emission mask, and NR summary displays.

Setting Available options Description
Link Direction Specifies the Link Direction of the signal. You can set to Uplink or Downlink

depending on the signal type.

Default value: Uplink

Uplink Unidirectional radio link for the transmission of signals from the user equipment to
a base station, from a mobile station to a mobile base station, or from a mobile
base station to a base station.

Downlink Unidirectional radio link for the transmission of signals from a base station to user
equipment. Also, in general, the direction from network to user equipment.

Downlink
Mode Specifies downlink channel configuration mode.

Default value: Test Model

Test Model A test model needs to be selected that will configure all the signals and channels
automatically according to the specifications.

User Defined Select to manually configure the signals, subblocks, and channels.
gNodeB Category A - Wide Area BS Specifies the Downlink gNodeB category

Default value: A - Wide Area BS

B (Option 1) - Wide Area
BS

The gNodeB type is Wide Area Base Station - Category B Option1.

B (Option 2) - Wide Area
BS

The gNodeB type is Wide Area Base Station - Category B Option2.

Local Area BS The gNodeB type is Local Area Base Station.
Medium Range BS The gNodeB type is Medium Range Base Station.

Transmitter Architecture Specifies the RF architecture at the transmitter in case of multi-carrier. Each
carrier can have a separate Local Oscillator (LO) or one common for the entire
subblock.

Default value: Lo Per Component Carrier

Lo Per Component Carrier Local oscillator per component carrier.
Lo Per SubBlock Local oscillator per subblock.

Subblock Configuration Tab
The Subblock Configuration tab allows you to analyze a subblock in 5GNR signal.
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The following image is of the Subblock Configuration tab available for the NR adjacent channel power, NR channel power, NR
constellation, NR spectral emission mask, and NR summary displays.

Setting Available options Description
Frequency Range Specifies whether to use band, channel bandwidth, and subcarrier spacing

configuration supported in the frequency range 1 or the frequency range 2.

Default value: Range 1

Range 1 The measurement uses the band, channel bandwidth, and the subcarrier spacing
configuration supported in frequency range 1.

Range2 The measurement uses the band, channel bandwidth, and the subcarrier spacing
configuration supported in frequency range 2.

Band Specifies the E-UTRA or NR operating frequency of a subblock. The band
determines the spectral flatness mask and spectral emission mask.

Default value: 78

1, 2, 3, 5, 7, 8, 12, 20, 25,
28, 34, 38, 39, 40, 41, 50,
51, 66, 70, 71, 74, 75, 76,
77, 78, 79, 80, 81, 82, 83,
84, and 86

Bands supported for frequency range 1

257, 258, 260, and 261 Bands supported for frequency range 2
Number of Component
Carriers

Specifies the number of component carriers in a subblock.

Default value: 1

1 Set to 1 for a single carrier.
2 to 8 Number of component carriers in a subblock (greater than 2 for multiple

component carriers in a subblock)
Channel Raster 15 kHz, 60 kHz, 100 kHz Specifies the subblock channel raster which is used for computing nominal

spacing between aggregated carriers. The value is expressed in Hz. The channel
raster defines a subset of RF reference frequencies that can be used to identify
the RF channel position in the uplink and downlink. The RF reference frequency
for an RF channel maps to a resource element on the carrier.

Default value: 15 kHz

Detect All Cell ID’s Select to detect all carrier's cell id.

This is enabled when Link direction is set as Downlink and Downlink configuration
mode is set to User Defined.
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Carrier Configuration Tab
The Carrier Configuration tab allows you to configure the component carrier settings of the 5GNR signal. Each component carrier is
represented by its row in the table. The corresponding PDSCH/PUSCH configurations are available through a button click at the right side
of the table.

The following image is of the Carrier Configuration tab available for the NR adjacent channel power, NR channel power, NR constellation,
NR spectral emission mask, NR Power vs Time, NR Occupied Bandwidth, NR EVM, and NR summary displays.

Setting Available options Description
Select Allows to select the component carrier, which helps to :

• Configure all component carriers with the selected component carrier configurations.
• Detect selected component carrier Cell ID.
• Configure parameters related to PUSCH/PDSCH for selected component carriers.

Component carrier Specifies which component carrier is being configured.
Bandwidth Specifies component carrier’s channel bandwidth.

Default value: 100MHz

Available values in MHz for Range 1: 5, 10, 15, 20, 25, 30, 40, 50, 60, 70, 80, 90, 100

Available values in MHz for Range 2: 50, 100, 200, 400

Frequency Offset Specifies the offset of the component carrier from the subblock center frequency.

Default value: 0

Test Model Specifies the NR downlink test models.

This can be configured when the Link direction is Downlink and Downlink configuration
mode is set to Test model.

Default value: TM1.1

Available values: TM1.1, TM1.2, TM2, TM2a, TM3.1, TM3.1a, TM3.2, TM3.3

Duplex scheme Downlink FDD,
Downlink TDD

Specifies the duplexing technique of the signal being measured.

FDD refers to Frequency-Division duplexing.

TDD refers to Time-Division duplexing.

This can be configured when the Link direction is Downlink and Downlink configuration
mode is Test model.

Default value: Downlink FDD

Cell ID 0 to 1007 Specifies the physical layer cell identity.

This can be configured when Auto calculation cell ID is deselected.

Default value: 0

Table continued…
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Setting Available options Description
Reference grid Subcarrier spacing Specifies the subcarrier spacing of the reference resource grid. This should be the largest

subcarrier spacing used in the component carrier.

Default value: 30 kHz

Available values for Range 1: 15 kHz, 30 kHz, 60 kHz

Available values for Range 2: 60 kHz and 120 kHz

Start Default value: 0

Available values: 0 to 275

Bandwidth part Subcarrier spacing Default value: 30kHz

Available values for Range1: 15 kHz, 30 kHz, 60 kHz

Available values for Range 2: 60 kHz and 120 kHz

cyclic prefix Specifies the cyclic prefix (CP) duration and the number of symbols in a slot for the signal
being measured.

Default value: Normal

Available values: Normal

Bandwidth part Grid
start

Specifies the resource grid starts relative to reference point A in terms of resource block
offset.

Default value: 0

RB offset Specifies the resource block offset of a bandwidth part relative to the resource grid start the
property.

Default value: 0

RBs Specifies the number of consecutive resource blocks in a bandwidth part.

Default value: 0

Auto Calculation Deselection of any of these parameters enables manual mode which allows to configure
them manually.

Cell ID Deselect to configure the cell ID manually.
Frequency Deselect to configure the Frequency manually.
Reference Grid Deselect to manually configure the Reference Grid Subcarrier spacing and Reference Grid

Start values.
Resource Block Deselect to manually configure the RB offset and RBs values.

Expand Click to view the table in a separate window. You can also configure the table.
PDSCH Click to configure the PDSCH parameters.

PDSCH button is enabled when link direction is selected as Downlink.

PUSCH Click to configure the PUSCH parameters.

PUSCH button is enabled when link direction is selected as Uplink.

Detect All Cell ID’s Select to manually identify the Cell ID of the signal.

This button is enabled when link direction is configured as Downlink and Downlink.

Table continued…
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Setting Available options Description
Apply for All CC Click to apply all the selected component carrier to all component carriers, except the Cell

ID.

Physical Uplink Shared Channel for Component Carrier 1 Window
The Physical Uplink Shared Channel for Component Carrier 1 Window allows you to configure the PUSCH settings for the selected
component carrier. The DMRS and PTRS settings related to the corresponding PUSCH are also configurable through this window.

The following image is of the Physical Uplink Shared Channel for Component Carrier 1 Window available in the carrier configuration
tab.

5GNR Analysis

RSA5100B Series Real-Time Signal Analyzers Help 508



Setting Available options Description
Modulation Type Specifies the modulation scheme used in the physical uplink shared channel

(PUSCH) of the signal being measured.

Default value: QAM256

PI/2 BPSK,

QPSK,

QAM16,

QAM64,

QAM256,

QAM1024

Specifies a PI/2 BPSK modulation scheme.

Specifies a QPSK modulation scheme.

Specifies a 16 QAM modulation scheme.

Specifies a 64 QAM modulation scheme.

Specifies a 256 QAM modulation scheme.

Specifies a 1024 QAM modulation scheme.

Symbol Allocation 1:14 Specifies the symbol allocation of each slot.

Valid values are from 1 to 14, inclusive.

The format is defined by range format specifiers. The range format specifier is a
comma separated list of entries.

Note: If incorrent value is entered in symbol allocation, the value will be
highlighed in red color

Examples:

2,4 will expand to {2,4}

1:3,7 will expand to {1,2,3,7}.

To manually specify the symbol allocation, uncheck All.

Slot Allocation 1:20 Specifies the slot allocation in NR Frame. This defines the indices of the allocated
slots.

Valid values are from 1 to maximum number of slots in the frame max number of
slots is dependent on numerology within the specifications

The format is defined by range format specifiers. The range format specifier is a
comma-separated list of entries.

Note: If incorrent value is entered in slot allocation, the value will be
highlighed in red color

Examples:

2,4 will expand to {2,4}

1:3,7 will expand to {1,2,3,7}.

To manually specify the slot allocation, uncheck All.

DMRS (Release 16)
Table continued…
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Setting Available options Description
Power Mode Specifies whether the value of PUSCH DMRS Pwr property is calculated based

on the PUSCH DMRS number of CDM Groups value or specified by the user
(user-defined).

Select to calculate the PUSH DRMS Pwr value based on PUSCH DMRS number
of CDM Groups value or by user-defined method.

Default value: CDM

User Defined Specifies the DMRS power manually.
Antenna Ports Specifies the antenna ports used for DMRS transmission.
Power Specifies the factor which boosts the PUSCH DMRS REs. This value is

expressed in dB. This property is ignored if you set the “Power Mode” value
to CDM Groups.

Number of CDM Groups Specifies the number of CDM groups, when you set the PUSCH “Transform
Precoding” value to False, otherwise, it is set to 2.

Mapping
Configuration Type Specifies the DMRS configuration type.

Default value: Type 1

• Type 1
• Type 2

• One DMRS subcarrier alternates with one data subcarrier.
• Two consecutive DMRS subcarriers alternate with four consecutive data

subcarriers.

Duration Specifies whether the DMRS is single-symbol or double-symbol..

Default value: Single Symbol

Single Symbol There are one or more non-consecutive DMRS symbols in a slot.
Double Symbol There are one or more sets of two consecutive DMRS symbols in the slot.

Type A Position 2,3 Specifies the position of the first DMRS symbol in a slot when you set the PUSCH
"Mapping Type" value to Type A.

2: The first DMRS symbol index in a slot is 2.

3: The first DMRS symbol index in a slot is 3.

Additional Positions Specifies the number of additional sets of consecutive DMRS symbols in a slot.

Default value: 0

0,1,2,3 0: No additional DMRS symbol set is present in the slot.

1: One additional DMRS symbol set is present in the slot.

2: Two additional DMRS symbol sets are present in the slot.

3: Three additional DMRS symbol sets are present in the slot.

Table continued…
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Setting Available options Description
Mapping Type Specifies the mapping type of DMRS.

Default value: Type A

Type A The first DMRS symbol index in a slot is either 2 or 3 based on PUSCH DMRS
"Type A Position" value.

Type B The first DMRS symbol index in a slot is the first active PUSCH symbol.
Scrambling
Mode Specifies whether the configured Scrambling ID is honored or the Cell ID is used

for reference signal generation.

Default value: Cell ID

Cell ID The value of the PUSCH DMRS Scrambling ID is based on the Cell ID property.
User Defined Select this to configure the Scrambling ID manually.

Identity 0 to 65535 Specifies the value of scrambling ID. This property is valid only when you set the
PUSCH "Transform Precoding" value to False.

Initialization Specifies the DMRS nSCID used for reference signal generation.
Transform Precoding Enable or disable Transform precoding configurations.
Group Hopping Specifies whether the group hopping is enabled. This parameter is valid only

when you set the PUSCH "Transform Precoding" value is set to True.
Sequence Hopping Enable or disable Sequence hopping.
PUSCH ID Mode Specifies whether PUSCH DMRS PUSCH ID is based on Cell ID or user-defined.

This parameter is valid only when you set the PUSCH "Transform Precoding"
value is set to True.

Default value: Cell ID

Cell Id The value of PUSCH DMRS PUSCH ID is based on the Cell ID property.
User Defined The value of the PUSCH DMRS PUSCH ID is specified by the user.

User Defined ID 0 to 1007 Specifies the value of PUSCH DMRS PUSCH ID used for reference signal
generation. This property is valid only when you set the PUSCH "Transform
Precoding" value to True and PUSCH DMRS "PUSCH ID Mode" value to User
Defined.

PTRS Enable or disable PTRS.
Power Mode Standard, User Defined Specifies the DMRS antenna ports associated with PTRS transmission. This

property is valid only if you set the PTRS Enabled property to True.

Default value: Standard

Power Specifies the factor by which the PUSCH PTRS REs are boosted. This value is
expressed in dB. This property is valid only if you set the PTRS Enabled property
to True.

Antenna Ports Specifies the DMRS antenna ports associated with PTRS transmission. This
property is valid only if you set the PTRS Enabled property to True .

Mapping
Table continued…
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Setting Available options Description
Resource Element Offset 00, 01, 10, 11 Specifies the RE offset to be used for transmission of PTRS. This property is

valid only if you set the PTRS Enabled property to True and Transform Precoding
Enabled property to False.

Default Value: 00

Frequency Density 2, 4 Specifies the density of PTRS in frequency domain. This property is valid only if
you set the PTRS Enabled property to True and Transform Precoding Enabled
property to False.

Default Value: 2

Time Density 1, 2, 4 Specifies the density of PTRS in time domain. This property is valid only if you set
the PTRS Enabled property to True.

Default Value: 1

Transform Precoding Enable or disable Transform precoding configurations.
Group Number 2, 4, 8 Specifies the number of PTRS groups per OFDM symbol. This property is valid

only if you set the PTRS Enabled property to True and Transform Precoding
Enabled property to True.

Default Value: 2

Samples 2, 4 Specifies the number of samples per each PTRS group. This property is valid only
if you set the PTRS Enabled property to True and Transform Precoding Enabled
property to True.

Default Value: 2

Physical Downlink Shared Channel for Component Carrier 1 Window
The Physical Downlink Shared Channel for Component Carrier 1 Window allows you to configure the PDSCH settings for the selected
component carrier. The DMRS and PTRS settings related to the corresponding PDSCH are also configurable through this window.

The following image is of the Physical Downlink Shared Channel for Component Carrier 1 Window available in the carrier
configuration tab.
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Setting Available options Description
Modulation Type Specifies the modulation type used in the physical downlink shared channel

(PDSCH) channel of the signal being measured.

Default value: QAM256

QPSK,

QAM16,

QAM64,

QAM256,

QAM1024

Specifies a QPSK modulation scheme.

Specifies a 16 QAM modulation scheme.

Specifies a 64 QAM modulation scheme.

Specifies a 256 QAM modulation scheme.

Specifies a 1024 QAM modulation scheme.

Symbol Allocation 1:14 Specifies the symbol allocation of each slot.

To manually specify the symbol allocation, uncheck All.

Slot Allocation 1:20 Specifies the number of PDSCH slot configurations.

To manually specify the slot allocation , uncheck All.

DMRS (Release 16)
Power Mode CDM Specifies whether the DMRS power is calculated based on several CDM groups

or manually entered by a user

Default value: CDM

User Defined Specifies the DMRS power manually.
Table continued…
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Setting Available options Description
Antenna Ports Specifies the Antenna ports used for DMRS transmission.

Default value: 1000

Power Specifies the DMRS power.

Default value: 0

Number of CDM Groups Specifies the number of CDM groups.

Default value: 1

Mapping
Configuration Type Specifies the DMRS configuration type.

Default value: Type 1

• Type 1
• Type 2

• One DMRS subcarrier alternates with one data subcarrier.
• Two consecutive DMRS subcarriers alternate with four consecutive data

subcarriers.

Duration Specifies whether the DMRS is a single symbol or double symbol.

Default value: Single Symbol

Single Symbol There are one or more non-consecutive DMRS symbols in a slot.
Double Symbol There are one or more sets of two consecutive DMRS symbols in the slot.

Type A Position Specifies the position of the first DMRS symbol in a slot for Type A configurations.

Default value: 2

Additional Positions 0 Specifies the number of additional sets of consecutive DMRS symbols in a slot.

Default value: 0

1,2,3 Different additional DMRS symbols are set in the slot.
Mapping Type Specifies the mapping type of DMRS.

Default value: Type A

Type A The first DMRS symbol index in a slot is either 2 or 3
Type B The first DMRS symbol index in a slot is 0.

Scrambling
Mode Cell ID Specifies the configured Scrambling ID is based on Cell ID or specified by the

user.

Default value: Cell ID

User Defined Select this to configure Scrambling ID manually.
Identity Specifies the scrambling ID used for reference signal generation.

Default value: 0

Table continued…
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Setting Available options Description
Initialization Specifies the DMRS nSCID used for reference signal generation.

Default value: 0

PTRS Enable or disable PTRS.
Power Mode Standard, User Defined Specifies whether the configured PTRS Power is calculated as per standard

specification or configured by you.

Default value: Standard

Energy per Resource
Element Ratio

0, 1 Specifies the EPRE Ratio Port used to determine the PDSCH PT-RS RE power
scaling when you set the PTRS Power Mode property to Standard.

Default Value: 0

Power Specifies the factor by which the PDSCH PTRS REs are boosted, compared to
PDSCH REs. This value is expressed in dB. The value of this property is taken
as an input when you set the Power Mode property to User Defined. If you set
the PDSCH PTRS Power Mode property to Standard, the value is computed from
other parameters.

Antenna Ports 1000 Specifies the DMRS Antenna Ports associated with PTRS transmission.
Mapping
Resource Element Offset 00, 01, 10, 11 Specifies the RE Offset to be used for transmission of PTRS.

Default Value: 00

Frequency Density 2, 4 Specifies the density of PTRS in frequency domain.

Default Value: 2

Time Density 1, 2, 4 Specifies the density of PTRS in time domain.

Default Value: 1

Averaging Tab
The Averaging tab allows you to configure the settings for averaging 5GNR measurements. The number of acquisitions and the averaging
type for different measurements (modulation accuracy is always mean) is configurable in this tab.

The following image is of the Averaging tab available for the NR adjacent channel power, NR channel power, NR constellation, NR spectral
emission mask, NR EVM, NR Occupied Bandwidth, NR Power vs Time, and NR summary displays.

Setting Available options Description
Averaging Specifies whether the averaging parameters are available to configure.
Table continued…
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Setting Available options Description
Count Specifies the number of acquisitions used for averaging.

Default value: 10

ACP Averaging Type Specifies the averaging type for averaging spectral acquisitions.

Default value: RMS

RMS Spectral acquisitions are averaged linearly.
Log Spectral acquisitions are averaged on a logarithmic scale.
Scalar Square root of spectral acquisitions is averaged.
Max The maximum power in the spectrum at each frequency bin is retained from one

acquisition to the next.
Min The lowest power in the spectrum at each frequency bin is retained from one

acquisition to the next.
CHP Averaging Type RMS,

Log,

Scalar,

Max,

Min

Specifies the averaging type for averaging spectral acquisitions.

Default value: RMS

SEM Averaging Type RMS,

Log,

Scalar,

Max,

Min

Specifies the averaging type for averaging spectral acquisitions.

Default value: RMS

OBW Averaging Type RMS,

Log,

Scalar,

Max,

Min

Specifies the averaging type for averaging spectral acquisitions.

Default value: RMS

PVT Averaging Type RMS,

Log

Specifies the averaging type for averaging spectral acquisitions.

Default value: RMS

ModACC Averaging Type Specifies the averaging type for averaging spectral acquisitions.

Default value: Mean

Prefs Tab
The Prefs tab allows you to configure settings required to show/hide graticule, marker readouts and readouts.
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The following image is of the Prefs tab available for the NR adjacent channel power, NR channel power, NR constellation, NR spectral
emission mask, NR EVM, NR Occupied Bandwidth, and NR Power vs Time displays.

Setting Available options Description
Show Graticule It controls the visibility of graticule in the plot.
Show Marker Readouts It controls the visibility of marker readouts in the plot.
Show Readouts It controls the visibility of readouts in the plot.

OBW Tab
The OBW tab allows you to configure the settings required for the occupied bandwidth measurement.

The following image shows the OBW tab for the NR Occupied Bandwidth display.

Setting Available options Description
Sweep Time To manually specify the Sweep Time, uncheck Auto.

Default Value: 1.000 ms

FFT Window None

Flat Top

Hanning,

Hamming,

Gaussian,

Blackman,

Blackman-Harris,

Kaiser-Bessel

Fast Fourier Transform (FFT) window type. Select to reduce the spectral leakage.

Default Value: None

Table continued…
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Setting Available options Description
Measurement Bandwidth Specifies the frequency range around the sub-block center frequency, which is

used to find the sub-block occupied bandwidth.

Default Value: 1.000 GHz

RBW Displays the Resolution Bandwidth (RBW) for NR measurements. To manually
specify the RBW, uncheck Auto.

Default Value: 30 kHz

RBW Filter Specifies the windowing method used for the transform.

Default Value: FFT Based

FFT Based No RBW filtering is being performed.
Gaussian Specifies the RBW filter with a gaussian response.
Flat Specifies the RBW filter with a flat response.

Limit To manually specify limit to check Pass/Fail condition of OBW measurement. If
‘Auto’ button checked OBW is compared if it is less than or equal to sub-block
bandwidth of the signal. If ‘Auto’ button unchecked user can give limit to compare
with OBW.

Default Value: 100 MHz

PVT Tab
The PVT tab allows you to configure the settings required for the Power Vs Time measurement.

The following image shows the PVT tab for the NR Power Vs Time display.

Setting Available options Description
Measurement Method Specifies the measurement method.

Default Value: Normal

Off Power Exclusion
Before

Specifies the time excluded from the Off region before the burst. The value is
expressed in seconds.

Default value: 0.00 us

Off Power Exclusion After Specifies the time excluded from the Off region after the burst. This value is
expressed in seconds.

Default value: 0.00 us

Table continued…
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Setting Available options Description
Apply Limit IT enables pass/fail result and limit trace.

CHP Tab
The CHP tab allows you to configure the settings required for the channel power measurement.

The following image shows the CHP tab for the NR channel power display.

Setting Available options Description
Sweep Time Specifies the sweep time or the total analysis time for the CHP measurement.

To manually specify the sweep time, uncheck Auto.

Default value: 1.000 ms

Integration BW Specifies the type of integration bandwidth to measure the power of the acquired
signal.

Default value: Signal Bandwidth

Signal Bandwidth Excludes the guard bands at the edges of the carrier or subblock.
Channel bandwidth Includes the guard bands at the edges of the carrier or subblock.

FFT Window Fast Fourier Transform (FFT) window. Specifies the FFT window type.

Default value: None

None No FFT window.
Flat Top, Hanning,
Hamming, Gaussian,
Blackman, Blackman-
Harris, Kaiser-Bessel

Select to reduce spectral leakage.

Resolution Bandwidth
RBW Displays the Resolution Bandwidth (RBW) for NR measurements.

To manually specify the RBW, uncheck Auto.

Default value: 30 kHz

Filter Specifies the RBW filter method used for the transform.

Default value: FFT Based

Flat Specifies the RBW filter with a flat response.
FFT Based No RBW filtering is being performed.
Gaussian Specifies the RBW filter with a gaussian response.
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SEM Tab
The SEM tab allows you to configure the settings required for the spectral emission mask measurement.

The following image is of the SEM tab for the NR spectrum emission mask display.

Setting Available options Description
Sweep Time Specifies the sweep time or the total analysis time for the SEM measurement.

To manually specify the sweep time, uncheck Auto.

Default value: 1.000 ms

FFT Window Fast Fourier Transform (FFT) window. Specifies the FFT window type.

Default value: None

None No FFT window.
Flat Top, Hanning,
Hamming, Gaussian,
Blackman, Blackman-
Harris, Kaiser-Bessel

Select to reduce spectral leakage.

Resolution Bandwidth
RBW Displays the Resolution Bandwidth (RBW) for SEM measurements.

To manually specify the RBW, uncheck Auto.

Default value: 30 kHz

Filter Specifies the RBW filter method used for the transform.

Default value: Gaussian

Flat Specifies the RBW filter with a flat response.
FFT Based No RBW filtering is being performed.
Gaussian Specifies the RBW filter with a gaussian response.

Mask Type
Table continued…
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Setting Available options Description
Uplink Specifies the spectrum emission mask used in the measurement when the link

direction is uplink.

Default value: General

NS_35,

NS_03,

NS_04,

NS_06,

NS_21

Selection of the different SEM masks as defined in specifications for uplink.

Custom Define a custom SEM mask for uplink.
Downlink Standard Specifies the spectrum emission mask used in the measurement when the link

direction is downlink.

Default value: Standard

Custom Define a custom SEM mask for downlink.
Maximum frequency
Deviation

Specifies the maximum frequency deviation of the offsets when the link direction
is downlink and downlink mask type is set to standard.

Default value: 15 MHz

Modulation Accuracy Tab
The Modulation Accuracy tab allows you to configure the settings needed to measure modulation accuracy. This tab contains important
parameters related to OFDM symbol demodulation and EVM computation.

The following image shows the Modulation Accuracy tab for the NR constellation and NR EVM display.

Setting Available options Description
Measurement
Unit Slot Specifies the units for measurement offset and measurement length. Slot: Length

and offset are specified in units of slots.

Default value: Slot

Time Measurement offset and measurement length are specified in seconds.
Length Measurement length in units specified by the unit property.

Default value: 1

Table continued…
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Setting Available options Description
Offset Measurement offset to skip from the synchronization boundary.

Default value: 0

FFT Window
Type Custom Specifies FFT window type used for EVM calculation. The FFT window offset is

used when set to custom, and the window length is set to 3GPP OFDM FFT size
internally.

Default value: Custom

3GPP The FFT window length is used when set to 3GPP, and the window offset is set as
per 3GPP specs internally.

Length Specifies the FFT window length as a percentage of cyclic prefix. This value is
used when window type is set to 3GPP.

To manually specify the length, uncheck Auto.

Default value: 20

Offset The starting position of the FFT window as a percentage of cyclic prefix is used to
calculate the EVM when the FFT window type is set to custom.

Default value: 50

Advanced
Spectral Flatness Normal Specifies the test condition for spectral flatness measurement as per normal

conditions in 3GPP Standard.

Default value: Normal

Extreme Specifies the test condition for spectral flatness measurement as per extreme
conditions in 3GPP Standard.

Phase Tracking Enables or disables the phase tracking method.
DC Subcarrier Removal Specifies whether the DC subcarrier is removed or not from the EVM results.
Spectrum Inverted Specifies whether the spectrum of the signal should be inverted before analysis of

modulation accuracy. This option can be utilized while analyzing down-converted
IQ data.

Timing Tracking Specifies whether to enable or disable timing tracking.
Composite Results
EVM Units dB Specifies the units of EVM results.

EVM is reported in dB.

Default value: Percent

Percent EVM is reported in percentage.
Include DMRS Specifies whether DMRS resource elements are included for composite EVM,

magnitude and phase error results, and traces.
Include PTRS Specifies whether PTRS resource elements are included for composite EVM,

magnitude and phase error results, and traces.
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Estimation Tab
The Estimation tab allows you to configure advanced modulation accuracy measurement estimation. It includes parameters needed to
configure IQ impairments while using direct conversion architecture and timing related parameters.

The following image is of the Estimation tab for the NR constellation display.

Setting Available options Description
Modulation Accuracy Estimation
Channel DMRS and Data Select to improve the estimation of equalizer coefficients under high SNR

conditions.

Default value: DMRS and Data

DMRS Select to estimate the equalizer coefficients exclusively using DMRS symbols
under any SNR condition.

Frequency Error Normal Specifies the mode of carrier frequency error estimation. When normal is
selected, the range of estimation is limited to +/- half the sub-carrier spacing.

Default value: Normal

Disable Used to disable the estimation and correction of carrier frequency offset.
Wide When selected, frequency error estimation range is +/- half resource block when

auto RB detection enabled is true, or range is +/- number of guard subcarrier
when auto RB detection enabled is false.

Common Clock Source Specifies whether the same reference clock is used for local oscillator and
digital-to-analog converter.

When the same reference clock is used, the carrier frequency offset is
proportional to the sample clock error or/and digital-to-analog converter

IQ Origin Offset Enables or disables estimation of IQ origin offset.
IQ Impairments Enables or disables estimation of IQ gain and imbalance.
Symbol Clock Error Enables or disables estimation of symbol clock error

Traces Tab
The Traces tab allows you to configure the display of constellation traces.

The following image is of the Traces tab for the NR constellation display.
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Setting Available options Description
Component Carrier Index 1, 2, 3, 4, 5, 6, 7, and 8 Select the component carrier index to display the component carriers

demodulated data and DMRS. Also, the scalar results in the constellation display
are modified accordingly.

Default value: 1

Trace Control
Data Enables or disables plotting the constellation of data symbols.
DMRS Enables or disables plotting the constellation of DMRS symbols.
PTRS Enables or disables plotting the constellation of PTRS symbols.
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Bluetooth Analysis

Overview
There are two Bluetooth Analysis options: Bluetooth (SV27) and Bluetooth 5 (SV31). These options allow you to evaluate short range RF
signals to ensure that they meet Bluetooth standard per Bluetooth Special Interests Group (SIG) Test Specifications for version 5. This
analysis option enables measurements and supports detection, demodulation, and decoding of packet information for the following three
standards: Basic Rate, Low Energy (LE), and Enhanced Data Rate (EDR).

• Basic Rate with uncoded data at 1 Mb/s
• Low Energy (the following three variants are supported):

• Low Energy 1M (LE 1M), with uncoded data at 1 Mb/s
• Low Energy 2M (LE 2M), with uncoded data at 2 Mb/s (Requires Option SV31NL or SV31FL)
• Low Energy Coded (LE Coded) with S=2 (500 Kb/s) or S=8 (125 Kb/s) (Requires Option SV31NL or SV31FL)

• Enhanced Data Rate (EDR) with 2 Mb/s or 3 Mb/s

You can also select from three RF test presets for the Low Energy standard and four test presets for the Basic Rate standard. This analysis
option includes modulation, power, carrier drift, and spectral measurements as mentioned in the Radio Frequency test specification
document by the Bluetooth SIG. These measurements are also compared with the limits provided by the standard to give pass/fail results.
(There are no pass/fail results for EDR.)

With the Bluetooth Analysis test suite, test engineers can simplify the execution of a number of transmitter tests while still enabled to
modify signal parameters for in-depth signal analysis. The analysis results give multiple views of Bluetooth signal characteristics to allow
the diagnosis of signal imperfections and impairments quickly and easily. Display controls allow you to selectively display the analysis
results to help locate trouble spots in the signal.

Bluetooth topics in this Help
The following information about Bluetooth Analysis is available:

• Bluetooth key features on page 525
• Reference table of supported Bluetooth measurements
• Bluetooth measurements and test setups on page 529
• Bluetooth Status Messages on page 533
• Bluetooth Standards presets on page 526
• Bluetooth displays on page 529
• Bluetooth Analysis Measurement Settings on page 557

Bluetooth key features
• Modulation/Carrier Drift/Output Power test setup in Bluetooth Standards Preset that will calculate results and compare against

recommended or user defined limits or Basic Rate, LE 1M, LE 2M, and LE coded.
• In-band Emission measurement preset with capability to compare results against recommended or user defined limits for Basic Rate,

LE 1M, LE 2M, and LE coded.
• 20 dB Bandwidth and Frequency Range measurement preset with capability to compare results against recommended or user defined

limits for Basic Rate.
• Appropriate masks for Out-of-band Spurious measurements for ETSI and FCC specifications.
• Enhanced Data Rate (EDR) demodulation of GFSK and PSK data and relative power measurement preset.
• Automatic detection of standards
• Automatic detection of test pattern.
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• Automatic determination of packet type.
• Summary display with decoded preamble, access code, packet header, payload header, and CRC packet information along with other

scalar measurements.
• Symbol Table display with color coding to show different regions in the packet.
• Freq Dev vs Time display with zoomed Octet viewing to help you understand how the modulation characteristics measurement is done.
• CF Offset & Drift display with offset (calculated in preamble and 10 bit intervals in payload) and drift results in a tabular view.
• Summary display that allows you to edit pass/fail limits for comparison with actual results. (Default is recommended limits from the

Bluetooth SIG Radio Frequency test specification document.)

Automatic detection of standards. This function can be enabled from the Standard Parameters control panel. This automatically detects
whether the Bluetooth standard is Basic Rate, Low Energy, or Enhanced Data Rate (EDR). This function is not available as a test setup
from the Standards Presets window.

Supported automated Bluetooth measurements

Bluetooth measurement Bluetooth standard(s)

Modulation characteristics Basic Rate

LE 1M, LE 2M, LE coded

Carrier frequency offset and drift Basic Rate

LE 1M, LE 2M, LE coded

Output power Basic Rate

LE 1M, LE 2M, LE coded

In-band emission /ACPR Basic Rate

LE 1M, LE 2M, LE coded

Out-of-band spurious emission Basic Rate

LE 1M, LE 2M, LE coded

20 dB bandwidth Basic Rate

Frequency range Basic Rate

Power density Basic Rate

Relative power Enhanced Data Rate (EDR)

Bluetooth Standards presets
Presets > Standards

The Bluetooth Standards preset allows you to access displays preconfigured for the Bluetooth standard and test setup you select. The test
setups load the displays and control setting options suggested by the standard to perform the measurements. You can read more about
how Presets work here..

There are four test setups for the LE 1M, LE 2M, and LE coded standard and eight test setups for the Basic Rate standard. There is one
preset (no test setups) for the EDR standard.
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The following table shows the set of Preset displays that load when the specified standards and test setups are selected.

Table 30: Bluetooth standards, test setups, and Preset displays

Standard Test setup Displays loaded with preset

LE 1M Modulation/Frequency Offset/Drift/Output Power BT Eye Diagram, BT Freq Dev vs Time, BT Summary, BT CF
Offset and Drift, Spectrum, Time Overview

In-band Emissions BT InBand Emission, Spectrum, Time Overview

Non-compliance BT Freq Dev vs Time, BT Constellation, BT Summary,
Spectrum, Spectrogram, Time Overview

LE 2M

LE Coded

(Requires Option
SV31NL or SV31FL)

Modulation/Frequency Offset/Drift/Output Power BT Eye Diagram, BT Freq Dev vs Time, BT Summary, BT CF
Offset and Drift, Spectrum, Time Overview

In-band Emissions BT InBand Emission, Spectrum, Time Overview

Non-compliance BT Freq Dev vs Time, BT Constellation, BT Summary,
Spectrum, Spectrogram, Time Overview

Basic Rate Modulation/Frequency Offset/Drift/Output Power BT Eye Diagram, BT Freq Dev vs Time, BT Summary, BT CF
Offset and Drift, Spectrum, Time Overview

In-band Emissions BT InBand Emission, Spectrum, Time Overview

Tx Output Spectrum — 20dB Bandwidth Bluetooth 20 dB BW, Spectrum, Time Overview

Non-compliance BT Freq Dev vs Time, BT Constellation, BT Summary,
Spectrum, Spectrogram, Time Overview

Enhanced Data Rate
(EDR)

Generic BT Eye Diagram, BT Constellation, BT Summary, BT Symbol
Table, Spectrum, Time Overview

Retain current center frequency and reference level settings
The Retain current Center Frequency setting appears when the Bluetooth Standards Preset is chosen. This setting allows you to retain
the previously used center frequency.

The Retain current Ref Level setting appears when the Bluetooth Standards Preset is chosen. This setting allows you to retain the
previously used reference level.

To activate these settings, check the box next to the desired setting.
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By default, the Ref Level setting box is checked.

By default, the Center Frequency setting box is unchecked and the Bluetooth preset displays will load with one of the center frequency
values shown in the following table.

Table 31: Default center frequencies for Bluetooth test setups

Standard Test setup Center frequency

Basic Rate

LE 1M

LE 2M

LE Coded

Modulation/Frequency Offset/Drift/Output Power 2.441 GHz

Basic Rate

LE 1M

LE 2M

LE Coded

In-band Emissions 2.441 GHz

Basic Rate

LE 1M

LE 2M

LE Coded

Out-of-band Spurious Emissions 2.441 GHz

Basic Rate Tx Output Spectrum — 20dB Bandwidth 2.441 GHz

Basic Rate Tx Output Spectrum — Power Density 2.441 GHz

Table continued…
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Standard Test setup Center frequency

Basic Rate

LE 1M

LE 2M

LE Coded

Non-compliance 2.441 GHz

Basic Rate Tx Output Spectrum — Frequency Range Lower 2.402 GHz

Basic Rate Tx Output Spectrum — Frequency Range Higher 2.480 GHz

Enhanced Data Rate Generic 2.441 GHz

Note: Changing analysis and display parameters recalculates the measurement results, but does not affect acquisitions.

Bluetooth displays
The displays in Bluetooth Analysis (Setup > Displays > Measurements: Bluetooth Analysis) are:

• Bluetooth 20dB Bandwidth display on page 552
• Bluetooth Carrier Frequency Offset and Drift display on page 539
• Bluetooth Constellation display on page 534
• Bluetooth Eye Diagram display on page 536
• Bluetooth Frequency Dev vs Time display on page 549
• Bluetooth InBand Emission display on page 555
• Bluetooth Summary display on page 541
• Bluetooth Symbol Table display on page 545
• Time Overview Display

Bluetooth measurements and test setups
A variety of measurements and test setups are provided by the Bluetooth Analysis option for use in performance testing of transmitters.
These test setups allow the analyzer to compare the measurement result to the standards limit. Test engineers can select from the test
setups and measurements described here. The following topics contain important information you should know about specific Bluetooth
measurements and test setups.

Note: Although the following information describes test setups for measurements recommended by the standard document, other
measurement results may also be provided as additional information for a given measurement. For example, carrier frequency
offset and drift results may be provided for modulation characteristics test setups.

Modulation characteristics (Basic Rate, LE 1M, LE 2M, LE Coded)
This measurement verifies that the modulation characteristics of the transmitted signal are correct. The Bluetooth test specification
recommends this measurement be done using fixed frequency, also known as hopping off, and can be done in Direct Tx mode. This
measurement can only be done if the payload has the bit pattern 10101010 or 11110000 for Basic Rate, LE 1M, and LE 2M; and 11001100
or 11110000 for LE Coded. This measurement and test setup are set to Free Run mode by default. However, you can set the analyzer to
Triggered mode (Setup > Trigger) to do the measurements.

More information about this measurement:
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• Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to perform modulation characteristics
measurements. This will load the displays found in the . Additionally, you can choose to load the BT Symbol Table and BT
Constellation displays, which can provide useful information.

• The Bluetooth Analysis splits the frequency deviation results in the payload region into octets (8 bit intervals). If the payload pattern is
10101010 for LE 1M and LE 2M, and 11001100 for LE Coded, then the maximum frequency deviation is calculated in every bit interval
within an octet and recorded as Δfmax. The Δfmax results are averaged to give Δf2avg. The percentage of Δfmax values greater than
recommended lower limit is also found.

• If the payload is 11110000, the average frequency deviation is found in 4 bit intervals (2, 3, 6 and 7) and the average of these values is
calculated as Δf1avg. The ratio of Δf2avg and Δf1avg is also found.

• BT Freq Dev vs Time display has an octet view (zoomed view of the 8 bit intervals in Payload) and also shows the bit intervals in which
the Δfmax values are computed. The octet view option also allows you to see the regions in which the calculations are done.

Note: The octet view option is only available when Preamble is detected.

• Specify an octet to view by entering a value in the Octet # field in the BT Freq Dev vs Time display. This also shows the maximum
number of octets used for analysis. The start and end point for every octet can be clearly seen using the octet view.

• In the Summary display, the scalar results (Δf1avg, Δf2avg, Ratio, Percentage of Δfmax values greater than a limit) averaged over the
last 10 packets analyzed are shown along with the packet count. These averaged results can be compared against limits set in the
Limits tab of the Settings control panel.

• The Points/symbol option in the Trace tab can be used to control how many samples per symbol should be used for computation of
these measurements. The standard recommends 32 samples per symbol for Low Energy and 4 samples per symbol for Basic Rate.
These are the default values provided for the respective standards in the Bluetooth Standards presets.

Carrier frequency offset and drift (Basic Rate, LE 1M, LE 2M, LE Coded)
This measurement verifies that the carrier frequency offset and carrier drift of the transmitted signal is within the specified limits for the
specified standard. The Bluetooth test specification recommends this measurement be done using fixed frequency, also known as hopping
off, and can be done in Direct Tx mode. This test can be done only if the payload contains 10101010 bit pattern. This measurement
and test setup are set to Free Run mode by default. However, you can set the analyzer to Triggered mode (Setup > Trigger) to do the
measurements.

More information about this measurement:

• Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to perform carrier frequency offset and
drift measurements. This will load the displays found in the Table 30 on page 527. Additionally, you can choose to load the BT Symbol
Table and BT Constellation displays, which can provide useful information.

• This measurement calculates the following:

• Frequency offset in Preamble (initial Carrier Frequency Offset). Calculated in 8 bits for LE 1M (f0),16 bits for LE 2M (f0) and 80 bits
for LE Coded. For LE Coded the 80 bits preamble is split into five 16 bits parts(f0-f4).

• For LE Coded there is an option to select only first 8 bits of f4. (Selection available in Analysis Params). This will ensure that
frequency offset computed in the interval f4 is not biased.

• Frequency offset in Payload (calculated in 10 bit intervals for LE 1M, 20 bits for LE 2M, and 16 bits for LE Coded in payload).
• Drift (the difference in frequency offset calculated in Payload from that calculated in Preamble).
• The drift is measured by taking the difference in frequency offset between two fixed intervals. For LE 1M, the interval length is

10 bits and the difference between intervals is 50 μs (5 intervals away). For LE 2M, the interval length is 20 bits and the interval
difference is 50 μs (5 intervals away). For LE Coded, the interval length is 16 bits and fhs interval difference is 48 μs (3 intervals
away).

• The BT CF Offset and Drift display shows all results in a table.
• The measurements shows the following scalar results:

• Preamble frequency offset (initial carrier frequency offset).
• Maximum frequency offset in Payload (along with the index number at which the offset is at maximum).
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• Drift of frequency offset from Preamble to first 10 bit interval in Payload (f1-f0).
• Maximum drift between Payload and Preamble (fn-f0) (along with index number at which the drift is maximum).
• Drift between two 10 and 20 bits intervals is denoted as fn-fn-5 for LE 1M and LE 2M. For LE Coded, it is denoted as fn-fn-3, which

is 48 μs away. The Maximum interval difference at which these values occur is shown in Frequency Drift display.
• The Preamble region in which the Preamble offset is calculated is shown in the BT Freq Dev vs Time display along with markings to

show the region in which maximum drift occurred. Maximum drift between Payload and Preamble is shown from the end of Preamble
to the end of 10 bit interval in Payload in which maximum drift occurred. Maximum drift in payload (in 50 μs duration) is also shown.

• In the Summary display, the scalar results (mentioned above) averaged over the last 10 packets are shown along with the packet
count. The results are compared against recommended limits. You can set these limits in the Limits tab of the Settings control panel.

In-band Emissions (Basic Rate, LE 1M, LE 2M, LE Coded)
This measurement verifies that the in-band spectral emissions are within limits. The standard document recommends that this
measurement be done with Hopping off, finding the integrated power in 1 MHz band (with RBW 100 kHz) in 80 channels starting
from 2401 MHz to 2481 MHz. The test can be done in Direct Tx mode. The integrated power values calculated in the adjacent channels
are compared against recommended limits (except the three channels around transmitted frequency). This measurement is referred to as
ACPR in the Radio Frequency Test Specification for Basic Rate. It is recommended to do this measurement in Free Run mode (set in
Setup > Trigger) if the analyzer does not support the required BW (80 MHz). The measurement internally searches for burst and aligns the
measurement to the on-slot region.

Note: For analyzers with limited bandwidth, this measurement will be done over multiple acquisitions to generate the data
required for the entire span. Therefore, it is important for the user to set an analysis length that will ensure that on slot region is
always included.

More information about this measurement:

• Select the In-band Emissions test setup from Presets > Standards to perform the in-band emissions measurements. This will load the
displays found in the Table 30 on page 527.

• The In-band Emissions display will set the Center Frequency to 2.441 GHz by default. When the Retain CF option is not enabled from
Standards Presets, 80 bands (each of bandwidth 1 MHz) are analyzed and the integrated power is found (indicated by Blue lines in the
plot).

• The integrated power is compared against limits for comparison (shown by white masks) in all bands except the three channels around
the transmitted frequency. If any band fails, that band is shown in red color. If more than three channels fail to meet the recommended
limits, a FAIL is shown in the top left corner of the display.

• The table below the plot shows the integrated power and also the limit for comparison.
• The limits for comparison are set to the values given by the standard by default, but you can manually set them from the Limits tab of

the Settings control panel.
• This measurement is done only on the on slot region if a ramp-up and ramp-down portions are available. However, the measurement is

done on the complete analysis region if a ramp up or ramp down is not available. It is recommended that a complete packet is included
in the analysis region.

• When the analyzer does not support the 80 MHz bandwidth requirement, multiple acquisitions are taken in different bands and stitched
together. This measurement is therefore best done in Free Run mode (set in Setup > Trigger) as Triggered mode might not find a
proper edge in an acquisition taken for stitching purposes.

Output Power (Basic Rate, LE 1M, LE 2M, LE Coded)
This test verifies the maximum peak and average power emitted from the EUT. The standards document recommends this test be done for
a PRBS payload pattern. Also, the measurement must be done over the duration of a burst starting at preamble position. The Bluetooth
test specification recommends this measurement be done using fixed frequency, also known as hopping off, and can be done in Direct Tx
mode.

More information about this measurement:

• Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to perform carrier frequency offset and
drift measurements. This will load the displays found in the Table 30 on page 527.

Bluetooth Analysis

RSA5100B Series Real-Time Signal Analyzers Help 531



• Calculates the average power and peak power for any Bluetooth signal. The peak power is the peak power value in the chosen on slot
region.

• The measurement is done only on preamble detection; otherwise, it is invalid.
• The BT Summary display shows the averaged result over 10 packets.

20dB Bandwidth (Basic Rate)
This measurement verifies if the emissions inside the operating frequency range are within limits. This measurement is done with Hopping
off. The difference between frequency points at which the power level drops to 20 dB below the peak power of the emission is found at 20
dB Bandwidth.

More information about this measurement:

• Select the 20dB Bandwidth test setup from Presets > Standards to perform the 20 dB emissions measurements. This will load the
displays found in the Table 30 on page 527.

• The BT 20 dB BW display allows you to set the relative power level (x dB BW) compared to the peak power at which the frequency
points are to be found.

• When you select the 20dB Bandwidth test setup, the center frequency (CF), span, and relative bandwidth (RBW) are set as
recommended by the standard document.

• It is recommended this measurement be done over three different center frequencies. You can do this by changing the center
frequency as needed.

• From the Params tab of the Settings control panel, you can select that the search for the x dB relative power (20 dB in this case) be
performed in one of two modes: from the edges towards the peak power (inwards) or vice versa (outwards). The default for this setting
is Inwards (from edges to peak power) when this measurement is chosen from the Standards Preset menu, as recommended.

• The blue markings in the plot indicate the 20 dB bandwidth and the frequency points at which the power level drops down by 20 dB
from the peak power.

• The resulting 20 dB bandwidth is compared with the limits recommended by the standard document and Pass/Fail is shown in the top
left corner of the plot. This is not user defined.

If the highest power value measured in step d) is equal or higher than 0 dBm: f = |fH - fL| ≤ 1.0 MHz.

If the highest power value measured in step d) is lower than 0 dBm: f = |fH - fL| ≤ 1.5 MHz.

Frequency Range (Basic Rate)
These measurements verify if the emissions inside the operating frequency range are within limits. These measurements are done with
Hopping off in two steps. The first measurement is done at the lower frequency spectrum of the Bluetooth band. (Start – 2399 MHz and
Stop 2405 MHz). The second is done at the higher frequency spectrum of the Bluetooth band (Start -2475 MHz and Stop at 2485 MHz).
The difference between the frequency point at which the power level drops to -30 dBm from the center frequency is measured. fL is the
difference on the lower side from the center frequency when the lower end of the spectrum is being analyzed. fH is the difference from the
center frequency on the higher side when the higher end of the spectrum is analyzed. fH – fL is the Frequency Range.

More information about these measurements:

• The BT 20dB BW display allows you to set the absolute power level (x dBm level) from the Parameters tab of the Settings control
panel. The Bluetooth SIG Radio Frequency test specification document suggests that this value be set to -30 dBm for doing the
Frequency Range measurement. If you chose to set up this measurement using start and stop frequencies and RBW, those should be
set as recommended by the standard. Separate start and stop frequencies are given for the two steps of this measurement.

• You can select for the analysis to find the x dBm frequency difference from the center frequency either on the lower side, higher side,
or both sides. This option (Meas Range) can be set from the Params tab of the Settings control panel.

• The blue marking indicates the frequency difference from the center frequency based on the Meas Range option choice. You can set
this option to Low while analyzing in the lower range of the frequency spectrum, and set it to High when analyzing the higher range of
the frequency spectrum.
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Power Density (Basic Rate)
This measurement verifies the maximum RF output power density.

More information about this measurement:

• This measurement can be done using the Spectrum display (Displays > Measurements > General Signal Viewing) and by setting
appropriate parameters as recommended in the Bluetooth SIG Radio Frequency test specification document.

• The Bluetooth test specification recommends this measurement be done using fixed frequency, also known as hopping off, and can be
done in Direct Tx mode.

Out-of-band Spurious Emission (Basic Rate, LE 1M, LE 2M, LE Coded)
This measurement can be done for FCC or ETSI masks using the Spurious display.

Relative Power (Enhanced Data Rate)
This measurement calculates the relative power in the GFSK and PSK part of the Enhanced Data Rate (EDR) signal. This measurement is
supported only when an EDR signal is detected.

Select the Enhanced Data Rate standard from Presets > Standards to perform the measurement. This will load the displays found in the
Table 30 on page 527.

Bluetooth Status Messages
The following status messages may appear. Each message indicates the related condition (Description) shown in the following table.

Status message Description

Bluetooth Analysis: Preamble Not Detected Shown in the display and status bar when no valid Sync and Preamble are
found for the chosen standard. Also shown when no preamble is found for any
of the standards in Automatic Standard Detection mode.

Bluetooth Analysis: LE 1M Sequence Detected Shown in the status bar when the LE 1M standard is detected in Automatic
Standard Detection mode.

Bluetooth Analysis: LE 2M Sequence Detected Shown in the status bar when the LE 2M standard is detected in Automatic
Standard Detection mode.

Bluetooth Analysis: LE Coded Sequence Detected Shown in the status bar when the LE Coded standard is detected in Automatic
Standard Detection mode.

Bluetooth Analysis: Basic Rate Sequence Detected Shown in the status bar when the Basic Rate standard is detected in
Automatic Standard Detection mode.

Bluetooth Analysis: EDR Signal Detected Shown in the status bar when the EDR standard is detected in Automatic
Standard Detection mode.

Bluetooth Analysis: EDR Sync Word Not Detected Shown in the display and status bar when EDR Sync Word is not found (when
EDR standard is selected).

Bluetooth Analysis: Not enough payload data for
Bluetooth measurements

Shown in the display and status bar when Preamble and Access Address/
Sync Word is detected but there is not enough payload data for Modulation
Characteristics and CF Offset and Drift measurement.

Table continued…
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Status message Description

Bluetooth Analysis: Meas BW may be too low Shown in the InBand Emission display and in status bar when Measurement
Bandwidth is too low.

Bluetooth Analysis: BT x dB BW detection failed Shown in the BT 20 dB BW display when x dB measurement detection fails.

Bluetooth Analysis: BT x dBm BW detection failed Shown in the BT 20 dB BW display when x dBm measurement detection fails.

Bluetooth Constellation display
The BT Constellation display shows a digitally modulated signal in constellation form. The constellation can be viewed either as IQ or
Freq Dev. The default view is Freq Dev. The frequency deviation result that is shown in the Constellation display is compensated for the
frequency error (shown as readout). 

To show the BT Constellation display you can select Presets > Standards > Bluetooth or do the following:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays window, select Bluetooth Analysis in the Measurements box.
3. In the Available displays box, double-click the BT Constellation icon or select the icon and click Add. The BT Constellation icon will

appear in the Selected displays box and will no longer appear under Available displays.
4. Click the OK button to show the display.
5. Select Setup > Settings to display the control panel.
6. Select the Standard Params tab. Set the Standard, Power class (if required), and Measurement and Reference filters as appropriate

for the input signal. You can also check the Auto Detect Standard box.
7. Select the Trace tab and set the Trace Type to Freq Dev or IQ, as required.
8. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the BT Constellation display of QPSK data in an EDR signal. Trace Type is set to IQ.
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Item Display element Description

A Trace Select and enable a trace.

B Trace Type Specifies Trace type (choice between Freq Dev and IQ). This option appears only when
EDR signal is detected.

C Freq Eror / Freq Offset / marker
readouts

The Freq Error, Freq Offset, and marker readout values appear here or below the plot,
depending on the display view and size.

The Freq Error value is the difference between the maximum and the minimum values of
signal frequency during the measurement time. The Freq Error (Auto) value is displayed
when the Auto check box is selected in the Analysis Params tab in the Settings control
panel.

The Freq Offset (Manual) value is displayed when the Auto check box is unselected in the
Analysis Params tab in the Settings control panel.

When markers are enabled, marker information (including time, magnitude, phase,
symbol, and value) is displayed.

D Avg Dev Shows the average deviation result at every symbol point.

E Plot Bluetooth constellation graph. Shown as either IQ or as Frequency Deviation. The trace
type is controlled from the Settings > Trace tab.

F Show Vectors Specifies whether to show or hide the selected trace.

The following image shows the BT Constellation display of GFSK data in a Basic Rate signal. Trace Type is set to Freq Dev.

BT Constellation Settings
Main menu bar: Setup > Settings

The BT Constellation Settings control panel provides access to settings that control parameters of the Constellation Display. 
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Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or Acquisition
Start) for Bluetooth Analysis displays.

Traces Allows you to select the trace to view, the trace type (IQ or Freq Dev), the number of points per
symbol (when trace content is set to Vectors or Lines), and to show or freeze the selected trace.

Prefs Allows you to select to show or hide the graticule and marker readouts.

Bluetooth Eye Diagram display
The BT Eye Diagram display shows a digitally modulated signal overlapped on itself to reveal variations in the signal.

To show the BT Eye Diagram display:

1. Press the Displays button or select Setup > Displays.
2. From the Measurements box, select Bluetooth Analysis.
3. Double-click the BT Eye Diagram icon in the Available Displays box. This adds the BT Eye Diagram icon to the Selected displays

box.
4. Click OK button. This displays the BT Eye Diagram view.
5. Select Setup > Settings to display the control panel.
6. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
7. Select the Trace tab and set the Trace Type to Freq Dev or IQ, as required..
8. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the BT Eye display of a basic rate signal with Trace Type set to IQ.
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Item Display element Description

A Freq Error / Freq Offset The Freq Error value is the difference between the maximum and the minimum values of
signal frequency during the measurement time. The Freq Error (Auto) value is displayed
when the Auto check box is selected in the Analysis Params tab in the Settings control
panel.

The Freq Offset (Manual) value is displayed when the Auto check box is unselected in the
Analysis Params tab in the Settings control panel.

B Top of graph The vertical scale is normalized with no units (for IQ) and with Hz (for Freq Dev).

C Position Specifies the value shown at the center of the graph display.

D Bottom Readout Displays the value indicated by the bottom of graph.

E Autoscale Adjusts the vertical and horizontal settings to provide the best display.

F Position Displays the horizontal position of the trace on the graph display.

G Scale Adjusts the span of the graph in symbols.

H Plot Displays the input signal.

The following image shows the BT Eye display of a Basic Rate signal with Trace Type set to Freq Dev.
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BT Eye Diagram Settings
Main menu bar: Setup > Settings 

The settings for the BT Eye Diagram display are shown in the following table.

Note: You might save time configuring the BT Eye Diagram display by selecting the Standard Presets button in the Bluetooth Eye
Diagram Settings control panel. This allows you to select a preset optimized for the selected standard.

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for Bluetooth Analysis displays.

Traces Allows you to select the trace to view, the trace type (IQ or Freq Dev), the number of points per
symbol (when trace content is set to Vectors or Lines), and to show the selected trace.

Scale Allows you to specify the horizontal and vertical scale settings.

Prefs Allows you to select to show or hide the graticule and marker readouts.
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Bluetooth Carrier Frequency Offset and Drift display
The BT CF (Carrier Frequency) Offset and Drift display shows the frequency offset preamble, payload regions, and the drift result values
are shown in this display. You can also view the values of frequency offset calculated in every ten bit interval in the payload and look for
excursions.

To show the BT CF (Carrier Frequency) Offset and Drift display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
3. In the Available displays box, double-click the BT CF Offset and Drift icon or select the icon and click Add. The BT CF Offset and Drift

icon will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the display.
5. Select Setup > Settings to display the control panel.
6. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
7. Select the Limits tab and set the limits , as required.
8. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the frequency offset and drift values of a basic rate (first image) and LE Coded signal in the BT Freq Offset and
Drift display.
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Display element Description

Column 1 Indicates ten bit interval numbers. Zero indicates preamble region and the non-zero number
indicate the ten bit intervals in payload.

Column 2 Shows the calculated frequency offset in the preamble and the ten bit intervals in the
payload.

Column 3 Shows the drift of offset from the preamble and over a 50 μs for LE 1M, LE 2M and 48 μs for
LE Coded duration.

Column 4 Shows the drift of offset over a 50 μs for LE 1M, LE 2M and 48 μs for LE Coded duration.

— Results that do not meet the limits are shown with a red colored background, indicating
failure. (Limits can be set in the Limits tab from the Settings control panel.)

Table continued…
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Display element Description

Scalar results The scalar results show below the table. They are as follows:

Freq Offset Preamble

Max Freq Offset (Payload)

For LE 1M, LE 2M:

Drift f1-f0

Max Drift fn-f

Max Drift fn-f(n-5)

For LE Coded:

Drift f0-f3

Max Drift f1-f4

Max Drift fn-f(n-3)

BT CF Offset and Drift Settings
Main menu bar: Setup > Settings 

The settings for the BT CF Offset and Drift display are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, and power class (when applicable). You can also set the
analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for Bluetooth Analysis displays.

Limits Allows you to load and define Bluetooth measurement limits for Pass/Fail comparison. You can save
defined limits as a .csv file and also load previously saved .csv files. These limits also apply to the
Settings control panel Limits tab of the BT Summary display.

Bluetooth Summary display
The BT Summary display shows a summary of all the scalar measurements done on the acquired test pattern. The summary display and
contents will vary according to the selected standard.

Pass/Fail information is also provided in this display for all enabled scalar measurements. You can set limits and choose which
measurement to compare for Pass/Fail from the Limits tab of the BT Summary Settings control panel. The default limits come from the
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performance recommendation limits given by the Standards document. The default limits can be reloaded by selecting the Bluetooth
Standards Preset option.

The results presented in the BT Summary display include scalar results of modulation characteristics, frequency offset and drift and, output
power measurements (these are averaged over the last 10 acquired packets). The display also shows packet related information for the
current acquired packet.

To show the BT Summary display you can select Presets > Standards > Bluetooth or do the following:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
3. In the Available displays box, double-click the BT Summary icon or select the icon and click Add. The BT Summary icon will appear in

the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the display.
5. Select Setup > Settings to display the control panel.
6. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
7. Select the Limits tab and set the limits , as required.
8. Select Replay/Run to take measurements on the acquired data.

Elements of the display
The following image shows all average scalar results and packet information for a Basic Rate signal in the BT Summary display.
Modulation characteristics, carrier frequency offset and drift, and power measurements, along with packet information, are shown. The
packet information will vary depending on the chosen or detected standard. For more information about specific measurement results, see
the Bluetooth measurements and test setups section here.

Element Description

Standard Display of the selected standard or the detected standard (if the Auto Detect Standard setting is
chosen in the Standard Params tab of the Settings control panel).

Table continued…
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Element Description

Power class Display of the Power class in the Standard Params tab of the Settings control panel. Only available
when Basic Rate is the selected or detected standard.

Clear Click button to reset measurement. Clears all values and all results in the queue used for average
computation.

Modulation characteristics

(ten packet average)

Display of a group of scalar results related to Modulation Characteristics measurements. These scalar
results are only populated in the BT Summary display if preamble is detected in the acquired data.
The four scalar results are:

Δf1avg is calculated when analyzed test pattern (payload) is 11110000.

Δf2avg and the percentage of Δf2max value (greater than a given limit) are calculated only when
analyzed test pattern (payload) is 10101010 for LE 1M and LE 2M, and 11001100 for LE Coded.

The ratio of Δf2avg and Δf1avg is calculated provided both the results are available (or have been
done before).

All the results given are averaged over the last ten packets. The scalar results can be compared with
pass/fail limits set in the Limits tab of the Settings control panel.

More information can be found here.

Modulation index The Modulation index denotes if the transmitter of a BLE Packet is Stable or Standard. If it is Stable,
the modulation index will be between 0.495 and 0.505. If it is Standard, the modulation index will be
between 0.475 and 0.525. If neither of these conditions is satisfied, then no text is shown.

Frequency offset and drift

(ten packet average)

Display of a group of five scalar results related to the carrier frequency offset and drift measurement.
These scalar results are only populated in the BT Summary display if preamble is detected and if
the test pattern payload is a 10101010 pattern. All the results given are averaged over the last ten
packets. The scalar results can be compared with pass/fail limits set in the Limits tab of the Settings
control panel.

The eight scalar results are:

Preamble offset.

Maximum offset in Payload (calculated over 10 bit intervals for LE 1M, 20 bit intervals for LE 2M, and
16 bit intervals for LE Coded).

Drift (f1-f0)

Max Drift (fn-f0).

Max Drift (fn-fn-5) for LE 1M, LE 2M

Drift (f0-f3)

Max Drift (f1-f4)

Max Drift (fn-fn-3) for LE Coded

For more information about this measurement, see the Carrier frequency offset and drift (Basic Rate,
LE 1M, LE 2M, LE Coded) on page 530 topic in Bluetooth Measurements and test setups.

Table continued…
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Element Description

Output power Display of Average Power and Peak Power scalar results for Output Power. All the results given are
averaged over the last ten packets. The scalar results can be compared with pass/fail limits set in the
Limits tab of the Settings control panel.

For Enhanced Data Rate signals, the relative power in GFSK and PSK regions is measured.

For more information about this measurement, see the Output Power (Basic Rate, LE 1M, LE 2M, LE
Coded) on page 531 topic in Bluetooth Measurements and test setups.

Packet information The Packet information includes the Packet type, Preamble, Synchronization Word or Access Code,
Packet Header, Payload length, and CRC details. The decoded bits are shown for the current
analyzed packet.

The following image shows all average scalar results and packet information for a LE 1M< LE 2M, and LE Coded signal in the BT
Summary display.

The following image shows all average scalar results and packet information for an EDR signal in the BT Summary display.
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BT Summary Settings
Main menu bar: Setup > Settings 

The settings for the BT Summary display are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or Acquisition
Start) for Bluetooth Analysis displays.

Limits Allows you to load and define Bluetooth measurement limits for Pass/Fail comparison. You can save
defined limits as a .csv file and also load previously saved .csv files. The frequency offset and drift
limits set here also apply to the CF Offset and Drift display.

Bluetooth Symbol Table display
The BT Symbol Table display shows decoded data values for each data symbol in the analyzed signal packet. It is like the BT Constellation
display except that a text table is used to display data instead of a graph. 

To show the BT Symbol Table display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
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3. In the Available displays box, double-click the BT Symbol Table icon or select the icon and click Add. The BT Symbol Table icon will
appear in the Selected displays box and will no longer appear under Available displays.

4. Click OK to show the display.
5. Select Setup > Settings to display the control panel.
6. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
7. Select the Limits tab and set the limits , as required.
8. Select Replay/Run to take measurements on the acquired data.

Regions of the Display
The BT Symbol Table is color coded to indicate different regions of the packet. The legend at the bottom of the symbol table lists the
packet contents in their associated colors. The following image shows values for a Basic Rate signal.

Packet standard Associated regions

Basic rate 4-bit preamble

64-bit access code

4-bit trailer

54-bit packet header

8- or 16-bit payload header based on packet type

Variable length payload data

16-bit CRC (Cyclic Redundancy Check)

Table continued…
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Packet standard Associated regions

LE 1M 8-bit preamble

32-bit access address / synchronization word

16-bit payload header

Variable length payload data (2–257 bytes)

24-bit CRC (Cyclic Redundancy Check)

LE 2M 8-bit preamble

32-bit access address / synchronization word

16-bit payload header

Variable length payload data (32–257 bytes)

24-bit CRC (Cyclic Redundancy Check)

LE Coded 80-bit preamble

256-bit access address / synchronization word

16-bit payload header

Variable length payload data (16–2057 bytes)

24-bit CRC (Cyclic Redundancy Check)

Enhanced Data Rate (EDR) 4-bit preamble

64-bit access code

4-bit trailer (if present, shown in black)

54-bit packet header

Guard region (shown as X)

EDR sync sequence (QPSK or 8PSK symbols)

16-bit payload header (QPSK or 8PSK symbols)

Variable length payload data (QPSK or 8PSK symbols)

16-bit CRC (Cyclic Redundancy Check) (QPSK or 8PSK symbols)

The following image shows values for a Low Energy signal.
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The following image shows values for an EDR signal.

Markers and the BT Symbol Table. Markers are indicators in the display that you can position on a trace to measure values such as
frequency, power, and time. A Marker always displays its position and, if the Delta Marker (M1-M4) readout is enabled, will display the
difference between its position and that of the Marker Reference (MR). In the BT Symbol Table, colored cells indicate the location of
markers. The selected Marker is highlighted with a light green background. All other markers are highlighted with a light gray background.
In the BT Symbol Table, the marker readout below the table shows the marker location in time, symbol numbers and symbol value.

BT Symbol Table Settings
Main menu bar: Setup > Settings 
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The settings for the BT Symbol Table display are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for Bluetooth Analysis displays.

Prefs Allows you to select to show or hide the marker readouts and set the radix of shown symbols.

Bluetooth Frequency Dev vs Time display
The BT Freq Dev vs. Time display shows how the signal frequency varies with time.

To display the BT Freq Dev vs. Time display:

1. Select the Displays button or Setup > Displays.
2. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
3. In the Available displays box, double-click the BT Freq Dev vs. Time icon or select the icon and click Add. The BT Freq Dev vs.

Time icon will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the display.
5. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
6. Select the Trace tab and set the Content to Vectors or Points, as required.
7. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the frequency deviation of the complete packet of a Basic Rate signal in the BT Freq Dev vs. Time display.
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Item Display element Description

A Top of graph The vertical scale is normalized with Hz.

B View (This option is visible only when Preamble is detected.)

Select one of the following:

Packet: view frequency deviation for an entire packet.

Octet: view frequency deviation for a specified octet duration (8 μs). The Octet is specified
in the Octet # field.

C Octet # (xx of total) (This option is visible only when Preamble is detected and Octet is selected as the View.)

Specifies the Octet number. (The total number of octets is also indicated.) When View
is set to Octet, you can enter a particular octet in the Octet # field for zoom view. The
plot will show only 8 μs of information corresponding to the octet number chosen in the
payload. The regions that are used for doing the exact measurements are highlighted
in the Octet View. For F0F0 (Low Deviation) pattern in payload, bit intervals 2,3,6,7
regions are highlighted. For 10101010 LE 1M and LE 2M, and 11001100 for LE Coded
(high deviation) pattern, all bit regions are highlighted with appropriate results. The offset
calculated for every octet region (f1ccf or f2ccf) are also shown.

D Position (center) Adjust the frequency shown at the center of the display.

F Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the best display.

G Position Displays the horizontal position of the trace on the graph display.

H Scale Adjusts the horizontal scale (time).

Table continued…
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Item Display element Description

I Plot Displays the last analyzed complete packet or the selected octet (Octet zoom view) of the
signal. Markings are shown for Preamble offset and for Maximum Drift from preamble and
Maximum Drift for 50 μs.

J Scalar results The Scalar results for Modulation Characteristics and Frequency Offset and Drift
measurements are captured here. These results are from the last analyzed packet and
therefore could be different from the Averaged Scalar results shown in the BT Summary
display.

For Drift results, the index is also shown where the maximum drift occurred. The Drift
results are shown only when the preamble is detected and the test pattern payload
detected is 10101010 for LE 1M and LE 2M, and 11001100 for LE Coded. ΔF1avg or
ΔF2avg is shown only when the detected test pattern payload is (10101010) for LE 1M
and LE 2M or (11001100) for LE Coded.

Note: This display shows the frequency deviation results without compensating for the frequency error.

The following image shows the frequency deviation of the first octet in the payload of a Basic Rate signal (high deviation).

The following image shows the frequency deviation of the first octet in the payload of a Basic Rate signal (low deviation).

Bluetooth Analysis

RSA5100B Series Real-Time Signal Analyzers Help 551



BT Frequency Dev Vs Time Settings
Main menu bar: Setup > Settings 

The Setup settings for BT Freq Dev vs. Time are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, reference filters, and power class (when applicable). You
can also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can also select
to auto detect test patterns. These parameters are used by the instrument to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis.
Also allows you to specify the Units (Symbols or Seconds) and Time Zero Reference (Trigger or
Acquisition Start) for Bluetooth Analysis displays.

Trace Allows you to select the number of points per symbol, content, and to choose between entire packet
view or zoom Octet view for a chosen octet number in a packet.

Scale Allows you to specify the horizontal and vertical scale settings.

Prefs Allows you to select to show or hide the graticule and marker readouts.

Bluetooth 20dB Bandwidth display
The BT 20dB BW display shows the results of two Bluetooth measurements: 20dB Bandwidth and Frequency Range. When the xdB BW is
chosen, the display shows the x dB bandwidth from the peak power. More detailed information about this measurement is available here.

To display the BT 20dB BW display:
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1. Select the Displays button or Setup > Displays.
2. In the Select Displays dialog, select Bluetooth Analysis in the Measurements box.
3. In the Available displays box, double-click the BT 20dB BW icon or select the icon and click Add. The BT 20dB BW icon will appear

in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the display.
5. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement and Reference filters as

appropriate for the input signal. You can also check the Auto Detect Standard box.
6. Select the Trace tab and set the Content to Vectors or Points, as required.
7. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image of the BT 20dB BW display shows a Basic Rate signal that would allow you to measure 20 dB bandwidth.

Item Display element Description

A PASS / FAIL Indicates Pass or Fail for the 20 dB BW measurement.

B Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

C Normal / MaxHold Indicates whether the measurement is done with a MaxHold or a Normal condition.

Table continued…
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Item Display element Description

D Clear Resets count for Average and MaxHold functions. Enabled only when Averaging or
MaxHold is enabled. Pressing Clear will clear the trace and, if acquisition is running,
restart the averaging or hold process.

E Main results area Shows the xdBm and xdB results. The requested dB or dBm value can be set in the
controls below the result readout. Use the two radio buttons to select which of the two
results are illustrated in the graph with the blue lines and arrows. RBW also can be set
using the control. VBW enables the VBW (Video Bandwidth) filter. Displays current VBW
filter setting. See Setup > Settings > Freq & RBW tab.

F Position and dB/div

Units (not shown)

Fix. Slugger 2

Position sets the top of graph value. The dB/div setting is the vertical scale value.

Set the global Amplitude units for all the views in the analysis window using the drop down
menu that appears when you click on the box. This will change the amplitude selection in
the Units tab of the Amplitude control panel.

G Bottom readout Displays the value indicated by the bottom of graph.

H Position Displays the horizontal position of the trace on the graph display.

I Scale Adjust the span of the graph in symbols.

J Detailed results Displays the following additional measurements results:

Freq Error: The frequency difference between the measured carrier frequency of the
signal and the user-selected center frequency of the analyzer.

x db BW Ref Power: The peak power measured within the measurement bandwidth.

K Grid divider Determines the portion of the display allocated to the graph and detailed results area. You
can move the grid divider all the way to the top or bottom and any position in between.

L Blue lines Indicates the measurement positions.

M Plot Displays the input signal. Shaded areas indicate the measurement bandwidth (Settings >
Parameters tab > Measurement BW).

BT 20dB BW settings
Main menu bar: Setup > Settings 

The Setup settings for BT 20dB BW are shown in the following table.

Settings tab Description

Freq & RBW Allows you to specify the frequency, resolution bandwidth (RBW), step, and VBW used for the MCPR
measurements.

Table continued…
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Settings tab Description

Parameters Allows you to specify the x dB level, Measurement Direction, Measurement BW, xdBm level, xdBm
Range, count, and to enable averaging and the Max Hold function.

Scale Allows you to define the vertical and horizontal axes.

Prefs Allows you to select show or hide the graticule and marker readouts.

Bluetooth InBand Emission display
The BT InBand Emission display verifies whether the emissions inside the operating frequency range are within limits. The power in
adjacent channels of 1 MHz bandwidth around the frequency of transmission are calculated and compared against limits. The integrated
power in the 1 MHz band for the adjacent channels is shown in a table below the plot.

To display the BT InBand Emission display:

1. Select the Displays button or Setup > Displays.
2. In the Select Displays dialog, select BT Inband Emission in the Measurements box.
3. In the Available displays box, double-click the BT Inband Emission icon or select the icon and click Add. The BT Inband Emission

icon will appear in the Selected displays box and will no longer appear under Available displays.
4. Click OK to show the display.
5. Select the Standard Params tab and select the appropriate standard.
6. Select the Measurement Params tab and turn on averaging, if desired.
7. Select the Limits tab and set the desired limits.
8. Select Replay/Run to take measurements on the acquired data.

Elements of the Display
The following image shows the BT Inband Emission display of a Basic Rate signal operating at 2.441 GHz (showing 80 adjacent bands).
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Item Display element Description

A PASS / FAIL Indicates Pass or Fail based on the number of adjacent channels that are below an upper
limit. A maximum of 3 adjacent channels can have integrated power higher than an upper
limit (Pass); otherwise, Fail is reported.

B Normal Displays Average Count if Average is turned on (set to Time Domain or Frequency
Domain) from the Measurement Params tab in the Settings control panel.

C Clear Resets measurement. Clears all values.

D Top of graph The vertical scale is normalized with appropriate power units.

(not
shown)

Units Sets the global Amplitude units for all the views in the analysis window. This will change
the amplitude selection in the Units tab of the Amplitude control panel.

E dB/div The vertical scale value.

F Bottom readout Displays the value indicated by the bottom of graph.

G Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

H Position Displays the horizontal position of the trace on the graph display.

I Scale Adjust the span of the graph in symbols.

Table continued…
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Item Display element Description

J Plot Divides the spectrum into different adjacent channels (each of 1 MHz bandwidth) as
suggested in the standard document. You can select to show integrated power by
checking the Show power levels in graph box in the Prefs tab in the Settings control
panel). The integrated power level is shown in blue and the prescribed limits for
comparison (set in the Limits tab of the Settings control panel) are shown in white. The
region around the frequency of transmission is shown in a different color.

K Results table Reports the integrated power results (Channel frequency, Integrated power, and Limits)
from the display in a table.

Bluetooth Analysis Measurement Settings
Main menu bar: Setup > Settings

The control panel tabs in this section are shared between the displays in Bluetooth Analysis (Setup > Displays). Some tabs are shared by
all the displays, some tabs are shared by only a subset of displays. The settings available on some tabs change depending on the selected
display.

Table 32: Common controls for Bluetooth Analysis displays

Settings tab Description

Standard Params Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params Specifies parameters used by the application to analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Symbols or Seconds) for Bluetooth Analysis displays.

Trace Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol when chosen to
view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Prefs Allows preferences with Radix display and marker readouts.

Scale Defines the vertical and horizontal axes.

Parameters Specifies parameters used to analyze the signal.

Freq & RBW Allows you to set Frequency and RBW settings for the BT 20 dB BW display.

Limits Allows you to define limits for pass/fail comparison with calculated values. The default values are as
recommended in the test specification.

Measurement Params Allows you to set average (Time Domain, Off, or Frequency Domain) and to correct for noise floor.
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Standard Params tab - BT
The Standard Params tab allows you to specify the standard, measurement and reference filters, power class (for some standards), and
set standard auto detect.

The following image shows the tab for all of the Bluetooth displays except for the BT InBand Emission display. The Power Class menu only
appears when Basic Rate is the selected standard.

The following image shows the tab for the BT InBand Emission display.

Settings Description

Standard Select the appropriate standard: Basic Rate, LE 1M, LE 2M, LE Coded, or Enhanced Data
Rate.

Auto Detect Standard Check box to enable automatic detection of the Bluetooth standard (Basic Rate, Low
Energy, or Enhanced Data Rate). A status message will appear indicating which of the three
standards is detected and the result will show as Standard selection.

Measurement Filter Specifies the filter used for measurement. The default filters for the Low Energy and Basic
Rate standards are LE-Recommended and BR-Recommended, respectively.

Reference Filter Specifies the filter used as a reference.

Power Class

(only available for Basic Rate)

Select one out of three available power classes. This sets the default limits for comparison
(set in the Limits tab of the Settings control panel) for Average and Peak power
measurements.

Power class for the Basic Rate standard

The power class for Basic Rate is the reference receive power range as specified by the standard. It sets the default limits for comparison
in the Limits tab of the control panel for Average and Peak power measurements. The power classes are specified as follows:

Class 1: max power 20 dBm (100 mW) with mandatory power control.
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Class 2: max power 6 dBm (4 mW) with optional power control.

Class 3: max power 0 dBm (1 mW) with optional power control.

Recommended measurement and reference filters
The available measurement and reference filters depend on the selected standard. You can use the filters recommended by the standard
(shown in following table) or load your own filters by selecting one of the User defined filters from a file.

The measurement filter is applied before the demodulation bit is detected and the ideal reference is calculated.

The reference filter is applied to the internally generated ideal reference signal.

CAUTION: Although there may be other filter types listed in the drop down menu, if you select any filter other than that which is
recommended, the measurement results may not be accurate.

Standard Measurement filters Reference filters

Basic Rate BR-Recommended None

LE 1M LE-Recommended None

LE 2M LE-Recommended None

LE Coded LE-Recommended None

Enhanced Data Rate BR-Recommended None

How to select filters
In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for another kind of necessary
shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This setting tells the analyzer what
filter your receiver uses. When the analyzer is set to the same filter used by the receiver, the analyzer sees the signal as your receiver
would. The Measurement Filter setting should be the same as the filter used in the receiver under normal operation (as opposed to
testing).

Analysis Params tab - Bluetooth
The Analysis Params tab contains parameters that control the analysis of the input signal. The Test Patterns menu only appears when the
Auto Detect Test Pattern is not checked. This tab is available for all displays except for the BT 20dB BW and the BT InBand Emission
displays.
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Settings Description

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error and the
measured Frequency Error is displayed. When the Auto box is unchecked, the entered value
is used by the analysis as a fixed frequency offset. This is useful when the exact frequency
offset of the signal is known.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Select Manual, Auto, or Link to Span.

Auto Detect Test Pattern When this box is checked, automatic detection of the test pattern is enabled. When this box
is unchecked (Manual mode), automatic detection id disabled and you can select the test
pattern and specify the Δfavg for the other pattern for ratio computation.

Test Pattern Allows you to select the test pattern to be analyzed. This choice is available only when Auto
Detect Test Pattern is disabled.

Use 8 bits for f4 preamble interval This option allows you to select only the first 8 bits of f4 for LE Coded. This ensures that the
frequency offset computed in the interval f4 is not biased.

Analysis Time tab - Bluetooth
The Analysis Time tab contains parameters that define how the signal is analyzed in the Bluetooth Analysis displays. This tab is available
for all displays except for the BT 20dB BW and the BT InBand Emission displays.

Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Available This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer. This value may not match the Analysis Length requested (in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Table continued…
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Settings Description

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (All time values are relative to the Time Zero Reference.)

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the actual amount of time for Analysis
Length, in Symbol or Seconds units, is shown below the control in the "Available" readout. This setting is not available when Auto is
checked. Range: minimum value depends on the standard. Resolution: 1 symbol.

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which the acquisition begins.

Trigger Time zero starts from the trigger point.

Limits tab - Bluetooth
This tab is only available for the BT CF Offset and Drift, BT InBand Emission, and BT Summary displays. It enables you to load an existing
limits table, save a limits table, or edit limits values. The content under Measurement Name varies based on the chosen standard and
power class.

Some measurements are done only when a specific test pattern is detected. If the specific pattern is not detected, then N/A appears in
blue in the BT Summary display because the measurement is not done. If the measurement is done, Pass or Fail is shown in the BT
Summary display.

The following image shows the Limits tab for the BT CF Offset and Drift and BT Summary displays.

The following image shows the Limits tab for the BT InBand Emission display.
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Settings Description

Load Click to load a saved Limits table from a .csv file.

Save Click to save the current Limits table to a .csv file.

Edit limits
To directly edit measurement limits in the table, click on the value in the Limit column that you want to change. The following table
describes the parameters that are set in the Limits Table.

Settings Description

On Click on the cell in the On column next to the measurement to specify whether or not measurements
are selected for limit comparison to indicate Pass or Fail. A check mark means the measurement will
be taken. An empty box means it will not be taken.

Measurement Name Specifies the name of the measurement related to the limit. (Not editable.) The content under
Measurement Name varies based on the chosen standard and power class.

Limit Specifies the value of the limit to the related measurement. When the cell is selected, the value is
shown along with the units.

Scale tab - Bluetooth
The Scale tab allows you to change the scale settings that control how the trace appears on the display but does not change control
settings such as Measurement Frequency. In effect, these controls operate like pan and zoom controls. The Scale tab values are unique to
each display. Also, note that each display uses horizontal and vertical units that are appropriate for that display. There are three versions of
the Scale tab for Bluetooth displays.

The following image shows the Scale tab for the BT 20dB BW and BT InBand Emission displays.

The following image shows the Scale tab for the BT Eye Diagram display.
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The following image shows the Scale tab for the BT Freq Dev vs Time display.

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the horizontal span of the trace display and position of the trace.

Scale Allows you to, in effect, change the horizontal span.

Position Allows you to pan a zoomed trace without changing the frequency.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto When Auto is checked, the scale and position values for the Symbols graph are automatically
adjusted to maintain the optimal display.

Reset Scale Resets all settings to their default values.

Note: The Units used for the horizontal scale for the BT Freq Dev vs Time display can be either Seconds or Symbols. To set the
units for the horizontal scale, display the Analysis Time tab. On the tab, select the appropriate units from the Units drop-down list.

Traces tab - Bluetooth
The Traces tab allows you to set the trace display characteristics of the BT Constellation, BT Eye Diagram, and BT Freq Dev vs Time
displays. The selections vary depending on the selected display.

The following image shows the tab for the BT Constellation display.
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The following image shows the tab for the BT Eye Diagram display.

The following image shows the tab for the BT Freq Dev vs Time display.

Setting Description

Trace Select the trace to display.

Show Shows / hides the selected by trace.

Freeze Halts updates to the selected trace.

Points/Symbol Select how many points to use between symbols when connecting the dots. Values: 1, 2, 4, 8, 16, and
32.

Content Select whether to display the trace as vectors (points connected by lines), points (symbols only
without lines), or lines (lines drawn between symbols, but no symbols are displayed). The choices
available depend on the display.

Trace Type Select to specify whether the plot is shown as IQ or as Frequency Deviation.

Table continued…
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Setting Description

View Allows you to see the full packet or only the chosen Octet.

Octet # (of xx) Allows you to view the specified octet. You can also select from the list of the available number of
Payload octets in the packet.

Comparing two traces in the BT Constellation display
You can use the Traces tab to enable the display of a second trace. The second trace is a version of the current acquisition. You can
choose to freeze a trace in order to display the current live trace to an earlier version of itself, you can display the trace as a second trace,
or you can choose to display both traces frozen in order to compare the trace to itself at different times.

To display a second trace in the BT Constellation display:

1. If more than one display is present, select the BT Constellation display to ensure it is the selected display.

2. Click .
3. Select the Trace tab.
4. Select Trace 2 from the Trace drop-down list.
5. Click the Show check box so that it is checked.
6. Specify the Content as desired.

The Trace 2 lines will appear in blue to help you distinguish Trace 2 from Trace 1.

Prefs tab - Bluetooth
The Prefs tab enables you to change appearance characteristics of some of the Bluetooth Analysis displays.

The following image shows the Prefs tab for the BT 20dB BW, BT Freq Dev vs Time, BT Eye Diagram, and BT Constellation displays.

The following image shows the Prefs tab for the BT InBand Emission display.

The following image shows the Prefs tab for the BT Symbol Table display.
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Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker readout in the
display. There are three choices for Radix: Binary (0,1) and Modulation Symbols (+1,-1). When EDR
is detected, the symbol table will always show results in Hex for the PSK region (after guard).

Trace detection +Peak: Shows the peak power in a bin (of chosen RBW) if there are multiple points to choose from
within a bin.

Avg (VRMS): Shows the average power in a bin (of chosen RBW) if there are multiple points to
choose from within a bin.

Show power levels graph Displays the calculated power levels in graph in each band.

Parameters tab - Bluetooth
The Parameters tab enables you to specify several parameters that control signal acquisition in the BT 20dB BW display.

Setting Description

x dB level x dB level defines the x dB BW level search threshold.

Meas Direction Specifies which way the search for the x dB level is done. Selecting Inwards directs the search for
x dB from the edges towards maximum power. Selecting Outwards directs the search for x dB from
maximum power (x dB ref power) to edges.

x dBm level x dBm level defines the x dBm BW level search threshold.

x dBm range Specifies the search direction for the x dBm level. The choices are Lower, Higher, or Both.

Table continued…
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Setting Description

Measurement BW Specifies the frequency range used by the measurement.

Max Hold spectral data Enables the Max Hold function.

Average results Enables/disables results average across acquisitions. (This is averaging of the results, not of the
trace.)

Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to 10,000.

x dB level
The x dB level determines the x dB bandwidth. The analyzer analyses the spectrum trace to locate the frequencies at which the level
is x dB down from the peak level, calculated over the measurement bandwidth. The frequency difference between the upper and lower
crossing thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -20 dB

Meas Direction
The search for the x dB level or x dBm level can be done by selecting Inwards or Outwards in Meas Direction. Selecting Inwards directs
the search from the edges towards maximum power. Selecting Outwards directs the search from maximum power (x dB ref power or CF
for x dBm) to edges.

x dBm level
The x dBm level determines the x dBm bandwidth. The analyzer analyzes the spectrum trace to locate the frequencies at which the level is
x dBm down from the Center frequency. The frequency range is calculated based on the choice of x dBm Range. The value of x dBm is set
to -30 dBm when the BT 20dB BW display is launched from the Bluetooth Standards Presets.

Meas Range (Higher, Lower, Both)
This determines the search range for the x dB level. The options are as follows:

• Lower: Indicates the frequency range from center to the lower frequency at which the power level drops to x dBm.
• Higher: Indicates the frequency range from center to the higher frequency at which power level drops to x dBm.
• Both: Indicates the frequency between the upper and the lower crossing thresholds at which the power level drops to x dBm.

Max Hold spectral data
Max Hold displays the maximum value in the acquisition record for each display point. Each new trace display point is compared to the
previous maximum value and the greater value is retained for display and subsequent comparisons.

Freq & RBW tab - Bluetooth
The Freq & RBW tab allows you to specify the bandwidth parameters used for setting measurement bandwidth in the BT 20dB BW display.
This determines what acquisition bandwidth the measurement will request.
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Setting Description

Meas Freq Specifies the measurement frequency.

RBW Select Auto or Manual. Adjusts the resolution bandwidth for the entire measurement. This setting is
independent of the Spectrum display’s RBW setting.

Step Sets the increment/decrement size for the adjustment of the center frequency. If Auto is enabled, the
analyzer will adjust the step size as required.

VBW Adjusts the video bandwidth.

Measurement Params tab - Bluetooth
The Measurement Params tab is only available for the BT InBand Emission display. It allows you to select the average domain.

Setting Description

Average Specify the average domain (Time Domain, Frequency Domain) or set Average to Off. If a domain is
selected, then you can also specify the number.

Number Specify the number value associated with the Average setting.
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Audio Analysis and Demodulation
Overview
Audio Analysis (Option 10) measures basic time- and frequency-domain parameters of analog audio signals modulated on a carrier (AM,
FM and PM modulation) or unmodulated (non-carrier) audio signals (Direct).

For modulated signals, the measurement analysis first demodulates the signal to provide the Audio signal waveform. Direct input signals
bypass the demodulation step. For FM and PM demodulation, the carrier frequency error is estimated during demodulation.

The Audio signal waveform excursions are then measured to determine the Peak and RMS waveform parameters. Next, the analysis
detects the highest-amplitude frequency component within the audio bandwidth, and makes a high-accuracy frequency measurement of
the frequency component. This value is called the Audio Frequency.

A spectral analysis of the Audio signal waveform is performed to determine the presence and level of harmonically- and/or non-
harmonically-related narrowband spurs and wideband noise. The Audio signal, harmonic and non-harmonic spurs, and noise level data are
combined to produce signal summary parameters including SINAD, Modulation Distortion, Signal-to-Noise, Total Harmonic Distortion, and
Total Non-Harmonic Distortion.

Controls are provided to allow the user to select audio filters of Low Pass, High Pass, FM De-emphassis, or Standard-defined response,
as well as completely user-definable filter response. Filtering can be applied as needed to modify the audio spectrum result before
measurement to remove unwanted spurs or noise.

Flexible control parameters are provided to allow setting the Audio Bandwidth for analysis, the Resolution Bandwidth (RBW) and RBW
filter type of the spectral analysis, and number and level qualifications for Harmonic and Non-harmonic spur detection. Multiple-spectrum
averaging can be enabled to provide a smoothed spectrum for results with less variability than single-spectrum results.

The Audio Spectrum display shows the frequency spectrum waveform with detected harmonic and non-harmonic components identified
by markers, and a corresponding table of frequency and level values for the spur components. The markers and table provide easy
visualization of the significant spurs and their relation to the fundamental Audio frequency signal.

Audio Spectrum Display
The Audio Spectrum display shows audio modulation characteristics. You can choose to show just the spectrum of the audio signal or
show the audio spectrum of the signal and the results of distortion measurements. The Audio Spectrum display can show a table listing the
frequency of a Harmonic Distortion (HD) and Non-Harmonic Distortion (NHD) and its level. The Spectrum graph indicates these harmonics
and non-harmonics with special markers. 

To display the Audio Spectrum display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Audio Analysis.
3. Double-click the Audio Spectrum icon in the Available Displays box. This adds the Audio Spectrum icon to the Selected displays

box.
4. Click the OK button. This shows the Audio Spectrum display.
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Elements of the Audio Spectrum Display

Item Display element Description

1 Vertical position Sets the top of graph value.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 Audio BW Specifies the measurement bandwidth of the Audio Spectrum display, which in turn can
influence the acquisition bandwidth.

4 Table Displays a table that shows the distortion measurement results and displays indicators on
the graph that highlight the location of the harmonics on the trace.

5 Bottom of graph readout Displays the bottom of graph value.

6 Non-harmonic threshold indicator Displays the threshold for detecting non-harmonic components.

7 Analysis results Display of the audio analysis results.

Audio Spectrum Settings
Main menu bar: Setup > Settings 

The measurement settings for the Audio Spectrum display are shown in the following table.

Settings tab Description

Params1 Tab on page 573 Specifies signal type, Audio Bandwidth, RBW, RBW filter, and Ref Audio Frequency.

Params2 Tab on page 574 Specifies Harmonics and Non-Harmonics measurement parameters.

Audio Filters Tab on page 575 Specifies the audio filter characteristics.

Table continued…
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Settings tab Description

Scale Tab on page 182 Sets vertical and horizontal scale and position parameters.

Prefs Tab on page 579 Specifies vertical units, and whether on not some features are displayed in the graph.

Audio Summary Display
To display the Audio Summary display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Audio Analysis.
3. Double-click the Audio Summary icon in the Available Displays box. This adds the Audio Summary icon to the Selected displays

box.
4. Click the OK button. This shows the Audio Summary display.

The Audio Summary Display

Audio Summary Displayed Measurements
Table 33: Audio Summary Measurements

Signal type Item Description
AM, FM, PM Carrier Power Average power of the carrier signal with modulation removed.
Direct Signal Power Average power of the input signal
FM, PM Carr Freq Err Carrier frequency error

AM, FM, PM. Direct Audio Freq Fundamental audio frequency

+Peak +Peak modulation excursion (where the modulation excursion
readout depends on the signal type)3

-Peak -Peak modulation excursion (where the modulation excursion
readout depends on the signal type)3

Peak-Peak/2 Half peak-peak modulation excursion (where the modulation
excursion readout depends on the signal type)3

Table continued…

3 For AM signal types, modulation excursion is "% Modulation Depth". For FM signal types, modulation excursion is "Frequency Deviation". For PM signal types,
modulation excursion is "Phase Deviation". For Direct, there is no modulation excursion, it is actually "signal excursion".
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Signal type Item Description
RMS RMS modulation excursion (where the modulation excursion

readout depends on the signal type)3

SINAD Signal to noise and distortion

Mod Distor Modulation distortion
S/N An estimate of the Signal level to Noise (only) level, with the

HD and NHD components removed
THD Total harmonic distortion
TNHD Total non-harmonic distortion
Ref Ref is the RMS modulation value stored when the Capture

Reference button is pressed. (Displayed only when Hum &
Noise is enabled.)

Diff Diff is the difference between the current RMS mod value and
the Ref value captured previously. (Displayed only when Hum
& Noise is enabled.)

Audio Summary Settings
Main menu bar: Setup > Settings 

The measurement settings for the Audio Summary display are shown in the following table.

Settings tab Description

Params1 Tab on page 573 Specifies signal type, Audio Bandwidth, RBW, RBW filter, and Ref Audio Frequency.

Params2 Tab on page 574 Specifies Harmonics and Non-Harmonics measurement parameters.

Audio Filters Tab on page 575 Specifies the audio filter characteristics.

Hum & Noise Tab Specifies whether or not Hum & Noise is measured and enables the capture of a signal to be used as
a reference of the Hum & Noise measurement.

Audio Analysis Measurement Settings
The control panel tabs in this section are shared by the displays in the Audio Analysis folder (Setup > Displays).

Table 34: Common controls for Audio Analysis displays

Settings tab Description

Params1 Tab on page 573 Specifies characteristics about the audio signal and how measurements are made.

Params2 Tab on page 574 Specifies parameters that control how measurements are made on harmonics.

Table continued…
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Settings tab Description

Audio Filters Tab on page 575 Specifies characteristics of filters applied to the signal before measurements are taken.

Scale Tab on page 182 Sets vertical and horizontal scale and position parameters.

Prefs Tab for Audio Analysis The Prefs tab enables you to change appearance characteristics of the Audio Analysis displays.

Params1 Tab
The Params1 tab is used to specify characteristics of the audio signal to be measured and how the signal will be measured.

Figure 76: Params1 tab for AM signal types

Setting Description

Signal Type Specifies the type of signal to be analyzed. The available choices are AM, FM, PM, and Direct.

Audio BW Specifies the bandwidth used for audio analysis.

Ref Audio Freq A measured value when Auto is selected. If you want to specify the reference audio frequency,
uncheck Auto and enter a value manually. If Ref Audio Freq is set manually, be aware that the
automated detection is still performed, but it is limited to a frequency range of ±1% of the Audio BW
centered around the manually specified value.

Carrier Freq Error / Carrier Freq
Offset

(FM and PM only) A measured value, when Auto is selected. If Auto is unchecked, you can specify
the Carrier Frequency Offset.

RBW Displays the Resolution Bandwidth for Audio measurements. This value is automatically set by default
to 1/500 of the measurement bandwidth. To manually specify the RBW, uncheck Auto. The minimum
RBW value is limited to the larger of 1 Hz or AudioBW/10000. The maximum is limited to AudioBW/
100.

RBW Filter Specifies the windowing method used for the transform.

Setting Frequency for Direct Signal Types
Direct (unmodulated) signal analysis is only possible with the instrument Frequency control set to 0 Hz. You will receive a warning to
set Frequency to 0 Hz when Direct signal type is selected, if you haven’t already done so. Modulated signal types may be selected with
Frequency set to 0 Hz, but results are not meaningful in that case. For modulated signals, Frequency should always be set to a value ≥
Audio Bandwidth to avoid self-interference of the signal due to spectral folding.
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Setting Audio Bandwidth
For AM, FM and PM, the Audio Bandwidth control sets not only the demodulated signal bandwidth, but also determines the pre-
demodulation bandwidth. Set it to a value at least half the pre-demodulation signal bandwidth, as in this equation:
Audio BW ≥ Signal Bandwidth / 2

Note: When performing audio analysis, you should allow the Audio BW control to automatically set the acquisition bandwidth,
rather than manually adjusting the Acq BW control on the Sampling Parameters tab of the Acquire control panel. The audio
measurement will cause the Acq BW setting to be ≥ Audio BW (Direct) or ≥ 2 × Audio BW (AM, FM, PM).

For Direct signals, set Audio Bandwidth large enough to include any significant harmonics/non-harmonics or other signal component of
interest. For example, to measure up to the 10th harmonic of a signal with a 5 kHz fundamental component, set Audio Bandwidth to 10 x
5 kHz = 50 kHz.

For modulated signals, Audio Bandwidth must be set wide enough to include all significant signal modulation components in addition to the
desired audio analysis bandwidth. For AM this is similar to Direct. For example, to measure up to the 10th harmonic of an AM signal with
3 kHz fundamental component, set Audio Bandwidth to 10 x 3 kHz = 30 kHz. This ensures that the bandwidth of the data provided by the
system to the measurement will be at least of 60 kHz (2 x 30 kHz) which is sufficient for this signal and analysis requirement.

FM and PM are more complex. For FM, the analysis bandwidth needs to be at least twice as wide as the the sum of peak Frequency
Deviation and the Fundamental Frequency (Carsons rule). This is a parallel condition along with setting Audio Bandwidth large enough for
the maximum audio bandwidth to analyze. Therefore, for FM, Audio Bandwidth should be:
AudioBW (FM) = MAX( MaxAudioAnalysisFreq, FreqDeviation+FundamentalFreq )
where MaxAudioAnalysisFreq is the highest audio frequency desired in the analysis. For example, for an FM signal with fundamental
signal of 5 kHz and peak frequency deviation (one-sided) of 10 kHz, Acquisition Bandwidth should be at least (2*(10k+5k)) = 30 kHz, or an
Audio Bandwidth of 15 kHz. Also if the analysis should extend to the 8th harmonic, then the Audio Bandwidth needs to be at least 8*5 kHz
= 40 kHz. So Audio Bandwidth should be set to 40 kHz. Using the equation:
AudioBW(FM) = MAX( 8x5kHz, (10+5)kHz ) = MAX( 40 kHz, 15kHz) = 40 kHz
The formula for PM is:
AudioBW (PM) = MAX (MaxAudioAnalysisFreq, PMFreqDeviation+FundamentalFreq)
where
PMFreqDeviation = PMPhaseDeviationInRadians x FundamentalFreq
RBW Filter Shape
Select Kaiser in most cases for best measurement performance. Select Flattop only if you want to use standard markers to measure signal
amplitude with highest accuracy.

Params2 Tab
The Params2 tab is used to specify how the signal harmonics are measured and to control spectrum averaging. 
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Setting Description

No. of Harmonics Specifies the number of harmonics to detect. The detected harmonics are tagged with a number on
the spectrum trace. The available range is 1–20.

No. of Non-Harmonics Specifies the number of non-harmonics to detect. The detected non-harmonics are tagged with a
number on the spectrum trace. The available range is 0–20.

Averaging Specifies the number of averages used to compute the results. Range: 2–100.

Ignore region Specifies the region about the signal frequency where the instrument will ignore non-harmonics.

Non-Harmonic Threshold Specifies the level which a spectrum peak must exceed to be declared a non-harmonic signal
component.

Non-Harmonic Excursion Specifies the difference in level between a spectrum peak and the average noise level that must be
exceeded for the peak to be declared a non-harmonic signal component.

About Averaging In Audio Analysis Displays
Analysis averaging is implemented using a “block” method. This means that the entire record required for multiple spectrum computations
is acquired and analyzed within one analysis cycle. The result of each analysis update is a complete, independent result from a set of N
spectrums averaged together, where N is the Averaging control value.. Since each update is a fully averaged result, no partially averaged
results are output before a final result is available, so each output is fully valid. However, with large Averaging values, acquisition record
sizes and measurement times may become large, so care should be taken to select the minimum amount of averaging needed.

Audio Filters Tab
The Audio Filters tab is used to specify filters to be applied to the acquired audio signal before measurements are taken. You can select
from pre-defined filters or use a filter you define in a text file. You can also specify the de-emphasis time constant applied to the audio
signal and the telecom weighting filters used to measure noise. 

Predefined Filters

You can specify low-pass filter (LPF) and high-pass filter (HPF) settings, a de-emphasis time constant and/or a telecom weighting filter to
match the response of your receiver. Alternatively, you can create a text file to specify the frequency response points.

To use predefined filters:

1. Select the Predefined Filters option button.
2. Select the LPF, HPF, De-emphasis and Standard check boxes as appropriate.
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3. Select the desired filter parameter from the drop-down list for each of the enabled filters or select User from the list if you wish to use a
custom value. For LPF and HPF, the listed frequencies represent the 3dB cutoff point of the filter.

4. If you select User from the drop-down list, enter a value in the text entry box that appears.

To disable all filtering:

1. Select the Predefined Filters option button.
2. Deselect all four filter check boxes.

Table 35: Predefined audio filters

Filter type Available settings

LPF (Low Pass Filter)

(5th-order Butterworth response)

300 Hz

3 kHz

15 kHz

30 kHz

80 kHz

300 kHz

User4

HPF (High Pass Filter)

(5th-order Butterworth response)

20 Hz

50 Hz

300 Hz

400 Hz

User4

De-emphasis (FM only) 25 μs

50 μs

75 μs

750 μs

User. Range: 25 μs to 10 ms

Standard CCITT

C-message

4 User-entered values are restricted to maximum of 0.9 * Audio BW, and will automatically adjust downward to meet this limit (if required) when AudioBW is decreased.
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Standard. Use this setting to specify the telecom weighting filter. The characteristics of these filters are described in ITU-T
Recommendation O.41, Psophometer for Use on Telephone-type Circuits.

Using Custom Audio Filters
If you want to use audio filters that have a different response shape than the pre-defined filters, you can create a custom audio filter using
a text or CSV file to specify the desired filter frequency response.

To use a custom audio filter:

1. Verify that Audio Spectrum or Audio Summary is the selected display.
2. Click the Settings icon or select Setup > Settings.
3. Select the Audio Filters tab.
4. Click the File button.
5. Click the ... button and navigate to the location of the custom audio filter file you wish to use. Select the file you want to use and click

Open.
6. Acquire a new trace or replay a saved file to see the effect of the custom filter.

Creating a Custom Audio Filter. A custom audio filter file is either a plain text file or a CSV format file. The file contains frequency (in
Hz) and amplitude (in dB) value pairs which specify the filter frequency response shape. Each pair must be on a separate line. The filter
response between the points is interpolated using a cubic spline fit.

The following table shows the first few lines of a custom audio filter text file.

0, -100

16.66, -85

50, -63

100, -41

200, -21

300, -10.6

400, -6.3

500, -3.6

600, -2

700, -0.9

800, 0

... ...

Format and rule-checking on custom audio filter files is performed as follows:

• The maximum number of frequency and amplitude pairs is 1000.
• Column 1 (frequency values in Hertz).
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• Non-negative values only (zero is allowed).
• Strictly increasing order of frequencies (frequency value on each line > frequency value on previous line).
• There is no upper limit on the frequency value.

• Column 2 (amplitude values in dB units, where gain is a positive value and attenuation is a negative value).

• Values are restricted to the range -200 to +20 dB.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change acquisition control settings. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the level shown at the top of the graph for linear units or the top of the graph for log units (for
example, dBm).

Autoscale Resets the Position so that the highest trace points are in the graph. For linear units (Volts, Watts), the
Autoscale also adjusts Scale.

Horizontal

Left Changes the frequency shown at the left side of the graph.

Right Changes the frequency shown at the right side of the graph.

Autoscale Resets the Left and Right settings to show the entire trace.

Log Sets the graph horizontal axis to a logarithmic scale.

Reset Scale Resets the Vertical and Horizontal settings to their default values.

Hum & Noise Tab
Hum & Noise (available only when the Audio Summary display is the active display) is useful for comparing residual power or modulation
if the Ref value is captured when the Signal is On (Direct) or modulated (AM/FM/PM).  When the signal is turned off (Direct) or modulation
turned off (AM/FM/PM), Diff indicates how much residual Hum and Noise are still present in the measurement value.
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To display Hum & Noise measurement:

1. Select Setup > Displays.
2. In the Select Displays window, select the Audio Analysis folder.
3. Double-click the Audio Summary icon so that it appears in the Selected displays box.
4. Click OK
5. With the Audio Summary display selected, select Setup > Settings.
6. Select the Hum & Noise tab. Click on the Measure Hum & Noise checkbox so that it is checked.

The Hum & Noise values appear at the bottom list of measurements in the Audio Summary display.
7. Acquire an appropriate signal.
8. While the analyzer is analyzing a signal you want to use as a reference, click the Capture reference now button to save a reference

value.

The Hum & Noise measurement compares the value of a specific signal quantity captured by the Capture reference now button with the
current measured value of that quantity. For Direct signal types (set on the Params1 tab), the Signal Level is captured and compared. The
Diff measurement is:
SignalLevel(current) – SignalLevel(Ref)
in dB.

For AM, FM, and PM signal types, the RMS modulation value (related to Modulation Depth, Frequency Deviation or Phase Deviation) is
captured and compared. The Diff measurement is:

20 x log10 (RMS(current)/RMS(Ref))

in dB.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the Audio Spectrum display.

Setting Description

Units: Specifies the vertical scale units. The units available depend on the signal type selected.

Show graticule Select to display or hide the graticule.

Table continued…
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Setting Description

Trace points Sets the number of trace points used for marker measurements and for results export.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show Non-Harm Threshold Shows or hides the non-harmonic threshold line.
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GP Digital Modulation
Overview
The displays in General Purpose (GP) Digital Modulation (Displays > Measurements > GP Digital Modulation) are:

• Constellation
• Demod I & Q vs Time
• EVM vs Time
• Eye Diagram
• Frequency Deviation vs Time
• Magnitude Error vs Time
• Phase Error vs Time
• Signal Quality
• Symbol Table
• Trellis Diagram

The General Purpose Digital Modulation Analysis (Option 21) provides vector signal analyzer functionality. A wide variety of modulation
types are supported, allowing you to view your signals in Constellation, Eye and Trellis diagrams, measure the quality of the modulation,
display time-domain waveforms for demodulated I & Q signals, EVM, Phase Error, Magnitude Error, and more.

Modulation Measurements

Note: A maximum of approximately 163,800 samples can be analyzed by the General Purpose Digital Modulation measurements
(the actual value varies with modulation type).

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and
can be reported in units of percent or dB. EVM is usually measured after best-fit estimates of the
frequency error and a fixed phase offset have been removed.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.

Magnitude Error The RMS magnitude difference between the measured signal and the ideal reference signal.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the magnitude
of the carrier feed-through signal.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path. Constellations with
gain imbalance show a pattern with a width that is different from height.

Rho ρ The normalized correlated power of the measured signal and the ideal reference signal. Like EVM,
Rho is a measure of modulation quality. The value of Rho is less than 1 in all practical cases and is
equal to 1 for a perfect signal measured in a perfect receiver.

Table continued…
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Measurement Description

Frequency Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the analyzer.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference between
I and Q channels away from the ideal 90 degrees expected from the perfect I/Q modulation.
Constellations with quadrature error will show some leakage of I into Q and vice versa.

Constellation Display
The Constellation Display shows a digitally-modulated signal in constellation form.

To show the Constellation Display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the Constellation icon in the Available Displays box. This adds the Constellation icon to the Selected displays box.
4. Click the OK button. This shows the Constellation display.

Elements of the Constellation Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Constellation display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

Table continued…

GP Digital Modulation

RSA5100B Series Real-Time Signal Analyzers Help 582



Item Display element Description

2 Marker Readout Located to the left of the constellation plot or below it, depending on the size of the
window. If markers are enabled, the marker readout shows the time, mag, phase, symbol
marker and symbol value of the point with the selected marker.

3 EVM Readouts The EVM readouts are located below the Constellation plot. The readout shows EVM
Peak (%) and location, RMS (%).

4 Plot Constellation graph.

Changing Constellation Settings

Constellation Settings
Main menu bar: Setup > Settings 

The settings for the Constellation view are shown in the following table.

Note: You might be able to save time configuring the Constellation display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604

Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation, symbol rate, and filters to be used in demodulating the input signal.

Freq & BW Sets values for frequency error/offset, measurement bandwidth, and frequency deviation (not every
control is present for every modulation type).

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

Specifies additional parameters that are less frequently used.

Find Tab on page 614 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 615 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 616 Allows you to set the trace display characteristics.

Prefs Tab on page 619 Enables you to set characteristics of the measurement display.

Demod I & Q vs Time Display
The Demod I & Q vs Time displays demodulated I and Q vs. Time. You can choose to display I only, Q only, or both.
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Elements of the Display
To show the Demod I & Q vs Time display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the Demod I&Q vs Time icon in the Available Displays box. This adds the Demod I&Q vs Time icon to the Selected

displays box.
4. Click the OK button. This shows the Demod I&Q vs Time display.

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Demod I & Q vs Time display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the I and Q amplitude value indicated at the top of the graph. Changing the top value
affects the bottom of graph readout. Also, note that the top of graph setting interacts with
the internal vertical scale setting (which is not user settable) such that the range between
the top and bottom of the graph increases or decreases automatically.

3 Position Specifies the I and Q amplitude value shown at the center of the graph display.

4 Bottom Readout Displays the I and Q amplitude value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Specifies the horizontal position of the trace on the graph display.

Table continued…
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Item Element Description

7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the graph
essentially becomes a window that you can move over the acquisition record by adjusting
the offset.

8 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq Error, it shows
the difference between the instrument Frequency setting and the measured value of the
signal's carrier frequency. When it displays Freq Offset, it shows the frequency offset
specified on the Settings & Freq & BW tab. If Freq Error is displayed, it also indicates that
the Carrier frequency detection setting is Auto. If Freq Offset is displayed, it indicates that
the Carrier frequency detection setting is manual.

Changing Demod I&Q Settings.

Demod I & Q vs Time Settings
Main menu bar: Setup > Settings 

The settings for the Demod I & Q vs Time display are shown in the following table.

Note: You might be able to save time configuring the Demod I & Q display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604

Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

Specifies additional parameters.

Find Tab on page 614 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 615 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 616 Allows you to set the trace display characteristics.

Scale Tab on page 618 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 619 Enables you to set characteristics of the measurement display.
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EVM vs Time Display
The EVM vs. Time Display shows the Error Vector Magnitude plotted over Time.

Note: A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital Modulation measurements
(the actual value varies with modulation type).

To show an EVM vs. Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the EVM vs. Time icon in the Available Displays box. This adds the EVM vs. Time icon to the Selected displays box.
4. Click the OK button. This displays the EVM vs. Time view.

Elements of the EVM vs Time Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the vertical scale.

2 Position Adjusts the vertical position.

3 Autoscale Adjusts the Horizontal and Vertical scale to show the entire trace.

4 Peak and RMS value readout Shows the maximum result, the time it occurred, and the RMS of the result over the entire
analysis length.

5 Scale Sets the length of time shown in the graph.

Changing the EVM vs Time Display Settings

EVM vs Time Settings
Main menu bar: Setup > Settings 
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The settings for the EVM vs. Time display are shown in the following table.

Note: You might be able to save time configuring the EVM vs. Time display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604

Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation used in the input signal and other parameters that controls the
demodulation of the input signal.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

Specifies Freq Offset, Magnitude normalization parameters, and enables swapping I and Q.

Find Tab on page 614 The Find tab is used to set parameters for finding bursts within the data record.

Analysis Time Tab on page 615 The Analysis Time tab contains parameters that define how the signal is analyzed in the general
purpose digital modulation displays.

Trace Tab on page 616 Specifies the display characteristics of the displayed trace.

Scale Tab on page 618 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 619 Specifies whether certain display elements are visible.

Eye Diagram Display
The Eye Diagram Display shows a digitally modulated signal overlapped on itself to reveal variations in the signal.

To show an Eye Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the Eye Diagram icon in the Available Displays box. This adds the Eye Diagram icon to the Selected displays box.
4. Click the OK button. This displays the Eye Diagram view.
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Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Frequency Deviation vs Time display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph The vertical scale is normalized with no units (except for nFSK and C4FM modulation
types where the vertical units are Hz).

3 Position Specifies the value shown at the center of the graph display.

4 Bottom Readout Displays the value indicated by the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Displays the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph in symbols.

8 Freq Error Displays the difference between the maximum and minimum measured values of the
signal frequency during the Measurement Time. The displayed frequency error is followed
by either Auto or Manual. This indicates the selected carrier frequency detection method
(see Settings > Freq & BW).

Changing Eye Diagram Settings
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Eye Diagram Settings
Main menu bar: Setup > Settings 

The settings for the Eye Diagram display are shown in the following table.

Note: You might be able to save time configuring the Eye Diagram display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604

Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Advanced Params
Tab on page 611

Specifies additional parameters.

Find Tab on page 614 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 615 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 616 Allows you to set the trace display characteristics.

Scale Tab on page 618 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 619 Enables you to set characteristics of the measurement display.

Frequency Deviation vs Time Display
To show a Frequency Deviation vs Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select Frequency Deviation vs Time.
3. Double-click the Frequency Deviation vs Time icon in the Available Displays box. This adds the Frequency Deviation vs Time icon

to the Selected displays box.
4. Click the OK button. This displays the Frequency Deviation vs Time view.

GP Digital Modulation

RSA5100B Series Real-Time Signal Analyzers Help 589



Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Frequency Deviation vs Time display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the frequency deviation value indicated at the top of the graph. Changing the top
value affects the bottom of graph readout. Also, note that the top of graph setting interacts
with the internal vertical scale setting (which is not user settable) such that the range
between the top and bottom of the graph increases or decreases automatically.

3 Position Specifies the frequency deviation value shown at the center of the graph display.

4 Bottom Readout Displays the value of the frequency deviation value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the graph
essentially becomes a window that you can move over the acquisition record by adjusting
the offset.

8 Freq Error Displays the difference between the maximum and minimum measured values of the
signal frequency during the Measurement Time. The displayed frequency error is followed
by either Auto or Manual. This indicates the selected carrier frequency detection method
(see Settings > Freq & BW).
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Changing Frequency Deviation vs Time Settings

Frequency Deviation vs Time Settings
Main menu bar: Setup > Settings 

The Setup settings for Frequency Deviation vs. Time are shown in the following table.

Note: You might be able to save time configuring the Frequency vs. Time display by pressing the Standard Settings button from
the Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604

Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

Specifies additional parameters.

Find Tab on page 614 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 615 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 616 Allows you to set the trace display characteristics.

Scale Tab on page 618 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 619 Enables you to set characteristics of the measurement display.

Magnitude Error vs Time Display
The Magnitude Error displays the magnitude of the symbol error. The amplitude appears on the vertical axis while time is plotted along the
horizontal axis.

Note: A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital Modulation measurements
(the actual value varies with modulation type).

To display Magnitude Error vs. Time:

1. Select the Displays button or Setup > Displays. This displays the Select Displays dialog box.
2. Select GP Digital Modulation in the Measurements box.
3. Double-click the Mag Error vs. Time icon or select the icon and click Add. The icon will appear in the Selected displays box and will

no longer appear under Available displays.
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4. Click OK.

Elements of the Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the value of the vertical scale.

2 Position Adjusts the level shown at the bottom of the display.

3 Autoscale button Adjusts the vertical and horizontal settings to provide the best display.

4 Horizontal Position Adjusts the horizontal position of the signal. Units can be either Symbols or Seconds
(Settings > Analysis Time tab > Units).

5 Peak and RMS value readout Displays the Peak value of the magnitude error, the RMS value of the magnitude error,
and the time at which it occurs within the acquisition. Units can be either Symbols or
Seconds (Settings > Analysis Time tab > Units).

6 Horizontal Scale Sets the time spanned by the graph. Units can be either Symbols or Seconds (Settings >
Analysis Time tab > Units).

7 Freq Error Freq Error is the difference between the Center Frequency and the measured frequency of
the signal being tested. This readout will be Freq Offset if the Freq Offset parameter on the
Settings > Advanced Params tab is set to Manual.

Changing Magnitude Error vs Time Display Settings

Magnitude Error vs Time Settings
Main menu bar: Setup > Settings 
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The Setup settings for Magnitude Errors vs. Time are shown in the following table.

Note: You might be able to save time configuring the Magnitude vs. Time display by pressing the Standard Settings button from
the Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604

Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

Specifies additional parameters.

Find Tab on page 614 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 615 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 616 Allows you to set the trace display characteristics.

Scale Tab on page 618 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 619 Enables you to set characteristics of the measurement display.

Phase Error vs Time Display
The Phase Error vs. Time display shows the phase angle of the symbol error over time. The phase is plotted along the vertical axis while
time is plotted along the horizontal axis.

Note: A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital Modulation measurements
(the actual value varies with modulation type).

To show the Phase Error display:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays dialog, select GP Digital Modulation in the Measurements box.
3. In the Available displays box, double-click the Phase Error icon or select the icon and click Add. The Phase Error icon will appear in

the Selected displays box and will no longer appear under Available displays.
4. Click OK to display the Phase Error.
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Elements of the Phase Error vs Time Display

Item Display element Description

1 Freq Error Freq Error is the difference between the Center Frequency and the measured frequency of
the signal being tested. This readout will be Freq Offset if the Freq Offset parameter on the
Settings > Advanced Params Tab on page 611 tab is set to Manual.

2 Top of graph adjustment Adjusts the phase angle shown at the top of the graph.

3 Position Adjusts the vertical offset.

4 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the graph.

5 Offset Adjusts the horizontal offset.

6 Peak and RMS readouts Displays the Peak value of the phase error and the time at which it occurred. Also displays
the RMS value over the analysis length.

7 Scale Sets the time spanned by the graph.

Changing the Phase Error vs Time Display Settings

Phase Error vs. Time Settings
Main menu bar: Setup > Settings 

The settings for the Phase Error vs. Time display are shown in the following table.

Note: You might be able to save time configuring the Phase Error vs. Time display by pressing the Standard Settings button from
the Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604
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Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

Specifies additional parameters.

Find Tab on page 614 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 615 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 616 Allows you to set the trace display characteristics.

Scale Tab on page 618 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 619 Enables you to set characteristics of the measurement display.

Signal Quality Display
The Signal Quality display shows several measurements of signal quality. The measurements displayed depend on the modulation type.
There is a set of measurements displayed for all modulation types except nFSK and C4FM. There is a second set of measurements
displayed for nFSK and C4FM modulation types.

Figure 77: Signal Quality display for all modulation types except nFSK, C4FM, OQPSK, and SOQPSK
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Figure 78: Signal Quality display for OQPSK and SOQPSK modulation types

Figure 79: Signal Quality display for nFSK modulation type

Figure 80: Signal Quality display for C4FM modulation type

Elements of the Display
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Table 36: Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and is
reported in units of percent and dB. EVM is usually measured after best-fit estimates of the frequency
error and a fixed phase offset have been removed. These estimates are made over the analysis
length. Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal. Displays
RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal magnitude.
Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the magnitude
of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path. Constellations with
gain imbalance show a pattern with a width that is different form height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference between I
and Q channels away from the ideal 90 degrees expected from the perfect I/Q modulation. Not valid
for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal. Like EVM,
Rho is a measure of modulation quality. The value of Rho is less than 1 in all practical cases and is
equal to 1 for a perfect signal measured in a perfect receiver.

Table 37: Measurements for OQPSK and SOQPSK modulation types

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal reference
signal over the analysis length. The EVM is generally measured on symbol or chip instants and is
reported in units of percent and dB. EVM is usually measured after best-fit estimates of the frequency
error and a fixed phase offset have been removed. These estimates are made over the analysis
length. Displays RMS and Peak values with location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q samples. For EVM,
I and Q samples are collected at the same time, for every symbol decision point (twice the symbol
rate for offset modulations). For Offset EVM, the I and Q symbol decision points are time-aligned
before collecting the I and Q samples. In this case, one I and one Q sample is collected for each
symbol (half as many samples as the same number of symbols for (non-offset) EVM.

Table continued…
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Measurement Description

Phase Error The RMS phase difference between the measured signal and the ideal reference signal. Displays
RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal magnitude.
Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates the magnitude
of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path. Constellations with
gain imbalance show a pattern with a width that is different form height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase difference between I
and Q channels away from the ideal 90 degrees expected from the perfect I/Q modulation. Not valid
for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal. Like EVM,
Rho is a measure of modulation quality. The value of Rho is less than 1 in all practical cases and is
equal to 1 for a perfect signal measured in a perfect receiver.

Table 38: Measurements for nFSK modulation types

Measurement Description

Peak FSK err Peak value of the frequency deviation error at the symbol point.

RMS FSK Err RMS value of the frequency deviation error at the symbol point.

Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal magnitude.

RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal magnitude.

Freq Error The frequency difference between the measured carrier frequency of the signal and the user-selected
center frequency of the instrument.

Freq Deviation Frequency distance from the center frequency at the symbol point.

Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of the analyzed
signal.

Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and the instrument
calculates the error between the user entered value and the instrument calculated value.
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Table 39: Measurements for C4FM modulation type

Measurement Description

RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.

Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.

Deviation Frequency distance from the center frequency at the symbol point.

Length Number of symbols in the analysis area.

Changing the Signal Quality Display Settings

Signal Quality Settings
Main menu bar: Setup > Settings 

The Setup settings for Signal Quality are accessible only when the Signal Quality display is selected.

Note: You might be able to save time configuring the Signal Quality display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604

Settings tab Description

Modulation Params
Tab on page 604

The Modulation tab specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

The Advanced Params tab specifies frequency offset, magnitude normalization method and allows
you to swap the I and Q signals.

Find Tab on page 614 Find tab is used to set parameters for finding bursts within the data record.

Analysis Time Tab on page 615 The Analysis Time tab contains parameters that define the portion of the acquisition record that is
used for analysis.

Prefs Tab on page 619 The Prefs tab enables you to set characteristics of the measurement display.
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Symbol Table Display
The Symbol Table Display is like the Constellation Display except that a text table is used to display data bits at a symbol rather than a
graph. The Synch Word characters, if used, are in bold font.

To display the Symbol Table:

1. Recall an appropriate acquisition data file.
2. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.
3. From the Measurements box, select GP Digital Modulation.
4. Double-click the Symbol Table icon in the Available Displays box. This adds the Symbol Table icon to the Selected displays box.
5. Click the OK button. This displays the Symbol Table view.
6. Press the Replay button to take measurements on the recalled acquisition data file.

Using Markers
Markers are indicators in the display that you can position on a trace to measure values such as frequency, power, and time. A Marker
always displays its position and, if the Delta readout is enabled, will display the difference between its position and that of the Marker
Reference. Within the Symbol Table, colored cells indicate the location of markers. The selected Marker is highlighted with a light green
background. All other markers are highlighted with a light gray background. In the Symbol Table, the marker readout below the table shows
the marker location in time, symbol numbers and symbol value.

Changing the Symbol Table Display Settings

Symbol Table Settings
Main menu bar: Setup > Settings 

The Setup settings for the Symbol Table view are shown in the following table.

Note: You might be able to save time configuring the Symbol Table display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604
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Settings tab Description

Modulation Params
Tab on page 604

The Modulation tab specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

The Advanced Params tab specifies additional parameters.

Find Tab on page 614 Find tab is used to set parameters for finding bursts within the data record.

Analysis Time Tab on page 615 The Analysis Time tab contains parameters that define the portion of the acquisition record that is
used for analysis.

Prefs Tab on page 619 The Prefs tab enables you to set characteristics of the measurement display.

Trellis Diagram Display
To show an Trellis Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
2. From the Measurements box, select GP Digital Modulation.
3. Double-click the Trellis Diagram icon in the Available Displays box. This adds the Trellis Diagram icon to the Selected displays box.
4. Click the OK button. This displays the Trellis Diagram view.

Elements of the Display
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows when the
Frequency Deviation vs Time display is the optimized display.

Note: When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays shows a
checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the phase value indicated at the top of the graph. Changing the top value affects the
bottom of graph readout. Also, note that the top of graph setting interacts with the internal
vertical scale setting (which is not user settable) such that the range between the top and
bottom of the graph increases or decreases automatically.

3 Position Specifies the phase value shown at the center of the graph display.

4 Bottom Readout Displays the value of the phase value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Displays the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph in symbols.

8 Freq Error Displays the difference between the maximum and minimum measured values of the
signal frequency during the Measurement Time. The displayed frequency error is followed
by either Auto or Manual. This indicates the selected carrier frequency detection method
(see Settings > Freq & BW).

Changing the Trellis Diagram Settings

Trellis Diagram Settings
Main menu bar: Setup > Settings 

The settings for the Trellis Diagram display are shown in the following table.

Note: You might be able to save time configuring the Trellis Diagram display by pressing the Standard Settings button from the
Settings control panel. This allows you to select a preset optimized for a standard from the Select Standard dialog box. See
Standard Settings Button on page 604

Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW Specifies settings for frequency error, measurement BW and Frequency Deviation. Each of these
settings is set internally when set to Auto. Alternatively, you can specify values appropriate for specific
measurement needs.

Table continued…
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Settings tab Description

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

Specifies additional parameters.

Find Tab on page 614 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 615 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 616 Allows you to set the trace display characteristics.

Scale Tab on page 618 Specifies the horizontal and vertical scale settings.

Prefs Tab on page 619 Enables you to set characteristics of the measurement display.

GP Digital Modulation Shared Measurement Settings
The displays in the GP Digital Modulation folder (Setup > Displays) are each a different format for presenting the results of a single
underlying analysis. For this reason, all controls that affect the analysis parameters are shared by all the displays in the GP Digital
Modulation folder.

Changing a setting on one tab changes that setting for all the GP Digital Modulation displays. For example, if you change the Modulation
Type for the Constellation Display, it also changes the Modulation type setting for the Signal Quality display. There are some controls that
affect only the way an individual display presents its results, such as graph scaling.

Table 40: Common controls for GP digital modulation displays

Settings tab Description

Modulation Params
Tab on page 604

Specifies the type of modulation, symbol rate, and filters to be used in demodulating the input signal.

Freq & BW Sets values for frequency error/offset, measurement bandwidth, and frequency deviation (not every
control is present for every modulation type).

Equalizer Tab on page 610 Enable the Equalizer and adjust its parameters.

Advanced Params
Tab on page 611

Specifies additional parameters that are less frequently used.

Find Tab on page 614 Used to set parameters for finding a burst within the data record and for entering a Synch word.

Analysis Time Tab on page 615 Contains parameters that define the portion of the acquisition record that is used for analysis. Also
allows you to specify the Units (Seconds or Symbols) for the GP Digital Modulation displays.

Trace Tab on page 616 Allows you to set the trace display characteristics.

Prefs Tab on page 619 Enables you to set characteristics of the measurement display.
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Standard Settings Button
On every GP Digital Modulation control panel there is a button labeled Standard Settings. This button is used to recall settings optimized
for analyzing the selected standard. See the following table for a list of the standards for which standard settings are available. Choosing a
standard from the dialog box changes only settings for GP Digital Modulation displays. 

All of the presets in the Standard Settings Dialog make the following settings:

• Analysis Length: Auto
• Points per Symbol: 4
• Data Differential: No
• Burst Mode: Off
• Burst Detection Threshold:  -10 dBc

Table 41: Parameter values set by presets in the standard settings dialog

Standard Modulation Symbol Rate Meas. Filter Reference Filter Filter Parameter Other

802.15.4 OQPSK 1e6 None Half sine NA

SBPSK-MIL SBPSK 2.4e3 None SBPSK-MIL NA

SOQPSK-MIL SOQPSK 2.4e3 None SOQPSK-MIL NA 5

CPM-MIL CPM 19.2e3 None None NA

SOQPSK-ARTM Tier 1 SOQPSK 2.5e6 None SOQPSK-ARTM NA 5

Project25 Phase 1 C4FM 4.8e3 C4FM-P25 RC 0.2

CDMA2000–Base QPSK 1.2288e6 IS-95
TXEQ_MEA

IS-95 REF NA

W-CDMA QPSK 3.84e6 RRC RC 0.22

Modulation Params Tab
Menu bar: Setup > Settings > Modulation Params 

The Modulation Params tab specifies the type of modulation on the input signal and other parameters that control the demodulation of the
input signal.

5 Center Symbol Position, Half Shift Removed
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Parameter Description
Modulation type Specifies the type of modulation on the input signal.
Symbol Rate Specifies the symbol rate in Hertz.
Measurement Filter Specifies the filter used for measurements.
Reference Filter Specifies the filter used as a reference.
Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some filter types)
Modulation index (Present only for CPM modulation type)

Modulation Type
The modulation types that can be demodulated and analyzed are:

Modulation type Description
QPSK Quadrature Phase Shift Keying
8PSK 8-Phase Shift Keying
D8PSK Differential Eight Phase Shift Keying
D16PSK Differential Sixteen Phase Shift Keying
PI/2DBPSK Pi/2 Differential Binary Phase Shift Keying
DQPSK Differential Quadrature Phase Shift Keying
PI/4DQPSK Pi/4 Differential Quadrature Phase Shift Keying
BPSK Binary Phase Shift Keying
OQPSK Offset Quadrature Phase Shift Keying
16QAM 16-state Quadrature Amplitude Modulation
32QAM 32-state Quadrature Amplitude Modulation
64QAM 64-state Quadrature Amplitude Modulation
128QAM 128-state Quadrature Amplitude Modulation
256QAM 256-state Quadrature Amplitude Modulation
MSK Minimum Shift Keying
2FSK 2-Frequency Shift Keying
4FSK 4-Frequency Shift Keying
8FSK 8-Frequency Shift Keying
16FSK 16-Frequency Shift Keying
CPM Continuous Phase Modulation
SOQPSK Shaped Offset Quadrature Phase Shift Keying
SBPSK Shaped Binary Phase Shift Keying
C4FM Constant Envelope 4-Level Frequency Modulation
16APSK 16-symbol Amplitude Phase Shift Keying
32APSK 32-symbol Amplitude Phase Shift Keying
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Symbol Rate
Specifies the symbol rate for demodulating digitally modulated signals. The symbol rate and the bit rate are related as follows:

(Symbol rate) = (Bit rate)/(Number of bits per symbol)

For example, the number of bits per symbol is 3 for 8PSK.

Measurement and Reference Filters
The available measurement and reference filters depend on the selected modulation type. If a particular filter is not practical for a
selected modulation type, it is not presented as an available filter. To determine which filters are available, make certain that your desired
modulation type is selected. See the following table.

Modulation type Measurement filters Reference filters
BPSK None

RootRaisedCosine

RaisedCosine

Gaussian

User

Rectangular (freq)

IS-95TX_MEA

IS-95TXEQ_MEA

None

RaisedCosine

Gaussian

User

Rectangular (freq)

IS-95REF

PI/2DBPSK
8PSK
D8PSK
DQPSK
PI/4DQPSK
16QAM
32QAM
64QAM
128QAM
256QAM
QPSK
16APSK
32APSK
MSK None

Root Raised Cosine

RaisedCosine

Gaussian

User

Rectangular (freq)

None

Gaussian

User

OQPSK None

RootRaisedCosine

User

IS-95TX_MEA

IS-95TXEQ_MEA

None

Half sine

RaisedCosine

User

IS-95REF

Table continued…
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Modulation type Measurement filters Reference filters
HDQPSK HDQPSK-P25 None

RaisedCosine

Gaussian

User

Rectangular (freq)

SOQPSK None

User

SOQPSK-MIL

SOQPSK-ARTM

User

CPM None

User

None

User

2FSK None

Gaussian

RootRaisedCosine

RaisedCosine

Rectangular (freq)

User

None

Gaussian

RaisedCosine

User

4FSK
8FSK
16FSK

C4FM C4FM-P25 RaisedCosine

User

SBPSK None

User

SBPSK-MIL

User

The measurement filter is applied before the demodulation bit is detected and the ideal reference is calculated.

The reference filter is applied to the internally generated ideal reference signal before the EVM is calculated.

Measurement BW
The measurement BW (reported on the Settings > Freq & BW tab) is computed based on the Modulation Type, the Symbol Rate (SR), the
Reference Filter type, and the Filter Parameter (alpha). The following table shows the formulas used, where SR= symbol rate, and α = filter
parameter.

Modulation type Measurement filter Measurement bandwidth

QPSK, 8PSK, D8PSK, DQPSK,
PI/4DQPSK, BPSK, PI/2DBPSK,
QAM16-256, APSK

Raised Cosine

None / Rectangular

All others

SR * (1 + α)

SR * 16

SR * 2

Table continued…
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Modulation type Measurement filter Measurement bandwidth

D16PSK Raised Cosine

None / Rectangular

All others

SR * (1.5 + α)

SR * 16

SR * 2.5

OQPSK Raised Cosine

Half Sine

None / Rectangular

All others

SR * 2

SR * 12

SR * 16

SR * 2

GMSK Gaussian

None / Rectangular

All others

SR * 12 * α

SR * 4

SR * 4

GFSK, FSKn, C4FM All SR * 8

How to Select Filters
In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for another kind of necessary
shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This setting tells the analyzer what
filter your receiver uses. When the analyzer is set to the same filter used by the receiver, the analyzer sees the signal as your receiver
would. The Measurement Filter setting should be the same as the filter used in the receiver under normal operation (as opposed to
testing).

The Reference Filter setting in the analyzer corresponds to the baseband filter in the transmitter-receiver combination (Fr * Ft). The
baseband filter for the transmitter-receiver combination is often referred to as the System Filter. This filter is called the reference filter
because it is used to recreate a reference signal that is compared to the received signal. This recreated reference signal is the ideal signal
with Fr * Ft applied; differences between this ideal signal and the received signal enables the determination of signal quality, such as EVM
measurements.

The following is an example of a hypothetical signal that is transmitted into a vector signal analyzer for analysis:

Assume that a signal is transmitted using a baseband filter (Ft). It then travels through a transmission medium (air/cable/etc) where it may
affected by the communication channel (Fc). The signal is received and filtered by the receiver’s filter (Fr). At this point, the signal has
passed through Ft and Fr, and in addition, the communication channel might have affected it (so: Ft * Fr * Fc). This double-filtered signal is
demodulated as it was received to determine the symbols/bits in it. The obtained bits are used to regenerate a baseband ideal signal that
can be compared against the received signal to determine signal quality. However, to determine the effect of the environment on the signal
quality, the ideal signal must be filtered by the REFERENCE FILTER (Ft * Fr), so that the ideal signal and the filtered signal differ only by
the effect of the environment. So, the received signal is the ideal signal filtered by Ft * Fr * Fc and the reference signal is the ideal
signal filtered by Ft * Fr, since they only differ by the effect of Fc, the comparison will show the effect of the communication channel
on the signal. The communication channel can also include the hardware path the signal follows after (Tx) or before (Rx) digitizing; this
would account for Tx/Rx hardware linear and non-linear distortion.

Common examples of how these filters are used are shown below:

• For Transmit Filter = Root Raised Cosine (RRC), Measurement Filter = RRC, the Reference Filter = RRC ^2 = Raised Cosine
• For Transmit Filter = Raised Cosine (RC), Measurement Filter = None, the Reference Filter = Raised Cosine (When the Measurement

Filter = None, the Reference Filter = Transmit Filter)
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• For Transmit Filter = Gaussian, Measurement Filter = None, the Reference Filter = Gaussian

Filter Parameter
The filter parameter specifies the alpha for the Root Raised Cosine or Raised Cosine filter, or the bandwidth-time product (BT) for the
Gaussian filter, when selected as the Reference filter. Some filter types have a fixed parameter value that is specified by industry standard,
while other filter types by definition have no filter parameter. For filter types with no filter parameter, there is no filter parameter control
present in the control panel.

Freq & BW Tab
The Freq & BW tab specifies a group of settings that affect how measurements are made.

Figure 81: Freq & BW tab with nFSK or C4FM modulation type selected and Frequency Error readout enabled (Auto selected)

Figure 82: Freq & BW tab with SOQPSK modulation type selected and Frequency Offset enabled (Auto deselected)

Setting Description

Frequency Error / Frequency
Offset

When Auto is enabled, this readout displays frequency error and the measurement is made at the
calculated frequency. When Auto is disabled, this setting changes to Frequency Offset. When set to
Frequency Offset, this setting is used to demodulate a signal that is not at the center frequency. The
measurement is made at the user-entered offset. The Measurement Filter (if any, specified on the
Modulation Params tab) is applied about the offset frequency whether set automatically or manually.

Measurement BW This setting allows you to override the automatic bandwidth calculation and directly enter a bandwidth
value. If you enter a value for the measurement bandwidth, be aware that the actual bandwidth of
data provided to the measurement will be at least as wide as the value you request and may be as
much as two times wider than requested. This override of the selected measurement bandwidth is
done so that the instrument uses sufficient bandwidth relative to the chosen symbol rate to ensure
good signal quality measurements.

Frequency Deviation For nFSK modulation types, this setting specifies the frequency deviation. Select Auto to make the
instrument do this automatically. Deselect Auto to enter a value manually.

This setting is present for only nFSK and C4FM modulation types.
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Equalizer Tab
The Equalizer tab enables you to apply an adaptive equalizer to a digitally modulated signal to compensate for linear distortions in the
signal. The Equalizer is available only for displays in the GP Digital Modulation folder (Select Displays window). The analyzer implements a
decision directed, feed-forward FIR filter to correct linear distortion in the input signal.

Parameter Description

Enable Equalization This setting turns the Equalizer on and off.

Reset Equalization Initializes the equalizer filter for training.

Enable EQ Export Exports a text file with equalizer taps in I/Q pairs.

Mode Specifies whether the equalizer is in learning (Train) mode or analysis (Hold) mode.

Convergence Specifies the update rate. Maximum value: 0.002. Default value: 0.0005

Taps/Symbol The number of filter coefficients per symbol used by the filter. Available choices are 1, 2, 4, and 8.

Taps The number of filter coefficients. Range: 3 to 100 (you can set a higher number, but 100 is the
practical limit).

Length Specifies the number of symbols analyzed (or filter length).

Selecting the Mode
When enabled, the Equalizer is in either Train mode or Hold mode. When the equalizer is in Train mode, it will update internal filter
parameters whenever you adjust the Convergence, Taps/Symbol, Taps, or Length values. When it is in Hold mode, the Equalizer uses the
parameter values (both internal and the values accessible on the Equalizer tab) in effect when it was placed into Hold mode.

Note: The Equalizer does not need to be retrained if the modulation type is changed. You can train the Equalizer by using a
simpler modulation type (such as QPSK), place the Equalizer into Hold mode and can then measure more complex modulation
types such as QAM.

Training the Equalizer
To obtain the desired results using the Equalizer, you must first train the Equalizer. This is an iterative process where you adjust some filter
parameters (and the analyzer adjusts internal parameters) to achieve the lowest error possible on the acquired signal.

To configure the Equalizer:

1. Press the Displays button or select Setup > Displays.
2. In the Select Displays window, select GP Digital Modulation from Measurements.
3. Add Signal Quality to the Selected Displays and select OK.
4. With the Signal Quality display selected, select Setup > Settings.
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5. Select the Modulation Params tab set the parameters as necessary for the signal.
6. Select the Equalizer tab.
7. Set the Convergence value to 0.0005.
8. Set Taps/Symbol to 2.
9. Click the Reset Equalization button to reset the equalizer.
10. Set the Mode to Train.
11. Click Enable Equalization so it is checked.
12. On the Signal Quality display, examine the value for EVM.
13. Change the Convergence, Taps/Symbol, and Taps values iteratively to achieve a minimum EVM value.

Note: Changing the Taps/symbol or Taps values resets the equalizer.

Using the Equalizer
To use the equalizer:

1. Select and configure a GP Digital Modulation display.
2. Select Setup > Settings.
3. Select the Equalizer tab.
4. Select Enable Equalization so it is checked.
5. Verify that Mode is set to Hold if you have previously trained the Equalizer. If you have not previously trained the Equalizer, Training

the Equalizer on page 610 and then set the Mode to Hold.

Exporting EQ Files
If the Enable EQ Export box is checked, the following outputs files are automatically generated to these locations after each measurement
update cycle if the EQ coefficients change: c:\temp\EqTaps.txt and c:\temp\EqTapsHdr.txt. These files have EQ taps in I/Q pairs (one pair
per row).

The Hdr version file has a five line header before the EQ tap data. Each line in the five line header of the Hdr version file has two data
values, with the second one always being "0":

<line1>Number_of_Header_Lines 0

<line2>EQ_Sample_Rate_Hz 0

<line3>Demod_Symbol_Rate_Sps 0

<line4>EQ_Samples_per_Symbol  0

<line5>Number_of_EQ_Taps_Following 0

Exporting EQ Files

Advanced Params Tab
The Advanced Params tab specifies additional parameters that control the demodulation of the signal.
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Figure 83: Advanced Params tab for all modulation types except nFSK and C4FM

Figure 84: Advanced Params tab for modulation type nFSK

Figure 85: Advanced Params tab for modulation type C4FM

Figure 86: Advanced Params tab for modulation type APSK

Parameter Description

Mag Normalize

(not present for nFSK or C4FM
modulation types)

Select RMS Symbol Magnitude or Max Symbol Magnitude. This setting applies to Mag Error and
EVM.

Swap I and Q When enabled, the I and Q data are exchanged before demodulating.

APSK Parameters

(Present only for APSK
modulation types)

Sets Constellation display parameters for APSK modulation types.

Table continued…
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Parameter Description

Symbol rate search

(Present only for nFSK
modulation types)

Determines whether to automatically detect or manually set the symbol rate. When selected,
automatically detects the symbol rate to perform analysis. The calculated symbol rate is displayed in
the Signal Quality display. The Symbol Rate Error is also calculated and displayed when Symbol rate
search is enabled.

User Symbol Map (per Modulation
Type)

Enables the use of custom symbol maps. This enables you to specify the location of symbols in the
display. This control can be set independently for each of the modulation types.

Mag Normalize
Specifies whether Magnitude Normalization uses the RMS Symbol Magnitude or the Maximum Symbol Magnitude as the basis for
normalization. Use RMS Symbol Magnitude on QPSK modulations (equal magnitude symbol locations), and use Maximum Symbol
Magnitude for signals that have a large difference in magnitude among the symbol locations (such as 128QAM). It prevents the instrument
from using the very low magnitude center symbols when normalizing the constellation. The outer symbols are a better normalization
reference than the center in this case.

Swap I and Q
Use the Swap I and Q control to correct a signal sourced by a downconverter that inverts the frequency of the signal under test.

APSK Parameters
Three parameters can be set for Constellation display of APSK modulation types.

Parameter Description
Ring Use to select which ring the radius and rotation values are being specified for. Values are 0 and 1 for

16APSK. 0, 1, and 2 for 32APSK.
Radius Sets the Ring ratio relative to Ring 0 (inner most ring). Set after selecting the appropriate Ring setting.
Rotation Sets the rotation value from the I axis. Set after selecting the appropriate Ring setting.

User Symbol Map
A User Symbol Map is a text file that specifies the location of symbols in the display. The symbol map is unique for each modulation type.
The easiest way to create a custom symbol map is to start with the default symbol map and modify it. The default symbol map file is
located at C:\RSA5100B\ExampleFiles. The default symbol map file is named DefaultSymbolMaps.txt. See Symbol Maps on page 620
for illustrations of the default symbol mapping.

To specify a user symbol map:

1. Click the ... button.
2. Navigate to the directory containing the user symbol text file you want to use.
3. Select the desired file in the Open window and click Open.
4. Select User Symbol Map to enable the user symbol map.

Editing the User Symbol Map. The symbol map is a plain text file and can be edited with any plain text editor.

CAUTION: Whenever you reinstall the program software, the existing DefaultSymbolMaps.txt file will be overwritten. To create a
custom symbol map, you should make a copy of the default symbol map file, edit the copy to suit your needs, and save it with a
new name. Guidance on how to edit the symbol map file is contained within the default symbol map file.

The following excerpt from the default symbol map file explains the structure of the file and how to edit it.
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## Symbol Mapping Definitions
## Version 1.2
## This file defines the mapping of modulation states to symbol values.
##
## File Format :
## -------------
## 1. Comments begin with '##' and may appear after the last field in a line
## 2. A symbol map begins and ends with a line containing the name of the
## modulation type. These names must exactly match the name of one of the
## modulation types in the RSA software
## 3. Empty cells may be included to preserve the constellation shape.
## 4. Blank lines are ignored.
## 5. A modulation type which does not match the name of an existing
## type will be ignored.
##
## Usage :
## -------
## 1. The file is intended to be edited with Notepad or similar text editor
The following text is an example of a symbol map.
## Symbol Map for 32 QAM
## (Resembles the shape of the constellation)
                32QAM
        00011 00010 00001 00000
01001 01000 00111 00110 00101 00100
01111 01110 01101 01100 01011 01010
10101 10100 10011 10010 10001 10000
11011 11010 11001 11000 10111 10110
        11111 11110 11101 11100
                32QAM

Find Tab
The Find tab is used to set parameters for finding bursts within the data record. This is a post-acquisition operation. Synch Word search
controls are also on this tab.
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Setting Description

Burst Detection: Mode Select whether to analyze bursts

- Auto: If a burst is found, analyze just that burst period. If a burst is not found, analyze the whole
analysis length.

- On: If a burst is found, analyze just that burst period. If a burst is not found, display an error
message.

- Off: Analyze the whole analysis length.

If the signal isn't adequate for demodulation, an error message is shown.

Burst Detection: Threshold Sets the level required for the signal to qualify as a burst. Enter a value in dBc down from top of the
signal.

Use Synch Word When enabled, specifies the string of symbols to look for. Enter the search string with external
keyboard or the on-screen keyboard.

Clear Blanks the search string field.

Analysis Time Tab
The Analysis Time tab contains parameters that define how the signal is analyzed in the general purpose digital modulation displays.

The settings values on this tab are the same as those on the main Analysis control panel for the instrument with the only difference being
that Analysis Length can be set in either Seconds or Symbols in this location.

Setting Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Table continued…
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Setting Description

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in either
seconds or symbols, depending on the Units setting. For most modulation types, the Analysis Length
set when Auto is enabled is 128 symbols. For some modulation types, a longer length is used.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Time Zero Reference Specifies the zero point for the analysis time.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols) being used by the
analyzer; this value may not match the Analysis Length requested (in manual mode).

Units Sets the units of the Analysis Length to either Symbols or Seconds.

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis Offset outside the range of time
covered by the current acquisition data. (all time values are relative to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the current range of acquisition
data settings. When the next acquisition is taken, its Acquisition Length will be increased to cover the new Analysis Length, as long as
the Sampling controls are set to Auto. If the Sampling parameters are set to manual, or if the instrument is analyzing saved data, the
actual analysis length will be constrained by the available data length, but in most cases, measurements are able to be made anyway.
The instrument will display a notification when measurement results are computed from less data than requested. Range: 0 to [(end of
acquisition) - Analysis Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed by a measurement. As you adjust this value, the actual amount of
time for Analysis Length, in Symbol or Seconds units, is shown below the control in the "Actual" readout. This setting is not available when
Auto is checked. Range: minimum value depends on modulation type. Resolution: 1 symbol. A maximum of approximately 80,000 samples
can be analyzed (the actual value varies with modulation type).

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time displays). Choices are:
Acquisition Start or Trigger.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Offset is measured from the trigger point.

Trace Tab
Menu Bar: Setup > Settings > Trace 

The Trace tab allows you to set the trace display characteristics of the selected display.
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Figure 87: Example traces tab for constellation display set to SOQPSK modulation type

Note that some settings are not present for all modulation types and some settings are not present for all displays.

Figure 88: Example trace tab for constellation display set to CPM modulation type

Figure 89: Example trace tab for Demod I&Q display

Setting Description

Trace Selects the trace that is hidden or displayed based on whether or not Show is selected.

Show Specifies whether the trace selected by Trace is displayed or hidden.

Freeze Halts updates to the trace selected by the Trace setting. Present for the Constellation display only.

Content Selects whether to display the trace as vectors (points connected by lines), points (symbols only
without lines), or lines (lines drawn between symbols, but no symbols are displayed). The choices
available depend on the display.

Q Offset For traces with offset modulation (OQPSK and SOQPSK), this setting enables the trace to be
displayed with Q offset or without Q offset. Choices available are Remove Q offset, Include Q
Offset, and Use Shared Pref. Selecting Use Shared Pref causes the analyzer to add or remove Q
offset according to the Remove Q Offset setting located on the Prefs tab. Setting the Q Offset on
the Traces tab changes the Q offset only for the Constellation display. If other GP Digital Modulation
displays are shown, they will use the use the Remove Q Offset setting on the Prefs tab regardless of
the Q Offset setting on the traces tab for the Constellation display. The Q Offset setting is available
only when the modulation type is set to OQPSK or SOQPSK.

Table continued…
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Setting Description

Points/symbol Select how many points to use between symbols when connecting the dots. Values: 1, 2, 4, 8.

Symbol point location Selects whether to evaluate the symbol value at the center or the end of the eye opening. This control
is only present for some of the supported modulation types.

Phase Multiplier Sets the multiplication constant for the phase multiplication display: ×1 (default), ×2, ×4, ×8, ×16,
or ×32. The phase multiplication display facilitates observation of noisy CPM signals by multiplying
measurement signal phase by the constant to reduce the number of phase states and expand the
phase difference between adjacent symbols.

Comparing Two Traces in the Constellation Display

When the Constellation display is the selected display, you can use the Traces tab to enable the display of a second trace. The second
trace is a version of the current acquisition. You can choose to freeze a trace in order to display the current live trace to an earlier version
of itself, you can display the trace as a second trace with or without Q Offset, or you can choose to display both traces frozen in order to
compare the trace to itself at different times.

To display a second trace in the Constellation display:

1. If more than one display is present, select the Constellation display to ensure it is the selected display.
2. Click the settings icon or select Setup > Settings from the menu bar.
3. Select the Traces tab.
4. Select Trace 2 from the Trace drop-down list.
5. Click the Show checkbox so that it is checked.
6. Specify the Content as desired. Trace 2 lines appear in blue to aid in distinguishing Trace 2 from Trace 1.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings changes how the trace appears
on the display but does not change control settings such as Measurement Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Table continued…
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Setting Description

Position Position adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Position Allows you to pan a zoomed trace without changing the Measurement Frequency. Position is only
enabled when the span, as specified by Freq/div, is less than the acquisition bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto

A Note About Units
The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for the horizontal scale, display the Analysis
Time tab. On the tab, select the appropriate units from the Units drop-down list.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the GP Digital Modulation displays.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker readout in the
Constellation display.

Remove Q offset The I and Q data traces are displayed with an offset of half a symbol when the modulation type is
set to SOQPSK or OQPSK. You can remove this offset by selecting Remove Q offset. (Which is only
present when the modulation type is set to OQPSK or SOQPSK.)

Show EVM and Offset EVM
results

Adds EVM results in the display when enabled (Offset EVM is always displayed). Present only in
Signal Quality display and with SOQPSK and OQPSK modulation types only
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Symbol Maps
This topic shows the symbol mapping for each digital modulation technique.

D8PSK

Phase shift

(radians)

Symbol value

(binary)

0 000

π/4 001

π/2 011

3π/4 010

π 110

5π/4 111

3π/2 101

7π/4 100

GP Digital Modulation

RSA5100B Series Real-Time Signal Analyzers Help 620



Pi/2 DBPSK

Phase shift

(radians)

Symbol value

(binary)

+π/2 0

–π/2 1

DQPSK

Phase shift

(radians)

Symbol value

(binary)

0 00

π/2 01

π 11

3π/2 10

Pi/4 DQPSK

Phase shift

(radians)

Symbol value

(binary)

+π/4 00

+3π/4 01

–π/4 10

-3π/4 11

MSK

Phase shift

direction

Symbol value

(binary)

– 0

+ 1

GP Digital Modulation

RSA5100B Series Real-Time Signal Analyzers Help 621



GP Digital Modulation

RSA5100B Series Real-Time Signal Analyzers Help 622



GP Digital Modulation

RSA5100B Series Real-Time Signal Analyzers Help 623



GP Digital Modulation

RSA5100B Series Real-Time Signal Analyzers Help 624



CPM

Phase shift

(h = modulation index)

Symbol value

(binary)

–3h 11

–h 10

+h 01

+3h 00

Overview: User Defined Measurement and Reference Filters
The Modulation Parameters control tab for GP Digital Modulation displays enables you to load custom measurement and reference
filters. If the existing filters do not meet your requirements, you can create your own filters for use in the measurement and reference
settings. This section describes the structure of user filters and provides two examples of customized filters. See User Filter File
Format on page 625.

Loading a User Measurement Filter
To load a your own measurement filter:

1. From the Modulation Params control tab (Settings > Modulation Params), click on the drop-down list for Measurement Filter.
2. Select one of the filter names that starts with User. This displays the Manage user filters window.
3. Enter a name for the filter in one of the Name (editable) boxes. This name will appear in the drop-down list on the Modulation Params

tab, prefaced with User. The maximum number of characters for the filter name is 20.
4. Click the Browse button and navigate to the directory containing the filter you want to load. Select the filter and click Open. If you wish

to use a filter that is not in the list, select User other and locate and open the file you wish to use.
5. Click OK to load the filter and return to the Modulation Params page.

User Filter File Format
The filter file is selected on the Modulation Params control panel tab used by the GP Digital Modulation displays (Option 21 only). It stores
the user-defined measurement or reference filter coefficient data in CSV format. The following figure shows the file structure.

Figure 90: User filter file structure

A filter file is a plain text file, in comma-separated-variable format. The file extension must be CSV.
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The filter file contains the following variables:

Rate. Specifies the oversampling rate (the number of samples per symbol). The filter coefficient data will be interpolated by the specified
rate.

FilterI,FilterQ. Specifies IQ pairs (1 to 1024) of the filter coefficient in time domain.

Rules for Creating a Filter File
• A line beginning with “#” is a comment line.
• Enter a positive value for the oversampling rate.
• A decimal number can be expressed by fixed point or floating point. For example, 0.01 and 1.0E-2 are both valid.
• “0” (zero) and “,0” (comma zero) can be omitted. For example, “1.5,0”, “1.5,”, and “1.5” are equivalent.
• Lines with only a comma and blank lines are skipped.

Example filters. For your reference, two example filters, Raised Cosine and Gaussian, are shown here. Both filters contain 65 data points
with an oversampling rate of 8.

Raised Cosine (α = 0.3)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)

# Rate 0.0383599,0 0.973215,0 0.0743803,0

8 0,0 0.895591,0 0.0720253,0

# FilterI,FilterQ -0.047715,0 0.774975,0 0.0594205,0

0,0 -0.0984502,0 0.623332,0 0.0405144,0

-0.0062255,0 -0.143898,0 0.455249,0 0.0194761,0

-0.0136498,0 -0.174718,0 0.286147,0 0,0

-0.0209294,0 -0.181776,0 0.130455,0 -0.0151973,0

-0.0263419,0 -0.157502,0 0,0 -0.0246357,0

-0.0280807,0 -0.0971877,0 -0.0971877,0 -0.0280807,0

-0.0246357,0 0,0 -0.157502,0 -0.0263419,0

-0.0151973,0 0.130455,0 -0.181776,0 -0.0209294,0

0,0 0.286147,0 -0.174718,0 -0.0136498,0

0.0194761,0 0.455249,0 -0.143898,0 -0.0062255,0

0.0405144,0 0.623332,0 -0.0984502,0 0,0

0.0594205,0 0.774975,0 -0.047715,0

0.0720253,0 0.895591,0 0,0

Table continued…
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Raised Cosine (α = 0.3)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)

0.0743803,0 0.973215,0 0.0383599,0

0.063548,0 1,0 0.063548,0

Gaussian (BT = 0.5)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)

# Rate 0.00191127,0 0.978572,0 0.000401796,0

8 0.00390625,0 0.917004,0 0.000172633,0

# FilterI,FilterQ 0.00764509,0 0.822878,0 7.10E--05,0

2.33E-10,0 0.0143282,0 0.707107,0 2.80E-05,0

9.11E-10,0 0.0257149,0 0.581862,0 1.06E-05,0

3.42E-09,0 0.0441942,0 0.458502,0 3.81E-06,0

1.23E- 08,0 0.0727328,0 0.345977,0 1.32E-06,0

4.21E-08,0 0.114626,0 0.25,0 4.37E-07,0

1.39E-07,0 0.172989,0 0.172989,0 1.39E-07,0

4.37E-07,0 0.25,0 0.114626,0 4.21E-08,0

1.32E-06,0 0.345977,0 0.0727328,0 1.23E-08,0

3.81E-06,0 0.458502,0 0.0441942,0 3.42E-09,0

1.06E-05,0 0.581862,0 0.0257149,0 9.11E-10,0

2.80E-05,0 0.707107,0 0.0143282,0 2.33E-10,0

7.10E-05,0 0.822878,0 0.00764509,0

0.000172633,0 0.917004,0 0.00390625,0

0.000401796,0 0.978572,0 0.00191127,0

0.000895512,0 1,0 0.000895512,0
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Marker measurements
Using markers

Overview
Markers are indicators in the display that you can position on a trace to measure values for the X and Y axes, such as frequency, power,
and time. A Marker always displays its position and, if enabled, will display the difference between its position and that of the Marker
Reference (MR).

You can display up to five markers including the reference marker. Markers can all be placed on the same trace or they can be placed on
different traces. There are three types of Markers: Reference, Delta, and Power Markers. The Marker Reference (labeled MR in the graph)
makes absolute measurements and is also used for calculating differences when Delta or Power readouts are enabled. The Delta Markers
(labeled M1 to M4 in the graph) are used to measure other points on the trace or the difference between the Marker Reference and the
Delta marker. The Power Markers (labeled M1 to M4 in the graph) function the same way as the Delta Markers, except they show power
density and integrated power density (dBm/Hz) instead of power level (dBm).

The following two tables show the appearance of the five types of marker readouts.

Marker Reference Readout Absolute Marker Readout Delta Marker Readout

Power Marker Readout DPX Bitmap Marker Readout

The following table shows the appearance of the marker indicators as they appear on the trace. Whichever marker is active will appear as
a solid diamond.

Marker Reference Absolute, Delta, and Power Marker
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Controlling markers with the touchscreen actions menu
In addition to controlling the marker actions from the front panel or screen menu items, you can use the touch screen actions menu to
move markers or add and delete markers.

To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger. You can also use a mouse to
display the Touchscreen Action menu by clicking the right mouse button.

Menu item Description

Marker to peak Moves the selected marker to the highest peak. If no marker is turned on, this control automatically
adds a marker.

Next Peak Moves the selected marker to the next peak. Choices are Next left, Next right, Next lower (absolute),
and Next higher (absolute).

Add marker Defines a new marker located at the horizontal center of the graph.

Delete marker Removes the last added marker.

All markers off Removes all markers.

Measuring signal density frequency and power on a DPX bitmap trace
To measure the signal density, frequency and power at a point on a DPX Bitmap trace:

1. Select Markers > Define Markers.
2. Select the Marker Properties tab.
3. Click Add. This displays a drop-down list under MR (Marker Reference), found inside the Reference box. The first marker defined

is always designated the Marker Reference. Subsequently defined markers are Delta Markers for which readouts can be selected for
Delta, Power, or Absolute. You can also select and adjust markers by clicking on an existing marker on a trace.

4. From the drop-down list, select Bitmap.

5. Click  to remove the Define Markers control panel.
6. Touch or click on the MR marker on the trace to activate the marker.
7. Drag the marker to the desired location on the bitmap.

Note: Delta markers on the DPX Bitmap trace can be placed on any point in the display, unlike markers in other displays that can
be placed only on a trace. This enables you to measure the signal density, frequency, and power level at any point on the graph.
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Note: Power markers can only be placed on a trace. To use Power markers in the DPX display, click the down arrow in the top left
portion of the display labeled Bitmap and select a Trace from the drop down menu.

Searching for peaks on the DPX bitmap trace. To locate peaks on the DPX Bitmap trace, use the arrow buttons on the Marker toolbar.
The left / right arrows move the selected marker to the next peak lower or higher in frequency. The up and down arrows search for peaks
at the same frequency. The peaks on the DPX Bitmap trace are defined by the settings for the DPX Signal Density on the Markers > Define
Markers > Define Peaks tab.

Measuring frequency and power in the spectrum display
To measure the frequency and power at a point on a Spectrum trace:

1. Select Markers > Define Markers.
2. Select the Marker Properties tab.
3. Click Add. This displays a drop-down list under MR (Marker Reference), found inside the Reference box. The first marker defined is

always designated the Marker Reference. Subsequently defined markers are Delta Markers for which readouts can be selected for
Delta, Power, or Absolute. You can also select and adjust markers by clicking on an existing marker on a trace.

4. From the drop-down list, select the trace to which you want to assign the marker.

5. Click the close control panel button to remove the Define Markers control panel.
6. Click on the marker on the trace to activate that marker.
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7. Use the knob or the arrow keys on the front panel to move the marker to the desired location on the trace. You can also click on the
marker location text box in the Markers toolbar at the bottom of the screen and adjust it with your mouse wheel. The Peak button in
the Markers toolbar and the arrow buttons to the right of it control marker peak searching on the trace.

8. Read the frequency and power level of the marker position on the display.
9. Read the signal density, frequency, and power level of the marker position on the display.
10. If Power markers are selected, read the point power density and the integrated power density.

Common marker actions

Marker action controls
Controls for enabling and moving markers and for initiating marker peak searches are found in several locations. There are buttons for a
few of the most common marker activities on the front panel of the instrument, used along with the knob for adjusting marker positions. The
Markers menu contains selections for peak searches and the Marker toolbar also has buttons for peak searches. All graphs that support
the markers offer a pop-up menu for marker actions.

Peak
Selecting Peak from the Markers menu moves the selected marker to the highest level peak within the acquisition record.

Next peak
Selecting Next Peak displays a submenu that enables you to move the selected marker to the next peak.

Setting Description

Next Left Moves the selected marker to the next peak to the left of the current marker position.

Next Right Moves the selected marker to the next peak to the right of the current marker position.

Next Lower (absolute) Moves the selected marker to the lower level peak (in absolute terms) on the trace.

Next Higher (absolute) Moves the selected marker to the higher level peak (in absolute terms) on the trace.

Marker to center frequency
Changes the center frequency to match the frequency of the selected marker.

Define markers control panel

Enabling markers and setting marker properties
The Define Markers Control Panel is used to enable markers and set their properties. You can set up to five markers including the marker
reference. Markers are shown in most displays.

Markers have three types of on-screen readouts: Absolute, Delta, and Power. When Readouts is set to Absolute, each readout displays
only the marker's position on the trace. In Frequency displays, this means the marker readout shows the frequency and power of the trace
at the marker position. When Readouts is set to Delta, each delta marker (M1-M4) readout displays both the marker's position on the
trace and the difference between its position and the position of the Reference Marker (MR). When Readouts is set to Power, each delta
marker (M1-M4) readout displays the marker's position on the trace, the difference between its position and the position of the Reference
Marker (MR), the point power density, and the integrated power density. 
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Defining Markers

1. Select Markers > Define Markers to display the Define Markers control panel.
2. Select Add to turn on the next marker. A drop-down list under the marker label allows you to assign the marker to a trace.

Note: The first marker defined will always be MR. The MR marker is the reference for delta marker readouts.

3. Select the trace to which the marker should be attached from the drop-down list.
4. Click Add to add additional markers.
5. Click on the Readouts drop down menu to select the readout to view. If you select Delta from the drop down menu, you can check the

dBc/Hz box to measure noise in dBc/Hz and show that for the delta value. Checking this box if other readouts are selected will force
the readout to Delta. You can read more about dBc/Hz mode here.

6. Click the close button to remove the Define Markers control panel.

Defining Peaks
You can specify two amplitude values that define peaks. For the DPX display, you can also define peaks based on signal density
characteristics.

Amplitude

Peak Threshold Peak Threshold specifies the level that the signal must exceed to be considered a peak.

Minimum Excursion Minimum Excursion specifies how much the signal must decrease and then increase before another
peak can be declared.

DPX Signal Density

Density Threshold Density Threshold specifies the signal density (number of hits per displayed pixel) that the DPX
bitmap must exceed to be considered a trigger event.

Minimum Excursion Minimum Excursion specifies how much the signal density must decrease and increase again before
another peak can be declared.

Table continued…
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DPX Signal Density

Smoothing (pixels squared) Smoothing specifies the number of pixels around the marker that are averaged together to reduce
"noise" in the readout of signal density. The value of this control is the number of pixels on each side
of the square area used for averaging. With Smoothing = 1, no averaging is done and the marker
z-axis readout is the hit count (density) of a single pixel. Use this control to characterize how wide or
narrow a range of pixels should be averaged to determine the signal density.

1. Select Markers > Define Markers to display the Define Markers control panel.
2. Select the Define Peaks tab.
3. To define the level for Peak Threshold, enter a value in the Peak Threshold number entry box.
4. To define the amount the trace must dip, enter a value in the Peak Excursion number entry box.
5. Click the close button to remove the Define Markers control panel.

Markers toolbar

Using the markers toolbar
Front Panel: Markers

Menu bar: View > Marker Toolbar

Select Marker Toolbar to display or hide the Marker Toolbar in the application window. The Marker Toolbar enables you to operate existing
markers or define new markers. 

Enabling a marker or adjusting the position of a marker automatically opens the Markers toolbar.

Icon / Readout Description

Opens the Define Markers control panel.

Selected marker readout. This readout shows which marker is selected. The pop-up menu allows you
to choose the selected marker, add markers, and turn all markers off.

Marker position controls. For frequency displays, this readout shows the marker position in Hertz. For
time displays, this readout shows the marker position in seconds. The position of the selected marker
can be changed by selecting the numeric readout and using the knob to adjust the value.

Changes the analyzer's Center Frequency to the frequency of the selected marker. Not selectable for
time markers.

Moves the marker to the highest peak on the signal. On displays that scale about zero on the vertical
axis (for example, Magnitude Error, EVM, and Frequency vs. Time), the highest peak selected by
the Peak button is an "absolute value", therefore, negative peaks are included in the search for the
highest peak.

Table continued…
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Icon / Readout Description

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value here refers to the numeric
value of the peak amplitude. Thus, when repeatedly moving the marker, it can move to the right or left
depending on the location of the next lower value.

Moves the selected marker to the next higher peak value. The peak value here refers to the numeric
value of the peak amplitude. Thus, when repeatedly moving the marker, it can move to the right or left
depending on the location of the next higher value.

Displays/hides the marker table from the display.

Removes the Marker Toolbar from the display.

Noise markers in the spectrum display

Measuring noise using delta markers in the spectrum display
In the Spectrum display, you can set Markers to dBc/Hz to measure noise on the trace. Markers in this mode operate just as they do in
normal mode, but the readouts for the markers are in dBm/Hz and dBc/Hz.

dBm/Hz is the power in milliwatts referenced to a 1 Hz bandwidth. To make this measurement, the analyzer assumes that the measured
signal is random noise. It then converts the measured power (made at any RBW) to the power that would be measured had a 1 Hz filter
been applied for the measurement.

dBc/Hz represents dBm/Hz referenced to a carrier. Here, it is assumed that the carrier is a CW signal, and its signal level does not change
when the RBW is changed, so the Reference Marker measurement on the carrier is unchanged from any other marker measurement.
However, the delta marker values are converted to dBm/Hz, and then a difference value, in dBc/Hz, is calculated between each delta
measurement and the reference. 

Measuring Noise
To measure noise on a Spectrum trace:

1. Select Markers > Define to display the Markers control panel.
2. Click Add. The first marker defined is always designated the Marker Reference. Subsequently defined markers are Delta Markers

for which readouts can be selected for Delta, Power, or Absolute. You can also select and adjust markers by clicking on an existing
marker on a trace.

3. Click Add again so that there are at least two markers defined.
4. Check that Readouts is set to Delta and check the dBc/Hz box.
5. If you have more than one trace defined, use the drop-down list for each marker to set it to the trace on which you want to measure

noise.
6. Notice that Detection is set to Average for the trace you are using for this measurement.

7. Check that the Amplitude units are set to dBm (that is the default). If they are not, click the  (Analysis) icon, select the Units tab,
and select dBm.

8. Click the Close button to remove the control panel.
9. Move the markers to the desired locations on the trace.
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10. Read the frequency and power level for the selected marker in the upper corners of the display. To display the delta measurement in
dBc/Hz, select the delta marker (M1, M2, M3 or M4) by clicking on it or pressing the front-panel Select button until it is selected.

The following image shows the Spectrum display with a Delta Marker.

The following image shows the Spectrum display with Power Markers.
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Mask Testing
The Mask Test Tool
You can specify pass/fail and mask parameter conditions for the Spectrum, Spurious, DPX Spectrum, Noise Figure, Gain, Frequency
Settling Time and Phase Settling Time displays. When these conditions are met, the instrument can perform actions such as stopping
acquisitions or saving data.

Mask Test Settings
Menu Bar: Tools > Mask Test 

Selecting Mask Test displays the Mask Test control panel. These settings define test parameters and specify actions to be performed
when the test conditions are met. Checking the Enable Test box sets the application to perform the test once the conditions are defined.

Setting Description

Enable Test Select to perform a test, then set the test conditions.

Define Specifies which result to test and what to test for.

Actions Specifies the action to take when the test condition is met.

Define Tab (Mask Test)
The Define tab sets the parameters for tests. From this tab, you specify which result to test and what kind of violation to test for.

The following image shows the Define tab with is great than selected. After you select that test, you will enter the desired signal level. The
procedure is the same if you select is less than.

The following image shows the Define tab with is outside mask selected. After you select that test, you need to click the Edit limits button
and set the desired test limits. The procedure is the same if you select is inside mask.
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Setting Description
Search in Specifies which result to test.
Test for Specifies what to test for. You can specify a test based on a signal level (“is greater than”, “is less

than”) or a mask (“is outside mask”, “is inside mask”). Options for Spurious and Settling Time are
Pass and Fail.

Search In
The possible choices for Search in include traces from Spectrum, DPX, Noise Figure, Spurious, and Setting Time displays. The available
choices are Trace 1, Trace 2, Trace 3, Math , Spectrogram Trace, Spurious, and Settling Time. The available choices include only results
from displays that are currently open.

Note: If you select a result that is not the selected trace or result in the target display, you will not see the results of the test. To
see the results, select the trace from the drop-down menu in the target measurement display and check the Show box:

Test For
The Test for setting has selections that vary based on which display's results you are testing.

Pass/Fail Tests for Spurious and Settling Time
The Frequency Settling Time, Phase Settling Time measurements, and Spurious measurements test functions provide pass/fail results.

Greater Than/Less Than Tests for Spectrum

If you select a greater than/less than test, you also specify the level that defines a violation. When you select either is greater than or is
less than, a text entry box appears to the right of the drop-down list. Use the text entry box to specify the signal level you wish to test for.
While not as flexible as mask testing, this type of test is quicker to set up.

The following figure shows the results of an is greater than test. The vertical red bar highlights results that match the test definition.
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Outside/Inside Mask Tests

If you specify a mask-based test, then you need to edit the mask to specify the levels that define a violation. When you select is outside
mask or is inside mask, an Edit limits button is displayed. Click the Edit limits button to display the Mask Test Editor window.

To set up and save mask test limits for a test. Perform the following procedure to set up a test using the mask limits.

1. After choosing the desired Search in and Test for items, click Edit limits to display the Mask Test Editor window.
2. Click the New button to create a table. This clears the existing points and loads the default table. You can also click Open to open an

existing table.
3. To edit values, add points, or delete points in a table:

a. To edit an existing value, double-click on the cell you want to edit and enter the desired value. The active point shows as a red
point on the plot.
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b. To add a new point, check the box next to the target mask (located below the Auto draw button).
c. Select Add points located below the Open button.
d. Select the target mask (Upper Mask Table or Lower Mask Table) from the drop-down menu.
e. Click in the desired location on the plot to add the point.

f. To use the auto draw feature to automatically place points on the chosen mask, enable the desired mask from the drop-down menu
and then click the Auto draw button.
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Note: Units may be changed for measurements other than Noise Figure in Setup > Analysis > Units.

4. To delete a point from the table, select the point to be removed, and click the X button.
5. To save the mask to a file for later recall, click Save As.
6. From the Save As dialog, name the file and save it in the desired location.

Note: Masks are saved in XML format with a .msk extension.

7. To dismiss the Mask Test Editor window, click Done.

Mask Test Result Example
The following figure shows the results of a Spectrum is outside mask test with Upper Mask enabled. The vertical red bar highlights results
that have exceeded the test limits. The shaded region shows the mask area.

The following figure shows the results of a passing Noise Figure is outside mask test with Upper Mask enabled. Markers are also in use.
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The following figure shows the results of a failing Noise Figure is outside mask test with Lower Mask and Upper Mask enabled. The red
area highlights the area of failure, which occurs at the lower mask. Markers are also in use.

Actions Tab
The Actions tab allows you to trigger the application when a signal in the frequency domain violates the mask.
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Setting Description
During Run or Replay Actions specified here will occur in either Run mode or Replay mode.

Beep The analyzer beeps when the test condition is met.

Stop The analyzer stops when the test condition is met.
During Run Only Actions specified here are taken only during Run mode (while acquiring live data).
Save acquisition data Saves acquisition data to a file when the test condition is met. Use the drop-down list to specify the

format of the saved data. The available file formats are: TIQ, CSV, and MAT.
Save trace Saves Trace data to a file when the test condition is met.
Save picture Saves a screen capture to a file when the test condition is met. Use the drop-down list to specify

the format of the saved picture. The available file formats are: PNG, JPG, and BMP. Note that no
trace will be saved if the tested trace isn't a saveable trace type. For example, a Spurious trace is not
saveable.

Max files Specifies the number of times a test action stores a file. After this limit is reached, no more files are
saved. The instrument will continue to run, but no additional files are saved when test conditions are
met.

Keep in mind when setting this number that picture files are counted as part of the total number
of files. For example, if you set Max files to 100, the instrument will save 100 acquisitions if only
acquisitions are saved or only pictures are saved. But, if both acquisitions and pictures are saved,
then 50 acquisitions and 50 pictures will be saved.

AutoSave File Naming
When one of the AutoSave actions is enabled, the name of the saved file is automatically incremented even if the Automatically
generate filenames option (Tools > Options > Save and Export) is not enabled. When the file is saved, it will be saved to C:\<instrument
name>Files\.
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Analyzing Data
Analysis Settings
Menu Bar: Setup > Analysis 

Favorites toolbar:

The Analysis control panel provides access to settings that are used by all displays. These settings affect only post processing and they do
not control hardware settings.

Setting Description
Analysis Time Tab on page 643 Specifies the length of time to use in measurements.
Spectrum Time Tab on page 644 Specifies whether the Spectrum Analysis display uses the same Analysis Time parameters as all the

other displays or if it uses a different Offset and Length.
Frequency Tab on page 645 Specifies the measurement frequency (center frequency).
Units Tab on page 647 Specifies the Power units for all displays.

Analysis Time Tab
The Analysis Time tab contains parameters that define the portion of the acquisition record that is used for analysis.

Setting Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the requirements of
the selected display.

Analysis Length Specifies the length of time to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Length value based on the requirements of
the selected display.

Time Zero Reference Specifies the zero point for the analysis time.

Table continued…
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Setting Description

Actual This is a displayed value, not a setting. It is the Analysis Length (time) being used by the analyzer;
this value may not match the Analysis Length requested (in manual mode).

Analysis Offset
Use analysis offset to specify where measurements begin. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed by a measurement. After you enter a value, this box changes
to show the actual value in use, which is constrained by Acquisition Time. This setting is not available when Auto is checked. Range:
minimum value depends on modulation type to Acquisition Length. Resolution: 1 effective sample (or symbol).

Time Zero Reference
The analysis offset is measured from this point. Choices are: Acquisition Start or Trigger Point.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Point Offset is measured from the trigger point.

Spectrum Time Tab
This tab controls whether the Spectrum display uses the same Analysis Time parameters as all the other views or uses a different Offset
and Length. These settings do not apply to the DPX display because it has no acquisition record or analysis time.

Settings Description
Spectrum Time Mode
Independent Causes the spectrum analysis views to use the settings unique to those displays.
Use Analysis Time settings Causes the spectrum analysis views to use the settings on the Analysis Time tab.
Spectrum Time (only available when Independent is selected)
Spectrum Offset Sets the beginning of Spectrum Time with respect to the selected time reference point (selectable in

the Analysis Time tab as either Acquisition Start or Trigger).
Spectrum Length The amount of data, in terms of time, from which spectrum traces are computed.
Auto When enabled, causes the instrument to set the Spectrum Length value based on the RBW setting.
Actual This is a displayed value, not a setting. It is the Spectrum Length (time) being used by the analyzer;

this value may not match the Spectrum Length requested (in manual mode). The actual spectrum
length is always an integer multiple of the time needed to support the RBW value.
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Frequency Tab
The Frequency tab specifies two frequency values: the Measurement Frequency and the Spectrum Center Frequency. The Measurement
Frequency is the frequency at which most displays take measurements. The Spectrum Center Frequency is the center frequency used by
the Spectrum, DPX Spectrum, Spectrogram and Time Overview displays.

The following screen capture shows a display with both the Measurement Frequency and the Spectrum Center Frequency locked together.

Normally, the Measurement Frequency and the Spectrum Center Frequency are locked together so that both have the same setting. But
in some situations, for example, where a signal contains a set of channels, it is useful to unlock the Measurement Frequency from the
Spectrum Center Frequency. When the Spectrum Center Frequency is unlocked from the Measurement Frequency, you can adjust the
Measurement Frequency so that measurements can be taken at different frequencies without resetting the center frequency. The following
screen capture shows the magenta-colored measurement frequency indicator still located at the center frequency.
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The following screen capture shows the measurement frequency indicator located at 2.0402 GHz while the Spectrum Center Frequency is
still located at 2.0000 GHz.

You can drag the Measurement Frequency indicator on the screen to set the measurement frequency. Note the base of the Measurement
Frequency indicator. The width of the box indicates the widest measurement bandwidth in use among the open displays. You can see
how the width of this box changes with the measurement bandwidth by, in this example, adjusting the Measurement BW setting for the
Constellation display (Settings > Freq & BW tab). As you adjust the setting, you will see how the width of the box at the base of the
Measurement Frequency Indicator changes.

The Measurement Frequency indicator is useful for interpreting system behavior when MeasFreq is unlocked. If a measurement has a
wide bandwidth relative to the spectrum span, and the Measurement Frequency is far from spectrum center, the measurement is likely to
fail because its required frequency range exceeds the frequency range of the available data. In such a case, the navigation control will
show that the measurement bandwidth extends outside the Spectrum's span.
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There are interactions between frequency unlocking and RF & IF Optimization (see the Amplitude Settings on page 653). When Best for
multiple displays is the selected optimization, the instrument is allowed to use its full bandwidth to meet the needs of all open displays.
This is the most user-friendly optimization because it decreases the number of Acq BW too small errors, but it can increase noise and
slightly decrease measurement accuracies. For all other optimization types, the instrument optimizes the acquisition bandwidth for the
selected display, improving measurement quality somewhat, but reducing concurrent measurement capability.

There are also interactions with trigger settings. When the Spectrum Center Frequency is unlocked from Measurement Frequency, the RF
triggers (Trigger Source = RF Input) can tune to either Spectrum Center Frequency or Measurement Frequency. When a spectrum display
is selected, the trigger frequency is the same as the Spectrum Center Frequency. When one of the other displays that uses Measurement
Frequency is selected, the trigger is tuned to the Measurement Frequency also. This allows you to trigger on the signal you are measuring.
But, there is an exception: when the selected RF & IF Optimization is Best for multiple displays, the trigger is always tuned to the
Spectrum Center Frequency.

The reason the trigger frequency is affected by Measurement Frequency and RF & IF Optimization, is that these functions control how the
acquisition is tuned. The optimization Best for multiple displays keeps the acquisition centered about the Spectrum Center Frequency
at all times. To accommodate off-center Measurement Frequencies, it just widens the acquisition bandwidth. Other optimizations tune the
acquisition frequency to match that of whichever display is currently selected. The RF trigger module receives the same acquisition data as
all the measurements, tuned to the center of the current acquisition bandwidth.

Units Tab
The Units tab specifies the global Amplitude units for all the views in the analysis window.

Note: If you are using an External Loss Table for antenna corrections (Ampl > External Gain/Loss Correction), set the Amplitude
units to dBuA/m or dBuV/m.

Replay Overview
The Replay function enables you to reanalyze data with different settings and even different measurements. You can replay all the
acquisitions in memory, a single acquisition, a single frame within an acquisition (if Fast Frame is enabled), or any contiguous set of data
records from acquisition history. You can replay the DPX Spectra that make up a DPXogram display.

Displaying the Replay Control Panel
To display the Replay control panel:

1. Select View from the main menu bar.
2. Select Replay Toolbar in the menu. The toolbar will appear near the bottom of the display.

3. Click the Define button to open the Replay control panel.
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Tip: You can read more about the other toolbar buttons here.

Selecting the Data Type to Replay

You can choose to replay either acquisition data or DPX spectra. Choose Acq Data to replay any acquisitions except DPXogram
acquisitions. Choose DPX Spectra to replay a DPXogram acquisition.

Select Data Records Tab
The Select data records tab is used to select which data records to replay. A data record is the smallest unit that can be replayed. Note
that what constitutes a data record can vary. If FastFrame is not enabled, a data record consists of a single acquisition. If FastFrame is
enabled, each acquisition can contain multiple frames, and a data record consists of a single frame.

Figure 91: Without FastFrame enabled

Figure 92: With FastFrame enabled

Date and Time Stamps. The line that appears above each Start box (one for acquisitions and one for frames when FastFrame is enabled)
is a date stamp that displays the date and time the first record in the current acquisition was acquired. The line that appears below each
Stop box is a date stamp that displays the date and time the last record in the current acquisition was acquired.

The line that appears to the right of each Start box displays the date and time the selected acquisition or frame was acquired. The line that
appears to the right of each Stop box displays the date and time the selected record or frame in the current acquisition was acquired.

Select All button. Selecting Select All resets the Start and Stop values. The Start value is reset to the first acquisition or frame of the
current acquisition. The Stop value is reset to the last acquisition or frame in the current acquisition.
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Select DPX Spectra Tab
The Select DPX Spectra tab is used to select which DPXogram spectra to replay. A spectra is the smallest DPXogram unit that can be
replayed. It is equivalent to one line in the DPXogram display.

Date and Time Stamps. The line that appears to the right of each Start box displays the date and time the selected DPX Spectra was
acquired. The line that appears to the right of each Stop box displays the date and time the selected DPX Spectra in the current acquisition
was acquired.

Select All button. Selecting Select All resets the Start and Stop values. The Start value is reset to the first DPX Spectra of the current
acquisition. The Stop value is reset to the last DPX Spectra in the current acquisition.

Acquisition Info Tab
Displays information about acquisition settings and sets the number of decimal places used for displaying the time stamp.

Replay Speed Tab
Sets the speed at which data records are replayed.

Replay Menu
The Replay menu provides controls that let you choose how to replay acquisitions. The replay function enables you to, in effect, “rerun” an
analysis while applying different measurements to the same set of acquisition data.

Menu item Description
Acq Data Select Acq Data to replay acquisitions.
DPX Spectra Select DPX Spectra to replay a DPXogram display.
Replay all selected records Replays the sequence of records specified by Start and Stop on the Select data records tab.
Loop overall selected records Replays the sequence of records specified by Start and Stop on the Select data records tab

continuously.
Replay current record Replays the currently selected acquisition (or frame).
Replay from selected Displays a submenu that you use to specify which records are to be replayed.
First record Replays the first record within the selected set.
Table continued…
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Menu item Description
Previous Replays the previous record within the selected set.
Next Replays the next record within the selected set.
Last record Replays the last record within the selected set.
Pause Suspends replay of the data records as soon as the current record's replay action is completed. Press

Pause again to begin replay with the next record in the sequence.
Stop Halts the replay of acquisitions. If replay is started after Stop has been selected, replay starts from the

first acquisition.
Select all Selects all acquisitions for replay.
Select records from history Displays the Select data records tab of the Replay control panel. Use the Select data records tab to

specify which acquisitions and frames you would like to replay.
Replay toolbar Displays or hides the Replay toolbar.

Acq Data
Selecting Acq Data selects acquisition data as the source for replay. Selecting Acq Data does not start replay, it only selects the type of
acquisition data that will be replayed.

DPX Spectra
Selecting DPX Spectra selects DPX spectra as the source for replay. Selecting DPX Spectra does not start replay, it only selects the type
of acquisition data that will be replayed.

Replay All Selected Records
Selecting Replay all selected records replays all the selected data records. The set of selected records may comprise a single record, all
records in acquisition history, or a subset of the records in history.

Replay Current Record
Selecting Replay current record replays the current data record. You can identify the current acquisition record by looking at the Replay
toolbar. The first number to the right of the Select button identifies the current data record. For example, if the number is 2:10, it means the
current record is the tenth frame of the second acquisition in history.

Replay from Selected
Select Replay from selected to replay records as selected from the submenu. The records replayed can be from the acquisition memory
(history) or from a saved acquisition data file that has already been recalled as the current acquisition data.

Pause
Select Pause to suspend playback. Selecting Pause again restarts the replay at the point it was paused.

Stop
Select Stop to halt the replay of data. Selecting any Replay action restarts replay of records from the beginning.
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Select All
Select Select all to select all data records for replay.

Select Records from History
Selecting Select records from history displays the Select data records tab of the Replay control panel. The Select data records tab
allows you to specify which records in the acquisition history will be used when the Replay button is selected.

Replay Toolbar
Displays or hides the Replay toolbar that appears below the main tool bar.

Figure 93: Replay toolbar

Item Description
Replay Selects data type to be replayed. Select DPX Spectra to replay a DPXogram. Select Acq Data for all

other types of replay.

Replays the first record in the selected set.

Replays the previous record in the selected set.

Replays the current record in the selected set.

Replays the next record in the selected set.

Replays the last record in the selected set.

Replays all records in the selected set.

Replays all records in the selected set continuously until stopped.

Pauses replay. Pressing pause suspends replay with the current record. Selecting pause again starts
Replay with the next record.

Stops replay. Starting any replay action after pressing stop starts a new Replay action rather than
continuing from the record at which the previous replay action was stopped.

Clicking Select All selects all records in history for replay. Selecting Select all resets the Start and
Stop values on the Select data records tab of the Replay control panel.

Table continued…
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Item Description

Clicking the Define button displays the Define Replay control panel. The Acquisition Info tab displays
information about the acquisition data such as acquisition bandwidth, sampling rate and acquisition
length. All data records in the acquisition history were acquired with identical parameters. When
any of these parameters are changed, all records in history are deleted as soon as the first record
acquired under the new parameter values is received.

You can also view and use the Select data records tab, Select DPX Spectra tab, and Replay Speed
tab.

This readout shows information about the data record being replayed. The information displayed
shows the acquisition and frame number and time stamp for the current data record.
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Amplitude Corrections
Amplitude Settings
Main menu Bar: Setup > Amplitude 

Favorites toolbar:

The Analysis control panel provides access to settings that are used by all displays. These settings affect only post processing and they do
not control hardware settings.

Setting Description
Internal Settings Sets the parameters that control the acquisition of the signal.
External Gain/Loss Correction Specifies whether a correction is applied to the signal to compensate for the use of external

equipment.
External Gain/Loss Correction Specifies whether a correction is applied to the signal if the analyzer detects a probe is connected

to the instrument. (Probes are connected to the analyzer through the RTPA2A Real-Time Spectrum
Analyzer TekConnect Probe Adapter.)

Internal Settings Tab
On the Internal Settings tab, you can specify the Reference Level for the signal analyzer's RF front end, the settings for the internal
attenuator, enable/disable the optional internal preamp, and specify the RF & IF Optimization.

Ref Level
The reference level can be set for the RF Input of the connected instrument.

Internal Attenuator
The Internal Attenuator setting can be set to Auto or Manual. When Auto mode is enabled, the attenuation setting is displayed but is
not adjustable. When Auto is disabled, the attenuator operates in manual mode, allowing you to set the internal attenuation. The internal
attenuation setting range varies depending on the instrument in use.

Internal Preamp
If your instrument has the optional internal preamp installed, use this setting to switch the preamp on or off.
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Note: To ensure the best accuracy, thermally stabilize before taking critical measurements.

Monitor Attenuator Use
The input attenuator relays are rated for several million cycles. Some measurement settings result in high rates of attenuator switching and
could prematurely age the relays. Enabling this function causes the instrument to monitor the attenuator switching rate. When a high rate
of switching is maintained for more than an hour, the instrument will halt acquisitions and display a message about the condition. To restart
acquisitions, press Run. If the check box is not selected, the monitoring function is disabled.

Note: This feature is provided to prevent accidental long-term high-rate attenuator switching (thus extending attenuator life). If you
need to run the instrument for extended period, such as overnight or over a weekend, disable the setting to prevent the halting of
acquisitions.

RF & IF Optimization
Specifies how the gain and bandwidth should be optimized (in the RF and IF stages of the front end).

You can select RF & IF optimizations to achieve the best dynamic range, fastest sweep speed, or minimum displayed noise. These choices
affect the RF and IF attenuation levels, the selection of the acquisition bandwidth, digitizer and the resolution of the mathematical operation
performed on the acquisitions used in varying conditions of span, reference level and resolution bandwidth.

The following paragraphs describe the effects of choosing each of the available choices.

Best for multiple displays (Default). This setting is the instrument default and is set as part of the Preset function. When this is selected,
the instrument considers all the open displays and chooses an Acquisition Bandwidth wide enough to satisfy as many measurements as
possible. Instead of optimizing the measurement performance of the selected display, this setting decreases the incidence of non-selected
displays being unable to run because the acquisition bandwidth is set too small by the selected display.

Auto. The Auto setting is an optimized trade-off of the competing performance choices.

Minimize sweep time. Selecting Minimize Sweep Time causes the instrument to use the widest available acquisition bandwidth when
sweeping across spans greater than the maximum available real-time span. For instruments with Option B40/B85/B16x, swept update rate
is significantly faster than Auto. This setting has no effect in instruments without Option B40/B85/B16x.

Maximize dynamic range. Selecting Maximize Dynamic Range has several effects:

• Sets RF attenuation to allow higher drive levels at the RF mixer.
• Sets IF gain levels to optimize the IF for the higher signal levels that result from allowing higher drive levels at the mixer.
• Selects the acquisition path used in the instrument taking into account the user-specified Resolution Bandwidth (RBW). When an RBW

of less than 20 kHz is selected, the instrument uses a narrow-band (312.5 kHz) acquisition path, regardless of the selected span or
measurement bandwidth. This results in the best rejection of out-of-band signals in the IF stage of the analyzer, but comes at the cost
of slower update rates for all signal analyzer spans and measurement bandwidths greater than 312.5 kHz.

• Increases the resolution of the mathematics used in calculations of all signal results from 16 bits to 28 bits whenever span or
measurement bandwidth is set to ≤312.5 kHz. This is made possible by the high levels of decimation applied to signals processed in
these narrow bandwidths.

Minimize noise. This mode increases the system gain at points past the RF mixer. This has the effect of reducing the displayed average
noise level.

The table below summarizes the conditions.
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Settings RF auto attenuation
(min 10 dB, max
55 dB)

Selected Acquisition
Bandwidth

IF Gain/Loss settings Notes and Trade-offs

Best for Multiple
Displays

Ref Level +15 dB Acquisition Bandwidth is set to
the value required to service as
many of the open displays as
possible.

Neutral Swept Speed, Dynamic Range,
Noise Floor

Auto Ref Level +15 dB Driven by the measurement
bandwidth of the selected
display. If span is greater than
the available acquisition BW,
unit sweeps using 25 MHz
acquisitions

Neutral Swept Speed, Dynamic Range,
Noise Floor may not be optimal

MinimizeSweep
Time

Ref Level +15 dB Unit uses widest available
acquisition BW for spans greater
than maximum acquisition BW.

Neutral Instruments equipped with
Option B40/B85/B16x, swept
update rate is significantly
faster than Auto. No effect in
units without Option B40/B85/
B16x.

MaximizeDynamic
Range

Ref Level +20 dB Driven by span and user-
selected RBW when a spectrum-
type display is selected, or
by measurement bandwidth and
filter bandwidth when other
display types are selected. For
RBW < 20 kHz, the high
dynamic range 312.5 kHz path
is used regardless of selected
span or measurement bandwidth.
Sweeps are made in 25 MHz
acquisitions.

IF attenuation increased
to improve dynamic
range. This causes
higher noise level.

Might result in very slow sweep
speeds in wide spans when
RBW < 20 kHz.

Minimize Noise Ref Level +15 dB Same as Auto Set to minimize noise
level.

Might result in earlier IF
overload under some signal
conditions.

Tip: See the Advanced topic for more information about preselector settings.

External Gain/Loss Correction Tab
The External Gain/Loss Correction tab allows you to apply a correction to a signal to compensate for the use of external equipment, such
as an amplifier or attenuator. You can specify whether the corrections on this tab apply to all acquired data or only to a set group of
displays. You can also apply external corrections to traces in the Spectrum, Spectrogram, Spurious, and Amplitude vs Time displays.

Amplitude Corrections

RSA5100B Series Real-Time Signal Analyzers Help 655



External Gain Value
Use the External Gain Value setting to apply a flat gain/loss correction to the signal. Positive values represent a gain and negative values
represent a loss. The range is –80 to +50 dB. Resolution is 0.1 dB.

Note: Selecting Preset clears the check box, but it does not change the value.

Apply External Corrections To
Use the two selections to specify whether the enabled external loss tables are applied to all acquired data or only to traces in the
Spectrum, Spectrogram, Spurious, and Amplitude vs Time displays.

When choosing whether to correct sample data or traces, keep the following in mind:

• If sample data is acquired while data correction is enabled, that data record is permanently corrected. If the acquisition is saved and
recalled, the recalled acquisition includes corrections. Corrections are not saved separately from the raw data; they are used during the
acquisition process to adjust the data values.

• Trace corrections can be applied at any time, as they are part of the measurement's computations. Using Replay will apply trace
corrections to a trace if this control is enabled (and an external loss table is specified and enabled).

• Be aware that if you recall acquisition data that was saved with data corrections and you use Replay with trace corrections selected
and an external loss table enabled, the trace will be calculated using corrected data and also corrected with trace corrections. This
probably creates incorrect traces.

• When only Traces are being corrected, triggering operates on uncorrected acquisition data. Frequency masks and trigger level lines in
the displays are also not corrected, so there is a visual discrepancy between data traces and trigger indicators in the graphs under this
condition.

• When only Traces are being corrected, triggering operates on uncorrected acquisition data. Frequency masks and trigger level lines in
the displays are also not corrected, so there is a visual discrepancy between data traces and trigger indicators in the graphs under this
condition.

Trace Corrections Versus Data Corrections. Because of the real-time nature of the instrument and desire to frequently reanalyze stored
acquisitions, it is possible to apply amplitude corrections in real time. Applying real-time corrections to the incoming data means that, the
correction factors present during the acquisition are already part of the data when the data is stored and then reanalyzed. This also allows
the DPX display to maintain its update rate while presenting an amplitude-corrected display.

Real-time gain/loss factors are applied by creating a correction filter that is applied by the same digital signal processing hardware used
to correct for calibration and alignment factors in the instrument. This process does have limitations. In creating a digital filter to represent
the gain/loss table, a limited number of filter taps are be used in order for the filter to be practically realizable. If your amplitude corrections
contain discontinuities or extremely sharp transitions, the filter used will contains errors and ringing.

If the above is the case, we recommended that you use trace corrections. These are very similar to a conventional spectrum analyzer, and
may be applied to the spectrum, spectrogram, spurious search and amplitude vs. time displays. These traces may contain transitions of
any type within the maximum and minimum correction values allowed in the tables.

Trace Corrections Versus Data Corrections
Because of the real-time nature of the analyzer and desire to frequently reanalyze stored acquisitions, it is possible to apply amplitude
corrections in real time. Applying real-time corrections to the incoming data means that, the correction factors present during the
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acquisition are already part of the data when the data is stored and then reanalyzed. This also allows the DPX display to maintain its
update rate while presenting an amplitude-corrected display.

Real-time gain/loss factors are applied by creating a correction filter that is applied by the same digital signal processing used to correct for
calibration and alignment factors in the instrument. This process does have limitations. In creating a digital filter to represent the gain/loss
table, a limited number of filter taps are be used in order for the filter to be practically realizable. If your amplitude corrections contain
discontinuities or extremely sharp transitions, the filter used will contains errors and ringing.

If the above is the case, we recommended that you use trace corrections. These are very similar to a conventional spectrum analyzer, and
may be applied to the Spectrum, Spectrogram, Spurious search and Amplitude vs. Time displays. These traces may contain transitions of
any type within the maximum and minimum correction values allowed in the tables.

External Loss Tables
Use an External Loss Table to apply a frequency dependent gain/loss correction to the signal. When an External Loss Table is selected,
the analyzer adjusts the signal according to the values in the table. An external loss table allows you to compensate the signal level for
variations in cable loss, antenna frequency response or preamp frequency response.

You can create external loss tables from the analyzer application and save them as files. External loss tables are saved as plain text files in
CSV (Comma Separated Value) format. The tables have a CSV file extension.

You can change the title for each table. However, note that the title is only a label. It is not tied to the file name of any table you may have
loaded or saved.

Note: If you are using an External Loss Table for antenna corrections, be sure to set the Amplitude units (Setup > Analysis >
Units) to dBuA/m or dBuV/m.

Creating an External Loss Table
You can create an external loss table with the analyzer application. No external application is required.

To create an external loss table:

1. Click Edit. to display the Table Editor.

2. Click New Table to create a table. This clears all entries in the existing table and loads the default table.
3. To edit values in the table:

a. To edit an existing value, double-click on the cell you want to edit.
b. To add a new point to the table, click on Add Point. Edit the values as required.
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c. Click Apply if you want to test your table without closing the editor (the table must be enabled with the check box in the control
panel and measurements must already be running).

To specify a frequency multiplier, you can type K, M, or G.
4. To delete a point from the table, select the point to be removed, and click Delete.
5. Select the Frequency Interpolation method:

• Select Linear when the frequency scale of the spectrum or spurious measurements are linear.
• Select Log when the frequency scale of the spectrum is logarithmic.

6. When you have entered all the necessary values, click Save As (to save the table in a file) or click OK.
7. From the Save As dialog, name the file and save it in the desired location.

External loss tables are saved in CSV (Comma Separated Value) format.

Loading an External Loss Table
To load an external loss table file:

1. Click Edit to display the Table Editor.
2. Click Load to display the Open dialog box.
3. Navigate to the location of the desired file, select it and click Open.
4. Click OK.

External probe correction tab
The External Probe Correction tab is used to specify whether a correction factor is applied to the signal when a Tektronix P7000 Series
probe is connected to the analyzer through the Tektronix RTPA2A Real-Time Spectrum Analyzer TekConnect Probe Adapter.

The analyzer can detect when an RTPA2A TekConnect probe adapter is connected to the instrument. The only setting available on the tab
specifies whether a correction is applied to the signal or not. The amount of correction is specific to the probe and is communicated to the
signal analyzer through the RTPA2A TekConnect probe adapter.

If the signal analyzer does not detect a probe adapter, the setting to correct for a probe is dimmed and No probe detected is displayed on
the tab.
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Controlling the acquisition of data
Acquisition controls in the run menu

Continuous versus single sequence
Menu Bar: Run > Single Sequence / Continuous

Selecting Single Sequence sets the acquisition mode so that when you press Run, a single acquisition sequence is performed and the
instrument stops once the acquisition sequence is completed. Selecting Continuous sets the acquisition mode so that an acquisition
sequence is started as soon as you select Continuous and as one acquisition sequence completes, another begins.

Note that an acquisition sequence can require more than one acquisition. For example, in a spectrum view, the trace function might be set
to Average 100 acquisitions Thus, a complete acquisition sequence would consist of 100 acquisitions that are averaged together to create
the trace that is displayed.

Run
Menu Bar: Run > Run

Application Bar / Front Panel: Run

Selecting Run begins a new acquisition/measurement cycle.

Resume
Menu Bar: Run > Resume

Restarts data acquisition, but does not reset accumulated results, such as Average or MaxHold. This allows you to stop acquisitions
temporarily, then continue. If the accumulation is already complete, for example, 10 acquisitions or 10 averages have already been
completed, each subsequent Resume command will cause one more acquisition to be taken, and its results added to the accumulation.
Not available if instrument settings have been changed.

Abort
Menu Bar: Run > Abort

Selecting Abort immediately halts the current acquisition/measurement cycle. In-process measurements and acquisitions are not allowed
to complete. Visibility and accuracy of results is unspecified after an abort.

Acquisition controls in the acquire control panel

The acquire control panel
Menu Bar: Setup > Acquire

Selecting Acquire displays the Acquire control panel. These settings control the hardware acquisition parameters for the signal analyzer.
Normally, these parameters are automatically adjusted for selected measurements. You can use Acquire to change these parameters
manually if necessary.
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Tab Description

Sampling Parameters Sets the parameters that control the acquisition of the signal.

Advanced Sets the Dither parameters.

FastSave Sets the FastSave parameters. Initiates FastSave acquisitions.

Run
Run mode specifies whether the analyzer will stop acquiring data after it completes a measurement sequence.

• Continuous - In Continuous mode, once the analyzer completes a measurement sequence, it begins another.
• Single - In Single mode, once the analyzer completes a measurement sequence, it stops.

Note: A measurement sequence can require more than one acquisition. If the analyzer is configured to average 100 traces
together, the measurement sequence will not be completed until 100 traces have been acquired and averaged.

Sampling parameters tab
The Sampling Parameters tab enables you to set the controls for data acquisition. There are two settings on the Sampling Parameters
Tab, the Adjust setting and FastFrame. Depending on the setting chosen for Adjust, two additional parameters can be set. Normally, the
best results are achieved by leaving the Adjust control set to All Auto. Manually overriding the automatic settings affects both real-time and
swept acquisitions.

Sampling Control
There are three sampling parameters that interact with each other: Acquisition Bandwidth, Acquisition Length, and Acquisition Samples.
Acquisition Bandwidth is the frequency range of the acquisition. Acquisition Length refers to the time over which the acquisition occurs.
Acquisition Samples is the number of samples acquired over the acquisition time. The parameters available for Adjust and how the
parameters are determined are shown in the following table.

Adjust User sets Analyzer calculates

All Auto N/A N/A All values based on the open
displays, with the highest priority
given to the selected display

Table continued…
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Adjust User sets Analyzer calculates

Acq BW / Acq Samples Acq BW Acq Samples Acq Length

Acq BW / Acq Length Acq BW Acquisition Length Acq Samples

Acquisition Memory Usage
The center portion of the tab shows how the acquisition memory is used.

Readout Description

Samples/s, sec/Sample Readout of the acquisition sample rate and sample period.

Capacity The maximum period of time and number of samples that could be acquired with the current sampling
parameters.

Using The total amount of acquisition memory that will be used based on the current settings.

FastFrame
FastFrame is a feature that allows you to segment the acquisition record into a series of frames, or data records. A typical use of
FastFrame is to record data samples around signal events of interest, while not wasting memory on irrelevant data between these events.
FastFrame is only valid for real-time acquisitions. If any measurement is configured for swept acquisitions, an error message is displayed:
Disabled: FastFrame doesn't support swept settings.

Setting Description

FastFrame Enables FastFrame acquisition mode.

Max Frames Specifies the maximum number of frames to record in a single acquisition process.

The Actual readout shows the actual number of frames that will be acquired into the acquisition memory. This number changes based on
the Acq BW, Acq Samples, and Acq Length values. This number will never be greater than the value set by Max Frames.

Advanced tab (Acquire)
Provides access to Advanced Acquire settings. 
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Setting Description

Dither Can be set to Auto or Manual. In Auto mode, each measurement sets Dither as appropriate for the
measurement. In Manual mode, the user setting overrides the measurement preference.

Dither
Dither is the process of adding noise to the analog signal prior to the analog-to-digital conversion. The purpose of adding noise is to
randomize the quantizing process of the ADC (analog-to-digital converter) so it does not appear as discrete components in locations where
the distortion components of the ADC would fall. All ADCs produce quantizing errors that appear as noise (quantizing noise) or as discrete
components which are less desirable. Without dither and in the presence of tones that are close to sub-multiples of the sample rate or
correlated to the sample rate, all the quantizing energy can fall in the same locations as discrete distortion components. This can increase
what appears as spurious tones but they are not related to the normal spurious mechanisms or true distortion. Adding noise can randomize
the quantization process so those tones aren’t produced.

In general, you should leave the Dither setting on Auto. In the Auto mode, individual measurements will select the best guess dither setting
(on or off). In Manual mode, the user setting overrides individual measurements’ dither settings enabling the user to determine the best use
for the best measurement.

Note: If the RF & IF Optimization is set to Best for multiple displays, you cannot change the Dither setting.

Dither is not always necessary. The signal itself can be used to randomize quantizing errors. Since the input signal is not under control
of the instrument, the use of dither is signal dependent and its use must be determined by the user. Typically, pure tones create the
most problems with quantizing errors. Dither should be used for those input types. Many digital modulation types are noise-like, so dither
is usually not needed for modulation types such as CDMA, GSM and many others. Dither also uses up a bit of headroom in the ADC,
typically 2-3 dB. If the largest dynamic range to the noise floor is needed, that is Signal to Noise Ratio, the dither can probably be turned
off. The measurements for Channel Power/ACLR and MCPR automatically turn dither off for just that reason. Signals in the range of
-6 dB to -40 dB below the reference level usually show the greatest benefit from having dither present. The user can find the best use by
observing the results for the particular input signals while setting dither on or off. There are cases where dither can make things worse. If
dither makes an improvement in the measurement, it should be left on. It is doing its job to improve dynamic range. If it makes it worse,
dither should be left off.

FastSave
FastSave (also known as Fast Save) is a way to automatically save acquisitions to a file. It is a way to collect data, not to analyze the data.
Analyzing the data require recalling the saved acquisition data file.

When making acquisitions and performing analysis, the instrument creates a cache file with a copy of the acquisition that it uses as the
source for analysis and displays. To Save a waveform as a .TIQ or .MAT file, the instrument pulls data from the cache, formats the data for
the chosen file type, and writes again to the disk with a .TIQ or .MAT extension. Normal operation requires creation of the cache file and
reading of a cache file prior to analysis or save functions. These hard-drive read and write cycles can be time consuming for large files. If
you need only to save data for later analysis, a mode named FastSave is available. 
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FastSave mode bypasses cache file creation and writes directly to a file. This eliminates two of three disk read or write operations.
Depending on the file size, FastSave reduces the time required for data acquisition up to 65%. Using FastSave means that only real-time
processes will be used. The instrument triggers and DPX display are not affected. All other measurements are suspended, and an
information message (Disabled - FastSave is selected) is displayed in the graph area of each display.

Preparing for a FastSave Acquisition

1. Configure the instrument as necessary to capture the signal event you are interested in.
2. On the Setup > Acquire > FastSave tab, specify the Base file name.
3. Click the ... button to specify the location where the acquisition files will be saved.
4. Set the number of files to save by entering a number in the Max files saved per Run box.
5. Specify the file format (TIQ or Matlab).

Starting a FastSave Acquisition
To start a FastSave acquisition:

1. Select the Acq button to display the Acquire control panel.
2. Select the FastSave tab.
3. Select the FastSave acquisition data checkbox ton enable FastSave acquisition.
4. Start a FastSave acquisition:

a. If the instrument is running when you enable FastSave, FastSave acquisitions begin immediately.
b. If the instrument is paused when you select FastSave, select Run to begin FastSave acquisitions.
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Note: When using FastSave in Single Sequence, it is possible for more than one acquisition to be saved under the following
conditions.

• The DPX display is open

• Acquisition length is less than about 50 ms

FastSave can store more than one short acquisition in the time it takes DPX to acquire, process and display one set of DPX
spectrums (about 50 milliseconds). Thus, you may find that FastSave creates more than one file under these conditions. To limit
FastSave to a single acquisition per process, set Max files saved per run to 1 in the FastSave tab (Setup > Acquire > FastSave).

FastSave Status Messages
Once the FastSave acquisition begins, a status messages appears in the graph area. The message that appears depends on whether the
instrument was running or paused when FastSave acquisition data was clicked.

• Disabled - FastSave is selected: This appears when acquisition is paused. It means that the display update is disabled until
FastSave is disabled. FastSave acquisition will not begin until you select Run.

• Saving X of XX - FastSave is active and saving files. This appears only while FastSave is active.

• Done saving - restart with Stop, then Run .. More - Displayed when the specified number of files have been saved. FastSave can
be restarted by selecting Run to begin a new set of acquisitions.

FastSave tab
Use FastSave tab is used to configure and initiate FastSave acquisitions.

Setting Description

FastSave acquisition data Enables/disables FastSave acquisitions. If acquisitions are running, selecting the FastSave
acquisition data checkbox immediately begins saving acquisition data to files. If the instrument is
paused, FastSave acquisitions will not begin until you select Run.

Format Specifies the file format of the FastSave acquisition data files. Files can be saved in TIQ or MAT
format.

Base file name Specifies the base name for acquisition data filenames. When acquisition data files are saved, a
24-character timestamp is appended to the base file name. The maximum base file name length
cannot exceed 232 characters.

Table continued…
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Setting Description

Location Specifies the directory location where files will be saved. Files can be saved on the local hard drive, a
network location or even a USB- connected drive. However, due to the time required to transfer files
across a network or by USB, the local hard drive is the only recommended location.

Max files saved per Run Specifies the number of files to be saved each time a FastSave acquisition is started. The number of
files that can be saved is limited only by the storage space available. Each saved acquisition file uses
about 3.3 MB of space.

Using triggers to capture just what you want

Triggering
The analyzer has two triggering modes: Free Run and Triggered. 

Free Run
In Free Run mode, the instrument initiates acquisitions without considering any trigger conditions. It is a fast and easy way to see the
signals. Free Run is usually adequate for the Spectrum display unless you need to specify a particular time at which to collect the data
record.

Triggered
In the Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The conditions that define a trigger event
depend on the selected trigger source. There are several source selections available for choosing the signal to monitor for a trigger event.
If the RF input is the selected trigger source, you can choose to use power, frequency mask triggering, DPX Density, or Runt as the trigger
types. If other inputs are selected as the trigger source, you can select the slope and level of the trigger point. With the Gated source, you
also specify the gating signal level.

Power triggering. Power triggering triggers the instrument on time-domain signal transitions. The incoming data is compared to a
user-selected level in dBm. You can select the time-domain bandwidth and trigger on the rising or falling edge.

Frequency Edge triggering. Frequency Edge triggering triggers the instrument when the frequency of the input signal changes relative to
the instrument center frequency.

Frequency mask triggering. Frequency Mask Triggering allows you to trigger the instrument when a signal in the frequency domain
violates the mask. You can draw a mask to define the conditions within the real-time bandwidth that will generate the trigger event. It allows
you to trigger on weak signals in the presence of strong signals. This triggering is also useful for capturing intermittent signals.

DPX Density triggering. DPX Density triggering uses characteristics of the DPX display to specify trigger parameters. When using DPX
Density triggering, the percentage of time the signal falls within the measurement box is used to define a trigger event. The measurement
box is defined by frequency and amplitude values.

Runt triggering. Runt triggering allows you to define a trigger event based on a pulse amplitude that crosses one threshold but fails to
cross a second threshold before recrossing the first.

You can define the following event parameters by selecting the respective tab in the Trigger control panel:

• Event source, event type, and event definition.
• Time parameters that define what portion of the data record is used for pretrigger samples and whether to delay the trigger for a set

amount of time after the recognized event.
• Advanced parameters define where a trigger occurs within the acquired memory or trigger each segment in the swept acquisition

mode.
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Save on Trigger
An additional feature of the triggering capability is to save acquisition data when a trigger event occurs. When the analyzer is run in
Triggered mode, you can configure the instrument to save acquisition data to a file. You can also set the instrument to save a picture of the
screen when the trigger event occurs. See Action Tab (Triggering) for details on configuring Save on trigger.

Trigger Front Panel Status Lights
The analyzer has three lights on the front panel that indicate the Trigger status:

• Arm – The instrument is collecting pre-trigger data.
• Ready – Enough pretrigger data has been collected and the instrument is waiting for the next trigger event.
• Trig'd – A trigger even has been received, and the instrument is collecting post-trigger data and transferring the complete data record

out of acquisition memory.

Setting Up Triggering
To set up triggering, use the Trigger control panel. To display the Trigger control panel:

• Press Trigger on the front panel or click Trig in the Application toolbar or select Setup > Trigger.

Using Free Run
To set Triggering to Free Run:

• Click the Free Run option button.

The signal analyzer will acquire a signal without regard to any triggering conditions.

Using Power Trigger
To trigger acquisitions based on the power of the signal:

1. Click the Triggered option button.
2. Select RF Input from the Source drop-down list.
3. Select Power from the Type drop-down list.
4. For further information on setting the power level parameters, see Event Tab (Triggering).

Using Frequency Edge Triggering
To trigger acquisitions based on input signal frequency changes:

1. Click the Triggered option button.
2. Select RF Input from the Source drop-down list.
3. Select Frequency Edge from the Type drop-down list.
4. Set the Freq Slope as appropriate. Select Rise to trigger when the signal frequency is increasing. Select Fall to trigger when the

signal frequency is decreasing.
5. Set the Freq Level. The Freq Level is the frequency that you want to generate a trigger.
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6. If appropriate, enable Power Threshold and set the value. Use this setting to ensure that only sufficiently large signals, not noise, can
generate a trigger.

7. If appropriate, enable Time-domain BW and set the level. Use this setting to process the trigger input signal before the trigger system
analyzes the signal.

For further information on setting the Frequency Edge parameters, see Event Tab.

Using Frequency Mask Triggering
To trigger acquisitions based on violations of a user-defined mask:

1. Click the Triggered option button.
2. Select RF Input from the Source drop-down list.
3. Select Frequency Mask from the Type drop-down list.

For further information on setting the frequency mask parameters, see Event Tab (Triggering) and Mask Editor. If Frequency Mask
triggering is installed, you can change the resolution bandwidth of the frequency transform used to compare to the trigger mask. The
standard FMT uses a fixed length FFT for frequency transforms.

Using DPX Density Triggering
To trigger acquisitions based on the density of the DPX Bitmap trace:

1. Click the Triggered option button.
2. Select RF Input from the Source drop-down list.
3. Select DPX Density from the Type drop-down list.
4. Set the DPX Density parameters as appropriate. You can do this two ways:

• Entering values for Threshold, Frequency, and Amplitude using the front-panel controls.
• Select Trigger On This from the Touchscreen Actions menu (right-click in the graph or press and hold on the display for two

seconds). Move and size the measurement box that appears to set the values for Frequency and Amplitude.

Note: If the Amplitude units (Tools > Analysis > Units) is set to Watts or Volts, you cannot move the measurement box
using a mouse or the touchscreen. Set the amplitude units to any unit other than Watts or Volts to move or resize the
measurement box.

For further information on setting the power level parameters, see Event Tab (Triggering).

Using Runt Trigger
To trigger acquisition based on a runt signal:

1. Click the Triggered option button.
2. Select RF Input from the Source drop-down list.
3. Select Runt from the Type drop-down list.
4. For further information on setting the power level parameters, see Event Tab (Triggering).

Frequency mask trigger
The frequency mask trigger monitors all changes in frequency occupancy within the capture bandwidth (40 MHz or 165 MHz).

The following topics describe the frequency mask trigger controls:

Event tab: explains how to configure frequency mask triggering parameters.

Mask Editor: explains how to create and edit frequency masks.

Triggering: explains how to initiate frequency mask triggering. 
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Mask editor (Frequency mask trigger)
The Mask Editor is used to create masks that are used by the Frequency Mask Trigger function. The Frequency Mask Trigger ( FMT )
function is used to define trigger events to capture signal anomalies based on their frequency and amplitude. 

Displaying the Mask Editor
To display the Mask Editor:

1. Press Trigger on the front panel or select Trig from the Application toolbar.
2. Select the Event tab.
3. Set Source to RF Input.
4. Set Type to Frequency Mask.
5. Select Mask Editor.

Creating a Mask
The simplest way to create a mask is to use the Auto draw function.

To create a new mask using Auto draw:

1. Select the trace on which to base the mask from the Reference trace drop-down list. (Only traces that are shown can be selected from
the drop-down list. To show a trace that isn't currently in the list, open its display and enable the trace of interest.)

2. Specify the margins to be applied between the mask and the reference trace. Enter values for the X Margin and the Y Margin.
3. Click Auto draw.

The following screen shows a mask created with Auto draw.

To create a new mask without using Auto draw:

• Click the New button.

Changing a Mask
A mask is a collection of points specified by their frequency (defined by their offset from the center frequency) and their amplitude. You can
change a mask by adding (or removing) points and editing points.

Note: When placing points in the frequency mask, keep in mind that in most cases, the Frequency Mask Trigger has a range
of 80 dB below Reference Level. However, for values of Reference Level lower than -50 dBm, this range decreases as the
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RefLevel decreases. The FMT range is also reduced when the Acquisition Bandwidth contains frequencies near 0 Hz. In both
these situations, the underlying reason the trigger range is reduced is because the instrument is using various amounts of "digital
gain" in addition to hardware gain. You are not prevented from placing mask points outside the usable range of the instrument, but
at the time the mask is applied, the instrument adjusts its range. When the mask is adjusted, you can see this in the Spectrum
display and the Mask Editor. The mask's shaded fill shows the usable vertical range. Points outside this range are shown, but will
not cause a trigger.

Adding Points
To add a point to a mask:

1. Click the Add points option button. (Alternatively, you can right-click on the desired point location (or left-click and hold for about a
second) and release.)

2. Click in the graph area where you want the new point added to the mask.

You can also add a point to the mask while it is in Edit Points mode:

• Right-click in the graph area where you wish to add a point to the mask. You can also left-click and hold the button down for one
second. You can duplicate this method on the touchscreen by touching the screen for one second.

If you add a point by accident, click Undo. You can click Undo until the Undo button is grayed out.

Editing Points
When you edit a point, you change its offset from the center frequency and/or its amplitude. There are two ways to edit the offset and
amplitude of a point on a mask. First, you can drag a point to the desired position. Second, you can double-click on the offset or amplitude
value in the table and enter a new value.

To edit a point on a mask:

1. Click the Edit Points option button.
2. Click on the point you wish to change.
3. Change the position of the point using the following methods:

a. Dragging it with the mouse to the desired position.
b. Clicking the arrow keys in the Mask Editor window to move the point to the desired position. Use the left/right keys to change the

frequency offset. Use the up/down arrow keys to change the amplitude. Once you click an arrow key, you can use the front panel
knob for fine adjustments.

4. To edit another point, click Next.

You can also edit a point by double-clicking on the value in the table that you want to change and typing in a new value.

Deleting Points
To delete points from the mask:

1. Click the Edit Points option button.
2. Click on the point to be removed and click the X button to delete the point.

You can also delete a point by clicking on the point in the table that you want to delete and clicking the X button.

If you delete a point by accident, click Undo. You can click Undo until the Undo button is grayed out.

Saving a Mask. To save a mask:

• Click the Save button.

To save an edited mask under a new name:

• Click the Save As button.

Opening an Existing Mask. To open an existing mask:
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1. Click on Open. This displays the Open dialog box.
2. Navigate to the location of the mask file.
3. Select the desired file and click Open.

Trigger settings
Menu Bar: Setup > Trigger

Application Toolbar: Trig

Front Panel: Trigger

The Trigger control panel allows you to set the parameters that define trigger events and how the instrument responds to them. 

Trigger Modes
There are two trigger modes: Free Run and Triggered.

Mode Description

Free Run Acquires and displays the signal without triggering.

Triggered Acquires a data record after the defined trigger event is recognized.

Trigger Tabs
Use the Trigger tabs to access controls for setting the different trigger parameters.

Tab Description

Event Sets parameters that control triggering on the selected trigger source.

Time Qualified Sets values used to adjust time of acquisition with respect to time of trigger event.

Advanced Sets controls for triggering in swept acquisitions.

Actions Sets parameters for Save on trigger function.

Event tab
The Event tab is used to set the parameters that define trigger events. The parameters that appear on the Event tab change depending on
the selected Trigger source and type. 

Source
Source specifies the source of the signal to be monitored for a trigger event. The choices available are: RF Input, Trig In (front), Trig 2 In
(rear), Gated, and Line. The Source drop-down list is always visible on the Event tab.
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Type
Type defines the trigger type as Power, Frequency Edge, Frequency Mask, DPX Density, or Runt. The Type selection is only present when
Source is set to RF Input.

• When Type is set to Power, a transition through an adjustable level of the selected source determines a trigger event.
• When Type is set to Frequency Edge, the input signal changing in frequency relative to the center frequency defines a trigger event.
• When Type is set to Frequency Mask, where and how the input signal crosses or fails to cross the edge of the mask defines a trigger

event.
• When Type is set to DPX Density, the amount of time a signal is present at a particular point in the DPX Spectrum graph defines a

trigger event.
• When Type is set to Runt, a signal that exceeds a specified level and then fails to exceed a second specified level defines a trigger

event.

Source = RF input.

The following table describes the settings for each triggering type available when Source is set to RF Input. Type specifies whether a
Power level, Frequency Edge violation, Frequency Mask violation, DPX Density threshold violation, or Runt signal will define a trigger
event.

Table 42: Trigger types

Event Type Setting Description

Power For the Power setting, if the RF input signal crosses the specified level (in the
direction set by Slope), a trigger event occurs. A trigger event does not occur if
the power level of the signal simply exceeds the level setting, there must be a
power level transient that crosses the specified level.

Slope The slope control determines whether the signal analyzer finds the trigger point
on the rising or falling edge of the RF input signal.

Level The Level setting determines the power level that will be recognized as a trigger
event. The Level is indicated in the Amplitude vs Time and Time Overview
displays with a dark cyan colored-line.

Time-domain BW Time-domain BW is a filter used to process the trigger input signal before
the trigger system analyzes the signal. The frequency edge trigger point must
lie within the range of time domain bandwidth. This makes the range of the
frequency edge trigger = Center Frequency ±(0.5 × Time Domain Bandwidth)

Frequency Edge For the Frequency Edge setting, if the RF input signal crosses the specified
frequency (in the direction set by Freq Slope), a trigger event occurs. For
Frequency Edge trigger, the frequency that initiates a trigger event is identified by
the Measurement Frequency + Frequency Level. Frequency Level can be either a
positive or negative value.

Table continued…
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Event Type Setting Description

Freq Slope The slope control determines whether the analyzer finds the trigger point on the
rising (increasing) or the falling (decreasing) edge. This setting is analogous to the
Slope control on the Power trigger type.

Freq Level The Freq Level setting specifies the difference in frequency between the input
signal and the analyzer center frequency required to generate a trigger event. The
Freq Level setting is limited to half the real-time bandwidth.

Power Threshold Specifies the power level the signal must exceed for a frequency variation to be
considered valid.

Time-domain BW Time-domain BW is a filter used to process the trigger input signal before the
trigger system analyzes the signal.

Frequency Mask For the Frequency Mask setting, events where the trace crosses the edge of the
mask when it should not or when the trace does not cross the edge of the mask
when it should define the trigger event. Use Mask Editor (on the Event tab when
Type is set to Frequency Mask) to create and modify Frequency Masks.

Violation Specifies the type of transition that defines a violation.

RBW Specifies the resolution bandwidth.

Auto Specifies whether the RBW is adjusted automatically or manually.

DPX Density For DPX Density, the percentage of time the signal falls within the measurement
box is used to define a trigger event. The measurement box is defined by
frequency and amplitude values.

Density Specifies whether a trigger event is defined by the DPX Density value exceeding
(Higher) the specified Threshold value or is defined by the DPX Density value
falling below (Lower) the specified Threshold value.

Threshold Threshold specifies the density value used for determining a trigger event.
Density is a measure of how much time the signal is present in a particular
region in the DPX Spectrum graph. The range for this value is 0 to 100%.

Frequency Specifies the frequency at the center of the measurement box. The +/- value
specifies the edges of the measurement box above and below the Frequency
setting.

Amplitude Specifies the amplitude of the center of the measurement box. The +/- value
specifies the edges of the measurement box above and below the Amplitude
setting.

Runt Defines a trigger event based on a pulse amplitude that crosses one threshold but
fails to cross a second threshold before recrossing the first.

Table continued…
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Event Type Setting Description

Pulse Specifies whether the runt trigger is defined by a positive-going pulse or a
negative-going pulse.

High level The High level defines the upper voltage limit (first threshold) of a runt pulse.

Low level The Low level defines the lower voltage limit (second threshold) of a runt pulse.

Time-domain BW Time-domain BW is a filter used to process the trigger input signal before the
trigger system analyzes the signal.

Source = Trig In (front).

Setting Description

Slope The slope control determines whether the analyzer finds the trigger point on the rising or the falling
edge of the trigger input signal.

Level The Level setting determines the signal amplitude that will be recognized as a trigger event.

Source = Trig 2 In (rear).

Setting Description

Slope The slope control determines whether the analyzer finds the trigger point on the rising or the falling
edge of the trigger input signal. The trigger level is automatically set at a TTL level.

Source = Gated. When the Source is set to gated, the front panel Trig In source is monitored for the trigger event and a signal on the rear
panel Gate / Trig 2 In is used to determine when a trigger event is valid. A transition through the selected Level on the TrigIn signal input
(selectable as rising or falling edge) will only be recognized as a trigger event if it occurs while the Trig2 signal is True (selectable as High
or Low). Note that only edges are trigger events, not stable signal levels.
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Setting Description

Slope The slope control determines whether the analyzer finds the trigger point on the rising or the falling
edge of a signal.

Level The Level setting determines the signal amplitude that will be recognized as a trigger event.

while Trig 2 In (rear) Specifies whether a High or Low signal at the Trig 2 In input (rear panel) allows a trigger event on the
Trig In (front) input to be accepted.

Source = Line.

The analyzer triggers off of the AC line supply.

Source = RF Input and Type = Frequency Edge.

Table 43:

Setting Description

Freq Slope The slope control sets whether the analyzer triggers on the rising (increasing) or the falling
(decreasing) edge. This setting is analogous to the Slope control on the Power trigger type.

Freq Level The Freq Level setting specifies the difference in frequency between the input signal and the
analyzer center frequency required to generate a trigger event. The Freq Level setting is limited
to half the real-time bandwidth. For example, if your analyzer has an 85 MHz real-time bandwidth,
the Freq Level is limited to ±42.5 MHz. If your analyzer has a 25 MHz real-time bandwidth, the
Freq Level is limited to ±12.5 MHz.

Table continued…
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Setting Description

Actual Readout of the Freq Level being used. This number will be different from the Freq Level setting
when Time-domain BW is enabled.

Hysteresis Readout of the current hysteresis value.

Power Threshold Specifies the power level the signal must exceed for a frequency variation to be considered valid.

Time-domain BW Specifies the Time-domain BW. Time-domain BW is a filter used to process the trigger input signal
before the trigger system analyzes the signal.

The frequency edge trigger point must lie within the range of time domain bandwidth. This makes
the range of the frequency edge trigger = Center Frequency ±(0.5 × Time Domain Bandwidth)

Actual Readout of the current acquisition bandwidth (see Setup > Acquire > Sampling Parameters). If
Time-domain BW is enabled, this readout mirrors the setting for the Time-domain BW.

Freq Slope

The following figures show how the Freq Slope setting affects the trigger.

Hysteresis

The following figures show how the hysteresis value affects when a trigger is generated. In the first figure, the signal frequency crosses
through the User Trigger Level (Freq Level setting) several times but never generates a trigger because it never crosses the lower
hysteresis level followed by crossing the upper hysteresis level.
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The following figure shows that a trigger is generated when the signal frequency changes sufficiently to exceed the hysteresis value (the
difference between the upper and lower thresholds) and cross the lower threshold followed by crossing the upper threshold.

The hysteresis value is calculated as:

Hysteresis = (0.2 X Full Trigger Level range)/10

This amounts to 0.2 divisions if the full range is set to 10 divisions.

• If Time-domain BW is not enabled and the ACQ BW is 165 MHz, the full range is 165 MHz, so the hysteresis is 2.2 MHz
• If Time-domain BW = 1 MHz, then full range is 1 MHz, resulting in a hysteresis value of 20 kHz

Frequency edge hysteresis only changes when the acquisition bandwidth or time-domain bandwidth changes. Hysteresis does not change
with the vertical scale factor.

Using a wider acquisition bandwidth allows you to monitor a wider frequency range but it also allows for more noise which requires more
hysteresis. To achieve the best results, use the smallest acquisition bandwidth (or time-domain bandwidth) that contains the frequency
variations of interest. Using a wide acquisition bandwidth with a small frequency variation can result in the frequency variation not
exceeding the hysteresis. This will result in no trigger being generated.

Source = RF Input and Type = Frequency Mask.

Setting Description

Violation These selections define the state or transitions of the signal used to define a trigger event.

Mask Editor Displays the Mask Editor so that you can create and edit Frequency Masks.

Load from file Invokes the Open dialog for selecting a previously saved frequency mask file.

Table continued…
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Setting Description

RBW Sets the Resolution Bandwidth value to be used in the spectrum view. The value is italicized when
Auto is selected.

Actual This is a displayed value, not a setting. It is the RBW being used by the signal analyzer; this value
may not match the RBW requested (in manual mode).

Violation. Violations are state changes (or a sequence of state changes) defined by whether a point on the signal falls within the frequency
mask or outside the frequency mask. A True violation occurs if even a single point on the trace falls inside the mask (above the mask's
lower edge). Conversely, a False violation occurs if no points on a signal fall inside the mask (all trace points are below the mask's lower
edge).

A trigger event is initiated based on the type of violation that occurs and the sequence of violations that occur.

Violation Description

T Only one state is required to initiate a trigger event. The signal has at least one data point inside
(above) the mask. The trigger event occurs when the instrument detects the first signal with a point
violating the mask. A trigger event could occur on the first acquisition.

F Only one state change is required to initiate a trigger event. The signal has all data points outside
(below) the mask. The trigger event occurs when the instrument has detected the first spectral
waveform that lies completely below (outside) the mask. A trigger event could occur on the first
acquisition.

T - F (Out) Two states are required to initiate a trigger event. The signal must be inside the mask and then
passes out of the mask. The trigger event occurs when the first non-violating waveform is detected.

F - T (In) Two states are required to initiate a trigger event. The signal must be outside the mask and then
passes into the mask. The trigger event occurs when the first non-violating waveform is detected.

Table continued…
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Violation Description

T - F - T (Out & In) Three states are required to initiate a trigger event. The signal starts inside the mask and then passes
out of the mask. Next, the signal must pass into the mask. The trigger event occurs at the second
transition where the signal passes back into the mask.

F - T - F (In & Out) Three states are required to initiate a trigger event. The signal starts outside the mask and then
passes into the mask. Next, the signal must pass back outside the mask. The trigger event occurs at
the second transition where the signal passes back out of the mask.

Mask Editor. Launches the Mask Editor that enables you to create and edit Frequency Masks.

Load from File. Enables you to load an existing frequency mask for use with Frequency Mask Trigger.

Source = RF Input and Type = DPX Density. DPX Density triggering analyzes the density of the DPX Bitmap trace to define trigger
events. You specify the portion of the DPX Bitmap trace to analyze by defining a measurement box. The measurement box is the only area
of the DPX Spectrum graph that is analyzed for trigger events.

Setting Description

Density Specifies whether a density value higher or lower than the threshold value defines a trigger event.

Threshold Specifies the DPX Density threshold that defines a trigger event. The DPX Density must be higher or
lower (specified by the Density selection) than this value to define a trigger event.

Frequency Specifies the center of the measurement box on the frequency axis (horizontal).

+/- Specifies the width of the measurement box.

Amplitude Specifies the enter of the measurement box on the power level (vertical) axis.

+/- Specifies the height of the measurement box.

Source = RF Input and Type = Runt. Runt triggering defines a trigger event based on whether or not a signal transition fails to cross a
user-defined level. Two levels are defined for Runt triggering. A Runt signal is one that passes through both levels in one cycle but only
passes through one level on the next cycle.
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Setting Description

Positive Specifies that a second signal transition cycle that fails to exceed the High level will define a trigger
event.

Negative Specifies that a second signal transition cycle that fails to fall below the Low level will define a trigger
event.

High level Specifies the High level used to define the trigger event.

Low level Specifies the Low level used to define the trigger event.

Time qualified tab
The Time Qualified tab allows you to specify whether triggers are accepted based on timing characteristics. Trigger events that pass the
timing qualification result in an acquisition. Trigger events that do not pass the timing qualification are ignored. Time-qualification can be
applied to Power, Frequency Mask, Runt and External triggers.

Setting Description

None No timing qualification is applied to trigger events. Acquisitions occur whenever a trigger event occurs
(as specified on the Event tab).

Shorter If the length of the trigger event is shorter than the time specified by the Time 1 setting, then the
trigger event is accepted and an acquisition is completed.

Longer If the length of the trigger event is longer than specified by the Time 1 setting, then the trigger event is
accepted and an acquisition is completed.

Inside If the length of the trigger event is longer than the time specified by the Time 1 setting and shorter
than the time specified by the Time 2 setting, then the trigger event is accepted and an acquisition is
completed.

Outside If the length of the trigger event is shorter than the time specified by the Time 1 setting or longer
than the time specified by the Time 2 setting, then the trigger event is accepted and an acquisition is
completed.

Time 1 Enter the Time 1 reference value here. Range: 20 ns-28 s.

Time 2 Enter the Time 2 reference value here. Range: 20 ns-28 s.

The following table shows how the appearance of the Time Qualified tab changes depending on whether time qualified triggering is
enabled or not enabled.
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Tab appearance Description

When None is selected on the Time Qualified tab, the watch icon is dimmed.

When any selection other than None is selected on the Time Qualified tab, the watch icon appears in
color.

Minimum off time between trigger events. This readout shows how long the trigger conditions must be absent between the end of one
trigger event and the start of the next trigger event to be ensure that the end of the first event is recognized. For example, if Freq Mask
is selected and its RBW causes a minimum off time of 500 µs, and your signal violates the mask for 600 µs of every 1 ms, (so that the
OFF time is 400 µs), it will appear to the analyzer that the signal is continuously in violation. Shorter and Inside settings will not produce a
trigger in this situation.

Advanced tab (Triggering)
Menu Bar: Setup > Trigger > Advanced

Application Toolbar: Trig > Advanced

Allows you to set parameters for trigger position and holdoff settings. 

Setting Description

Position Sets the point along the acquisition record the trigger event should occur.

Auto Enables the instrument to set the position of the trigger event. To manually specify the position of the
trigger event, unselect Auto.

Delay Sets how long after the trigger event specified by the Position setting, the analyzer should wait before
actually initiating the trigger event.

Holdoff Prevents triggers until there have been no trigger events for at least the specified time. Range:
20 ns-10 s.

Trigger each frequency segment
in Swept acquisition mode

Sets the analyzer to wait for a trigger for each acquisition in a swept spectrum or other measurement
requiring multiple acquisitions worth of span.

Holdoff
Holdoff on the analyzer does not work exactly like the traditional Holdoff setting on an oscilloscope. On an oscilloscope, once the
instrument triggers, the holdoff setting causes the oscilloscope to refuse to accept another trigger until the holdoff time has expired. On the
analyzer, once a trigger event is identified, the instrument determines how long it has been since the previous trigger event occurred and
if the time since the previous trigger event is greater than the holdoff time, the trigger event is accepted and an acquisition is completed.
If the time since the previous trigger event is less than the holdoff time, the latest trigger event is ignored (no acquisition occurs) and the
holdoff time count restarts.
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The most common reason for using holdoff is ensuring that the instrument triggers on the first pulse in a burst. For this application, the
difference between the signal analyzer holdoff and the traditional oscilloscope holdoff has no effect on acquisitions.

The case where the difference can be noticed is when the time between trigger events is always less than the specified holdoff time.
An oscilloscope will trigger on the first event after the holdoff time expires, no matter how short the time has been since the most recent
rejected trigger event. In such a situation, the analyzer will not ever trigger because it requires that there are no trigger events during the
holdoff time before an accepted trigger event.

Actions tab (Triggering)
The Actions tab sets parameters for the Save on trigger function. The Save on trigger function allows you to save an acquisition data file
and/or a screen capture when a trigger event occurs.

Trigger events are defined on the Event and Time Qualified tabs. 

Table 44: Action tab settings

Setting Description

Save acq data on Trigger Enables the Save on Trigger function. The list box to the right of the Save acq data on
Trigger check box specifies the format of the saved file. Acquisition data files can be saved
in TIQ (native) format, CSV format, and MAT (Matlab) format. For descriptions of these file
formats, see Data, Settings and Picture File Formats.

When TIQ is the selected file type, a file is saved after a complete acquisition, which can
include multiple frames. When CSV or MAT is the selected file type, a separate file is saved
for each frame.

Files are saved in the last location a file was saved. If Automatically increments
filename/number is enabled (see Save and Export), files will be saved without user
interaction. If Automatically increments filename/number is not enabled, you will be
prompted for a filename when a trigger event occurs.

Save picture on Trigger Enables saving a picture of the display when a trigger event occurs. Files can be saved in
PNG, JPG, and BMP format. For descriptions of these file formats, see Data, Settings, and
Picture File Formats.

Max total files saved per Run Specifies the number of times a Save on Trigger action stores a file. After this limit is
reached, no more files are saved. The instrument will continue to run, but no additional files
are saved when a trigger event occurs.

Keep in mind when setting this number that picture files are counted as part of the total
number of files. For example, if you set Max total files to 100, the instrument will save
100 acquisitions if only acquisitions are saved or only pictures are saved. But, if both
acquisitions and pictures are saved, then 50 acquisitions and 50 pictures will be saved.
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Signal Database and Channel Navigation
How to use the Signal Database
Select Tools > Signal Database to open the Signal Database window. Here you can select which signal standards and types are listed
(and selectable) in the Channel Navigation toolbar and/or the Define Survey control panel.

Signal standards and signal types defined
The analyzer uses the following definitions of signal standards and signal types to populate the Signal Database.

• Signal standard: A group of channels that adheres to the parameters and characteristics of a given signal type. These channels could
include both uplink and downlink frequencies.

• Signal type: Parameters and characteristics (bandwidth, spectral shape) common to a given signal. A signal type can be shared by
multiple signal standards.

How to select signal standards in the database window

The following image is of the Signal Database window with the Signal Standards tab selected. The table describes the fields and buttons of
the tab. The standards selected here show in the Define Survey control panel and the Channel Navigation toolbar.

Setting Description
Signal Standards
Supported

List of all available signal standards. Click a standard to select it or click and drag to select a contiguous range
of standards.

Add > > Adds (moves) selected items from the Signal Standards Supported list to the Signal Standards selected
list.

< < Delete Deletes (moves) selected items from the Signal Standards selected list to the Signal Standards Supported
list.

Table continued…
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Setting Description
Signal Standards
selected

List of selected signal standards that will be made available in the Channel Navigation toolbar and the Region
tab of Define Survey control panel. To delete items, select one or more signal standards and click the Delete
button.

Factory Reset Sets the supported and selected fields to the factory-specified signal standards.
Channel Nav Toolbar
check box

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You can read
more about the Channel Navigation toolbar here.

Signal Survey Toolbar
check box

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can read more
about the Signal Survey toolbar here.

How to select signal types in the database window

The following image is of the Signal Database window with the Signal Types tab selected. The table describes the fields and buttons of the
tab. The types selected here show in the Define Survey control panel.

Item Description
Signal Types supported List of all available signal types. Click a type to select it or click and drag to select a contiguous range of types.
Add > > Adds (moves) selected items from the Signal Types Supported list to the Signal Types selected list.
< < Delete Deletes (moves) selected items from the Signal Types selected list to the Signal Types Supported list.
Signal Types selected List of selected signal types made available in the Region tab of the Define Survey control panel. To delete

items, select one or more signal types and tap the Delete button.

Factory Reset Sets the supported and selected fields to the factory-specified signal types.

Channel Nav Toolbar
check box

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You can read
more about the Channel Navigation toolbar here..

Signal Survey Toolbar
check box

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can read more
about the Signal Survey toolbar here..
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How to select channels in the database window

The following image is of the Signal Database window with the Channel Table tab selected. The table describes the fields and
buttons of the tab. The channels selected here are included in the Signal Channel Selection window. (See the Channel Navigation
toolbar on page 684 section for information about channel selection.)

Item Description

Selected Signal Standard Drop down list allows you to select the signal standard, the channels of which will populate the channel table.
This list is taken from the enabled standards in the Signal Standards tab.

Enabled column
checkboxes

Enables/disables the channel in the row.

Mark All Selects all channels in the table to enable them.

Unmark All Deselects all channels in the table to disable them.

Hide unmarked checkbox Hides any deselected channels so that you can view only the enabled channels in the table.

Factory Reset Sets each channel to the factory-specified enabled/disabled state.

Channel Nav Toolbar
checkbox

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You can read
more about the Channel Navigation toolbar here..

Signal Survey Toolbar
checkbox

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can read more
about the Signal Survey toolbar here..

Channel Navigation toolbar
Select View > Chan Nav Toolbar to view the Channel Navigation toolbar. This toolbar allows you to navigate easily from channel to
channel in any measurement display. It provides the following capabilities:
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• Select a channel for enabled standards (only standards selected in the Signal Database).
• Select the channel direction, if applicable (uplink or downlink).
• Access the Signal Channel Selection window, which allows you to select from a list of enabled channels.

The following image shows the toolbar and the following table describes how it functions. 

Item Description

Signal Standard Drop down list allows you to select the signal standard, the channels of which will populate the Channel field
to the right . This list is taken from the enabled standards in the Signal Standards tab of the Signal Database.

Channel This field shows the channel number of the currently selected signal standard that the instrument is currently
tuned to. An entry of "--" indicates that the current instrument frequency does not match that of any of the
currently enabled channels.

Clicking in this field allows for direct channel number entry. To select the next or previous channel, you can
use the up and down arrow keys on your keyboard or the arrows in the Numeric Keypad (in the View menu,
check the Numeric Keypad box). Note that this applies to enabled channels only.

If you see a ≈ in front of the channel number, it means that the current instrument frequency is close to, but
not exactly equal to, the currently selected channel. It means that the current instrument frequency does not
exactly match the currently selected channel frequency, but that it is within the current channel bandwidth.

You cannot directly enter or use the arrow keys to select non-numeric channel names for signal standards You
must use the Select Channel button.

Select Channel Opens the Signal Channel Selection window. This window shows a table of enabled channels for the selected
standard. Click on the channel you want to view in the plot and then click the OK button. This window also
allows you to access the Signal Database window (using the Enabled Channels button) so that you can
enable different channels or change standards or types, if desired.

Uplink Click to select the uplink channels for the currently selected signal standard.

Downlink Click to select the downlink channels for the currently selected signal standard.
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See also:
How to use the Signal Database on page 682
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Signal Classification
Overview
With the SV54 optional application license for SignalVu-PC installed, you can use the signal classification toolset to help you classify
signals. You will first define areas of interest as regions anywhere on a Spectrum or DPX waveform. You can then use our Signal Database
tool to compare the spectral shape of the selected signal area to known signal types, and the center frequency of the selected signal
area to known signal standard channels. Finally, you can assign classification labels to regions, record related notes, and save all defined
regions to a region survey file. This toolset also allows you to import and export survey files. The following information and procedures are
available to help you find, navigate through, and use the signal classification tools to classify a signal.

• Step by step procedures for classifying a signal. These procedures walk you through the classification process from start to finish using
the analyzer’s signal classification tools. Examples are included.

• How to use the Signal Survey toolbar. Once launched, this toolbar allows you to access the Create/Edit, Define, and Classify tools.
These tools allow you to create a new survey/region, import and export surveys, define region signal standards and types, navigate
quickly through regions in a survey, and classify a signal in a region.

• Signal Survey toolbar on page 694How to use the Signal Survey Editor window. This window is accessed through a Signal Survey
toolbar button. It allows you to create and edit regions or import or export a survey.

• How to use the Define Survey control panel. This panel is accessed through a Signal Survey toolbar button. It allows you to select
signal standards and types from the Standards Database; see bandwidth, frequency, and channel information; view all regions and
related information in a survey in a table; and select and view a spectral profile (most signal types have an available profile).

How to classify a signal
The following procedure shows you how to use the signal classification tools to classify a signal. It is divided into four main tasks.

Note: Before you proceed, you will need to select a list of enabled signal standards, signal types, and channels in the Signal
Database. You do not need to perform this setup each time you classify a signal. Once set up, this list does not change unless you
reset to default or change the selections.

1. Create areas of interest as regions (center frequency and frequency span) anywhere on the signal.
2. Define a survey (a region or collection of regions) by comparing the bandwidth of the unknown signal to that of known signal types, and

the center frequency of the unknown signal to that of known signal standard channel frequencies.
3. Classify the signal by assigning classification labels and notes to a defined region.
4. Export or import a region survey file.

Create a region
The first step in classifying a signal is to create a region that defines the portion of the signal you want to use.

1. Open a Spectrum or DPX display to view the signal you want to classify.
2. Select View from the analyzer menu bar and select (check) Signal Survey Toolbar. The toolbar will appear near the bottom of the

screen.
3. Click the Create/Edit... button in the Signal Survey tool bar to open the Signal Survey Editor window.
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4. Check that the selected reference trace is correct in the Reference dropdown list which is located to the right of the Export As...
button. Note that for a trace to be in the list, it must be enabled in the Spectrum or DPX display.

5. Click the Add Region button.
6. By default, Click and drag on plot is selected for the add region method. Click and drag on the plot around the signal area of

interest to define the width (span) of the region. The analyzer will draw a box on the plot that is outlined in gray, indicating that the
region is as yet undefined. Click on the

icon at the bottom of the region to change the CF. You can also click and drag on the left or right edge of the region rectangle to
change its span. The amplitude of the signal does not need to be totally enclosed in the region box.

7. If you want to manually enter the center frequency and span parameters to create a region, select Manual entry, enter the values in
the New Region Location fields, and then click the Add Region button.

8. Create more than one region, if needed.

Note: A maximum of two regions can overlap at any given frequency. If you try to create a new region that contains any
frequency point that is already shared by two other regions, an error message is displayed stating that too many regions
overlap.

9. If you want to edit a region, then you can use the same tools as when you first created the region (click, drag,

). If you want to delete a region, select the desired region and then click the Delete Region button. You can also click Delete All
Regions to delete all regions in the display.

When Manual entry is selected in the On Add area, you can manually edit the Frequency and Span.
10. Click the OK button when you are finished creating and editing regions. Clicking the Cancel button will result in all additions/changes

made during the current edit session (as long as the Signal Survey Editor dialog has been open) being discarded.

See also:
How to use the Signal Survey Editor window.

How to use the Signal Survey toolbar.

How to use the Define Survey control panel.

What region color codes mean.

How to use the Signal Database on page 682
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Define a region using known standards
The next step after creating a region is to define it by comparing the unknown signal’s bandwidth and frequency to the known signal
standards and signal types. Doing this allows you to potentially find a match and classify the unknown signal. You can also use known
signal standard channel frequencies to match against a region’s center frequency.

Note: You can also define a region using a known signal standard channel frequency and match it against the center frequency of
a region.

1. Click the Define button to open the Define Survey panel.
2. Do one of the following to select a region:

• Click on a region (shown as a horizontal bar along the top edge of the plot) in the Spectrum or DPX display. When selected, the
region will expand to a rectangular box around the signal.

• Click on a row in the Survey Summary tab table of the Define Survey panel. This table is scrollable and contains summary
information about all of the regions in the current display (called a survey). Clicking on a row in the table selects the region in the
display. Information in the rows is not editable.

• Use the left or right arrows on the Signal Survey toolbar to navigate to the desired region. Notice that this will highlight the row
number in the Survey Summary tab table of the associated region, and thus select the region in the display.

Note: Only one region can be active at a time. Inactive regions are shown as horizontal bars along the top edge of the signal.
An active region is shown as a box drawn around the signal.

3. In the Define Signal panel, select the Region tab and click to view the drop-down list under the Signal Type Bandwidth. In the below
image, you can see that in the list, the Bluetooth signal type has a star next to it. The degree and darkness of the shading of a star
indicates how close of a bandwidth match the given signal type is to the unknown signal. (You can read about how the star indicator
works in The Define Survey control panel topic.)
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4. You now want to select from this list of known signal types and associated bandwidths. Once selected, a spectral profile (shown as
a green waveform in the example image) will be overlaid on the portion of the signal in the region. The spectral profile is used to
compare against the signal in the region. If the profile and the signal match, then there is a good chance the signal is that given signal
type.

Note: Most, but not all, signal database signal types have spectral profiles.

5. Click on the Prefs tab in the Define Survey panel to set the spectral profile to do one of the following:

• Snap to Channel Frequency: Use this option if you want to verify the frequency of the signal is aligned with the selected signal
standard channel frequency. If the selected signal standard channel frequency is within the selected region, then the spectral
profile will center on that channel frequency. If the channel frequency is outside of the selected region, then the spectral profile will
revert to being centered within the region.

• Snap to Center of Region: Use this option if you know that the frequency you are viewing has no defined signal standard
channels in the database.

• Off: Use this option if you want to view the signal in the region without the spectral profile overlayed on the signal.

See also:
The Signal Survey Editor on page 694

Signal Classification

RSA5100B Series Real-Time Signal Analyzers Help 690



How to use the Signal Survey toolbar

How to use the Define Survey control panel.

What region color codes mean

Signal Database

Classify a region
After you have created a region, you can classify it by assigning classification labels and notes to it.

1. Select a region.
2. Click the Classify button in the Signal Survey toolbar to view the Declare Region window.

3. Select a Classification state from the drop-down list and enter a Description and Comments for the region.

Classification state and region color coding.

Each region’s outline is colored according to it’s classification state:

• Gray = None
• Yellow = Unknown
• Orange = Unauthorized
• Blue = Permitted

4. Click OK to save the classification information as a survey and close the window. Once a region has been classified, the signal type
and signal standard used for classification are locked. To apply different signal types and standards to the region, set the classification
to None.

The following example survey is of a portion of the TV broadcast band. Seven regions have been declared as either Permitted, Unknown,
or Unauthorized, as indicated by the color bars for each region.

Signal Classification
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The illustration below shows a detailed portion of one of the declared regions. Since we have declared this to be an ATSC video signal, the
spectral profile for the ATSC signal is shown overlaid in the region. The signal is a close match to the spectral profile, including the vestigial
carrier at the lower side of the signal, characteristic of ATSC broadcasts.

See also:
How to use the Signal Survey Editor window

Signal Survey toolbar on page 694

The Define Survey control panel on page 695

How to use the Declare Region window

Signal Database

Export or import a survey file
The application does not enforce a hard limit on the total number of regions you can create. However, as the number or regions increase,
system performance decreases. A good rule of thumb is to keep the total number of regions under 500. If more than that are required,
create and save separate surveys, each with no more than 500 regions.

Export a file. To export a region or set of regions in a file, do the following:

1. Click the Create/Edit... button in the Signal Survey toolbar to open the Signal Survey Editor window.
2. Click the Export As... button in the Signal Survey Editor window.
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3. Navigate to the location you want to save the file.
4. From the Save as type drop down list in the Save As window, select one of the following:

• *.Survey – survey in an internal format
• *.txt – survey in a tab separated format
• *.csv – survey in a comma separated format

5. Enter the file name and click Save to save the file.

Survey Import/Export file format notes.

• All lines starting with a "#" character are treated as a comment line.
• All blank lines are ignored.
• Lines starting with "Signal Classification: Number of Regions" are ignored (in order to be compatible with H500/SA2500 survey

import/export files).
• The only required fields are the region center frequency and region bandwidth all other fields can be left blank.

Survey file field definitions. You can create your own .txt and .csv Survey files using software applications such as Excel or Notepad,
and then import them. The following information will help you do this. You can also refer to the SurveyImportFileExample.txt sample
import/export file installed with SignalVu-PC in the C:\SignalVu-PC SignalVuRSA5100BFiles\Example Files\SignalClassification directory.

• # - Region number. Note that the value specified is not used during import (regions are renumbered as necessary)
• Freq (Hz) - Center frequency of the region
• Span (Hz) - Bandwidth of the region
• Description - Short description of the region
• Classification - Declared region classification (None, Unknown, Permitted, or Unauthorized)
• Type - Declared region signal type ("Not Set", "Unknown" or any currently defined signal type name)
• Standard - Declared region signal standard ("Not Set", "Unknown" or any currently defined signal standard name)
• Channel - Declared region channel number (channel number from the specified signal standard; "----" can be used to denote no

channel number specified)
• Ch Freq (Hz) - Declared region channel frequency (for the specified channel number; "----" can be used to denote no channel

frequency specified)
• Comments - Declared region comments

Import a file. To import a region or survey file, do the following:

Note: If a problem is found with the format of the file being imported, a dialog will be displayed indicating the file line number
where the problem was found and a short description of the problem. For example, “Survey Import failed: Syntax Error near line
10: Invalid span value”.

1. Click the Create/Edit... button in the Signal Survey toolbar to open the Signal Survey Editor window.
2. Click the Import... button in the Signal Survey Editor window.
3. Navigate to the location of the saved file and select to import one of the following file types:

• *.Survey – survey in an internal format
• *.txt – survey in a tab separated format
• *.csv – survey in a comma separated format

4. Click Open to open the selected file.

Importing guidelines. If you try to import a survey when regions are already defined, an Import Regions dialog will appear and prompt
you to select one of the following import options:

1. Delete all existing regions prior to import.
2. Attempt to merge the imported regions with the existing regions.
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3. Cancel the import.

If an import and merge action does not successfully merge all regions, the "Warning: not all regions were successfully merged" message
will be displayed in the informational area of the Signal Survey Editor dialog.

Signal Survey toolbar
Select View > Signal Survey Toolbar to view the Signal Survey toolbar. It allows you to create, edit, define, and classify a signal. It also
allows you to navigate from one region to another in the DPX or Spectrum display and to delete the selected region. This topic describes
the toolbar and all of its related windows and functions.

Item Description
Create/Edit... Opens the Signal Survey Editor window that allows you to create and edit regions and import and export

region survey files.

Define Opens the Define Survey control panel. This panel allows you to view a survey summary, select how to view
spectral profiles, and to specify a signal type and signal standard channel for each region.

Classify Opens theThe Declare Region window (classify) that allows you to classify a region.
Selected Region Click the arrows to navigate from region to region.
Delete Click to delete a selected region.

The Signal Survey Editor
Click the Create/Edit... button on the Signal Survey toolbar to access the Signal Survey Editor window. Following is an image of the
window and a table describing it.

Note: If you change which waveforms are enabled in the DPX or Spectrum display after the Signal Survey Editor window is open,
the Reference list in the Editor will no longer be accurate. You must close and then reopen the Editor to refresh the list.

Item Description
Import Click this button to import a survey from a file.
Export Click this button to save changes made to a previously saved survey file. This button is only available for

previously saved surveys. This function is like the common Save function.
Export As... Click this button to export all of the region information to a survey file. This function is like the common Save

As function.
Reference This drop down list shows all active traces from the currently displayed Spectrum and/or DPX measurement

displays. When you first open the Editor, the displayed reference trace will be the trace in the currently
selected Spectrum or DPX measurement display.

Delete All Regions Click this button to delete all regions on the plot.
Add Region Click the Add Region button to enable the plot to allow you to add a region by clicking and dragging or

entering the values manually, depending on the selected On Add setting.
On Add: Select to add a region manually or by clicking and dragging on the plot.
New Region Location When Manual entry is selected in the On Add area, the New Region Location area appears. Here you can

manually enter the Frequency and Span.
Status message area Shows informational and error messages.
Table continued…
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Item Description
Region table Shows regions and the related frequency and span. These are editable in the table for regions that have not

yet been classified.
Measurement display Interactive view of the active measurement plot (DPX or Spectrum). You can click and drag on the plot to

create a region and left-click in the display area to select the current click/drag mode. Allowable modes are
Select, Span Zoom, and CF Pan. You can also adjust the area of the signal within the region using the
following:

dB/div Shows the dB per division on the y-axis of the plot.
CF Shows the current region center frequency. Click on the field to enter a new value.
Span Shows the current region span. Click on the field to enter a new value.
Classification Shows the classification label of the selected region: Unknown, Unauthorized, or Permitted. If it has not been

classified, this field reads None.
Signal Type Shows the signal type of the selected region, if the signal in the region has been classified. If it has not been

classified, this field reads Not Set.
Signal Standard Shows the signal standard of the selected region, if the signal in the region has been classified. If it has not

been classified, this field reads Not Set.
Delete Region Click this button to delete the selected region.

See also:
The Create a region on page 687 topic to see how the Signal Survey Editor works when creating/editing a region.

The Define Survey control panel
Click the Define button on the Signal Survey toolbar to access the Define Survey control panel. The following images and tables describe
the Define Survey control panel and its tabs.

Region tab

Item Description
Signal Type For classified regions, this field is not editable. For unclassified regions, this field is a drop-down list of all

enabled signal types (set in the Signal Database). The types that best match the signal are starred in this list.
See here for star rating definitions.

Bandwidth Shows the bandwidth of the selected signal type.
Notification area Notes may appear between the Signal Type and Signal Standard fields.
Signal Standard For classified regions, this field is not editable. For unclassified regions, this field is a drop-down list of all

enabled signal standards (set in the Signal Database) and standards for which channels are enabled. The
standards and their channels that best match the center frequency of the region are starred in this list. See
here for star rating definitions.

Frequency Shows the channel frequency of the selected signal standard.
Channel Shows the channel number for the selected signal standard. .

Signal Classification
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Criteria for signal standard and type star ratings.

Criteria
Star Signal standards Signal types

The region center frequency matches the selected signal
standard channel frequency and the selected signal
standards database signal type matches that of the
selected signal type.

The region bandwidth exactly matches the selected signal type
bandwidth.

The region center frequency matches the selected signal
standard channel frequency.

The region bandwidth is within ±5% of the selected signal type
bandwidth and does not exceed the defined min/max matching
bandwidth range of the selected signal type.

A large portion of the region start/stop frequency overlaps
the selected signal standard channel frequency.

The region bandwidth is within the defined min/max matching
bandwidth range of the selected signal type.

A small portion of the region start/stop frequency
overlaps the selected signal standard channel frequency.

Not applicable.

No star No portion of the region start/stop frequency overlaps the
selected signal standard channel frequency.

The region bandwidth is outside the defined min/max matching
bandwidth range of the selected signal type.

Survey Summary tab

Item Description
Summary table of all of
the regions in the active
plot

Each region is identified by a number.
The center frequency of the region.
The span of the region.
The classification of the signal in the region.
The signal type of the signal in the region, if it has been set. Otherwise, this field reads Not Set.
The signal standard and channel of the signal in the signal in the region, if it has been set. Otherwise, this field
reads Not Set.

Preferences tab
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Item Description
Spectral Profile Off turns the spectral profile off so that it does not appear on the plot. Use this option if you want to view the

signal in the region without the spectral profile overlayed on the signal.
Snap to Center of Region aligns the spectral profile to the center of the region. Use this option if you know
that the frequency you are viewing has no defined signal standard channels in the database.
Snap to Channel Frequency aligns the spectral profile with the specified signal standard channel frequency
of the signal. Use this option if you want to check that the channel frequency of the spectral profile matches
the signal frequency you are looking at. If the selected signal standard channel frequency is within the
selected region, then the spectral profile will center on that channel frequency. If the channel frequency is
outside of the selected region, then the spectral profile will snap to the center of the region.

See also:
Define a region using known standards.

The Declare Region window (classify)

Click the Classify... button on the Signal Survey toolbar to access the Declare Region window. Once a region is classified, you can no
longer change the signal type or signal standard in the Region tab of the Define Survey control panel. The following image and table
describe the Declare Region window.

Item Description

Classification Lists classification types to assign to the current region. Each classification has a unique color
that is assigned to the region box:

None: Gray

Unknown: Yellow

Unauthorized: Orange

Permitted: Blue

Description Enter a brief description to identify the region.
Comment/Notes Enter additional comments to provide needed information regarding the region.
Signal Lists the selected signal type and signal standard of the selected region.
Region Lists the span and center frequency of the selected region.
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Note: If a region is classified, you need to change the classification to "None" before you can make any changes to that region.

Signal Classification
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Managing Data, Settings, and Pictures
Managing data settings and pictures

Saving and recalling data settings and pictures
You can save different types of data for later recall and analysis. 

Data type Description Save as type

Setup files Saves all of the setup information for all
displays, except those settings that are not
part of Preset.

Setup (.Setup)

Picture of Selected Display (PNG/JPG/BMP) Saves a capture of the screen in the
specified format. This option is useful for
including the graphic in reports or other
applications. Marker readouts and other
information are included.

Picture (.BMP, .PNG, .JPG)

Results Export files Saves the trace and numeric data for the
selected display. The trace and numeric
data are saved as CSV files.

Results export (various)

Measurement Settings Saves a list of settings relevant to the
selected measurement to a text file.
This option is useful for including the
measurement settings in reports.

Measurement settings export (TXT)

Trace Saves a trace for later recall into the display
from which it was saved.

Selected trace (various)

Data Saves data for reanalysis by RSA6100B
Series Real-Time Spectrum Analyzers,
RSA5100B Series Real-Time Signal
Analyzers, SPECMONB Series Real-Time
Spectrum Analyzers, or as data to use
with external software (either CSV (comma-
separated value) or MAT (MATLAB format).
For fastest capture of data files in TIQ or
MAT format, use FastSave. This function
disables caching and analysis of incoming
data, greatly decreasing the time required to
save files to local or network storage.

Acquisition data with setup (TIQ); or
Acquisition data export (CSV or MAT)

Saving Files
Saving files follows the same procedure regardless of the type of data being saved. To save setups (including application presets),
pictures, results, or acquisition data:
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1. If you are going to save DPX Spectra (DPXogram) acquisition data, stop acquisitions.

Saving while running is allowed by the analyzer, but data files saved while running will not contain any DPX spectral data.
2. Select Save As from the File menu to open the Save As dialog box.
3. Navigate to the folder where you want to save the setups, or use the default location.

• To save setups so that they appear in the User Presets list, save your setup in the folder C:\RSA5100B Files\User Presets. The
saved setup will appear in the User Presets window with the name you give the file.

4. Enter a file name.
5. Select the type of file to save from the Save as type drop-down list.
6. Click Save.
7. If you save acquisition data (Acq data with setup (TIQ), Acq data export (CSV), and Acq data export (MAT)), the File Contents window

appears. In the File Contents window, you need to specify the data type, data records, and data length to save the acquisition data.

a. Select the data type: Choose IQ data, DPX Spectra, or both. DPX spectral data only exists while either the DPXogram or Split DPX
display is open, and acquisitions are stopped. IQ data is not available when FastSave is turned on. In cases where the selected
data type is not available, the file will be saved without that data.

b. Select the data records you want saved. Frames can be saved only when FastFrame was enabled during acquisition.
c. Select the desired data length. The data length controls are enabled only when IQ data is being saved.
d. Click Save to save the acquisition data file.

Saving Data with FastSave
To save data using FastSave, use the procedure Preparing for a FastSave Acquisition.

Recalling Files
You can recall three types of files: Setup files, Selected Trace, and Acquisition data with setup. Recalling data follows the same procedure
regardless of the type of data being recalled.

1. Select Recall from the File menu to open the Open dialog box.
2. Navigate to the folder containing the file you want to recall.
3. Select the type of file to recall from the Files of type drop-down list. This selection determines the files that appear in the Open dialog

box.
4. Select the file to recall.
5. Click Open.
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Setup Files
You can set up the instrument as desired and then save the settings in a setup file. This enables you to quickly setup the instrument by
recalling previously saved setups.

Exporting Results
Save for further analysis of results in other programs, such as MATLAB or Excel.

Pictures of the Selected Display
You can save pictures of the instrument display for documentation purposes. When saving pictures of the display, you can select from
three file types: BMP, JPG, or PNG.

Measurement Settings
You can save a list of settings relevant to the selected display to a file for documentation purposes. The exported file uses tab characters to
separate values. The settings included in the file depend on the selected display. The contents of the file are the same as a Results export
except it does not include the results.

Saving Acquisition Data with Setup
Save for later analysis with the analyzer. The setup is saved as part of the acquisition data file so you can choose when recalling data
whether or not to also recall the associated acquisition and analysis parameters.

Saving Acquisition Data Export in CSV Format
Save for examining results in other programs, such as MATLAB or Excel.

Data settings and picture file formats
You can save different types of data for later recall and analysis. 

Saved File Types

File type File extension Description

Setup files .setup Setup files enable you to save instrument settings for later recall. Using these
files saves setup time and ensures consistent measurements.

Picture .png/.jpg/.bmp Screen capture of analyzer application window. They are useful for documenting
results in test reports.

Results Export .csv Results files contain the trace points and numeric values that were produced by
the selected measurement. The header of a Results file includes key acquisition
and analysis settings to aid in the interpretation of the data. The file is saved
as a plain text file, but the contents are formatted as CSV (comma-separated
values). Results files can be opened from applications such as Microsoft Excel
and MATLAB.

Measurement Settings .txt Measurement settings files contain a list of settings that describe how
the instrument is set up for the selected measurement. The list contains
measurement settings (for example, Span), trace settings (for example, whether
or not a trace is selected) and global settings (for example, Frequency and
Reference Level). The list of settings contained in the file varies depending on
which display is selected.

Table continued…
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File type File extension Description

Selected Trace varies with display Trace files contain the trace results data in binary format. These files are only
readable by the analyzer application. Several of the instrument's measurements
allow you to recall a Trace file for visually comparing a saved trace to a live
trace.

Acquisition Data with
Setup

.tiq These files contain the acquisition data record and complete instrument setup (in
binary format). Use these files to save data for later recall and analysis. When
you save an Acquisition Data file, the current Setup is always saved with the
file. At the time of recall, you will be asked whether you want to restore only the
acquisition data or both data and setup. If the instrument is already set up for a
specific measurement, you will probably want to recall only the acquisition data.
Recalling both data and setup returns the instrument to the same state it was in
at the time you saved the file.

Acquisition Data .csv These files contain IQ sample data before it has been processed by a
measurement. The acquisition data points are saved as IQ pairs. Use this format
to import the acquisition data into Microsoft Excel for further analysis.

Acquisition Data .mat These files contain IQ sample data before it has been processed by a
measurement. The acquisition data points are saved as IQ pairs. Use this format
to import the acquisition data into MATLAB for further analysis.

Range file .csv These files contain a list of settings that describe how the instrument is set up for
the Spurious measurement. The file contains the number of ranges enabled, the
start and stop frequencies for each enabled range, the limits for each enabled
range, the mask type and more.

Results Export File Format
The Results Export format contains trace points and/or scalar results produced by the measurement. The file contains general information
about the measurement settings at the top of the file and the results data in the second part of the file. Groups of settings or results are
headed with [text], as described below.

At the top of the file is the measurement name and the date and time data was acquired.

The first group of settings is [Global Parameters]. These settings include the Measurement Frequency, Acquisition Data, Reference Level
and others.

The second group of settings is [Parameters]. These settings are specific parameters which vary depending on the measurement.

The next group is [Trace Parameters], which may not be present, depending on the measurement. Within this group, there are parameters
specific to a trace. There will be a Trace Parameters group for each trace shown on the display.

The next group is [Results]. These are scalar results for the measurement.

Next is [Traces]. The Traces group consists of one or more [Trace] groups. There is one Trace group for each trace. Each [Trace] group
contains background information about the trace (units, number of points, x scaling, and others depending on the measurement) at the top
of the group, followed by the trace points.

Acquisition Data with Setup File (.tiq) Format
The file consists of two parts - the header that is in XML and the data that is in binary format.

Header. The header consists entirely of the DataFile element. This element is broken down into sub-elements.
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1. DataSetsCollection
2. Setup

DataSetsCollection. The DataSetsCollection contains a DataDescription element, a DataSet element, and a ProductSpecific element.

Binary data. Binary data is a sequence of Int32 values, which are IQ pairs (I,Q,I,Q, ...) in binary Little Endian format.

To convert these values to volts, multiply the individual values by the Scaling value in the DataDescription.

The binary data starts at an offset into the file == the "offset" attribute in the DataFile element. This offset number will always start at the
19th character into the file (starting with 1), and will always be 9 characters long.

Note: You should not casually modify the XML header, because this will change the offset to the start of the binary data.

Acquisition Data Files (.csv)
The acquisition data files have two sections. At the top of the file is the following information:

• SamplingFrequency - The sampling frequency in Hertz.
• NumberSamples - The number of IQ samples in the file.
• DateTime - When the data was acquired.
• Frequency - The center frequency in Hertz.
• AcquisitionBandwidth - The acquisition bandwidth Hz.

Following the AcquisitionBandwidth are the data. The data are IQ pairs, in volts.

Groups of settings or results are headed with [some text].

The first thing in the file is the measurement name and the date/time when the acquisition was taken.

The first group [Parameters] are global parameters. Measurement Bandwidth in this group is the measurement bandwidth used by the
General Signal Viewing measurements (Spectrum, Amplitude vs. Time, etc). It also includes some source settings, like Acq BW, Dither,
Preamp, and RF Attenuation.

The second group [Parameters] are measurement-specific parameters.

Another group which can occur is [Trace Parameters]. Within this group, there will be a set of parameters, one for each trace that is
currently shown.

Another group is [Results]. These are scalar results for the measurement.

Another group is [Traces]. It has [Trace] groups under it, one for each trace. Each [Trace] group has some background information about
the trace (units, number of points, x scaling, etc), and the trace points themselves.

Acquisition Data Files (.mat)
The acquisition data files saved in MATLAB format contain the following MATLAB variables:

• InputCenter - The center frequency in Hertz.
• XDelta - The sample period in seconds.
• Y - A complex array containing IQ pairs.
• InputZoom - The acquisition bandwidth in Hertz.

The MATLAB format used to save acquisition data has the following properties and limitations:

• Files are stored in MATLAB Level 5 format.
• MATLAB Level 5 file size is limited to 2 GB.
• The instrument acquisition memory limit is 1 GB (1.024 Gigabytes). Because of the way acquisition data is processed, 1 GB of

acquisition memory requires 2 GB of memory to store. When header information (instrument settings) is added to the acquisition data,
the resulting file size is >2 GB.
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• If acquisition memory is filled (1 GB), exporting the data to MATLAB format will result in a file that exceeds 2 GB in Matlab level
5 format. A PC with sufficient memory is required to open the file. If memory is not sufficient, Matlab will warn the user. To check
how much acquisition memory is filled, select Setup > Acquire > Sampling Parameters. When the instrument is stopped, or you are
analyzing a recalled data file, you can find the acquisition length under File > Acquisition Data Info.

Printing screen shots
You can print screen shots (screen captures) two ways: use File > Print or save a picture file and print the file using a separate graphics
program. Printing a screen capture is the same as printing with any windows program. For details on the available file formats for saving a
screen capture, refer to Data, Settings, and Picture File Formats. For details on saving a picture to a file, see Saving and Recalling Data,
Settings, and Pictures.

To print a screen shot:

1. Select File > Print.
2. Select File > Print Preview if you wish to review the screen shot before sending it to the printer.
3. Select File > Print to print the file to a printer.
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Reference
Online help
Menu Bar: Help > User Manual

This menu item displays this help. The help is a standard Windows help system. The Online Help menu item is the only method available
to display the help; there are no other links to the help within the software.

About the Tektronix RTSA
This window displays information about the software and hardware versions for the analyzer.

Version
At the top of the window is a line that displays the version of the analyzer application software.

Installed Options
This text box lists the instrument options installed on the analyzer. This window does not list every option installed on the instrument, just
those that can be detected by the software.

Hardware Information
This text box lists information about the instrument hardware versions.

Copy Info
The Copy Info button copies information about the instrument to the Windows clipboard. This information may be useful if you need to
have your instrument serviced.
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Connecting signals

Configure In-Out settings
Menu bar: Setup > Configure In/Out.

The Configure In/Out control panel enables you to configure the analyzer inputs and outputs. The settings in this control panel are shared
by all application windows. 

Settings tab Description

Trigger Specifies the impedance for the Trig 1 (front panel) input. You can select between 50 Ω and 5 kΩ.

Frequency Reference Specifies the source of the Frequency Reference. You can select between an Internal (10 MHz)
source and an external source.

Zero Span Specifies whether the Zero Span Output is on or off. Additional output settings (bandwidth and
voltage) are available.

Other Outputs Specifies whether the 28 VDC and Digital I and Q outputs are on or off. Additional settings are
available for IQ outputs.

Connecting an RF signal
The analyzer has a single RF signal input located on the front panel. The input impedance is 50 Ω. The input frequency range for each
analyzer model is listed in the following table. The maximum measurable continuous input power for all models is 1 W.

Table 45:

Model Input frequency range

RSA5103B 1 Hz to 3 GHz

RSA5106B 1 Hz to 6.2 GHz

RSA5115B 1 Hz to 15 GHz

RSA5126B 1 Hz to 26.5 GHz

About RF Input Protection
The following paragraphs describe how the analyzer behaves to protect the RF input during power-off, power-on, power-on self test
(POST), and attenuator switching:

Reference
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• When switched off (or when power is removed), the RF input is electronically disconnected from the input connector. The analyzer
always has a minimum 10 dB attenuation applied during power-up and power-on-self-test. This is accomplished by always switching
the attenuation control to Auto during these states. The minimum Auto attenuation value is 10 dB and is applied prior to the
pre-amplifier (Option 50/51) in the signal path.

• When switching attenuator values, the action is performed in a 'make before break' sequence, such that the attenuation never switches
to zero during an attenuator switching sequence. For example, consider switching from 20 dB to 15 dB attenuation. This change
requires the instrument to switch from using one 20 dB attenuator to using one 10 dB and one 5 dB attenuator. This attenuator
switching is done such that the 10 dB and 5 dB attenuators are switched in prior to switching out the 20 dB attenuator.

To connect an RF signal:

1. If the source signal is greater than 1 Watt (+30 dBm), connect the source signal to an attenuator. Connect the attenuator output to the
RF Input connector.

CAUTION: To prevent damage to the analyzer, do not connect signals greater than +30 dBm (1 Watt).

CAUTION: To prevent damage to the analyzer, do not turn the equipment under test on or off with a LISN (Line Impedance
Stabilization Network) RF cable connected to the analyzer. The power cycling of the equipment under test causes surge
currents that can damage the sensitive input of the analyzer.

2. Connect the appropriate Planar Crown connector if applicable for your instrument model.
3. Connect the signal to the RF INPUT connector.

The maximum limits for the input signal are as follows:

Table 46:

RSA5100B Series

Characteristic Description

Maximum DC Voltage ± 5 V (RF input)

Maximum Measurable Input Power + 30 dBm (RF input, RF ATT Auto)

50 Watts peak (RF Band, RF ≧ 30 dB (<10 ms pulse width, 1% Duty Cycle repetitive
pulses))

Connecting a signal using a TekConnect probe
You can connect a signal to the analyzer using a TekConnect Probe by using an RTPA2A Real-Time Spectrum Analyzer TekConnect
Probe Adapter. The RTPA2A enables you to use Tektronix P7000 Series active and differential probes to connect to signals. See the
RTPA2A Instruction Manual for instructions on how to connect the probe adapter and a probe to the analyzer.

Installing the RTPA2A Probe Adapter Device Driver
When the RTPA2A probe adapter is connected to the instrument's USB port for the first time, the Windows Add Hardware wizard may
automatically start. If the wizard does start, use the procedure below to install the device driver for the new hardware. (If the wizard does
not start, the probe adapter device driver is already installed.)

To properly install the probe adapter device driver:

1. Select the option for Windows to install from a specific location (then select Next).
2. Only search for the driver in the following location depending on your instrument:
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• C: \Program Files\Tektronix\RSA5100B\RSA\ProbeAdapter
3. If Windows warns about Windows Logo testing, select Continue Anyway.
4. Select Finish after the Found New Hardware wizard completes.

Connecting external trigger signals
External trigger signals are connected to the analyzer using the Trig In connector on the front panel. There is also an additional trigger
input on the rear panel, the Trig 2 In.

To connect a trigger signal to the analyzer, connect the signal to the Trig In connector on the front panel, or the Trig 2 In connector on the
rear panel. 

Table 47: External trigger signal input requirements

Input Level Impedance

Trig In -2.5 V to +2.5 V 50 Ω or 5,000 Ω

Set in Setup > Configure In/Out > Trigger
tab.

Trig 2 ln +5 V (TTL) 10,000 Ω

Enabling External Trigger
To use an external trigger signal, select either Trig In (front) or Trig 2 In (rear) in the Source control on the Trigger control panel's Event
tab.

Digital I and Q outputs
The Digital I and Q outputs are a means for you to obtain the analyzer digital baseband I/Q signals in a real-time data stream. This output
enables you to use the analyzer as a down-converter and then pass the down-converted baseband I/Q signals to external equipment for
either additional processing or storage.

The rear panel I and Q output connectors are LVDS connectors. For full details on the connectors, see the Specifications and Performance
Verification manual. A PDF file on the manual is located on the Documentation CD that shipped with your instrument. The manual can be
downloaded from the Tektronix Web site, www.tektronix.com/manuals. 

Note: The Digital I and Q outputs are disabled when an alignment is running.

Other outputs
The Other Outputs tab is accessed from the Config In/Out control panel (Setup > Configure In/Out > Other Outputs tab). The IQ Output
settings appear only when Option 65 is installed. 
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28V DC power
The 28V DC power provides a voltage source to power an external noise source. The output connector is located on the rear panel and
provides 28 VDC at 140 mA.

IQ Output
The IQ Output transmits the digitized analyzer data for capture and storage by external equipment. The I/Q data is provided in 16-bit, two’s
complement format, along with clock and data-valid signals.

There are three selections available for the IQ Output: Off, On, and Test. When in the “Off” position, the IQ Output is disabled, and all lines
are static. When in the “On” position, the data is output as described in the Specifications and Performance Verification manual.

Use the “Test” position to verify operation when setting up your equipment. When in the “Test (Counting Pattern)” position, the I channel
data will be counting up and the Q channel data will be counting down. The EXT_IQ_CLK and EXT_IQ_DAV signals will operate at a rate
consistent with the instrument SPAN setting.

Note: The IQ outputs are disabled when an alignment is running.

Zero span
The Zero Span tab is accessed from the Config In/Out control panel (Setup > Configure In/Out > Zero Span tab). The tab only appears if
Option 66 is installed.

With Zero Span installed, the instrument provides an analog zero span output at the rear of the instrument.

The output is a voltage that represents the signal at the center frequency. The resolution bandwidth is based on the selected display and
the output is scaled by the vertical settings (offset and scale) of the selected display.

The zero span output is only active with the following displays: 

• DPX spectrum
• DPX Zero-Span
• Spectrum

Note: The analog Zero Span output is disabled when an alignment is running.

Control Description

Zero Span Out Enables or disables the rear panel analog zero span output.

Active or Disabled is displayed to indicate if a signal is being output. The output is disabled if DPX or
Spectrum is not displayed or if the output is swept.

When disabled, a message is also displayed in the status bar at the bottom of the screen.

Table continued…
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Control Description

RBW This control sets the RBW that is applied to the real-time baseband I/Q data.

• Auto: The RBW specified in the active (selected) Spectrum display is applied to the Zero Span data.

• Manual: The user may specify the RBW to be applied. The acceptable range of values are Span/4096 <
RBW < Span/2.

• None: The RBW filter is bypassed, allowing the full I/Q bandwidth to generate the ZSO output (including
the full noise power within the IF). This mode provides the best detail for pulsed signals.

Output Filter This control selects the analog output filter applied to the Zero Span output. These low-pass filters are
designed as anti-alias filters to eliminate the images created by the DAC sampling. Refer to Figure 1 to
understand where these filters are applied in the signal path. They are multiple-pole low-pass filters.

• Auto: Chooses the appropriate output filter (10 MHz or 100 kHz) based on the sample rate.

• 10 MHz: Uses the 10 MHz low pass output filter.

• 100 kHz: Uses the 100 kHz low pass output filter. This filter reduces the noise content of the output, but
also causes a slight distortion of the pulse edge.

Full Scale Voltage • Auto (1V=Ref Level): Sets the voltage scale where 1 V equals the Reference Level input power.

• Manual: The user may specify anywhere from 0.5 V to 1 V as the full-scale representation of a signal at
reference level.

Delay Indicates the processing delay for the Zero Span Output. The value represents the delay from a signal
present at the RF input connector to the corresponding signal present at the Zero Span Output connector.

Mapping measurements
The RSA Map software lets you record measurements on a geo-referenced map or a bitmap map for documentation purposes. If an
external GPS receiver is connected to the analyzer, measurements can be mapped at the GPS coordinates where the measurement
was taken. Using an external GPS receiver, RSA Map can perform repeat measurements using either time or distance to initiate
measurements. RSA Map software can also save results for future reference or analysis.

To map measurements:

• Select Tools > RSA Map. This launches the RSAMap software in a separate window.
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Full documentation on how to use RSA Map is provided in the RSA Map Help. In RSA Map, select Help > User Manual.

Menus

Menu overview
The main menus are:

Menu Description

File Select measurements, open and save files, print documents, and preset.

View Change display size, display the Marker toolbar and Status bar.

Run Start, stop and abort acquisitions, select single or continuous acquisition mode.

Replay Replay measurements; select which record(s) to play, Replay/Stop/Pause, or enable continuous loop.

Markers Define markers and search for signal peaks.

Setup Change settings for acquisition, trigger, analysis, measurements, amplitude, alignments, and
configure in/out settings.

Presets Load and configure presets.

Tools Perform searches, access diagnostics, install upgrades and configure user preferences.

Window Controls the size and layout of displays within the analyzer application.

Help Access the help, display information about the instrument hardware and software.
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File menu
Command Description

Recall The Recall dialog enables you to recall saved data, setups and traces.

Save Saves a file without asking for a file parameters (based on most recent settings).

Save As Displays the Save dialog enabling you to specify the parameters of the save operation.

Save on trigger Displays the Actions tab of the Trigger control panel which allows you to configure the Save on
Trigger function.

Acquisition save options Displays the Save and Export tab of the Options control panel which allows you to specify how much
data is saved in acquisition files.

FastSave Acquisitions Displays the FastSave tab of the Acquire control panel which allows you to configure FastSave
acquisitions.

Acquisition data info Displays the Acquisition Info tab of the Replay control panel. The info on this tab describes such
acquisition parameters as acquisition bandwidth, sampling rate, RF attenuation, and acquisition
length.

Measurement Data Info Displays the characteristics of the most recently analyzed record in the display.

Print Prints the selected display.

Print Preview Displays a preview of the print output.

Exit Closes the analyzer application. Selecting Exit does not shut down the instrument.

Recall
Menu Bar: File > Recall

Front Panel: Recall

Use the Recall command to load previously saved acquisition data, setups or trace data.

To Recall Data or Setups
1. Select File > Recall. This displays the Open dialog box.
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2. Select the file type to be recalled and click Open.

Save - save as
Menu Bar: File > Save / Save As

Use Save / Save As to store acquisition data, setups, and traces. Save is also used to export traces, results and pictures of the display for
use in other programs.

Difference Between Save and Save As
Use Save As to specify what kind of data you want to save and where the data should be saved. Use Save to quickly save the same data
as you saved the last time you executed a Save, without having to specify the data type and location.

For example, suppose you want to save a picture of a spectrum trace each time you adjust a circuit to document how the adjustments
affect the output of the circuit. The first time you want to save a picture of the display, you will need to select Save As. From the Save As
dialog box, you specify the type of data you want to save (Picture of Selected Display) and specify the location of the saved file. As long as
the Save and Export option is set to automatically name saved files, the next time you want to save a picture of the display, you can just
press Save on the front panel and a picture of the selected display will be saved without requiring you to type a file name or the location of
the file to be saved.
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What Data Types Can Be Saved

Data type Description

Acquisition Data Data collected during acquisition that can be recalled for later analysis. Data is saved in a
format readable only by RSA6100/RSA5100/SPECMON Series instruments or oscilloscopes running
SignalVu software. You can save acquisition data as IQ records only, DPX spectra (DPXogram data)
only, or both IQ records and DPX Spectra.

Setup Configuration information detailing instrument settings. Data can be saved in a format readable only
by SignalVu-PC, oscilloscopes running SignalVu software, or RSA6100/RSA5100/SPECMON Series
instruments.

Selected Trace Saves the selected trace for later analysis by the analyzer. Data is saved in a format readable only
by SignalVu-PC, oscilloscopes running SignalVu software, or RSA6100/RSA5100/SPECMON Series
instruments.

Exported Traces and Numeric
Results

Save traces and results in a file format that can be used by other programs.

Pictures of the Display Save screen images in graphic image file formats that can be used in other programs.

Exported Acquisition Data Save acquisition data records in a file format that can be used by other programs. Acquisition data
can be saved in either comma-separated-variable format or MATLAB format.

Data, Settings, and Picture File Formats.

Options for Saving Pictures of the Display

Option Setting Description

Image Format PNG Saves exported screen captures in Portable Network Graphics format.

JPG Saves exported screen captures in Joint Photographic Experts Group (JPEG) format.

BMP Saves exported screen captures in Windows bitmap format.

Measurement data info
The Measurement Data Info command in the File menu displays a listing of acquisition-related information about the last data analyzed by
the selected measurement. The last data can be from the current acquisition or it could be from a recalled data file. 
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Print
Menu Bar: File > Print

Front Panel: Print

Print displays the Windows Print dialog box for printing a screen capture of the display. To save ink when printing, use the Colors tab to set
the color scheme. See Options Settings.

Print preview
Menu Bar: File > Print Preview

Print Preview shows how a print out will appear when it is printed.

View menu
The View menu enables you to control the display of items in the application window.

Command Description

Full Screen Toggles all views between full-screen size and user-selected size.

Replay Toolbar Shows or hides the Replay toolbar.

Marker Toolbar Shows or hides the Marker toolbar. Enables you to define Markers and perform Peak searches.

Status Bar Shows or hides the Status bar.

Full screen
Menu Bar: View > Full Screen

When unchecked, clicking Full Screen resizes the application window to fill the screen. Full Screen mode maximizes the application
window, and turns off the application title bar.
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When checked, clicking Full Screen restores the application window to its previous size. The application title bar is restored.

Status bar
The Status Bar displays information on specific instrument settings. It contains only status information; it does not display any error
information. The Status bar has no controls. It can be hidden.

Elements of the Status Bar

Area within Bar Description

Run Status Displays the running state. For example, some run states are Arm, Ready, Triggered, Analyzing, or
Stopped.

Status message area Displays status messages (for example, ADC Overrange). When there no status messages to report,
displays current acquisition parameters (for example, Acq Length: 22.320 us).

Acquisition mode Displays either Real Time or Swept. Indicates how the next acquisition will be acquired.

Trigger Settings Displays Trigger settings. For example, you will see Free Run, Power, Trig In (front), Frequency Mask
and others.

Frequency Reference Setting Indicates whether the internal or external reference source is selected. Displays Ref: Int or Ref: Ext.

Internal Attenuator setting Displays the setting of the internal attenuator.

Preamp Setting If the optional preamp is installed, this indicates whether the preamp is on or off. If the preamp is on,
displays Preamp: ON, 3 GHz max. as a reminder that the input frequency range is restricted when
using the preamp.

Run Status Indicators

Indicator Description

Acquiring The analyzer is capturing the signal.

Analyzing The analyzer has captured the signal and is processing the signal record.

Arm The trigger circuitry is filling the pretrigger portion of the signal record.

File Data The analyzer is analyzing recalled acquisition records.

Replaying The analyzer is analyzing recalled waveform or acquisition records.

Stopped If Stopped is displayed, Signal acquisition has been halted. This can occur because the Run button
has been pressed or because a trigger event has occurred, signal acquisition has occurred and Run
mode was set to Single.

Triggered If Triggered is displayed, the analyzer has recognized a valid trigger and is filling the posttrigger
portion of the signal record.
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Showing or Hiding the Status Bar
• Select View > Status Bar to toggle the display of the Status bar.

Run menu
The Run menu provides access to commands that control the signal acquisition.

Command Description

Run If acquisition mode is Stopped, selecting Run begins a new measurement/acquisition cycle. If
acquisition mode is Run, pressing Run halts the current measurement/acquisition cycle after it
completes.

Resume Restarts data acquisition, but does not reset accumulated results, such as Average or MaxHold. This
allows you to stop acquisitions temporarily, then continue. If the accumulation is already complete, for
example, 10 acquisitions or 10 averages have already been completed, each subsequent Resume
command will cause one more acquisition to be taken, and its results added to the accumulation.
Resume is not available if instrument settings have been changed.

Abort Immediately halts the current measurement/acquisition cycle.

Single Sequence Selects the single-sequence acquisition mode. This is only a mode selector; it does not initiate an
acquisition.

Continuous Selects the continuous acquisition mode. Selecting Continuous does initiate acquisitions.

Single sequence acquisition mode
Menu Bar: Run > Single

Selecting Single sets the Run mode to Single. In Single mode, as soon as one acquisition sequence completes, acquisition stops.

Note that a single acquisition sequence can require more than one acquisition. For example, in a spectrum view, the trace function might
be set to Average 100 acquisitions. Thus, a complete acquisition sequence would consist of 100 acquisitions to produce 100 intermediate
traces that are averaged together to create the final trace that is displayed. Once the 100 acquisitions have been completed, acquisition
stops.

This is only a mode selector, it does not initiate an acquisition.

Continuous acquisition mode
Menu bar: Run > Continuous

Selecting Continuous places the analyzer in the Continuous acquisition mode. In Continuous mode, the analyzer acquires and displays
acquisitions repeatedly. The Continuous and Single Sequence acquisition modes are mutually exclusive.

Selecting Continuous restarts acquisitions.

Replay menu
The Replay Menu allows you to rerun measurements using the data in acquisition memory or a recalled TIQ file. You can use this to
compute new results for old data after you change settings or measurements.
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Markers menu
The Markers menu provides to settings that define and control the location of markers.

Setting Description

Peak Moves the selected marker to the highest peak on the trace.

Next Peak > Moves the selected marker to next peak depending on the setting chosen.

Marker to Center Frequency Sets center frequency to the frequency of the selected marker.

Define Markers Displays the Define Marker control panel.

Setup menu
The Setup menu provides access to control panels that specify parameters for numerous signal analyzer functions.

Command Description

Displays Displays the Displays control panel.

Settings Displays the Settings control panel for the selected display.

Trigger Displays the Trigger control panel.

Acquire Displays the Acquire control panel.

Analysis Displays the Analysis control panel.

Amplitude Displays the Amplitude control panel.

Configure In/Out Displays the Configure In/Out panel.

Presets menu
The Presets menu provides you access to instrument presets and preset options.

Command Description

Main Resets the instrument to factory defaults. Acquisition data and settings that have not been saved will
be lost.

DPX Recalls the DPX presets.

Standards Recalls the Standards presets.

Application Recalls the Application presets.

User Recalls the User presets.

Table continued…
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Command Description

Preset Options Displays a control panel where you can configure options for Presets.

Tools menu
Provides access to several utilities for controlling instrument functions.

Command Description

Mask Test Enables you to locate and highlight specified signal levels in specified displays.

Alignments Displays the Alignments dialog box.

Diagnostics Displays the Diagnostics dialog box.

Install Upgrades Used to activate upgrades you have purchased.

Options Displays the Options control panel.

Alignments dialog
Menu Bar: Tools > Alignments

The analyzer can adjust itself, optimizing the internal signal path used to acquire the signal you measure. Alignment optimizes the analyzer
to take more accurate measurements based on the ambient temperature. The Alignments dialog enables you to specify when alignments
occur, either automatically or only when manually initiated.

Elements of the Alignments Dialog

Setting Description

Automatically align as needed Specifies that alignments run as ambient conditions require.

Run alignments only when "Align
Now button is pressed.

Specifies that alignments will never run unless manually initiated.

Align Now Use to manually initiate an alignment.

Abort Stops the alignment process.

Table continued…
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Setting Description

Close Closes the Alignments dialog box.

Diagnostics
Menu Bar: Tools > Diagnostics

The Diagnostics menu item displays the Diagnostics Tests window, which enables you to run variety of tests to verify the operation of the
signal analyzer. For detailed information on running diagnostics, refer to the Service Manual. The manual can be downloaded from the
Tektronix Web site, www.tektronix.com/manuals. 

Install upgrades
You can install upgrades on your analyzer as your needs change. To install upgrades, you will need an Option Installation Key. For
information about available options or to make a purchase in North America, call 1-800-833-9200. Worldwide, visit www.tektronix.com to
find contacts in your area.

Full instructions on how to install your upgrade and activate the option with the Option Installation Key are provided with the upgrade kit.

Window menu
Use the Window menu to arrange how windows are displayed. Displays can be set to appear full screen (one display at a time) or with
all (selected) displays visible at once. When all displays are visible at once, you can rearrange the displays by dragging the title bar of a
window (deselect Window > Lock Windows to move displays around). 

Command Description

Close View Closes the selected view.

Cascade Positions windows in a cascade view (not available when Lock Windows is selected).

Tile Horizontally Positions widows in a horizontal orientation (top to bottom).

Table continued…
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Command Description

Tile Vertically Positions widows in a vertical orientation (side by side).

Lock Windows Locks the windows into their current position, preventing them from being moved. If the windows are
locked, the Cascade arrangement is not selectable.

(List of windows) A numbered list of open windows.

Help menu
The Help menu provides access to the help and version information about the analyzer hardware and software.

Command Description

User Manual On-line Displays the help.

User Manual (PDF) Displays a PDF version of the help.

Application Reference (PDF) Displays a PDF version of the analyzer Applications Manual.

Quick Start Manual (PDF) Displays a PDF version of the analyzer Quick Start User Manual.

About Tektronix Real-Time
Analyzers

Displays information about the analyzer model and installed options.

Troubleshooting

Error and information messages
The following list describes some of the common error and information messages that might appear during instrument operation.
Messages that apply specifically to one or more measurements appear in the displays. Messages that pertain globally, such as those
about hardware status, are shown in the Status Bar at the bottom of the analyzer application window. 

Acq BW too small for current setup

The display needs a wider acquisition bandwidth than what the current data record contains. This can be due to any of the following
reasons:

• The sampling parameters are being manually controlled.

In the Acquire control panel > Sampling Parameters tab, set the Adjust control to All Auto to allow the software to pick the sample rate
and record length that it needs.

• A display other than the one you intended has been selected. The selected display has requested a smaller acquisition bandwidth to
achieve a better accuracy or dynamic range for its particular measurement.

Select the display that contains the message. Click Run if the instrument is not already acquiring data.

• Acquisitions are not running and the measurement now requests a wider bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

• The data is from a recalled TIQ file.
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There is no way to increase the acquisition bandwidth for saved IQ data. You must adjust the measurement settings so that less
bandwidth is required.

• The current Frequency setting is different than that of the data record, causing the measurement bandwidth to fall at least partly
outside the bandwidth of the data.

Analysis failure: <description of error>

The instrument is unable to complete a measurement due to difficulty in characterizing the signal. For example, due to either the signal or
settings, the instrument may not be able to recognize a pulse so it can compute the pulse measurements.

• Try changing settings to improve analysis. For example, when Pulse Trace is displayed, try changing the settings on the Settings >
Params.

Analysis failure: Carrier detection failed

The instrument was unable to locate a carrier signal. Try adjusting the Carrier Threshold or Integration BW values, if the measurement has
these controls.

Analysis Length was limited

This message appears if the "Results Length", the time over which the measurement computed its results, is less than the Actual Analysis
Length reported in the Analysis Time control panel tab and the Time Overview display. The Results Length is indicated by the magenta line
below the Time Overview graph. This can occur because the acquisition contained more data samples than a measurement can process
(for example, digital demodulation is limited to 80,000 samples) or the measurement had to use some of the first and last samples for
pre-measurement processes.

Analysis length too small for current setup

Increase the Analysis Length or decrease the RBW (Spectrum, ACPR, MCPR).

Avg Tx not available in Volts units

The Average Transmitted Power measurement is not defined for Volts.

Cache file missing. Unable to create new cache file. Not enough free space (need XXX GB).Remove unnecessary files,
defragment the hard drive using a standard disk management utility, then relaunch application.

The instrument is unable to create a required cache file. To resolve this issue, use a standard disk management utility to defragment the
hard disk. If this error persists, backup your data (including any setup files you have saved), any applications and associated files you have
installed and perform an OS restore on the hard disk. After restoring the OS, reinstall the analyzer product software.

Can't get acquisition data record

No acquisition record currently exists in memory (run an acquisition or recall a file), or an error has occurred. Repeat the acquisition.

Can't replay data from swept acq

The measurement could not produce results because it is a real-time only measurement but was asked to reanalyze (Replay) an
acquisition taken in swept mode.

Can't replay. Live data needed for swept settings

The measurement could not produce results because it was asked to reanalyze (Replay) the acquisition but it is in Swept acquisition
mode. Swept-mode measurements cannot analyze recalled data.

CISPR accuracy limited by acq memory. Adjust RBW or freq range

The CISPR function was applied, but the available data did not represent a long enough time to satisfy CISPR requirements. Increasing
RBW reduces the amount of time needed for analysis. Reducing frequency range (for example, by reducing Span), decreases sample rate,
allowing the available memory to cover a longer time period.

Data acquired during hardware failure

If this data is from a saved file, the error cannot be cleared.
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Data acquired during RF ADC overrange

If this data is from a saved file, this error cannot be cleared.

Data acquired during RF digital gain overflow

This data was acquired when the input signal contained peaks greater than 6 dB above the Reference Level setting.

See the definition for "RF digital gain overflow".

If the data is from a file, this error cannot be cleared.

Data acquired during warm-up

This data was acquired while the instrument was warming up. The warm-up period is 20 minutes. Until this warm-up period is completed,
the instrument is considered uncalibrated.

Data from unaligned instrument

The acquisition data was captured when the instrument was not aligned. This message refers to the acquisition data currently being
analyzed, but not necessarily to the current status of the instrument. Measurements made on this data might not be accurate.

Data from uncalibrated instrument

The acquisition data was captured when the instrument was not calibrated. This message refers to the acquisition data currently being
analyzed, but not necessarily to the current status of the instrument. See the definition for "Not calibrated".

If this data is from a file, the error cannot be cleared.

Disabled: data is from swept acquisition

The display needs to run in real-time mode. The display associated with this message cannot run now because it is not the selected
display, and the selected display is performing multiple acquisitions (it is in swept mode).

• Change the settings of the selected display so it is performing real-time acquisitions.
• Select the associated display to make it the selected display. When it is selected, it will force the acquisition parameters to change to

meet its own needs.

Disabled: Freq Mask Trigger in use

The DPX display cannot run while the instrument is set to use Frequency Mask Trigger.

• To run the DPX display, you must turn off Frequency Mask Trigger.

DPX disabled: RefLev too low for Volts/Watts units

The Reference Level value is set too low. It is possible to set a RefLev value so low that DPX can't run if volts or watts are the selected
amplitude units. Reset the Reference Level to a higher value.

Frequency exceeds preamp range

This is a warning that signals below the minimum preamp operating frequency are likely to be severely attenuated (this is 100 kHz for
option 51, 1 MHz for option 50).

Needs swept acq or larger AcqBW - Acquire data while display is selected

The display is not running because it needs to perform multiple acquisitions (it must be in swept mode) but it is not the selected display.
Only the selected display can perform multiple acquisitions.

• Select the display showing this message to give it control of acquisitions parameters.

Sometimes, only one display can work and the others will be blank and show errors. This happens when different displays have conflicting
demands on the acquisition data record.

Dither: manual control

This is a reminder that the Dither control has been set to manual, which might affect the quality of measurement results.
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Export failure: file not saved

An error occurred while exporting Results. The file was not created.

• Export the results again.

Export failure: unable to open results file for export. File not saved.

The Export Results file could not be opened for writing, so the export of results was not completed.

• Verify that there is sufficient free space on hard disk.

External Frequency Reference signal not valid.

The instrument is no longer locked to the external reference signal because it can no longer detect a signal with proper amplitude and
frequency.

• Verify that the external reference signal is still connected to the instrument.

Hardware failure detected by Diagnostics

A hardware failure was detected while running Diagnostics. To see a description of the event initiated by the failure, display the Windows
Event Viewer. There is a shortcut to the Windows Event Viewer on the Windows desktop.

Hardware failure - see Windows Event Viewer

A hardware failure has occurred. To see a description of the event initiated by the failure, display the Windows Event Viewer. There is an
shortcut to the Windows Event Viewer on the Windows desktop.

Insufficient data for CISPR. Acquire while display is selected

This message appears when a measurement is not the selected measurement and CISPR filters are selected. Set the measurement to be
the selected measurement and reacquire the signal.

IQ Processing Error: 8012

This message occurs in GP Digital Modulation displays. The most likely cause for this message is that there are not enough symbols to
analyze. This can happen if:

• The Analysis Length is set too short. Increase the Analysis Length on the Analysis Time tab.
• The Analysis Offset has pushed the Analysis Time so far out that the actual Analysis Length is too short, even though the

user-requested Analysis Length would have been long enough without the excessive offset. Decrease the Analysis Offset on the
Analysis Time tab.

• The input signal is bursted, and the burst does not contain enough symbols.

Locking to ext freq ref signal

This a status message displayed while the instrument is attempting to lock to an external reference signal. The message disappears when
the instrument locks to the reference signal.

Needs swept acq or larger Acq BW - Acquire data while display is selected

The display has one of two problems: It is not the selected display, which prevents it from controlling the hardware acquisition parameters,
and setting the acquisition mode to Swept; or its settings require a wider data bandwidth.

• Select the display that you are interested in and it will change the acquisition to meet its own needs.
• Increase the acquisition bandwidth manually or by changing the selected display's settings to cause the wider bandwidth.

No Math trace: unmatched trace lengths

A math trace could not produced because the traces selected to generate the math trace do not have the same number of points. This can
easily happen if both traces are recalled, but were saved under different “Points” settings. This can also occur if one of the selected traces
is a live trace and the other trace is a recalled trace.
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• In a Spectrum display, as long as one trace is live, you can change the “Points” setting (Setup > Settings > Freq & Span tab) to match
the recalled trace.

• If you are using two recalled traces to generate the Math trace. You must recreate at least one of the traces.

Not aligned

The instrument needs to be aligned. When the instrument is not aligned, measurements might not be accurate.

• Select Tools > Alignments > Align Now to alignment the instrument.

No burst detected

The Burst Detection Mode is On, but no burst was detected in the signal.

• Check that the Threshold setting is properly set.

Not calibrated

The instrument requires calibration. Calibration can be performed only at a Tektronix Service center. Contact Tektronix to schedule a
calibration.

Not enough samples for current setup

The measurement was not able to run because the combination of analysis length, offset, and measurement bandwidth relative to
acquisition bandwidth, were such that not enough samples were available for the measurement to analyze. This can occur when two or
more displays are shown and one display requires a wide acquisition bandwidth and another display requires a much narrower bandwidth.
The display requiring the much narrower bandwidth must decimate and filter the acquisition record which can result in too few samples left
for the measurement.

• Increase the Analysis Length to provide more samples.
• Close any displays you don't currently need.

Not enough samples – try increasing MeasBW

The measurement was not able to run because there are not enough samples available for the measurement to analyze. The Settling
Time measurement requires at least 256 samples. This can occur when two or more displays are shown and one display requires a wide
acquisition bandwidth and another display requires a much narrower bandwidth. The display requiring the much narrower bandwidth must
decimate and filter the acquisition record which can result in too few samples left for the measurement.

• Increase the Analysis Length to provide more samples.
• Close any displays you don't currently need.

No FFT (not all pulses have results)

If a pulse cannot be measured (because its shape is too indistinct or it does not meet the parameters that define a pulse), its results will be
“- -" for every measurement on that pulse. The instrument cannot compute an FFT.

No pulses found

The instrument was unable to find any complete pulses in the signal.

• Make sure the analysis length includes at least one complete pulse cycle, from before one rising edge until after the next rising edge.

Pulse Detection Error

The instrument was unable to detect a pulse.

• The pulse Measurement Filter needs to be smaller. Try reducing the bandwidth and/or selecting the Gaussian filter.
• Detection threshold is not set to the proper level for the signal. Adjust the Power threshold to detect pulses.
• The pulse interval is too long for the current settings. Try decreasing the filter bandwidth, as this may reduce the number of data points

to a manageable quantity.

RBW conflict. Increase Span or Analysis Length
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The measurement is not running because the actual RBW used by the measurement is too large for the current acquisition span. Typically,
the analysis length is too short as well.

• Either increase the span or increase the Analysis Length.

RBW decreased

The current span or acquisition bandwidth is too small to allow a wider RBW filter.

• Increase the span or acquisition bandwidth if the decreased RBW is not acceptable.

RBW increased

The current Spectrum Length (or Analysis Length if Spectrum Length is not Independent) is too small to allow the requested RBW.

• Increase the Spectrum Length (or Analysis Length) if the increased RBW is not acceptable.

RBW limited by AcqBW to: XX Hz

The requested RBW is too close to the acquisition BW. Increase the frequency range of the measurement (for example, Span).

RBW too small/large for current Acq BW

If the RBW is set manually, it is possible for the acquisition bandwidth to be incompatible with the RBW setting.

• Change the RBW setting.
• Adjust the Acq BW setting, either directly (Setup > Acquire > Sampling Params: select on of the manual modes) or by adjusting the

measurement bandwidth of the selected display (Setup > Acquire > Sampling Params: All Auto).

Recall error: Setup not completely restored

An error occurred while recalling a Setup file. Thus, the current setup may be a combination of settings from the Setup file and the previous
Setup.

• Recall the setup again.

Recall failure: problem with file or file contents

An error occurred while recalling a Setup, Trace or Data file. This can occur because of a problem opening the file (operating system error)
or because of a problem with the contents of the file.

• Recall the file again.

Restoring acquisition data

This is a status message displayed while data is being restored from a file.

RF ADC overrange

This input signal power is outside the range of the analog-to-digital converter circuitry.

• Decrease the input signal power or increase the internal attenuation setting.
• Increase the Reference Level setting.

RF Attenuator: manual control

This message is just a reminder that the internal attenuator has been set to manual mode.

RF digital gain overflow

The input signal contains peaks greater than 6 dB above the Reference Level setting.

• Increase Reference Level
• Decrease input signal power

Save failure: file not saved

An error occurred while saving a Setup or Data file.
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• Save the file again.

Saving acquisition data

This is a status message displayed while data is being saved to a file.

Selected VBW does not use full Spectrum Length

This message can occur when the Spectrum Length is greater than required for the VBW filter. If you look at the Time Overview display,
the Magenta line for Results Length indicates the part of the Spectrum Length that was actually used. The measurement results are
correct, but don't include some of the data in the selected Spectrum Length. To clear this message, you can set the Spectrum Length to
Auto.

Setup error: <description of error>

When this message appears, it includes text that explains the problem. For example, the ACPR display might show: “Setup error: channels
can’t overlap”. Setup errors are the result of conflicts in instrument settings. These types of errors occur when a user makes manual
changes to settings. In the example above, the channel settings in the Channel Power and ACPR display have been set so that the
channels overlap in frequency.

• Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Integration BW exceeds Measurement BW

When this message appears, it includes text that explains the problem. Setup errors are the result of conflicts in instrument settings. These
types of errors occur when a user makes manual changes to settings.

• Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Measurement time for Freq & Phase results

The Measurement time for Freq & Phase results specifies how far across the pulse top the instrument should wait before measuring
the Phase Difference and Frequency Difference for each pulse. If this value is set too large for any of the pulses in the signal, the
measurement point ends up on the falling edge or during the pulse off time.

• Decrease the Measurement time for Freq & Phase results setting (Settings > Define tab).

Swept: RF Trig invalid for most signals

This is an status message that appears when the instrument is in swept acquisition mode and Power Trigger mode at the same
time. When the acquisition is swept, it captures the requested bandwidth using multiple acquisitions, each for a different portion of the
bandwidth. The trigger system evaluates each of these separate acquisitions for trigger events, so unless a valid event exists in each of
these smaller frequency ranges, the acquisition will not complete.

Unexpected software error. Please cycle power and try again. If the problem persists, contact your Tektronix Service Center.

An unrecoverable error has occurred, and the instrument application software will shut down.

• Switch the instrument off and restart it or relaunch the analyzer application.

Unable to lock to External Frequency Reference.

The instrument is no longer locked to the external reference signal.

• Verify that the external reference signal is still a valid signal.
• Select External on the Frequency Reference tab in the Config In/Out control panel.

VBW not applied - Acq BW too small

Increase VBW or measurement bandwidth. Make sure Sampling Parameters are set to Auto.

VBW not applied - Spectrum Length too short

This message occurs when the requested VBW can't be produced because the Spectrum Length is too short.
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To clear this problem, set the Spectrum Length to Auto or manually increase the Spectrum Length (see Setup > Analysis > Spectrum
Time tab). If Spectrum Length is coupled to Analysis Length, set Analysis Length to Auto or manually increase it (see Setup > Analysis >
Analysis Time tab).

Displaying the windows event viewer
When the analyzer generates an error message, information about the error is logged to the Windows Event Viewer.

To display the Windows Event Viewer: 

1. Select Start > Control Panel.
2. Select Administrative Tools. (If your instrument displays control panels in Category View, select System and Security, and then select

Administrative Tools.)
3. Double-click Event Viewer.
4. From the Event Viewer window, select Windows Logs, then select Application. This displays a list of all errors that have been

reported to the operating system from applications.

Errors reported to the Event Viewer from the analyzer application appear under Source as TekRSA.
5. Double-click the last error reported for TekRSA to see details on the most recently reported error. Please note that many items reported

as “errors” are simply informational and do not mean that your instrument is impaired. Contact the Tektronix Customer Support Center
or Service Center if you are concerned about an error shown in the Event Viewer. Do not send an instrument out for repair based solely
on these event reports.
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Dealing with sluggish instrument operation
Over time you might notice that acquisitions seem to be occurring sluggishly. This can occur if the disk is too full or if someone has
accidently deleted the instrument cache file. While the instrument automatically recreates a missing 4 GB cache file, if the disk is too full
when the replacement cache file is created, the cache file can be fragmented and result in sluggish performance.

If your instrument appears to be performing acquisitions slowly, do the following:

• Delete unnecessary files to create free space. After deleting unnecessary files, run a commercial disk defragmentation program.
• If removing unnecessary files and defragging the hard drive does not improve instrument performance, reinstall the operating system

and application software. To do this, back up all your data and files, and then reinstall the instrument operating system. After
reinstalling the operating system, reinstall the application software.

On-Standby switch
Use this button to power the instrument on or to shut down (set the instrument to standby).

Before shutting down, you should first exit the instrument application and any other active Windows applications to avoid error messages
on shutdown or the next power up.

How to find out if software upgrades are available
Software upgrades might be available can be downloaded from the Tektronix Web site. To see if a software upgrade is available for your
product, use your browser to go to www.tektronix.com/software. Search by the product model number.

To add additional software options or features, you will need an option key from Tektronix. In some instances, you may need to upgrade
the product software before adding the new option key. Follow the installation instructions provided with your software option.

Settings
Menu Bar: Setup > Settings

Front Panel / Application Toolbar: Settings
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The Settings menu item enables access to control panels that allow you to change settings for the selected display. The control panel that
appears when you select Settings depends on the selected display. The Settings control panel for the Spectrum display is shown in the
following figure.

The control panel for the CCDF display is shown in the following figure.

Settings Control Panels
Acquire

AM Settings

Amplitude Settings

Amplitude vs Time Settings

Analysis Settings

Audio Spectrum Settings

Audio Summary Settings

CCDF Settings

Channel Power and ACPR Settings

OFDM Channel Response Settings (OFDM) (WLAN)

Configure In/Out Settings

Constellation Settings

DPX Spectrum Settings

EVM vs Time Settings

Eye Diagram Settings

FM Settings

Frequency Deviation vs Time Settings

Frequency vs Time Settings

Magnitude Error Settings

MCPR Settings

Occupied Bandwidth Settings

OFDM Constellation Settings
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OFDM EVM Settings

OFDM Magnitude Error Settings

OFDM Phase Error Settings

OFDM Power Settings

OFDM Summary Settings

OFDM Symbol Table Settings

Phase Error vs Time Settings

Phase Noise Settings

Phase vs Time Settings

PM Settings

Pulse Statistics Settings

Pulse Table Settings

Pulse Trace Settings

RF I Q vs Time Settings

Mask Test Limits Settings

Spectral Emissions Mask Settings

Settling Time Settings

Signal Quality Settings

Spectrogram Settings

Spectrum Settings

Spurious Settings

Symbol Table Settings

Time Overview Settings

Trellis Diagram Settings

Remote login
You can access the instrument across a network using Windows Remote Desktop Connection.

To access the instrument using Windows Remote Desktop Connection for the first time:

1. On the PC from which you want to remotely access the instrument, select Start > All Programs > Accessories > Remote Desktop
Connection.

2. In the Remote Desktop Connection window, click the Options button to display all the available settings if they are not already visible.
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3. Enter the name of the instrument in the Computer field. (To find out the name of the instrument, go to the Windows desktop, right-click
the Computer icon, and select Properties. The computer name will appear on the control panel window.)

4. Enter OEM in the User name field.
5. Click Connect to initiate the connection.
6. Enter spearfish as the password when prompted.
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Glossary
Accuracy
The closeness of the indicated value to the true value.

ACLR
Adjacent Channel Leakage power Ratio is the ratio of the RRC (Root Raised Cosine) filtered mean power centered on the assigned
channel frequency to the RRC filtered mean power centered on an adjacent frequency (defined in 3GPP).

ACPR Measurement
Adjacent Channel Power Ratio (ACPR) is the ratio of the mean power centered on the assigned channel frequency to the mean power
centered on an adjacent channel frequency. In the 3GPP specification, it is called ACLR (Adjacent Channel Level Ratio) and both the main
channel and adjacent channels are required to be filtered with RRC (Root Raised Cosine) filters.

Acquisition
A series of time-contiguous frames. This is also called a Block.

Analysis Length
The length of time in the Analysis Time.

Analysis Time
The portion of the acquisition record over which one or more measurements are calculated.

ASK
Acronym for Amplitude Shift Keying. The process, or result of a process, in which the amplitude of the carrier is varied in accordance with
the state of a digital input signal.

Block
An integer number of time-contiguous frames. See also: Acquisition.

Calibrator
A signal generator producing a specified output used for calibration purposes.

Carrier
The RF signal upon which modulation resides.

Carrier Frequency
The frequency of the CW component of the carrier signal.
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Carrier Signal
The electrical signal, typically a sine wave, upon which modulation is impressed.

Carrier-to-Noise Ratio (C/N)
The ratio of carrier signal power to average noise power in a given bandwidth surrounding the carrier; usually expressed in decibels.

CCDF - Complimentary Cumulative Distribution Function
The Complementary Cumulative Distribution Function (CCDF) represents the probability that the peak power above average power of a
measured signal exceeds a threshold.

CCDF is a plot of the percent of time that a signal's power value exceeds it average value versus the amount by which it exceeds the
average. The CCDF plot has a log of probability on the Y-axis (100% at the top) and dB above average amplitude on the X-axis (0 at the
left).

CDMA
Acronym for Code Division Multiple Access.

Center Frequency
The frequency corresponding to the center of a frequency span of the analyzer display.

Check Mark Indicator
The check mark indicator in the upper-left corner of the display indicates the display for which the acquisition hardware is optimized. When
you have more than one display open, the display with the check mark indicator has control over the acquisition hardware. To give a
display priority over any others, click its title bar.

When Best for multiple windows is selected in the Amplitude control panel's RF & IF Optimization control, none of the measurement
displays shows a checkmark, as there is not a single optimized measurement.

CISPR
International special committee on radio interference. (Comité international spécial des perturbations radioélectriques)

CW
Acronym for Continuous Wave.

CW Signal
Continuous wave signal - a sine wave.

DANL
Acronym for Displayed Average Noise Level. See Sensitivity on page 740.
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dBfs
A unit to express power level in decibels referenced to full scale. Depending on the context, this is either the full scale of the display screen
or the full scale of the analog-to-digital converter (ADC).

dBm
A unit of expressed power level in decibels referenced to 1 milliwatt.

dBmV
A unit to express voltage levels in decibels referenced to 1 millivolt.

dBuV
A unit to express voltage levels in decibels referenced to 1 microvolt.

Decibel
Ten times the logarithm of the ratio of one electrical power to another.

Detection
The process by which a long waveform is decimated (reduced) down to the desired number of trace points, by dividing the waveform into
intervals and choosing a single value to represent each interval in the trace.

Display Reference Level
A designated vertical position representing a specified input level. The level may be expressed in dBm, volts, or any other units.

Distortion
Degradation of a signal, often a result of nonlinear operations, resulting in unwanted signal components. Harmonic and intermodulation
distortion are common types.

Dynamic Range
The maximum ratio of the levels of two signals simultaneously present at the input which can be measured to a specified accuracy.

EVM
Acronym for Error Vector Magnitude.

Export
Save data to a file in a format other than application-native.

FastFrame
FastFrame segments the acquisition record into a series of frames and then captures acquisitions as single frames. You can then view and
measure each frame individually.
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FFT
Fast Fourier Transform - a mathematical process to calculate the frequency spectrum of a discrete number of time domain sample points.

Filter
A circuit that separates electrical signals or signal components based on their frequencies.

FM
Acronym for Frequency Modulation.

Frame
A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce a spectrum view of a specified
span and RBW.

Frequency
A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce a spectrum view of a specified
span and RBW.

Frequency Band
The continuous range of frequencies extending between two limiting frequencies, expressed in hertz.

Frequency Domain View
The representation of the power of the spectral components of a signal as a function frequency; the spectrum of the signal.

Frequency Drift
Gradual shift or change in displayed frequency over the specified time due to internal changes in the analyzer, where other conditions
remain constant. Expressed in hertz per second.

Frequency Range
The range of frequencies over which the performance of the instrument is specified.

Frequency Span
A continuous range of frequencies extending between two frequency limits.

Frequency Settling Time
The time measured from a reference point to when the signal of interest settles to within user-defined tolerance.

GPIB
Acronym for General Purpose Interface Bus, the common name for the communications interface system defined in IEEE Std. 488.

Glossary

RSA5100B Series Real-Time Signal Analyzers Help 736



Graticule
The calibrated grid overlaying the display screen of analyzers, oscilloscopes, and other test instruments.

Grayed Out
An on-screen control is “Grayed Out” if it is not adjustable.

I/Q
Acronym for In-phase / Quadrature.

IF
Acronym for Intermediate Frequency.

Import
Bring data into the application from a file of some format other than application-native.

Impulse Response
The Impulse Response trace display shows normalized power on the vertical axis and time on the horizontal axis.

Input Impedance
The impedance at the desired input terminal. Usually expressed in terms of VSWR, return loss, or other related terms for low impedance
devices and resistance-capacitance parameters for high impedance devices.

LISN
Acronym for Line Impedance Stabilization Network.

Local Oscillator (LO)
An oscillator which produces the internal signal that is mixed with an incoming signal to produce the IF signal.

Marker
A visually identifiable point on a waveform trace, used to extract a readout of domain and range values represented by that point.

Max Hold
Digitally stored display mode which, at each frequency address, compares the incoming signal level to the stored level and retains the
greater level. In this mode, the display indicates the peak level at each frequency after several successive acquisitions.

MCPR (Multiple Carrier Power Ratio)
The ratio of the signal power in the reference channel or group of channel to the power in adjacent channels.
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Min Hold
Digitally stored display mode which, at each frequency address, compares the incoming signal level to the stored level and retains the
lower level. In this mode, the display indicates the minimum level at each frequency after several successive sweeps.

Modulate
To regulate or vary a characteristic of a signal, typically in order to transmit information.

Modulating Signal
The signal which modulates a carrier. The signal which varies or regulates some characteristic of another signal.

Modulation
The process of varying some characteristic of a signal with a second signal.

Noise
Unwanted random disturbances superimposed on a signal which tend to obscure it.

Noise Bandwidth (NBW)
The exact bandwidth of a filter that is used to calculate the absolute power in dBm/Hz.

Noise Floor
The noise intrinsic to a system that represents the minimum limit at which input signals can be observed; ultimately limited by thermal
noise (kTB). The analyzer noise floor appears as a “grassy” baseline in the display, even when no signal is present.

Open (Recall)
Bring data into the application from a file of application-native format.

OQPSK
Acronym for Offset QPSK (Quadrature Phase Shift Keying).

Phase Settling Time
The time measured from a reference point to when the signal of interest settles to within user-defined tolerance.

PM
Acronym for Phase Modulation.

Primary Marker
The marker displayed in the Single Marker mode whose frequency and/or position is changed when tuning with the general purpose knob.
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PSK
Acronym for Phase Shift Keying. The process, or result of a process, in which the carrier phase is varied discretely in accordance with a
digital code.

QAM
Acronym for Quadrature Amplitude Modulation. The process, or result of a process, in which the amplitude and phase of the carrier are
varied concurrently by synthesizing two orthogonal ASK waves (see ASK).

Real-Time Analysis
Measurement technique based on triggering on an RF signal, seamlessly capturing it into memory, and analyzing it in the frequency, time,
and modulation domains.

Real-Time Bandwidth
The frequency span over which real-time seamless capture can be performed, which is a function of the digitizer and the IF bandwidth of a
Real-Time Signal Analyzer.

Real-Time Seamless Capture
The ability to acquire and store an uninterrupted series of time domain samples that represent the behavior of an RF signal over a long
period of time.

Reference Level
The signal level represented by the uppermost graticule line of the analyzer display.

Residual FM (Incidental FM)
Short term displayed frequency instability or jitter due to instability in the analyzer local oscillators. Given in terms of peak-to-peak
frequency deviation and expressed in hertz or percent of the displayed frequency.

Residual Response
A spurious response in the absence of an input signal. (Noise and zero pip are excluded.)

RBW
The RBW determines how well the analyzer can resolve or separate two or more closely spaced signal components.

Ripple
The Ripple measurement result is displayed in either Watts or Volts. The amplitude units selected on the Setup > Analysis > Units tab
determine whether the measurement is presented in Watts or Volts. Volts are shown for linear units (for example, volts or amps); Watts are
shown for non-linear units (for example, watts or dBm).

The Ripple measurement, in Watts, is calculated as follows:

%RippleWatts =10 0× RatioPos+RatioNeg

Where:
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RatioNeg= DelNeg RefNeg +1 2 -1

RatioPos= DelPos RefPos +1 2 -1

• DelPos = Delta Positive in Volts
• RefPos = Reference Positive in Volts
• DelNeg = Delta Negative in Volts (this is a positive value)
• RefNeg = Reference Negative in Volts

The Ripple measurement, in Volts, is calculated as follows:

%RippleVolts =100× RatioPosV+RatioNegV

Where:

• RatioPosV = DelPos/RefPos
• RatioNegV = DelNeg/RefNeg

Secondary Marker
The “second” marker displayed only in the Delta Marker mode.

Sensitivity
Measure of a analyzer’s ability to display minimum level signals, usually expressed as displayed average noise level (DANL on page 734).

Shape Factor (Skirt Selectivity)
The ratio of the frequency separation of the two (60 dB/3 dB) down points on the response curve to the static resolution bandwidth.

Signal
As used in this help, the signal refers to the input signal before it is processed. The signal is an input.

Signal Strength
Signal Strength locates the direction of a signal using a directional antenna and an audio tone and a visual display.

Span
Span is the range of frequencies displayed in a spectrum window. Span, start frequency and stop frequency are related by the following
equation: Span = (stop frequency) - (start frequency). The settings for center, start and stop frequencies are related to the setting for span;
when one parameter is changed, the others are changed automatically.

Span Per Division (Span/Div)
Frequency difference represented by each major horizontal division of the graticule.

Spectrogram
Frequency vs. time vs. amplitude display where the frequency is represented on the x-axis and time on the y-axis. The power level is
indicated by variations in color.
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Spectrum
The frequency domain representation of a signal showing the power distribution of its spectral component versus frequency.

Spectrum Analysis
The technique or process of determining the frequency content of an RF signal.

Spectrum Analyzer
A device for determining the frequency components of a signal.

Spectrum Time
Analysis Time for spectrum analysis views. Spectrum time can be the same as Analysis Time, but it can be different.

Spur/Spot
A spur is a signal peak that exceeds a user-definable threshold (See Spurious > Settings > Ranges) and excursion setting. A spur that
also exceeds a limit (either Absolute or Relative) specified on the Settings > Limits tab is considered a violation. This is called a spot in the
EMC-EMI display.
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carrier-to-noise ratio (C/N) 734
CCDF 51
CCDF - Complimentary Cumulative Distribution Function 734
CCDF display 180
CDMA 734
center frequency 734
Center Frequency

Freq & BW tab 88
Change start and stop freq

EMC Range &amp; Limits table 391
Channel direction 685
Channel Power 51
Channel Power and ACPR (Adjacent Channel Power Ratio) display
149
Channel Power and ACPR Settings control panel 151
Channel Power measurement 151
Channel Response

OFDM 51
WLAN 52

Channels
how to enable 685
in signal database 684

Channels tab
Channel Power &amp; ACPR display 152
Signal Strength display 157

Channels tab (MCPR) 165
check mark indicator 30, 734
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CISPR 734
CISPR Filter shape

Spectrum display BW tab 124
Classic color scheme 47
Classify a signal 697
Color (DPXogram)

DPXogram display 93
Combined impact gains/losses 384
Compare traces

EMC troubleshooting 368
Configure

accessories 347
Configure In/Out control panel 706
configuring Presets 40
connecting signals 706
connecting trigger signals 708
Constellation

OFDM 51
WLAN 52

Constellation display
displaying a second trace 618

Constellation display settings 583
Continuous Acquisition Mode 717
Convergence

Equalizer tab 610
Create a region (Signal Classification) 687
creating a mask 668
creating presets 44
CW 734
CW signal 734

D
DANL 734
Data file formats 701
Data length

File Contents window 700
Data properties

File menu 714
Data records

File Contents window 700
Data types

File Contents window 700
Database

how to select channels 684
how to set up signal types 683
how to set up standards 682
of signal standards 682

dBfs 735
dBm 735
dBmV 735
dBuV 735
De-emphasis

Audio Filters tab 575
decibel 735
Declare a signal 697

default settings, restore 36
Define a region (Signal Classification) 687
Define Markers 631
Define Peaks tab 632
Define tab

Pulsed RF displays 311
Settling Time displays 200

Delay
Triggering 680

Delta Markers 631
Demod I&Q vs Time display settings 585
Density tab 95
detect

AM display 135
FM display 140
General Signal Viewing displays 122
Time Overview 102

Detect
PM display 146

detection
AM display 135
FM display 140
General Signal Viewing displays 122
Time Overview 102

Detection
DPX display 90
PM display 146

detector
AM display 135
FM display 140
General Signal Viewing displays 122
Time Overview 102

Detector
PM display 146
Ranges and Limits table 178

Deviation 54
Diagnostics 720
Diff

Audio Summary display 572
Digital I and Q outputs 708
Digital Phosphor Spectrum 80
Disabled - FastSave is selected 664
Display

EMC-EMI 371
Pulse Statistics 305

display reference level 735
Displays

arranging 49
BT CF Offset and Drift 539
BT Constellation 534
BT Eye Diagram 536
BT Symbol Table 545
Cumulative Histogram 294
Cumulative Statistics Table 297
EMC Analysis 340, 363
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Displays (continued)
interactions between 49
LTE ACLR 450
LTE Channel Spectrum 453
LTE Constellation 455, 457
OFDM Channel Response 250
OFDM Constellation 252
OFDM EVM 254
OFDM Mag Error 257
OFDM Phase Error 258, 259
OFDM Power 259
OFDM Spectral Flatness 255
OFDM Summary 261
OFDM Symbol Table 262
P25 Constellation 415
P25 Eye Diagram 417
P25 Power 419
P25 Symbol Table 424
selecting 49
SEM (Spectrum Emission Mask) 205
WLAN Channel Response 222
WLAN Constellation 224
WLAN EVM 225
WLAN Mag Error 227
WLAN Phase Error 229, 230
WLAN Power 231
WLAN Spectral Flatness 233
WLAN Summary 235

distortion 735
Dither Control 661
documentation 19, 20
Done

Ranges and Limits table 179
Done saving - restart with Stop, then Run 664
Downlink 685
DPX Density 95
DPX Density Trigger 667, 670
DPX display

DPXogram 80
Frequency 80
Phase 80
Spectrum 80
Zero Span 80

DPX Spectra
Replay menu 649

DPX Spectra/Acq Data 648
DPX Spectrum settings 86
DPXogram

DPX display 80
Droop 59, 293
Droop dB 59, 293
Duty Factor (%) measurement 59, 292
Duty Factor (Ratio) measurement 59, 292
Dwell Time 120
dynamic range 735

E
Elements of the display 30
EMC

accessories setup 378
Analysis option 339
key features 339
pre-compliance testing 339
standards 339
troubleshooting 340

EMC Analysis
displays 340, 363
troubleshooting tools 363

EMC Analysis tool
how to open 340

EMC reports
generating 360

EMCVu
how to open 340

Enable EQ Export
Equalizer tab 610

Enable Equalization
Equalizer tab 610

error message
Windows Event Viewer 728

Error messages 721
Event tab (Triggering) 670
Event Viewer 728
EVM

OFDM 51
WLAN 52

EVM tab
WLAN Analysis displays 248

EVM vs. Time display 586
Excrsn (dB)

Ranges and Limits table 179
Expand

Ranges and Limits Tab 177
export 735
Ext Gain/Loss Table tab 287
External Gain value 655
External Probe Correction tab 658
external trigger

enabling 708
external trigger signals

connecting 708
Eye Diagram display settings 589

F
Fall Time 58, 292
Fast Save 662
FastFrame 661, 735
FastSave

configuring 663
overview 662
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FastSave (continued)
starting 663
status messages 664

FastSave acquisition data
FastSave tab 664

FastSave tab 664
FFT 736
File Contents window 700
File formats 701
filter 736
Filter Shape

Ranges and Limits table 178
Spectrum display BW tab 124

Find tab
GP Digital Modulation displays 614

Flatness
OFDM 51
WLAN 52

FlatTop (CW ampl) Filter Shape
Spectrum display BW tab 124

FM 736
FM display 137
FM measurements 55
FMT (Frequency Mask Trigger) 665, 667, 668, 670
Format

FastSave tab 664
frame 736
Freq & BW tab

DPX display 88
RF I & Q vs Time display 119

Freq & Span tab
General Signal Viewing displays 120

Freq and RBW tab
LTE 468

Freq Deviation 54, 60, 293
Freq Diff, Phase Diff, Freq Abs settings 312
Freq Error 54
Freq Estimation tab

Pulsed RF displays 315
Freq Setup tab 286
Freq-domain Linearity setting 311
Freq, Span & RBW tab

Channel Power & ACPR display, MCPR display 163
RF Measurements displays 214

Freq, Span &amp; RBW tab
Signal Strength display 155

frequency 736
Frequency

DPX display 80
of local oscillator 272

frequency band 736
Frequency Dev vs Time (P25) display 427
Frequency Deviation vs. Time settings 591
frequency domain view 736
frequency drift 736
Frequency Edge triggering 674

Frequency Error 53, 597
Frequency Mask Trigger (FMT) 665, 667, 668, 670
Frequency Offset

GP Digital Modulation displays 609
frequency range 736
Frequency scale

linear 384
log 384

frequency settling time
measuring 197

frequency span 736
Frequency tab (Phase Noise) 187
Frequency vs. Time display 114
Frequency vs. Time Settings 116
Full Screen 716

G
Gain and Noise Figure measurements 271
Gain display 273
Gain display settings 274
Gain Imbalance 53, 597
GPIB 736
GPIB tab 46
graticule 737
Graticule On/Off

RF Measurements displays 219
Signal Strength display 158

grayed out 737

H
Hanning Filter Shape

Spectrum display BW tab 124
Harmonic markers

EMC troubleshooting 364
Hide sensitive readouts 46
Hide Sensitive readouts 46
Histogram readout

Pulsed RF displays 320
Holdoff

Triggering 680
HPF

Audio Filters tab 575
Hum & Noise

Audio Summary display 578
hysteresis 676

I
I/Q 737
IF 737
Ignore Region

Params2 tab 575
import 737
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Impulse Response Amplitude 60, 293
Impulse Response setting 311
Impulse Response Time 60, 293
InBand Emission

Bluetooth 555
Information messages 721
input impedance 737
input protection 706
Inspect suspect frequencies

EMC troubleshooting 364
Intermediate Values tab

Uncertainty Calculator Display 284
Internal Preamp

Internal Settings tab 653
IQ Origin Offset 53, 597
IQ output 709
IQ outputs 708
IQ vs. time view 118
is greater than (Test) 637
is inside mask (Test) 638
is less than (Test) 637
is outside mask (Test) 638

K
Kaiser (RBW) Filter Shape

Spectrum display BW tab 124
Keep-out time 311

L
Launch EMC Analysis tool 340
Length

Equalizer tab 610
Level target

EMC troubleshooting 367
Levels tab

Pulsed RF displays 314
Limit lines 636
Limits

Spurious display 180
Limits tab

P25 Analysis displays 436
Linear frequency scale 384
Link to Span 119
LISN 737
Load

Ranges and Limits Tab 177
Ranges and Limits table 179

Local oscillator 272
local oscillator (LO) 737
Location

FastSave tab 665
Lock Center Frequency of Spectrum displays to Measurement

Frequency
Frequency tab 645

Log
Audio Spectrum display 578

Log (Horizontal)
Spectrum display 106

Logarithmic frequency scale 384
Loop over all selected records

Replay menu 649
LPF

Audio Filters tab 575
LTE

Analysis Params tab 470
Analysis Time tab 471
Channels tab 460
Freq and RBW tab 468
Measurement Params tab 469
Modulation Params tab 469
Offsets and Limits Table tab 463
Parameters tab 461
Prefs tab 467
Processing tab 462
Scale tab 465
Trace tab 472
VBW (Channels tab) 461
VBW (Freq &amp; RBW tab) 469

LTE ACLR
settings 452

M
Mag Error

OFDM 51
WLAN 52

Magnitude Error vs. Time display 591
Magnitude Error vs. Time settings 592
manuals 19, 20
marker 737
Marker Noise mode 634
Marker Properties tab 631
Marker to Center Frequency 631
Markers

in the BT Symbol Table 548
Marker Toolbar 633
Using Markers 628
Using Markers in Noise Mode 634

Markers menu 718
Markers snap to peaks when dragged 48
Mask

Ranges and Limits table 179
Mask Editor 636, 668
Mask tab

Settling Time displays 202
mask testing

settling time measurement 189
MATLAB file format 701
Max files saved per Run
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Max files saved per Run (continued)
FastSave tab 665

Max Freq Error 59, 293
max hold 737
Max Number of Pulses

Params tab 310
Max Phase Error 60, 293
Max total files saved per Run 681
Max trace points 112, 114, 116, 118
MCPR (multiple carrier power ratio) 737
MCPR display 158
MCPR settings 162
Meas BW

Frequency Settling Time 201
Meas Frequency

Frequency Settling Time 200
Measurement BW, no filter

Freq & BW tab 88
Measurement Filter

Params tab 309
Measurement Length

Time Params tab 202
Measurement Params tab

Channel Power &amp; ACPR display, MCPR display 163
Signal Strength display 156

Measurement point 312
Measurement settings export 699
Measurements tab 309
measuring settling time 197
Menus 711
MER (RMS) 53, 598
min hold 738
Min Settled Duration

Time Params tab 202
Minimum off time between pulses

Params tab 310
Mod Distor

Audio Summary display 572
Mode

Equalizer tab 610
modulate 738
modulating signal 738
modulation 738
modulation measurements 581
Modulation measurements 52
Modulation Params tab

GP Digital Modulation displays 604
OFDM Analysis displays 264
P25 Analysis displays 430, 558
WLAN Analysis displays 242

Modulation types supported 605
moving windows 720
Multi-Carrier Power Ratio 51
Multiple Carrier Power Ratio 162

N
Network Connections 35
nFSK modulation type measurements 54
nFSK signal quality measurements 598
No. of Harmonics

Params2 tab 575
No. of Non-Harmonics

Params2 tab 575
noise 738
Noise

Params tab 288
noise bandwidth (NBW) 738
Noise Figure and Gain measurements 271
Noise Figure display 275
Noise Figure display settings 276
noise floor 738
Noise markers 634
Noise Source tab 286
Noise Table display 271
Noise Table settings 273
Noise Temperature display 277
Noise Temperature display settings 278
Non-Harmonic Excursion

Params2 tab 575
Non-Harmonic Threshold

Params2 tab 575
None

trace motion 88
Normal

trace motion 88
NR Averaging tab 515
NR Carrier Configuration tab 506
NR Channel power display 486
NR CHP tab 519
NR Estimation tab 523
NR Modulation Accuracy tab 521
NR SEM tab 520
NR Signal Configuration tab 503
NR Subblock Configuration tab 504
NR Traces tab 523

O
OBW Level Left/Right 167
Occupied Bandwidth 169
OFDM Channel Response

settings 252
OFDM Constellation

settings 253
Off

Ranges and Limits table 179
Off button (Alignments dialog) 36
Offset & Limits Table tab

SEM display 211
Offset EVM 597
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On
Ranges and Limits table 178

On/Standby switch 729
online help 705
open (recall) 738
Open EMC Analysis tool 340
Options control panel 46
OQPSK 738
OQPSK and SOQPSK modulation type measurements 53
Outputs

28 VDC 708
IQ 709
Zero Span 709

Overlap 109
Overshoot

dB 293
Overshoot dB 59, 293
Overshoot settings 313
Overview tab 285

P
P25

presets 43
P25 Constellation

settings 416
P25 limits 421
P25 measurements 55
Parameters tab

AM display 133
CCDF display 182
FM display 139
Occupied BW display 169
Phase Noise display 188
PM display 144
SEM display 209
Spurious display 175

Params tab
DPX display 87
Noise 288
Pulsed RF displays 309

Params1 tab
Audio Analysis displays 573

Params2 tab
Audio Analysis displays 574

Pass /Fail readout
SEM display 207

Pass/Fail Limit Testing
Spurious display 180

Pass/fail testing
EMC Range &amp; Limits table 392

Pass/Fail tests 637
Pause

Replay menu 650
Peak Excursion 631
Peak FSK err 54

Peak Mag Err 54
Peak Power 58, 292
Peak Threshold 631
Peak-Peak/2

Audio Summary display 571
Peak/Avg Ratio 51
Phase

DPX display 80
Phase Deviation 60, 293
Phase Difference 293
Phase Error

OFDM 51
WLAN 52

Phase Error vs. Time display 593
Phase Error vs. Time settings 594
Phase Noise display 183
phase settling time

measuring 197
Phase Settling Time display 193
Phase Settling Time settings 196, 199
Phase vs. Time display 116
Phase vs. Time settings 117
pictures

saving 699
Pk-Pk

FM display 55
PM display 55

Pk-Pk/2
FM display 55

Plot
Accessories tab 384

PM 738
PM measurements 55
Position

Triggering 680
Power

OFDM 52
Power class

Bluetooth 558
Power Markers 631
power measurements 149
Power measurements 51
Power Threshold to Detect Pulses

Params tab 310
Power vs Time

WLAN 52
Pre-defined Filters

Audio Filters tab 575
Prefs tab

AM display 136
FM display 142
GP Digital Modulation displays 619
OFDM Analysis displays 269
Options control panel 46, 47
P25 Analysis displays 436
PM display 148
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Prefs tab (continued)
WLAN Analysis displays 249

presets 44
Presets

configuring User 40
P25 43
recalling 40
Standards 43
WLAN 43

Presets tab
Options control panel 46, 47

primary marker 738
Print 715
Print Preview 715
Processing tab

SEM display 210
PSK 739
Pulse measurements 58, 292
Pulse Table display 301
Pulse Trace display 303
Pulse Width 58, 292
Pulse-Pulse Frequency Difference 294
Pulse-Pulse Phase Difference 294
Pulse-ref Freq Difference 293
Pulse-ref Phase Difference 293
pulses

how many can be analyzed 310

Q
QAM 739
Quadrature Error 53, 597

R
Range file 701
Ranges and Limits Tab

Spurious display 177
RBW 739
RBW (Time-domain BW) filter

Freq & BW tab 88
Ready trigger status light 666
real-time analysis 739
real-time bandwidth 739
real-time seamless capture 739
recalling Presets 40
red text

settling time measurements 195
Ref

Audio Summary display 572
Ref Channel tab

SEM display 210
reference level 739
Reference tab

Spurious display 175

Rel
Ranges and Limits table 179

Rel Same
Ranges and Limits table 179

Rel Start (dB)
Ranges and Limits table 179

Rel Stop (dB)
Ranges and Limits table 179

Repeat 659
Repetition Interval 59, 292
Repetition Rate 59, 292
Replay all selected records

Replay menu 649
Replay current record

Replay menu 649
Replay from selected

Replay menu 649
Replay menu 649
Replay Speed tab 649
Replay toolbar

Replay menu 650
Reports

EMC Analysis 356
generate EMI test 360
save EMI test results 359

Reset Equalization
Equalizer tab 610

Reset layout
Ranges and Limits Tab 177

residual FM (incidental FM) 739
residual response 739
results

saving 699
Resume 659
RF & IF Optimization

Internal Settings tab 654
RF Channel Power measurement 151
RF I & Q vs. Time display 118
RF I & Q vs. Time settings 119
RF input protection 706
Rho 53, 597
Ripple 59, 293
Ripple dB 59, 293
ripple measurement

calculation 739
Ripple settings 313
Rise Time 58, 292
RMS

Audio Summary display 572
FM display 55
PM display 55

RMS Error Magnitude 54
RMS Freq Error 293
RMS FSK Err 54
RMS Mag Err 54
RMS Phase Error 59, 293
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Roll
trace motion 88

RTPA2A 707
Run 659
Run menu 717

S
S/N

Audio Summary display 572
Sampling Parameters Tab 660
Save

Ranges and Limits Tab 177
Save acq data on Trigger 681
Save and Export tab

Options control panel 47
Save As

Ranges and Limits table 179
Save on trigger 681
Save picture on Trigger 681
saved file types 699
saving

acquisition data 699
pictures 699
presets 44
results 699
setups 699

Saving and Recalling Data 699
Saving X of XX 664
Scale tab

AM display 136
Audio Analysis displays 578
CCDF display 182
DPX Spectrum display 92
FM display 141
General Signal Viewing displays 126
GP Digital Modulation displays 618
OFDM Analysis displays 268
P25 Analysis displays 434
PM display 147
Pulsed RF displays 318
RF Measurements displays 218
SEM display 213
Settling Time displays 204
Signal Strength display 157
Spectrogram display 110
Spectrum display 106
WLAN Analysis displays 247

Search control panel 641
Search In 637
secondary marker 740
Security tab

Options control panel 46, 47
Select all

Replay menu 650

Select data records tab 648
Select DPX Spectra tab 648
Select records from history

Replay menu 650
sensitivity 740
Set limits

EMC Range &amp; Limits table 392
Set to max BW 119
Settings

AM display 132
Audio Spectrum display 570
Audio Summary display 572
BT 20dB BW 554
BT CF Offset and Drift 456, 458, 541
BT Constellation 535
BT Eye Diagram 538
BT Frequency Dev vs. Time 552
BT Summary 545
BT Symbol Table 548
CCDF display 181
Cumulative Histogram display 296
Cumulative Statistics Table display 300
DPX Spectrum 86
EVM vs. Time display 586
FM display 138
Frequency vs. Time 116
Gain display 274
LTE ACLR 452
LTE Channel Spectrum 455
Noise Figure display 276
Noise Table display 273
Noise Temperature display 278
Occupied Bandwidth 169
OFDM Constellation 253
OFDM EVM 255
OFDM Flatness 256
OFDM Mag Error 258
OFDM Power 260
OFDM Summary 262
OFDM Symbol Table 263
Options control panel 46
P25 Constellation 416
P25 Eye Diagram 419
P25 Frequency Dev vs. Time 428
P25 Power vs Time 421
P25 Summary 424
P25 Symbol Table 426
Phase Noise 187
Phase Settling Time 196
Phase vs. Time 117
Pulse Statistics display 307
Pulse Table display 302
Pulse Trace display 304
Pulse-Ogram display 301
restoring defaults 36
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Settings (continued)
RF I & Q vs. Time 119
Spectrogram display 109
Spectrum display 105
Spectrum Emission Mask 208
Spurious display 174
Symbol Table display 600
Time Overview display 100
Trigger 670
Uncertainty Calculator display 283
WLAN Constellation 225
WLAN EVM 226
WLAN Mag Error 228
WLAN Power vs Time 232
WLAN Spectral Flatness 234
WLAN Summary 238
Y Factor display 280

Settings tab 289
Settled Frequency

definition 189
Settled Phase

definition 189
settling time

measuring 197
Settling Time

definition 189
Settling Time decimal places

Settling Time displays 205
settling time measurement

text color 195
setups

saving 699
shape factor (skirt selectivity) 740
Show Parameter Readouts 128
Show points 384
Show recalled trace

Time Overview display 101
signal 740
Signal Classification

create a region 687
define a region 687

Signal Power
Audio Summary display 571

Signal Quality display 595
Signal quality measurements 596
Signal Quality settings 599
Signal standards 682
signal strength 740
Signal Strength display 153
Signal Strength Settings control panel 155
Signal types 682
SINAD

Audio Summary display 572
Single 717
sluggish operation 729

span 740
span per division 740
Span/RBW Ratio

Spectrum display BW tab 124
spectrogram 740
Spectrogram display 107
Spectrogram display settings 109
spectrum 741
Spectrum

DPX display 80
spectrum analysis 741
spectrum analyzer 741
Spectrum display 103
Spectrum display settings 105
Spectrum Monitor

Spectrogram 112
spectrum time 741
Spectrums/line 109
Split

DPX display 80
spot 741
Spot requirements

EMC Range &amp; Limits table 392
Spur

defining 180
Spurious 170
Standard

Audio Filters tab 575
Standard Settings button 604
Standards

how to set up database 682
Standards presets

P25 43
WLAN 43

Start (Hz)
Ranges and Limits table 178

Status Bar 716
Step size

Freq & BW tab 88
Stop

Replay menu 650
Stop (Hz)

Ranges and Limits table 178
Summary

WLAN 52
Sweep time 88
symbol maps 620
Symbol Rate 54
Symbol Rate Error 54
Symbol Table

WLAN 52
Symbol Table display 600

T
Taps
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Taps (continued)
Equalizer tab 610

Taps/Symbol
Equalizer tab 610

Target Reference
Frequency Settling Time 201

Test For 637
Test Patterns tab

P25 Analysis displays 433
Test using a mask 638
THD

Audio Summary display 572
Thrshld (dBm)

Ranges and Limits table 179
Thunderstorm color scheme 47
Time 293
Time & Freq Scale tab

Spectrogram display 94, 111
Time Overview 98
Time Overview display settings 100
Time Params tab

Settling Time displays 201
time scale status readout 109
TIQ acquisition data files 47
TIQ acquisition data files parameters 46
TNHD

Audio Summary display 572
Tolerance (+/-)

Frequency Settling Time 201
Tools Menu 719
Total AM

AM display 55
Touch Screen 28
Touch-screen Actions 28
Trace 2

Constellation display 618
Trace motion for Sweep ≥ 1 sec 88
Trace tab

AM display 134
FM display 140
GP Digital Modulation displays 616
OFDM Analysis displays 267
P25 Analysis 433
PM display 145
Settling Time displays 203
Time Overview display 101
WLAN Analysis displays 246

Traces tab
General Signal Viewing displays 121
Pulse-Ogram display 317
RF Measurements display 215
Spectrogram display 110
WLAN Channel Response display 246

Traces tab - Math Trace
General Signal Viewing displays 124

Transform Window

Transform Window (continued)
Spectrum display BW tab 124

Trellis Diagram display settings 602
Trig Meas tab

P25 Analysis displays 436
Trig'd trigger status light 666
Trigger On This 667
Trigger settings

Advanced tab 680
Event tab 670

trigger signals
connecting 708

trigger status lights 666
triggering

frequency mask trigger 665
troubleshooting 720
Troubleshooting tools

EMC Analysis 363
Troubleshooting tools EMC

persistence display 370
Tutorials

YouTube videos 21
Types

how to set up signal database 683

U
Uncertainty Calculator display 281
Uncertainty Calculator settings 283
Uncertainty tab

Uncertainty Calculator Display 284
Uniform (None) Filter Shape

Spectrum display BW tab 124
Units tab 647
Upgrades 720
Uplink 685
User Filters

file format 625
loading 625

User presets 44
User Symbol Map 613

V
VBW

LTE 461, 469
Spectrum display BW tab 124

VBW (Hz)
Ranges and Limits table 178

VBW On
Ranges and Limits table 178

Video tutorials 21
View Menu 715
violation (frequency mask trigger) 677
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W
watch icon 679
Waterfall

Spectrogram/DPXogram 110
Spectrogram/DPXogram display 93

Window menu 720
Windows Event Viewer 728
WLAN

presets 43
video tutorials 21

WLAN Channel Response
settings 223

WLAN Constellation
settings 225

X
x dB Level 170

Y
Y Factor display 279
Y Factor display settings 280
YouTube

Tektronix channel 21

Z
Zero Span

DPX display 80
Zero Span output 709
Zero Span tab 709
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